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System Administration
CSM provides a number of powerful Administrative features that help you install, configure, secure,
automate, and extend your system.

23

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Installing
The installer provides all the elements and tools needed to successfully install or update CSM.
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Installation
Installation steps vary depending on which installers are run (Server, Portal and Browser Apps, and
Client), whether you are installing a new instance of CSM or upgrading an existing instance, and whether
or not Auto-Deploy is used.

For more information about installation/upgrade steps, see Steps to Install or Update CSM.

Installation configurations also vary. A typical installation is called a single-server installation because the
Cherwell Application Server and supporting services are all installed on one machine. A typical single-
server installation involves three tiers:

• (Tier 1) Database server: Houses the CSM database (SQL database).

• (Tier 2) Cherwell Server (main server): Houses the Cherwell Application Server and supporting
services, and the Portal and Browser applications.

• (Tier 3) Client machines: Houses the client-only files/administrator tools (the CSM Desktop Client,
CSM Administrator, and all the supporting tools/utilities).

The following figure shows a typical single-server installation.
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Multi-Language Installers
The CSM installer is available in English, German, French, Spanish, and Brazilian Portuguese. Download
the CSM installer for your preferred language to step through the installation process in that language.

Platform code-level support for all five languages is included with each installer. Each multi-language
installer follows the same sequence of steps to complete the Server, Web Applications, and Client
installations.

Content support for all five languages is included in the Demo and Starter databases by default.

Globalization features enable you to translate platform and content strings into multiple languages.
Globalization is enabled by default.
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Considerations for CSM SaaS Implementation
Using a hosted implementation of CSM has benefits that on-premises installations do not have. However,
there are a few differences in users' ability to control the product.

Some features described in the Cherwell Product Documentation are only available to users on an on-
premises system. To ensure the security of the hosted environment, some other features require users
with software as a service (SaaS) implementations of CSM to coordinate with Cherwell Support.

The following CSM functionality is not available for SaaS customers:

• Database server object management, including accessing, creating, editing, or deleting

• Configuring database file settings

• Creating CSM database views

• Performing database system maintenance, which includes:
◦ Shrinking the event log

◦ Rebuilding full-text search catalog

• Modifying or deleting the CSDAdmin or CherwellServices accounts in the User Manager

• Linking new Business Objects to an external database

The following actions must be coordinated with Cherwell Support:

• Configuring the Log Viewer

• Installing the Trusted Agents Hub

• Restoring a database

• Configuring a SAML integration

• Penetration testing

• Upgrading CSM

• Creating encryption keys

Note: SaaS users must sign a Field-Level Encryption addendum before working with
Cherwell Support to create encryption keys.

The following activities are available for SaaS users after Cherwell installs and configures the Trusted
Agents Hub:

• Using Trusted Agents to provide secure access between private network and Cherwell data center

• Configuring a Trusted Agent to use printers on their remote network

• Using One-Step Actions with Trusted Agents to perform the following tasks:
◦ Run a program

◦ Write to a file
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◦ Excel merge

◦ Call a web service

Related concepts
Database Server Objects Security Rights
About Encrypted Fields
Trusted Agents Components
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Installations
CSM provides the following installations:

• Server: Installs the Server Manager, the Cherwell Application Server, and the Cherwell Service
Host.

• Web Applications: Installs the CSM Browser Client, CSM Portal, Cherwell REST API, and Auto-
Deploy.

• Client: Installs the main Client applications (client-only files) and administrator tools (optional). (You
can optionally install the server files as well, but it is not typical.) For most Users, the Client
applications will be installed via Auto-Deploy.

Important: Run the Server installation first, then the Portal and Browser Apps installation.
Client installations are run last and are typically pushed out to client machines using the
Auto-Deploy feature (Auto-Deploy is configured separately to push out a preconfigured
Client installation and connection).

The following tables describe the installation components in each installation.

Server Installation

Item Description

Cherwell
Application
Server

The Cherwell Application Server is a CSM service that runs programs and handles
application operations between Users and their databases. The Application Server is
the middle tier of the Cherwell 3-tier application. Client applications connect to the
Application Server.

Cherwell
Service Host

The Cherwell Service Host includes four microservices: Automation Processes, E-mail
and Event Monitoring, Cherwell Mail Delivery, and Scheduling.
The Cherwell Mail Delivery Service is automatically installed, along with the Cherwell
Message Queue Service (CherwellMQS) message broker application. Since the
installation is automatic, Cherwell Mail Delivery Service will not appear as an
installation option.

Note: Along with RabbitMQ, Erlang is automatically installed to power
CherwellMQS. Erlang will show up in the Start menu of any machine where
CSM is installed.
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Item Description

Database
Options

The installer prompts Users to either:

• Install a new database (Starter or Demo): Installs the most recent version of a
CSM Demo or Starter database, including any required internal system
definitions.

• Update an existing database: Installs new internal system definitions (required for
new functionality) to your existing CSM database. Updating does not affect
current system definitions.

Portal and Browser Apps Installation

Item Description

Customer
Portal

The CSM Customer Portal is a highly configurable web application that enables
Customers to securely and conveniently access their CSM data (example: Incidents,
company news, documents, the Service Catalog, etc.) using a browser. A Portal
supports multiple sites (for different types of Users), and also allows managers to
access their Team’s data.

Browser
Client

The CSM Browser Client is a web application that enables Users to access most of the
features available from the CSM Windows-based Desktop Client using a browser. The
CSM Browser Client supports most major modern browsers on desktop machines and
tablets.

Auto-Deploy

Cherwell Auto-Deploy is an installation tool that allows system administrators to
automatically distribute preconfigured Desktop Client and or CSM Administrator
installations and connections to client machines. Auto-Deploy is configured using the
stand-alone Auto-Deploy Configuration Utility and is deployed using the Auto-Deploy
web page.

Cherwell
REST API

The Cherwell REST API provides programmatic access to many CSM functions via an
HTTP-based RESTful API. Methods are available for finding, creating, and updating
Business Objects; finding and running saved Search queries; managing users; and
more. Comprehensive API documentation is available in the Cherwell REST API
Discovery Tool, which enables you to discover and test methods using your CSM data.

Cherwell Web
Service
(CWS)/Web
API

The Cherwell Web Service (CWS) is an API for communicating with CSM using Simple
Object Access Protocol (SOAP) over HTTP. CWS must be running for the Mobile
applications to operate, and is also required for a number of other features (RSS feeds,
SAML security access, etc.).
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Item Description

Web-Forms

Cherwell Web-Forms™ is a browser-based application that allows users to enter, view,
and edit CSM Business Objects over the web without having to log in (example:
Registration, ordering.). This tool also allows for the remote execution of One-Step
ActionsOne-Step™ Action.

Client Installation

Item Description

Client-Only Applications CSM Desktop Client, Outlook® Add-in (Installer), Report
Runner, and the Dashboard Viewer.

Administrator Applications CSM Administrator, System Upgrade/Restore, and Test
LDAP Tool.

Server Applications See Server installation.

Note: The Browser applications (example: CSM Browser Client, Customer Portal, CWS, etc.)
are installed during the Portal and Browser Apps installation.
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Connections
A connection is the means by which a CSM application connects to another tier of the CSM suite (a Client
is a tier, a Cherwell Server is a tier, and the database is a tier).

CSM has two different types of connections that are used in different ways and from different places. Both
types of connections are configured through the Connection Wizard:

• Direct-to-Database connection (2-tier): A direct-to-database connection is a connection
between one or more CSM applications and a CSM database. Typically, only CSM
Servers (example: Cherwell Application Server) use this type of connection, although the
Client applications can use direct-to-database connections under special circumstances,
bypassing the Cherwell Application Server. A direct-to-database connection is also
referred to as a "2-tier connection" because only two tiers are involved: The Cherwell
Server (Tier 2) connects to the CSM database (Tier 1).

• App Server connection (3-tier): An App Server connection is a connection between one
or more CSM applications (example: CSM Desktop Client) and the Cherwell Application
Server. An App Server connection is also referred to as a "3-tier connection" because
three tiers are involved: The CSM application (Tier 3) connects to the CSM database (Tier
1) through the Cherwell Application Server (Tier 2).

For a new installation, configure the following three connections:

• Server connection: The Server connection is a configured direct-to-database (2-tier) connection
between any Cherwell Server (primarily the Application Server and the Cherwell Service Host.) and
a CSM database. During the Server installation, you are prompted to create this connection which,
by default, is named Cherwell.

• Browser connection: The Browser connection is a configured direct-to-database (2-tier)
connection between the CSM Browser applications and a CSM database. CSM Browser
applications use a different connection than the desktop clients because Browser applications run
inside IIS and the connection needs to work with the IIS security options. During the Portal and
Browser Applications installation, you are prompted to create this connection which, by default, is
(and should remain) named "Cherwell Browser."

• Client connection: A Client connection is a configured App Server connection (3-tier) that allows a
User to connect to the CSM database through the Cherwell Application Server. Although Users can
manually configure this connection, we recommend that the system administrator configure the
Client connection as part of the Auto-Deploy configuration, and then push the Client connection out
to all Users using the Auto-Deploy process. A Client connection pushed out by Auto-Deploy is also
referred to as an "Auto-Deployed Client connection."

The configuration steps vary by the type of connection. Typically, a system administrator configures all
three connections during the installation process. To help with the configurations, CSM provides the
Connection Wizard, which is launched automatically by the Installation Wizard during the Server and
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Browser/Portal Apps installations, and manually by the system administrator during the Auto-Deploy
configuration.

Related concepts
Default Port Numbers
Configure the Server Connection
Configure the Client Connection
Related tasks
Configure the Browser Connection
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Default Port Numbers
The list below lists the default ports that CSM uses.

Connection Protocol Default Port

Client Connection

HTTPS (Recommended for all production environments.)

HTTP (Not recommended for production environments.)

Note: CSM versions installed before 9.5.0 can run on
TCP; however, TCP connections are a legacy
configuration. HTTPS is the recommended protocol.
For TCP connections, the default port is 8001.

443 (HTTPS)

80 (HTTP)

Internet
HTTPS (Recommended for all production environments.)

HTTP (Not recommended for production environments.)

443 (HTTPS)

80 (HTTP)

LDAP LDAP 389

CherwellMQS
(RabbitMQ) AMQP (Transport by TCP)

5672

15672

E-mail

SMTP

SMTP SSL

POP3

POP3 SSL

IMAP4

IMAP4 SSL

25

465

110

995

143

993

Microsoft SQL Server TCP 1433

Redis (optional for
load balancing) TCP 6379
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Connection Protocol Default Port

Splunk (optional) HTTP 8089

Related concepts
Server Installation Options
Configure the Application Server
Define General Directory Service Properties
Define Global POP or IMAP Account Settings
Troubleshooting Application Server Installations Using IIS
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Before Installing CSM
Before installing for the first time:

1. Verify that the system meets the System Requirements.

2. Complete the Installation worksheet.

3. Configure Internet Information Services (IIS).

4. Read the steps to install CSM.

Related concepts
Securing Your CSM Environment
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Gather Information Required for Installation
Before installing CSM, gather these worksheet items so you are prepared with the required server
information, account details, license keys, and URLs.

Table 1. Worksheet Items

Installation Item Description

Cherwell® Server

This is the machine where the Cherwell Application Server
and the supporting services are installed.

The account used to launch the services on this machine is
called the Cherwell Server account (Network account or
Services account).

The Cherwell Server account must have rights to the
registry and file system on the local machine, and must be
allowed to communicate via TCP. Often the account is a
local administrator. If you want the services to use the
same account to connect to the CSM database, you must
use a domain account that has rights to SQL Server.

• Server Name: Example: CherwellServer

• Location: Example: \\domain\CherwellServer

For Cherwell Server Account Credentials:

• Username: Example: domain\henri

• Password: Example: Colorado719
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Installation Item Description

Database Server (SQL Server Machine)

This is the machine where the CSM database (SQL
database) is installed.

The account used to access the CSM database is often
called the Database Login account (SQL Login). The
Database Login account must have rights to insert, update,
and delete rows within tables. If you are planning to use
this account for the administrative functions that modify
that database, this account must also have rights to create,
drop, and alter tables, and to create views, indexes, and
stored procedures.

When the CSM services use this connection, the account
under which the service is running is the account whose
credentials will be used to connect to the database. If the
Cherwell Application Server is installed in the same
domain as the database server, and the service account
has rights to the database, and then use Windows
Authentication to provide the credentials. This information
is needed when creating connections.

• Server Name: Example: CSMDatabaseServer

• IP Address: Example: 168.212.225.204

Database Login Account Credentials:

• Username: Example: sa

• Password: Example: Colorado719

Cherwell Application Server

This is the location of the Cherwell Application Server.
HTTPS is the recommended protocol.

URL: Example:https://<CHERWELLSERVER>:<Port#>

Web Applications Server

CSM web applications must be contacted using a URL that
includes a fully qualified domain server name (DNS) and
this must also be resolved on the server.

CSM SaaS systems are configured to use the fully
qualified domain name by default; on-premises customers
can use one of these methods to ensure the web
applications server can resolve to a fully qualified domain
name:

• Add the fully qualified domain name mapped to
127.0.0.1 entry to the host file on the web server
used by CSM.

• Create internal DNS entries for the servers to resolve
the name to the internal correct IP address.
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Installation Item Description

Browser Application Account

The Browser App Database Login account must have
rights to insert, update, and delete rows in database tables.
We recommend that you use a SQL Account with sufficient
rights here, rather than Windows credentials. Otherwise,
IIS will need to be specially configured to use a Windows
account that has appropriate rights to the database.

• Username: Example: sa

• Password: Example: Colorado719

License
• Organization Name: Example: Cherwell Software

• Cherwell License Key: Example: 3SKPFM-PC9ZM-
PD4MK-FPG90-RLUW8

REST API URL

The base REST API URL is required for authenticating
Users for CSM applications, third-party reporting tools, and
webhooks. System administrators can configure the URL in
the Security section of CSM Administrator. The URL must
be in the following format: https://[servername]/
CherwellAPI/api/

Related concepts
Set the Base URL for the Cherwell REST API
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Configure IIS for CSM
As a prerequisite to installing CSM, on-premise customers must enable certain features for the Internet
Information Services (IIS) server that will be used with CSM. This includes adding HTTP activation
features for the .NET Framework, enabling dynamic compression, and enabling support for the
WebSocket Protocol (IIS 8.0 and later only).

Enable HTTP Activation for the .NET Framework
To enable HTTP Activation:

1. On the IIS server, open the Windows Server Manager.
2. Select Manage>Add Roles and Features.

3. Click Next until the Features page opens.

4. For .NET Framework 4.5 verify that HTTP Activation is selected.
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Improve Response Time for CSM Web Applications
Enable dynamic compression to potentially improve response times for CSM Web Applications,
particularly the Browser Client and CSM Portal. In many cases, the performance improvements are
dramatic, so Cherwell highly recommends that you enable dynamic compression for all IIS instances.

To learn more about dynamic compression and how to enable it, see https://docs.microsoft.com/en-us/iis/
configuration/system.webserver/httpcompression/#setup.

Enable the WebSocket Protocol
WebSockets establish an efficient 2-way connection between IIS and CSM web applications. You can
enable the WebSocket Protocol in IIS 8.0 and later; if you use an older version of IIS, polling is used and
Users may experience issues with CSM web applications, particularly when multiple tabs are used in the
same browser session.

To enable the WebSocket Protocol, see https://docs.microsoft.com/en-us/iis/get-started/whats-new-in-
iis-8/iis-80-websocket-protocol-support.

Related concepts
Troubleshooting Application Server Installations Using IIS
Related tasks
Steps to Install CSM
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Steps to Install CSM
The installation steps vary depending on which installations are run (Server, CSM Web Applications, and
Client), whether it is a new installation or an upgrade, and whether Auto-Deploy is used.

Important: Using a proxy server during configuration is not supported or recommended. Proxy
servers can change request headers and cache information, both of which can cause unknown
and unexpected issues with the CSM Client Applications andCSM Web Applications.

Complete the following high-level steps to install the CSM suite for the first time. Run the installation as a
system administrator so that all installation steps can execute successfully.

1. Add Windows Features to the IIS Server.
2. Run the Server installation to install the Server application and services files. Download and install

any third-party tools as prompted by the installer.
3. Configure the Server connection (when prompted by the Server installation). This is a direct-to-

database (2-tier) connection between the Cherwell Application Server and the CSM database.
4. Run the Portal and Browser Apps installation to install the Browser application files.
5. Configure the Browser connection (when prompted by the Portal and Browser Apps installation).

This is a direct-to-database (2-tier) connection between the Cherwell Browser Apps and the CSM
database.

6. Configure and start the Cherwell Service Host and CSM services.
7. Configure Auto-Deploy to push out the Client installation and connection to client machines.

Important: During the Auto-Deploy configuration, the configure the Client connection that
are auto-deployed must be configured.

8. Reboot the installation server. If you installed CSM and Portal and Browser Apps on different
servers, reboot both servers.

9. License CSM.
10. Log in to CSM Administrator (username = CSDAdmin, password = CSDAdmin) and complete these

configuration tasks:
a. Set up the User and Customer Profiles so that people in the organization can log in to other

CSM applications.
b. Open CSM Administrator, and set the base URL to the Cherwell REST API. The URL is

required for User authentication, third-party reporting tools, and webhooks. See Set the Base
URL for the Cherwell REST API.

To push out Client installations using Auto-Deploy, see Using Auto-Deploy.

Note: New Users must access the system administrator designated web page to run Auto-Deploy.
Existing Users are prompted to install the new version when they next run CSM locally.

Related concepts
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Configure IIS for CSM
Run the Web Applications Installation
Configure the Cherwell Service Host
Configuring Auto-Deploy
Log in to the CSM Desktop Client or CSM Administrator
Related tasks
Run the Server Installation
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Run the Server Installation
Launch the installation on the server in the location to install the Server application files.

Remember: Run the installation as a system administrator so that all installation steps can
execute successfully.

1. Double-click the CSM Installation.exe file.
2. Select Server.
3. Review the introductory text, and then select Next.
4. Select the I accept the terms in the license agreement radio button, and then select Next.
5. Provide the customer information, and then select Next.
6. Use the default location/folder in which to install the Server installation files or select Change to

browse to another location. We recommend accepting the default installation folder. For details
about the default location, refer to Folder Selection Options. Select Next.

7. Select the database components to install, then select Next. For details about the database options,
see Database Selection Options.

8. Select which CSM services to enable by default. You can disable or configure services later using
the Server Manager. For details about the server options, see Server Selection Options. Select
Next.

9. Provide the Cherwell Server account credentials that will be used to launch the CSM services, then
select Next. For details about the logon information options, see Server Logon Information.

10. Select Install.
11. The next page depends on selections made on the Database Selection page:

◦ Load the Demo or Starter database: The Connection Wizard opens to help configure the
Server connection (the connection between the CSM Application Server and the CSM
database).

◦ Update an existing database: A prompt appears to select an existing CSM database to update.
Select a database, log in, and then approve the update. Select OK when the wizard shows
that the update is complete.

◦ Not update any data: Installation is complete. A database update is typically necessary, so
there might be a prompt to update the database upon first run of the applications.

◦ If prompted, select an installation environment:
◦ Development: The database file is being used to configure functionality.
◦ Production: The database file meets all requirements, has been tested, and is ready for

business use.
◦ Test: The database file is being used for testing purposes.

Note: The environment type provides visibility into the environment you are
working with while managing your system. Once this value is selected, it displays
in the client login windows, window titles for the CSM Desktop Client and CSM
Administrator (when configured), the Health Check Results window, and the
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Company Information drop-down in the CSM Browser Client and Customer
Portal. You can leverage these values in your configurations using their
associated System Functions.

12. Select Finish.
13. Provide the base URL of the Cherwell REST API in the format https://host.domain/CherwellAPI/api/,

and select OK.

Note: If you skip this step, you can still install CSM, but an error that says that the
application is not configured to communicate with the Cherwell REST API server will display
when you attempt to log in.

Related concepts
Server Installation Options
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Configure the Server Connection
Use the Connection Wizard (automatically launched by the Installation Wizard during the Server
installation) to configure the Server connection (direct-to-database/2-tier connection between the Cherwell
Application Server and the CSM database).

Important: Using a proxy server during configuration is not supported or recommended. Proxy
servers can change request headers and cache information, both of which can cause unknown
and unexpected issues with the Cherwell Client and Web Applications.

To configure the Server connection:

1. Open the Connection Wizard in one of the following ways:
◦ Automatically opens during installation If installing the Demo or Starter database (new User).

◦ Manually open the Connection Wizard from the Connect to CSM window by clicking the Add
button.

◦ For an existing User with a CSM connection already configured, the Connection Wizard does
not appear, but there is a prompt to update the database either during the installation process
or on first run of an application if an update is required.

2. Review the introductory text.

3. Click Next.
4. Select a connection type:

◦ Connect to a Cherwell Server.This option takes you to the Server Location page next to
provide the URL for the Cherwell Application Server.

◦ Connect directly to a Cherwell database (this is a direct-to-database/2-tier connection).

5. Click Next.
6. Select a location to install the CSM database to.

7. Click Next.
8. Provide a name and owner for the database, or click Browse to see a list of available databases. If

unsure of the database name or owner, accept the default values.

9. Click Next.
10. Specify the Database Login account credentials.

11. Click Next.
12. Select the connection pooling and security or failover options.

13. Click Next.
14. Accept the default connection name (Cherwell) and provide an optional description.

Important: If the default connection name (Cherwell) is not accepted, the CSM Server
(service) connections have to be manually configured.
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15. Click Next.
16. Click the Test Connection button to verify the connection to the database. If the test fails, check

settings or choose to finish the installation.

17. Click Finish.

CSM creates the Server connection, and then imports the database. If this is an upgrade, CSM
imports any new, required internal system definitions.

If there is a message that the database needs to be upgraded to work with the latest version of
CSM, click Yes, and then perform the upgrade.

Related concepts
Connections
Default Port Numbers
Related reference
CSM Server and Browser Connection Options
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Server Installation Options

Folder Selection Options
You can use the default location/folder to install the Server installation files or click Change to browse to
another location. The following table describes the default folders.

Option Description Notes

Default folder for
32-bit machines

The default folder for 32-bit
machines is:

C:\Program Files\Cherwell
Service Management

Default folder for
64-bit machines

The default folder for 64-bit
machines is:

C:\Program Files (x86)\Cherwell
Service Management

Even though CSM files are installed to the (x86)
directory, CSM runs as a 64-bit application on
64-bit machines.

The reason CSM installs to the x86 directory is
that Windows installers do not easily support
installing applications that are both 32-bit and
64-bit. We do not install to C:\Inetpub because
IIS sometimes removes files in this directory in
certain scenarios.

Change Choose this option to browse to
another location.

We recommend accepting the default installation
folder.

Database Selection Options
You must select the data to install. The following table describes each of the database options.

Option Description Notes

Cherwell Demo
Database

Installs the Cherwell Demo
database (contains
structure and sample data/
Users).

Recommended for evaluating CSM. When Install is
selected, the Connection Wizard opens, prompting
you to configure the database connection.

Cherwell Starter
(Empty)
Database

Installs the Cherwell Starter
database (contains
structure but no data).

Recommended for using CSM in a production
environment. This option opens the Connection
Wizard, prompting you to configure the database
connection.

Upgrade an
existing
database

Updates an existing
database to the most
recent version.

If the database is not updated here, there is a prompt
later if an update is required. Click Install, and then
select a database to update.
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Option Description Notes

Do not load any
data

Skips installing or updating
the database.

Use this option when a database is not needed on the
machine where you are installing server applications.
For example, select this option if you are installing
CSM on distributed servers.

Server Selection Options
During the server installation, the Server Manager and all servers and services are installed. You must
select which to enable by default. The following table describes each server option.

Option Description Notes

Application
Server

Select this option to
enable the Application
Server as a web
application under IIS.

Windows Communication Foundation (HTTP and Non-
HTTP Activation) components are also required.

Automation
Process
Service

Select this option to
enable the Automation
Process Service.

Configure the Automation Process Service in the Server
Manager after installation.

Scheduling
Service

Select this option to
enable the Scheduling
Service.

Configure the Scheduling Service in the Server Manager
after installation.

E-mail and
Event Monitor

Select this option to
enable the E-mail and
Event Monitor service.

Configure the E-mail and Event Monitor in the Server
Manager installation.

Mail Delivery
Service

This service enables
email message queuing,
which provides increased
throughput of messages.

Configure the Mail Delivery Service in the Server
Manager after installation.

The Mail Delivery Service is automatically installed and
enabled, along with the Cherwell Message Queue
Service message broker application. Since the
installation is automatic, Mail Delivery Service will not
appear as an installation option.

• When you install CSM for the first time and select
the Don't load any data option instead of the
Starter or Demo database, you must set the
connection information manually; credentials will be
set to use CSDAdmin.

• When you install CSM for the first time and use the
demo or starter database, the Mail Delivery Server
uses that database as its connection; credentials
will be set to use CSDAdmin.
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Server Logon Information
You must specify a name and password for Cherwell Service Host and microservice configuration. You
can choose a specific Windows domain account or a special Windows service account.

Option Description Notes

Specific
account

Provide a User name (should be in the format
DOMAIN\UserAcct) and Password.

Click Browse to locate domains and
accounts on each domain.

Confirm that
User name &
Password are
legal

Select this check box to confirm that legal
credentials were entered.

By default, the installer confirms that
the credentials are legal.

Use Special
Account

Select this check box to use a Windows
account for the Cherwell Service Host and its
four microservices.
If a special account is selected, the
Application Server is installed using the built-
in AppPoolIdentity account.

You must select one of the following
options:

• Local System Account

• Local Service Account

• Network Service Account

Local System
Account

This account has extensive administrative
privileges on the local computer and acts as
the computer on the network. With
unrestricted access to local resources, it is
capable of doing things that could bring down
the entire system.

Enabled when the Use Special
Account check box is selected.

Important: The local system
account should not be used in
production environments.

Local Service
Account

This account has minimum privileges on the
local computer and presents anonymous
credentials on the network. The User
privileges are limited to the local computer.
Use this service for processes that do not
require access outside the server on which it
is running.

Enabled when the Use Special
Account check box is selected.

Network
Service
Account

This account has minimum privileges on the
local computer and acts as the computer on
the network. The service is authenticated to
other computers on the network by using the
computer’s account in the domain.

Enabled when the Use Special
Account check box is selected.

Related concepts
Default Port Numbers
Using Databases with CSM
Configure the Application Server
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CSM Server and Browser Connection Options
When configuring browser and server connections during your CSM installation, specify a location for the
database, the database login account credentials, administrative login options, connection pooling
options, and additional advanced options.

Database Location Options
The following table describes database location options.

Database Location Options

Option Description Notes

Database is
on this
machine

Connect to a local
database. Typically, this option is only for evaluation systems.

Specific
server

Connect to a database
that is installed on a
named server.

Provide the database server name, or select the name of
the database server in the drop-down list. The list might take
a few seconds to populate, and the desired server may not
be listed.

Note: If installing on an alternative instance of SQL
Server, specify the instance as part of the name:
CSMDatabaseServer\Instance.

IP Address

Connect to a database
installed on a server
referenced by an IP
address.

Provide the database server IP address.

Database Login Account Credentials
The database login account must have DBReader and DBWriter SQL permissions with rights to insert,
update, and delete rows within tables. If you also plan to use this account for the administrative functions,
the account must also have DBOwner View Server State permissions (although these permissions are not
recommended for production environments).

Database Login Options

Option Description Notes

Windows
authentication

Use the stored Windows credentials (user name
and password) for authentication.

Not recommended for
browser connections.

User ID and Password Select this option to log in by providing the user
ID and password of SQL Server.

Recommended for browser
connections.

We strongly recommend that you use a SQL account with sufficient rights rather than Windows
Authentication to connect to the CSM database for the following reasons:
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• The database connection must work with the security options for Internet Information Sevices (IIS).
When connecting using SQL credentials, a different connection is used so that the CSM browser
applications can run inside IIS. However, when connecting using Windows Authentication, IIS must
be specially configured to use a Windows account that has appropriate rights to the database.

• When using Windows Authentication credentials, the Windows account that must be authenticated
against SQL Server is the account that is used by the IIS application pool running the CSM browser
applications. This account is usually a special local account, which does not have rights beyond the
machine, and usually does not have rights to SQL Server running on the same server. This impact
to connection pooling may also impact performance.

Note: Setting up Windows Authentication requires configuration of both IIS and SQL Server
and is beyond the scope of this document.

When using SQL account credentials, note the following requirements:

• The View server state privilege must be set for the SQL database login account. In SQL Server
Management Studio, this privilege is located on the Securables tab of the Login Properties window.

• SQL Server must be configured for mixed mode authentication to support the use of SQL
credentials.

• The SQL account must have rights to insert, update, and delete rows in the database.

Administrative Login Options for Server Connection
Specify the account credentials that the administrative functions use to log in to the CSM database when
the database is being modified during the publishing of a CSM Blueprint.

The administrative login account must have DBOwner permission and View Server State privileges with
rights to create, drop, and alter tables, as well as insert, update, and delete rows within tables. When the
CSM services use this connection, the account under which the service is running is the account whose
credentials will be used to connect to the database. If the Cherwell Application Server is installed in the
same domain as the database, and the service account has rights to the database, then you can use
Windows Authentication to provide the credentials.

Administrative Login Options

Option Description Notes

Same as standard
login

Select this option to use the same login options
as the system.

Not recommended for
production
environments.

Windows
authentication

Select this option to use the stored Windows
credentials (user name and password) for
authentication.

User ID and Password
Select this option to login in using a specific user
name and password.

Provide the user ID and
password.
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Connection Pooling and Advanced Options
The Connection Options page includes sections for connection pooling options and advanced settings.

Connection Pooling and Advanced Options

Option Description Notes

Use default
pooling options

Select this option to use the
default pooling options.

This option is appropriate for most systems
with 30 or fewer concurrent CSM licenses.

Customize
pooling options

Select this advanced option to
specify custom pooling options.

Specify the pool sizes to customize the
caching options.
To improve performance, set the maximum
pool size to three times the number of
concurrent CSM licenses that are used in your
organization. You may need to adjust this
value, depending on usage of your system.

SQL Server is
configured as
an AlwaysOn
group

Sets the MultiSubnetFailover
property on the connection string,
which allows for a faster detection
and connection to the active
server.

In the instance of a failed server, instead of
attempting to reconnect one IP address at a
time sequentially, SQL attempts using all
addresses simultaneously to re-establish the
connection.

Encrypt
connection with
SQL Server

This option sets the Encrypt
property within the connection
sting.

In a server with a certificate installed, the
property gets or sets a Boolean value. In turn,
the value informs SQL whether to use the SSL
encryption when sending and receiving data
between the client and server application.

Always trust
SQL Server's
SSL certificates

This option sets the
TrustServerCertificate property on
the connection string.

This option is enabled when Encrypt
connection option is selected. When this
property is selected, the transport layer uses
the SSL to encrypt (to the level specified by
the server) the channel. The channel
bypasses going through the certificate chain to
validate trust.

Change
Connection
Packet Size

Allows Users to specify the packet
size of the connection.

Related concepts
Configure the Server Connection
Related tasks
Configure the Browser Connection
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Run the Web Applications Installation
Logged in as system administrator, install Browser Applications, update Auto-Deploy, and configure the
Browser connection to the CSM database.

Launch the installation on the server where you want to install the Portal and Browser applications files.

Important:

Before running the Browser Applications installer, first install the most currently supported version
of Microsoft .NET Framework. For specific version information, refer to System Requirements.

Remember: Run the installation as a system administrator so that all installation steps can
execute successfully.

To run the Portal and Browser Apps installation:

1. Double-click the CSM Installation.exe file.

2. Click Portal and Browser Apps.

The Portal and Browser Apps Installation Wizard opens.

3. Review the introductory text, and then click Next.
4. Read the license agreement. The license agreement can also be printed. If you accept the license

terms, select the I accept the terms in the license agreement check box, and then click Next.
5. Select which Browser applications to install.

Note: The REST API is installed regardless of the selections made on this page. If no
selection is made, the REST API is installed.

Click Next.

6. Select Auto-Deploy options, then click Next.
7. Use the default location/folder in which to install the Browser installation files or click Change to

browse to another location. We recommend accepting the default installation folder. For details
about the default location, refer to the folder selection options. Click Next.

8. Click Install.
9. The next page depends on previous selections:

◦ If Auto-Deploy is not yet configured and the User wants to update it: The installer prompts to
configure Auto-Deploy installation. Click Yes and configure it now, or configure it later by
clicking Windows Start > Cherwell Browser Applications > Auto-Deploy Config or
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Windows Start > Programs > Cherwell Service Management > Tools > Configure Auto-
Deploy, depending on the Server.

◦ If Browser connection (new User) is not yet configured: The Connection Wizard opens to help
configure the connection between the CSM Browser applications and the CSM database. This
is a different connection than the one for CSM because the Browser Apps run inside IIS and
the connection needs to work with the IIS security options. Follow the instructions in the
wizard.

◦ If the Cherwell Browser connection (existing User) is already configured: Installation is
complete.

10. Select Finish.
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Configure the Browser Connection
Use the Connection Wizard, which is automatically launched by the Installation Wizard during the Portal
and Browser App installation, to configure the Browser connection. The Browser connection is a direct-to-
database/2-tier connection between the Browser applications and the CSM database.

Most options are assumed or set by default to assist with decision making. For example, the connection
type is assumed to be a direct-to-database connection and the database connection is named Cherwell
Browser. Wizard page examples are in Configure the Server Connection.

Important: Using a proxy server during configuration is not supported or recommended. Proxy
servers can change request headers and cache information, both of which can cause unknown
and unexpected issues with the CSM Web Applications.

To configure the Browser connection:

1. Open the Connection Wizard in one of the following ways:
◦ If installing the Demo or Starter database (new User), the Connection Wizard automatically

opens during the installation process.
◦ Manually open the Connection Wizard from the Connect to CSM window by selecting the Add

button.

Tip: If the Connection Wizard is manually opened, be sure to name the connection
Cherwell Browser.

◦ If an existing User already has a CSM connection configured, the Connection Wizard does not
appear but instead you are prompted to update your database either during the installation
process or on first run of an application if an update is required.

2. Review the introductory text, and then select Next.

Note: If the wizard is automatically launched by the Installation Wizard, this window does not
appear because CSM already knows that it is a direct-to-database connection.

3. Select Connect directly to a Cherwell database because this is a direct-to-database/2-tier
connection, then select Next.

4. Specify where to find the CSM database, this is the name of the SQL Server machine where the
CSM database was installed, then select Next. For information on the database location options,
see CSM Server and Browser Connection Options.

5. Provide the name and owner of the installed Cherwell database to connect to. If unsure, leave the
default values. Select Next.

Note: The last page of the wizard enables you to test the database connection.

6. Specify the Browser App Database Login account credentials that the Browser applications use to
log in to the CSM database, then select Next. For more information on the options and requirements
for these credentials, see CSM Server and Browser Connection Options.
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7. Select connection pooling and security/failover options, then select Next. For more information on
these options, see CSM Server and Browser Connection Options.

8. Accept the default connection name (Cherwell Browser), provide an optional description for the
Browser connection, and then select Next.

Note: If the default connection name (Cherwell Browser) is not accepted, manually edit
configuration files for the Browser applications. For more information, refer to Troubleshoot
the CSM Web Applications

9. Select Test Connection to verify the connection to the database.

Note: If the test fails, the installation can continue.

10. Select Finish.

Related concepts
Connections
Default Port Numbers
Related reference
CSM Server and Browser Connection Options
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Web Applications Installation Options

Auto-Deploy Options
In the course of running your Web Applications installation, you will be required to specify auto-deploy
options. The following table describes each auto-deploy option:

Option Description Notes

Update
Auto-
Deploy

Update the Auto-Deploy
feature. Updating Auto-
Deploy wraps the latest
version of the installer so that
Users can then install CSM
by clicking a link on a web
page, or automatically after
being prompted to upgrade
when running an older
version of CSM.

If this is the first time setting up Auto-Deploy, there will be a
prompt to configure Auto-Deploy after clicking Install (later
in the installation).

Don’t
Update
Auto-
Deploy

Does not update the Auto-
Deploy configuration.

If not updated now, Auto-Deploy can be configured/
updated later by clicking either of these options depending
on the server:

• Windows Start>Cherwell Browser
Applications>Auto-Deploy Config

• Windows Start>Programs>Cherwell Service
Management>Tools>Configure Auto-Deploy

Folder Selection
In the course of your Web Applications installation you will have the option to use the default location/
folder in which to install the Browser installation files or click Change to browse to another location. The
following table describes the default folders:

Option Description Notes

Default folder for
32-bit machines

The default folder for 32-bit
machines is:

C:\Program Files\Cherwell
Browser Applications.
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Option Description Notes

Default folder for
64-bit machines

The default folder for 64-bit
machines is:

C:\Program Files (x86)\Cherwell
Browser Applications

Even though CSM files are installed to the (x86)
directory, CSM runs as a 64-bit application on
64-bit machines.

The reason CSM installs to the x86 directory is
that Windows installers do not easily support
installing applications that are both 32-bit and
64-bit. CSM does not install to C:\Inetpub
because IIS sometimes removes files in this
directory in certain scenarios.

Change Choose this option to browse to
another location.

We recommend accepting the default installation
folder.
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Run the Client Installation
Launch the installation on the Client machine in the location to install the Client application files.

Remember: Run the installation as a system administrator so that all installation steps can
execute successfully.

Tip: Client installations are run last and are typically pushed out to Users using the Auto-Deploy
feature (configured separately).

To run the Client installation:

1. Double-click the CSM Installation.exe file.

2. Click Client.
3. Review the introductory text, and then click Next.
4. Read the license agreement. The license agreement can also be printed. If the license terms are

accepted, select the I accept the terms in the license agreement radio button, and then click
Next.

5. Select who can use CSM on the Client computer, and then click Next.
6. Use the default location/folder in which to install the Client installation files or change the location by

clicking Change. We recommend accepting the default installation folder. For details about the
default location, refer to Default Installation Folders. Click Next.

7. Select which CSM applications to install, and then click Next. For details on the setup types, refer to
Client Setup Types.

8. Click Install.
9. When the install is complete, click Finish.
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Configure the Client Connection
Use the Connection Wizard to configure the Client connection (App Server/3-tier connection between the
Client machine and the Cherwell Application Server).

In most cases, the Connection Wizard is launched and the Client connection configured during the Auto-
Deploy configuration so that it can be pushed out to Users using the Auto-Deploy feature. Wizard page
examples are in Configure the Server Connection.

Important: Using a proxy server during configuration is not supported or recommended. Proxy
servers can change request headers and cache information, both of which can cause unknown
and unexpected issues with the Cherwell Client and Web Applications.

To configure the Client connection:

1. Open the Connection Wizard in one of the following ways:
◦ Manually open the Connection Wizard from the Auto-Deploy Configuration window by

selecting the Connection button.

◦ Manually open the Connection Wizard from the Connect to CSM window by selecting the Add
button.

◦ If an existing User and a CSM connection is already configured, the Connection Wizard does
not appear but there is a prompt to update the database either during the installation process
or on first run of an application if an update is required.

2. Review the introductory text, and then select Next.
3. Select Connect to a Cherwell Server (because this is an Application Server/3-tier connection), and

then select Next.
4. Specify where to find the Cherwell Application Server, and then select Next. For details on

specifying the server location, refer to Client Connection Options.

5. Provide a name and description for the Client connection, and then select Next.

Note: There cannot be two connections with the same name, so we recommend a name like
Company Cherwell.

6. (Optional) Select Test Connection to verify that the connection to the server/database.

Note: The Cherwell Application Server must be running in order to successfully test a 3-tier
connection. If the Application Server is not running (first time install or paused), manually
start it using the Server Manager (select Start>All Programs>Cherwell Service
Management>Tools>Server Manager, then select the Cherwell Application Sever and select
Start Server).

Note: It is possible to finish creating the connection without testing the connection.
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7. Select Finish.

CSM creates the Client connection.

Related concepts
Connections
Related reference
Client Connection Options
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Client Connection Options

Server Location Options
In the course of configuring your Client Connection, you will be required to specify the location of the
Cherwell Application Server. The following table describes each option:

Field Description Notes [optional]

URL
Provide the URL of the server
where the CSM Application
Server was installed.

Provide a URL using the HTTP protocol.

TCP connections are a legacy configuration and are only
available for systems upgraded from a version earlier
than CSM 9.5.0. For new installations of CSM, only
HTTP connections are supported.

The connection type must match the configuration on the
server, however.

Advanced

Select this link to specify
Certificate Validation Mode
settings. This option is for
advanced CSM users.

If the Security Mode is unknown, leave the option set to
Server Determines Mode, and CSM reads the settings
from the server.
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Client Installation Options

Default Installation Folders
In the course of your Client installation you will have the option to use the default location/folder in which
to install the Client installation files or click Change to browse to another location. The following table
describes the default folders:

Options Description Notes

Default folder for
32-bit machines

The default folder for 32-bit
machines is:

C:\Program Files\Cherwell
Browser Applications

Default folder for
64-bit machines

The default folder for 64-bit
machines is:

C:\Program Files (x86)\Cherwell
Browser Applications

Even though CSM files are installed to the (x86)
directory, CSM runs as a 64-bit application on
64-bit machines.

The reason CSM installs to the x86 directory is
that Windows installers do not easily support
installing applications that are both 32-bit and
64-bit. We do not install to C:\Inetpub because
IIS sometimes removes files in this directory in
certain scenarios.

Change Choose this option to browse to
another location.

We recommend accepting the default installation
folder.

Client Setup Types
In the course of your Client installation, you will be required to specify a setup type. The following table
describes each option:

Options Description Notes

Client-only Installs the CSM Desktop Client, Outlook Add-in (Installer), and the
Dashboard Viewer.

Client and
Administrator tools

Installs the client-only applications and the Administrator tools
(CSM Administrator, Report Runner, System Upgrade/Restore, and
Test LDAP)
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Logging in to CSM Applications
The main CSM applications require Users to log in to access the system. These applications include:

• CSM Desktop Client or CSM Administrator

• CSM Browser Client

• Cherwell Portal

To Log in to a CSM Application:

1. Select a connection: Either directly to the database or to the Cherwell Application Server, which is
connected to the database.

2. Provide CSM login credentials: User ID and password.

3. Select a Role for the session (if the User has access to multiple Roles): For example, an
Administrator could have the Role of IT Service Desk or IT Service Desk Manager.
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Using Auto-Deploy
Auto-Deploy is an installation tool that allows system administrators to automatically distribute
preconfigured Client installations and connections to client machines.

When working with the Auto-Deploy feature, Users can:

• Configure Auto-Deploy.

• Run Auto-Deploy.

Use the Auto-Deploy Configuration window to configure Auto-Deploy to push out Client installations.
When configuring Auto-Deploy, the system administrator defines:

• Which Client connection to push out.

Important: For first-time installations, the Client connection must be configured during the
Auto-Deploy configuration. Refer to Configure the Client Connection.

• Where to place the installation files.

• Connection and minor release options.

• Which CSM applications to install.

• Installation account options.

Run Auto-Deploy
Users must download and install Auto-Deploy the first time they open the Desktop Client. After the initial
installation, Users are prompted to install the new version.

The minimum supported version of the Microsoft .NET Framework is the 4.7.2 package. Users must
install .NET 4.7.2 before running Auto-Deploy.

To run Auto-Deploy:

1. Type the URL into the Auto-Deploy installation.

2. To install CSM, click the Cherwell Service Management link.
The Open/Save download box appears for the download.

3. Run the file.
Auto-Deploy launches. The Auto-Deploy options vary depending on how the system administrator
configured Auto-Deploy.

4. After the installation finishes, reboot your machine.
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Configuring Auto-Deploy
To configure Auto-Deploy:

1. Open Auto-Deploy:

Important: Due to commonly used components in Auto-Deploy technologies, an error may
appear cautioning against running the Auto-Deploy application. An error may also appear
depending on your Operating System and anti-virus settings. If the error appears, click the
Run Anyway button.

◦ If Cherwell Application Server is installed: click Windows Start>All Programs>Cherwell
Service Management>Tools>Auto-Deploy Config

◦ If Cherwell Browser is installed: click Windows Start>All Programs>Cherwell Browser
Apps>Auto-Deploy Config

2. Optional: Configure the Client connection if this is a first-time installation.

3. Click the Ellipses button to select an existing Client connection if this is not a first-time installation.
The database manager window opens.

4. Select an existing connection.

Note: Do not use the connections created for the Cherwell Servers or Browser Applications
because these are direct-to-database connections. Connect to the Cherwell Application
Server.

5. Click OK.

6. Provide the Auto Deploy Site URL.

7. Click the Ellipses button to select a Target folder. The Target folder is a directory location on the
server that specifies where the install files are stored.

8. Select desired check boxes to configure additional options:
a. Overwrite Client Connection

b. Make Connection Be Default

c. Require Users to Install Minor Releases

d. Connect Without Prompting

e. Display Debug Messages

9. Select the Install Under Specific Account checkbox.

10. Click the Add button. The install account window opens.

11. Provide account domain details and login credentials.

12. Click OK to close the install account window.

13. Click OK to close the Auto-Deploy Configuration window.

Related concepts
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Configure the Client Connection
Install Accounts for Auto-Deploy
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Configuring Auto-Deploy Options
The table below describes the details of the Configure Auto-Deploy options.

Option Description

Connection The Client connection that is pushed out to all clients during installation. This
must be an Application Server connection (3-tier connection).

Auto Deploy Site
The URL of the website housing the Auto-Deploy installation. If the defaults
are selected during the installation, then it is called CherwellAuto-Deploy
(example: http://MyServer/CherwellAutoDeploy).

Target Folder

The directory on the server where the install files are stored. This should be
the directory where Auto-Deploy is installed (the physical directory that is
pointed to by the Auto-Deploy site). If defaults were selected during the
installation, this should be C:\Program Files(x86)\Cherwell Browser
Applications\CherwellAutoDeploy.

Options

Overwrite client connection
Overwrites any defined Client database connections with the same name. For
example, if the Auto-Deploy connection was [Common]Cherwell and the User
already had a connection named [Common]Cherwell, it is overwritten.

Make connection be default Makes the installation connection the default Auto-Deploy connection for
Users.

Require Users to install minor
releases

Requires Users to install minor releases (example: 9.6.1 on top of 9.6.0) even
if the current version is compatible with the server. If this check box is cleared,
Users are given the option.

Connect without prompting Automatically connects to the installation connection without prompting Users.

Display Debug messages Use for troubleshooting only. A series of message boxes appear during
deployment. Leave this check box cleared.

Installation Options The CSM applications to install on the Client machines.

Run Installer on client without
providing any options to User

Does not give the User any options during the installation. Users are prompted
whether or not to install, but are not allowed to change the install directory or
files to install, and then select what to install.

Install only the Cherwell client
application

Installs the CSM Desktop Client, Outlook Add-in (Installer), and the Dashboard
Viewer.

Install the Cherwell client and
Administrative tools Installs both the Client application and the Administrator tool.

Allow User to choose what to
install

Allows the User to select whether or not to install the Administrator tool.

Note: This option is disabled if the Run Installer check box is selected.

Install for all Users Allows Auto-Deploy to run for all Users.
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Option Description

Install under specific accounts

Runs the installer as the specified administrator User for added accounts. The
installer selects the first account with a domain name that matches the current
domain. If there is no match, the installer selects the first account that has no
domain specified. There can only be one install account per domain name.
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Install Accounts for Auto-Deploy
Auto-Deploy allows you to add multiple install accounts to the Auto-Deploy configuration. The installer
runs through the accounts to find a domain that has installation rights.

To Add or Edit an Install Account for Auto-Deploy

1. Open the Auto-Deploy Configuration window.

2. Select the Install Under Specific Accounts check box.

3. Click Add or select an account and click Edit.
4. Provide the Domain name and User account. The format for the domain name is domain\account

(ex: Cherwell/firstname.lastname).

5. Provide the Password for the domain/account.
You should see the list of added accounts in the Auto-Deploy Configuration window.

Note: The Validate button only verifies the Domain/Account that the User is currently on.

To Remove an Install Account
Select an install account and click Remove.
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Licensing CSM
Licensing controls how many Users can log into CSM. CSM uses a concurrent or floating licensing model.
This means that a fixed number of licenses are shared among a group of Users/Customers, and that a
fixed number of people can simultaneously access the product. License codes determine the number of
people who can log in at any given time.

Example: If 100 licenses are purchased (100-person concurrent license), 100 people can log into CSM at
any given time; the 101st person is prohibited. When any one of the 100 people logs out, the next person
can log in.

License consumption varies depending on the product, who logs in (User or Customer), and what tasks
each person performs.
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Add a License Key
License keys, also known as license codes, determine the number of people who can log in at any given
time.

Use the Licensing window in CSM Administrator to provide a license code.

Note: You may be prompted to provide a license code when you attempt to log in to CSM.

To license CSM:

1. Open the Licensing window (CSM Administrator>Security>Licensing).

2. Click the Enter Code button.

The Enter License Code window opens.
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3. Provide a company name and license code. If you need a license code, contact Cherwell
Software.

4. Select OK.
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Reserve a License
Use the Reserve License feature in the Licensing window to ensure that a license is always available for
a:

• User: Reserve a license for the system administrator, so that he can always access CSM.

• Department: Reserve two licenses for the IT department so that members of that department can
always access CSM.

Note: This option is available only if a Department Holds Property is set on a Department
field in the UserInfo Business Object (CSM Administrator>Blueprint>Edit UserInfo Business
Object>General Page>Holds drop-down at the bottom of page). It is also recommended that
this Field be validated with a list of legal Departments.

To reserve a license:

1. Open the Licensing window (CSM Administrator>Security>Licensing).

The Reserved Licenses area lists the reserved licenses by User and department.

2. To reserve a license for a particular User:
a. Click Add user.

The Add Reserved License window opens, listing Users who do not currently have a reserved
license.

b. Click one or more users for whom to reserve a license.

Tips: Press Ctrl to select noncontiguous Users. Press Shift to select contiguous Users. Click
New User to create a new User Profile easily.

c. Select OK.

The User's Profile updates to reflect a reserved license (Has reserved license check box is
selected).

Tip: Reserve/free a license by selecting the Has reserved license check box on the User's
Profile (Admin>Security>Edit Users).

3. To reserve one or more licenses for a particular Department:
a. Click Add department.

The Add Department License window opens.

b. Select the department for whom to reserve a license.

c. Select the number of licenses to reserve for that department.

d. Select OK.
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4. To free a license, select the User/department, and then click the Remove button.

5. To change the number of reserved licenses for a department, click the department, and then click
the Edit button.

6. Select OK.
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Automatically Release a License
Use the Automatically Release a License option in the Licensing window to automatically release idle
licenses due to:

• User inactivity (example: Walked away with CSM open).

• A CSM Desktop Client crash.

Good to know:

• Configure the system to automatically log out idle Users, thus releasing licenses (CSM
Administrator>Security>Edit Security Settings>Desktop Client page>Logout inactive users from
Cherwell Client).

• The Browser Client, Customer Portal, and Mobile Clients automatically log out Users/Customers
after a period of inactivity based on Browser application settings and IIS configuration.

To Automatically release a license:

1. Open the Licensing window (CSM Administrator>Security>Licensing).

2. Select the If Client Stops Responding, Auto-release License After x Minutes check box.

3. Minutes: Specify the number of minutes to wait before releasing the license.

4. Select OK.
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License Consumption
License consumption varies depending on the application, who logs in (User or Customer), and which
operations each person performs:

• Only the following Cherwell applications require a license: Desktop Client, Browser Client, Cherwell
Mobile™ (Cherwell Mobile™ for iOS® and, Cherwell Mobile™ for Android™), and the Outlook®
Add-In. Under special circumstances, the Customer Portal might also require a license.

• A User consumes one and only one license when logging into a license-consuming Cherwell
application, regardless of the number of applications or instances of Cherwell that are accessed. In
other words, a User can simultaneously access multiple Cherwell applications and multiple
instances of Cherwell using one license.

Example: Andrew logs into CSM via his computer; Andrew consumes one license. Andrew then
logs into CSM through his mobile device; Andrew still consumes only the one license.

• Customers logging into Customer Portal to view/edit their own records typically do not consume a
license (example: A Customer owns the record, is the requestor, and is associated with the record).
Certain editing tasks require that the Customer log in and consume a license. CSM notifies the
Customer when a license is necessary. Customers who do do not have rights to consume a license
cannot edit the record.

• A Customer logging into the Customer Portal to access someone else's records does not consume
a license to view the record but does consume a license to edit a record. After a license is acquired,
it is held for the remainder of the Customer's session.

The following table shows license consumption by item:

Item Consumes License

Client Applications

CSM Desktop Client

CSM Browser Client

Cherwell Mobile™ for iOS®

Cherwell Mobile™ for Android™

Cherwell Mobile™ for Browser

Cherwell Portal™
Sometimes (see People)
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Item Consumes License

CSM Administrator

Supporting Applications

Auto-Deploy

Dashboard Viewer

Definition Editor

Import Utility (legacy)

Outlook® Add-in

Outlook Add-in Installer

Report Runner

System Restore/Upgrade

Test LDAP

Server applications

Server Manager

Cherwell Web-Forms™

People

User logging into a license-consuming application

User logging into a second license-consuming application

User logging into a second instance of a licensing-consuming
application

Customer logging into the Portal to view/create/edit their own record
(Requestor/record owner)*

Customer logging into the Portal to view someone else's record (not the
Requestor/record owner but has extended rights to manage another
Customer's records)*
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Item Consumes License

Customer logging into the Portal to edit someone else's record (not the
Requestor/record owner but has extended rights to edit another
Customer's records).

Exceptions: Sometimes, a One-Step Action can edit another
Customer's records without consuming a license (ex: Send an E-mail,
Create a Journal, Rating a Record, etc.).

(with exceptions)

* Some Portal Sites and activities require use of a license. CSM prompts the Customer if a license is
required.
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Troubleshooting Application Server Installations
Using IIS

If you are unable to log in to any CSM Client using an HTTP or HTTPS server connection, follow these
troubleshooting steps.

Verify the Server Installation

1. Open the Cherwell Server Manager, and then select Application Server from the Server list.
a. If the Cherwell Server Manager is started in IIS, Browser application found is shown on the

dialog box.

b. Click Configure.

c. Click the Connection ellipsis icon.
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d. Select a connection, and then click Edit.
e. Step through Connection Wizard by clicking Next. Do not change any options.

f. On the summary page, click Test Connection.
If the connection fails, the issue is with the database connection and not IIS.
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2. Cancel the test connection and close the Connection Wizard.

Verify Port and Security Settings

1. Open the Cherwell Server Manager, and then select Application Server from the Server list.
a. Click Configure.

b. Verify these settings:
◦ Communicate via HTTP option is selected.

◦ Port: Defaults ports are 80 for HTTP or 443 for HTTPS. (HTTPS should be used for all
production environments.)

◦ Security Configuration Mode: Encrypted must selected for environments using
HTTPS.

◦ Sever Certificate: If this field is not auto-populated, click the ellipsis icon to browse and
select the certificate.

2. Click the Connection ellipsis icon.

3. Click Add.

Note: Do not use an existing connection to test, as this can cause issues.

4. Select these options in the Connection Wizard:
a. Connection Type: Select Connect to Cherwell Server.
b. Server Location: Provide the URL to the server being used. For example, http://

cherwell.company.
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c. Connection Name: Provide a name and description.

d. Click Test connection.

If the test connection succeeds, CSM and IIS are configured correctly. You can cancel the test connection.

Verify that Windows Features are Enabled on the IIS Server
Verify that HTTP activation features are enabled for the IIS server that will be used with CSM. See
Configure IIS for CSM.

Verify Application Pool (AppPool) Settings in IIS

1. Open IIS.

2. Expand the Connections tree to verify the CherwellAppServer is listed as a site.

3. Select Application Pools in the Connections Tree.

4. Verify that the CherwellAppServer Identity field is ApplicationPoolIdentity or a domain account.
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Verify Application Pool (AppPool) Settings for the Folder

1. On the IIS server, navigate to Application Server installation directory. The default location is C:
\Program Files (x86)\Cherwell Service Management\Cherwell Application Server.

2. Right-click inside the directory, and then select Properties.

3. Select the Security tab, and then click Edit.
4. On the Permissions tab, click Add, and then click Locations.

5. Select the server name from the Locations dialog.

6. Click OK.
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7. On the Select Users or Groups dialog, type iis AppPool\CherwellAppServer in the Object Names
box, and then click Check Names.

8. Click OK.

9. On the Permissions page, select CherwellAppServer, and then click the Allow check box for all
permissions.
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10. Click OK.

Verify the Application Server Connection Using a URL
In a browser, navigate to this address:

HTTPS://YourServer/CherwellAppServer/Rest.svc

Use HTTPS or HTTP in the URL based on your environment's security protocols.

A web page should open that shows Service. If this does not happen, contact Cherwell Support.

Related concepts
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Default Port Numbers
Configure the Application Server
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Installing CSM from the Command Line
Use command-line options to silently install CSM client, server, and web applications. After installation,
you can configure CSM servers using the Server Manager or Command-Line Configure Utility.

Each section contains commands and examples for running the "silent installer." Variables with spaces
require the quotes be proceeded by a \. Spaces are not required, however.

CSM Client Installation
Use the following command to install CSM clients:

msiexec /i "Cherwell Client.msi" /qn <InstallParametersHere>

The following example installs the Desktop Client and administrator tools (CSM Administrator, Report
Runner, System Upgrade/Restore, and Test LDAP) for all Users:

msiexec /i "Cherwell Client.msi" /qn ALLUSERS=1 INSTALLLEVEL=10

Options Definition Values

ALLUSERS Install Client application files
for all Users or current User.

• 1 = Files are installed for all Users (anyone
who uses the computer). (default)

• 2 = Files are installed for current User.

INSTALLDIR
Location/folder in which to
install the Client application
files.

[ProgramFilesFolder]Cherwell Service
Management (default)

INSTALLLEVEL
Install the CSM Desktop
Client only or both CSM
Desktop and CSM
Administrator.

• 1 = Client component only installed.

• 10 = Client and Administrator components
installed.

CSM Server Installation
During the server installation, the Server Manager and all servers and services are installed and you must
select which to enable by default.

Use the following command to install the Cherwell Server:

"Cherwell Server.exe" /s /v /qn <InstallParametersHere>
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Options Definition Values

INSTALLDIR
Location/folder in which
to install the Server
installation files.

[ProgramFilesFolder]Cherwell Service
Management (default)

Database Options

Note: The Connection Wizard is launched only for 1, 2, or 3.

DATABASETYPE Select the database
components to install.

Cherwell Demo Database = 1 (default)

Cherwell Starter (empty) Database = 2

Upgrade an existing database = 3

Don't load any data = 4

Service Options

SERVERSERVICE Enable the Application
Server.

• 1=Enable (default)

• 0= Disable

BUSINESSPROCSERVICE Enable the Automation
Process microservice.

• 1 = Enable (default)

• 0 = Disable

SCHEDULINGSERVICE Enable the Scheduling
microservice.

• 1 = Enable (default)

• 0 = Disable

EMAILSERVICE
Enable the E-mail and
Event Monitoring
microservice.

• 1 = Enable (default)

• 0 = Disable

Logon Information

IS_NET_API_LOGON_USERNA
ME

Cherwell Server
account username that
will be used to launch
the CSM services. Must
be in the form Domain/
username.

Blank (default), but information is
required.

Format: DOMAIN\Username if the
server is joined by a domain. Example:
Cherwell\Henri.Bryce

IS_NET_API_LOGON_PASSWO
RD

Cherwell Server
account password that
will be used to launch
the CSM services.

Blank (default), but information is
required.
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USE_SP_ACCOUNT
Use special account
(Windows account) to
launch the CSM
services.

• 1 = True

• 0 = False (default)

CWSPECAILACCOUNT
Name of special
account that will be
used to launch the
CSM services.

• LocalSystem (default)

• LocalService

• NetworkService

CWAPPSERVERIIS
Install the Application
Server as a web
application under IIS.

• 2 = True (default)

• 0 = False

CSM Web Applications
Use the following command to install the CSM Web Applications:

"Cherwell Browser Apps.exe" /s /v/qn <InstallParametersHere>

The following example will install to the default directory, will not install the Portal, but will install the Web-
Forms, and will update Auto-Deploy:

"Cherwell Browser Apps.exe" /s /v /qn CWPORTAL=0 CWWEBFORMS=1 CWAUTODEPLOY=
1

Options Definition Values

CWPORTAL Install Cherwell
Portal.

• 1 = Install (default)

• 0 = Do not install

CWBROWSWERCLIENT Install Cherwell
Browser Client.

• 1 = Install (default)

• 0 = Do not install

CWAUTODEPLOY Install Auto-Deploy.
• 1 = Install (default)

• 0 = Do not install
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CWWEBSERVICES Install the Web
Service.

• 1 = Install (default)

• 0 = Do not install

CWWEBFORMS Install Web-Forms.
• 1 = Install

• 0 = Do not install (default)

INSTALL_AUTODEPLOY
Select whether or not
to update the Auto-
Deploy configuration.

• 1 = Update (default)

• 2 = Installs the Auto-Deploy feature silently.
Note: If you install silently, you must
manually configure Auto-Deploy to wrap
and distribute the most current client
installation.

INSTALLDIR
Location/folder in
which to install the
Browser application
files.

[ProgramFilesFolder]Cherwell Browser
Applications (default)

Cherwell Service Monitor
Use the following command to install the Cherwell Service Monitor:

"Cherwell Service Monitor.exe" /s /v /qn <InstallParametersHere> 

The following example installs the Service Monitor for a set of Users who can modify the Server Manager
but sets it as read-only for everyone else:

"Cherwell Service Monitor.exe" /s /v /qn CW_USERSWHOCANALWAYSEDIT="user lis
t" CW_DEFAULTACCESSISREADONLY="1""

The following options are set only through the command line.

• View: Read-only access (example: View service status in the Service Monitor but no edit).

• Edit: Full read/write access (example: View service status AND start/stop/restart services in the
Service Monitor.

Available Settings Definition Default Values
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INSTALLDIR
Location/folder in which to
install the Service Monitor
files.

[ProgramFilesFolder]\Cherwell
Service Management (default)

CW_ISPRODUCTION Type of server to be
monitored.

• True = Production (default)

• False = Non-production

CW_TITLE Title to be displayed on the
Service Monitor web page.

Cherwell Service Monitor
(default)

CW_DEFAULTACCESSISREADONLY

Default access to the
Service Monitor.

This is the default access
for Users who are not
explicitly given access
through the Read/Write
Permissions List.

• 1 = Read-only (default)

• 0 = Access denied.

CW_USERSWHOCANALWAYSEDIT
List of Users who explicitly
can edit the Service Monitor
(full read/write access).

Blank (default), but information
is required.

Comma delimited list of Users.

Format: DOMAIN\Username if
the server is joined by a domain.
Example: Cherwell\Henri.BryceCW_USERSWHOCANNEVEREDIT

List of Users who explicitly
cannot edit the Service
Monitor (access denied).

CW_ANONYMOUSUSERCANVIEW
Non-authenticated Users
can view but not edit (read-
only access).

• True

• False (default)

CW_ANONYMOUSUSERCANEDIT
Non-authenticated Users
can edit the Service Monitor
(full read/write access).

• True

• False (default)

CW_ADMINISTRATORSCANVIEW
Allow Users in the OS-level
Administrator Group to view
but not edit the Service
Monitor (read-only access).

• True

• False (default)

CW_ADMINISTRATORSCANEDIT
Allow Users in the OS-level
Administrator Group to edit
the Service Monitor (full
read/write access).

• True

• False (default)
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Related concepts
Server Installation Options
Web Applications Installation Options
Install the Service Monitor
Command-Line Configuration (CLC) Options
Related reference
Client Installation Options
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Securing Your CSM Environment
When preparing for overall security of your on-premises CSM environment, follow recommendations for
individual CSM components, including the database, the Cherwell® Service Host, and Internet Information
Services (IIS). Also, adhere to recommendations when planning for penetration testing of your CSM
environment.
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Securing the CSM Database
Cherwell® Service Management uses two accounts for database access – an application-level account
and an administrator user account. These two accounts are configured when a 2-tier database connection
is created to control the level of database access given for the application.

Create the following two accounts before you run the scripts in this procedure:

• CSMAdminUser (administrator account)

• CSMUser (application-level user)

The application and administrator accounts control different aspects of CSM.

By configuring each account separately, CSM uses the appropriate security context for advanced
operations that CSM Customer Portal and technician users do not typically perform. These advanced
actions usually occur during Blueprint publishes, system restore, and system upgrade. For a multi-tenant
environment (multiple databases on a single database server), do not share database accounts if access
to these databases is restricted between instances of CSM. Integrated security for connections is not
recommended.

Note: When configuring connection options, do not use a single sa account for both account
values.

To grant the appropriate permissions, run scripts against the target database for the
CSMAdminUser and CSMUser accounts.

1. On the command line, navigate to the target database.
2. Run the following script to grant permission to create tables and perform DDL operations to an

Administrator user named CSMAdminUser.

DEFAULT_DATABASE=[master], DEFAULT_LANGUAGE=[us_english], CHECK_EXPIRAT
ION=OFF, CHECK_POLICY=OFF
GO

GRANT VIEW SERVER STATE TO [CSMAdminUser]
GO

CREATE USER [CSMAdminUser] FOR LOGIN [CSMAdminUser] WITH DEFAULT_SCHEMA
=[dbo]
GO
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EXEC sp_addrolemember N'db_owner', N'CSMAdminUser'
GO

3. Run the following script to grant permission to access table data to an application-level User named
CSMUser.

CREATE USER [CSMUser] FOR LOGIN [CSMUser] WITH DEFAULT_SCHEMA=[dbo]
GO

EXEC sp_addrolemember N'db_datareader', N'CSMUser'
GO

EXEC sp_addrolemember N'db_datawriter', N'CSMUser'
GO

Related concepts
Using Databases with CSM
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Securing the Cherwell Service Host
Assign network service-level security access and permissions on the Cherwell® Service Host to support
its microservices Automation Process Service and Scheduling Service.

For back-end processes that run One-Step™ Actions, you should only allow permissions that are required
for performing the Actions. Allowing for more advanced permissions is not recommended.
To configure security:

1. Start the Windows Services Manager, and locate the Cherwell Service Host.
2. Right-click the Cherwell Service Host and select Properties.
3. Select the Log On tab.
4. Select the This account option, and then select the Browse button.
5. In the Select User window, type Network Service in the Enter the object name to select field,

and then select Check Names to resolve the name.

Note: Network Service is the recommended account for all Cherwell services. Do not use
Local Service.

6. Select OK.
7. Select Apply to save your updates, and then select OK to close the Properties window.

Related concepts
About the Cherwell Service Host
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Securing IIS
Internet Information Services (IIS) uses application pools to coordinate the identity of the website that is
running on the server.

For Cherwell® applications, only one application pool is allowed per virtual directory. Application pools
cannot be shared across virtual directories.

To confirm your IIS configuration:

1. To verify how an IIS application pool is used for Cherwell applications, open the Windows IIS
Manager and view the connection information.

2. To check if a virtual directory has a specific application pool assigned, right-click the virtual directory,
select Manage Application > Advanced Settings, and view the Application Pool value. Close the
window.

3. To verify the identity of the application pool, right-click the name of the application pool in the
Connections pane, and select Advanced Settings. If configured, ApplicationPoolIdentity is listed
as the identity of the application pool. The ApplicationPoolIdentity identity is recommended for
Cherwell applications running under IIS.

4. To assign a direct permission to the application pool identity, still in the IIS Manager, right-click the
site folder, and then navigate to Edit Permissions > Security > Edit > Add. Search for the local
application pool (example: IIS AppPool\CherwellClient). Select the Check Names button to resolve
the name.

5. Use the following information as a reference for assigning security permissions for the CSM Browser
Client:

◦ Cherwell Application Server
◦ Log to file directory: Create, Read, and Write/Modify
◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Create, Read, and Write/

Modify
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Read
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Not applicable
◦ Browser Client

◦ Log to file directory: Create, Read, and Write/Modify
◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Not applicable
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Read
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Not applicable
◦ CSM Portal

◦ Log to file directory: Create, Read, and Write/Modify
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◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Not applicable
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Read
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Create, Read, and Write/Modify
◦ Cherwell REST API

◦ Log to file directory: Create, Read, and Write/Modify
◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Not applicable
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Read
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Not applicable
◦ Cherwell Service

◦ Log to file directory: Create, Read, and Write/Modify
◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Not applicable
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Read
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Not applicable
◦ Cherwell Auto-Deploy

◦ Log to file directory: Not applicable
◦ C:\ProgramData\Trebuchet\Trebuchet.AppServerRecovery.dat: Not applicable
◦ HKLM\SOFTWARE\Trebuchet\ServerSetup Access: Not applicable
◦ General file access: Not applicable
◦ Right to act as service: Not applicable
◦ Permissions to [Programx86]\Cherwell Browser Applications\Portal\dist\Bundles\Portal

\css: Not applicable
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Securing CSM Applications
Security configuration recommendations for on-premise CSM installations are provided for the Cherwell
Application Server, CSM Web Applications, and CSM Administrator.

Recommendations for Cherwell Application Server

• Install the Cherwell Application Server with Internet Information Services (IIS) with the Cherwell
REST API enabled.

• Configure Secure Sockets Layer (SSL) using a Trusted Agent.

• Change the default password for the CSDAdmin account.

• Configure database security with separate database accounts for the 2-tier connection.

Recommendations for CSM Web Applications

• Configure SSL using a Trusted Agent.

• Set the RedirectHttptoHttps appSetting element in the web.config file to true.

Recommendations for CSM Administrator

Note: Recommendations for CSM Administrator apply to both on-premise and SaaS
environments.

• Adhere to Open Web Application Security Project (OWASP) best practices for attachments
(Security > Attachments) and password complexity (Security > Cherwell Credentials).

• Validate Windows security accounts (navigate to Security > Desktop and then select Validate
Windows/LDAP credentials on Server).

• Disable client auto-login (navigate to Security > Desktop, and then clear the Allow users to have
system remember last password option).

• Set URLs for CSM Web Applications to use HTTPS (Browser Settings > Portal and Browser
Client URLs).

• Disable iFrame embedding (navigate to Browser Settings and select Do not allow browser
applications to be embedded within iFrame).

• Disable detailed error messages (navigate to Browser Settings and select Do not send detailed
error information to client).

• Disable linked attachments (navigate to Browser Settings and select Disable linked attachments
in the browser applications).

• Disable password auto-complete on the login page (navigate to Browser Settings and select
Disable password auto-complete on login page).
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• Disable RSS Anonymous feeds from Cherwell Service (navigate to Browser Settings and clear
Enable Anonymous RSS Feeds from Cherwell Service).
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Security
CSM security is powerful, granular, and set in layers to secure people, functionality, data, environment,
and sharing.
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About Security
CSM provides a default security design (complete with Security Groups, Roles, Teams/Workgroups, and
system security settings). You can implement the default design (and just add users and customers,
assigning them to other default Security Groups, Roles, and Team/Workgroups), edit it, or create a new
security design.

Note: Security is configured and managed in CSM Administrator, typically by a system
administrator.

Security components include:

• Security Group: A collection of CSM security rights that controls access to CSM functionality and
data (Business Objects/fields).

• Role: A user or customer's current function/responsibility in CSM, and controls how data is
presented in that person's CSM environment.

• User: A service desk professional who logs in and uses CSM to manage service desk data
(example: A technician, manager, designer, system administrator, etc.).

• Team: A collection of CSM users that can share CSM items (such as Dashboards), record
ownership, and assignments.

• Customer: An end user, either an internal employee or an external individual, who relies on CSM to
initiate/fulfill a Service or Product (example: A person reporting a lost password or requesting a new
phone).

• Customer Workgroup: A collection of CSM customers who can share CSM items (such as
Dashboards).
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Related concepts
About Security Groups
About Roles
About Users
About Teams and Workgroups
About Customers

106

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fabout_security_groups.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fabout_roles.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fabout_users.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fabout_teams_and_workgroups.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fabout_customers.html


Security Rights
Security rights control access to CSM functionality and data.

For example, to create a Dashboard, you must have security rights to access the Dashboard Manager
(functionality). To view, add, edit, or delete the Description Field in an Incident record, you must have
security rights to access the Incident Business Object and the Description field (data).

For a detailed explanation of each Security right, see Security Rights Reference.

Security rights are set at the Security Group level in CSM Administrator using the Rights and Business
Object tabs (Security > security groups > Edit.

• Use the Rights tab to configure access to functionality; specifically View, Add, Edit, Delete, Allow,
Run, and Open rights.

• Use the Business Objects tab to configure access to Business Object/Field data; specifically View,
Add, Edit, Delete, Limit, Edit in final state, and Change final state. Business Objects rights can be
set for different types of Business Object Owners (example: Record Owner, Manager of Owner).

Each Security Group has a defined set of security rights (access to functionality and data). Each user or
customer is assigned to one and only one Security Group. The user or customer then inherits the security
rights of that Security Group.

Related concepts
Security Rights Reference
About Security Groups
Related tasks
Define Functionality Security Rights (Access to Functionality)
Related information
Define Business Object Rights (Access to Data)
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Security Considerations
When designing a security strategy, consider security rights, licenses, users and customers, record
ownership, and scope.

Like everything in CSM, access to Security functionality is controlled through security rights (that is, you
need security rights to manage security rights). If you cannot View, Add, Edit, or Delete Security
functionality, check your security functionality rights in CSM Administrator (Security > Edit Security
Groups > security group > Rights > security group.

License consumption varies depending on the product, who logs in (user or customer), and which tasks
each person performs. Consider your licensing needs when setting up security (especially when
considering record ownership rights and reserving licenses).

Users (service desk professionals working in CSM) and customers (end users using the CSM Portal to
conduct self-service activities) perform different functions in CSM and, therefore, require different security.
Users require access to functionality and data based on their Role as workers in the CSM system.
Customers require access to functionality and data based on their Role as initiators of a Service or
Product. To facilitate this, CSM provides User and Customer Security Groups.

Different record ownership rights can be set to extend/deny access to users and customers, managers,
departments, Teams/Workgroups, and Team/Workgroup managers. Be sure to consider the implications
of Relationships and setting different rights based on ownership.

Scope is the intended audience for a CSM item (example: the Dashboard is intended for everyone on a
specific Team). CSM scopes include User, Role, Team, Global, System, Blueprint, and Site. When
creating CSM Items and defining default settings, be sure to consider how scope affects access.

Related concepts
Security Rights
Related information
License Consumption
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Differences Between Users and Customers
Users and customers perform different functions in CSM and, therefore, require different security.

A user is a service desk professional who logs in and uses CSM to manage service desk data (example:
A technician, manager, designer, system administrator, etc.). A user is assigned to only one Security
Group (so they can access specific functionality and data), can log in using one or more Roles (so they
can have a personal viewing environment), and can belong to one or more Teams (so they can share
CSM items, such as Dashboards).

A customer is an end user, either an internal employee or an external individual, who relies on CSM to
initiate/fulfill a Service or Product (example: A person reporting a lost password or requesting a new
phone). If configured, a customer can access CSM data and perform self-service activities using the CSM
Portal. A customer is assigned to one, and only one, Security Group (so they can access specific
functionality and data) can log in using their default Role (so they can have a personal Customer View)
and can belong to one or more Workgroups (so they can share CSM items, such as Dashboards).

Often, a user functions as both a user and a customer in CSM. For example, a Service Desk Technician
performs user functions but is a customer of the HR Department. If the user is also a customer, they must
have a Customer Profile, as well as a User profile.

Users and customers operate very differently in CSM. Below are some of the differences:

Difference User Customer

Profile
information
(personal
information,
security
information,
credentials,
etc.)

Information is stored in the User
Profile in CSM Administrator
(Security > Edit users. Personal
user information is a subset of the
User Profile, is configurable, and is
stored in the User Info Business
Object (called User Info in the Starter
database).

Customer information is stored in the
Customer Record. The Customer Record is
configurable and is stored in the Customer
Business Object (called Customer - Internal
in the Starter database).

Licensing
Users consume a license when
logging in to CSM (Desktop Client or
Browser Client).

A customer logging in to CSM through the
CSM Portal to access her own records (she
is the customer owner) typically does NOT
consume one of the concurrent licenses.

A customer logging in to CSM through the
CSM Portal to access someone else's
records (she is NOT the customer owner but
has been granted access rights), DOES
consume a license.

Security group Assigned to a User Security Group. Assigned to a Customer Security Group.
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Team Member of a Team. Member of a Customer Workgroup.

Ownership

A record usually has a user owner.
Record access rights can be
extended to the user's manager and
department.

A record might have a customer owner.
Access rights can be extended to the
customer's manager and department.

Web
Applications

Accesses the Browser Client through
a browser. Accesses the CSM Portal through a browser.

Related concepts
User and Customer Security Groups
About Teams and Workgroups
Record Ownership
Related information
License Consumption
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Record Ownership
Record ownership is an important concept in CSM because it affects security and licensing.

It affects security because ownership controls who has particular rights to a record, and it affects licensing
because non-owners typically require a license to edit a record via the CSM Portal. Moreover, it differs
depending on whether the record owner is a user or a customer.

The following people can be record owners:

• Primary User: A record is usually owned by a single user.

• Customer: A record might also be owned by a customer if the customer is the requestor (is assigned
to the record) and has rights.

• Team: A record might also be owned by a Team it if it is explicitly assigned to the Team.

• Customer Workgroup: A record might also be owned by a Workgroup it if it is explicitly assigned to
the Workgroup.

Record ownership rights can be extended to the following people:

• Department Member: Any person assigned to the same department as the record owner. Typically,
this is just for a user.

• Manager of owner: Person designated as the manager of the record owner. This is for a user or
customer.

• Team/Workgroup Member: Any member of the Team/Workgroup owning the record.

• Team/Workgroup Manager: Person designated as the manager of the Team/Workgroup owning the
record.
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Set Record Ownership
To set record ownership in a new or existing Blueprint, activate ownership tracking for a Business Object,
set the record ownership Holds property, and set the Business Object rights based on the ownership.

1. To open the Business Object Properties window:
a. In the CSM Administrator main window, select the Blueprints category, and then select the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

b. In the Object Manager, select (New Object) in the Object tree, and then select the New
Business Object task from the Structure area.

Note: If working on an existing Business Object, open the Business Object Editor for
that Business Object, and then select the Bus Ob Properties button.

2. To open the Business Object Editor:
a. In the CSM Administrator main window, select the Blueprints category, and then select the

Create a New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its main pane. The Object
Manager lists the existing Business Objects.

b. In the Object Manager, select a Business Object in the Object tree, and then select the Edit
Business Object task in the Structure area (or double-click a Business Object in the Object
tree).

Tip: You can also select the Edit Business Object button on the Blueprint Editor
Toolbar to open the Business Object Editor.

3. To activate ownership tracking for a Business Object:
a. Select the Track owner check box to track Business Object ownership by user.
b. Select the Track team owner check box to track Business Object ownership by Team.

CAUTION: Clearing either check box deletes the Owned by and Owned by ID Fields
for the Track owner selection, and the Owned by Team and Owned by Team ID
Fields for the Track team owner selection. Users are prompted to continue upon
clearing the check boxes.

4. Set the Record Ownership Holds property.

Tip: To simplify your setup, CSM set the ownership property on some standard Fields in
your Starter database.
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5. Set Business Object rights based on ownership. Business Object rights are set at the Business
Object level in a Security Group in CSM Administrator (Security > Edit security group > User/
Customer Security Group > Business Objects > Business Object. Rights are typically View,
Add, Edit, and Delete. Rights can be set for all owners/extended owners, or they can be set
differently for record owner, department member, manager of owner, Team/Workgroup member, and
Team/Workgroup manager.

Related concepts
Open an Existing Blueprint
Blueprint Editor
Blueprint Editor Toolbar
Related tasks
Create a Blueprint
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Record Ownership Holds Property
Record ownership is identified by the Holds property on a Field. The Hold property identifies that a person
listed in a Field is the record owner.

The property value tells CSM the type of owner (User, Customer, Team, Workgroup, Department, or
Manager). For example, in the Starter database, the Owner ID Holds value is set on the Owner ID Field
and tells CSM that the person listed in that Field is the official user record owner.

Because many ID Fields (example: Owner ID) work in tandem with and are populated by more user
friendly Fields (example: Owner ID works with Owner Name), a second Holds property should be set on
the exposed Field. In the example above, Owner Name is also set on the Owned By Field to tell CSM
that April Hawkins is the display name of the official User record owner.

Set an ownership value in the Holds drop-down list on the Field's General tab.

Record Ownership Value Considerations

• Most record ownership values are tied to a record type and are set on the Fields in a Business
Object (example: They are set in the Incident Business Object).

• Department and Manager are tied to a person and are set on the Fields in the User Info and
Customer Business Objects.

• To simplify your setup, CSM provides the record ownership property on some standard Fields in the
Starter database. It is assumed that certain Relationships are based on CSM's User Profile and
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Customer Record. For example, we assumed that the record owner manager is the manager listed
on the User Profile in CSM Administrator (Security > Edit users). Because CSM is highly
configurable, your system might vary.

• CSM does not set any Workgroup ownership attributes. They must be configured Workgroup
attributes.

Record Ownership Values
CSM uses the following values to identify record owners and extended owners. If the value typically works
in tandem with another value, it is listed as well.

Record Owner Values

Holds Value Description

Owner ID

Owner name

Identifies User record owner.

Note: Typically, the Owned By ID and
Owned By Fields hold the ownership
values.

Requester ID

Requester name

Identifies Customer record owner.

Note: Typically, the Requested By ID and
Requested By Fields hold the ownership
values.

Team ID

Team name

Identifies Team record owner.

Note: Typically, the Owned By Team ID
and Owned By Team Fields hold the
ownership values.

Customer Workgroup ID

Customer Workgroup name

Identifies Workgroup record owner.

Note: Typically, the Owned By Workgroup
ID and Owned By Workgroup Fields hold
the ownership values. Currently, these
Fields are not part of the Starter database,
but you can add them manually,

Extended Record Owner

115

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Holds Value Description

Department

Identifies any person assigned to the same
department as the record owner.

Note: Typically, the Department Field holds
the ownership value (example: in User Info
and Customer-Internal). Unlike the other
specialized Fields, the Department Field
holds the name of the department, not an ID
identifying the department.

Manager ID

Manager name

Identifies the person designated as the manager of
the record owner. Remember, a record owner can be
a user and/or customer, and a Team and/or
Workgroup.

Note: Typically, the Manager ID and
Manager Fields hold the ownership value
(example: in User Info and Customer-
Internal).

Record Ownership Values Matrices
The following tables list the record ownership values by owner type.

User Record Owner

Record Owner Description Holds Value Example Business
Obect.Fields

Record owner (User) Identifies the User who
owns the record.

Owner name

Owner ID

Incident.Owned By

Incident.Owner ID

Manager
Identifies the manager of
the User who owns the
record.

Manager name

Manager ID

User Info.Manager

User Info.Manager ID

Department Identifies the User owner's
department. Department

User Info.Department

Customer-
Internal.Department

Team Owner Record

116

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Record Owner Description Holds Value Example Business
Object.Fields

Team owner Identifies the Team who
owns the record.

Team name

Team ID

Incident.Owned By Team

Incident.Owner Team ID

Team owner manager
Identifies the manager (or
managers) of the Team
who owns the record.

Not applicable. Team
owner manager is
assumed to be the
manager (or managers)
selected on the Team
Profile.

Not applicable.

Custom Record Owner

Record Owner Description Holds Value Example Business
Object.Fields

Record owner (Customer/
requester)

Identifies the Customer
who owns the record.

Requester name

Requester ID

Change
Request.Requested By

Change
Request.Requested By ID

Manager
Identifies the manager of
the Customer who owns
the record.

Manager name

Manager ID

Customer-Internal.Manager

Customer-Internal.Manager
ID

Department Identifies the Customer
owner's department. Department Customer-

Internal.Department Field

Workgroup Record Owner

Record Owner Description Holds Value Example Business
Object.Fields

Workgroup owner
Identifies the Customer
Workgroup who owns the
record.

Customer Workgroup
name

Customer Workgroup ID

Change Request.Owned
By Workgroup

Change Request.Owner
Workgroup ID

Workgroup owner
manager

Identifies the manager (or
managers) of the
Customer Workgroup who
owns the record.

Not applicable.
Workgroup owner
manager is assumed to
be the manager (or
managers) selected on
the Workgroup Profile.

Not applicable.

Related tasks
Set a Record Ownership Holds Property Example
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Set a Record Ownership Holds Property
Set the record ownership Holds property. To simplify your setup, CSM set the ownership property on
some standard Fields in your Starter database.

1. Open the Business Object that contains the Field you want to tag as an ownership Field:
a. In a Blueprint, select the Business Object.
b. Select Edit business object.

2. Set the property on the Ownership field:
a. Double-click the icon in front of the Field.
b. Select the General page.
c. In the Holds drop-down list, select a record ownership value.
d. Select OK.
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Set a Record Ownership Holds Property Example
In this example, you want a Customer Workgroup to have ownership rights to a Change Request. You
need to add the Workgroup ID and Workgroup Name attributes to a Field on your Change Request form.

Because the Change Request Business Object does not have any appropriate Fields to house the
attributes, you need to add two new Fields (Workgroup ID and Owned By Workgroup) to the Form.

To set a record ownership Holds property:

1. Open the Object Manager.
2. Select Change Request, and then select Edit business object.
3. Add a Field named Owned By Workgroup:

a. Name: Owned By Workgroup
b. Type: Text
c. Length (of text): 30

4. Define Field properties:
a. Select the Field Properties button.
b. On the General page, in the Holds drop-down list, select the Customer Workgroup name

ownership attribute. This selection tells CSM that the Workgroup in this Field is a record
owner.

c. On the the Validation/Auto-populate page, select the Other validation types check box to
expand the section.

d. Select the Valid Team or Workgroup radio button, and then select All customer
workgroups. This selection tells the Field to list all the valid Customer Workgroups.

e. Define additional Field properties as necessary: Full-Text Search, default values, etc.
f. Select OK.

5. Add a Field named Owner Workgroup ID:
a. Name: Owner Workgroup ID
b. Type: Text
c. Length (of text): 42

6. Define Field properties:
a. Select the Field Properties button.
b. On the General page, in the Holds drop-down list, select the Customer Workgroup ID

ownership attribute. This selection tells CSM that the Workgroup in this Field is a record
owner.

c. On the Validation/Auto-populate page, select the Auto-populate check box to expand the
section.

d. In the Populate when there is a change in table: [ITEM] field drop-down list, select Owned
By Workgroup.

e. Select the Customer workgroup ID radio button.
f. Define additional Field properties as necessary: Full-Text Search, default values, etc.

g. Select OK.
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7. Add the Owned By Workgroup field to the Form.
8. Publish the Blueprint to commit the changes (File > Publish Blueprint).
9. In the Customer Security Group, set the different ownership rights for the Change Request Business

Object.

Related concepts
Record Ownership Holds Property
Publish a Blueprint
Set Different Business Object Rights Based on Ownership
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Scope
Scope is the intended audience for a CSM Item (example: A Dashboard is intended for everyone on a
specific Team).

CSM uses the following Out of the Box (OOTB) scopes:

• User: Audience is a specific User/Customer (example: User can access his Dashboards).

• Role: Audience is every member assigned to a Role (example: Every User/Customer logging in
through the Role can access that Role's Dashboards).

• Team: Audience is every User on a Team, or every Customer in a Workgroup (example: Every
User/Customer assigned to a specific Team/Workgroup can access that Team/Workgroup's
Dashboards).

• Global: Audience is all Users/Customers who can log in to CSM (example: All CSM Users/
Customers can access Global Dashboards).

• System: Audience is the CSM system itself. Any User/Customer who can log in to CSM can use a
system item; however, editing is available only in CSM Administrator, typically by a system
administrator. A Document Repository is an example of a System item.

• Blueprint: Audience is any User/Customer who can log in to CSM; however, use is typically
automated and editing is available only in a Blueprint, typically by a system administrator. A One-
Step™ Action that runs when a User clicks a button on a form is an example of an item in a
Blueprint scope.

• Site: Audience is a Portal Customer (example: Dashboard is available only on a specific Portal
Site). Site-only items must be created within the Site Manager (Site Manager>Menu).

Note: If you want items to be widely available, do not limit them to a Site scope; rather store
the items with the other CSM items in their perspective Managers.

Note: CSM Browser Clients support limited functionality so some CSM items and operations
are not applicable in the Portal and/or Browser Client.

When setting security rights for CSM items for security groups (example: Administrator, Service Desk
Technician, Manager, etc.), access to functionality can be limited by scope. For example, an Anonymous
Browser (not logged-in Portal Customer) might not be able to see a Calendar that a logged-in Customer
has access to.

Note: When creating CSM Items and defining default settings, be sure to consider how scope
affects access.

Scopes are used by most CSM items (Calendars, Dashboards, Attachments, One-Step Actions, etc.) to
apply a range of use. As a result, most CSM Managers organize their items at the root level in the
Manager tree by scope.
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OOTB Security Design
CSM provides an OOTB security design to get new systems started. This design has all the Security
Groups, Roles, and Teams/Workgroups to successfully access CSM features and CSM data. We
recommend implementing this OOTB design and adding Users and Customers by creating User and
Customer Profiles. Later, edit the security design or create a new security design to meet specific
organizational needs.

Note: Use the User/Customer Worksheet to determine to which Security Group and Teams/
Workgroups each User/Customer is assigned.

Below is a high-level summary of the OOTB security design. For a detailed design spreadsheet, refer to
the CSM OOTB Security Design Spreadsheet (posted to our Support Portal).

Security Groups

Administrator Service Desk
Manager

Service Desk
Level 1, 2, or 3

Portal
Workgroup
Manager

Portal
Customer

Roles

Service Desk
Technician

Service Desk
Manager

Service Desk
Manager Portal End-User Portal End-User Portal End-User

Typical Rights

• Viewer: Access to data (General Customer, Executives, etc.).

• Service desk: Access to record logging.

• Design: Access to design functionality (example: Can create, edit, or delete Dashboards).

• Administrator: Access to administrative functions and tools (example: Security and
settings).

Functionality

View, Add, Edit,
Delete, Allow,
Run, Open

Full
Most service desk,
some design, some
administrator.

Some service
desk, limited
design, no
administrator.

Limited service
desk, no design,
no administrator.

Very limited
service desk, no
design, no
administrator.

Data

View, Add, Edit,
Delete, Allow,
Run, Open

Full Most Some Limited Very limited
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Security Scenario
Below is an example security scenario. Remember that CSM is highly configurable, so individual Users/
Customers, Security Groups, Roles, and Teams/Workgroups will vary.

Andrew, Gina, Sawyer, Tracy, and John work at the River T Corp. organization:

• Andrew is a System Administrator and is assigned to the Admin User Security Group. As a
member of this group, Andrew has security rights to access all data and functionality in the system.
This means Andrew has Allow, Run, View, Add, Edit, and Delete rights for all CSM Administrator
functionality (security, Blueprints, e-mail setup, etc.), CSM functionality (Dashboards, One-Step
Actions, etc.), and Business Object data (Incidents, Problems, etc.). In short, Andrew is a superuser
and has rights to do just about anything in CSM. Because Service Desk and Service Desk Manager
are legal Roles for the Admin Security Group, Andrew can log in using either of those Roles, and
therefore has access to different environments (Dashboards, Forms, etc.).

Andrew is also a member of two User Teams (2nd Level Support and Knowledge Management),
and can therefore share CSM Items (example: Dashboards), support processes (Queues and
Knowledge Article publishing/approvals), and record ownership (if configured) with the other
members of those Teams. Andrew can use either the Desktop Client to access data or the Browser
Client to log in via his web browser.

Note: Andrew can also function as a Customer to other parts of the organization (example:
HR). As a Customer, Andrew is a member of the Portal Customer Security Group and the
Information Technology Customer Workgroup. See below for more details about Customers.

• Gina is the Service Desk Manager and is assigned to the Service Desk Manager User Security
Group. As a member of this Security Group, Gina has security rights to Allow, View, Add, Edit, and
Delete most data in the system (Incidents, Problems, etc.) but has limited security rights to
functionality (example: Gina can View, Add, Edit, and Delete Team and User Dashboards but cannot
edit system security). Because Service Desk Manager is the only legal Role for the Service Desk
Manager Security Group, Gina can log in using only that Role. Her default environment
(Dashboards, Forms, etc.) is appropriate for her managerial Role.

Gina is also a member of two User Teams (CAB and IT Management) and can therefore share CSM
Items (example: Dashboards), support processes (example: Queues), and record ownership (if
configured) with the other members of that Team. Gina can use either the Desktop Client to access
data or the Browser Client to log in via her web browser.

Note: Gina can also function as a Customer to other parts of the organization (example:
HR). As a Customer, Gina is a member of the Portal Workgroup Manager Security Group
and the Information Technology Customer Workgroup. See below for more details about
Customers.

• Sawyer is a Service Desk Worker who reports to Gina and is assigned to the Service Desk User
Security Group. As a member of this Security Group, Sawyer has limited security rights to both data
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and functionality. For example, Sawyer can View but cannot Add, Edit, or Delete Team Dashboards;
Sawyer can, however, View, Add, Edit, and Delete User Dashboards. Because Service Desk is the
only legal Role for the Service Desk Security Group, Sawyer can log in using only that Role. His
default environment (Dashboards, Forms, etc.) is appropriate for his troubleshooting Role.

Sawyer is also a member of the 1st Level Support User Team and can therefore share CSM Items
(example: Dashboards), support processes (example: Queues), and record ownership (if
configured) with other members of that Team. Sawyer can use either the Desktop Client to access
data or the Browser Client to log in via his web browser.

Note: Sawyer can also function as a Customer to other parts of the organization (example:
HR). As a Customer, Sawyer is a member of the Portal Customer Security Group and the
Information Technology Customer Workgroup. See below for more details about Customers.

• Tracy is a Shipping Specialist and a Customer, meaning she is an employee but not a licensed
CSM User. Tracy is a Customer who uses the CSM Customer Portal to find company information
and log Incidents for a service or product (example: She can log an Incident that her printer is not
working). Tracy logs in to the Customer Portal using her default assigned Portal Customer Security
Group, which has very limited security rights. Tracy can view and edit her own records (example:
Incidents) but has very limited access to functionality.

Tracy is a member of the Shipping Customer Workgroup and can therefore share CSM Items and
record ownership (if configured) with other members of that Workgroup.

• John is the Production Manager and a Customer Manager, meaning he is an employee but not
a licensed CSM User. John is Tracy's manager and also a Customer. John can log in to the
Customer Portal to log Incidents using his default assigned Portal Workgroup Manager Security
Group, which has very limited security rights. Like most Customers, John can view and edit his own
records (example: Incidents) but has very little access to functionality; however, unlike Tracy, John is
a manager, so he has extended rights to view and edit Tracy's records, as well.

John is also a member of the Shipping Customer Workgroup and can therefore share CSM Items
and record ownership (if configured) with other members of that Workgroup.

The following table provides a nice visual to see how the layers trickle down the security rights.
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Person/
Security
Needs

Security
Group Functionality Rights

Business
Object
Rights

Roles Team/Workgroup

Andrew

System
Administrator

 

Admin

Full security rights for
all.

Example: Allow, Run,
View, Add, Edit, and
Delete for all CSM
Administrator
functionality (security,
Blueprints, e-mail
setup, etc.) and all
Cherwell Service
Management
functions (Calendars,
Dashboards, One-
Step Actions, etc.).

Full security
rights for all.

Example:
View, Add,
Edit, and
Delete
Incident.

Service
Desk

Service
Desk
Manager

 

Teams:

• 2nd Level
Support
Knowledge
Management

 

Gina

Service Desk
Manager

Service
Desk
Supervisor

No security rights for
system administrator
functionality, nearly
full security rights for
CSM functionality.

Example: View, Add,
Edit, and Delete
Team Dashboards
but does not have
security rights to
access system
security.

Full security
rights for all.

Example:
View, Add,
Edit, and
Delete
Incidents.

Service
Desk
Manager

Teams:

• CAB

• IT
Management

Sawyer

Service Desk
worker

Service
Desk

No security rights for
system administrator
functionality, limited
security rights for
CSM functionality.

Example: View Team
Dashboards but
cannot Add, Edit, or
Delete. View, Add,
Edit, and Delete User
Dashboards.

Limited
security rights
for some.

Example:
View and Add
Incidents but
cannot Edit or
Delete.

Service
Desk

Team:

• 1st Level
Support
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Person/
Security
Needs

Security
Group Functionality Rights

Business
Object
Rights

Roles Team/Workgroup

Tracy

Customer
(employee but
not a licensed
Cherwell User;
she logs
service
requests as a
Customer)

Portal
Customer

No security rights for
system administrator
functionality, very
limited security rights
for CSM functionality.

Example: View
Dashboards but
cannot Add, Edit, or
Delete.

 

Limited
security rights
to most.

Example:
View and Edit
her own
Incidents but
cannot
Delete.

 

Portal
End-User

Workgroup:

• Shipping

John

Customer
Manager
(employee but
not a licensed
Cherwell User;
he logs service
requests as a
Customer)

Portal
Workgroup
Manager

No security rights for
system administrator
functionality, very
limited security rights
for CSM functionality.

Example: View Team
Dashboards but
cannot Add, Edit, or
Delete.

Limited
security rights
to most.

Example:
View and Edit
his own
Incidents, as
well as
Tracy's
Incidents.

Portal
End-User

Workgroup:

• Shipping
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About Security Groups
A Security Group is a collection of CSM security rights that controls access to CSM functionality and data
(Business Objects/fields).

You can use Security Groups to implement different levels of security. Each user or customer is assigned
to only one Security Group. The user or customer then inherits the security rights of that Security Group,
as well as access to the Roles assigned to the Security Group.

CSM provides several Security Groups. The following are examples of Security Groups:

• Administrator Security Group: Might have full rights to all CSM functionality and data (view, add,
edit, and delete).

• Service Desk Manager: Might have limited rights to CSM functionality and data (view, add, edit, but
not delete).

• Service Desk Worker: Might have very limited to limited rights to CSM functionality and data (view
or edit only) depending upon Service Desk level (not required).

• Customer (via the Customer Portal): Might have no rights to CSM functionality and limited rights
(view only) to CSM data.

Note: To accommodate the differences between Users and Customers, CSM provides two
kinds of Security Groups: User and Customer Security Groups.

Security Group properties include:

• Info: Name and description

• Rights: Security rights to access CSM functionality

• Business Objects: Security rights to access CSM data (example: Business Objects/Fields)

• File Attachments: Attachment security rights (example: Import/link and global overrides)

• Roles: Roles assigned to the Security Group

• Users: Users assigned to the Security Group

Note: The Users tab only displays for User Security Groups. Customers are assigned as
part of their Customer Profile, and only if they require Portal login credentials.

Related concepts
Differences Between Users and Customers
User and Customer Security Groups
OOTB Security Groups
Create a Security Group
Users Security Rights
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OOTB Security Groups
CSM provides the following OOTB Security Groups:

• Admin: Used for CSM System Administrators. Typically, these Users can delete groups of records
and administer the system.

• Anonymous Browser: Used for CSM Users/Customers who need to access CSM Browser and
Mobile Applications without logging in.

• IT Service Desk Level 1: Used for CSM Service Desk Technicians. Typically, these Users can add/
edit/delete items in their User Folders but cannot modify records in their final state, delete records,
or administer the system.

• IT Service Desk Level 2 & 3: Used for CSM Service Desk Technicians. Typically, these Users can
add/edit/delete items in their User Folders but cannot modify records in their final state, delete
records, or administer the system.

• IT Service Desk Manager: Used for CSM Service Desk Managers. Typically, these Cherwell Users
can add/edit/delete items in their Team's Folder and in their User Folders but cannot modify records
in their final state, delete groups of records, or administer the system.

• Portal Customer: Used for Customers accessing CSM via the Portal. Typically, these Customers
have rights to view and edit their own records.

• Portal Workgroup Manager: Used for Customers accessing CSM via the Portal who manage
teams in their organizations. Typically, these Customers have rights to view and edit their own
records, as well as the ability to view and edit their Workgroup members' records.

Use these OOTB Security Groups as-is, edit them, or create new Security Groups using the Security
Group Manager in CSM Administrator.
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User and Customer Security Groups
Users (Service Desk professionals working in CSM) and Customers (End-Users using the CSM Portal to
conduct self-service activities) perform different functions in CSM and, therefore, require different security.
Users require access to functionality and data based on their Role as workers in the CSM system.
Customers require access to functionality and data based on their Role as initiators of a Service or
Product. To facilitate this, CSM provides User and Customer Security Groups.

Note: CSM provides several OOTB Security Groups, both User (Admin, IT Service Desk, IT
Service Desk Manager) and Customer (Portal Customer and Manager). You can use these OOTB
Security Groups as-is, edit them, or create your own using the Security Group Manager.

When creating a Security Group (CSM Administrator>Security>Edit Security Groups), select one of the
following:

• New Cherwell User Security Group.

• New Customer Security Group.

User Security Groups have a Users tab to assign Users to the Security Group. Customer Security Groups
do not have a Users tab.

A Customer is assigned to a Customer Security Group when you create Customer login credentials
(CSM>Customer>Portal Settings>Current Customer Credentials or Batch Customer Credentials).
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Note: For more information about the differences between Users and Customers, refer to
Differences Between Users and Customers in the Security documentation.
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Anonymous Security Group
The Anonymous Security Group (OOTB: Anonymous Browser) is required for CSM Web Applications to
read basic setup information from the system. The Anonymous Security Group can also be configured to
allow Users/Customers in the group to view (or not view) the CSM Portal and a variety of items on the
CSM Portal, including Business Objects, Form Controls, Dashboards, Widgets, and Actions.

OOTB Anonymous Security Group
The CSM Starter Database provides an OOTB Security Group named Anonymous Browser.

Initial Configuration for Anonymous Access
The following initial configurations must be set for the Anonymous features to work:

• Security Settings: Configure Anonymous Login Settings for CSM Web Applications. This is
required for CSM Web Applications to read basic setup information from the system.

• Site Settings: Configure the Site to Allow Anonymous Access.

Enable Searching Rights for Anonymous access
Users in the Anonymous Security Group can be enabled for specific Searching Rights in the CSM Portal.

• Enable Anonymous Searching Rights

Enable specific Business Objects for Anonymous access
Users in the Anonymous Security Group can be enabled to view specific Business Objects in the CSM
Portal. Any Business Objects associated with Form Controls, Dashboards, Widgets, and Actions enabled
for Anonymous access will also need to be enabled for Anonymous access.

• Enable Anonymous View of a Specific Business Object
◦ Examples

◦ Knowledge Articles

◦ Service Catalog

◦ Anonymous Users can execute a direct link (also known as deep link) to Business Objects that
have been configured for anonymous access.

Enable a Dashboard for Anonymous View
Users in the Anonymous Security Group can be enabled to view specific Dashboards in the CSM Portal.
When not configured, the Anonymous User is prompted to login to view the Dashboard.
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Note: The configured Startup Dashboard is automatically visible to Anonymous Users regardless
of the configured setting.

• Enable Anonymous View of a Dashboard.

• Anonymous Users can execute a direct link (also known as deep link) to Dashboards that have
been configured for Anonymous view.

• If a Form or Dashboard is configured to be visible to Anonymous Users, each control on the Form or
Dashboard is also enabled to be visible to Anonymous Users. Anonymous Users have view access
only. If an Anonymous User selects a control to execute an action, they are prompted to login. After
successful login, the action runs.

Note: You can add a Button or Link with a Portal Login Command to a CSM Portal Form or
Dashboard or a Portal Login Command to the CSM Portal Menu. The Portal Login Command
immediately prompts an Anonymous User with the Login modal. See Add a Portal Login
Command to a Customer Portal Dashboard, Menu, or Form.

Enable the Service Catalog for Anonymous Access
Users in the Anonymous Security Group can be enabled to view the Service Catalog in the CSM Portal in
a variety of ways. See Enable Anonymous Access of the Service Catalog for specific information.

Enable Anonymous Access to RSS Feeds
If anonymous access to RSS feeds is allowed, Business Objects accessible via RSS must be enabled for
Anonymous view.

Restrict a Specific Form Control or Widget from Anonymous View
Use the ViewAnonymous() System Function to restrict Anonymous User visibility of a specific Form
Control or Widget by setting the Value to false for that control. If the Value is set to False, the control is not
visible to Anonymous Users.

Note: If a Form or Dashboard is configured to be visible to Anonymous Users, each control on the
Form or Dashboard is also enabled to be visible to Anonymous Users.

The ViewAnonymous() System Function is a visibility expression for an item on a Form or Dashboard. It
can be set as a Boolean Property wherever a System Function can be accessed (e.g., One-Step Action,
Expression, etc.).

Limit Anonymous Access to Records
Anonymous Users can be limited in their access to records. When enabling Anonymous view of a specific
Business Object, select Limit records based on criteria and Browse to configure a custom query to
limit the records available to Anonymous Users.
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Related concepts
Configure Anonymous Login Settings for CSM Web Applications
Enable Anonymous Searching Rights
Enable Anonymous View of a Specific Business Object
Enable Anonymous View of a Dashboard
Restrict Anonymous User Visibility for a Form Control
Restrict Anonymous User Visibility for a Dashboard Widget
Related tasks
Configure the CSM Portal Site to Allow Anonymous Access
Enable Anonymous View of the Service Catalog
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Enable Anonymous View of a Specific Business
Object

The CSM Portal can be configured to allow Anonymous Users to view specific Business Objects and
associated fields. Any Business Objects associated with Form Controls, Dashboards, Widgets, and
Actions enabled for Anonymous access will also need to be enabled for Anonymous access.

Note: Anonymous access requires some initial configuration. See Anonymous Security Group for
specific information.

To enable anonymous view of a specific Business Object:

1. In CSM Administrator, select Security > Edit security groups.

2. In the Group drop-down list, select the Anonymous Security Group (OOTB: Anonymous Browser).

3. Select the Business Objects tab.

4. In the Business Object drop-down list, select the specific Business Object (Example: Knowledge
Articles) you want to allow Anonymous Users to view.

5. Select the View check box for the Business Object and all associated fields you want the
Anonymous User to be able to view. You must also grant View permissions to any Business Objects
associated with the selected Business Object. For example, if the Knowledge Articles Business
Object is associated with the Journal - Comment Business Object, you would additionally provide
View access to Journal - Comment).

6. Optional: Select Limit records based on criteria and Browse to configure a custom query to limit
the records available to Anonymous Users.

7. Select Save.

Note: Anonymous users can only view the selected Business Object(s). Login is required for
Users who want to interact with or edit records in the Portal.

Related concepts
Anonymous Security Group
Configure Anonymous Login Settings for CSM Web Applications
Enable Anonymous Searching Rights
Enable Anonymous View of a Dashboard
Restrict Anonymous User Visibility for a Form Control
Restrict Anonymous User Visibility for a Dashboard Widget
Related tasks
Configure the CSM Portal Site to Allow Anonymous Access
Enable Anonymous View of the Service Catalog
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Example: Enable Anonymous View of Knowledge
Articles

The CSM Portal can be configured to allow Anonymous Users to view knowledge articles without having
to log in to the CSM Portal.

Note: This is only one example of how Anonymous Security Group Users can be granted view
access to a Business Object in the Portal. The specific Business Object used in this example may
appear differently or not at all in your unique database. Click here for more generic instructions.

To enable anonymous view of knowledge articles:

1. In CSM Administrator, select Security > Edit security groups.

2. In the Group drop-down list, select the Anonymous Security Group (OOTB: Anonymous Browser).
3. Select the Business Objects tab.

4. In the Business Object drop-down list, select Knowledge Article.

5. Select the View check box for Knowledge Article and all associated fields you want the anonymous
user to be able to view.

6. In the Business Object drop-down list, select Journal.
7. Select the View check box for Journal and all associated fields you want the anonymous user to be

able to view.

8. In the Business Object drop-down list, select Journal - Comment.
9. Select the View check box for Journal - Comment and all associated fields you want the anonymous

user to be able to view.

10. Select Save.

Note: Anonymous Users can only view the knowledge articles. Users who want to interact
with or edit records must log in.
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Enable Anonymous Searching Rights
The CSM Portal can be configured to allow Anonymous Users to run searches that reference fields to
which the User doesn't have rights.

Note: Anonymous access requires some initial configuration. See Anonymous Security Group for
specific information.

To enable anonymous searching rights:

1. In CSM Administrator, select Security > Edit security groups.

2. In the Group drop-down list, select the Anonymous Security Group (OOTB: Anonymous Browser).

3. Select the Rights tab.

4. In the Category drop-down list, select Searches.

5. Select the applicable option and select the Allow check box. Specific options are described in the
following table:

Option Description Example

Can run searches that
reference fields to which the
user doesn't have rights.

If you select the Allow check
box, the Anonymous User can
run searches that reference
fields to which the User doesn't
have rights.

If the User has been enabled to
view the Knowledge Articles
Business Object and a
Knowledge Article has
associated Journal - Comments,
but the user does not have View
access for Journal - Comment,
the user could still perform the
search and view the Knowledge
Article.

Perform Global Searches?

If you select the Run check box,
applicable Saved Searches can
run for the Anonymous User.
Enable Run if appropriate for the
scope of the Saved Search.

Perform Role Searches?

If you select the Run check box,
applicable Saved Searches can
run for the Anonymous User.
Enable Run if appropriate for the
scope of the Saved Search.

Perform Site Searches?

If you select the Run check box,
applicable Saved Searches can
run for the Anonymous User.
Enable Run if appropriate for the
scope of the Saved Search.
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Option Description Example

Perform Team Searches?

If you select the Run check box,
applicable Saved Searches can
run for the Anonymous User.
Enable Run if appropriate for the
scope of the Saved Search.

Perform User Searches?

If you select the Run check box,
applicable Saved Searches can
run for the Anonymous User.
Enable Run if appropriate for the
scope of the Saved Search.

6. Select Save.

Related concepts
Anonymous Security Group
Configure Anonymous Login Settings for CSM Web Applications
Enable Anonymous View of a Specific Business Object
Enable Anonymous View of a Dashboard
Restrict Anonymous User Visibility for a Form Control
Restrict Anonymous User Visibility for a Dashboard Widget
Related tasks
Configure the CSM Portal Site to Allow Anonymous Access
Enable Anonymous View of the Service Catalog
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Managing Security Groups
When managing Security Groups, you can define business object rights, assign roles and users, create
new Groups, edit existing Groups, and more.

Security Groups are managed using the Security Group Manager.

Use the Security Group Manager to:

• Create or edit Security Groups:
◦ Define general information for a Security Group.

◦ Define functionality security rights.
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◦ Define Business Object rights.

◦ Define File Attachment rights for a Security Group.

◦ Assign Roles to a Security Group.

◦ Assign Users to a Security Group.

◦ Move Users to a different Security Group.

• Delete a Security Group.

• Copy a Security Group.

Note: After editing Security Groups, the changes take effect immediately in the database.
However, the changes may be delayed in other CSM applications (CSM Desktop Client, CSM
Browser Client, and Cherwell REST API) due to a synchronization service that pulls database
changes at designated intervals for maximum performance. The default value for both client and
server checks is 15 seconds, but you can change this value by navigating to Settings > Edit
system settings > Advanced Settings and updating the fields in the Notifications section.

Related concepts
Configure Global Advanced Settings
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Open the Security Group Manager
Open the Security Group Manager from CSM Administrator.

From the CSM Administrator main window, select the Security category, and then select the Edit
Security Groups task.
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Create a Security Group
Use the Security Group Manager in CSM Administrator to create a Security Group.

When creating a Security Group, define the following properties:

• Info: Name and description.

• Rights: Security rights to access CSM functionality.

• Business Object: Security rights to access CSM data (Business Objects/Fields).

• File Attachments: Attachment security rights (ex: Import/link and global overrides).

• Roles: Roles assigned to the Security Group. You can also designate a default Role for the Security
Group.

• Users: Users assigned to the Security Group.

To create a Security Group:

1. Open the Security Group Manager. See Open the Security Group Manager.

2. Select the Create New button Down arrow  , and then select the type of Security Group
(User or Customer):

◦ New Cherwell User Security Group: Creates a Security Group for a user (technician).

◦ New Customer Security Group: Creates a Security Group for a customer (end-user).

Note: Users and customers require different levels of security, and therefore, different
User and Customer Security Groups.

3. Define general information (Info tab): Name and description.

4. Define security rights (Rights tab): Access to CSM functionality.

5. Define Business Objects rights (Business Objects tab): Access to CSM Business Object/Field data.

6. Define File Attachment rights (File Attachments tab): Attachment security rights (ex: Import/link and
global overrides).

7. Assign Roles to the Security Group (Roles tab): You can assign an existing Role or create a new
Role.

8. Assign people to the Security Group:
◦ Assign users if it is a User Security Group (Users tab). You can reassign an existing user or

create a new User Profile.

◦ Assign Customers if it is a Customer Security Group. This is done when you create Portal
credentials (CSM Desktop Client>Customer).

9. Assign LDAP or SAML groups (for systems configured to use LDAP or SAML authentication and
automatic user imports only). See Map LDAP Groups to CSM Security Groups and Map SAML
Security Groups to CSM Security Groups

10. Select Save.
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Related concepts
Users Security Rights
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Define General Information for a Security Group
To Define general information for a Security Group:

1. Open the Security Group Manager

2. In the Group drop-down, select the Security Group for which you want to define rights (example:
Admin).

3. Click the Info tab.

4. Define the general properties:
a. Name:

The name of the new Security Group (this property can be searched in CSM Item Managers).

b. Description:

A description of the type of User that belongs to the new Security Group and an explanation of
when it should be used (this property can be searched in CSM Item Managers).

5. Click Save .
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Define Functionality Security Rights (Access to
Functionality)

Use the Rights tab in the Security Group Manager to define the access to CSM functionality for a Security
Group.

Good to know:

• Functionality security rights control access to CSM functionality (example: Allowing a User/
Customer in a Security Group access to global Dashboards).

• To make items easy to find, functionality is organized by category/subcategory (example:
Dashboards/Global Dashboards).

• For a detailed description of each security right, see Security Rights Reference.

To define functionality security rights:

1. Open the Security Group Manager.
2. In the Group drop-down, select the Security Group for which you want to define rights (example:

Admin).
3. Click the Rights tab.
4. Category: Select the CSM functionality category for which you want to set rights (example:

Dashboards, Calendars, etc.). Notable categories include:

Option Description

Default right Sets default rights for all functionality in a
Security Group, use. This default is also
used for any new functionality that is added
in future versions of CSM.

Note: The defaults only affect
untouched functionality; if you have
already set specific rights for
functionality, those rights override the
default. You can override the default
at any time by manually setting rights
for functionality.

Application rights Houses basic CSM functionality rights, such
as Table Management, Grid/Toolbar/Task
Pane personalization, etc.

Access Service Monitor Grants access to the Service Monitor.

Security features Houses security feature rights, such as
system settings, Role/Team management,
SAML settings, etc.
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Option Description

Sites Houses Portal Site rights.

A list of associated subcategories displays below the category.
5. Subcategory: Select the functionality for which you want to set permissions. The available rights

show as check boxes below the subcategory. Rights vary by functionality but include a combination
of the following:

Option Description

View Item can be viewed

Add New item can be added

Edit Existing item can be modified

Delete Item can be deleted

Allow Action/access is allowed

Run Item can be run

Open Item can be opened

Note: Many rights are scope-related (User, Role, Team, Global), meaning they allow/deny
access to an item based on an intended audience.

6. Rights check box: Select this check box to allow this Security Group permission to perform the
action. Clear the check box to deny permission.

7. Click Save .

Example: To deny the Service Desk Security Group access to the Cherwell
Administrator module:

1. Open the Security Group Manager.

2. Click the Rights tab.

3. Select the Security features category.

4. Click the Run the administrator tool? security right.

5. Clear the Allow check box.

Related concepts
Users Security Rights

145

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fsecurity%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fcsm_users_security_rights.html


Define Business Object Rights (Access to Data)
Use the Business Objects tab in the Security Group Manager to define access to CSM data for a Security
Group. Business Object security rights control access to:

• General data: Security Group can access (view, add, edit, delete) data in a Business Object.
Business Object rights can be set at the Business Object or Field level.

• File Attachments: Security Group can access (view, add, edit, and delete) Business Object record
Attachments.

Different record ownership rights (both User and Customer) can be set to extend/deny access to
managers, departments, Teams/Workgroups, and Team/Workgroup managers.

To define Business Object security rights:

1. Open the Security Group Manager.

2. In the Group drop-down, select the Security Group for which you want to define rights (ex: Admin).

3. Click the Business Objects tab.

4. In the Business Object drop-down, select the Business Object for which you want to set rights. You
can also select individual Fields within the Business Object.

Tip: To set default rights for all Business Objects/Fields in a Security Group, use the New
Business Objects and New Field Rights options. These defaults are also used for any new
Business Object/Field created in a Blueprint. Please note that the defaults only affect
untouched Business Objects/Fields; if you have already set specific rights for a Business
Object/Field, those rights override the defaults. To override the defaults at any time,
manually set rights for a Business Object/Field. To restore a Business Object so that it uses
default rights, use the Reset Rights options on the Options menu.

The available Business Object rights show as check boxes to the right of Business Object/Fields.

5. Define general rights:
a. Select the check boxes to allow the Security Group permission to perform the operation. Clear

the check box to deny permission. Rights include a combination of the following:
◦ View: Data/record can be viewed.

◦ Add: Data/record can be added.

◦ Edit: Data/record can be modified.

◦ Delete: Data/record can be deleted.

◦ Limit records based on criteria: Data is limited based on a defined criteria. Even though
you can define complex Queries, it is recommended that you limit the Queries to ones
using only Fields from the Business Object being limited, or Fields in 1-1 Related
Objects.

Example: Members of the network Security Group might be limited to seeing Incidents
with the category of Networking. If a criteria is applied, then only records that meet that
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criteria will be seen by the User. Not only will searches be limited, but Dashboard
Widgets will show only included records, as will Reports, and all other features of the
system.

◦ Can edit the final state: Data/record can be edited when it is in its defined final state.

Note: This option is only available if the Business Object has a final state, such
as Closed. Typically, this Right is limited to managers and system administrators.

◦ Can change the final state to the recall state: Data/record can be changed from its final
defined state to a different lifecycle state.

Note: This option is only available if the Business Object has a final state (such
as Closed) and a recall state (such as Reopened). The main reason to force
Users to change from a final state to a specific recall state is to ensure that
changes are logged, and to trigger any special Automation Processes that need
to be run when a record is recalled. Field rights are limited to View and Edit;
Business Object rights vary depending on lifecycle support.

Tip: It is a very common mistake to set view/edit rights for a Business Object but
forget to set view/edit rights for Fields, so the User still cannot edit any Fields.
The most straightforward way is to edit the New Field option for a Business
Object, because that applies to any Fields to which rights have not been set.

6. Define Encrypted Fields rights:
◦ View: Encrypted Fields can be viewed (can run the decrypt command on encrypted Fields).

◦ Edit: Data can be entered into encrypted Fields in new records.

7. Define File Attachment rights:
a. Select the check boxes to allow the Security Group permission to perform the operation. Clear

the check box to deny permission. Rights include a combination of the following:
◦ View: Attachments can be viewed.

◦ Add: Attachments can be added.

◦ Edit: Attachments can be modified.

◦ Delete: Attachments can be deleted.

8. (Optional) Different rights based on ownership: Select this check box to set different rights based on
ownership.

Note: Record ownership is an important concept in CSM because it affects security and
licensing, and it differs depending on whether the owner is a User or a Customer. Be sure to
understand the complexities of ownership.

9. Click Save .

Related concepts
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Users Security Rights
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Set Different Business Object Rights Based on
Ownership

Business Object rights take effect when CSM can identify who each owner is (record owner, department
member, manager of owner, Team/Workgroup member, and Team/Workgroup manager). Be sure that
each entity is identified with an ownership attribute; otherwise, CSM ignores ownership.

To set different Business Object rights based on ownership:

1. Open the Security Group Manager

2. In the Group drop-down, select the Security Group for which you want to define rights (ex: Admin).

3. Click the Business Objects tab.

4. In the Business Object drop-down, select the Business Object for which you want to set rights. You
can also select individual Fields within the Business Object.

5. Select the Different rights based on ownership check box. The rights expand.

Note: A Customer Security Group displays Workgroup Member and Workgroup Manager
instead of Team.

6. Set the Business Object rights for each entity.

7. Click Save .
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Define File Attachment Rights for a Security Group
Use the File Attachments tab in the Security Group Manager to define the following File Attachments
rights for a Security Group.

You can define:

• Which Attachment operations the Security Group can perform (example: Can import file
attachments, link file attachments, and link URLs).

• Override system defaults for attachments: Whether or not the Security Group can override global
Attachments settings (example: Maximum file size limit and allowable file types).

Global File Attachments rights are defined as part of system security settings. For more information, refer
to Configure Global File Attachment Settings.

To define File Attachment rights:

1. Open the Security Group Manager.

2. In the Group drop-down, select the Security Group for which you want to define rights (example:
Admin).

3. Click the File Attachments tab.

4. Define which Attachment operations the Security Group can perform (select all that apply):
a. Can import files:

Select this check box to allow the Security Group to import files as Attachments.

b. Can link files:

Select this check box to allow the Security Group to link files that are on a network drive
directly to CSM.

c. Can link URLs:

Select this check box to allow the Security Group to link a website directly to CSM.

5. (Optional) Override system defaults for attachments: Select this check box to allow the Security
Group to override the default settings with its own settings. Then, define the Security Group's
settings:

◦ Select the Limit Imported File Size to check box to specify a maximum allowable file size to
import, in MB. Then, provide the file size limit, in MB. If not selected, there is no limit and any
size file can be imported.

◦ Define allowable file types to be imported as Attachments (select one option):
◦ Allow any files:

Select this radio button to allow all file types.

◦ Only allow files with the following extensions:
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Select this option to import only explicit extensions. Then, provide the extensions to
include (example: pdf), separated by a comma, either by typing directly in the Extensions

box, or by clicking the Choose File Types button  to open the Select File Types
window.

◦ Allow files with any extension except:

Select this option to exclude explicit extensions. Then, provide the extensions to exclude,
separated by a comma, either by typing directly in the Extensions box, or by clicking the

Choose File Types button  to open the Select File Types window.

Tip: To restore the OOTB default file types, click the Restore to Cherwell defaults

button .

6. Click Save .

Related concepts
Users Security Rights
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Select Allowed File Attachment Types for
Attachments

Use the Select File Types window to select the types of files to include or exclude as Attachments.

To select allowed file types for Attachments:

1. Open the Security Group Manager (CSM Administrator>Security>Edit Security Groups).

The Manager lists the existing Security Groups.

2. Select a Security Group.

3. Click the File Attachments tab.

4. Select the Override system defaults for attachments check box.

5. Select the Only allow files with the following extensions radio button to limit the allowed
Attachment file types.

OR

Select the Allow files with any extension except radio button to exclude certain file types from
being Attachments.

6. Click the Select file types button .

The Select File Types window opens.

Note: If you selected to only allow certain file types, the Allowed File Types window opens. If
you selected to exclude certain file types, the File Types to Prohibit window opens. Both
windows appear and function the same; however, one will allow certain file types while the
other prohibits their use.

7. Select or clear the File types check boxes to add or remove file types to/from the list. Beneath the
File Types list is the file extension(s) included in the file type (ex: Adobe Photoshop Files have .psd
file extensions).

File extensions are automatically added or removed from the File Extensions list at the bottom of the
window as you select/clear file types. You can also type the file extensions directly into this File
Extensions list.

8. Click the Reset to Default button to reset the file types to Cherwell defaults.

9. Click the Uncheck all file types button  to clear all file type selections.

10. Click the Check all files types button  to select all file types.
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11. Select OK.
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Reset Security Group Rights
To reset the rights of a Security Group, perform the following steps:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Groups task.
The Security Group Manager opens.

2. While on the Rights or Business Objects tab, select Options > Reset Rights...
3. Choose a reset option:

◦ Reset all standard rights - these are the rights that appear on the "Rights" tab
◦ Reset all business object rights - these are the rights that appear on the "Business

Objects" tab
4. Click OK.
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Assign Roles to a Security Group
Use the Roles tab in the Security Group Manager to assign Roles to a Security Group.

Good to know:

• A Role can be assigned to one or more Security Groups at a time.

• A User can access any of the Roles in his Security Group, but can only log in using one Role at a
time.

• If the Security Group supports only one Role, Users in that Security Group will be assigned to that
Role without being asked. Otherwise, they will have the option of choosing the Role they want to
use when they log in to one of the main client products.

• Customers are automatically logged into their Security Group's default Role when logging in.

To assign a Role to a Security Group:

1. Open the Security Group Manager.

2. In the Group drop-down list, select the Security Group for which you want to define rights
(example: Admin).

3. Select the Roles tab.
A list of assigned Roles (legal Roles) opens.

4. Select the Add button.
The Add Role to Security Group window opens, listing the available CSM Roles (Roles not already
in the Security Group).

5. Select the Role you want to assign to the Security Group or select the New Role button to create an
ad hoc Role.

6. Select OK.

7. Designate a default Role by selecting a Role, and then selecting the Make default button.

Note: When a User logs into CSM, their default Role is selected, but they can select any
Role. When a Customer logs into CSM, they log in using their default Role.
Select the Remove button to remove a Role from the Security Group.

8. Select Save.

Related concepts
About Security Groups
About Roles
Open the Security Group Manager
Related tasks
Create a Role
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Assign Users to a Security Group
You can manually add users to a Security Group. If you have SAML or LDAP configured for your system,
you can map Active Directory groups to a Security Group and automatically add users to CSM from those
groups.

Users can be assigned to only one Security Group at a time. When you reassign an existing user to a
Security Group, you remove that user from the first Security Group. The Security Group is stored in the
user's profile. You can assign a user to a Security Group when you edit a user profile or when you edit a
Security Group.

Note: If you have SAML or LDAP configured, you can mapping Active Directory groups to CSM
Security Groups. See Map LDAP Groups to CSM Security Groups and Map SAML Security
Groups to CSM Security Groups.

To assign a user to a Security Group:

1. Open the Security Group Manager.
2. In the Group drop-down list, select the Security Group for which you want to define rights

(example: Admin).
3. Select the Users tab.
4. Select Add. The Add user to security group window opens, listing the available Users (Users not

already in the Security Group).
5. Select the User you want to assign to the Security Group, or select New User to create a new User

Profile.
6. Select OK.

◦ Select the Move To button to move a User from the Security Group to another Security Group.
◦ Select the Import button to import a User from Windows or AD/LDAP.

7. Select Save.

Related concepts
Import Directory Service Users
Related tasks
Create a User Profile
Map SAML Security Groups to CSM Security Groups
Move a User to a Security Group
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Move a User to a Security Group
To move a User to a Security Group, perform the following steps:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Groups task.
The Security Groups Manager opens.

2. In the Users tab, choose the User you wish to reassign, then select the Move tobutton.
The Move User to a Different Security Group dialog opens.

3. Select the new Security Group and click OK.
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About Roles
A Role is a user or customer's current function/responsibility in CSM, and controls how data is presented
in that person's CSM environment.

For example, a Role determines which Home Dashboard is displayed and how the Incident form looks
(example: Which fields are exposed, required, etc.). A Role is assigned to a Security Group and can be
assigned to more than one Security Group at a time. A user or customer can access any of the Roles in
his Security Group, but can only log in using one Role at a time. Examples of Roles include Service Desk
Manager and Portal Customer.

Related concepts
About Security Groups
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OOTB Roles
CSM provides the following OOTB Roles:

• Service Desk

• Service Desk Manager

• Portal Customer

Use these OOTB Roles as-is, edit them, or create new Roles using the Role Manager in CSM
Administrator.
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Managing Roles
Roles are managed using the Role Manager.

Use the Role Manager to:
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• Create or edit a Role.

• Delete a Role.

• Copy a Role.

• Clear Settings.
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Open the Role Manager
To open the Role Manager in CSM Administrator main window, click the Security category, and then click
the Edit Roles task.
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Create a Role
Use the Role Manager in CSM Administrator to create a Role.

A Role controls how data is presented in that person's CSM environment. For more information, see
About Roles.

When you create a Role, you define:

• Name and description.

• Primary Business Object: A Primary Object is the Business Object that the system defaults to for
any newly added items (if there is not some other default). For example, if a Role's default Business
Object is Incident, when a new Dashboard Widget is created, it defaults to being an Incident Widget.
In many cases, the system remembers the last selected Business Object for an option (example:
Quick Search on the Task Pane defaults to searching the last selected Business Object). However, if
there is no previous value, or a particular option does not remember the last choice, CSM uses the
Primary Object.

• Available Business Objects: Business Objects that the Role can access from the New menu, Quick
Search, and Item Managers; cleared Roles will be suppressed (not visible from those locations) but
not restricted (that is, the UI will not be cluttered with the Business Object but the Role can still
access the Business Object when in a Relationship with accessible objects). For example, if
Problem is not selected, Problem will not be on the New menu but Users of this Role will still be able
to access Problems through Incidents.

• Default system items for the Role:
◦ Dashboard

◦ Dashboard Theme

◦ Heads-Up Display (HUD)

◦ Calendar

◦ Visualization

• Custom Views: View to use when members of this Role log into the CSM Desktop Client (applicable
for Users only) and the CSM Web Applications (Portal for Customers and Browser Client for Users).

• Culture: Determines the cultures available for Users assigned to the Role.

Good to know:

• If no default Role Dashboard/HUD is selected, the Global defaults are used.

• With security rights, a User can override the Role defaults and select their own defaults. For more
information, see Security Rights.

• Customers have limited options and cannot override defaults in the Portal.

• A system administrator can clear Role and User defaults (for a specific User/Role or all), resetting
the defaults to the Global-defined settings (File>Clear Settings in the User Manager or Role
Manager).

To create a Role:
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1. Open the Role Manager. For more information, see Open the Role Manager.
The Manager lists the existing Roles.

2. Select Create New.
A [New] Role is added to the list.

3. Define general information for the Role:
a. Name: Specify a name for the Role.
b. Image:

Select the Image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

c. Primary Object: From the drop-down list, select a primary Business Object for the Role.
d. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

e. Control Business Objects available with this Role: Select the Ellipses to select Business
Objects that the Role can access.

4. Select default CSM Items for the Role (Dashboard/Heads-Up Display/Calendar/Visualization):
◦ Use default: Select this option to have the Role use the Global defaults.
◦ Dashboard/Dashboard Theme/Heads-Up Dashboard (HUD)/Calendar/Visualization: Select

these options to select specific default CSM items for the Role. The Managers open to select
an existing item or create a new item. Be sure to select items that everyone in that Role can
access (that is, the item must be in scope). For more information, see Scope.

Note: For Dashboard Theme, you can select to use the Global Dashboard Theme, the
Dashboard's default Theme, or a specifically-selected Theme.

Most defaults can be overridden by a User assuming they have security rights. For
example, a User can right-click a displayed Dashboard and choose to make it their
default Home Dashboard instead of the system administrator-chosen default. Also, for
most options, there is a Global default that is displayed if the Role does not explicitly
override it. Customers have limited options and cannot override defaults in the Portal.
System administrators can clear User defaults by selecting File>Clear Settings.

5. Select the Views to use when members of this Role log into the CSM Desktop Client (applicable for
Users only) and the CSM Web Applications (Portal for Customers and Browser Client for Users).
Typically, Customers will have a limited Portal view.

6. Select culture options for the role. For more information, see Set Cultures for Roles.
7. Select Save.

Related concepts
About Dashboards
Dashboard Themes
Heads-Up Display (HUD)
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About Calendars
About Visualizations
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Exclude Business Objects from a Role
You can specify which Business Objects a Role can access from the New menu, Quick Search, and Item
Managers; excluded Roles will be suppressed (not visible from those locations) but not restricted (that is,
the UI will not be cluttered with the Business Object but the Role can still access the Business Object
when in a Relationship with accessible objects). For example, if Problem is not selected, Problem will not
be on the New menu but Users of this Role will still be able to access Problems through Incidents.

To exclude a Role's access to certain Business Objects, perform the following steps:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Roles
task.
The Roles Manager opens.

2. Select the Ellipses button  to control Business Objects available within a Role.
The Available Business Objects dialog opens.

3. Uncheck the Business Objects you wish to exclude from the Role.

Click OK.
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About Teams and Workgroups
CSM provides several default Teams and Workgroups. Use these Teams/Workgroups as-is, edit them, or
create your own using the Team and Workgroup Manager.

A Team is a collection of CSM users that can share CSM items (such as Dashboards), record ownership,
and assignments. Examples include Support, Management, and Knowledge Management. A Team plays
an important part in record ownership because members of the Team can have additional rights to view
and edit records.

A Workgroup is a collection of CSM customers who can share CSM items (such as Dashboards).
Examples include Sales, HR, and Operations. A Workgroup plays an important part in record ownership
because members of the Workgroup can have additional rights to view and edit records.

Team/Workgroup properties include:

• Information: Name and description, and defaults for sending e-mails to Workgroup members.

• Members: Users on the Team and Customers in the Workgroup.

Note: If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended
to managers, departments, and Teams/Workgroups, so carefully consider the implications of
these relationships.

Related concepts
Record Ownership
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Default Teams and Workgroups
CSM provides several default Teams and Workgroups.

Default User Teams:

• 1st Level Support

• 2nd Level Support

• 3rd Level Support

• Change Advisory Board (CAB)

• Facilities

• HR

• IT Management

• Knowledge Management Teams

• Reporting

Default Customer Workgroups:

• Accounting

• Business Development

• Customer Service

• Design

• Executive

• Finance

• Human Resources

• Information Technology

• Marketing

• Office

• Operations

• Sales

• Shipping

• Telesales

Use these default Teams/Workgroups as-is, edit them, or create your own using the Team and Workgroup
Manager in CSM Administrator.
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Managing Teams and Workgroups
Teams and Workgroups are managed using the Teams and Workgroups Manager and the Team
Manager. Use these managers to view, edit, and delete a team or workgroup, create a customer
workgroup, and create a team.
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Open the Team and Workgroup Manager
The Team and Workgroup Manager is available from the Security category in CSM Administrator.

1. Open the CSM Administrator.
2. In the main window, select the Security category.
3. Select the Edit Teams and Workgroups task.
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View Team Information
You can access Team Info from a Blueprint Lookup table or Security Teams and Workgroups in CSM
Administrator or Table Management in the CSM Desktop Client.

The Team Info Business Object creates a lookup table based on the information in Security Teams and
Workgroups.

Note: The ability to edit and create Team Info is set through security rights.

• To view Team Info from a Blueprint in CSM Administrator:
1. Create a Blueprint.

2. Select the Lookup tables radio button.

3. Select Team Info Business Object.
4. Select the Edit data task.

The Edit Blueprint Data - Team Info objects window opens.

5. Double-click a Team Info object to view the details.

• To view Team Info from the Security category in the CSM Administrator, open the Team and
Workgroup Manager.

• To view Team Info in the Desktop Client:
1. Open the Table Management Interface.

2. In the Type drop-down list, select Team Info.

3. Double-click a Team Info object to view the details.

Related concepts
Using Blueprints
Related tasks
Create a Blueprint
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Team Information Synchronization
Manually synchronize Team Info to keep information current across locations. When the system is
synced, the Team Info Business Object is updated from the Team Info Definitions.

If a Team info Business Object is found, then the Team definition is updated. Otherwise, a new Team Info
Business Object is created.
To manually synchronize Team Info:

1. In CSM Administrator, select the Database category, and then select the System maintenance
task.
The System Maintenance window opens.

2. Select the Synchronize Team Info Business objects with team list check box.
3. Select OK.
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Create a Team
Create a Team/Workgroup to define name, description, and email information for the Team (Info) and
Users on the Team (Members).

Use the Team and Workgroup Manager in CSM Administrator to create a Team or Customer Workgroup.

Note: If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to
managers, departments, and Teams/Workgroups, so carefully consider the implications of these
relationships.

To create a Team:

1. Open the Team and Workgroup Manager.
2. Select the User Teams radio button.

The Manager lists the existing Teams.
3. Select the Create New button to add a new team to the list.
4. Define general information for the Team:

a. Select the Info tab.
b. Provide a name for the Team.
c. Select the Image button to open the Image Manager, and then select an existing image or

import a new image to represent the item in the UI.
d. Provide a description to use within CSM (this property can be searched in CSM Item

Managers).
5. Define options for determining how emails are sent to the Team (when the Team is chosen as the

email recipient).
a. Send to All Members Who Have a Valid E-mail Address: Select this radio button to send

emails to all of the addresses for all members of the Team (based on the member list created
in the next step).

b. Send to This Alias: Select this radio button, and then provide the email alias (example:
Admins@mycompany.com) to send emails to an already defined email alias. This option is
useful if a company has created an email alias (example: Company Administrators) that
mirrors the membership of the Team.

6. Add Users to the Team:
a. Select the Members tab.
b. Select the Add button.

The Add Team Member window opens.
c. Select one or more Users to add to the Team.
d. To designate a Team manager, select a User (member), and then select the Team manager

check box. You can designate more than one manager, if needed.
e. Select OK to add User(s) to the team.

7. Select Save.

Related concepts
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About Teams and Workgroups
Record Ownership
Select Email Recipients from the CSM Address Book
About Users
Related tasks
Create a User Profile
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Add a User to a Team
To add a user to a Team:

1. In the CSM Administrator main window, select the Security category.
2. Select Edit Teams and Workroups.

The Team and Workgroup Manager opens.
3. Select the User Teams radio button and choose the Team you wish to add users to. Select the

Members tab.
4. Select the Add button to open the Add Team Member window.
5. Select team member(s) to add, close the dialog, then close the Teams and Workgroups Manager.

Tip: Select New user to create a new User Profile or use the search bar to search for User
names.

6. Select OK.

To designate a user as the Team Manager, select a User (member) in the Teams and Workgroups
Manager, and then select the Team Manager check box. You can designate more than one manager, if
needed.

Note: If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to
managers, departments, and Teams/Workgroups, so carefully consider the implications of these
relationships.

Related concepts
Add a License Key
Record Ownership
Related tasks
Create a User Profile
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Create a Customer Workgroup
Using the Team and Workgroup Manager, create a Customer Workgroup by defining the name,
description, and email information about the Workgroup (Info) and the Customers in the Workgroup
(Members).

If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to managers,
departments, and Teams/Workgroups, so carefully consider the implications of these relationships.
To create a Customer Workgroup:

1. Open the Team and Workgroup Manager.
2. Select the User Teams radio button.
3. Select the Customer Workgroup radio button.

The Manager lists the existing Workgroups.
4. Select the Create New button to add a new workgroup to the list.
5. Define general information for the Workgroup:

a. Select the Info tab.
b. Provide a name for the Workgroup.
c. Select the Image button to open the Image Manager, and then select an existing image or

import a new image to represent the item in the UI.
d. Provide a description to use within CSM (this property can be searched in CSM Item

Managers).
6. Define options for determining how emails are sent to the Workgroup (when the Workgroup is

chosen as the email recipient).
a. Send to All Members Who Have a Valid E-mail Address: Select this radio button to send

emails to all of the addresses for all Customers in the Workgroup (based on the member list
created in the next step).

b. Send to This Alias: Select this radio button, and then provide the email alias (example:
Admins@mycompany.com) to send emails to an already-defined email alias. This option is
useful if a company has created an email alias (example: Company Administrators) that
mirrors the membership Workgroup.

7. Add Customers to the Workgroup:
a. Select the Members tab.
b. Select the Add button to open the Contact Manager.
c. Select a Customer to add to the Workgroup, and then select OK.
d. To designate one of the members as a Workgroup manager, select a Customer (member), and

then select the Customer Workgroup Manager check box. You can designate more than one
manager, if needed.

e. Select OK.
8. Select Save.

Related concepts
About Teams and Workgroups
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Select Email Recipients from the CSM Address Book
About Customers
Record Ownership
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About Users
A user is a service desk professional who logs in and uses CSM to manage service desk data (example:
A technician, manager, designer, system administrator, etc.).

A user is assigned to only one Security Group (so they can access specific functionality and data), can log
in using one or more Roles (so they can have a personal viewing environment), and can belong to one or
more Teams (so they can share CSM items, such as Dashboards).

Note: Although a User can belong to one or more Teams, they must have a default team
assigned. To add a User to a Team, see Create a User Profile.

Each User has a User Profile that stores the pertinent details and properties for that User, including:

• Login credentials: Username and password, and authentication method

• Culture settings

• User information: Name, department, title, manager, and other contact information

Note: The User Information fields are configurable and are stored in the User Info Business
Object.

• Account details: Password resets, reserved licenses, and other account details

• Assigned Security Group

• Assigned Teams

User Profiles are managed (created, viewed, imported, deleted) as part of Security in CSM Administrator
using the User Manager. For more information, see View User Accounts.

Note: A User often functions as both a User and a Customer in CSM. For example, a service desk
technician performs User functions but is a Customer of the HR Department. If the User is also a
Customer, he/she must have a User Profile AND a Customer record. A Customer record does
NOT store account credentials, so any Customer requiring a Portal login must also have Portal
credentials. For more information, see Create Portal Login Credentials (for a Customer).

Related concepts
About Security Groups
About Roles
About Teams and Workgroups
User Manager
Related tasks
Set Cultures for Users
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User Manager
The User Manager is used to create or modify User Profiles.

Use the User Manager to complete the following User Profile operations:

Operation Description

Create Create new users.

Import Import existing users.

Edit Edit existing users.

Copy Copy the settings for existing users into new files.

Delete Remove selected user(s).

Clear Settings
Clears all custom settings/defaults defined for the selected user, resetting
the custom settings/defaults to the Global settings/defaults. An option is
also available to clear all custom settings for all users.

Note: When using a hosted services license (SaaS), if you try to modify or delete the CSDAdmin
or CherwellServices accounts, you will receive the following message: "This account is used for
hosting services and cannot be modified." The only user account that can modify these accounts
is CSDAdmin.

Open the User Manager by using the Security category in the CSM Administrator Task Pane.

To open the User Manager:

1. In the CSM Administrator main window, select the Security category, and then select the Edit
Users task.
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1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. User list:

Displays a list of available users.

5. Tabs:
◦ User: Details about the user, separated into login credentials, culture settings, User

Information, and Account Details.
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◦ Teams: Teams of which the User is a member.

6. User Information:

Personal information about the user.

Note: The User Information fields are configurable and are stored in the User Info Business
Object.

7. Account Details:

Details about account locking, password resets, and reserved licenses.
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User Manager Menu Bar

File Menu

Action Description

New Creates a new item.

Abandon Abandons changes to the current item.

Save Saves changes to the current item.

Clear Settings

Clears all custom settings/defaults defined for the current item, resetting the settings/
defaults to the Global settings. An option is also available to clear all custom settings
for all items. Cleared settings include: Default Dashboard/Dashboard Theme, HUD,
Calendar, Visualization, Mobile Configuration, window sizes, and some Grid settings.

Import User
Imports users from Windows NT, AD/LDAP.

Note: This option only appears if your system has been appropriately configured.

Copy Creates a new item whose properties are the same as the copied item. The new item
can then be named and customized.

Delete Deletes the current selection.

Close Closes the Manager.

View Menu

Action Description

User Account List.. View list of user accounts and their details.

Help Menu

Action Description

Help Opens the online help.

Contents Opens the online help.

About Displays information about the application.
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Manager Menu Bar

Button Action Description

Create New Creates a new item.

Abandon Abandons changes to the current item.

Save Saves changes in the active window.

Import User Imports users from Windows NT, AD/LDAP.

Copy Creates a new item whose properties are the same as the copied
item. The new item can then be named and customized.

Delete Deletes the current selection.

Show Legal Values
(Lookup) Displays a list of legal values (for lookup fields only).
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Open the User Manager
To open the User Manager in the CSM Administrator main window, click the Security category, and then
click the Edit Users task.
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Create a User Profile
Use the User Manager in CSM Administrator to create a User Profile for each CSM User. The User Profile
stores the pertinent details and properties for the User, such as:

• Login credentials: Username and password, and authentication method.

• User information: Name, department, title, manager, contact information, etc.

• Account details: Password resets, reserved licenses, etc.

• Assigned Security Group.

• Assigned Teams.

Good to know:

• To save time, import Users already stored in a Service Directory. Refer to Microsoft Active Directory.

• Login credentials (either Cherwell or Windows/Lightweight Directory Access Protocol [LDAP]),
Security Group, and Full Name are required Fields on a User Profile. Department, E-mail, and
Manager are highly recommended because some features (record ownership, One-Step Actions/
Actions, Automation Processes, etc.), if configured, use them.

• If the User's Security Group does not yet exist, you must create it before creating the User Profile.
You can create the Teams before, or on the fly.

• The User Information fields are configurable and are stored in the User Info Business Object.

• If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to managers,
departments, and Teams/Workgroups, so carefully consider the implications of these relationships.

To create a User Profile:

1. Open the User Manager.

2. Click the Create New button .
A [New] User is added to the list.

3. Click the User tab.

Setting User Authentication Options

4. Define login credentials for the User (either Cherwell authentication or Windows/LDAP
authentication):

Field Description

Login ID Provide a Cherwell login ID for the User
(example: First initial + last name). The login
is limited to 60 characters and must be
unique.

Security Group Select a Security Group for the User.
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Field Description

Password Provide a Cherwell password for the User.
Provide the password again to confirm it.

(Optional) Windows authentication ◦ Window login ID: Uses Windows
credentials for login (instead of Cherwell
credentials). Provide the User's
Windows Login ID. See Use Windows
Credentials.

Note: To use this feature, Windows or
LDAP must be a supported login mode
(CSM Administrator > Security > Edit
security settings > select the
Windows check box

◦ Requires Active Directory group
membership: Select this check box to
further validate the Windows login by
authenticating it against Microsoft®
Active Directory® (AD). If Users are
created on the fly from AD, this option
will be set automatically.

Note: To use this feature, AD
must be configured and LDAP
must be a supported login mode
(CSM Administrator >
Security > Edit security
settings) and select the LDAP
check box.

Adding User Information

5. Provide personal User Information:

Field Description

Full name Provide the User's full name (example:
Andrew Simms).
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Field Description

Set Image
Select the Image to open the Image Manager,
and then select an existing image or import a
new image to represent the item in the UI.

Tip: A person's image is often called
an avatar because it can be a photo or
a character representation.

Department Select the User's department.

Note: If configured, record ownership
rights (View, Add, Edit, Delete rights)
can be extended to managers,
departments, and Teams/Workgroups,
so carefully consider the implications of
these relationships.

E-mail Provide the User's e-mail address. If e-mail is
configured, CSM can send e-mails to this
address. Note that Automation Processes and
Actions/One-Step Actions can also use an e-
mail address.

Tip: When testing a system, consider
using a test e-mail account to avoid
unnecessary e-mails.

Manager Click the Selector button to open the User
Selector window. Then, select another User to
be the manager. Browse, search, or create a
new User, if needed.

Tip: If configured, record ownership
rights (View, Add, Edit, Delete rights)
can be extended to managers,
departments, and Teams/Workgroups,
so carefully consider the implications of
these relationships.
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Field Description

Manager E-mail Auto-populates with the selected manager's e-
mail address (if defined in the manager's User
Profile). If e-mail is configured, CSM can send
e-mail to this address. Note that Automation
Processes and Actions/One-Step Actions can
also use a User's e-mail address.

Other Phone numbers, fax number, availability
(example: Day shift), scheduled time-off, etc.

Note: The User Information fields are configurable and are stored in the User Info Business
Object.

Setting User Account Details

6. Define account locking, password reset, and reserved license options:

Field Description

Account locked Select this check box to lock the User account.

Note: Accounts can also be locked
using the View Logged-in Users
window (CSM
Administrator>Security>View currently
logged-in users).

Password never expires Select this check box to forgo password
expiration. This overrides any system setting
to reset the password.

Note: If this is selected, the User must
reset password at next login and
Password reset date settings are
hidden.

User cannot change password Select this check box to restrict a User from
changing his password. If a password reset is
required by the system, the system
administrator must reset the password.
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Field Description

Has reserved license Select this check box to reserve one of your
company's concurrent licenses for this User.

Tip: Use the Licensing window to
manage all reserved licenses.

User must reset password at next login Select this check box to prompt the Customer
to change her password the next time she logs
in. This check box will clear itself after the
Customer changes her password.

Note: This restarts any administrator-
scheduled password reset.

Tip: This is an immediate reset. Use
this setting if the User forgot his
password.

Password Reset Date Select this check box to prompt a User to
change his password on a specific date. Then,
click the Date Selector button  to select a
reset date.

Adding Users to Teams

7. Add the User to one or more existing Teams. If the Team does not yet exist, create the Team:
a. Click the Teams tab.
b. Click the Add button.

The Add User to Team window opens.
c. Select one or more Teams.
d. Click OK.

The User is added to the Team(s).
e. To select a default Team, select the Team, and then click the Default Team button.

8. Click Save .
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View User Accounts
With the User Accounts List, system administrators can view the current account status of the Users in
the CSM database, including:

• User names.

• Account creation dates.

• Locked status of the account.

• If the User can change their password.

• If the User's password is set to expire.

• The date of a User's last password reset.

• The date of a User's next password reset.

To access the User Accounts List:

1. Open the User Manager

2. In the User Manager menu bar, click View>Select User Account List.

The User Account List opens.

3. Double-click a User Profile in the User Account List.

The User Profile window opens.

Note: The Add User window is the same form as the User tab of the User Manager when
you create a User profile.

Profiles can also be edited by clicking the profile once to highlight it in the User Account List, and then
clicking the Edit... button. From the User Account List, new profiles can also be added and existing
profiles deleted by clicking the Add... (to open the Add User window) and Delete buttons.
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Import User and Customer Information Using
Microsoft Active Directory

Active Directory is a special-purpose database that stores data for objects in a network, including User
and Customer information. User and Customer data from Active Directory can be imported into CSM to
readily view information such as full names, e-mail addresses, etc. for internal Users and Customers.

To import Users and Customers using Active Directory:

1. Complete the Directory Services worksheet.

2. Configure CSM Directory Services Settings.

3. Configure Users for Directory Services.

4. Configure Customers for Directory Services.

Tip: Alternatively, configure these settings using the Getting Started Page in CSM
Administrator (Help>Go to Getting Started Page).

191

CSM 10.0.0 Administration

CSM 10.0.0 Administration



About Customers
A customer is an end user, either an internal employee or an external individual, who relies on CSM to
initiate/fulfill a Service or Product (example: A person reporting a lost password or requesting a new
phone).

If configured, a customer can access CSM data and perform self-service activities using the CSM Portal.
A customer is assigned to one, and only one, Security Group (so they can access specific functionality
and data) can log in using their default Role (so they can have a personal Customer View) and can
belong to one or more Workgroups (so they can share CSM items, such as Dashboards).

Each customer has a Customer Profile (called a Customer record) that stores the pertinent details and
properties for the customer, including:

• Identification information: Name, department, title, manager, etc.

• Details: Contact information, SLA level, social media information, etc.

Note: The Customer record Fields are configurable and are stored in the Customer Info
Business Object (called Customer - Internal in the Starter Database).

Customer records are created in the CSM Desktop Client and are managed (searched for, edited,
deleted, etc.) using the Contact Manager. A Customer record does NOT store account credentials, so any
customer requiring a CSM Portal login must also have credentials to store:

• CSM Portal login credentials (username and password).

• Assigned Security Group.

• Account details (password resets, etc.).

Related concepts
About Security Groups
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Contact Manager
The Contact Manager is an interface that allows you to quickly manage Customer records. Use the
Contact Manager to:

• View: View a Grid list or card view of Customer records, or view a specific record in detail. In Grid
and Card view, Customer records are listed alphabetically by last name, organized by lettered tabs
(ex: ABC, DEF, etc.).

• Find a specific Customer record using filtering and searching options.

• Create, edit, or delete a Customer Record.

The Contact Manger can be opened several ways in the CSM Desktop Client or Browser Client.

To open the Contact Manager:

• From the CSM Desktop Client menu bar, click Customer>Contact Manager.
• From the CSM Browser Client menu bar, click Tools>Contact Manager.

• From a Business Object record, click the Customer Selector button .

• From the Team and Workgroup Manager in CSM Administrator (CSM Administrator>Security>Edit
Teams and Workgroups), select the Customer Workgroup radio button, click the Members tab,
and then click the Add button.

1. Tabs: View Customer records, organized alphabetically by last name on lettered tabs.
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2. Search: Shows/hides search and filtering options:
◦ Search: Search for a specific Customer record (ex: Search any searchable field, such as First

Name, Last Name, etc.).

◦ Changed: Displays a time frame filter to refine your search (ex: Anytime, Today, Previous
Month, etc.).

3. Record View: Displays a Grid list or card view of Customer records, or a specific Customer record in
detail.

Good to know:

• From the Grid, you can print, export, run an Action, sort, filter, group, size, move/reorder, and add/
remove columns. Double-click a record to display it.

• See Contact Manager Behaviors for tips on working with Customer records in the Contact Manager.
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Open the Contact Manager
To open the Contact Manager:

• From the CSM Desktop Client menu bar, click Customer>Contact Manager.
• From the CSM Browser Client menu bar, click Tools>Contact Manager.

• From a Business Object record, click the Customer Selector button .

• From the Team and Workgroup Manager in CSM Administrator (CSM Administrator>Security>Edit
Teams and Workgroups), select the Customer Workgroup radio button, click the Members tab,
and then click the Add button.
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Contact Manager Behaviors
Menu Bars and Toolbars

Use the CSM Desktop Client menu bar/toolbar and Browser Client menu bar/toolbar to access Table
Management operations, such as:

• Navigating records.

• Switching between Grid view and Current Record view.

• Adding, editing, and deleting Customer Records.

Context Menu (Desktop Client Only)

Use the Contact Manager context (right-click) menu to quickly access common Contact Manager
operations.

Menu Item Description

Go to Record Displays the selected Customer Record.

New Creates a new Customer Record.

Delete Deletes the selected Customer Record.

Print Grid Prints the active Grid.

Export Grid Exports the active Grid to a file.

Tip: If Context Menu Actions are defined, an Actions menu item is also displayed to run Actions.

Record Views

There are several ways to view records in the Contact Manager:

• Grid list: Select the Show Results Grid button   on the toolbar to display a Grid list of
Customer Records.

• Current record: Select the Show Current Record button   on the toolbar to display the
selected Customer Record.

• Card: Select the Card view check box in the Navigation pane to display the Customer Records in a
user-friendly business card format.

Grid Capabilities

When Contact Records are displayed in Grid view, use the CSM Grid capabilities (ex: Print, export, run an
Action, sort, filter, group, size, move/reorder, and add/remove columns) to display only the data you want
and in a way that is meaningful to you.

Find Records
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Use the filter and search options to find Customer Records.
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Create a Customer Record
Create a Customer record using the Customer - Internal form in the CSM Desktop Client. The Customer
record stores the pertinent details and properties for the Customer, including:

• Identification information: Name, Department, Title, Manager.

• Details: Contact information, SLA level, organizational information.

Good to know:

• To save time, import Customers already stored in a Service Directory. See Import User and
Customer Information Using Microsoft Active Directory.

• Department, Manager, Phone, E-mail, and SLA Subscription Level are highly recommended
because some features (record ownership, One-Step Actions/Actions, Automation Processes, etc.),
if configured, use them.

• SAM Account Name (a unique Microsoft® username attribute) is used for Customer information
imported from Microsoft® Active Directory®.

• If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to Managers,
Departments, and Teams/Workgroups. Carefully consider the implications of these relationships.

The following image shows the Customer - Internal form.
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To create a Customer record:

1. From the toolbar in CSM Desktop Client or CSM Browser Client, select New > New Customer -
Internal.

2. (Optional) In the Default Form, click the Image to add a photo or graphic to the Customer Record.

3. Select Change Status in the Default Form. The Select Status dialog box opens.

4. Select a status from the drop-down menu.

5. Click OK.
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6. Complete the following fields in the General section of the Form Area:

Field Description

First Name (Required) Customer's first name.

Middle Customer's middle initial.

Last Name (Required) Customer's last name.

Employee Type

Customer's type of employment. The drop-down menu includes the
following options:

◦ Contractor

◦ Full-Time

◦ Part-Time

◦ Temporary

SLA Subscription Level Customer's Service Level Agreement subscription level.

Site Name The name of the site where the customer is located. Use the Related
Item button to open the Site Selector dialog box.

Building The building where the customer is located. The drop-down menu offers
building names dynamically based on the Site Name field.

Location ID The name or number of the customer's location within the Site and
Building.

7. Complete the following fields in the Contact section:

Field Description

Primary Phone

Customer's primary phone number. Use the Type drop-down menu to
select the type of phone:

◦ Home

◦ Mobile

◦ Work

Secondary Phone

Customer's secondary phone number. Use the Type drop-down menu to
select the type of phone:

◦ Home

◦ Mobile

◦ Work

E-mail

Customer's primary email address. (Example, work email address.)

If email is configured, CSM can send emails to this address. Note that
Automation Processes and Actions/One-Step Actions can also use an
email address.

Secondary E-mail Customer's secondary email address. (Example, private email address.)
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8. Provide organization information:

Field Description

Department Customer's work department.

Title Customer's job title.

Manager Immediate manager of the customer.

Notes Text field to enter notes about the customer.

9. Click Save.

Note: Unlike a User Profile, a Customer record does not store account credentials or
Workgroup information. If the Customer requires a Portal login, you must also create portal
login credentials to store username and password, assigned Security Group, and account
details (password resets, etc.). Refer to create Portal credentials. If the Customer needs to
share information with a team, you must assign the Customer to a Customer Workgroup.

The Create an Incident action in the Actions List allows you to create an Incident that is associated with
the Customer. When you select Create an Incident, the Incident Form opens. See Create an Incident.
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Create Portal Login Credentials (for a Customer)
Before a Customer can access the Portal, you must create Portal login credentials for them. This is
necessary for CSM to appropriately identify the Customer, and to make sure that a particular person using
the Portal is who they say they are. Customer credentials are configured within the Customer record
because it is usually a support desk task to manage Customer accounts. You can also schedule an
automatic Action to assign credentials on a regular basis by making use of the Cherwell Scheduler.

Note: If configured, a Customer can access the Portal anonymously using CSM's Anonymous
Security Group. Anonymous Customers do not require credentials, but their access is limited to
the features configured for Anonymous access.

Create Customer credentials:

• On an individual basis (particular Customer).

• For a group of Customers (batch credentials). For a group of Customers, passwords can be
generated randomly and e-mailed to each Customer, or can be assigned in other manners, including
the use of Active Directory credentials.
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Create Portal Login Credentials for an Individual
Customer

CSM allows a Customer to log in using assigned Cherwell credentials or using Windows/LDAP
credentials.

To create Portal login credentials for an individual Customer:

1. Open the Contact Manager (Customer>Contact Manager).

2. Double-click a Customer record.

3. On the menu bar, click Customer>Portal Settings>Current Customer Credentials.

Tip: You can also press CTRL+F5 while on a Customer record.

The Portal Credentials window opens.

4. Define the login credentials for the Customer (either Cherwell Authentication or Windows/LDAP
Authentication):

a. Customer configured to use Cherwell Portal: Select this check box to enable the Customer to
log in to the Portal.

b. Customer group: Select a Customer Security Group for the Customer.

Note: The Security Group controls access to CSM functionality and data. Customers
have their own Security Groups in CSM.

c. Provide Cherwell Credentials:

Note: If you provide a Windows/LDAP ID, you can omit the Cherwell Login ID and
Password.

i. Login ID: Specify a Cherwell Login ID for the Customer (ex: First initial + last name).
The value must be unique.

ii. Password: Provide a Cherwell password for the Customer.
◦ Password: Specify a password.

◦ Auto-generate a new password for this Customer: Select this check box to have
the system randomly generate a password.

d. (Optional) Windows Login ID: To have CSM attempt to log in the Customer using Windows
credentials or LDAP credentials instead of Cherwell credentials, provide the Customer's
Windows Login ID. For more information, refer to Use Windows credentials in the online help.

Notes: To use this feature, either Windows or LDAP must be a supported login mode (CSM
Administrator>Security>Edit security settings>select the Windows check box). This is intended
for situations when you know the Customer (that is, they are employees). If you provide a
Windows/LDAP ID, you can omit the Cherwell Login ID and Password.
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e. E-mail customer new credential information: Select this check box to e-mail the Customer her
credentials. If selected, you can click the Edit e-mail button to customize the text that will be
sent.

Note: If you randomly generate a password, you should select to e-mail the Customer
her credentials; otherwise, there is no way for the Customer to retrieve the password. If
selected, you can click the Edit e-mail button to customize the text that will be sent.

5. Define account locking and password reset options (Account details section):
a. Account locked: Select this check box to lock the Customer's account (preventing them from

logging in to the Portal).

Note: A Customer can be automatically locked out of the system, too, if there are too
many failed login attempts (depending on system settings).

b. Password never expires: Select this check box to forgo password expiration. This overrides
any system setting to reset the password.

Note: If this is selected, the User must reset password at next login and Password
reset date settings are hidden.

c. User cannot change password: Select this check box to restrict a Customer from changing
their password. If a password reset is required by the system, the system administrator must
reset the password.

d. User must reset password at next login attempt: Select this check box to restrict a Customer
from changing their password. If a password reset is required by the system, the system
administrator must reset the password. This restarts any system administrator-scheduled
password reset.

This is an immediate reset. Use this setting if the Customers forget their passwords.

e. Password reset date: Select this check box to prompt a Customer to change their password on
a specific date. Then, click the Date Selector button  to select a reset date.

6. Select OK.

204

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Create Portal Login Credentials for a Batch of
Customers

CSM allows a Customer to log in using assigned Cherwell credentials or using Windows/LDAP
credentials.

Note: To batch-assign both Cherwell and Windows credentials, you must run the batch process
twice, once for standard, and once for Windows credentials.

Tip: Use the CSM Scheduler to assign batch Customer credentials on a scheduled basis. This is
commonly used by those who import Customers from LDAP.

To create Portal login credentials for a batch of Customers:

1. Open the Contact Manager (Customer>Contact Manager)

2. Select a group of Customers either by running a Saved Search or by using the Search tab in the
Contact Manager.

Tip: The easiest way to assign credentials to all Customers (or all Customers that do not yet have
credentials assigned) is to bring up the Contact Manager and switch to the Search tab. Select the
Customer type for your Customers (or just select All Customers), leave the Search text blank, and
click the Go button (make sure that Changed is set to Any time).

3. Click Customer>\Portal Settings>Batch Customer Credentials.

The Batch Portal Credentials window opens.

4. Define the login credentials for the Customers (either Cherwell Authentication or Windows/LDAP
Authentication):

a. Field with Login ID: Select the Field to provide the value to use for each Customer’s login ID.
The value must be unique.

Tip: If you do not have a Field that contains the value that you want, consider creating a
calculated Field in the Customer Business Object to automatically create the value you want
(ex: First letter of First name + Last name).

Note: For Cherwell credentials, this Field is used as a source for the new User ID. For
Windows/LDAP credentials, this is the Field that holds the Customer’s Windows (or LDAP) ID.
When using Active Directory, this Field will usually be SAMAccountName. The value will be
combined with a domain to create the full Windows/LDAP User ID.

b. Customer group: Select a Security Group for the Customers.

Note: The Security Group controls access to CSM functionality and data. Customers have
their own Security Group, called Portal End User in the Starter Database.
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5. Set passwords for Customers. You have several options:
◦ Randomly generate a password for each Customer: Click this button to have the system

randomly generates the password.

Note: The randomly generated passwords will adhere to the password setting specified in the
Cherwell Settings applied in Admin Portal.

Note: If you select this option, you MUST select to e-mail each Customers their credentials;
otherwise there is no way for the Customer to retrieve the password.

◦ Set password the same for all: Click this button to provide an identical password for everyone
in the group.

Note: Not recommended for secure systems.

◦ Password is value from Field: Click this button to pull the value from a Field in the Customer
Record. This could be something like phone number or office number, or it could be a more
complex calculated Field.

◦ Set login ID Field as Windows/LDAP Login: Click this option to have CSM attempt to log in the
Customer using her Windows credentials instead of Cherwell credentials. Then, select
options for determining the domain:

Note: If the Field being used to provide the credentials is fully qualified (in the form of domain
\user-id), that identifier will be assumed to be the full Windows ID, and will be used as-is.
However, if the Field just contains the User ID, there are several options for how the system
should try to determine the domain to use. Note that the first two options are only available if
User/Customers have been imported from LDAP. When importing from Active Directory, the
SAMAccountName does not usually contain the domain, and so one of the following options
should be selected. If multiple options are selected, the system will try them each in turn until a
domain can be determined.

◦ Attempt to determine domain from LDAP distinguished name: Select this check box to
have the system determine if the Customer’s distinguished name is stored in a Field in
the Customer Record and contains a domain that can be used.

◦ Attempt to use domain associated with LDAP customer mapping: Select this check box
to use the domain specified in the settings used to import this particular Customer.

◦ Use this domain: Select this check box to provide a domain name. Then, provide the
domain name.

Note: For more information, refer to Use Windows Credentials in the online help.

6. Define account locking and password reset options (Account details section):
a. Account locked: Select this check box to lock the Customer's account (preventing her from

logging in to the Portal).

Note: A Customer can be automatically locked out of the system if there have been too many
failed login attempts (depending on system settings).
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b. Password never expires: Select this check box to forgo password expiration. This overrides
any system setting to reset the password.

Note: If this is selected, the User must reset password at next login and Password reset date
settings are hidden.

c. User cannot change password: Select this check box to restrict a Customer from changing
their password. If a password reset is required by the system, the system administrator must
reset the password.

d. User must reset password at next login attempt: Select this check box to restrict a Customer
from changing their password. If a password reset is required by the system, the system
administrator must reset the password.

Note: This restarts any system administrator-scheduled password reset.

Tip: This is an immediate reset. Use this setting if the Customer forgot their password.

e. Password reset date: Select this check box to prompt a Customer to change their password on
a specific date. Then, click the Date Selector button  to select a reset date.

7. Select options for e-mailing Customers their new credentials:
◦ E-mail customer new credential information: Select this check box to e-mail each Customer

their credentials. If selected, you can click the Edit e-mail button to customize the text that will
be sent.

Note: If a password is being auto-generated, you should select to e-mail the Customer their
credentials; otherwise, there is no way for the Customer to retrieve the password.

◦ Skip customers with no e-mail addresses: Select this option to skip assigning credentials to
Customers whom do not have known e-mail addresses. E-mail is the only way to retrieve the
password.

8. Skip customers who already have login IDs assigned: Select this check box to assign credentials
only to new Customers (that is, skip assigning credentials to Customers who already have them).

Example: To change everyone's credentials at once, clear this check box. If you add new
Customers or import new records (Active Directory) in bulk and want to assign credentials to the
newly added Customers, select this check box.

9. Select OK.
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Assign a Customer to a Workgroup
Use the Security Group Manager Members tab to add Customers to a Workgroup so that Customers can
share CSM Items and, if configured, record ownership rights.

Note: By default, Customers can share record ownership with their Customer and Manager;
however, our Out-of-the-Box (OOTB) system in not configured to share with Workgroup members.

To add a Customer to a Security Group:

1. Open the Team and Workgroup Manager (CSM Administrator>Security>Edit Teams and
Workgroups).

2. Select the Customer Workgroup radio button.

The Manager lists the existing Workgroups.

3. Click the Customer Workgroup to which you want to assign a Customer (ex: Accounting)

4. Click the Members tab.

5. Click the Add button.

The Contact Manager opens.

6. Click a Customer to add to the Workgroup, and then click OK.

7. To designate one of the members as a Workgroup manager, select a Customer (member), and
then select the Customer Workgroup Manager check box. You can designate more than one
manager, if needed.

Note: If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended
to managers, departments, and Teams/Workgroups, so carefully consider the implications of
these relationships.

8. Select OK.

The Customer is added to the Workgroup.

9. Click Save .
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Implementing Security
The steps to implement security vary depending on whether you:

• Implement the OOTB security design.

• Create a custom security design.
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Steps to Implement the OOTB Security Design
CSM is shipped with an OOTB security design complete with OOTB Security Groups, OOTB Roles,
OOTB Teams/Workgroups, and OOTB security settings. Complete the following steps to implement the
OOTB security design.

To implement the OOTB security design:

1. Review the OOTB security design: Understand the OOTB Security Groups, Roles, and Teams/
Workgroups.

2. Complete the User/Customer Worksheet to determine which Security Group and Teams/
Workgroups to assign each User/Customer to.

3. Add your people:
a. Create User Profiles: Create a User Profile for each CSM User (CSM

Administrator>Security>Edit Users). During this process, you will assign each person to one
Security Group, and one or more Teams.

b. Create Customer Profiles (Customer Records): Create a Customer Record for each Customer
you support (from the CSM Desktop Client toolbar, click the New button and select Customer-
Internal).

Unlike a User Profile, a Customer Record does not store account credentials or Workgroup
information.

Tip: To save time, you can import users already stored in a Directory Service (ex: Active
Directory). Refer to import Users/Customers.

4. Explore Security design ideas.

5. (Optional) Configure Security: CSM provides numerous system security settings (ex: Login,
authentication, inactivity, password enforcement, etc.); you can change these, if needed, but it is not
required.
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Security Design Ideas
CSM provides an OOTB security design to get you started. This design has Security Groups, Roles, and
Teams/Workgroups. You can use this design as-is or tailor it to meet the needs of your organization.
Design ideas include:

• Create new Security Groups and define specific functionality and data security rights for each.

• Define new Roles, and then assign them to Security Groups.

• Create new Teams/Workgroups, and then add Users/Customers.

• Configure the Scheduler to regularly import Active Directory data.

• Integrate with SAML.

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.
Refer to the online help for this detailed information.
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Steps to Create a Custom Security Design
Complete the following steps to create a custom security design.

Tip: CSM is shipped with an OOTB security design complete with OOTB Security Groups, OOTB
Roles, OOTB Teams/Workgroups, and OOTB security settings. We recommend that you start with
this design, and then tailor it to meet your needs.

To create a custom security design:

1. Review the OOTB security design: To understand the OOTB Security Groups, Roles, and Teams/
Workgroups.

2. Design your security model:
a. Identify which Security Groups you will need and the defined set of security rights (access to

functionality and data) for each.

b. Identify which Roles you will need.

c. Identify which Teams/Workgroups you will need.

Tip: Complete the User/Customer Worksheet to determine which Security Group and
Teams/Workgroups to assign each User/Customer to.

3. Create Security Groups.

4. Create Roles.

5. Create Teams (for Users) and Workgroups (for Customers).

6. Add your people:
◦ Create User Profiles: Create a User Profile for each CSM User.

◦ Create Customer Profiles (Customer Records): Create a Customer Record for each Customer
you support. If a Customer requires login access to a CSM Customer Portal, you must also
create Portal login credentials.

Tip: To save time, you can import Users/Customers already stored in a Directory
Service (example: Active Directory®).

7. Configure Security: Configure rights to access security functionality, as well as system security
settings (ex: Login, authentication, inactivity, password enforcement, etc.).
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Security Worksheets
CSM provides the following worksheets to help you implement and/or design your system security:
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User/Customer Worksheet
Use the following worksheet to determine to which Security Group and Teams/Workgroups each User/
Customer is assigned.

Good to know:

• A User often functions as both a User and a Customer in CSM. For example, a service desk
technician performs User functions but is a Customer of the HR Department. If the User is also a
Customer, he must have a User Profile AND a Customer record.

• If configured, record ownership rights (View, Add, Edit, Delete rights) can be extended to managers,
departments, and Teams/Workgroups, so carefully consider the implications of these relationships.

Important: Our OOTB system is configured so that Users can share records with managers,
departments, and Team members. However, Customers are configured to share only with
managers and departments.To extend rights to Workgroup members, you must configure
extended ownership rights on the records you want to share.

User/Customer Worksheet: Make applicable role selections for each person.

Name:

 

Role: User Role: Customer

Security Group Teams Security Group Workgroups
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(Select One per
User)

• Admin

• Service Desk
Manager

• Service Desk
Level 1

• Service Desk
Security Group
Level 2&3

(Select All That Apply)

• 1st Level Support

• 2nd Level Support

• 3rd Level Support

• IT Management

• Knowledge
Management

• Reporting

(Select One per
Customer)

• Portal
Customer

• Portal
Workgroup
Manager

(Select All That Apply)

• Accounting

• Business
Development

• Customer Service

• Design

• Executive

• Finance

• Human Resources

• Information
Technology

• Marketing

• Office

• Operations

• Sales

• Shipping

Example: Name:
Andrew Simms    

User Customer

Security Group Teams Security Group Workgroups

• Admin
• 2nd Level Support

• Knowledge
Management

• Portal
Customer

• Information
Technology
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Directory Services Worksheet
To integrate CSM with a Directory Service, gather the information provided in this worksheet.

Account Information

Note: Search and read capability for the Directory Service account is needed.

• User name

• Password

• Domain name

Server Information

• Server operating system (example: Windows Server 2008 R2)

• Server name (example: Server-AD)

• Server long name (example: Server-1.DNS.Domain.local)

• IP address (example: 10.1.2.3)

• AD domain name (example: AD-Domain)

• RootDSE Path

• Schema path

• Search start

• Note: Custom filters (contact the Active Directory/LDAP administrator)

The Map Default Object Properties window becomes the Map LDAP/Active Directory Object window
depending on which Directory Service is selected.
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Managing Security
Security is managed in CSM Administrator. In CSM Administrator, Users can:
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Lock/Unlock the System
Use the Lock/Unlock feature to prevent Users from logging into CSM Clients while administrative work is
being done. System administrators will still be able to log in to CSM Administrator, but no Users will be
able to log in to clients. Users already logged in will not be automatically logged out of the system.

Tip: Use the Unlock feature to manually unlock the system if the system gets automatically
locked. Automatic locking can occur, for example, during a failed Blueprint publish.

To lock/unlock the system:

1. In the CSM Administrator main window, click the Security category, and then click the Lock the
System task.

The Lock/Unlock System window opens.

2. Select the Lock system check box.

3. Provide a reason for the lockout (example: Locked for maintenance). This is displayed to any User
who attempts to log in.

4. Select OK.

Note: To unlock the system, repeat the above steps, but select the Unlock System check
box.
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View the Audit Log
Use the Security Audit log to track successful logins and logouts, and all attempted logins. This might be
required in your environment for compliance reasons.

To view the Audit log:

1. In the CSM Administrator main window, select the Security category, and then select Audit Log.

The Audit Log window opens.

2. Users can then choose from the following:
◦ View: Filter the type of record audit logs you want to view by selecting one of the following (the

list varies depending on which actions you select to track/log):
◦ All records: Displays audit logs for all records.

◦ Failed attempts: Displays audit logs for all failed login attempts.

Note: The values in the User Name column will be blank until after successful
authentication.

◦ Particular application: Displays audit logs for a specified Cherwell product.

◦ Particular login ID: Displays audit logs for a specified login ID.

◦ Particular user: Displays audit logs for a specified User.

◦ Still logged in: Displays audit logs for all Users currently logged in.

◦ Successful attempts: Displays audit logs for all successful login attempts.

◦ Refresh: Select this button to refresh the data in the list.

◦ Configure: Select this button to select the actions to track. Select the box next to the item to
track:

◦ Login

◦ Logout

◦ Failed login attempts

◦ File>Clear Log: Clears either all entries from the log or all entries earlier than a specified date.
It is recommended that you regularly clear log files because the log can get very large.

◦ File>Export/Print: Exports or print the audit log.

Note: Date/Time stamps in the audit log are shown in UTC (Coordinated Universal Time). If your
installation is on-premises, Date/Time stamps are shown in the server time zone.
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Configure the Audit Log
To configure the audit log, perform the following steps:

1. In the CSM Administrator main window, click the Security category, and then click the Audit Log
task .

2. Click the Configure button.

The Audit Options dialog opens.

3. Select the options you wish to track:
◦ Track login
◦ Track logout
◦ Track failed login attempts

4. Click OK.
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View/Manage Logged-In Users/Customers
To view/manage logged-in Users/Customers:

1. In the CSM Administrator main window, click the Security category, and then click the View
Currently Logged-In Users task.

The Logged-In Users Log window opens. All currently logged-in Users are listed alphabetically by
login ID. Customers logged into the Portal will also be listed if they are using licenses. Regular
Customers using the Portal (those not logged in) are not shown.

2. Click one or more Users.

3. Click an Action for the User:
◦ Logout of module: Logs the User(s) out of the selected Cherwell product.

◦ Logout all modules: Logs the User(s) out of all the Cherwell products the User is currently
logged in to.

◦ Lock user out: Locks the User(s) out of the selected module after they log out.
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Configuring Security
Complete the following procedures to configure Security. Configuration procedures are completed in CSM
Administrator.

To configure Security:

1. Configure System Settings security rights: Configure who can configure system settings.

2. Configure Application security rights: Configure who can access general application functionality
(ex: Who can access Table Management, who can create custom toolbars etc.).

3. Configure System Security settings: Configure general security settings (default domain and
anonymous login); login modes, authentication, and inactivity settings for each client; login settings
for mobile applications (Cherwell Mobile); and password enforcement rules.
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Configure System Security Settings
Use the Security Settings window in CSM Administrator (CSM Administrator>Security category>Edit
System Settings task) to configure the following system security settings:

• General: Configure the default domain and anonymous login settings.

• Attachments: Configure global Attachment settings.

• Desktop Client, Browser Client, and Browser Portal: Configure login modes, authentication, and
inactivity settings for each client.

• Mobile Applications: Configure login settings for Cherwell Mobile applications (whether or not to
remember the User ID and password).

• Cherwell Credentials: Configure User/Customer Password rules.
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Configure the Default Domain, Anonymous Login,
and Lookup Table Security Settings

Use the General page in the Security Settings window (in CSM Administrator) to configure the following
general system security settings for all clients:

• Default domain

• Anonymous login settings

• Lookup Table security

Configure the default domain and anonymous login settings:

1. Open CSM Administrator and select Security > Edit security settings.

2. Select General.
3. Provide the default domain name for your network. This is used any place where a domain is

needed but not otherwise provided, such as automatically assigning credentials to Customers.

Tip: Select Arrow ( ) to have CSM auto-populate the name.

4. Configure anonymous login settings:
a. Allow Anonymous Login: Select this check box to allow CSM Web Applications to read basic

setup information from the system without User login and to enable the Anonymous Security
Group access to items specifically configured for Anonymous view.

b. Security group when not logged in: Select the Anonymous Security Group (OOTB:
Anonymous Browser) that should be used by CSM Web Applications before any User/
Customer has logged in.

5. Select the Enforce Lookup Table Security for Validated Fields check box to require that security
rights be set for validation Fields in Lookup Objects before Users and Customers can access values
in those Fields. For example, if you enforce security for Lookup Tables, Users cannot see values for
validated Fields on Forms and in the Query Builder unless you grant them rights to these Fields in
the Lookup Tables.

If you select this check box, be sure to review and modify Lookup Object security rights for all
security groups in your system. For more information, see Define Business Object Rights (Access to
Data).

6. Select OK.
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Configure Global File Attachment Settings
Use the Attachments page in the Security Settings window (in CSM Administrator) to configure Global
Attachments settings, including:

• Maximum allowable file size to import, in MB.

• Which file types can be imported (example: All, explicit include list, or explicit exclude list).

Each Security Group can be configured to override the global settings.

To configure the default Attachment security settings:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Settings task.

2. Click the Attachments page.

3. Select the Limit Imported File Size to check box to specify a maximum allowable file size to import,
in MB. Then, provide the file size limit, in MB. If not selected, there is no limit and any size file can
be imported.

4. Define allowable file types to be imported as Attachments (select one option):
◦ Allow any files:

Select this radio button to allow all file types.

◦ Only allow files with the following extensions:

Select this option to import only explicit extensions. Then, provide the extensions to include
(example: pdf), separated by a comma, either by typing directly in the Extensions box, or by

clicking the Choose File Types button  to open the Select File Types window.

◦ Allow files with any extension except:

Select this option to exclude explicit extensions. Then, provide the extensions to exclude,
separated by a comma, either by typing directly in the Extensions box, or by clicking the

Choose File Types button  to open the Select File Types window.

Tip: To restore the OOTB default file types, click the Restore to Cherwell defaults button

.

5. Select OK.
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Configure Login, Authentication, and Inactivity
Settings for Each Client

Configure login, authentication, and inactivity settings for the CSM Desktop Client, CSM Browser Client,
and CSM Customer Portal.

By default, the Browser Client and CSM Portal use the same settings as the Desktop Client. To specify
unique settings for the Browser Client and CSM Portal, clear the User Same Settings as Destop Client
check box on their respective pages, and then define the unique settings.

To configure login, authentication, and inactivity settings:

1. In the CSM Administrator main window, select Security > Edit Security Settings.
The Security Settings window opens.

2. Select the Desktop Client page.
3. In the Supported login modes area, select the login modes that you want to allow.

Note: You can enable multiple login modes so that if one authentication fails or the user or
customer cancels the process, the next configured login method is invoked (SAML, then
external authentication server, then LDAP, then Windows, then Internal). Not all of these
options will necessarily be in your system if they have not been configured.

4. Select general login option check boxes as applicable:
◦ Display last logged-in User on Login page (Desktop Client only). If enabled, the user ID is

stored in the registry on the user’s computer, which might be considered a security risk.
◦ Allow Users to have system remember last password (auto-login) (Desktop Client only). If

enabled, the password is stored in an encrypted format in the registry on the user’s computer,
which might be considered a security risk.

◦ Validate Windows/LDAP credentials on server. We recommend that you configure your
server to use encrypted communication before enabling this feature so that credentials are not
passed to the server in a potentially sniffable format.

◦ Allow logging of authentication code (for troubleshooting). To assist with troubleshooting
and debugging, select this option to write authentication-related messages to your log file. Log
messages begin with the prefix AuthLog.

Note: To display authentication messages, enable logging in the Cherwell Server
Manager and set the level to Info, Stats, or Debug.

5. In the Default domain for login field, provide a default domain to use when users log in.
6. Select Validate credentials via external authentication server.
7. Select Require user to enter credentials to require users and customers to provide their

credentials each time they log in.

Note: If this option is not selected, and users and customers are on the same domain as the
Cherwell Authentication Server, then the user or customer's current Windows credentials are
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used to determine the person's identity. Otherwise, users and customers must provide their
Windows domain/user ID and password on the login window.

8. In the Authentication server URI field, provide the URI (location) of the external authentication
server.

Note: Both client applications and the Cherwell Application Server must have access to this
URL.

9. In the Select Logout Inactive Users from Cherwell Client area (Desktop Client only):
◦ Specify the minutes to wait before logging out an inactive user.
◦ Select the warning period to warn users before they are automatically logged out and specify

the minutes before the logout to send a warning where users can select stay logged in or log
out.

10. Select OK.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Logging Options
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Configure Cherwell Mobile Login Settings
Use the Mobile Apps page in the Security Settings window (in CSM Administrator) to configure the
following login settings for Cherwell Mobile applications (Cherwell Mobile for iOS and Cherwell Mobile for
Android:

• Whether or not to store the User's Cherwell Mobile login User ID and password. When stored, those
login values are saved (remembered) so that the next time the User logs in, the login Fields will be
automatically populated.

• Whether or not to enable SAML.

Note: Cherwell Mobile does not support Windows login mode.

To configure login settings for the Cherwell Mobile applications:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Settings task.

2. Click the Mobile Apps page.

3. Select a login option for all Cherwell Mobile applications:
◦ Store both User ID and Password: Select this radio button to store the User's Login ID and

password on each User's mobile device, auto-populating the login Fields.

Note: This might be considered insecure because any person who gets access to a User’s
mobile device will be able to view CSM data without any prompt for identity. Also, while the
device stores the User ID and Password in the correct, secure manner, there are techniques
for retrieving this information.

◦ Store User ID, but prompt for Password: Select this radio button to store the User's Login ID
but not the password.

◦ Prompt for User ID and Password: Select this radio button to prompt for the User's Login ID
and password every time they log in to a Cherwell Mobile application.

◦ Allow SAML Login: Select this check box to enable Users to log into Cherwell Mobile
applications using SAML.

Note: SAML is supported on Cherwell Mobile for Android, as well as Cherwell Mobile for ioS
version 2.0 or greater.

4. Select OK.
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Configure Cherwell Credential Settings (User/
Customer Password Rules)

Use the Cherwell Credentials page in the Security Settings window (in CSM Administrator) to configure
the following User/Customer password enforcement rules:

• Complexity

• Character length

Note: The maximum password length is 200 characters.

• Reset

• Lockout

Notes: Password resets should only be configured if (1) the User/Customer has security
rights to change their password and (2) the system administrator has not prevented the
User/Customer from changing their password in their User Profile/Customer Credentials.
Individual Customer and User password settings can override some of these settings, if
needed. User password settings are defined in the User Profile (CSM
Administrator>Security category>Edit Users task); Customer password settings are defined
in the Customer Credentials window (CSM Desktop Client>Customer>Portal Settings).

To configure User/Customer password enforcement rules:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Settings task.

2. Click the Cherwell Credentials page.
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3. Configure enforcement rules for User and Customer credentials:

Note: The settings selected apply to individual User/Customer account creation, individual User/
Customer password changes, and batch generated User/Custer credentials.

a. Enforce Windows complexity rules: Select this check box to require that the password be
complex (six (6) characters, a combination of at least three (3) of the following: uppercase
letters, lowercase letters, numbers, symbols/punctuation marks, and cannot contain the
User's/Customer's login ID).

Note: If Enforce Windows complexity rules is selected, the minimum number of characters
must be at least six (6).

b. Enforce minimum password length: Select this check box to require that a minimum number of
characters be in a password. Then, select the minimum number of characters.
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c. Enforce maximum password age: Select this check box to require a password reset every x
days. Then, schedule the reset by selecting the number of days between resets.

d. Days before required password change to warn customers: Select this check box to warn
Users/Customers ahead of time that a password reset is required. Then, select how many
days in advance to send the warning. Users/Customers receive daily warnings of the
impending reset when they log in.

e. Lockout Customers After X Failed Login Attempts: Specify the number of times Users/
Customers can attempt to login using the incorrect credentials before CSM locks them out of
the system.

4. Select OK.
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Security Rights Reference
View detailed information for security rights in each category.

Security rights control access to CSM functionality and are configured in the Security Group Manager in
CSM Administrator (CSM Administrator>Security>Edit Security Groups).

Use the Rights tab to configure rights for different features and functions.

Good to know:

• Security design strategy is very important. Carefully consider the level of access to each scope. For
more information, see the OOTB Security Design documentation.

• Manager security rights control who can access the individual CSM Item Managers and are set
separately (Managers category).

• Security rights control who can access CSM functionality. The Business Object tab of the Security
Groups window (CSM Administrator>Security>Edit security groups) allows Users to configure
access to Business Object/field data. While a User may have access to functionality, data may not
be visible without Business Object rights.
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Application Security Rights
Application rights are selected from the Category drop-down list on the Rights tab in CSM Administrator
(Security > Edit security groups).

Right Description (when selected ) Grant To:

Attachments?

Rights are organized
by scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with Attachments
on Business Objects and within the
Attachment Manager in CSM to:

• View: Access Attachments.

• Add: Create Attachments.

• Edit: Edit attachments.

• Delete: Delete Attachments.

View/Run Only:

• Users/Customers

All rights:

• System administrators

• Managers

Can customize Grids
even if they don't
support customization?

Allow: Allows selected users to customize
Grids (add/remove Fields and move
columns) even if the Grid does not
support customization.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

Can customize Grids
that support
customization?

Allow: Allows selected users to customize
Grids that support customization.

• System administrators

• Managers

• Users

Can import definitions
from inside Managers?

Allow: Allows selected users to import
definitions (.ced files) into Managers so
that you can share definitions between
systems.

• System administrators

• Advanced Users (Level 2
and 3 technicians)

Can override the Task
Pane definition?

Allow: Allows selected users to override
the default Task Pane options and
configure your own personal user options.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

• Users
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Right Description (when selected ) Grant To:

Can export definitions
from inside Item
Managers?

Allow: Allows selected users to export
definitions (.ced files) into Managers so
that you can share definitions between
systems.

• System administrators

• Advanced Users (Level 2
and 3 technicians)

Can delete all records
in a group?

Allow: Allows selected users to delete all
records in the current Search results
group (example: All Incidents).

• System administrators

Can export data from
grids?

Allow: Allows you to export data in a Grid
to use CSM data in other applications for
reporting or display purposes.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

Run application? Allow: Allows selected users to run the
Desktop Client and Browser Client.

• System administrators

• Managers

• Users

Can modify settings
governing scaling of
Business Object
forms?

Allow: Allows selected users to edit the
default scaling settings of Business Object
forms (Form > Scale Form).

• System administrators

• Managers

• Users

Table management?

Allow: Allows selected users to access
Table Management so that you can
manage (create, edit, and delete) table/
Field values directly from the Desktop
Client.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

Can define custom
toolbars?

Allow: Allows selected users to create
personal User toolbars.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

Can rank Business
Objects that have
ranking enabled?

Allow: Allows selected users to rank
records for Business Objects that have
ranking enabled.

• System administrators

• Managers

• Users
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Right Description (when selected ) Grant To:

Images?

Rights are organized
by scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with application
images in CSM to:

• View: Access images.

• Add: Import images.

• Edit: Edit image properties.

• Delete: Delete images.

View Only:

• Users/Customers

All rights:

• System administrators

• Managers

Related concepts
Scope
Related tasks
Export a Grid
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Automation Process Blueprints Security Rights
Automation Process Blueprints rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected ) Grant To:

Create
Automation
Process
Blueprints?

Allow: Allows selected Users to create Automation
Processes in CSM Administrator (Edit Automation
Processes window>File>New or Edit Automation
Processes window>Create New button).

• System
administrators

Publish
Automation
Process
Blueprints?

Allow: Allows selected Users to publish Automation
Process Blueprints in CSM Administrator (Automation
Processes window>File>Publish Blueprint).

• System
administrators
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Automation Process Service Security Rights
Automation Process Service rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Enable/disable
individual
processes?

Allow: Allows selected Users to enable or disable
individual Automation Processes in CSM
Administrator (Automation Process Status window
and Edit Automation Process window).

• System
administrators

Allow viewing of
running/
completed
processes?

Allow: Allows selected Users to view running and/or
completed Automation Processes in CSM
Administrator (Automation Process Status window
and Edit Automation Process window).

• System
administrators

• Managers

• Users

Check status of
Automation
Processes?

Allow: Allows selected Users to check the status of
Automation Processes (Automation Process Status
window and Edit Automation Process window).

• System
administrators

• Managers

• Users

Clear Automation
Processes?

Allow: Allows selected Users to clear all scheduled
Automation Processes or a history of all completed
Automation Processes (Automation Process Status
window>File>Clear all processes).

• System
administrators

Retrieve/update
events from the
Event Queue?

Allow: Allows API Users to read/update Automation
Processes in the Automation Process event queue.

Note: The account used by the Automation Process
Service must have this right.

• System
administrators

Pause/resume
service?

Allow: Allows selected Users to pause and resume the
Automation Process microservice using the Pause/
Resume Automation Process Service window from
within CSM Administrator.

• System
administrators
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Browser and Mobile Device Security Rights
Browser and Mobile Device rights are selected from the Category drop-down list on the Rights tab (CSM
Administrator > Security > Edit Security Groups).

Right Description (when selected ) Grant To:

Assign login
information to
groups of
Customers (batch)?

Allow: Allows selected Users to create Portal login
credentials for a batch of Customers (CSM Desktop
Client> Customer > Portal Settings > Batch
Customer Credentials).

• System
administrators

• Advanced Users
(Level 2 and 3
technicians)

Configure mobile
devices?

Rights are
organized by scope:
Global, Role, and
User.

Allow: Allows selected Users to Configure default
Cherwell Mobile settings (example: Default Mobile
Dashboards, Business Objects, and Actions/One-
Step Actions).

The default Cherwell Mobile settings (either Global
or Role) are initially configured in CSM
Administrator. If Users have security rights, they
can override her User (personal) Cherwell Mobile
settings from Tools > Options > Dashboard
Options

• System
administrators

• Managers

• Users

Edit Self-Service
settings?

Allow: Allows selected Users to edit Self-Service
settings on the Browser and Mobile page in CSM
Administrator.

• System
administrators

Login information
for Customers?

Allows people working with the CSM Portal to:

• View: View Portal login credentials for
Customers (CSM Desktop Client> Customer
> Portal Credentials).

• Edit: Create/edit Portal login credentials for
Customers (CSM Desktop Client > Customer
> Portal Credentials).

• System
administrators

• Managers

• Users

Portal Right 1-5
Arbitrary right that
can be assigned to
the Portal.

Allow: Allows selected Users to set up to five (5)
arbitrary rights assigned to the Portal.

• System
administrators

• Managers

• Users
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Business Hours Security Rights
Business Hours rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Business Hours?

Rights are organized by scope:
Blueprint, Business Intelligence,
Global, Role, Team, and User.

Note: The Business
Intelligence scope is available
only for Automation
Processes.

Allows people working with the
Business Hours Manager to:

• View: Access Business Hours.

• Add: Create Business Hours.

• Edit: Edit Business Hours.

• Delete: Delete Business
Hours.

• System
administrators

• Managers
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Calendar Security Rights
Calendar rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Calendars?

Rights are organized by
scope: Blueprint, Global, Role,
Team, and User.

Allows people working with Calendars to:

• View: View Calendars.

• Add: Create Calendars.

• Edit: Edit Calendars.

• Delete: Delete Calendars.

View/Run Only:

• Users

• Customers

All rights:

• System administrators

• Managers
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CAM Security Rights
Security rights control access to Cherwell Asset Management (CAM) functionality and are configured in
the Security Group Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups).
Use the Rights tab to configure the following functionality rights under the CAM Administrator, CAM
Purchasing, and CAM Reporting Categories.

Table 1. CAM Administration

Right Description (when selected ) Grant To:

Configure all
aspects of the
CAM system (CAM
system
administrator)?

Allows the Security Group to run CAM Administrator,
Reporting, License Analytics, and Purchasing. Only users
with this permission are able to do the following:

• Run the Setup Wizard

• Configure baselines

• Reset data

• Change the license key

• View all panels

• View and configure all tabs and options in the
Options dialog box

• System
administrators

Configure and
manage
recognized
software
characteristics?

Allows the Security Group to:

• View the License Units, Unconfigured Applications,
and Files panels

• Add, delete, or modify license units

• View and modify the license unit template

• Automatically configure applications into license
units

• Mark any unconfigured applications that you don't
want to configure into license units

• Enable metering

• Configure control profiles

• Add, delete, or modify license unit groups

• Organize files

• Run administrative reports related to license units

• System
administrators
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Right Description (when selected ) Grant To:

Configure
hardware assets
other than
computers?

Allows the Security Group to:

• View the Network Devices and Other Assets panels

• Discover network devices

• Delete network devices

• Add, delete, or modify other assets

• Import asset data

• View and modify the network device template

• View and modify the asset template

• Add, delete, or modify network device groups and
asset groups

• Run reports related to network devices and other
assets

• System
administrators

Configure
managed
computers and
users?

Allows users to:

• View the Machines and Users panels

• Inventory machines

• Install the CAM Agent on machines

• Uninstall the CAM Agent from machines

• Run remote inventory

• Discover machines and users

• Launch the Remote Desktop Connection

• Open the Agent Options dialog box

• Check licenses in and out for selected machines

• Import user-defined data

• Add, delete, or modify machine groups

• Add, delete, or modify user groups

• Delete and restore machines

• Delete and restore users

• Run administrative reports related to machines and
users

• System
administrators
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Right Description (when selected ) Grant To:

Configure
purchasing access
profiles, orders,
and contracts?

Users with Purchasing administrator permissions have full
access to Purchasing and all panels and commands are
available. Specifically, purchasing administrators can run
Purchasing and use all functionality, including:

• Use its Administration panel

• Configure email notifications for access profiles

• Move orders and contracts from one access profile
to another

• System
Administrators

Table 2. CAM Purchasing

Right Description (when selected ) Grant To:

Run the
purchasing
application?

Allows users to:

• Run Purchasing, Reporting, and License
Analytics

• View orders and contracts available for the
relevant access profile

• System Administrators

• Managers

Table 3. CAM Reporting

Right Description (when selected ) Grant To:

Run the reports and license
analytics applications?

Allows users to run Reporting and
License Analytics.

• System Administrators

• Managers
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Chat Service Integration Features Security Rights
Chat Service Integration Features rights are selected from the Category drop-down list on the Rights tab
(CSM Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Add chat session
history to
Business
Objects?

Allow: Allows selected Users to manually add a
remote support session history to Business Objects
using the Add Chat Session History command in the
CSM Desktop Client.

• System
administrators

• Managers

• Users/Customers

Can process chat
session events
and create and
modify Business
Objects in web
service?

Allow: Allows the Cherwell Web Service (CWS) to
automatically process remote support session events
as well as create and modify Business Objects by
logging into Cherwell as a User specified in the
General page of the Chat and Remote Support
Connector Settings window.

Note: This setting is for Users who are configured to
be logged in by the CWS that processes BeyondTrust
remote support session end notifications. If this
privilege is not allowed, the web service will ignore all
BeyondTrust events.

• System
administrators

• Managers

• Users

Chat settings?
Edit: Allows selected Users to edit remote support
service settings (CSM Administrator>Security>Edit
Chat and Remote Support Connector Settings).

• System
administrators

• Managers

• Users

Request a new
chat session?

Allow: Allows selected Users to initiate new remote
support sessions using the New Chat Session
command.

• System
administrators

• Managers

• Users/Customers

Request a new
device
administrator
session?

Allow: Allows selected Users to remotely control a
device using the Remotely Administer a Device
command.

• System
administrators

• Managers

• Users
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Right Description (when checked ) Grant To:

Request chat
service
information?

Allow: Allows selected Users to access information
about the BeyondTrust remote support service (using
the Display Chat Service Information command), such
as API version information.

• System
administrators

• Managers

• Users/Customers
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Command Manager Security Rights
Command Manager rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

View Command
Manager?

View: Allows selected Users to access the Command
Manager and select commands for use where
appropriate.

• System administrators

• Managers

• Users

246

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Configuration Management Security Rights
Configuration Management rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Device
Manager?

 

Allows people working with the Device Manager to:

• View: Access devices in the Device Manager.

• Add: Create devices in the Device Manager.

• Edit: Edit devices in the Device Manager.

• Delete: Delete devices in the Device Manager.

View/Run Only:

• Managers

• Users

All rights:

• System administrators

Discovery
Rules
Manager?

Allows people working with the Discovery Rules
Manager to:

• View: Access the Discovery Rules Manager.

• Add: Create Discovery Rules.

• Edit: Edit Discovery Rules.

• Delete: Delete Discovery Rules.

View/Run Only:

• Managers

• Users

All rights:

• System administrators

Run Discovery
and Inventory?

Allow: Allows selected Users to create a scheduled
Action to run Discovery and Inventory. Otherwise, the
Config Discovery and Config Inventory items do not
show as Actions when scheduling an item.

• System administrators

• Managers

• Users
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Counter Security Rights
Counter rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Counters?

Rights are organized by
scope: Blueprint, Global,
Role, Team, and User.

Allows people working with Counters to:

• View: View Counters.

• Add: Create Counters.

• Edit: Edit (reset or change) Counters.

• Delete: Delete Counters.

View/Run Only:

• Managers

• Users

All rights:

• System administrators
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Dashboard Security Rights
Dashboard rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Dashboards?

Rights are organized by
scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with
Dashboards to:

• View: View Dashboards.

• Add: Create Dashboards.

• Edit: Edit Dashboards.

• Delete: Delete Dashboards.

View/Run Only:

• Users/Customers

All rights:

• System administrators

• Managers

• Advanced Users (Level 2 and 3
technicians)

Mobile Dashboards?

Rights are organized by
scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with Mobile
Dashboards to:

• View: View Mobile Dashboards.

• Add: Create Mobile
Dashboards.

• Edit: Edit Mobile Dashboards.

• Delete: Delete Mobile
Dashboards.

View/Run Only:

• Managers

• Users

All rights:

• System administrators

• Advanced Users (Level 2 and 3
technicians)

Slideshows?

Slideshows are
accessed from within
the Dashboard Viewer.

Rights are organized by
scope: Global, Role,
Team, and User.

Allows people working with
Dashboard Slideshows to:

• View: Access Dashboard
Slideshows.

• Add: Create Dashboard
Slideshows.

• Edit: Edit Dashboard
Slideshows.

• Delete: Delete Dashboard
Slideshows.

View/Run Only:

• Users

All rights:

• System administrators

• Managers

• Advanced Users (Level 2 and 3
technicians)
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Right Description (when checked ) Grant To:

Widgets?

Rights are organized by
scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with Widgets
to:

• View: Access Widgets.

• Add: Create Widgets.

• Edit: Edit Widgets.

• Delete: Delete Widgets.

View/Run Only:

• Users/Customers

View/Run/Add/Edit Only:

• Managers

• Advanced Users (Level 2 and 3
technicians)

All rights:

• System administrators

Can set a default
Dashboard Theme?

Allow: Allows selected Users to select
a default Theme for all Dashboards.

• System administrators

• Managers

• Users
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Database Options Security Rights
Database Options rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant to:

Allow system
restore?

Allow: Allows selected Users to perform a system
restore on the database.

• System
administrators

Database transaction
log settings?

Allow: Allows selected Users to view and edit the
Database Transaction Log settings in the
Tools>Options window of a Blueprint.

• System
administrators

Export system data? Allow: Allows selected Users to export system
data from the database.

• System
administrators

Import data from
CSV files?

Allow: Allows selected Users to import data
from .csv files into CSM.

• System
administrators

Perform maintenance
on the database?

Allow: Allows selected Users to perform
maintenance on the database.

• System
administrators

Saved import
definitions?

Allows people working with .csv import definitions
to:

• Run: Create and run imported definitions
stored on the system.

• Delete: Delete import definitions.

• System
administrators
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Database Server Objects Security Rights
Database Server Objects rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant to:

Database server
object
management?

Allows people working with Database Server Objects
(triggers, views, and stored procedures) in CSM
Administrator to:

• View: Access Database Server Objects.

• Add: Create Database Server Objects.

• Edit: Edit Database Server Objects.

• Delete: Delete Database Server Objects.

Note: All Database Server Management operations take
place within a Blueprint and are not available for SaaS
Users.

• System
administrators
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Directory Service (LDAP) Security Rights
Directory Service (LDAP) rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Associate LDAP
Groups with
Security Groups?

Allow: Allows selected Users to associate LDAP Groups
with Security Groups in order to allow Users to log in to
CSM using LDAP authentication.

• System
administrators

Change LDAP
settings?

Allow: Allows selected Users to configure/edit directory
service settings.

Note: Directory services in the Tools menu of a Blueprint
cannot be accessed without this right.

• System
administrators

Import LDAP
data into
Business
Objects?

Allow: Allows selected Users to import Customer data
into Business Objects rather than manually inputting it.

Note: The Import from Active Directory task in the
Database category in CSM Administrator cannot be
accessed without this right.

• System
administrators

Import LDAP
Users?

Allow: Allows selected Users to import User data into the
User Information Business Object.

• System
administrators

Map Business
Objects to LDAP
objects?

Allow: Allows selected Users to map Business Objects to
LDAP objects so that directory service data can be
imported into CSM Business Objects.

• System
administrators
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Document Repository Items Security Rights
Document Repository Items rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Default rights?

Allows people working with Document Repository Items
in the CSM Desktop and Browser Clients to:

• View: Access Document Repository Items.

• Add: Create Document Repository Items.

• Edit: Edit Document Repository Items.

• Delete: Delete Document Repository Items.

The default Document Repository rights will be applied to
any Document Repository that does not have specific
rights set (which can be determined by looking at the Use
default checkbox for each specific Repository).

View/Run Only:

• Users

All rights:

• System
administrators

• Managers

Default Portal
Documents
(for each
defined
Document
Repository)?

Allows people working with the default documents in the
Document Repository in the CSM Portal to:

• View: Access documents.

• Add: Create documents.

• Edit: Edit documents.

• Delete: Delete documents.

• Use Default: Uses the same security rights set for
the Default Sites rights (above).

Note: For each Document Repository, you can also
define Expressions that limit access. For example, you
can limit add/edit rights to a particular Repository based
on whether the Team Lead checkbox is checked on the
Customer’s record. The type of Expression (User or
Customer) will differ depending on the type of security
group.

View/Run Only:

• Users/Customers

All rights:

• System
administrators

• Managers
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Document Repository Manager Security Rights
Document Repository Manager rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Document
Repository
Manager?

Allows people working with the Document Repository
Manager:

• View: Access the Document Repository Manager.

• Add: Create items in the Document Repository
Manager.

• Edit: Edit items in the Document Repository
Manager.

• Delete: Delete items from the Document Repository
Manager.

View/Run Only:

• Users

All rights:

• System administrators

• Managers
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E-mail and Event Monitor Security Rights
E-mail and Event Monitor rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Allow to import
emailmonitor.ini?

Allow: Allows selected Users to import an
emailmonitor.ini file using the E-mail and Event
Monitoring Manager.

Note: The emailmonitor.ini file was used prior to
CSM version 3.2.

• System administrators

E-mail and Event
Monitor item
management?

Allows people working with e-mail monitors in
the E-mail and Event Monitoring Manager in
CSM Administrator to:

• View: Access Monitors.

• Add: Create Monitors.

• Edit: Edit Monitors.

• Delete: Delete Monitors.

View/Run Only:

• Managers

All rights:

• System administrators

• Advanced Users
(Level 2 and 3
technicians)

Pause/resume the E-
mail and Event
monitor?

Allow: Allows selected Users to pause or resume
the E-mail and Event Monitoring microservice
using the pause/resume task in CSM
Administrator (E-mail and Event
Monitoring>Pause/Resume Monitoring).

• System administrators
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E-mail Security Rights
Security rights control access to CSM functionality and are configured in the Security Group Manager in
CSM Administrator (CSM Administrator>Security>Edit Security Groups). Use the Rights tab to configure
the following functionality rights.

Right Description (when checked ) Grant To:

Can override server
and account settings
on locked accounts?

Allow: Allows selected Users to override the
e-mail account server settings and account
information for a global account configured
in CSM Administrator (ex: Allows Users in
CSM to override the global account settings
configured in CSM Administrator, even if the
padlock is set to Locked in the server and
account information sections).

• System administrators

 

Can send e-mail from
the system?

Allow: Allows selected Users to send e-
mails from within the system.

• System administrators

• Managers

• Users

Can add User e-mail
accounts?

Allow: Allows selected Users to add and
personalize your own e-mail account and
settings.

• System administrators

• Managers

• Advanced Users (Level 2
and 3 technicians)

Can e-mail Teams? Allow: Allows selected Users to e-mail
Teams (ex: IT Service Desk Level 1).

• System administrators

• Managers

• Users

Can administrate
global e-mail settings?

Allow: Allows selected Users to configure
global e-mail accounts in CSM
Administrator.

• System administrators

Can e-mail
Workgroups?

Allow: Allows selected Users to e-mail CSM
Workgroups.

• System administrators

• Managers

• Users
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Right Description (when checked ) Grant To:

Show teams in
address book?

Allow: Allows selected Users to view and
select CSM Teams in the CSM address
book.

• System administrators

• Managers

• Users

Show the address
book?

Allow: Allows selected Users to access and
use the CSM address book.

• System administrators

• Managers

• Users

Show Workgroups in
address book?

Allow: Allows selected Users to view and
select CSM Workgroups in the CSM
address book.

• System administrators

• Managers

• Users

Can specify arbitrary
FROM addresses even
if not allowed for
Users?

Allow: Allows selected Users to specify
arbitrary From Addresses even if this option
has been disabled for Users

• System administrators
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External Data Options Security Rights
External Data Options rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant to:

Create connections to
external data?

Allows selected Users to link to external data
from CSM Administrator. • System administrators

Import external data? Allows selected Users to import external data
using CSM Administrator into a CSM Database. • System administrators
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HTML Pages Security Rights
HTML Pages rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

HTML Pages?

Rights are organized
by scope: Blueprint,
Global, Role, Site,
Team, and User.

Allows people working with HTML Pages in the
CSM Browser Client and Portal to:

• View: Access HTML Pages.

Allows people working with HTML Pages in CSM
Administrator to:

• Add: Create HTML Pages.

• Edit: Edit HTML Pages.

• Delete: Delete HTML Pages.

View/Run Only:

• Users/Customers

All rights:

• System administrators

• Managers
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Knowledge Security Rights
Use CSM Administrator Security Groups to define Knowledge Security Rights.

You can view Knowledge Security Group Rights in CSM Administrator > Security > Edit Security
Groups. Select the Group from the drop-down list and select the Rights tab. In the Category drop-down
list, select Knowledge. See Configure Knowledge Security Group Permissions for specific steps on how
to configure Security Group permissions for Knowledge.

The following are suggested settings for Knowledge Security Rights using the default Security Groups:

Right Description (when selected )
Grant To (Default Security
Groups):

Change
Knowledge
Search
options?

Allow: Allows selected Users to change
Knowledge Search options in the CSM Desktop
Client from the default options to either expand
or limit the search as necessary.

• Admin

• IT Service Desk Level 2 & 3

• IT Service Desk Manager

• Knowledge Manager

• Service Desk - KM Tier 1

Import
Knowledge?

Allow: Allows selected to import Knowledge
using third-party Knowledge bases through the
Knowledge Import Wizard.

• Admin

• IT Service Desk Level 2 & 3

• Knowledge Manager

Knowledge
mapping?

Allows people working with Knowledge Mapping
in CSM Administrator (Settings>Knowledge
Mapping) to:

• View: Access the Knowledge Mapping
window.

• Add: Add Knowledge Sources to a
specified type of search (ex: General
search) using the Knowledge Mapping
window.

• Edit: Edit Knowledge Sources for a
specified type of search (ex: General
search) using the Knowledge Mapping
window.

• Delete: Remove Knowledge Sources from
a specified type of search (ex: General
search) using the Knowledge Mapping
window.

View/Run Only:

• IT Service Desk Level 1

• IT Service Desk Level 2 & 3

• Service Desk - KM Tier 1

View/Add/Edit:

• Knowledge Manager

View/Add/Edit/Delete:

• Admin
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Right Description (when selected )
Grant To (Default Security
Groups):

Knowledge
sources?

Allows people working with Knowledge Sources
in CSM Administrator (Settings>Knowledge
Sources) to:

• View: Access Knowledge Source Manager.

• Add: Create Knowledge Sources using the
Knowledge Source Manager.

• Edit: Edit Knowledge Sources using the
Knowledge Source Manager.

• Delete: Delete Knowledge Sources using
the Knowledge Source Manager.

View/Run Only:

• IT Service Desk Level 1

• IT Service Desk Level 2 & 3

• Service Desk - KM Tier 1

View/Add/Edit:

• Knowledge Manager

View/Add/Edit/Delete:

• Admin
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Manager Security Rights
Manager rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected ) Grant To:

Can pin/unpin items
from all Users'
pinboards?

Allow: Allows you to pin or unpin an item to/from all
Users' Pinboards (ex: Pinning a new Dashboard to all
Users' Pinboards for easy access).

• System
administrators

Can pin/unpin items
from any Role
pinboard?

Allow: Allows you to pin or unpin an item to/from any
Role's Pinboard (ex: Pinning a Report to any Role's
Pinboard for easy access).

• System
administrators

Can pin/unpin items
from current Role
Pinboard?

Allow: Allows you to pin or unpin an item to/from the
Pinboards of all Users in the current User's Role (ex:
Pinning a One-Step Action to all Users' Pinboards
within the currently logged-in Technician Role so that
they can run the same One-Step Action).

• System
administrators

• Managers

Can view items in
Managers for all
Users?

Allow: Allows you to view items in the Managers for
all Users.

Normally, you can only edit items in a Manager for
your current Role. When this right is set, you can edit
items for any Role.

• System
administrators

Can view items in
Managers for all
Sites?

Allow: Allows you to view items in the Managers for
all Sites.

Normally, you can only edit items in a Manager for
your current Role. When this right is set, you can edit
items for any Role.

• System
administrators

Can view items in
Managers for all
Customer
Workgroups?

Allow: Allows you to view items in the Managers for
all Customer Workgroups.

Normally, you can only edit items in a Manager for
your current Role. When this right is set, you can edit
items for any Role.

• System
administrators
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Right Description (when selected ) Grant To:

Can view items in
Managers for all
Roles?

Allow: Allows you to view items in the Managers for
all Roles.

Normally, you can only edit items in a Manager for
your current Role. When this right is set, you can edit
items for any Role.

• System
administrators

Can view items in
Managers for all
Teams?

Allow: Allows you to view items in the Managers for
all Teams.

Normally, you can only edit items in a Manager for
your current Role. When this right is set, you can edit
items for any Role.

• System
administrators
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Mergeable Applications (mApps) Security Rights
mApps rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Create mApp
Solutions?

Allow: Allows selected Users to create mApp
Solutions.

• System
administrators

Apply mApp
Solutions?

Allow: Allows selected Users to apply mApp
Solutions.

• System
administrators

View installed mApp
Solutions?

Allow: Allows selected Users to view a list of
mApp Solutions that have already been installed
on a CSM system.

• System
administrators

View mApp Solutions
development history?

Allow: Allows selected Users to view available
history records for all definitions within a CSM
system that were modified by a mApp Solution.

• System
administrators
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Metrics Security Rights
Metrics rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Metrics?

Rights are organized by scope:
Blueprint, Global, Role, Team,
and User.

Allows people working with Metrics to:

• View: View Metrics.

• Add: Create Metrics.

• Edit: Edit Metrics.

• Delete: Delete Metrics.

View/Run Only:

• Users

All rights:

• System administrators

• Managers
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Prompts Security Rights
Prompt rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Prompts?

Rights are organized by scope:
Blueprint, Global, Role, Team,
and User.

Allows people working with Prompts to:

• View: View Prompts.

• Add: Create Prompts.

• Edit: Edit Prompts.

• Delete: Delete Prompts.

View/Run Only:

• Users

• Customers

All rights:

• System administrators

• Managers
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One-Step Security Rights
One-Step rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected) Grant To:

One-Step Actions?

Rights are organized by
scope: Blueprint, Business
Intelligence, Global, Role,
Site, Team, and User.

Note: The Business
Intelligence scope is
available only for
Automation
Processes.

Allows people working with One-Step
Actions to:

• Run: Run One-Step Actions.

• Add: Create One-Step Actions.

• Edit: Edit One-Step Actions.

• Delete: Delete One-Step Actions.

For the Site scope, the following additional
options are available:

• Run other Users: Run Site One-Step
Actions (from the One-Step Action
Manager) that were created by other
Users.

• Add other Sites: Create One-Step
Actions for Sites that belong to other
Security Groups.

• Edit other Sites: Edit One-Step Actions
for Sites that belong to other Security
Groups.

• Delete other Sites: Delete One-Step
Actions for Sites that belong to other
Security Groups.

View/Run Only:

• Users/Customers

• Managers

All rights:

• System
administrators

Can configure One-Step
Actions to run through a
Trusted Agent?

Allow: Allows Users to configure One-Step
Actions to run on a remote network using
Trusted Agents.

This right controls the configuration of One-
Step Actions with Trusted Agents, but does
not control a User's ability to view or run
One-Step Actions configured to use Trusted
Agents.

• System
administrators

Can edit One-Step Actions
set to explicitly run under any
Security Group?

Allow: Allows Users to edit One-Step
Actions, regardless of the Security Group
they are configured to run under.

• System
administrators
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Right Description (when selected) Grant To:

Can edit One-Step Actions
set to explicitly run under this
Security Group?

Allow: Allows Users to edit One-Step
Actions if their Security Group is the same
as the Security Group the One-Step Actions
are configured to run under.

• System
administrators

• Managers

• Users

Can set One-Step Actions to
run under any Security
Group?

Allow: Allows Users who create and edit
One-Step Actions to select any Security
Group for One-Step Actions to run under.

• System
administrators

Can set One-Step Actions to
run under this Security
Group?

Allow: Allows Users who create and edit
One-Step Actions to select only their current
Security Group for One-Step Actions to run
under.

• System
administrators

• Managers

• Users

Can a User work with the
Web Service One-Step Action
Action?

Allows people working with Web Service
One-Step Action Actions to:

• View: Access Web Service One-Step
Action Actions.

• Add: Create Web Service One-Step
Action Actions.

• Edit: Edit Web Service One-Step
Action Actions.

• Delete: Delete Web Service One-Step
Action Actions.

Note: The ability to set up and use web
services also requires security rights.

View/Add/Edit Only:

• Advanced Users
(Level 2 and 3
technicians)

All rights:

• System
administrators

One-Step Actions can access
values for fields for which the
Security Group doesn't have
rights?

Allow: Allows One-Step Actions to access
values for Fields even if the Security Group
the One-Step Action is configured to run
under does not have rights to the Field
values.

• System
administrators

Run One-Step Actions for
groups?

Allow: Allows you to run One-Step Actions
against groups of records.

• System
administrators

• Managers
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Outlook Integration Security Rights
Outlook Integration rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Can set the default
configurations for the
system and for Roles?

Allow: Allows selected Users to configure
default Outlook Integration Configurations for all
Users and/or for each Role.

• System administrators

Can a User run the
Outlook integration?

Allow: Allows selected Users to run the Outlook
Add-In within Microsoft Outlook.

• System administrators

• Managers

• Users

Outlook integration
item management?

Allows people working with the Outlook
Integration Manager to:

• View: Access Outlook Integration
Configurations.

• Add: Add Outlook Integration
Configurations.

• Edit: Edit Outlook Integration
Configurations.

• Delete: Delete Outlook Integration
Configurations.

View/Add/Edit Only:

• Users

• Managers

All rights:

• System administrators
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Queues Security Rights
Queues rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Queue Manager?

Rights are organized by
scope: Blueprint, Global,
Role, Team, and User.

Allows people working with the Queue
Manager in the CSM Desktop Client
(Tools>Queues>Queue Manager) to:

• Open: Open the Queue Manager.

• Add: Create Queues using the Queue
Manager.

• Edit: Edit Queues using the Queue
Manager.

• Delete: Delete Queues using the
Queue Manager.

View/Run Only:

• Users

• Managers

All rights:

• System administrators

Queues - remove items?

Rights are organized by
scope: Blueprint, Global,
Role, Team, and User.

Allow: Allows selected Users to remove
items from the Queues of the specified
scope.

• System administrators

• Managers

• Users

Queues - suspend/
unsuspended items?

Rights are organized by
scope: Blueprint, Global,
Role, Team, and User.

Allow: Allows selected Users to suspend/
unsuspend records in the Queue for the
scope.

• System administrators

• Managers

• Users

Can remove items from
other User's Queues?

Allow: Allows selected Users to remove
items from another User's Queue.

• System administrators

• Managers

• Advanced Users (Level
2 and 3 technicians)

User Queue settings?
Allow: Allows selected Users to define User
Queue settings in CSM Administrator
(Settings>Edit user queue settings).

• System administrators

• Managers
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Record Locking Security Rights
Record Locking rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Can edit record
locking
settings?

Allow: Allows selected Uses to configure the Record
Locking settings in CSM Administrator to control how
record locking behaves globally or per Business Object.

• System
Administrators

Global User
lock list?

Allows Users working with the Global Record Locking
Manager in CSM Administrator to:

• View: View Global locks (all locked records for all
Users).

• Delete: Unlock records (all locked records for all
Users).

• System
Administrators
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Reports Security Rights
Reports rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Report styles?

Rights are
organized by
scope: Blueprint,
Global, Role, Team,
and User.

Allows people working with Report styles in
CSM Desktop to:

• View: Access Report styles.

• Add: Create Report styles.

• Edit: Edit Report styles.

• Delete: Delete Report styles.

View/Run Only:

• Users

• Managers

All rights:

• System administrators

Report can be run
against all records
in a system?

Allows people working with Reports to create a
Report that uses all records in the system to
generate the new Report in the Cherwell
Report Wizard.

Note: This is not recommended as there is no
way to tell how many records a table will have
upon generating the Report.

• Users

• Managers

• System administrators

Reports?

Rights are
organized by
scope: Blueprint,
Global, Role, Team,
and User.

Allows people working with Reports in the
CSM Desktop Client, Browser Client, and
Customer Portal to:

• View: Access Reports.

• Run: Run Reports.

• Edit: Edit Reports.

• Delete: Delete Reports.

View/Run Only:

• Users/Customers

• Managers

All rights:

• Advanced Users (Level 2
and 3 technicians)

• System administrators
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Scheduler Security Rights
Scheduler rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Edit Scheduled
Items?

Allow: Allows selected Users to edit Scheduled Items
(example: Scheduled imports or reports).

• System
administrators

Pause/resume
scheduling
service?

Allow: Allows selected Users to pause and resume
Scheduling microservice processing from CSM
Administrator.

Note: The scheduling process will still run, but
no Scheduled Items will execute if processing is
paused.

• System
administrators
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Searches Security Rights
Searches rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected) Grant To:

Can access the Quick
Search Builder?

Allow: Allows selected Users to access to:

• Quick Search Query Builder

• Edit Current Search menu option

• Save Current Search as menu option

• Open Advanced Editor

• Filters menu option (available on
filtered Search results)

Tip: Grant this right to disable Quick
Search features at all levels. You
can then use Perform Searches
rights to enable Quick Search
features at various levels. For
example, you can grant Add rights
to enable Users to create Quick
Searches for specific Roles.

• System
administrators

• Managers

• Users

Can edit searches that
reference fields to which the
User doesn't have rights.

Allow: Allows selected Users to edit
Searches that reference Fields which they
do not have rights to access. Users cannot
view restricted Fields, but Searches can use
them to retrieve data.

• System
administrators

• Managers

• Users

Can run searches that
reference fields to which the
User doesn't have rights.

Allow: Allows selected Users to run
Searches that reference Fields which they
do not have rights to access. Users cannot
view restricted Fields, but Searches can use
them to retrieve data.

• System
administrators

• Managers

• Users

Change Full-Text Search
options?

Allow: Allows selected Users to change Full-
Text Search options for Business Objects
and Fields.

• System
administrators
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Right Description (when selected) Grant To:

Perform Searches?

Rights are organized by
scope: Blueprint, Global,
Role, Site, and Business
Intelligence.

Note: The
Business
Intelligence scope
is available only for
Automation
Processes.

Allows people working with Searches in the
CSM Desktop Client (Searching>Search
Manager) to:

• Run: Run Searches.

• Add: Create Searches.

• Edit: Edit Searches.

• Delete: Delete Searches.

View/Run/Add/Edit Only:

• Users/Customers

• Managers

All rights:

• System
administrators

Perform Full-Text Search? Allow: Allows selected Users to run a Full-
Text Search.

• System
administrators

• Managers

• Users/Customers
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Security Features Security Rights
Security Features rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected ) Grant To:

Advanced system
settings?

Edit: Allows selected Users to edit advanced
system settings.

• System
administrators

Audit log?

Allows people working with the audit log in CSM
Administrator to:

• View: Access the audit log.

• Edit: Edit audit log settings.

• Delete: Delete entries from the audit log.

• System
administrators

Credential
Management?

Allows people working with credentials in CSM
Administrator to:

• View: Access credentials.

• Add: Create credentials.

• Edit: Edit existing credentials.

• Delete: Delete credentials.

View/Run Only:

• Users

• Managers

All rights:

• System
administrators

In a Portal, can
request a license to
edit records owned
by other Users?

Allow: Allows selected Users to request a license to
edit records owned by other Users. • Managers

License products? Allow: Allows selected Users to provide Cherwell
licenses into the system.

• System
administrators

Lock system so
Users cannot log in?

Allow: Allows selected Users to lock the CSM
system so that Users cannot log in (ex: During
scheduled maintenance).

• System
administrators
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Right Description (when selected ) Grant To:

Publish log?

Allows people working with Blueprint publish logs
to:

• View: Access logs in order to publish.

• Delete: Deletes previous publish logs.

• System
administrators

REST API client
management?

Allows users working with Rest API client keys to:

• View: Access client keys.

• Add: Create client keys.

• Edit: Modify client key settings.

• Delete: Delete client keys.

• System
administrators

Role management?

Allows people working with Roles to:

• View: Access Roles.

• Add: Add Roles.

• Edit: Edit existing Roles.

• Delete: Delete Roles.

• System
administrators

Run the
Administrator tool?

Allow: Allows selected Users to run the CSM
Administrator.

• System
administrators

SAML Cherwell
Service Provider
settings?

Edit: Allows selected Users to edit the service
provider settings to configure CSM as a SAML
Service Provider.

• System
administrators

SAML Identity
Provider settings?

Edit: Allows Users to edit the identity provider
settings to configure the SAML Identity Provider.

• System
administrators

Security group
management?

Allows people working with Security Groups in
CSM Administrator to:

• View: Access Security Groups.

• Add: Add Security Groups.

• Edit: Edit existing Security Groups.

• Delete: Delete Security Groups.

• System
administrators
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Right Description (when selected ) Grant To:

Security settings?

Allows people working with Security settings in
CSM Administrator to:

• View: Access the Security settings.

• Edit: Edit the Security settings.

• System
administrators

System settings? Edit: Allows selected Users to edit default system
settings in CSM Administrator.

• System
administrators

Team management?

Allows people working with Teams in CSM
Administrator to:

• View: Access Teams.

• Add: Add Teams.

• Edit: Edit existing Teams.

• Delete: Delete Teams.

• System
administrators

Twitter Account
Management?

Allows people working with their Twitter account in
CSM Administrator and the Desktop Client to:

• View: Access affiliated Twitter accounts.

• Add: Add Twitter accounts.

• Edit: Edit existing Twitter accounts.

• Delete: Delete Twitter accounts.

View/Add/Edit Only:

• Advanced Users
(Level 2 and 3
technicians)

• Managers

All rights:

• System
administrators

Unlock a system
that has been
locked?

Allow: Allows selected Users to unlock a system
that has been locked.

• System
administrators

View logged-in
Users?

View: Allows selected Users to view logged-in
Users.

• System
administrators

• Managers
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Sites Security Rights
Sites rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

View rights are only used for Sites that require login.

Right Description (when checked ) Grant To:

Default rights?

View: The default view rights assigned to any site when the
security group does not explicitly specify view rights.

Note: This does not apply to sites that do not require a login
(anonymous sites and browsers).

Customers

For each defined Site (ex:
CompanyHomepage)?

Allows Customers working in the CSM Portal to:

• View: View the Site.

• Use Default: Uses the same security rights set for the
Default Sites rights (above).

Note: This can also be conditional upon information in the
Customer's record. For example, access can be limited to
only full-time employees.

Customers
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Sites Manager Security Rights
Sites Manager rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Sites Manager?

Allows people working with the Sites Manager:

• View: Access the Sites Manager.

• Add: Create items in the Sites Manager.

• Edit: Edit items in the Sites Manager.

• Delete: Delete items from the Sites Manager.

• System administrators
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Stored Expressions Security Rights
Stored Expressions rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Stored Expressions?

Rights are organized
by scope: Global,
Role, and User.

Allows people working with Stored
Expressions in CSM Administrator and the
Desktop Client to:

• View: Access and use Stored
Expressions.

• Add: Create Stored Expressions.

• Edit: Edit Stored Expressions.

• Delete: Delete Stored Expressions.

• System administrators

• Managers

• Advanced Users (Level
2 and 3 technicians)

Notes:
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Stored Values Security Rights
Stored Values rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Stored Values?

Rights are organized
by scope: Global,
Role, Team, and User.

Allows people working with Stored Values in
CSM to:

• View: Access and use Stored Values.

• Add: Create Stored Values.

• Edit: Edit Stored Values.

• Delete: Delete Stored Values.

• System administrators

• Managers

• Users
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System Blueprints Security Rights
System Blueprints rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Create System
Blueprints?

Allow: Allows selected Users to create
System Blueprints in CSM Administrator. • System administrators

View details of current
Field when in
application?

Allow: Allows selected Users to view the
details of the current Field in CSM
Administrator.

• System administrators

• Advanced Users (Level 2
and 3 technicians)

Publish System
Blueprints?

Allow: Allows selected Users to publish
System Blueprints in CSM Administrator. • System administrators
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System Settings Security Rights
System Settings rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected ) Grant To:

Can choose a
custom form when
configuring the
Create New
Command from the
Command
Selector?

Allow: Allows selected Users to choose a custom
form when configuring the Create New Command
from the Command Selector.

ex: When creating Portal menus, Users can define a
Create New command that runs a One-Step Action
before or after creating the object and also have an
alternate form be displayed instead of the main form.
This is useful to create a custom New Incident form
that is different for different types of requests.

• System
administrators

Can clear Role
settings?

Allow: Allows selected Users to clear settings and
remembered information (ex: toolbar and window
positions) for a particular Role or all Roles in CSM
Administrator.

• System
administrators

• Managers

• Users

Can configure
definition for
custom toolbars for
Roles?

Allow: Allows selected Users to create custom
toolbars for Roles.

• System
administrators

• Managers

Can configure
definition for Task
Panes for Roles?

Allow: Allows selected Users to create custom Task
Panes for Roles.

• System
administrators

• Managers

Can configure
global definition for
custom toolbars?

Allow: Allows selected Users to create Global
toolbars.

• System
administrators

• Managers

Can configure
global definition for
Task Panes?

Allow: Allows selected Users to create Global Task
Panes.

• System
administrators

285

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Right Description (when selected ) Grant To:

Group maps?

Allows people working with Group Maps in CSM
Administrator? to:

• View: Access Group Maps.

• Add: Create Group Maps.

• Edit: Edit existing Group Maps.

• Delete: Delete Group Maps.

• System
administrators

Stored Field
formats?

Allows people working with Stored Field formats (ex:
Telephone numbers, zip codes) in CSM Administrator
to:

• View: Access Stored Field formats.

• Add: Add Stored Fields?

• Edit: Edit existing Stored Field formats?

• Delete: Delete Stored Field formats?

• System
administrators

Views?

Allows people working with the View Manager to:

• View: Access the View Manager.

• Add: Create Views.

• Edit: Edit Views.

• Delete: Delete Views.

• System
administrators
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Theme Security Rights
Themes rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Theme
management?

Allows people working with the Theme Manager in CSM
Administrator (Create a Blueprint>Managers>Themes) to:

• View: Access the Theme Manager.

• Add: Create Themes.

• Edit: Edit Themes.

• Delete: Delete Themes.

• System
administrators
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Third-party Chat Integration Security Rights
Third-party chat integration rights are granted from the Category drop-down on the Rights tab (CSM
Administrator > Security > Edit Security Groups.

Right Description (when selected ) Grant to:

Can manage chat
settings?

Allow: Allows users to edit chat configuration
settings in CSM Administrator. System administrators.

Chat conversations?

• View: Allows users to view existing chat
conversations.

• Add: Allows users to add existing chat
conversations.

Users who will participate
in existing chat
conversations.

Create new chat?
Allow: Allows users to create a new chat
conversation or channel and add other users to
the conversation.

Users who will create new
chat conversations.

Store chat history? Allow: Allows users to store conversations in
Business Object records.

Users who participate in
chat conversations.

Related information
Related Item Navigation
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Tools Security Rights
Tools rights are selected from the Category drop-down list on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Tools include:

• Health Check.

• System Analyzer.

• Trusted Agents

• Client-side Logger.

Right Description (when selected ) Grant To:

Change client-
side logger
settings?

Allow: Allows selected Users to change Client-side
logger settings in the CSM Desktop Client
(Tools>Options>Other).

• System
administrators

Configure Trusted
Agents?

Allow: Allows Users to set Trusted Agent configuration
options in CSM Administrator.

• System
administrators

Manage
encryption keys
via Server
Manager?

Allow: Allows selected Users to manage (add and edit)
encryption keys for servers and web applications
using the Server Manager.

• System
administrators

Run Health
Check?

Allow: Allows selected Users to run the Health Check
in CSM Administrator.

• System
administrators

Run System
Analyzer?

Allow: Allows selected Users to run the System
Analyzer in the CSM Desktop Client.

• System
administrators
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Users Security Rights
Users rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Can clear User
settings?

Allow: Allows selected Users to clear User
settings and remembered information
(example: toolbar and window positions).

• System administrators

• Advanced Users (Level
2 and 3 technicians)

Can set password reset
options?

Allow: Allows selected Users to set password
reset options in CSM Administrator. • System administrators

Change password? Allow: Allows selected Users to change their
passwords.

• System administrators

• Managers

• Users/Customers

Change User ID? Allow: Allows selected Users to change a
CSM User's Login ID. • System administrators

Change Windows ID? Allow: Allows selected Users to change a
CSM User's Windows ID. • System administrators

Import Users from
Windows?

Allow: Allows selected Users to import Users
into CSM from Windows. • System administrators

Lock/unlock User
Accounts?

Allow: Allows selected Users to lock or
unlock User accounts. • System administrators

Can see logged in/out
data for other Users/
Customers (via the
User Data
Expression)?

Allow: Allows selected Users to see login/
logout information for other Users or
Customers using the User/Customer Data
Expression.

• System administrators

• Managers

• Users
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Right Description (when checked ) Grant To:

User management?

Allows selected Users who are working with
User accounts in CSM Administrator to:

• View: Access User accounts.

• Add: Create new Users.

• Edit: Edit existing Users.

• Delete: Delete Users.

• System administrators
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Visualizations Security Rights
Visualizations rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Visualizations?

Rights are organized by
scope: Blueprint, Global,
Role, Site, Team, and User.

Allows people working with Visualizations
to:

• View: Access Visualizations.

• Add: Create Visualizations.

• Edit: Edit Visualizations.

• Delete: Delete Visualizations.

View/Run Only:

• Users/Customers

View/Add/Edit

• Managers

All rights:

• System administrators
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Webhooks Security Rights
Webhooks rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when selected ) Grant To:

Allow Users to
manage webhooks?

Allow: Allows selected Users to view, add, edit,
and delete webhooks in CSM Administrator. • System administrators

Related concepts
About Webhooks in CSM
Manage Webhooks
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Web Services Security Rights
Web Services rights are selected from the Category drop-down on the Rights tab (CSM
Administrator>Security>Edit Security Groups).

Right Description (when checked ) Grant To:

Allow calling
Web Services
from client
machine (if
allowed by
system)?

Allow: Allows selected Users to call web services
(using a Call a Web Service Action in a One-Step
Action) from a client machine as opposed to having
the server make the call. You can select to have all
web service calls forced to the server (CSM
Administrator>Edit System Settings>Advanced).

Note: The global settings for web services must be set
to allow calling from a client based on security.

• System administrators

• Managers

• Users

Web Services?

Rights are
organized by
scope: Global,
Role, Team, and
User.

Allows people working with web services in CSM
Administrator and the CSM Desktop Client to:

• View: Access web services.

• Add: Create web services.

• Edit: Edit web services.

• Delete: Delete web services.

View/Add Only:

• Users/Customers

View/Add/Edit Only:

• Managers

All rights:

• System administrators
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Authentication Methods
CSM provides four methods for authenticating users: internal, LDAP/Active Directory, Security Assertion
Markup Language (SAML), and Windows credentials.

You can enable multiple login modes so that if one authentication fails or the user/customer cancels the
process, the next configured login method is invoked (example: SAML, then external authentication
server, then LDAP, then Windows, then Internal). Not all of these options will necessarily be configured in
your system.

• Internal
CSM authenticates using the login ID and password that is defined in either CSM Administrator or
CSM Desktop Client.

◦ In the CSM Administrator User Profile, select Security > Edit Users.

◦ In the Desktop Client, first select Customer > Contact Manager, select a customer, and then
select Customer > Portal Settings > Current Customer Credentials.

Note: Users must type CHERWELL\ in front of the user name (example: CHERWELL\Bob).
For more information, see Define the Default Domain and Anonymous Login Settings.

• LDAP/Active Directory

CSM authenticates login credentials stored in a Directory Service such as LDAP or Active Directory.
Depending on configuration, user/customer data can be imported based on LDAP data.

• SAML

Allows SAML authentication.

• Windows

CSM authenticates using Windows login credentials.

Related concepts
Create a Customer Record
Windows Credentials
Directory Services
SAML
Related tasks
Create a User Profile
Configure Login, Authentication, and Inactivity Settings for Each Client

295

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=define_the_default_domain_and_anonymous_login_settings
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fshared%2Fcreate_a_customer_record.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fshared%2Fuse_windows_credentials.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fdirectory_services%2Fdirectory_services__02.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fcsm_intergrations%2Fsaml.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fshared%2Fcreate_a_user_profile.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fauthentication%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fconfigure_login-_authentication-_and_inactivity_settings_for_each_client.html


Windows Credentials
If enabled, CSM can use Windows/LDAP credentials to authenticate users and customers.

To use Windows credentials:

• Windows or Active Directory must be enabled for each Client in CSM Administrator. Navigate to
Security > Edit security settings, select Desktop Client, Browser Client, or Browser Portal, and
finally select Windows or LDAP as the login mode. See Configure Login Authentication for Each
Client.

• The Windows login ID must be provided for each sser's CSM. See Create a User Profile or Create a
Customer Record.

Note: In the CSM Desktop Client, Windows credentials are automatically used, if enabled. In
Internet Explorer, the CSM Browser Client can automatically retrieve the user's/customer's
credentials from the system and pass them to the server. In other browsers, users and customers
might be prompted to provide Windows credentials. The browser validates the credentials before
passing them to the server. If users or customers have previously provided credentials to the
browser, they might not be prompted to provide their credentials.

If users or customers are not currently logged in to their standard Windows system (example: they are
logging in from a mobile device or from outside the network), or their system is configured to use an
alternate LDAP provider that does not provide direct Windows validation, they can still use their Windows/
LDAP Credentials for single sign-on.

Users and customers provide their Windows (or LDAP) credentials in the User Name field and their
Windows (or LDAP) credentials in the Password field. When the Login button is selected, CSM confirms
that the specified credentials are valid, and if so, logs the user or customer in.

Note: User/customer must specify a fully qualified ID in the format domain\user-id.

CAUTION: HTTPS is the recommended protocol for production environments. When HTTP is
used instead, credentials are visible when they are passed from the browser to the server and
may pose security risks.

Related concepts
Create a Customer Record
Related tasks
Configure Login, Authentication, and Inactivity Settings for Each Client
Create a User Profile

296

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_login-_authentication-_and_inactivity_settings_for_each_client
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_login-_authentication-_and_inactivity_settings_for_each_client
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_user_profile
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_customer_record
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_customer_record
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fshared%2Fcreate_a_customer_record.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fsystem_administration%2Fsecurity%2Fconfigure_login-_authentication-_and_inactivity_settings_for_each_client.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fshared%2F..%2F..%2Fcontent%2Fshared%2Fcreate_a_user_profile.html


Use the Windows Login for the CSM Portal
The WinLogin clause is an addition to the CSM Customer Portal URL that allows the system to
automatically log customers in with their Windows credentials.

Normally, customers access the CSM Portal with a URL like this:

http://MyServer/CherwellPortal

This URL redirects automatically to the default CSM Portal site, such as:

http://MyServer/CherwellPortal/IT

Customers can also go directly to a particular CSM Portal site:

http://MyServer/CherwellPortal/SomeSite

Depending on the configuration of the site, customers might then be prompted to log in, or they might
have to select the Login link to be prompted for credentials. However, if the WinLogin clause is added to
the URL (example: http://MyServer/CherwellPortal/WinLogin/IT), the system attempts to automatically log
customers in using their Windows credentials, and then take them to the startup page. Note that, if the
credentials are not legal, an error message is displayed.

Note: Using a URL with the WinLogin clause is equivalent to going to the CSM Portal, selecting
Login, and then selecting Use Windows Login.

Related concepts
Windows Credentials
Related tasks
Configure Login, Authentication, and Inactivity Settings for Each Client
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Directly Provide Windows/LDAP Credentials
If users/customers are not currently logged in to their standard Windows system, they can still use their
Windows/LDAP credentials for single sign-on.

For example, if users/customers have logged in from a mobile device or outside their network, or their
system is configured to use an alternate LDAP provider that does not provide direct Windows validation,
they can still use their Windows/LDAP credentials for single sign-on.

Users/customers can provide their Windows (or LDAP) credentials in the User Name field and Windows
(or LDAP) credentials in the Password field. When the Login button is selected, CSM confirms that the
specified credentials are valid, and then logs the user/customer in to the system.

Note: The user/customer must specify a fully qualified ID in the format domain\user-id.

CAUTION: HTTPS is the recommended protocol for production environments. When HTTP is
configured, credentials are visible when they are passed from the browser to the server and may
pose security risks.
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Directory Services
You can authenticate Users from a Directory Service such as LDAP or Active Directory.

Related concepts
Windows Credentials
SAML
Create a Customer Record
Related tasks
Configure Login, Authentication, and Inactivity Settings for Each Client
Create a User Profile
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About Directory Services
On the General Options page of the Map an Object window, the Directory Service drop-down list shows
a complete list of available vendors.

The following list of vendors are available:

• Active Directory Domain Service (Microsoft)

• LDAP: Generic and OpenLDAP (open source implementation)

• eDirectory (NetIQ)

• IBM Tivoli Directory Server

• iPlanet Directory Server

• Netscape Directory

Note: After a particular vendor is chosen, CSM displays that name (example: Active
Directory) throughout the system.
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User Mapping Wizard Field Information
The User Mapping Wizard is used in all directory services to map the CSM User Business Object and
user information to the directory service object that represents users. LDAP is used in this example, but
the information is the same for any type of directory service.

To open the User Mapping Wizard, log in to CSM Administrator, navigate to Create a New Blueprint >
Tools > Directory Services, and edit the desired service. Select Users in the left navigation pane, and
then select the Wizard button.

The Wizard automatically maps CSM fields to directory service fields. The Wizard also creates some
common fields. Since fields in the directory service standard are sometimes cryptic, CSM assigns more
obvious names to them. For example, the co field in LDAP holds the name of the country, so CSM calls
its field Country.

The Map LDAP Object page is where objects are selected to map to each other. Select the Add button to
see all of the directory service fields that were not mapped and add any additional fields. There no
maximum number of fields allowed. Select the Delete button to remove any fields that are not necessary.

Note: Be sure to map the field that holds the user ID of each LDAP user. This field is needed to
synchronize when a re-import is done for users.

• Cherwell Service Management Business Object: Shows the name of the CSM User Business
Object that holds the LDAP data.

• LDAP object: The name of the LDAP object that is mapped to a CSM Business Object.

Active Directory uses the User object to hold user information. The LDAP standard uses
INetOrgPerson to hold user information. Each vendor may have its own name that it uses for the
INetOrgPerson object.

• Additional Filters on User: The filter limits the search results to the specified path and filters. For
example, set filters to show only active users, only users with an email attribute, and more. To set up
additional filters, select the Add button. The Add Filter window opens.

The Filter window offers three types of filters:

◦ Filter for attribute that equals a certain value: Filters on an attribute that has a particular
value.

◦ Enter a custom filter string: Filter LDAP directly. For example: (&(objectClass=user)
(objectCategory=person)(!userAccountControl:1.2.840.113556.1.4.803:=2))

◦ Special Filters: Choose special filters that CSM provides for certain objects.
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Integration with Directory Services Workflow
You can configure the integration between CSM and a directory service. Most configuration procedures
are completed in CSM Administrator.

Note: CSM provides a directory service with example settings selected. Use the Directory
Services Worksheet to access the required configuration values that are specific to an
organization.

Using a directory service with CSM consists of both configuring Users and Customers, as shown in the
figure.
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To configure the LDAP integration:

1. Configure CSM Directory Service settings
a. Configure users for Directory Services.

i. Enable authentication for users

b. Configure customers for Directory Services.
i. Enable authentication for customers

2. Use the Test LDAP tool. This tool is only available for LDAP connections.
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Configuring CSM Directory Services Settings
Use the Directory Services window in CSM Administrator to configure a directory service.

Before authentication can be set up, the Directory Services Settings window must be completed. This
process is the same for configuring both Users and Customers. For example, the CSM User Business
Object must be mapped on the Users page.

To configure a directory service:

1. In the CSM Administrator main window, select the Blueprints category, and then select the Create
a new Blueprint task.

2. In the menu bar, select Tools > Directory Services (Active Directory, LDAP).
3. In the Directory Services (Active Directory, LDAP, etc.) window, select Add to set up a new directory

service.

The Map LDAP Object window opens.

4. In the Directory Service drop-down list, select the directory service (example: Active Directory or
LDAP). The name of the Map LDAP Object window updates with the name of the new directory
service.

5. Select the options in the left navigation pane to define properties on the General, Schema, Users,
Groups, and Trusted Agents pages.

Note:
◦ The Groups page is available only when users are allowed to log in to the system

and/or when users are allowed to be imported into the system. These settings are
available on the Users page.

◦ The Trusted Agents page is available only when Trusted Agents are configured for the
CSM system.

Related concepts
Configuring Trusted Agents
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Define General Directory Service Properties
The General page in the Map Object window in a Blueprint includes options for general information,
settings for Security, Configuration, and Searching, and a series of check boxes for mapping options.

To define General properties:

1. Open the Map Object window.

2. Select the General page.

3. Define General properties.

4. Define Security properties.

5. Define Configuration properties.

6. Define Use Paged Searching properties.

7. Define the Miscellaneous properties.

General Properties

• Name: The name of the service.

• Directory Service: The type of directory service.

• Domain: The domain name of the network.

• Server: The host name of the LDAP directory server.

Note: If you are using Secure LDAP (LDAPS), specify the host name of the SSL/TLS
certificate used by your LDAP directory to establish a secure connection. If your certificate is
self-signed or from a non-standard Root CA, you may need to install the certificate on the
machines that are connecting directly to the LDAP directory. This may include your CSM
Application Servers and machines running the CSM Administrator and CSM Trusted Agent
Server if they directly connect to the LDAP directory.

Security Properties

• Authentication type: The type of authentication required to access LDAP.
◦ No Encryption: No login is required and all data is transferred in plain text.

◦ Basic: User ID and password are required, but no confidentiality is provided. Data is
transferred in plain text.

◦ Secure: User ID and password is authenticated through NTLM or Kerberos, depending on the
service selected. The data between LDAP and CSM is not encrypted.

◦ SSL: User ID and password are required and data between LDAP and CSM is encrypted. This
changes the path to LDAP and the default port to 636.
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• Search User ID: The User ID used for all LDAP searches. The User ID can be set in a variety of
formats:

◦ Windows Only: domain\user, user@domain, cn=user.dc=company.ddc=com

◦ Other: cn=user.ou=company.c=US.

Tip: Select the question mark to see the list of valid formats. Ask an LDAP
administrator which format is used at a specific organization.

◦ Search Password: The password assigned to the User ID.

Configuration Properties

• Port: The standard LDAP ports are 389 and 636 (secure LDAP). If unsure of the port number, try
these two first.

• RootDSE Path: The RootDSE is the root of the LDAP directory server. Some examples are:
◦ LDAP://192.168.0.123/RootDSE

◦ LDAP://192.168.0.123:389/RootDSE (when port number is included)

◦ LDAP://ServerName/RootDSE

Note: If you are using any port besides 389, type the port number in the RootDSE path
(example: LDAP://www.mycompany.com:389/RootDSE).

• Schema Path: The schema contains a definition of all of the objects on the LDAP server (User,
Group, etc.).
The easiest way to set up the schema path is to select the Locate button. Before doing this, go to
the Security section on the General properties page and verify that the encryption type, User ID,
and password are set up. When the RootDSE and security information is entered, CSM
Administrator should be able to find the schema. If the schema is not found, Users should ask an
LDAP administrator for assistance.

Some common schema paths include:

◦ LDAP:// 192.168.0.123/CN=Schema,CN=Configuration,DC=Cherwell,DC=com

◦ LDAP://ServerName/CN=Schema,CN=Configuration,DC=Cherwell,DC=com
(these are the formats used by Active Directory)

◦ LDAP://192.168.0.123/cn=schema

◦ LDAP://www.mycompany.com/cn=Subschema

◦ LDAP://www.openldap.com:389/cn=Subschema

• Search Start: This is the location where LDAP searches begin. Using only the server location can
slow the data transfer. Enter a path more specific to the location of the data to increases data-
transfer efficiency. For example, to search for only Users in Colorado Springs the path might be:
LDAP://Cherwell/DC=ColSpgs,DC=Cherwell,DC=Com
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Tip: DC stands for domain context (used by Microsoft computers with domains). The LDAP
standard also suggests some prefixes that are used by most vendors – OU (Organizational
Unit), O (Organization), CN (Common Name), and C (Country). The prefixes are case
insensitive.

More examples include:
◦ LDAP://Cherwell/OU=ColSpgs,DC=Cherwell,DC=com

◦ LDAP://192.168.0.123/ou=Administrators,ou=TopologyManagement,o=NewspapeRing

◦ LDAP://ServerName/O=Cherwell,c=US

◦ LDAP://www.mycompany.com/o=Cherwell

◦ LDAP://www.mycompany.com /dc=site

• Follow Server Referrals: Data can be stored on multiple LDAP servers. Selecting this check box
allows the initial-contact server to continue searching for data beyond the initial server to secondary
servers for information. Users should consult an LDAP administrator or IT staff member to verify if
this should be selected.

Note: Allowing referral services can cause delays during data transfer.

Page Searching Properties
The Use Paged Searching option is recommended because it allows you to set the maximum page size
and server time limit. Using paged searching increases the speed of searching by grouping search results
into pages set by the Max page size limit. The time limit is set so that the server stops searching after the
entered time if there are no results to the search.

Recommended settings: Max page size - 100; Server Time Limit - 120 seconds.

Note: Some vendors do not support this functionality. Select Test Paged Search to see if the
feature is supported.

Miscellaneous Options

• Allow Business Objects to be mapped to objects: Select the check box to map CSM Business
Objects to Active Directory Objects.

• Allow Business Objects to be imported from data: Select the check box to import Active
Directory data into CSM.

• Client-Side LDAP (for SaaS): When using an application server and a 3-tier connection, select the
check box to allow data to be shared from CSM to LDAP without going through the Cherwell
Application Server. Do not select this check box unless specifically directed.

Related concepts
Default Port Numbers
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Define Directory Service Schema Properties
The Schema page (in the Map LDAP Object window) is where Users set the Schema Attributes, and the
page is used to map directory service objects to CSM objects. The schema contains the structure of all
objects stored in a directory service.

To define Schema properties:

1. Open the Map LDAP Object window.

2. Select the Schema page.

3. Select the Save schema first time it is read in check box.

4. Define the following Schema Attributes:

Save schema
first time it is
read in

The field in schema objects that contains the ID. When selected, the LDAP
schema is cached the first time an LDAP-mapped Business Object is created.
This improves performance because mappings can be done without accessing
the LDAP server.

ID The ID attribute.

Path The field in schema objects that holds the path to an object. Microsoft calls this
field distinguishedName.

Attributes that
Hold Name

The standard has several fields that can be used to hold a name – cn (common
name), ou (organizational unit) and o (organization). Active Directory adds
name. Have the most commonly used name at the top (name for Active
Directory and cn for other vendors).

◦ Select the Add button to add attributes.

◦ Select an attribute, and then select Delete to un-associate the attribute.

◦ Use the arrows to order the attributes.
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Define Directory Service Users Properties
The directory service Users page (in the Map LDAP Object window in a Blueprint) maps CSM users to
LDAP Users. Once the mapping is done, users log in using a Directory Service authentication and/or are
imported directly into CSM.

To define Active Directory users:

1. Open the Map LDAP Object window.

2. Select the Users page.

3. Define the users properties.

Allow LDAP Users
to Login to the
System

Use LDAP authentication when users log in.

Note: In CSM Administrator, go to the Security page, select the
Edit System Settings and the LDAP check boxes under
Supported Login Modes.

Allow Users to be
imported

Import users directly into CSM. To import users, open CSM Administrator
and select Database > Import from LDAP.

Wizard

Opens the Wizard to map Active Directory fields to CSM Business Object
Fields. If LDAP fields change in the future, use the Add, Edit, and Delete
buttons to modify the field mappings.

Note: For more information about how to use filters, refer to User
Mapping Wizard.

Name of Active
Directory User
Class

Specify the ObjectClass attribute of users.

Field that Holds
User ID

After the Wizard, select the field that holds the User ID for each LDAP user.
This is used for synchronization when users are re-imported.

Start of User
Searches

Specify the path where user searches should start or provide the same path
specified for Search Start on the General page.

Note: LDAP searches can be slow, it is best to pick the LDAP
directory that contains all of the users and provide that path. Select
the Test button to verify the directory specified is correct.
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Additional Filters
When Pulling
Active Directory
Data:

Select Add to open a window to add additional criteria that are applied to
LDAP objects when an import is done.
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Define Directory Service Groups Properties
If the Allow LDAP Users to login to the system or Allow LDAP Users to be imported check boxes are
selected on the Users page, then the Groups page option is shown on the Map Object window.

The group information is used to associate LDAP Users with a CSM Security Group.

For options with Browse, select the Browse button to verify the object is available, even if the group name
is known. If the object is not there, Users should ask an LDAP administrator if a security setting is
preventing it from being shown.

To define the LDAP Groups:

1. Open the Map Active Directory Object window.

2. Select the Groups page.

3. Define the Groups properties.

Name of Group
Object

The name of the directory service object that holds group information. In
directory services, this is called Group. Select the Browse button to see the
list of objects available.

Location of
Group
Membership

The standard has two options that Users can be associated with a group.
Many vendors allow both methods.

◦ The User object holds the name of the group.

◦ The Group object holds a list of group members (Users).

If both options are available, select User object holds name of group
member. LDAP authentication is faster if this method is used.

Start of Group
Searches

The Wizard button maps directory services fields to CSM Business Object
Fields. If directory service fields change in the future, use the Add, Edit, and
Delete buttons to modify the field mappings.

Note: For more information about how to use filters and run the
wizard, refer to User Mapping Wizard.

Name of Active
Directory User
Class

Specify the ObjectClass attribute of Users.

Field that Holds
User ID

After the Wizard is run, select the field that holds the User ID for each
directory service User. This is used for synchronization when Users are re-
imported.
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Start of User
Searches

Provide the path where group searches should start. The same path entered
for Search Start (on the General page) can be used.

Although LDAP searches can be slow, pick the LDAP directory that contains
all groups and enter that path. Select the Test button to confirm the directory
is correct.

Test Select Add to provide additional criteria that are applied to LDAP objects
when an import is done.
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Define Trusted Agents Properties for Directory
Services

Use the Trusted Agents page to assign the Active Directory connection to a Trusted Agents Group. This
scenario is used to scale out Trusted Agents for request routing.

To assign service groups to a connection, you must first:

1. Configure Trusted Agents.

2. Connect to the Trusted Agents Hub from CSM Administrator.

3. Configure Trusted Agents Service Groups.

For more information, see Scaling Trusted Agents for Request Routing.

To define Trusted Agents properties:

1. Open the Map LDAP Object window.

2. Select the Trusted Agents page.

3. Select the Use Trusted Agents check box.

4. Select one of these options:
◦ Any Trusted Agent Group: Allows any group to handle requests for this Active Directory

connection.

◦ Trusted Agent Group: A specific group to handle requests for this Active Directory
connection.
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Workflow for Configuring Users for Directory
Services

The process to configure Users in CSM to integrate with Directory Services differs slightly from
configuring Customers. Complete the steps for Configuring CSM Directory Services Settings before
configuring Users.

To configure Users:

1. Map Directory Service Groups to CSM Security Groups.

2. Order Directory Service Groups.

3. Enable Authentication for Users.

4. Import Users:
◦ If Groups are mapped, the account is created when Users log in to Cherwell using their Active

Directory/LDAP credentials.

◦ If Groups are not mapped, or the Users are entered manually, accounts are imported using the
User Manager in CSM Desktop Client.
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Map LDAP Groups to CSM Security Groups
When users log in to CSM, the assigned security rights are based on the CSM Security Group. For LDAP
users, security rights are assigned only in an Active Directory Group. Active Directory Groups must be
mapped to CSM Security Groups.

Use the Security Groups window to define:

• The Security Groups for LDAP Groups

• The order of Security Groups

To map LDAP Groups to CSM Security Groups:

1. In the CSM Administrator main window, select Security > Edit security groups.

2. Select the Users tab on the Security Groups window (the directory service must be configured in the
database).

3. Select Order groups. If no groups are shown in the Groups section, select Add to open the
Associate LDAP Groups window.

4. To show available groups. provide a group or set of characters in the text field, and select Search.

5. Select the groups that should be associated with this CSM Security Group and select OK.

The window closes and the group appears in the Associated LDAP Groups section of the Security
Groups window.

Tip: If the LDAP Groups are not visible, go to the Map LDAP Object window and select the
Groups page to verify the Search Start settings.

Related concepts
Order Directory Service Groups
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Order Directory Service Groups
Once all directory service Groups are associated with CSM Security Groups, the groups need to be
ordered.

Users can belong to more than one directory service Group, so CSM requires groups to be ordered. This
ensures the correct directory service Group is used for the User’s CSM Security Group.

For example, Joe belongs to the Administrators and Developers Groups. When he logs in to CSM, he is
assigned to the Security Group that is associated with Administrators. He is assigned to that group
because the Administrators Group has the most rights out of the list.

To order directory service Groups:

1. In CSM Administrator, select Security > Edit security groups > Users > Order groups to open
the Order LDAP Groups window.

2. Select the arrows to order the directory service Groups.

Note: Put the Directory Service Groups in the order they should be verified when picking the
associated CSM Security Group.

3. Select OK.
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Enabling LDAP Authentication for Users
Before a directory service can work with CSM, LDAP must be enabled as a supported login mode in CSM
Security Settings.

Regardless of the type of directory service being used, the selections for this setting all refer to LDAP in
the user interface.

Note: LDAP authentication does not fall back to Windows authentication if LDAP authentication is
unsuccessful. Enable Windows authentication to verify credentials with a Windows domain using
native Windows APIs.

To enable LDAP authentication:

1. In the CSM Administrator main window, select Security > Edit security settings.

2. In the Security Settings window, select Desktop Client.
3. Under Supported login modes, select the LDAP check box.

4. Select OK.
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Import Directory Service Users
To import Directory Service Users, ensure that Windows login is allowed in CSM. Enable Windows login in
the CSM Administrator.

If Security Groups are already configured, importing Users is not necessary, as Users are added to the
system when they log in.

Use the Import Users window to define:

• Directory service to import

• Users to import

• Default domain

• Security Group to assign to imported Users

• LDAP Key field

To import Users:

1. To open the User Manager in CSM Administrator, select Security > Edit Users.

2. In the toolbar, select the Import Users button .

3. In the Import Users window, select the Directory Service Users radio button and provide the
following User information:

◦ LDAP Directory Service: Select the created LDAP Blueprint in the list.

◦ Starts With: Leave blank or provide a few characters to narrow the search, and then select
Search to see a list of all LDAP Users.

◦ Default domain: Provide the domain that the imported Users belong to and select a default
domain-option radio button.

◦ Security Group for imported Users: Select the CSM Security Group in the list.

Tip: If the LDAP Users are not shown, go to the Map LDAP Object window. Select the
Users page to verify the Search Start setting.

◦ LDAP Key Field: Select the Key Field for the LDAP import in the list.

4. Select OK.
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Import Active Directory Image Data into CSM
The Active Directory import allows images to be added to a User or Customer Internal Business Objects
in CSM by mapping the fields to an Active Directory image attribute.

To import Active Directory image data into CSM:

1. In the CSM Administrator main window, select Create a new Blueprint.
2. In the Object Manager, verify that the Major radio button is selected.

3. Select Customer > Customer-Internal.

Note: This process can also be done on the User-Info Lookup table Object for Users.

4. Select the Edit Business Object task to open the Edit Customer - Internal Business Object Group
Member page.

5. Select the Bus Ob Properties button.

6. Select the Active Directory page.

7. Select Add to open the Map Active Directory Field window.

8. Under User Attributes, select the Active Directory attribute that holds the image. The default
attribute is thumbnailPhoto.

9. Select Add.

10. Select the attribute for the image in the Map Active Directory Field window.

11. Select the Existing field radio button, and select Avatar.
12. Select OK.
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13. Select Object Manager in the Blueprints task pane.

14. Select the Lookup tables radio button.

15. Select UserInfo.

16. Select the Edit Business Object task.

17. Select the Bus Ob Properties button.

18. Select the Active Directory page.

19. Select Add to open the Map Active Directory Field window.

20. Under User Attributes, select the Active Directory attribute that holds the image.
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21. Select the Existing field radio button, and select Avatar.
22. Select OK.

23. Save and publish the Blueprint.
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Workflow for Configuring Customers for Directory
Services

The process to configure Customers in CSM to integrate with Directory Services differs slightly from
configuring Users.

Complete the steps for Configuring CSM Directory Services settings before configuring Customers.

To configure Customers for LDAP:

1. Map the CSM Customer Object to a Directory Service (this can be used for any Business Object).

2. Enable Authentication for Customers.

3. Import Directory Service Data into the Customer Business Object using the Import Data Wizard or a
Scheduled LDAP Import Action.

4. Batch Updating Customer Credentials after the Customer records are imported.
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Map the CSM Customer Object to a Directory
Service

After the General properties window is complete, map Customers to the CSM Business Object.

Use the LDAP Mapping Wizard to define:

• Directory services

• Group information

• Business Objects to use LDAP data

• Fields to map to LDAP attributes

To map a CSM Business Object to Directory Service objects:

1. In a newly created Blueprint, go to the Object Manager.

2. Select Customer-Internal Business Object. Under Structure, select Map to Active Directory to
open the LDAP Mapping Wizard.

3. Select Next.
4. Select the LDAP directory service to use for the mapping, and then select Next.
5. Select if the new LDAP Business Object is part of a group.

Note: This step is shown only if mapping a New Object.

◦ Not a Member of a Group: The Business Object is not a member of a group.

◦ Group Leader: The Business Object is a group leader. A group leader is an object that has
other Business Objects as its children and holds the common fields shared by the children
Business Objects.

◦ Member of Group: The association to a group. When selected, the drop-down list is enabled.
Select an item.

◦ Group Members: Select a list item to select the group members (only one item can be
selected).

6. Set up the CSM Business Object to use directory service data:
a. Cherwell Service Management Business Object: Provide a name for the CSM Business

Object. This autopopulates with the Object that is selected in the Blueprint.

b. Directory Service object: Scroll down and select User.
c. Reload Schema button: Select the Reload Schema button to reload the Active Directory

objects. A warning appears that this function can take a while.

d. Additional Filters on User: The following Out-of-the-Box (OOTB) filters are in place. The
filters are applied to filter out the records returned.

i. ObjectCategory=Person: Ensures that computers are not included along with people in
the records returned.
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ii. User accounts that are not disabled: Ensures that disabled User accounts are not
included in the records returned.

To add additional filters, select Add.

Note: Be sure to map the field that holds the User ID of each User. In Active Directory, this is
usually SAMAccountName. This field is needed to synchronize when performing a User re-
import action.

7. Select Next.
8. Select Add to add fields to map on the Map fields to LDAP attributes page to open the Map LDAP

Field window.

9. Select User Attribute.

10. Select either:
◦ New field: Creates a new field. Select an option in the Data Type drop-down list and provide

the size.

◦ Existing field: Select this radio button, and then select an already existing field in the drop-
down list.

Note: The System_LDAPPath field is a reserved system field and is not for Customer
mapping.

11. Select the Auxiliary attribute radio button and provide the attribute name. The Auxiliary attribute
text box extends the mapping functionality to allow entry of an attribute name that is not structurally
defined on the selected LDAP class but should be included in the mapping process.

12. Select Finish.

The Map Wizard closes, and the Business Object Properties window opens.

13. Publish the Blueprint.

14. Import Customers by Importing Directory Services Data into the Business Object.
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Enable Authentication for Customers
Regardless of the type of directory service being used, the selections for this setting all refer to LDAP in
CSM. Before a directory service can work with CSM, the CSM Security Settings must be configured.

To enable authentication:

1. In the CSM Administrator main window, select the Security category, and then select the Edit
security settings task.

2. Select the Browser Portal page.

3. Verify the Use Same Settings as Desktop Client check box is selected.

4. Under Supported login modes, select Internal and LDAP.
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Import LDAP Data into Business Objects
The LDAP Import Wizard assists with importing LDAP data. Before importing data, create a Business
Object to import the data into, and then complete importing Customers using the Customer-Internal
Business Object. The CSM Scheduler can be used to import LDAP data at scheduled times.

Due to read-only settings, you may need to assign a new value to the Exempt User from Read Only AD
Import Stored Value (under the Blueprint folder). You must enter the full name for the User account under
which the import runs or the import may fail. The read-only settings are related to how your content is
configured, so this may not apply to your customizations.

To import LDAP data into Business Objects:

Note: The Wizard and page names depend on the Directory Service selected on the General
page.

1. In the CSM Administrator main window, select the Database category, and then the Import from
Active Directory task (or other directory service) to open the Import Wizard.

2. Select Next.
3. Select the Directory Service that was configured to import Active Directory Users/Customers in the

Customer - Internal Business Object.

4. Select Next.
5. On the Select Business Object page, select the Business Object that is mapped to Active Directory,

and then select Next to continue.

6. Import all items or only particular ones.
◦ Import Option: Select Import All (the Business Object selected in the previous step appears

next) or select Choose items to import.
◦ Existing items: Select Update existing items, and then select the key in the drop-down list.

If any existing items should be refreshed, select Do not update existing items.

◦ If CSM data should not be overwritten when the LDAP field is empty, select Do not overwrite
CSM Service Management field when the LDAP field is empty.

a. If the Import All option is selected, the filter page opens.
◦ Start Import at: Shows where CSM searches to import Active Directory Users.

◦ Additional Filters on Customer-Internal: Applies filters to filter out the records
returned. The example uses two filters:

◦ ObjectCategory=Person: Ensures that computers are not included along with
people in the records returned.

◦ User accounts that are not disabled: Ensures that disabled User accounts are not
included in the records returned.

◦ Select Add to set up additional filters or Delete to delete filters.
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b. If the Choose items to import option is selected, the Select Active Directory Data page
opens. To view items, either leave the Starts with text field empty or enter a few characters to
narrow the search.

i. Select Search.

ii. Select Customer-Internal items.

7. Select Finish to complete the import.

Tip: In CSM Administrator, select Scheduling > Edit Schedule to open the Scheduler and
import Customer data consistently at a defined date and time.

Related concepts
Create a Scheduled Item
Import External Data into a New External Business Object
Assign a Value to a Stored Value
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Batch Updating Customer Credentials for a
Directory Service

After using the Import Wizard, use the Contact Manager in the CSM Desktop Client to view, edit, and
manually batch update Customer credentials.

The Contact Manager feature takes all imported Customers and assigns them Portal IDs. CSM allows a
Customer to log in using assigned Cherwell credentials or using Windows/LDAP credentials.

Note: Ensure that Windows or LDAP Login is allowed in CSM. To do this, open CSM
Administrator, and select Security > Edit security settings, and select either Windows or LDAP
as a supported login mode.

To batch Customer credentials for a Directory Service:

1. Open the Contact Manager.

2. In the Customer type to show drop-down list, select the Business Object that is mapped and has
the imported data.

3. Select Go to allow all Users that are imported from the directory service.

4. On the menu bar, select Customers > Select Portal Settings > Batch Portal Credentials.

Note: This menu option only appears when the search returns Users.

5. Define the login credentials for the Customers:
a. Field with Login ID: Select User ID Field. This is usually SAMAccountName (depending on

the directory service).

b. Customer Group: Select the security group to assign Users that are included in the batch.

6. Define the Password options:
a. Select the Set Login ID Field as Windows/LDAP login radio button.

b. Select the Use this domain check box and provide the domain.

c. Leave all other options cleared.

7. Define Account details options:
a. Account locked: Select to lock the Customer's account (preventing her from logging in to the

Portal).

Note: A Customer can be automatically locked out of the system because of too many
failed login attempts (depending on system settings).

b. Password never expires: Select to forgo password expiration. This overrides any system
setting to reset the password.
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Note: If selected, the User must reset password at next login and Password reset
date settings are hidden.

c. User cannot change password: Select to restrict a Customer from changing the password. If
a password reset is required by the system, the system administrator must reset the
password.

d. User must reset password at next login attempt: Select force users to reset their
passwords at their next login attempt.

e. Password reset date: Select to prompt a Customer to change the password on a specific
date. Select the Date Selector button  to select a reset date.

8. Select E-mail options:
a. Select E-mail customer new credential information so that Customers receive an email with

their User ID/password for credentials.

b. Select Skip customers with no e-mail addresses. This option is used when using Cherwell
Internal Authentication, LDAP, Windows Authentication, and domain credentials that do not
require an email address.

9. Select Skip the customers who already have login IDs assigned to assign credentials only to
new Customers (that is, skip assigning credentials to Customers who already have them).

10. Select OK to generate the IDs.
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Related concepts
Open the Contact Manager
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Using the Test LDAP Tool
When working with the LDAP testing tool, Users can test LDAP and directory service browsing for
connectivity, search streams, servers, and authentication in some instances.

The tabs allow Users to search or browse for containers and objects.

To use the Test LDAP tool:

1. Go to Start > All Programs > [variable here] Service Management > Tools > Test LDAP.

The Connect to Cherwell Service Management window opens.

2. Select a connection and select OK to open the Test LDAP login window.
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3. Provide the user ID and password.

4. Select OK to open the Test LDAP window.

5. Troubleshoot LDAP Authentication:
◦ Windows ID: Searches LDAP for the account in field and auto-populates with the account of

the person logged in to the workstation.

◦ Test: Takes the account and verifies in the LDAP service if account exists. If no account exists,
an error window opens.

6. Test LDAP Searching:
◦ LDAP Service: Select the directory service loaded in CSM.

◦ Search start: Shows the location of where the LDAP search begins.

◦ Search filter: Shows the filter syntax to narrow search results. This field is required to run the
search.

◦ Active Directory Filters: Contains predefined filters.

◦ Add Filter: Adds the Active Directory filter to the Search Filter path.

◦ NOT, AND, OR: Inserts operators into the Search Filter field.

7. Select either:
◦ Browse: Runs a directory service browser and shows the different containers in a tree. Select

a container to view the objects in the container.

Note: Verify that the account you are using has the required permissions for the
Browse function to work.
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◦ Search: Runs a search against the value provided in the Search filter. The results show in the
Search section.
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About Active Directory Integrations
Microsoft Active Directory® is a special-purpose database that stores data for objects in a network,
including Customer information.

Customer data from Active Directory can be imported into CSM to readily view account information such
as full names and email addresses for internal Customers. CSM integrates with Active Directory by
connecting to the directory service, mapping objects, and enabling security settings to import Users and
data.
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About LDAP Integrations
Lightweight Directory Access Protocol (LDAP) is a protocol used to access information in a directory
service (a directory stored on a server).

LDAP integrates by connecting to the directory service, mapping objects, and enabling security settings to
import the Users and data into CSM.
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Troubleshooting Directory Services
You can troubleshoot issues with Directory Services by answering a series of questions.

• Who is responsible for integrating CSM with Directory Services?

Users should consult an LDAP administrator, IT staff member, or the Cherwell Professional
Consulting Services team for assistance with LDAP.

• Why are Users not able to login using LDAP authentication?

If Users are not able to login using LDAP authentication, try these tips:

◦ Ensure the Domain value in LDAP General settings matches the domain specified by Users in
the login dialog. This is how CSM matches User accounts with the correct LDAP settings.

◦ Ensure the selected directory service value matches the type of LDAP directory being
configured. The LDAP (generic) settings may be tried for unlisted directories, but LDAP
functionality within CSM may be limited or non-functional.

◦ Ensure all accounts within the LDAP General settings Search Start scope are unique. CSM
expects that, within the configured Search scope for an LDAP settings definition, duplicate
User accounts (ex. SAMAccountNames) do not exist. There are two options available for this:

◦ Enter a Search start path in the General page of LDAP settings that is limited to a single
domain or OU that contains unique User accounts.

◦ Ensure that all User accounts that are found in the configured Search scope have unique
User accounts (ex.SAMAccountNames). Multiple LDAP settings can be created to cover
multiple domains or OUs.

337

CSM 10.0.0 Administration

CSM 10.0.0 Administration



SAML
Security Assertion Markup Language (SAML) is an XML-based open standard for exchanging
authentication and authorization data between identity providers and service providers to support Single-
Sign-On (SSO) capability.

SAML uses:

• Identity Providers: Manage User Identities and interact with data stores containing User credentials.
Identity providers normally provide interfaces allowing Users to log in to SAML sessions.

• Service Providers: Provide applications and act as Relying Parties for SAML identity information.

Related concepts
Configure SAML in CSM
Related tasks
Configure Login, Authentication, and Inactivity Settings for Each Client
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About SAML
CSM supports SAML 2.0 as a service provider. Before SAML can be used, the integration must be
configured in CSM Administrator and in the identity provider.

Note: The CSM Outlook add-in does not currently support SAML authentication.

When a user starts CSM, including the CSM Desktop Client or CSM Browser Client, a Cherwell Service
sends an authentication request to the user’s identity provider. Users who are not already logged in to an
identity provider are presented a log in window so they can enter their credentials, which are
authenticated by the identity provider. If the authentication is successful, the identity provider passes a
response containing one or more assertion statements to the Cherwell assertion consumer Service.

An assertion indicates that the identity provider has successfully authenticated the user and includes a
user name ID (example: email address or Windows login ID) and possibly additional optional attributes
about the user (example: Name, department, and more). The Cherwell Service uses the Name ID to find
the user information in CSM (the user can be either a customer or an internal user), and then logs the
user in to the Cherwell application without requiring further user interaction.

Note: SAML is designed for browsers. Desktop Client applications open a browser window when
initiating support of the SAML authentication process. After SAML authentication has completed
successfully, this window automatically closes. Each Desktop Client application maintains its own
separate session information, so every time users log in to the Desktop Client, they are prompted
to log in to the identity provider (with the exception of ADFS, which uses the current Windows
session information).

The figure shows the CSM SAML SSO process.
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The figure shows the CSM SAML IdP Initiated process.
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Related concepts
Configure SAML in CSM
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SAML Good to Know
When using SAML, note the following integration considerations.

• Before SAML can be used, the integration must be configured in CSM Administrator and in the
identity provider.

• Edit Web.config files to enforce redirecting HTTP requests to HTTPS for a better, more secure logon
experience.

Related concepts
Configure SAML in CSM
Configure SAML Security Rights
Related tasks
Prevent Browsing HTTP from HTTPS
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SAML Configuration Components
SAML configuration components include SAML user identities, metadata, single sign-on (SSO), single
logout, and identity providers.

SAML User Identities (Name IDs)
CSM supports the following types of user identities (Name IDs) in SAML assertions:

• Email addresses

• Windows login IDs

All identity providers should support email addresses and some also support Windows login IDs. Using
either of these identity types allows for easy association with CSM user information because these types
are already supported by CSM. Users only need to select which type to use, verify that the identity
provider supports it, and verify that information is populated for all users in the CSM Database and that
the ID is unique across all users.

Note: For users on Windows environments, the recommended solution is to use ADFS and
Windows account names. This solution is known to work well and potentially requires less logging
in. Using account names also avoids issues where multiple users share the same email address.
When using other identity providers, particularly those that are hosted outside the organization's
network, email addresses might be the only solution available.

SAML Metadata
SAML defines a format for metadata, which is provided in the form of an XML document that describes
what is supported and required by an identity or service provider. Metadata is a convenient way to set up
providers without having to enter complex information manually. CSM provides the ability to import
metadata for identity providers and to export metadata for the CSM Service Provider.

SAML SSO
SAML was intended to be used primarily with browser-based applications. The authentication process is
implemented through page posts and redirects through the user’s browser. This normally is automatic and
transparent and does not require any interaction with the user, with the exception of the initial login at the
identity provider. After the user is authenticated, the user credentials are kept in the browser session. If
the user logs in again or logs into a different SAML-based application, the authentication process is
normally automatically complete without further prompting.

SAML is designed for browsers. CSM Desktop Client applications open a browser window when initiating
support of the SAML authentication process. After SAML authentication has completed successfully, this
window automatically closes. Each Desktop Client application maintains its own separate session
information, so every time a user logs in to a Desktop Client, they are prompted to log in to the identity
provider (with the exception of ADFS, which uses the current Windows session information).
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Note: User credentials are kept in the browser session, so it is very important for the user to close
all browser applications when logging out to prevent someone else from using their credentials.

SAML Single-Logout
SAML defines a single-logout protocol. SAML single-logout is not supported by CSM because of its
limited support by identity providers.

The single-logout allows a user to select a global logout feature in a SAML application, which logs out the
user from the current application, and also sends notifications to all SAML applications running in the
current session to log out the user. There are a number of issues with this feature, and it is not always
supported by identity providers. For example, Shibboleth does not support the logout feature at all, and
Microsoft ADFS only supports it in a limited way.

SAML Identity Providers
You can configure a SAML service provider such as Microsoft ADFS to work with CSM. Microsoft ADFS
supports SAML with Active Directory and is the best choice for organizations where users are internal
employees using Windows. For ADFS, the most commonly configured SAML name ID type would be the
Windows login ID, although email addresses can also be used. As long as a user is logged into the same
network as the ADFS service, the user should be able to use any configured SAML application without
ever being prompted for a login. If the user is not directly logged into the network, the user is prompted to
login through ADFS.

CSM supports an identity-provider initiated SAML feature. Users log in to the identity provider page using
their login information and select CSM as the desired service provider, which transfers users to CSM after
login.
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SAML Signing Certificates
Security is one of the most important concerns when using an SSO framework like SAML. Ensure that
messages are actually coming from the expected identity and service provider rather than a malicious
third party.

To ensure the identity of message originators, signing certificates are used within messages. These
certificates are stored in both the identity and service providers at the time of configuration. In addition,
some data might be optionally encrypted.

To use Cherwell SAML SSO, gather a number of standard x.509 certificates for use by the Cherwell
Server. A self-signed certificate can be used temporarily during initial testing. For production, use a
publicly trusted X.509 certificate from a public third-party certification authority (CA).

Identity Provider Token Signing and Encryption Certificates
The identity provider uses a certificate to verify the source of its communications to CSM (referred to as a
token-signing certificate). The identity provider’s public certificate needs to be imported into CSM. The
easiest approach is to import the metadata provided by the identity provider as a file into CSM. The
metadata includes configuration information as well as certificates. If configuring the identity provider
manually, copy and import its public certificate manually into Cherwell. In addition to the signing
certificate, the identity provider may optionally also use a separate token encryption certificate. To import
this certificate into CSM, import the identity provider’s metadata file.

Service Provider Token Signing Certificate
Like the identity provider, CSM (acting as a service provider) must use a token signing certificate, and the
public certificate must be imported into the identity provider. For this purpose, both a public certificate
(typically with a .cer file extension) and matching private key certificate (typically with a .pfx file extension)
must be created. The private key certificate must be imported into the CSM using the Administrator SAML
settings. The public certificate needs to be imported into the identity provider. The easiest way to do this is
to export the CSM settings as metadata, and then import the metadata (which includes the certificate) into
the identity provider.

Note: Network IT staff normally manage signing certificates and should be knowledgeable about
the procedure for obtaining new certificates. Certificates must be obtained from trusted certificate
authorities (such as VeriSign, Thawte, GoDaddy, and more).
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Configure SAML in CSM
SAML is configured in CSM Administrator and in the identity provider.

Follow this general process to configure SAML in CSM.

Task Notes

1. Obtain and apply a self-signed certificate on your
CSM server. This task is typically performed by an
organization's IT department.

See SAML Signing Certificates.

2. In CSM Administrator, grant security rights to
system administrators so they can configure SAML. See Configure SAML Security Rights.

3. In CSM Administrator, set SAML identity provider
options, and then import the identity provider metadata
file.

See Configure the SAML Identity Provider.

4. In CSM Administrator, set SAML service provider
options, and then export the CSM service provider
metadata file.

See Configure CSM as a SAML Service Provider.

5. Complete the steps to configure the SAML identity
provider. See Configure Microsoft ADFS for CSM.

6. In CSM Administrator, configure automatic user
account creation and updates in CSM. This option only
applies when Microsoft ADFS is used and when
Windows logins are used as the SAML name ID.

See Configure Automatic User Imports From SAML.

7. In CSM Administrator, enable SAML as a supported
login mode. See Enable SAML.

Related concepts
Configure the SAML Identity Provider
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Configure SAML Security Rights
Security rights control access to CSM functionality and are configured in the Security Group Manager in
CSM Administrator.

To configure security rights:

1. In CSM Administrator, open the Security Group Manager (Security > Edit security groups).

2. In the Info tab, provide the name of the Security Group (example: Admin).

3. Select the Rights tab.

4. In the Category menu, select Security features.
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5. Select each security feature right, and then select the appropriate check box to (example: Allow,
View, Add, Edit, and Delete). Use the following descriptions as a guide:

◦ SAML Cherwell Service Provider settings?: When Edit is selected, system administrators
can edit the service provider settings and configure CSM as a SAML Service Provider.

◦ SAML Identify Provider settings?: When Edit is selected, system administrators can edit the
identity provider settings and configure the SAML Identity Provider.

◦ System settings?: When Edit is selected, system administrators can edit system settings and
enable SAML.

Related concepts
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Security Rights
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Configure the SAML Identity Provider
Integrate CSM with a SAML-compliant identity provider such as Microsoft Active Directory Federation
Services (ADFS).

Each identity provider uses a different procedure for integrating with CSM. The procedures in this section
provide some sample guidelines on how to configure CSM with each identity provider. Refer to the
specific identity provider documentation for guidelines on installing and initially configuring the identity
provider, and to ensure that the correct configuration steps are followed for the desired implementation.

Tip: A convenient way to create the configuration is to import the identity provider’s metadata.
This configures all the required settings except for the selection of the type of ID. However, you
can manually enter all the data and import the signing certificate, if needed.

To configure the SAML identity provider:

1. In CSM Administrator, create a Blueprint.

2. From the toolbar menu, select Tools > Edit SAML Settigs.

3. Select the Identity Provider page.

4. Select Import Metadata.

5. When prompted for a file name, select the Service Provider's metadata .xml file. For example, use
the metadata file from ADFS.
The following information is automatically imported from the metadata file. If it is not, you can
manually enter information into the writable fields.

Option Description

Entity URL
A URL that uniquely identifies the identity
provider. This is provided by the identity
provider.

Organization Name (Optional) The name of the identity provider,
used only for display.

Organization URL (Optional) The main URL of the identity
provider, used only for display.

Single-Sign-On URL
The URL of the identity provider’s
authentication service. This should always be a
secure URL (beginning with https:).
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Option Description

Certificate

The identity provider signing certificate (a
standard .cer file) is used to verify messages
from the identity provider.

Note: Signing certificates are normally
managed by network IT staff; IT should
be knowledgeable about the procedure
for obtaining new certificates.
Certificates must be obtained from
trusted certificate authorities (such as
VeriSign, Thawte, GoDaddy, and
more).

6. If you have changed the SSO URL or are re-routing requests to a SSO URL outside the CSM
environment, you must list proxy SSO URLs here. Select Add and provide the URL(s). They are
added to the safe URLs list in the form-action attribute in the Content Security Policy header.

7. From the Type of ID options, select the type of ID (SAML Name ID) to request from the identity
provider:

◦ Email Address: Select this option to use email addresses as the SAML Name ID. See Use E-
mail Address as the Name ID.

Note: When using email address, ensure that the Email Attribute is set on the Email
Address Field of the User/Customer Business Objects (User Info and Customer-
Internal).

◦ Windows Login: Select this option to use the Windows login ID as the SAML Name ID. This
option must be selected if you want to automatically update user imports from SAML. See Use
Windows Login as the Name ID.

8. Select the Hide SAML authentication window check box to hide the SAML authentication window
used by the CSM Desktop Client.

Note: This should be used only with ADFS and when users are normally logged into the
same network, in which case users are never prompted to log in and so the browser window
might be considered an unnecessary distraction.

9. Select the appropriate signing options to configure SAML signing certificates according to your
identity provider's parameters. When an authentication response is returned, it may consist of many
SAML assertions. Identity providers may sign the entire response, sign individual assertions, or
both. For example, ADFS signs individual assertions but not entire responses. Consult
documentation from your identity provider to determine the appropriate settings. You must select at
least one option.

10. Optionally, select the Force check box to disable Force Authentication. Authentication is forced by
default; this means users are required to enter their credentials each time they access CSM.
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Warning: Cherwell strongly recommends that you do not disable Force Authentication, as it
decreases security. If you are considering disabling Force Authentication (due to network/
physical server environments, or to make it easier for users to maintain a session), please
contact Cherwell Support to ensure you understand the implications.

Optional web.config settings:

• Adjust the server time allowance to allow for differences in clocks on the identity provider and local
servers. This setting will default to 60 seconds but can be overridden by a setting in the web.config
files for both Cherwell Service and the REST API. To override the default setting, specify a value in
seconds in the web.config files as follows:

<add key="SAMLServerTimeAllowance" value="90" />

• If using SAML and a non-ADFS identity provider, you must add this setting to the web.config file in
the Cherwell Service folder. Specify the setting under the <appSettings> section as follows:

<add key="IdpIsAdfs" value="false"/>

If you have upgraded and are using ADFS, you do not need to add the setting.

Related concepts
SAML Signing Certificates
Related tasks
Create a Blueprint
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Configure CSM as a SAML Service Provider
Use the Service Provider page in the SAML Settings window to configure CSM as a SAML Provider.

To configure CSM as a SAML Service Provider:

1. In CSM Administrator, create a Blueprint.
2. From the menu, select Tools > Edit SAML settings.
3. Select the Service Provider page.
4. Provide CSM identity information:

Option Description

Entity URL
Provide the URL that identifies the service provider.
The entity and service URLs should use the same
domain as specified in the signing certificates.

Organization name (Optional) Provide the service provider organization
name, this is used only for display.

Organization URL (Optional) Provide the URL of the service provider
organization, this is used only for display.

Cherwell web service URL

Provide the Cherwell web service URL (example:
https://host.domain/CherwellAPI).

Note: If upgrading CSM, the existing SAML
web service URL is automatically updated to
match the Cherwell REST API URL that us
entered in the upgrade prompt. For example,
if the REST API URL is https://host.domain/
CherwellAPI/api/, the web service URL will
be updated to https://host.domain/
CherwellAPI (without the /api at the end of
the path).

CSM default startup URL
Provide the CSM Client or CSM Portal URL for the
site to be redirected to after logging in using SAML
Identity-Provider initiated authentication.
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Option Description

Validate SAML authentication

After a user is successfully authenticated through
SAML, CSM receives a response that the user is
valid. To verify that the user valid response is itself is
valid, CSM sends a request to a CSM web service to
authenticate the response. Select whether the
request is sent:

From Server (recommended): If CSM is locally
hosted, this might require changes to the firewall
configuration to allow HTTPS web communication
between the Cherwell Application Server and the web
server hosting the Cherwell Web Service, if on
different machines.

From Client: Provide for backwards compatibility and
in cases where the from server option might be
incompatible with the network configuration. This is a
less secure option.

Note: In most configurations, this option only
impacts the behavior of the CSM Desktop
Client.

Signature algorithm

Select the Secure Hash Algorithm to use for signing
SAML messages between CSM applications and your
identity provider. SHA-1 and SHA-256 are supported,
but SHA-256 is the default and recommended option,
particularly for customers who operate under General
Data Protection Regulation (GDPR) jurisdiction.

5. Import the Private Certificate: Personal Information Exchange Format (.pfx) file containing a
certificate with a private key. This certificate must be issued by a trusted certificate authority. To
import a private certificate, select Import and select the .pfx file. There is a prompt to enter the
password for the file.

Note: Signing certificates are normally managed by network IT staff; IT should be
knowledgeable about the procedure for obtaining new certificates. Certificates must be
obtained from trusted certificate authorities (such as VeriSign, Thawte, Go Daddy, and
more).

6. Export the service provider settings to a metadata file.

Tip: Use this file later to import the service provider metadata into the identity provider.

a. Select Export Metadata to open the Export File window.
b. Select a name and location for the metadata .xml file.

Related concepts
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SAML Signing Certificates
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Configure Automatic User Imports From SAML
You can configure automatic user account creation and updates in CSM when users log in using SAML.
Control the user data and group membership passed to CSM by mapping ADFS attributes to Business
Object fields and Active Directory security groups to CSM Security Groups.

This feature is only supported when SAML is configured with Microsoft ADFS.

The process for configuring automatic user updates requires setup in ADFS and in CSM Administrator.

Task Notes

1. In Microsoft ADFS, verify that Windows login IDs are
used as the SAML name ID that identifies users. See Use Windows Login as the Name ID.

2. In Microsoft ADFS, verify that email addresses are
not used as the SAML name ID that identifies users. See Use E-mail Address as the Name ID.

3. In Microsoft ADFS, configure user attributes that will
be passed to CSM. For example, create attributes such
as first name, last name, email address, etc.

See Configure User Attributes in ADFS.

4. In Microsoft ADFS, add a rule for every Active
Directory security group that you want to map to a CSM
Security Group.

See Map SAML Security Groups to CSM Security
Groups.

5. In CSM Administrator, verify that the type of ID set for
the identity provider is Windows Login. See Configure the SAML Identity Provider.

6. In CSM Administrator, add the SAMLImport general
attribute to the User Business Object.

See Add SAMLImport Attribute to User Business
Object.

7. In CSM Administrator, map attributes in the Business
Object that stores user information to ADFS attributes.

See Map Active Directory User Attributes to CSM
User Fields.

8. In CSM Administrator, map Active Directory groups to
CSM Security Groups.

See Map SAML Security Groups to CSM Security
Groups.

Related concepts
Windows Credentials
Related tasks
Configure User Attributes in ADFS
Map Active Directory User Attributes to CSM User Fields
Configure Groups in ADFS
Map SAML Security Groups to CSM Security Groups
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Add SAMLImport Attribute to User Business Object
Before you can automatically create and update user accounts from SAML, you must apply a special
general attribute to the Business Object used to store user data.

To apply the SAMLImport attribute:

1. Create a Blueprint.
2. From the Object Manager, select the Business Object used to store user data. For example, select

the UserInfo Lookup Table.
3. Select Edit Business Object, and then select Bus Ob Properties.
4. Select the Advanced page.
5. Expand General Attributes.
6. Add SAMLImport to the Attribute column.
7. Select OK.
8. Publish the Blueprint.
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Map Active Directory User Attributes to CSM User
Fields

Map Active Directory user attributes to User Business Object fields so that data is copied to the user
record when the user logs in to CSM through SAML.

You need the list of Active Directory attributes added in the AD FS Management tool. See Configure User
Attributes in ADFS.

To map Active Directory User Attributes:

1. In CSM Administrator, create a Blueprint.
2. From the toolbar menu, select Tools > Edit SAML Settigs.
3. Select the User Mapping page.
4. Select the Create or update users when logging in users SAML check box.
5. Select Add.
6. In the Attribute name box, type the exact name of the Active Directory attribute.
7. Select one of these options:

◦ New Field: Add a new Business Object field to map to the Active Directory attribute. You must
also select a data type and size.

◦ Existing Field: Select an existing field in the User Business Object.
8. Repeat for each Active Directory attribute added to ADFS.
9. Publish the Blueprint.
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Map SAML Security Groups to CSM Security
Groups

Map SAML groups to CSM Security Groups to ensure that new and updated user accounts are added to
the correct CSM Security Group when users log in using SAML.

You need the list of groups you added in the AD FS Management tool. See Configure Groups in ADFS.

Keep in mind that users can belong to multiple SAML groups but only one CSM Security Group. You can
associate multiple SAML groups to a single CSM Security Group, but you cannot assign a single SAML
group to multiple CSM Security Groups.

For example, a user may belong to two SAML groups:

• Domain Admins

• Network Admins

In this case, you must choose one CSM Security Group for the user, such as the Admin group.

1. In CSM Administrator, open the Security Group Manager (Security > Edit security groups).
2. From the Group drop-down list, select the CSM Security Group you want to map to a SAML group.
3. Select the Users page.
4. In the SAML Groups area, select Add.
5. Type the name of the SAML group to associate with the selected CSM Security Group.
6. Select OK.

Note: If you have already mapped the SAML group to a different CSM Security Group, you
are given the option to change the assignment to the group you are currently modifying.

7. Repeat this step for each SAML group that should be mapped to the CSM Security Group.
8. Select Order Groups.
9. Order the list to determine the assignment priority for users who belong to multiple SAML groups.

When these users log in using SAML, the first SAML group found determines which CSM group the
users are assigned to.

10. Select OK.
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Enable SAML
Before SAML can be used, SAML must be enabled as a supported login mode. The other login types can
also be enabled so that if SAML authentication fails, or the user cancels the process, the next configured
login method is invoked.

By default, the CSM Web Applications use the same security settings as those configured for the CSM
Desktop Client Applications; however, configure the system to use different login modes for each. Select
Browser Client or Browser Portal, and then clear Use Same Settings as Desktop Client, and then
enable or disable SAML authentication separately for each type of application.

To enable SAML:

1. In the CSM Administrator main window, select Security > Edit security setting.

2. Select Desktop Client.
3. Under Supported login modes, select SAML.

SAML authentication is now enabled and, if configured, is now invoked for users logging in.

4. Select OK.

Note: There might be a delay (up to 15 minutes or so) before the new configuration is loaded and
made available by the SAML Web Services.
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Configure Microsoft ADFS for CSM
Configure Microsoft Active Directory Federation Services (ADFS), an add-on product for Active Directory
that supports identity federation protocols, including SAML 2.0.

Note: CSM provides integration with third-party identity providers, not support. For more
information about your AD/ADFS setup, work with an AD/ADFS Administrator.

Note: This topic applies to versions of ADFS that are currently supported by Microsoft.

Task Notes

1. In CSM, follow steps 1-4 in Configure SAML in
CSM.

2. In Microsoft ADFS, verify DNS and certificate
settings. See Verify DNS and Certificate Properties in ADFS.

3. In Microsoft ADFS, import or manually add CSM
as a relying party trust. See Manually Add CSM as a Relying Party.

4. In Microsoft ADFS, configure the type of SAML
Name ID.

Note: To automatically import new and
updated user accounts in CSM, you must
use Windows login IDs.

See Use E-mail Address as the Name ID or Use
Windows Login as the Name ID.

5. In Microsoft ADFS, configure user attributes if you
want to automatically import new and updated user
accounts in CSM.

See Configure User Attributes in ADFS.

6. In Microsoft ADFS, configure groups if you want to
automatically import new and updated user accounts
in CSM.

See Configure Groups in ADFS.

7. In Microsoft ADFS, configure ADFS as the SAML
Identity Provider. See Configure the SAML Identity Provider.
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Verify DNS and Certificate Properties in ADFS
Before you configure SAML for CSM, verify that the general properties of ADFS are configured correctly.

1. Open the ADFS x.x Manager.
2. Right-click Service and select Edit Federation Service Properties.
3. Verify that the settings on the General tab match the correct DNS and certificate common names.
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Import the CSM Service Provider Metadata File into
ADFS

1. Start the ADFS x.x Manager.
2. Select Add Relying Party Trust.
3. Select Import data about the relying party from a file.
4. Select the CSM Service Provider metadata file exported when CSM was configured as a service

provider.
5. Provide a display name, and then select Next.
6. Select Permit all users to access this relying party, and then select Next.
7. Ensure that the Open the Edit Claim Rules dialog for this relying party when the Wizard closes

check box is selected, and then select Close.
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Manually Add CSM as a Relying Party
Add CSM Service Provider to Microsoft Active Directory Federation Services (ADFS) as a relying party.

Note: This topic applies to versions of ADFS that are currently supported by Microsoft.

To manually add CSM as a relying party:

1. Start the ADFS x.x Manager.
2. Under Trust Relationships (left of the window), select Relying Party Trusts.
3. On the right, select Add Relying Party Trust.
4. Select Start.
5. Select Enter data about the relying party manually, and then select Next.
6. Provide a display name, and then select Next.
7. Select ADFS x.x profile, and then select Next.
8. Import an encryption certificate:

a. Select Browse, and then select the certificate (.cer file) that was used when setting up the
CSM Service Provider.

b. Select Next.
9. Select Enable support for the Saml 2.0 WebSSO protocol, and enter the URL to the Cherwell

web service page that is used as the assertion consumer. This is the domain followed by
CherwellAPI/saml/assertion (example: https://www.mycompany.com/CherwellAPI/saml/assertion).

10. Select Next.
11. Provide a URL for the relying party trust identifier. The URL must match what was entered in CSM

as the service provider entity ID.
12. Select Add, and then Next.
13. Select Permit all users to access this relying party, and then select Next.
14. Verify the selections, and then select Next.
15. Ensure that the Open the Edit Claim Rules dialog for this relying party when the Wizard closes

option is selected, and then select Close.
16. On the Issuance Transform Rules tab, select Add Rule, and then follow the instructions for the

desired type of ID.
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Use Windows Login as the Name ID
For users on Windows environments, the recommended solution is to use ADFS and Windows account
names. Windows logins are required if you intend to automatically create and update user accounts from
SAML.

If the Add Transform Claim Rule Wizard is not already open, select CSM Relying Party, and then select
Edit Claim Rules (on the right), and then select Add Rule on the Issuance Transform Rules tab.

To use Windows Login as the Name ID:

1. For Claim rule template, select Transform an Incoming Claim, and then select Next.
2. Provide a name for the claim rule (example: Windows account name).
3. In the Incoming claim type field, select Windows account name.
4. In the Outgoing claim type field, select Name ID.
5. In the Outgoing name ID format field, select Kerberos Principal Name.
6. Select Select Pass through all claim values.
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7. Select Finish.
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Use E-mail Address as the Name ID
Before you choose to use email addresses as the SAML Name ID, verify that your identity provider can
return the desired type of ID. For some identity providers, particularly those that are hosted outside the
organization's network, email address might be the only solution available.

To use E-mail Address as the Name ID:

1. For Claim rule template, select Send LDAP Attributes as Claims, and then select Next.

2. Provide a claim rule name (example: E-mail Attribute).

3. In the Attribute store field, select Active Directory.

4. Under Mapping of LDAP attributes to outgoing claim types, select E-mail-Addresses in the
LDAP Attribute column and E-mail Address in the Outgoing Claim Type column.

5. Select OK.

6. Select Add Rule.

7. For Claim rule template, select Transform an Incoming Claim, and then select Next.
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8. Provide a claim rule name (example: E-mail Address).

9. In the Incoming claim type field, select E-mail Address.

10. In the Outgoing claim type field, select Name ID.

11. In the Outgoing name ID format field, select Email.
12. Select the Select Pass through all claim values radio button.

13. Select OK.

After completing the above steps, change the following:

1. Under Trust Relationships (left-hand side), select Relying Party Trusts, and then double-click the
entry for the CSM Relying Party.

2. Select the Advanced tab.
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3. Select the Secure Hash Algorithm specified on the SAML Settings - Service Provider page. SHA-1
and SHA-256 are supported, but SHA-256 is the default and recommended option, particularly for
customers who operate under General Data Protection Regulation (GDPR) jurisdiction.

4. Select OK.

Related tasks
Configure CSM as a SAML Service Provider
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Configure User Attributes in ADFS
Create or configure Active Directory user attributes that you want to map to fields in the CSM User
Business Object. This is typically the CSM User Info Lookup Object, but it could be a different table based
on your user implementation.

To configure Active Directory user attributes:

1. Open the AD FS Management tool.
2. From the navigation pane, expand Trust Relationships, and then select Relying Party Trusts.
3. Select the CSM server that is configured for SAML.
4. Select Edit Claims Rules, and then select Add Rule.
5. From the Add Transform Claim Rule Wizard, select the Send LDAP Attributes as Claims rule

template, and then select Next.
6. Add the following claim rule properties:

Property Value

Claim rule name Provide a name, such as User Attributes.

Attribute Store Select Active Directory.

LDAP Attribute Add an entry for each attribute you want to
pass to CSM. For example, add Given
Name, Surname, E-mail Addresses, and
Department.

Outgoing Claim Type Type (do not select) a name for each
attribute. For example, add First Name for
the Given Name attribute.

7. Record the Outgoing Claim Type entries you make so have the names when you map them to
Business Object fields in CSM.
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8. Select Finish.
9. Map the Outgoing Claim Types to Business Object fields. See Map Active Directory User Attributes

to CSM User Fields.
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Configure Groups in ADFS
Create or configure Active Directory groups that you want to map to Security Groups in CSM. Users are
automatically added to the mapped CSM Security Group when their account is created or updated.

To configure groups in ADFS:

1. Open the AD FS Management tool.
2. From the navigation pane, expand Trust Relationships, and then select Relying Party Trusts.
3. Select the CSM server that is configured for SAML.
4. Select Edit Claims Rules, and then select Add Rule.
5. From the Add Transform Claim Rule Wizard, select the Send Group Membership as a Claim rule

template, and then select Next.
6. Add the following claim rule properties:

Property Value

Claim rule name Provide a name, such as Admin or IT
Service Desk Level 1. For easier
maintenance, choose a name that matches
Security Group names in CSM.

User's Group Select Browse, and then add the domain
name group you want to map to CSM
Security Groups. For example, add Domain
Admins if you want to automatically add
users in this group to the Admins Security
Group in CSM.

Outgoing Claim Type Select Group.

Outgoing Claim Value Provide a name for the group. This is the
name you will use to map the ADFS group to
a CSM Security Group.
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7. Record the group names you added so have the names when you map them to Security Groups in
CSM.

8. Select Finish.
9. Repeat this process for each ADFS group you want to map to a CSM Security Group.

10. Map the ADFS groups to CSM Security Groups. See Map SAML Security Groups to CSM Security
Groups.
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SAML Diagnostics
SAML logging is included with general CSM logging features and is configured using the Server Manager.

The following sections discuss how to test and troubleshoot SAML.

Troubleshoot SAML
When SAML is enabled and correctly configured, a web page initially opens after the CSM Desktop Client
or CSM Browser Client are opened. The web page indicates that a SAML authentication request has
been sent to the identity provider (this might appear very briefly), and then the identity provider’s login
page can be seen.

If the web page does not open or other issues are experienced related to SAML, try the following
suggestions.

1. After SAML settings have been changed, it might take a while before the settings are reloaded into
the Cherwell Web Services and Application Server. Ensure the latest settings are active by
restarting the IIS Web Server and the Cherwell Server (through the Cherwell Server Manager
application). Also, clear the local browser cache.

2. Verify that the selected identity provider ID type (email address or Windows login) matches the type
of ID that the identity provider is configured to return.

3. If settings were manually configured in the CSM Administrator for an identity provider (rather than by
importing a metadata file), verify that the entity and SSO URLs exactly match what is specified by
the identity provider. The URLs for some identity providers are case sensitive.

4. Verify that the domains contained in certificates match the domains of the identity and service
provider URLs and are issued by a recognized Certificate Authority and have not expired.

5. Recheck the SAML settings in CSM and the identity provider to ensure that they are correct and
consistent.

6. Ensure that the date and time are synchronized on the Cherwell and identity provider servers.

To access CSM clients without SAML authentication, select Cancel in the SAML window that is initially
displayed. This skips the SAML authentication step and displays the login window (or whatever the next
login option that is configured).

Test SAML With a Browser
Run a simple test using a web browser and view the results of a SAML authentication without running a
client application by following the steps below.

To test SAML through a browser:

Note: In the steps below, the URL saml.cherwell.com should be replaced with the actual URL.
This can also be done as an easy way to generate debug logs.
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1. Navigate to https://MyServer/Service/SAML/login.aspx. The browser redirects to the
identity provider and prompts a login.

2. Provide the User credentials.
After the identity provider response has been processed, a page opens and displays the important
information returned to the service provider, such as result status codes, the user name ID, session
ID, and the authentication and assertion xml body.

Bypass SAML for Individual Users
If you are using a login method other than SAML (external, LDAP, Windows, internal), bypass SAML
authentication and log in using a different method. For example:

• For the Desktop Client, select Cancel on the SSO dialog after SAML authentication has begun and
the next login method is invoked.

• For CSM Web Applications, use a special URL to bypass SAML authentication and display the
standard login dialog, which also includes a link to initiate SAML authentication. Add
CherwellLogin to the end of the URL normally used to access the technician or Portal site, such
as:
http://myserver/CherwellPortal/CherwellLogin
or
http://myserver/CherwellClient/CherwellLogin

If the CSM Portal site is configured to allow Anonymous access, select Click to Login to start the SAML
authentication. SAML authentication can also be started immediately by adding SamlLogin to the URL
(similar to adding CherwellLogin as described above).  To go directly to the login page, add
CherwellLogin to the URL.

Bypass SAML for All Users
To bypass the initial SAML authentication for all Users for either the Browser Client or CSM Portal, add a
configuration setting to the web.config file in the appropriate folder on the web server.

For example, navigate to: 
C:\Program Files (x86)\Cherwell Browser Applications\Portal
or

C:\Program Files (x86)\Cherwell Browser Applications\BrowserClient 

In the <appSettings> section in the web.config file, add the following line:

<add key="DefaultAuthMode" value="CherwellLogin" />
This addition bypasses SAML authentication and forces the login dialog to be displayed instead. SAML
authentication is available using the link provided on the login dialog.
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Diagnose Microsoft ADFS Errors
If an error is displayed by Active Directory Federation Services (ADFS) during SAML authentication, more
information about the error is available in the Windows Event Viewer on the ADFS server.

Note: This topic applies to versions of ADFS that are currently supported by Microsoft.

To open the Event Viewer on the ADFS server:

1. Open the Event Viewer by navigating to Start > Programs > Administrative Tools > Event Viewer
or Control Panel > Administrative Tools.

2. In the console tree, expand Applications and Service Logs > ADFS, and select Admin.

To enable a debug trace viewer for more detailed information:

1. On the menu bar, select View > Show Analytic and Debug Logs.

2. In the console tree, expand Applications and Services Logs > ADFS x.x Tracing, and then select
Debug.
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3. In the Actions pane, select Enable Log. Tracing for ADFS x.x is now enabled.

4. Restart the ADFS x.x Windows Service.
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Resolve Problems Using ADFS with Safari Browser
A known issue exists when using Safari and Microsoft Active Directory Federation Services (ADFS).
Instead of automatically authenticating users, they are forced to provide credentials. The problem is
resolved by editing the ADFS Relay State options.

Note: This topic applies to versions of ADFS that are currently supported by Microsoft.

The CSM SAML Service should automatically detect when a Safari browser is being used, and
automatically use the alternate GET method without specifying the UseSAMLADFSRedirect setting in the
web.config file. Users only need to set the UseSAMLADFSRedirect setting if they want to force this
behavior for all requests.

To edit the ADFS Relay State options:

1. On the server where ADFS is installed, locate and open the web.config file. Examples:
◦ ADFS 2.0/2.1 example: %systemroot%\inetpub\adfs\ls\web.config

◦ ADFS 3.0 example: %systemroot%\ADFS\Microsoft.IdentityServer.Servicehost.exe.config

2. Enable the Relay State option.

3. Go to the CherwellService folder (Example: C:Program Files (x86)/Cherwell Browser Applications/
CherwellService).

4. Open the web.config file.

5. Enable USESAMLADFSredirect key in the Cherwell Server web.config file.
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6. For ADFS x.x, run IISReset to restart IIS.

7. Restart the Active Directory Federation Services.

Test Changes
Test that the enable commands work by running Fiddler and capturing the requests made when
connecting to ADFS. The request should connect to an idp-initiated page first (in bold) and contain a
Relay State (italicized) value. This call should be a GET instead of the POST method used without a
Relay State:

GET/adfs/ls/idpinitiatedsignon.aspx?RelayState= RPID%3dhttps%3a%2f%2

This is the behavior if you are not using the relay state options.

POST /adfs/ls/?binding=urn%3aoasis%3anames%3atc%3aSAML%3a2.0%3abindings%3aHTTP-POST
HTTP/1.1

Good to Know

• There are several web.config files used by CSM.

• When an application starts, the web.config file is backed up in a separate folder.
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• Content of the web.config files is retained during both upgrade and reinstallation, so any changes
you make to web.config files are preserved.

380

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Resolve Problems Using ADFS with Chrome or
Firefox Browsers

If Microsoft Active Directory Federation Services (ADFS) appears to be working with Internet Explorer but
problems occur when using Chrome, Firefox, Safari, or other browsers (example: Continuously seeing the
ADFS login prompt), the ExtendedProtectionTokenCheck on the ADFS server might need to be disabled.

Disabling this feature lessens security somewhat against man-in-the-middle attacks. If turning off this
feature is not acceptable (check with your AD/ADFS administrator), Internet Explorer might be the only
browser available.

Note: This feature is disabled only on the ADFS server; Users do not have to change anything
with their browser.

Note: This topic applies to versions of ADFS that are currently supported by Microsoft.

To disable the ExtendedProtectionTokenCheck on the ADFS server:

1. Open the Windows PowerShell window (under Administrative Tools).

2. Provide the following command: Set-ADFSProperties  -ExtendedProtectionTokenCheck  None.

3. Close the PowerShell window.

4. Open the Internet Information Services (IIS) Manager (under Administrative Tools).

5. Expand Web Server node (left side), and then expand Sites > Default Web Site > adfs. Select ls
node.

6. Double-click Authentication under IIS.

7. Right-click Windows Authentication, and then select Advanced Settings.

8. Change the selection under Extended Protection to Off.
9. Close the IIS Manager.

10. Restart both the IIS and ADFS Services.
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Global Settings
Global settings control how CSM looks and behaves by default for all users or in some cases, users
assigned to specific Roles. Configure Global settings from CSM Administrator.
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Configure Global System Settings
Configure Global system settings for Search, Display, Dashboards/Calendar/Visualization, Catalog, Rich
Text, Record Locking, Help, and more. Most of these settings can be configured Globally, by Role, and by
user.

To configure the Global System Settings:

1. In the CSM Administrator main window, select the Settings category, and then select the Edit
System Settings task.

2. Select the Search page and configure the Global Search settings: Full Text Search, Quick Search,
and Knowledge Search settings.

3. Select the Display page and configure the Global Display settings: Multiple Monitor settings and a
default application skin.

4. Select the Dashboards page and configure these Global settings: default Dashboard, Calendar, and
Visualization settings.

5. Select the Catalog page and configure the Global Catalog settings: Whether or not to store primary
system definitions in a local catalog file on a user's machine, to allow users to decide whether to use
a definition catalog, and to force catalog files to be rebuilt each time a user restarts a CSM
application.

6. Select the Rich Text page and configure the Global Rich Text settings: Determines how images are
stored and shown in Rich Text Fields, size limits, and the custom default font for Rich Text.

7. Select the Locking page and configure the Global Record Locking settings: General Record Locking
settings, OOTB Record Locking settings for all Major Business Objects, and Portal Record Locking
settings.

8. Select the Globalization page and configure the Global Globalization settings: Determines culture
settings for your system. You can override these settings for Roles or for individual users.

9. Select the Help page and configure the Global Help settings: Help system settings, and whether to
globally enable/display Process and Terminology Help for Business Objects and Fields. Also
configure a custom Support phone number and a custom report error email address.

10. Select the Advanced page and configure the Global Advanced settings: Dashboard Widget refresh,
system notifications, web service call settings, and Google Analytics settings.
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Configure Global Search Settings
Global Search Settings are the foundational default search settings when the User and/or Saved Search
has not modified these preferences. Global Search Settings are configured in CSM Administrator >
System Settings > Search.

To configure search functionality and default options across various search types:

Text Search
(only applies to
Query Builder)

Select the default setting for how Query Builder searches fields:

• All Search Words Should Exist in the Same Field: Returns records only
when both words are found in a single Field (example: CSM and Software are
found in the same Field).

• Search Words Can Be Found in Different Fields: Returns records if both
words are found in different Fields in the same Business Object (example:
CSM is found in one Field and Software is found in another Field).

• Search For Different Forms of the Word: Returns records that have plural
and past tense forms of the word and different verb tenses. For example, if the
search is for find, the records found will be those with find, finds, found, etc.

Quick Search
should default
to using (only
applies toQuick
Search)

Select the default setting for how Quick Search searches fields:

• All Words: Search uses all words (AND is used to separate words in search).
With the Relevancy ranking, "noise" words ARE included in the search
(Example: "the" and "will"). An All Word search is better at finding records
where the user is looking for records containing all of the words in the search
string.

• Any Words: Search uses any of the words (OR is used to separate words in
search). With the Relevancy ranking, this option ranks records higher that
have more of the search words. An Any Word search is better at ranking
records by those containing the most instances of any words in the search
string.

Knowledge
Search should
default to using
(only applies to
Knowledge
Search)

Select the default setting for how Knowledge Search searches fields:

• All Words: Search uses all words (AND is used to separate words in search).
With the Relevancy ranking, "noise" words ARE included in the search
(Example: "the" and "will"). An All Word search is better at finding records
where the user is looking for records containing all of the words in the search
string.

• Any Words: Search uses any of the words (OR is used to separate words in
search). With the Relevancy ranking, this option ranks records higher that
have more of the search words. An Any Word search is better at ranking
records by those containing the most instances of any words in the search
string.
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Configure Global Display Settings
Use the Display page in the CSM Administrator System Settings window to configure Global Display
settings for Multiple Monitors and Desktop Client Application Skin.

Multiple Monitors
Specify where to open/restore CSM Application windows after they are closed (if there are multiple
monitors):

• Original Monitor
Window opens in the same location on the same monitor where it was last closed.

• Application Main Window Monitor
Window opens in the same location on the same monitor as the application Main window (the
upper-left of the main application is the control point if the application straddles multiple monitors).

• Mouse Pointer Monitor
Window opens in the same location on the same monitor as the mouse pointer. This option only
differs from the Application Main Window Monitor option when the User uses the keyboard to open
windows in CSM, and the mouse pointer is located on a different monitor from the one where the
application Main window is located. For example, if you have the CSM Main application on monitor
2, but bring up the One-Step Action Manager and drag it to monitor 1, when you edit an existing
One-Step Action, the Manager will appear on monitor 1, even though the main application is still on
monitor 2.

Note: This setting applies to all CSM databases (example: CSM Administrator) on your
current computer. Windows that always open fully on the screen are not governed by these
changes. If a window is too large to physically fit on the monitor, it will be snapped to the left
and/or top edges depending on if it is too big in just one or both dimensions. You might
notice this if you consistently drags windows partially off of the screen and expect them to
open that way the next time.

Application Skin
Select a default application skin from the Skin list to control the appearance of the Desktop Client and
Administrator Client shells. Options are Cherwell Light (default), Cherwell Blue, or Cherwell Dark.

The skin selected affects all Users by default. However, Users can change the application skin in the
Desktop Client, which only affects their personal interface.

Note: Users may need to close and reopen the Administrator Client for this change to take effect
in that client.

Web Appearance
You can choose to display form controls with right-angled or rounded corners.
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Configure Global Dashboard, Calendar, and
Visualization Settings

Use the Dashboards, etc. page in the CSM Administrator System Settings window to configure a Global
default:

• Dashboard (Home Dashboard)

• Heads Up Display (HUD)

• Calendar

• Visualization

To configure Global Dashboard, Calendar, and Visualization settings:

Default Dashboard Click the Dashboard button to open the Dashboard Manager, and then select an
existing Dashboard or create a new Dashboard to use as the system default.

Default Heads-up
Display

Click the Dashboard button to open the Dashboard Manager, and then select an
existing Dashboard or create a new Dashboard to use as the OOTB HUD.

Default Dashboard
Theme

In the drop-down, select a Dashboard Theme to apply to all Dashboards in the
system.

Default Calendar Click the Calendar button to open the Calendar Manager, and then select an
existing Calendar or create a new Calendar to use as the default.

Default config
visualization

Click the Visualization button to open the Visualization Manager, and then select
an existing Visualization or create a new Visualization to use as the default.
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Configure Global Catalog Settings
When the Desktop Client is initially launched, core system definitions are retrieved from the server and
stored in a local catalog file. Definitions do not need to be retrieved again unless a Blueprint is published.
Use the Catalog page in the CSM Administrator System Settings window to define Global setting for the
catalog, such as whether or not to:

• Store primary system definitions in a local catalog file on a User's machine.

• Allow Users to decide whether or not use a definition catalog.

• Force catalog files to be rebuilt each time a User restarts a CSM Application.

To configure Global Catalog settings:

Store Primary System
Definition in a Local
Catalog File on Users'
Machines

Retrieves core system definitions from the server when the Desktop Client
is initially launched, and then stores them in a local Definition Catalog file.
Definitions do not need to be retrieved again unless a Blueprint is
published.

Allow Users to Decide
Whether or Not to Use a
Definition Catalog

Allows Users to override the above default and set their own personal
Catalog defaults in the CSM Desktop Client (Tools>Options>General
page).

Invalidate all Current
Catalogs

Forces all local Catalog Files to be built the next time each User starts a
CSM Application.

387

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Configure Global Rich Text Settings
Use the Rich Text page in the CSM Administrator System Settings window to:

• Determine how images (example: Embedded screenshots) are stored and shown in Rich Text
Fields, including file type (JPEG or PNG), display mode (thumbnail or full), and size limits (in KB or
MB).

• Set default font for Rich Text.

To configure Global Rich Text settings:

Image Format Select either JPEG or PNG. Images not in a default format are converted to the default
image format (either JPEG or PNG).

Default
Display Mode  

Form Images
Are Displayed
As

Determines how embedded images are shown in the Rich Text Field:

• No Image Support: No image is shown.

• Small Thumbnails: A small thumbnail of the image is shown.

• Medium Thumbnails (default): A medium thumbnail of the image is shown.

• Large Thumbnails: A large thumbnail of the image is shown.

• Full Images: A full-sized version of the image is shown.

Zoomed
Images Are
Displayed As

Select an option (No Image Support, Small/Medium/Large Thumbnails, Full Images
(default)) to determine how embedded images in Rich Text Fields are shown in the Rich
Text Zoom window.

Size limits

• Maximum size per image (default is 500 kilobytes)

Note: If the image size exceeds the maximum size, the image will
automatically be re-sized to fit within the maximum size limits.

• Maximum total size for images (default is 3 megabytes)

Note: If the total image size exceeds the maximum size, the images will
automatically be re-sized to fit within the maximum size limits.
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Custom
Default Font

Uses a default font for all Rich Text Fields.

Click the Ellipses button to open the Font window. Select a Font, Font style, and Size.

Note:
The Rich Text Editor uses a default font based on the following settings, shown
in priority order:

• Field Properties for a specific Field in a Business Object (example:
Resolution fields in Problems).

• Default font selected in the Global Rich Text settings.

• Default Theme Form control font.

• CSM

• CSM global system font (not configurable)
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Global Record Locking Setting Options
Define the options below for Record Locking Settings.

Enable Record
Locking Enables Record Locking

Unlock Records when
User session ends
(Recommended)

Automatically unlocks all of a User's records when the User logs out of a
session. If cleared, the record remains locked until the record is saved (if
configured), until the lock expires (if configured), or until the record is manually
unlocked.

Update Lock Status
and Notify of Any
Changes, When
Possible

Automatically shows status and change notifications (example: Reload and
Merge) to the lock holder and any other User who might be viewing a locked
record. If not selected, Users are notified only if they attempt to edit a record.

Note: Automatic notifications are not available in the Browser Client.

Configure OOTB
Record Locking
settings for all Major
Business Objects

These OOTB settings can be overridden on a per Business Object basis by
configuring Record Locking settings for a Business Object.

Default Lock Type: Select one lock type.

• None: Does not enforce or inform record locking even though it is
enabled for the system. Tip: Use this option to enable record locking for
the system but not use it for most Business Objects, then enable/
configure Record Locking settings on a per Business Object basis.

• Enforced: Prevents Users from editing a record when it is locked by
another User (the lock holder).

• Informational: Warns Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two
Users do edit the same record, CSM gives Users the option to merge
the edits.

Default Lock Type

• None: Does not enforce or inform record locking even though it is
enabled for the system. Tip: Use this option to enable record locking for
the system but not use it for most Business Objects, then enable/
configure Record Locking settings on a per Business Object basis.

• Enforced: Prevents Users from editing a record when it is locked by
another User (the lock holder).

• Informational: Warns Users when a record is currently locked by
another User so that Users do not attempt to edit the same record. If two
Users do edit the same record, CSM gives Users the option to merge
the edits.

Lock Record Upon
Editing

Automatically locks the record when a User attempts to edit the record. If
cleared, Users must manually lock records.
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Unlock Record Upon
Saving

Automatically unlocks the record when a User saves the record. If cleared, the
record remains locked until the User ends his session (if configured), until the
lock expires (if configured), or until the record is manually unlocked.

Lock Expires After

Enables lock expiration and specifying the time limit in minutes (example:
30). If cleared, the record remains locked until the User ends his session (if
configured), until the record is saved (if configured), or until the record is
manually unlocked.

Minutes Before Lock
Expiration to Notify
Users

Notifies Users of impending expiration and allow renewal before expiration.
Users can specify the number of minutes before expiration to notify Users
(example: 3 minutes).

Maximum Number of
Records a User Can
Have Locked at One
Time (Per Business
Object Type)

Specify the maximum number of records a User can have locked at one
time, per Business Object (example: Each User can lock only ten Incidents at
a time).

Customer Portal
Settings

Portal Participates in Record Locking (applicable only for enforced locking):
Allows Customers working in the Portal to lock records and see locks on
records.

Note: When a Customer attempts to edit a record, the record is automatically
locked; and, when the Customer saves the record, the record is automatically
unlocked. This prevents Users from editing records at the same time as
Customers. However, the Customer does not see messages about locks
unless they attempt to edit a record that is locked by another User or
Customer.

Note: If the Portal does not participate in record locking (or record locks are
Informational), the Customer is able to edit records even if a User has the
record locked. The User is given the option to merge the Customer’s edits.
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Configure Global Help Settings
Use Global Help system settings to provide an alternate help site to your users and customize support
contact settings. Access Global Help settings from CSM Administrator (Settings > Edit System Settings
> Help).

Alternate Help Site
Define a custom Help System or site instead of the OOTB CSM Help System.
After selecting the Alternate Help Site checkbox, provide an alternate Help
System URL.

Pass Parameters Select the Pass Parameters checkbox to enable passing parameters for the
provided Help System URL.

Show Process and
Terminology Help

Enables Process and Terminology Help in CSM. Process and Terminology Help
text is defined in the Process and Terminology pages in the Business Object
Properties or Field Properties windows.

Disable Reporting
Error

By default, CSM allows users to send a Report Error e-mail to the Cherwell
Support Team. Select the Disable Reporting Error checkbox to disable the send
error reports feature.

Alternate Report
Error E-mail

Provide a custom e-mail address for error reports to be sent to instead of the
default Cherwell Support Team e-mail address.

Alternate Support
Phone Number

Provide a custom Support Team phone number instead of the default Cherwell
Support Team phone number.

Note: The Cherwell Support Team phone number will remain in several
error messages, (e.g., upgrade errors) as directly contacting Cherwell
Support is the best way to solve those problems.
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Configure Global Advanced Settings
Use the Advanced page in the CSM Administrator System Settings window to configure the following
Global Advanced settings:

• How many Dashboard Widgets to refresh simultaneously.

• How long to wait between notification checks.

• How to handle web service calls.

Note: No Role or User Advanced settings are available.

• How to configure the Google Analytics Tracking ID to enable tracking for the CSM Portal.

About configuring the Global Advanced settings:

Max
simultaneous
Widget refresh

Define the maximum number of Widgets that can be refreshed simultaneously
(default is 5). Use the up/down arrows to increase/decrease the number.

Note: When a Dashboard is set to reload its data, it will combine refresh
requests. Increasing this number might make Dashboards update more
smoothly, but might also increase network traffic and slow down other Users/
operations.

Configure
Notification
Settings

The Cherwell Application Server sends messages to clients regarding updates
(example: Definitions need to be reloaded, Queues need to be updated, or records
have been locked, etc.). This information is attached to regular requests from the
client to the server. However, if the client has not communicated with the server
within the maximum notification time, the client checks for updates.

You can set the maximum amount of time between client notification checks and
server notification checks.

Note: Decreasing these values can make clients get updated data more
frequently, but also increase network traffic.

Web Service
Settings

The settings defined here might override some of the settings defined when you set
up a web service.
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Calling Web
Services from
Client

Select an option for allowing web service calls from a client.

• Allow: Select this option to allow web services to be called from a client.

• Don't Allow: Select this option to prevent web services from being called by
clients. Users who try calling a web service from a client will receive an error.

• Force to Server: Select this option to force client web service calls to the server.

• Based on Security: Select this option to determine whether a client can call a
web service based on security rights (Allow calling web services from client
machine).

Unsecured
Calls (HTTP)

Select an option for unsecured web service calls.

• Allow: Select this option to allow unsecured (HTTP) web service calls.

• Don't Allow: Select this option to prevent unsecured web service calls. Users
who try making unsecured calls receive an error.

• Force to HTTPS: Select this option to have all unsecured web service calls
forced to HTTPS.

Allow self-
signed
certificates
(HTTPS)

Select this check box to allow calls to web services with self-signed certificates
(certificates not signed through a signing authority such as VeriSign).

If this box is cleared, Users receive an error whenever they try to call a self-signed
web service.

Auditing

Select an option for determining what to audit (log).

• None: Select this option to audit nothing.

• Based on Service Settings: Select this option to audit based on the web
service's auditing setting.

• All Web Service Calls: Select this option to audit all web service calls.

• Server-Based Calls: Select this option to only audit web service calls made
from the server.

Note: Web service calls are audited by writing an entry into the Cherwell
Application Server log (which can write to a file, to the event log, or to an
external logging tool such as Splunk). The log must be configured for web
service calls to be captured.

Analytics
Select the Google Analytics Tracking ID (Portal) check box and provide your
Google Analytics Tracking ID to enable the tracking of data for your CSM Portal sites.
See Tracking Portal Use with Google Analytics.
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Warning: Using the Use legacy rules for related data retrieval check box is not recommended.
It allows the system to emulate legacy behavior. Doing so loads Relationships beyond the second
level and can severely degrade system performance or cause recursion problems.

Related information
Track Portal Use With Google Analytics
Tips for Using Google Analytics with CSM
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Configure Global User Queue Settings
Configure default options for each automatically created User Queue, including defining a History Record
to track Queue options and enabling ownership transfer if records in a User Queue.

User Queue settings are defined in CSM Administrator.
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Open the User Queue Settings Window
To open the User Queue Settings window from the CSM Administrator main window, click the Settings
category, and then click the Edit User Queue Settings task.
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Define User Queue History Settings
Use the User Queue History Settings window to define Queue History Journal records to track Queue
operations (example: Add to Queue, check in, check out, reassign, suspend, unsuspend, remove).

To define User Queue History settings:

1. Open the User Queue Settings window.

2. Select Queue History Journal options for Queue operations (Add to Queue, Check Out, Check In,
Reassign, Suspend, Unsuspend, Remove): Select one of the following options from the
corresponding drop-down:

◦ Auto-generate: Select this option to automatically create a Queue History Journal record
containing default text when the action takes place.

◦ No History: Select this option to create no Queue History Journal record when the action
takes place.

◦ Optional: Select this option to prompt the User to add notes to the Queue History Journal
record when the action takes place. It also allows the User to select not to create a Queue
History Journal record.

◦ Prompt: Select this option to prompt the User to add notes to the Queue History Journal
record when the action takes place, but does not allow the User to cancel the Queue History
record.

Notes: Canceling the prompt will cancel the entire Queue operation. If a record is added to a
Queue using an automated process (example: Automation Process), the Optional and Prompt
options will add History, but use default text.

3. Select OK.
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Transfer Ownership When Record is Placed in User
Queue

Use the User Queue History Settings window to define if Users can transfer record ownership to a specific
User when a record is placed in a User Queue.

To transfer record ownership when a record is placed in a User Queue:

1. Open the User Queue Settings window.

2. Select the Transfer ownership to User when record put on User Queue check box.

3. Select OK.
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Configure Global Task Pane and Search Control
Settings

Configure which items appear in the Task Pane or which Search Control is used on the CSM Menu bar.
These settings can be applied to globally all Users or for Users assigned to specific Roles.

To configure Global/Role Task Pane and Search Control settings:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit Default
Task Panes and Menu Search task.

Note: Default is a Global default and applies for all Users/Roles unless overridden. The
small green check mark indicates that Task Pane and Search Settings have been defined for
a particular Role. If no defaults are defined for a Role, members of that Role see the Task
Pane and Search Settings for the Global default, if defined.

2. Click Default (Global) or a Role, and then click the Edit button.

The Global or Role Task Pane and Search Settings window opens (our example shows how to edit
the OOTB task pane and search settings, which applies to all Users and becomes the Default Task
Pane Setup).

3. Configure Task Pane settings:
◦ View or hide sections.

◦ Add new sections.

◦ Configure sections (only applicable to new sections).

◦ Delete sections (only applicable to new sections).

◦ Organize sections.

4. View or hide the following sections in the Task Pane (select or clear the corresponding box):
◦ Quick Search

◦ Common Tasks

◦ Actions

◦ Queues

◦ Process and Terminology

◦ Customer Information

5. Add Sections to the Task Pane:

Note: Any items added to the Global Task Pane become part of the Global default task pane
setup. If editing the Task Pane and Search settings for a Role, select the Use default task
pane setup check box to use the settings defined for the Global default. This check box
must be cleared to add items to a Role Task Pane.

a. Click Add.
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b. Provide a title for the Task Pane section.

c. Click Add to open the Action Manager.

d. Select the CSM Items to show in the Task Pane (Calendars, Commands, Dashboards,
Document Repositories, One-Step Actions, Reports, Searches, or Visualizations).

e. Select OK.

Tip: Click Configure to edit the title and list of Actions for a newly added section. Click Delete
to delete a newly added Task Pane section. Use the up/down arrows to change the order of
Task Pane sections.

6. Customize the CSM Search Control in the Menu bar Search Options:
◦ Use Default: Uses the OOTB Search Menu Search Widget, which allows Users to run a Quick

Search on multiple Business Objects simultaneously (example: Knowledge Article, Incident,
Problem, and Change Request). Users can also select a Business Object in the drop-down to
search one item at a time (example: Specific Search).

◦ Use Search Widget: Uses a specific Search Widget. Click the Ellipses button to open the
Widget Manager, and then select an existing Search Widget or create a new Search Widget.

◦ No Menu Bar Search: Removes the Search Control from the menu bar.
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Configure Custom Global Toolbars
Create and configure custom Desktop Client toolbars to provide quick access to CSM operations for all
Users or Users assigned to particular Roles.

Note: Custom Global toolbars are not available in the Browser Client.

To configure a custom Global toolbar:

1. In the CSM Administrator main window, select the Settings category, and then select the Edit
Custom Toolbars task.
The Configure Toolbars window opens. Default is a Global default and applies for all Users/Roles
unless overridden. The small green check mark indicates that a custom toolbar has been defined for
a particular Role. If no defaults are defined for a Role, members of that Role see the custom toolbar
for the Global default, if defined.

2. Select Default (Global) or a Role, and then select the Edit button.
The toolbar for <Global/Role> opens.

3. Select the Add button.
4. Define general properties and Actions for the toolbar:

a. Name: Provide a name for the toolbar. This is the name that shows in the toolbar context
menu (in the Desktop Client, right-click toolbar to show a context menu of available toolbars to
display).

b. Show by Default: Shows the custom toolbar in the Desktop Client by default. Otherwise, Users
have to manually show it (right-click toolbar>select a toolbar to display).

c. Add Action: Select this button and select the type of Action to add to the custom toolbar
A CSM Item Manager opens (varies by type of Action selected in the previous step), and then
select/create the CSM Item to initiate through the Action.

d. Select a CSM Item (example: A specific Dashboard).
e. Define properties for the Action:

◦ Action: Shows the name of the Action as it is recognized by CSM (example: Name of the
Dashboard or Report).

◦ Display text: Provide the text to show on the toolbar button if Show text on button
(below) is selected.

◦ Image button:

Select the Image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

◦ Help text: Provide a tooltip to show when the cursor is on the menu item.
◦ Begin group: Shows a horizontal line before the menu item, separating it from other

menu items.
◦ Show text on button: Shows the Display Text on the toolbar button.

f. Add additional Actions to the toolbar.
5. (Optional) Create additional custom toolbars.
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Configure CSM Remote Support Settings
Use the Chat and Remote Support Connector Settings window in CSM Administrator to configure how
CSM accesses and initiates remote support systems, how CSM identifies Customers requesting remote
support, and which Business Objects are linked to remote support sessions.

You can use the BeyondTrust Remote Support mApp Solution to easily configure a remote services
integration.

For detailed information, see:

• Define General Settings

• Define Identify Customer Settings

• Define Business Object Settings

To configure CSM remote support settings:

1. In CSM Administrator window, select the Settings category, and then the Edit Chat and Remote
Support Connector Settings task.

The Chat and Remote Support Connector Settings window opens.

2. Define General page settings for remote support:
a. Enable Chat and Remote Control Services.

b. Define Chat Service Credentials.

c. Define Cherwell Credentials for Processing Chat Service Events.

d. Define Chat Service Technician Queue options.

e. Define Chat Service Support Issue Queue options.

f. (Optional) Create a remote support session invitation e-mail template that CSM technicians
can use to invite Customers to remote support sessions.

3. Define Identify Customer page settings: Define how CSM identifies Customers requesting a support
session from the Portal.

a. Define options for Self-Service Portal Customers Logged In.

Note: If no options are selected and the Customer is not prompted to select a support
issue, no window opens for the Customer to provide information.
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b. Define options for Self-Service Portal Customers Not Logged In.

When any or all of these options are selected, a window opens to prompt the Customer to
provide the specified information when a new remote support session is requested.

4. Define Objects page settings: Define which Business Objects are linked to remote support sessions
and create One-Step Actions for processing session information.

5. Select Add, Edit (Add and Edit open the Chat Actions window), or Remove for existing Business
Objects in the list, or Clear Default.

6. From the Chat Actions Window:
a. Specify the Chat Action Behavior (Create or Update):

Note: The CSM Desktop Client and Portal both support creating new Business Objects
at the end of a remote support session. In the Desktop Client, if a Business Object is
currently in focus, the new Business Object is created under the Customer that owns
the current Business Object. If no Business Object is in focus, the new Business
Object is created under the default Customer designated in the Chat and Remote
Support Connector Settings. When a Customer launches a remote support session
from the Portal, a new Business Object can be created under the currently logged-in
Customer, the Customer identified by email address, or a default Customer if the
Customer could not be identified. If no default Customer is configured and a Customer
cannot be identified, a new Business Object might not be created.

Note: The option to create a new Business Object to associate with the remote
support session must also be selected in the New Chat Session command options in
order for a new Business Object to be created at the end of a remote support session,
and to have remote support session history attached to it.
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b. Select Add and select the Action from a list: Create New, Update, Add to a Queue, Run a
One-Step Action.

7. Specify the Actions that should be performed when the selected Business Object type is created at
the end of a remote support session: Select Add, Edit, Copy, or Delete.

Note: When a remote support session is not launched from CSM, CSM does not have any
information about the type of Business Object to create after a session ends. By setting a
Business Object as the default, CSM creates a new object of the specified type if no
Business Object information is available when a remote support session has ended. If no
default Business Object is selected and a remote support session is not initiated through
CSM, the event is ignored and no action taken.

8. Select OK.
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Define General Settings
The General Settings define how CSM accesses and initiates remote support (the URL for the remote
service, login information, queue selection, and email invitation template).

Setting Description

Enable Chat and Remote Control
Services

Enables remote support (example: BeyondTrust) through CSM. When
this option is selected, the Remote Support Service commands appear in
the menu bar of the CSM Desktop Client under Tools>Chat.

Note: Clear this check box to temporarily disable remote support
integration while still keeping other settings.

Service URL Provide the base URL for the remote support service API. Security
Warning: Use HTTPS for this URL to ensure security.

Chat Server IP Address
(Optional) Provide the IP address of the remote support server
(determined from the CWS server). If specified, remote support event
notifications are allowed only when originating from this IP address.

Chat Service Credentials Provide the User Name and Password for a remote support service user
authorized to perform API requests.

Cherwell Credentials for Processing
Chat Service Events

These are the credentials a CWS uses to log in to CSM to process
information from the remote support service after a remote support
session ends.

Use Active Web Service Credentials: The CWS uses its current
Windows login credentials. Create a corresponding Windows User in
CSM using the same Windows user name. This User must have the
proper security rights to process events, run One-Step Actions, and
create or modify Business Objects and Customer Records. Typically, this
user name is IIS AppPool\DefaultAppPool or something similar (the exact
user depends on the CWS configuration)

Use Specific Cherwell User: Use a CSM User login (internal or
Windows user). Provide the User name and Password of the CSM User
that is used for logging in to process remote support events. This User
must have the proper security rights to process events, run One-Step
Actions, and create or modify Business Objects and Customer Records.
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Setting Description

Chat Service Technician Queue

These options (only supported in the CSM Desktop Client) allow CSM
technicians to have remote support sessions placed in their personal
queues in the BeyondTrust Representative Console.

Select Technician Queue Using Current User Login: Match the user
name for the currently logged-in CSM technician against the usernames
of all CSM technicians who are currently logged into the BeyondTrust
Representative Console. If a match is found, the remote support session
is created within that technician’s queue

Select Technician Queue Using Login Stored In Current User
Business Object: Match the user name stored in a Field in the User
Business Object (UserInfo) for the currently logged-in technician against
the user names of all technicians who are currently logged into the
remote support system. If a match is found, the remote support session is
created within that technician’s queue. To indicate which Field contains
the technician's user name, add an attribute with the name
ChatUserName to the Field. For more information about Field attributes,
see Define Advanced Properties for a Field.

Chat Service Support Issue Queue

These options determine whether a Customer can select from a list of
support issues when launching a remote support session, or whether all
remote support sessions launched by Customers are categorized under a
specified support issue.

Prompt for Support Issue: Select this option to have a pop-up open for
the Customer to select from a list of issues downloaded from the remote
support system.

Always Use a Specific Support Issue: Automatically use a specified
issue. Default indicates that the request should be placed in the general
queue in the remote support system.

Select Issue: Select a specific issue to use, which determines the queue
the request is placed in.

Note: If the Technician queue options described above are enabled and a
Technician match is found, the support issue queue options are ignored
and the remote support session is created in the technician’s personal
queue.

Chat Invitation E-mail (Optional) Create a remote support session invitation e-mail template that
CSM technicians can use to invite Customers to remote support sessions.
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Create the Remote Support Session Invitation E-
mail Template

In the CSM Desktop Client, when a technician selects the command for a new remote support session, an
email message is constructed and sent to Customers to invite them to participate in the session. In the
Portal, a remote support session is immediately started when a Customer selects the New Chat Session
command.

To create a remote support session invitation e-mail template:

1. In CSM Administrator, select the Settings category, and then the Edit Chat and Remote Support
Connector Settings task.

The Chat and Remote Support Connector Settings window opens.

2. On the General page, click the Chat Invitation E-mail button.

3. Use the following options to design an email template:
a. Select the Selector button or right-click in the e-mail template to insert Expressions, functions,

and variables into the template.

Tip: Use Expressions, functions, and variables to insert conditional/actual values into the
email when it is created.

b. Select Variables in this list to view a list of variables associated with remote support session
requests. The following variables are available:

Variable Name Description

Chat Session URL URL that can be used to initiate the remote support session.

E-mail Address Email address of Customer.

Object Name Name of Business Object with which a remote support session is associated.

Object Plural Name Plural name of Business Object with which a remote support session is
associated.

Provider E-mail Body

Text for the body of the email returned by the remote support system. The body
of a Customer invitation email is configured the remote system. The generated
email body can be passed to CSM through the API and used in lieu of the
remote support session invitation email template in CSM.

Provider E-mail
Subject Text for the email subject returned by BeyondTrust.

Support Issue Name of the support issue selected by the Customer (if any).

Team Name Name of the team queue the remote support session request is submitted to (if
any).
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Define Identify Customer Settings
At the end of remote support sessions, Business Objects can be created or updated and associated with
remote support session histories. Use the Identify Customer page to define how to identify Customers
under whom Business Objects can be created at the completion of remote support sessions.

In the Portal, when a command to start a remote support session is selected, an optional window can
open to prompt the Customer for a user name, company, e-mail address, support issue (if enabled on the
General page in the Chat Service Support Issue Queue area), and issue description. This information is
passed to a support technician in the remote support system at the start of the remote support session. If
the Customer is not currently logged into the Portal, the e-mail address she enters (if any) is used in an
attempt to identify her.

Self-Service
Portal
Customers
Logged In

Select the check boxes next to the types of information a Customer who is logged into
the Portal should be prompted to enter when they launch a new remote support
session. This information is passed to the remote support system with the request to
start a session.

• Name: Prompts the Customer to enter her name.

• E-mail Address: Prompts the Customer to enter her e-mail address.

• Company: Prompts the Customer to enter her company name.

• Issue description: Prompts the Customer to enter a description of the problem she
is experiencing.

When any or all of these options are selected, a window appears to prompt the
Customer to provide the specified information when a new remote support session is
launched.
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Self-Service
Portal
Customers
Not Logged
In

Select the check boxes next to the types of information a Customer who is not logged
into the Portal should be prompted to provide when they launch a new remote support
session. This information is passed to the remote support system with the request to
start a remote support session. In addition, the e-mail address is used to attempt to
identify the Customer in CSM.

• Name: Select this check box to prompt the Customer to enter her name.

• E-mail Address: Pompts the Customer to specify her e-mail address. If the
Customer provides an e-mail address, the e-mail address is matched against
CSM User Records according to the additional Identify options in an attempt to
identify the Customer.

• Company: Prompts the Customer to provide her company name.

• Issue description: Prompts the Customer to provide a description of the problem.

Identify Customer by Matching E-mail Address to Default E-mail Address Fields: If
this option is selected and no current Customer is logged into the CSM Portal, the e-
mail address entered by the Customer (if any) is matched against the default e-mail
Business Objects and Fields.

Search All Contact Manager Objects: If this option is selected and no current
Customer is logged into the CSM Portal, in addition to searching the default Business
Objects and Fields, the e-mail address entered by the Customer (if any) is also matched
against Fields having the E-mail Address attribute in all Contact Manager Objects.

Identify Customer by Matching E-mail Address to Specific Business Object and
Field: If this option is selected and no current Customer is logged into the CSM Portal,
the e-mail address entered by the Customer (if any) is matched against the e-mail
Business Object and Field selected in the drop-downs.

Note: If no options are selected and the Customer is not being prompted to select a
support issue, no window opens for the Customer to provide information.

If no
Customer
identified or
associated
with chat
session use
default

Select the Customer Identified or Associated with Chat Session, Use Default check
box to select a default Customer from the Contact Manager.

Click the Ellipses button (shows Default if check box is selected or select Customer if
cleared). In the following cases, CSM creates Business Objects at the end of a remote
support session under a default Customer:

• Customer is not prompted to provide an e-mail address.

• CSM could not find a match to the Customer's e-mail address in Customer
Records.

• The remote support session was not initiated through CSM (example: sessions
launched from the remote support system.

Note: If this option is not selected, and no Customer information for a completed remote
support session is available, the session event is ignored and no processing takes
place.
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Define Business Object Settings
Business Objects must be defined for Business Object Records to be created or updated and associated
with remote support session history.

Add Select to add the highlighted Action. See Chat Actions window options below.

Edit Select to edit the highlighted Action. See Chat Actions window options below.

Remove Select to remove the highlighted Action.

Up/Down
Arrow
buttons

Select to change the order of the selected Actions.

Clear
Default

Select or clear Business Object defaults to determine what type of Business Object
CSM creates after the end of a remote support session that was not launched from CSM
(example: sessions launched from the BeyondTrust Web Portal or BeyondTrust
Representative Console).

• If the currently selected Business Object type is not the default, select Make Default
to make it the default.

• If the currently selected Business Object type is already the default, select Clear
Default to change it to no longer be the default.

Note: When a remote support session is not launched from CSM, CSM does not
have any information about the type of Business Object to create after a session
ends. By setting a Business Object as the default, CSM creates a new object of
the specified type if no Business Object information is available when a remote
support session has ended. If no default Business Object is selected and a
remote support session is not initiated through CSM, the event is ignored and no
action taken.
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Configure Cherwell Mobile Settings
The Cherwell Mobile applications for iOS and Android were deprecated in March 2019 and are no longer
available in their respective application stores. Cherwell Mobile applications that are already installed
should continue to work as expected, however.

To replace Cherwell Mobile and accommodate users on any device, including mobile devices, use
Adaptive Layouts to design Forms and Dashboards that adapt to different dimensions.

Cherwell Mobile settings define which:

• Mobile Dashboard (Home) to display by default.

• Mobile Dashboard (Alert) to display by default.

• Business Objects to make available. Associated Saved Searches will also be available.

• Actions/One-Step Actions to allow for each Business Object.

The default Cherwell Mobile settings (either Global or Role) are initially configured in CSM Administrator.
Users with security rights can configure their personal Cherwell Mobile settings.
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Configure Global/Role Cherwell Mobile Settings
Use the Mobile Configuration window in CSM Administrator to configure how Cherwell Mobile looks and
behaves on mobile devices, Globally or by Role. You can configure which:

• Mobile Home Dashboard to display by default.

• Mobile Alert Dashboard to display by default.

• Business Objects to make available. Associated Search Groups will also be available.

• Actions/One-Step Actions to make available for each Business Object.

To configure Global/Role Cherwell Mobile settings:

1. In the CSM Administrator main window, click the Browser and Mobile category, and then click the
Edit Mobile Configuration task.

The Mobile Configuration window opens, listing the available Roles (Default is a global default, is
always defined, and applies for all Users/Roles unless overridden). The small green check mark
indicates that settings have been configured for a particular Role.
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2. Click Default (Global) or a Role, and then click the Edit button.

Note: Our example uses Global. If you select a Role, you have the option to override the
Global default and configure Cherwell Mobile settings from scratch.

Tip: Click the Clear button to clear configured settings for a selected Role. If no defaults are
configured for a Role, members of that Role see the Global default settings (which cannot be
cleared).

The Mobile Access Setup window opens, listing the objects (Dashboards and Business Objects)
currently being displayed on mobile devices.

3. Select default Mobile Dashboards (Home and Alert):

Tip: If you do not want to display any Dashboards, remove the Dashboard item from the List of
Objects to Display on Mobile Device list.

a. Home Page: Select a default Mobile Home Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards.
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◦ Click the Mobile Dashboard button to open the Mobile Dashboard Manager, and then
select an existing Mobile Dashboard or create a new Mobile Dashboard.

b. Alerts Page: Select a default Mobile Alert Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards

◦ Click the Mobile Dashboard button to open the Mobile Dashboard Manager, and then
select an existing Mobile Alert Dashboard or create a new Mobile Alert Dashboard.

4. Select the Business Objects to make available in Cherwell Mobile:

Important: In order for a Business Object to be available, it must have the Show in Search
Manager property set (in the Business Object properties within a Blueprint).

a. Override List of Objects to Display on Mobile Device: Select this check box to override the
current Global default list of Business Objects. This check box does not appear when
configuring Global defaults because there is nothing above them to override.

b. Click Add, and then select the Business Object to make available on mobile devices.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from the list.

c. Define how to display the Business Object in Cherwell Mobile:
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◦ Custom Name: Provide a display name to use in Cherwell Mobile. If blank, the Business
Object name is displayed.

◦ Custom Image:

Select the Image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

If no image (None) is selected, the default image for the Business Object is displayed.

Android: Android devices use standard color images. For the best results, use the
images in the BusObs>32x32 folder in the Image Manager. If you are setting up a mobile
configuration for use on both Android and iOS devices, use the iPhone-specific images.
They will be automatically mapped to equivalent standard images for non-iOS devices.

d. Select the Actions/One-Step Actions to make available in Cherwell Mobile:
i. Click Add to add a new Action/One-Step Action to the list.

Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from
the list. Use the Up/Down arrows to change the order of the Actions/One-Step Actions
when displayed in Cherwell Mobile (ex: In the Actions list).

ii. Define additional options for the list of Actions:
◦ Also Show Default Business Object Actions: Select this check box to also make

available any default Actions for the Business Object. This option is only available if
the Business Object has default Actions available (ex: Approvals have built-in
functionality to approve, deny, and abstain).

◦ Also Show Global Actions: Select this check box to make available any Actions that
were defined for the Business Object as part of the Global default settings.

Note: This option is available only if you are configuring settings for a Role.

5. Configure the order of the Actions when displayed in Cherwell Mobile (ex: On the Actions popup
list):

a. Use the Up/Down arrows to order the Actions.

6. Select OK.
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Concurrent Development
Concurrent development allows multiple designers to simultaneously work on system changes, which is an
essential technique for increasing the productivity of large IT organizations. In CSM, simple and complex
system configuration is done using Blueprints or mApp® Solutions.

418

CSM 10.0.0 Administration

CSM 10.0.0 Administration



CSM System Design Using Concurrent
Development

When you use Blueprints for concurrent development, you use two or more Blueprints to develop the
functionality and then apply each Blueprint to the production environment.

Overview
When you use mApps for concurrent development, you have two options:

• Use two or more Blueprints to develop the functionality and then create a mApp to apply the
functionality into the production environment.

• Use two or more mApps to develop the functionality and then apply each mApp to the production
environment.

These approaches have several advantages:

• Complex changes can be developed and expanded over a long period of time without affecting
current Users.

• The changes themselves can be applied during downtime without requiring the actual design work
to be done after hours.

• Designers can experiment with various independent changes or work on different design projects.

• The same set of changes can be applied to a test system, and then later be applied to the
production environment.
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However, when multiple designers are working on system configurations at the same time, conflicts,
overwrites, errors, and other undesirable results can occur. For example, if one designer works on
Incident Fields and then another designer modifies the Incident Form with additional fields, the work of the
second designer could overwrite the work of the first designer.

Use the guidelines and best practices in this document enable multiple designers to work simultaneously
on system changes.
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Best Practices for Concurrent Development
Use the following best practices as part of your organization's Software Development Lifecycle (SDLC) to
enable multiple designers to work simultaneously on system changes.

Communicate, Communicate, Communicate
Communicate with your team as much as possible. The level of communication will vary based on project,
but ensure that the following information is shared at the very least:

• The Major Business Object and any associated Supporting or Lookup Table Objects that you will
work on (example: I'm going to work with Incident and Tasks). Also communicate any associated
Views or features.

• Features (example: Calendar) you will work on that do not have an associated Business Object.

Communication might include:

• Setting up automatic e-mail notifications (possible in most software).

• Manually sending e-mail or chat messages.

Decide Whether to Use a Blueprint or mApp
Before beginning the project, decide whether to use a Blueprint or mApp for your system configuration by
considering the characteristics and benefits of each.

Blueprints allow you to:

• Use two or more Blueprints to develop the functionality and then apply each Blueprint to the
production environment.

• Use the Blueprint Changes window to view a list of changes included in the Blueprint, remove
selected changes from the Blueprint, and compare the version of a change in the Blueprint with the
version of the item in the current system.

• Use the Resolve Blueprint Conflicts window to view a list of conflicts between your Blueprint and the
current schema. Choose item by item which changes to apply and which to discard.

mApps allow you to:

• Use one of two options:
◦ Use two or more Blueprints to develop the functionality and then create a mApp to apply the

functionality to the production environment.

◦ Use two or more mApps to develop the functionality and then apply each mApp to the
production environment.

• Use the Blueprint Changes window to view a list of changes included in the Blueprint, remove
selected changes from the Blueprint, and compare the version of a change in the Blueprint with the
version of the item in the current system.

• Specify what to import down to the field level of a Business Object.
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• Define the specific merge action to take for each item (example: import, overwrite, delete, etc.).

• Rebase (refresh definitions) by looking at the current system's version of each item included in the
mApp and bringing the older definition up to parity with the latest definition.

Assign Business Object and Feature Owners
Assign individual Business Objects (including their Views and associated features) and features (that do
not have an associated Business Object) to different designers as their area of responsibility. For
example, one designer is responsible for Incident changes (including the Portal View for Incident) and
another designer is responsible for Calendar changes. If multiple designers need to work on the same
Business Object or feature, ensure that the designers are using a check-in/check-out process (refer to the
Create a Check-In/Check-Out Process section below).

Create Multiple Working Databases
Use multiple CSM databases when implementing concurrent development using Blueprints or mApps:

• Have one independent development database for each designer.

• Have one master development database where one or more gatekeepers are allowed to make
changes.

Designers can use their independent development databases (which are restored using the master CSM
development database) to develop their individual system configurations. Only approved changes are
applied to the master development database (which is restored using the current production
environment).

Create Frequent Backups
Before publishing Blueprints or applying mApps to the master development database, create a
backup .czar file of the system. If the Blueprint or mApp causes significant errors, the database can be
restored using the backup file. Also, consider automating frequent backups using the Backup Database
option of the Scheduler.

Use a Consistent Naming Convention
Ensure that all Blueprints and mApps follow a consistent naming convention that includes:

• When the Blueprint or mApp was created.

• The primary Business Object.

• The designer’s name.
(example: 2016-12-10-Incident-Johnson.bp or 2016-12-10-Incident-Johnson.mapp)

Store all final Blueprint or mApp files in a common location in a network share. Then, the Blueprints or
mApps can easily be grouped together and applied to the production system in the appropriate order.
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Evaluate Security Risks
Consider security risks to both development and production environments throughout the lifecycle of the
project. Risks might involve:

• Customer data, including personal or company information.

• Business Object data, including existing active and inactive records.

• Impacted CSM Services, such as Application Service, Automation Process Server, etc.

• Impacted external connections, such as SCCM, Outlook, Active Directory, etc.

(Optional) Create a Check-In/Check-Out Process
If more than one designer must work on the same Business Object, create a process similar to the
following that allows designers to check out a particular Business Object:

1. Create a master list of all target Business Objects. This can be done using a custom Business
Object in CSM, a spreadsheet, or a wiki page.

2. Notify all other designers and update the master list when an item is checked out. The checkout
lasts until the changes have been approved by the gatekeeper and applied to the master
development database.

3. Create a .czar of the updated master development database. The next time work is done on the
item, the designer must use new .czar.

4. Notify all other designers and update the master list when an item is checked in.

5. Repeat steps two through four until work on the item is complete.
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Using Blueprints or mApps for Concurrent
Development

Use the following workflows to accommodate multiple designers simultaneously working on system
changes using Blueprints or mApps.

Use Blueprints for Concurrent Development
When you use Blueprints for concurrent development, you use two or more Blueprints to develop the
functionality and then apply each Blueprint to the production environment.

To use Blueprints for concurrent development:

1. Project Manager creates a rollout document. The document should be detailed and include the
following information at the very least:

◦ A list of stakeholders, including:
◦ Business Object owners who are the sole developers assigned to work on a particular

Business Object, including its Views (example: Portal View) and features (example:
Dashboards, Widgets, One-Steps, etc.).

◦ Feature owners who are the sole developers assigned to work on a particular feature
(example: Calendar) that does not have an associated Business Object.

◦ A gatekeeper who ensures that the Blueprint adheres to requirements and follows team
standards (example: Naming conventions, design guidelines, etc.) before being
published.

◦ A product manager who is responsible for the scope and outcome of the project.

◦ Required external connections (example: SCCM, Outlook, Active Directory, etc.).

◦ Impacted CSM Services (example: Application Server, Automation Process Server, etc.).

◦ System configurations that must be done outside the Blueprint. These might include changes
to Security, the Scheduler, E-Mail Monitor, etc.

◦ Test plans, including any user acceptance test requirements.

◦ A backup and recovery plan.

2. Create a development environment for by restoring the master development server to the current
production environment. When creating this environment, consider the following:

◦ Create one copy of the production environment and store it in a shared location.

◦ You do not need to include Attachments in the file unless you are specifically testing their
functionality.

◦ Ensure that all impacted CSM Services (example: Application Server, Automation Process
Service, etc.) are disabled. If you need to test E-mail Monitor functionality, make sure to
configure the test e-mail account.

3. Develop the functionality.
a. Designers make individual copies of the master development database.

b. Designers communicate which Business Objects and features they intend to work on.

424

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=managing_external_connections
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=configure_test_and_production_accounts


c. Designers develop the functionality using individual databases.

4. Conduct internal testing on the first Blueprint:
a. Reference the rollout document to ensure that:

◦ The current Blueprint is intended to be published first.

◦ The Blueprint includes all of the required system configurations.

b. Publish the Blueprint using the master development environment.

c. Test the Blueprint.

d. Edit the Blueprint or create a new Blueprint based on test results.

e. Repeat internal testing (steps a through d) until the gatekeeper approves the Blueprint.

f. Update the rollout document. Make sure to include any additional system configurations that
were done outside of the Blueprint.

5. Conduct internal testing on the second Blueprint using the development environment that includes
the first published Blueprint:

a. Reference the rollout document to ensure that:
◦ The current Blueprint is intended to be published second.

◦ The Blueprint includes all of the required system configurations.

b. Publish the Blueprint using the master development environment.

c. Test the Blueprint.

d. Edit the Blueprint or create a new Blueprint based on test results.

e. Repeat internal testing (steps a through d) until the gatekeeper approves the Blueprint.

f. Update the rollout document. Make sure to include any additional system configurations that
were done outside of the Blueprint.

6. Conduct internal testing on subsequent Blueprints by repeating the instructions in step five.

7. Release the Blueprint into the production environment:
a. Gatekeeper applies the first Blueprint while referencing the rollout document.

b. Gatekeeper applies the second Blueprint while referencing the rollout document.

c. Gatekeeper applies subsequent Blueprints while referencing the rollout document.

d. Gatekeeper conducts a final review and publishes the Blueprints to the master development
database.

e. Quality Assurance Engineers complete regression testing.

f. Publish the Blueprints in the production environment. The order in which the Blueprints are
published is critical. Ensure that the Blueprints are published in the same order that they were
applied to the master development database.

8. Conduct a post-implementation review.

Use mApps for Concurrent Development
When you use mApp solutions for concurrent development, you have two options:
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• Use two or more Blueprints to develop the functionality and then create a mApp to apply the
functionality into the production environment. (Process shown below.)

• Use two or more mApps to develop the functionality and then apply each mApp to the production
environment.

To use mApps for concurrent development:

1. Project Manager creates a rollout document. The document should be detailed and include the
following information at the very least:

◦ A list of stakeholders, including:
◦ Business Object owners who are the sole developers assigned to work on a particular

Business Object, including its Views (example: Portal View) and features (example:
Dashboards, Widgets, One-Steps, etc.).

◦ Feature owners who are the sole developers assigned to work on a particular feature
(example: Calendar) that does not have an associated Business Object.

◦ A gatekeeper who ensures that the mApp adheres to requirements and follows team
standards (example: Naming conventions, design guidelines, etc.) before being applied.

◦ A product manager who is responsible for the scope and outcome of the project.

◦ Required external connections (example: SCCM, Outlook, Active Directory, etc.).

◦ Impacted Services (example: Application Server, Automation Process Server, etc.).

◦ System configurations that must be done outside the Blueprint. These might include changes
to Security, the Scheduler, E-Mail Monitor, etc.

◦ Test plans, including any user acceptance test requirements.

◦ A backup and recovery plan.

2. Create a development environment for by restoring the master development server to the current
production environment. When creating this environment, consider the following:

◦ Create one copy of the production environment and store it in a shared location.

◦ You do not need to include Attachments in the file unless you are specifically testing their
functionality.

◦ Ensure that all impacted CSM Services (example: Application Server, Cherwell Service Host,
etc.) are disabled. If you need to test E-mail Monitor functionality, make sure to configure the
test e-mail account.

3. Develop the functionality.
a. Designers make individual copies of the master development database.

b. Designers communicate which Business Objects and features they intend to work on.

c. Designers develop the functionality using individual databases.

4. Conduct internal testing on the first Blueprint:
a. Reference the rollout document to ensure that:

◦ The current Blueprint is intended to be published first.

◦ The Blueprint includes all of the required system configurations.

b. Publish the Blueprint using the master development environment.
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c. Test the Blueprint.

d. Edit the Blueprint or create a new Blueprint based on test results.

e. Repeat internal testing (steps a through d) until the gatekeeper approves the Blueprint.

f. Update the rollout document. Make sure to include any additional system configurations that
were done outside of the Blueprint.

5. Conduct internal testing on the second Blueprint using the development environment that includes
the first published Blueprint:

a. Reference the rollout document to ensure that:
◦ The current Blueprint is intended to be published second.

◦ The Blueprint includes all of the required system configurations.

b. Publish the Blueprint using the master development environment.

c. Test the Blueprint.

d. Edit the Blueprint or create a new Blueprint based on test results.

e. Repeat internal testing (steps a through d) until the gatekeeper approves the Blueprint.

f. Update the rollout document. Make sure to include any additional system configurations that
were done outside of the Blueprint.

6. Conduct internal testing on subsequent Blueprints by repeating the instructions in step five.

7. Create a mApp based on the approved system configurations included in the Blueprints:
a. Gatekeeper applies the first Blueprint while referencing the rollout document.

b. Gatekeeper applies the second Blueprint while referencing the rollout document.

c. Gatekeeper applies subsequent Blueprints while referencing the rollout document.

d. Gatekeeper creates a backup of the master development server that includes all of the
Blueprints.

e. Gatekeeper conducts a final review and creates a mApp based on the approved system
configurations included in the Blueprints.

8. Conduct testing on the mApp:
a. Apply the mApp while referencing the rollout document.

b. Test the mApp while referencing project requirements.

c. Edit the mApp or create a new mApp based on test results.

d. Repeat testing (steps a through c) until the gatekeeper approves the mApp.

e. Update the rollout document.

9. Release the mApp into the production environment:
a. Gatekeeper conducts a final review and applies the mApp to the master development

database.

b. Quality Assurance Engineers complete regression testing.

c. Publish the mApp to the production environment.
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Blueprints
A Blueprint is a working copy of changes to your CSM system definitions (Business Objects, Fields,
Forms, Grids, etc.) that allows you to make offline changes and then publish them to your live system at a
later time.
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About Blueprints
Blueprints affect system definitions and are created and managed from within CSM Administrator. Access
Blueprints and Blueprint functionality from the CSM Administrator Blueprint page.

Use a Blueprint to:

• Manage System Objects: Create, edit, and delete Business Objects, Fields, Forms, Grids, and
Relationships.

• Manage Business Object Data: Create, edit, and delete data from Supporting Objects and Lookup
Objects using the Data Editor.

• Manage CSM Items at a system level: Create, edit, and delete various CSM Items (example:
Dashboards, Search Groups, etc.) using the CSM Item Managers in a Blueprint. Managing and
storing CSM Item definitions at a Blueprint level (and in a Blueprint scope) keeps them extremely
secure (only administrators can access them).

• Access the following Blueprint tools/functionality:
◦ Configure Directory Services integrations: Configure the integration between CSM and various

Directory Services (example: Active Directory, LDAP, etc.).

◦ Export a Blueprint Schema: A Blueprint Schema is a collection of meta-data that is exported
from your system as a single document (.html, .rtf, .txt, or .xml) to textually expose your
Business Object definitions and database structure.

◦ View the Blueprint Publish Log: A Blueprint Publish Log contains detailed information about
Blueprints published to your system.

◦ Define global database settings: Global database settings include timeout values, foreign
keys, Transaction Log settings, and Form/Grid display settings.

Related concepts
Manage System Objects
Manage Business Object Data
Manage CSM Items
Access Blueprint Tools/Functionality
Related tasks
Review Visual Elements for All Business Objects
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Blueprint Workflow
1. Create a Blueprint.

2. Save the Blueprint to the named .bp file (File>Save As).

3. Manage your system definitions:
◦ System Objects:

◦ Business Objects

◦ Fields

◦ Forms

◦ Grids

◦ Business Object data

◦ CSM Items (example: Dashboards, Saved Searches, etc.)

◦ Blueprint tools/functionality

4. Periodically save your changes.

5. Periodically scan the Blueprint for potential errors.

6. View the changes the Blueprint will make to your system definitions.

7. Publish the Blueprint.

Tip: Consider publishing your Blueprint to a test system before publishing to your live
system.

430

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Related concepts
Save a Blueprint
Access Blueprint Tools/Functionality
Scan a Blueprint
View Blueprint Changes
Publish a Blueprint
Related tasks
Create a Blueprint
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Managing Blueprints
Blueprints are managed in CSM Administrator using the Blueprint Editor.
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Blueprint Editor
The Blueprint Editor is the built-in interface within CSM Administrator that allows you to manage System
Objects, Business Object data, Items, Blueprints, and Blueprint tools/functionality.

When you create and work with Blueprints, the CSM Administrator interface changes to the Blueprint
Editor.

Use the Blueprint Editor to:

• Manage System Objects: Create, edit, and delete Business Objects, Fields, Forms, and Grids.
System Objects are managed using the Blueprint's powerful Object Manager and Object Editors,
which are accessed from the Blueprint Editor main window.

• Manage Business Object Data: Create, edit, and delete data from Supporting Objects and Lookup
Objects using the Data Editor.

• Access the Definition Reviewer: Quickly review and modify Forms, Grids, and Form
Arrangements for all Business Objects or for those elements that have changed in the current
Blueprint.

• Manage CSM Items: Create, edit, and delete Dashboards, Search Groups, etc. at a system level to
keep them secure. CSM Items are managed using the various CSM Item Managers.

• Access the following Blueprint tools/functionality (click Tools from the Blueprint Editor menu
bar):
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◦ Configure Directory Services integrations: Configure the integration between CSM and various
Directory Services (example: Active Directory, LDAP, etc.).

◦ Export a Blueprint Schema: A Blueprint Schema is a collection of meta-data that is exported
from your system as a single document (.html, .rtf, .txt, or .xml) to textually expose your
Business Object definitions and database structure.

◦ View the Blueprint Publish Log: A Blueprint Publish Log contains detailed information about
Blueprints published to your system.

◦ Define global database settings: Global database settings include timeout values, foreign
keys, Transaction Log settings, and Form/Grid display settings.

• Manage Blueprints: Save, scan, publish, and close Blueprints using the tasks in the Task Pane.

Related concepts
Manage System Objects
Manage Business Object Data
Manage CSM Items
Access Blueprint Tools/Functionality
Related tasks
Review Visual Elements for All Business Objects
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Blueprint Editor Menu Bar
Use the Blueprint Editor menu bar to access common Blueprint tasks.

Note: The Blueprint Editor menu bar is dynamic so options vary depending on what is active in
the Blueprint Editor main pane. For example, when the Object Manager is active, several
additional options are available on the Edit menu; when a Grid is active in the Object Manager, the
Grid Menu Bar item appears with Grid-specific commands; when a Form is active in the Object
Manager, the Form Menu Bar item appears with Form-specific commands; etc.

File Menu

Action Description

Save Blueprint to
disk Saves changes to the active Blueprint.

Save As Saves the new or active Blueprint as a named .bp file.

Close Blueprint
Closes the Blueprint, but not CSM Administrator. If the Blueprint is not yet saved to
a named .bp file, you are prompted to name and save it. If changes are not yet
saved, you are prompted to save them to the active .bp file.

Print Grid
Prints the active Grid.

Only displayed when a Grid is active in the main pane.

Export Grid
Exports the active Grid.

Only displayed when a Grid is active in the main pane.

Scan Blueprint Scans the active Blueprint for potential errors.

Publish Blueprint Publishes the active Blueprint to a test or live system.

Blueprint
Changes

Opens a window, and then view the items that have been added, changed, or
deleted in the active Blueprint.

Exit Exits CSM Administrator. If you are working in a Blueprint and have unsaved
changes, CSM prompts you to save your changes.

View Menu
Selects what to display in the Blueprint Editor main pane.

Action Description

Object Manager Opens the Object Manager Home page. For more information about the Object
Manager, refer to the Business Object documentation.

Definition Reviewer Opens the Definition Reviewer. You can then review and modify Forms, Grids,
and Form Arrangements for all Business Objects.
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Action Description

View Business Object Opens the Business Object Editor. You can then manage the active Business
Object.

View Relationship Opens the Relationship Editor. You can then manage Relationships for the
active Business Object.

View Form Opens the Form Editor. You can then manage Forms for the active Business
Object.

View Grid Opens the Grid Editor. You can then manage Grids for the active Business
Object.

View Arrangement Opens the Form Arrangement Editor. You can then manage the Form
Arrangement for the active Business Object.

Find Dependencies Displays the active Business Object's dependencies.

Edit Menu

Action Description

Cut Moves the selected item to the clipboard. You can then paste the item into a new location.

Copy Copies the selected item to the clipboard. You can then paste the item to a new location.

Paste Inserts an item from the clipboard to a new location.

Managers Menu

Action Description

Adaptive Layout Presets Opens the Adaptive Layout Preset Manager.

Attachment Manager Opens the Attachment Manager.

Automation Processes Opens the Automation Process Manager.

Business Hours Opens the Business Hours Manager.

Calendar Manager Opens the Calendar Manager.

Counters Opens the Counter Manager.

Dashboards Opens the Dashboard Manager, Widget Manager, Metric Manager, or
Color Palette Manager.

Database Server Objects Opens the Database Server Objects Manager.

Document Repositories Opens Document Repository Manager.

E-mail and Event Monitoring Opens the E-mail and Event Monitoring Manager.

Expressions Opens the Expression Manager.

External Connections Opens the External Connections Manager.
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Action Description

Canonical Definitions Opens the Canonical Definitions Manager.

Formats Opens the Stored Format Manager.

Group Maps Opens the Group Map Manager.

HTML Page Manager
Opens the HTML Page Manager. This allows you to add an HTML page
to a Blueprint. To create/edit an internal HTML page, see Managing
HTML Pages.

Images Opens the Image Manager.

Knowledge Opens Knowledge Mapping Manager, and Knowledge Source Manager.

Language Packs Opens the Language Pack Manager.

Locked Strings Opens the Locked Strings Manager.

One-Step Action Opens the One-Step Action Manager.

Prompts Opens the Prompts Manager.

Queues Opens the Queue Manager.

Reports Opens the Reports Manager.

Scheduled Items Opens the Scheduled Items Manager.

Searches Opens the Search Manager.

Site Manager Opens the Portal Site Manager.

Stored Imports Opens the Stored Imports Manager.

Stored Values Opens the Stored Value Manager.

Teams Opens the Team Manager.

Themes Opens the Theme Manager.

Twitter Account Manager Opens the Twitter Account Manager.

Visualizations Opens the Visualization Manager.

Web Services Opens the Web Services Manager.

Webhooks Opens the Webhooks Manager.

Tools Menu

Action Description

Directory Services Opens the Directory Services window. You can then configure and manage
your Directory Service integrations (example: Active Directory, LDAP, etc.).

Windows Domains Opens the Windows Domains dialog. You can edit your domain connection.
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Action Description

Canonical Mapping
Wizard

Opens the Map Canonical Object Wizard. You can use the wizard to map a
Canonical object to a Business Object. For more information, see Canonical
REST API Mapping Wizard.

Foreign Key
Administration

Opens the Foreign Key Administration dialog. You can automatically configure
all shared foreign keys in your system. For more information, see Foreign Key
Administration.

Export Schema Exports a Blueprint Schema to a .bp file.

View Publish Log Displays the Published Blueprint Log.

Options
Opens the Blueprint Options window. You can then define global database
settings (example: Timeout values, foreign keys, Transaction Log, Grid and
Form display settings, etc.).

Localization Menu

Action Description

Culture Quick Swap (CTRL+Q) Switch between the preferred culture and the last
selected culture.

Preferred Culture (CTRL+D) Switch to the preferred culture.

Previous Culture (CTRL+P) Switch to the last culture you selected.

Help Menu

Action Description

Blueprint Help Opens the online help.

Report Error Opens the Report Error window so you can report an error to Cherwell Software.

About Opens an About window to view version and licensing information for CSM.
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Blueprint Editor Toolbar
Use the Blueprint Editor toolbar to quickly access common Blueprint operations.

Note: The Blueprint Editor toolbar is dynamic so options vary depending on what is active in the
Blueprint Editor Main Pane (example: When a Business Object is active in the Object Manager,
create and delete options are available).

Tip: Many toolbar items are also available from the Blueprint Editor menu bar and the Task Pane.

Button Action Description

Home Opens the Object Manager Home page in the Editor Main Pane.

Definition
Reviewer Opens the Definition Reviewer.

Save Saves changes in the active window.

Update Updates the current item.

Abandon Abandons changes to the current item.

Create New Creates a new item.

Delete Deletes the current selection.

Cut Moves the selected item to the clipboard, so you can then paste the
item into a new location.

Copy Creates a new item whose properties are the same as the copied item.
The new item can then be named and customized.

Paste Inserts an item from the clipboard to a new location.

Business Object Opens the Business Object Editor, where you can manage the active
Business Object.

Relationship Opens the Relationship Editor, where you can manage Relationships
for the active Business Object.

Form Opens the Form Editor, where you can manage Forms for the active
Business Object.

Grid Opens the Grid Editor, where you can manage Grids for the active
Business Object.
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Button Action Description

Arrangement Opens the Form Arrangement Editor, where you can manage the Form
Arrangement for the active Business Object.
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Blueprint Editor Task Pane
Use the Blueprint Editor Task Pane to access Blueprint tasks.

You can access:

• Blueprints: Common tasks for managing Blueprints.

• Common Tasks: Common Blueprint Editor tasks.

• Help: Online documentation.

The Task Pane is located on the left side of the Blueprint Editor.

Behaviors include:

Behavior Step

• Size the pane Hover over the gray line on the right side of the
pane, and then click-and-drag the Sizing Handles.

• Collapse a section Click the title banner of the section.

• Display an item in the Main pane or in a
separate window

Click a specific item.

Tip: Hover over an item to display a tooltip.
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Open the Blueprint Editor
There are several ways to open the Blueprint Editor:

• In the Common Tasks section of the CSM Administrator Task Pane, click Create a New Blueprint.
• In the CSM Administrator main window, click the Blueprints category, and then click the Create a

New Blueprint task or the Open an Existing Blueprint task.

Tip: Your most recent working Blueprint is also listed here. Click it to open it in the Blueprint
Editor.
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Create a Blueprint
Use the Create Blueprint task (accessed from the CSM Administrator main window) to open an existing
Blueprint file.

To create a Blueprint:

1. Open CSM Administrator.
2. Click Blueprints > Create a New Blueprint.

The Blueprint Editor opens. By default, the Object Manager is displayed in the Blueprint Editor's
Main Pane.

3. Click File > Save As to save the Blueprint to a named .bp file.
The name of the open Blueprint is displayed at the top of the CSM Administrator window and at the
top of the Blueprint Editor.

4. As you make changes, save the changes to the named .bp file.

Tip: Periodically scan your Blueprint to find potential errors.

5. When ready, publish the Blueprint to commit the changes.
Refer to Publish a Blueprint for details about the publication process.
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Open an Existing Blueprint
Use the Open an Existing Blueprint task (accessed from the CSM Administrator main window) to open an
existing Blueprint file.

To open an existing Blueprint:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Open an
Existing Blueprint task.

Tip: The last saved Blueprint is also listed for your convenience. You can also open the last saved
Blueprint by clicking it in the Common Tasks section of the CSM Administrator Task Pane.

2. Select a Blueprint (.bp) file, and then click Open.

The Blueprint opens in the Blueprint Editor. The name of the Blueprint is displayed at the top of the
CSM Administrator window and at the top the Blueprint Editor.
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Download a Blueprint
Download a Blueprint from the Publish Log to easily revert your system or to apply changes created by
another User.

To download a Blueprint:

1. In the CSM Administrator main window, click the Blueprints category.

2. Click View Publish Log from the Blueprints category. The Blueprint Publish Log opens and displays
a list of all Blueprints that have been published to your system.

3. Select a Blueprint, and click the Download button. The File Explorer opens.

4. Select a location on your local machine and click Save. A copy of the Blueprint is now saved on
your local machine.

After downloading a Blueprint, you can open the Blueprint in order to edit it, or publish the Blueprint to
revert your system or apply changes from another user.
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Save a Blueprint
You can save a Blueprint to a named .bp file or save changes to the open Blueprint.

To save a Blueprint as a named .bp file:

1. Create a Blueprint.

2. From the Blueprint Editor menu bar, click File>Save As.

Tip: You can also save a Blueprint as a named .bp file by clicking Save Blueprint to Disk in the
Blueprints section of the Blueprint Editor Task Pane.

3. Provide a filename for the Blueprint. Use a naming convention that makes sense to your
organization. For example, consider adding a date, time, system name, etc. to the filename to
distinguish it.

4. Ensure that the file type is .bp.

5. Click Save.

A .bp file is created. The name of the Blueprint is displayed at the top of the CSM Administrator
Main window and at the top the Blueprint Editor.
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Scan a Blueprint
Use a Blueprint Scan to periodically check your working Blueprint for potential errors. The scan will look
for missing items and alert you to any changes you need to make.

Examples of when you will receive warnings:

• You create a Business Object without also creating a Form and/or Grid to display it.

• You delete items that are referenced by other items in CSM (example: An Expression used on a
Form).

• A table needs to be rebuilt in the database due to changes in the Business Object.

• You scan a Blueprint that contains Security Group and Role changes that were applied from a mApp
Solution.

To scan a Blueprint:

1. Open the Blueprint Editor.

2. From the Blueprint Editor menu bar, click File>Scan.

You can also scan a Blueprint by clicking Scan Blueprint in the Blueprints section of the Blueprint
Editor Task Pane.

If the scan is successful, a success window opens.

If the Blueprint contains changes that require reloading definitions or restarting applications after the
Blueprint is published, an alert appears along with the scan results. The alert is triggered if the
Blueprint contains changes to significant system definitions, such as Business Objects, Forms,
Grids, Form Arrangements, Relationships, Custom Views, One-Step Actions, automated behaviors,
Dashboards, and/or Widgets.

If the scan detects errors, the Scan Results window opens and lists errors and warnings.

You can:

◦ Choose to limit the Display list to warnings or errors.

◦ Click Show Usage to open a window that shows how the definition causing an error is used is
CSM.

◦ Click Go to Error to navigate to the error and resolve it (if the error cannot be automatically
resolved). For Security Groups and Roles, click this button to compare changes in these
definitions.

◦ Click Resolve to automatically resolve each error or warning separately.

◦ Click Rescan to rescan the Blueprint.

◦ Click Ignore warnings and continue to enable the OK button. In this case, when you click
OK, the warnings are ignored but the publish continues.
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Note: The Ignore warnings and continue check box is only available when the
display list contains only warnings.

Related concepts
Scan a mApp Solution
Blueprint Scan Errors for Foreign Key Relationships
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View Blueprint Changes
Use the Blueprint Changes window in the Blueprint Editor to see which system definitions will be changed
by the active Blueprint when it is published.

When you view Blueprint changes, you can:

• Select how to display changes (group by Business Object, Definition Type, or View).

• Search for specific changes in the Blueprint.

• Remove changes from the Blueprint.

• Compare the Blueprint changes with the original system definitions.

The Blueprint Changes window can be opened from the Blueprint Editor menu bar (File>Blueprint
Changes).

1. Display: Groups changes in the tree by Business Object, Definition, or View.
◦ By Business Object: Groups changes by Business Object (example: Incident).

◦ By Definition Type: Groups changes by the type of system definition (example: Forms).

◦ By View and then Business Object: Groups changes by View (example: Default, Portal
Default) and then by Business Object (example: Incident).

◦ By View and then Definition Type: Groups changes by View (example: Default, Portal Default)
and then by type of system definition (example: Forms).

2. Search: Searches for changes by keyword or phrase.
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a. In the Search Box, provide a word or phrase to search for. The drop-down displays the most
recently used (MRU) searches.

b. Click Go to run the search. The items containing the specified word or phrase are displayed
within their hierarchical structure.

3. Blueprint Changes tree: Displays changes in a hierarchical tree grouped by the selected display
option.

◦ Click the arrow next to a category (Business Object, Definition Type, or View) to expand it and
view its changes. Click the arrow again to collapse it.

Tip: Right-click a category or change to open a context menu to select options to expand/
collapse the tree, remove changes, or compare definitions.

4. Remove/Compare:
◦ Click Remove to remove a selected item from the Blueprint (it is not removed from the

system).

◦ Click Compare to compare the Blueprint change with the existing system definition.

Note: Remove and Compare are only enabled when you have an individual change
selected. You cannot remove or compare changes by selecting display categories
(Business Object, Definition Type, or View). You can only compare a change if you
edited or updated an existing system definition in the Blueprint; newly added definitions
cannot be compared (there is nothing to compare them to).
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Review Visual Elements for All Business Objects
The Definition Reviewer provides a quick way to review and modify Forms, Grids, and Form
Arrangements for all Business Objects. This is useful for ensuring consistency and usability across visual
elements in your system, especially after you apply translations to your system using the Globalization
tool set.

You can review and modify:

• All visual elements in a Blueprint or mApp

• Changed visual elements in a Blueprint or mApp

Note: As you modify Forms, Grids, and Form Arrangements in the Definition Reviewer, your
changes are saved as you move from definition to definition without having to manually update
your Blueprint with changes. This enables you to quickly test and adjust definitions.

To use the Definition Reviewer:

1. Create a Blueprint or mApp.
2. Use one of the following methods to open the Definition Reviewer:

◦ From the menu bar, select View > Definition Reviewer.
◦ Click Definition Reviewer in the task pane.

3. From the Definition Reviewer, you can:

Option Description

1 Select the type of definition to review:
Forms, Grids, or Form Arrangements.

2 Select to view all definitions for the selected
type or only definitions that have changed in
the active Blueprint.

3 Search for a definition of the selected type.

4 Toggle the display of the Business Object
name to each visual element.

5 Search for fields used in the selected
definition.

6 Toggle the Folders option show definitions in
folders or in a list from the root node.

7 Scroll through the definitions list to view
Forms, Grids, or Form Arrangements in the
editor.
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Option Description

8 Use the editor to modify the Form, Grid, or
Form Arrangement as needed. See:

◦ Create/Edit a Form
◦ Create/Edit a Business Object Grid
◦ Create/Edit a Form Arrangement

4. Optionally, right-click on a definition in the list to perform these localization tasks:
◦ View Translations

See Viewing Translations for Definitions and Form Controls.

◦ Apply Language Pack Bundles

See Applying Language Pack Bundles to Definitions or Form Controls.

◦ Delete Translations

See Deleting Translations from Definitions.
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Publish a Blueprint
Publish a Blueprint to commit definition changes to a test or live system. Before you publish, you are
prompted to select before and after publishing operations.

Good to know:

• Publish a Blueprint to a backup test system before publishing to your live system so that you can
experiment and verify that everything works.

• Blueprints can be published out of order (that is, if you create Blueprint 1 and Blueprint 2, you can
publish Blueprint 2 and then Blueprint 1). However, depending on what you changed, you might get
unexpected results.

• A Blueprint contains only those objects that you have modified, so if one administrator works on
Incidents and one works on Assets, there will not be any problem. If, however, they both work on
Incidents, the changes of the last published Blueprint might overwrite the changes of the previous
administrator.

• Use the Cherwell Scheduler to publish the Blueprint after hours when all of the Users are out of the
system.

• Foreign keys are automatically updated when you publish if the Blueprint contains changes made to
foreign key settings for validated fields. The update only occurs for modified foreign key fields and
foreign key fields referenced by those fields. For example, foreign keys for the Sub-Category field
would be updated if changes are made to the Category field.

To publish a Blueprint:

1. From the Blueprint Editor menu bar, click File>Publish Blueprint.

Tip: You can also publish a Blueprint by clicking Publish Blueprint in the Blueprints section
of the Blueprint Editor Task Pane.

2. Select before publishing operations:

Option Description

Save Blueprint

Select this check box to save the Blueprint before
publishing it.

Note: If the Blueprint is not yet saved to a
named .bp file, you are prompted to name
and save it. If changes are not yet saved, you
are prompted to save them to the active .bp
file.

Create Rollback Blueprint
Select this check box to create a Blueprint rollback file
that, when published, backs out the changes made by
the published Blueprint file.
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Option Description

Scan for errors
Scans the Blueprint for potential errors. The scan will
look for missing items and alert you to any changes
you need to make.

Stop on Warnings Select this check box to stop the publishing process
when an error is encountered.

Only Scan Enabled Cultures Select this option to scan Business Object property
values for all cultures that are enabled in your system.

Only Scan Current Culture
Select this option to scan Business Object property
values for the culture selected in the Culture Selector
when you publish a Blueprint.

Scan All Cultures
Select this option to scan Business Object property
values for all cultures available in your system, even
disabled cultures, when you publish a Blueprint.

Lock System

Selected by default. Select this check box to lock the
system, preventing Users from logging in to CSM
Clients while administrative work is being done.

Note: System administrators can log in to
CSM Administrator, but no Users can only log
in to clients. Users already logged in will not
be automatically logged out of the system.

Pause All Services

Selected by default. Select this check box to pause all
CSM microservices (Automation Process Service, E-
mail and Event Monitor, Mail Delivery Service, and
Scheduling Service).

Ignore Conflicts Select this check box to bypass the Blueprint Conflict
Resolution feature.

3. Select the Publish changes check box to publish the Blueprint to the database you are connected
to.

4. Select after publishing operations:
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Option Description

Rebuild Full-Text Catalog

Select this check box to rebuild the Microsoft SQL
Server Full-Text Catalog. If you change Business
Objects and fields to include or not include them in a
Full-Text Search, the catalog must be rebuilt in order
for the changes to take effect.

Note: Include Business Objects and fields in
the Full-Text Searches by selecting the
Include in Full-Text Search box in the
Business Object Properties window (Search
Results page) and the Field Properties
window (General page).

Restart Services

Select this check box to restart the CSM
microservices you paused before the publish. If you
do not select this check box, you must manually
restart the Services using the Server Manager.

Unlock System

Select this check box to unlock the CSM system if
you locked before the publish. If you do not select
this check box, you must manually unlock the CSM
system in CSM Administrator (Security).

Run a One-Step Action

Select this check box to run a One-Step Action after
the publish process is complete. Select a recently
used One-Step Action from the drop-down or click
the Ellipses button to edit it or to select a different
one.

When publishing a Blueprint that came from a mApp
Solution, the One-Step Action may be pre-populated.

Note: This option is not available via the
CSM Configuration command-line.

The Action must be an unassociated One-
Step Action (not tied to a particular Business
Object).

5. Click Publish.

Related concepts
Develop Blueprints Concurrently
Define Publish Blueprint Action Options
Scan a Blueprint
Blueprint Scan Errors for Foreign Key Relationships
Performance Impact of Blueprint Changes
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Performance Impact of Blueprint Changes
Certain changes to Business Objects may cause database tables to be rebuilt during the publish process.
This can extend the amount of time it takes to complete the publish process, especially for Business
Objects that contain a large number of records. This may impact system performance and cause some
Business Objects to be unavailable.

For example, certain changes made to the Journal Business Object may cause a table rebuild, which can
prevent users from accessing Journal records in related Business Objects, such as Incidents, during the
publish process.

Business Object Changes
Changing the primary key for a Business Object will cause a table to be rebuilt.

Field Changes
The following changes to fields will cause a table to be rebuilt.

Change Location

Field type General page, Field Properties dialog

Text fields only:

• Max allowed or Max searchable options

• Length setting is decreased
General page, Field Properties dialog

Number fields only:

• Whole digits setting decreased

• Decimal digits decreased
General page, Field Properties dialog

Field names that are reused in the same publish
process. For example, if you rename the
Component field to Main Component and the
Feature field to Component, the table is rebuilt.

General page, Field Properties dialog

Related concepts
Publish a Blueprint
Scan a Blueprint
Related information
Define General Properties for a Field
Define Advanced Properties for a Field
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Publish a Rollback Blueprint File to Undo Changes
Rollback Blueprint files serve as a snapshot of CSM prior to changes that are implemented in a newly
published Blueprint. After changes are published, you can undo the changes and return the system to its
previous state.

Rollback Blueprint files are created before a Blueprint is published, but are only available after a Blueprint
has been published.

To remove changes prior to publishing the Blueprint, use the Undo Business Object Changes within a
Blueprint feature.

To publish a Rollback Blueprint file and override changes made to your system:

1. In CSM Administrator, select the Blueprints category.
2. Select Open an existing Blueprint.
3. Navigate to the saved Rollback Blueprint file (example: Desktop/font_changes_rollback.bp).
4. Select Open.

The Rollback Blueprint file opens in the Object Manager.
5. Select Publish Blueprint.

The Publish Options window opens.
6. Select the Ignore Conflicts check box.

Select Publish in the Publish Options window to publish the file.

If changes persist and do not reset when the Rollback Blueprint file is published, reload the system
definitions (CSM Desktop Client > Tools > Reload Definitions). If reloading the system definitions is
unsuccessful, contact your administrator.
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Close a Blueprint
Use the Close Blueprint option to close the active Blueprint, but not CSM Administrator.

To close a Blueprint, from the Blueprint Editor menu bar, click File>Close Blueprint.

Tip: You can also close a Blueprint by clicking Close Blueprint in the Blueprints section of the Blueprint
Editor Task Pane.

If the Blueprint is not yet saved to a named .bp file, you are prompted to name and save it. If changes are
not yet saved, you are prompted to save them to the active .bp file.
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View Details of the Last Published Blueprint
Use the View Details of the Last Blueprint Publish task on the Blueprints page to view when and by whom
the last Blueprint was published.

Tip: You can also view a detailed Blueprint Publish Log.

To view details of the last published Blueprint in the CSM Administrator Main window, click the Blueprints
category, and then click the View Details of the Last Blueprint Publish task.
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Develop Blueprints Concurrently
When you publish a Blueprint, CSM checks your changes against the existing schema and displays a list
of conflicts that must be resolved before continuing the publish process.

These conflicts typically arise when another developer has published changes system after you began
working on your Blueprint.

The conflicts appear in the Blueprint Conflict Resolution window.

1. The left pane lists conflicts between the most recently-published schema and the Blueprint . Choose
item by item which new changes to apply to the schema.

2. Select Use current schema to keep the system settings and throw away your changes. This option
is selected by default. A disconnect icon  denotes you will keep the current schema.

3. Select Use my blueprint to publish your Blueprint changes, overwriting the system. The connect
icon  denotes items from your Blueprint you intend to publish.

4. Details about the selected item including who last modified it and when.

Note: If another administrator makes a change to the system while you are reviewing the
Blueprint Conflict Resolution results, those changes will not be captured in the list of
changes. For information on best practices for CSM concurrent development, see CSM
System Design Using Concurrent Development.
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You can choose to bypass this feature by selecting Ignore Conflicts in the Publish Options window.
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Using Blueprints
Users can use Blueprints to manage objects at a system level.

For example, Users can:

• Manage System Objects: Create, edit, and delete Business Objects, Fields, Forms, and Grids.
System Objects are managed using the Blueprint's powerful Object Manager and Object Editors,
which are accessed from the Blueprint Editor Main window.

Note: For more information about managing system objects, refer to the Business Object
Documentation.

• Manage Business Object Data: Create, edit, and delete data from Supporting Objects and Lookup
Tables using the Data Editor.

• Manage CSM Items: Create, edit, and delete Dashboards, Search Groups, etc. at a system level to
keep them secure. CSM Items are managed using the various CSM Item Managers.

• Access the following system tools/functionality (click Tools on the Blueprint Editor menu bar):
◦ Configure Directory Services.

◦ Export a Blueprint Schema.

◦ View the Blueprint Publish Log.

◦ Define settings for the Blueprint Editor.

• Follow our best practices for CSM system design using concurrent development.

Related concepts
Manage System Objects
Manage Business Object Data
Manage CSM Items
Access Blueprint Tools/Functionality
Related tasks
Review Visual Elements for All Business Objects
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Manage System Objects
Use the Object Manager and its various Editors, accessed from within a Blueprint or mApp® Solution, to
manage the Business Objects, Forms, Grids, and Fields from a system level.

Note: For more information about managing system objects, refer to the Business Object
Documentation.
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Manage Business Object Data
Use the Data Editor to manage data in Supporting Business Objects and Lookup Objects.

Note: Because data is edited within a Blueprint, the data in your system is not actually modified
until the Blueprint is published.
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Data Editor
The Data Editor is the interface within the Blueprint Editor or mApp Solution Editor that allows you to edit
data within a Supporting Business Object or Lookup Business Object.

Because data is edited within a Blueprint or a mApp Solution, the data in your system is not actually
modified until the Blueprint is published or the mApp Solution is applied.

Use the Data Editor to:

• Add records (rows) with new data.

• Delete existing records.

• Update the data in a record.

• Translate culture-specific values for Lookup Business Objects, if you have localization enabled for
the object. See Enable Localization Support for a Lookup Table.

• Clear all data from the table and replace it with new/updated data.

There are several ways to open the Data Editor:

• In the CSM Administrator Main Pane, click the Settings category, and then click the Table
Management task.

• In a Blueprint or mApp Solution, select a Supporting Object or Lookup Object (example: Incident
Category Lookup Object) from the Object tree in the Object Manager, and then click the Edit Data
task in the Structure area.

• In the Validation/Auto-Populate page of the Field Properties window, when you select to validate a
Field from a table, click the Edit Table Data button (activated after selecting a table in the drop-
down).

• In a Blueprint or mApp Solution, enable localization for a Lookup Object. Select the option to open
the Data Editor so you can translate values. See Configure Localization Support for Lookup Tables.
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1. Menu bar: Displays a row of drop-down menus available in the Data Editor.

2. Toolbar: Displays a row of buttons for operations available in the Data Editor.

3. Main Pane: Displays either the list of records in the data table (as a Grid), or the details for the
currently selected record (depending on the view you are in). The Action column shows what will be
done with the data in each row of the table when the mApp Solution or Blueprint is applied/
published.

Note: Select the Clear all data from destination table check box to have all existing data
in the current system Lookup Object cleared out when the mApp Solution or Blueprint is
applied/published. If you want to keep any existing data, you must select the rows with the

data you want to keep and click the Include in mApp or Blueprint button .
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Data Editor Menu Bar
Use the Data Editor menu bar to edit Business Object data.

Note: The Data Editor toolbar is dynamic so available options vary depending on which view you
are in (example: When you are viewing the details for a specific record, the cut, copy, and paste
options are available) and which tasks you have already performed (example: The option to revert
a record to its original values is only available if you have made changes to the record).

File Menu

Action Description

New Adds a new row (record) to the table.

Save Saves changes to the active Blueprint/mApp Solution.

Abandon Abandons changes to the current item.

Delete Deletes the current selection.

Include Includes the selected row (record) in the current Blueprint/mApp Solution (the Action column
changes to Update).

Restore Reverts a row (record) back to its original values (the Action column returns to No Change).

Print Prints the current item.

Close Closes the Manager.

Edit Menu

Action Description

Undo Cancels the last operation.

Redo Repeats the last operation.

Cut Moves the current selection to the clipboard, so you can then paste it into a new location.

Copy Creates a new item whose properties are the same as the copied item. The new item can
then be named and customized.

Paste Inserts the cut or copied item from the clipboard.

Refresh Refreshes the data.
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View Menu

Action Description

Show Results Displays a set of records meeting a specified criteria.

Show Current Record Shows the currently selected Record.

First Record Go to the first viewed Record.

Previous Record Go to the previously viewed Record.

Next Record Go to the next Record.

Last Record Go to the last Record in the list.

Help

Action Description

Record Selector Help Opens the Online Help.
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Data Editor Toolbar
Use the Data Editor toolbar to edit Business Object data.

Note: The Data Editor toolbar is dynamic so available options vary depending on which view you
are in (example: When you are viewing a specific record, the cut, copy, and paste options are
available) and which tasks you have already performed (example: The option to revert a record to
its original values is only available if you have made changes to the record).

Tip: Many toolbar items are also available from the Data Editor menu bar.

Button Action Description

Create New Creates a new record in the table.

Save Saves changes to the active Blueprint/mApp Solution.

Abandon Abandons changes to the current item.

Delete Deletes the current selection.

Include Includes the selected record in the Blueprint/mApp Solution (changes
Action column to Update).

Restore Reverts an existing record back to its original values (changes Action
column back to No Change).

Cut Moves the selected item to the clipboard, so you can then paste the
item into a new location.

Copy Creates a new item whose properties are the same as the copied
item. The new item can then be named and customized.

Paste Inserts an item from the clipboard to a new location.

Show results Displays a set of records meeting a specific criteria.

Show current record Displays the currently selected record.

Go to first record Jumps to the first record in set.

Go to previous
record Jumps to the previous record in set.
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Button Action Description

Go to next record Jumps to the next record in set.

Go to last record Jumps to the last record in the set.
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Data Editor Main Pane
Use the Data Editor Main pane to view and select records (rows) in a Lookup table and see how the edits
you make will affect each record in your system's Lookup table when the Blueprint is published or a mApp
Solution is applied.

When you first access the Data Editor, the Main pane displays a Grid showing a Blueprint/mApp Solution
Action column, followed by the lookup table's default Grid.

To view the details of a specific record, click the Show Current Record button on the Toolbar.

The Blueprint/mApp Solution Action column shows what will be done to each record in the table when the
Blueprint is published (or the mApp Solution is applied):

• No Change: Record will remain unchanged. When you first access the Data Editor, all records are
marked as No Change until you edit them.

• Add: A new record was created and will be added to the lookup table.

• Delete: Record will be deleted.

• Update: Existing record will be modified with the values contained in the Blueprint/mApp Solution.

Localization and Lookup Tables
If Localization is enabled for a Lookup Object, the Data Editor includes a column for each culture enabled
for your system.
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Open the Data Editor
There are several ways to open the Data Editor:

• In the CSM Administrator Main Pane, click the Settings category, and then click the Table
Management task.

• In a Blueprint or mApp Solution, select a Supporting Object or Lookup Object (example: Incident
Category Lookup Object) from the Object tree in the Object Manager, and then click the Edit Data
task in the Structure area.

• In the Validation/Auto-Populate page of the Field Properties window, when you select to validate a
Field from a table, click the Edit Table Data button (activated after selecting a table in the drop-
down).

• In a Blueprint or mApp Solution, enable localization for a Lookup Object. Select the option to open
the Data Editor so you can translate values. See Configure Localization Support for Lookup Tables.
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Manage CSM Items
Manage CSM Items at a system level using the various CSM Item Managers.

Access CSM Item Managers by selecting Managers from the Blueprint or mApp Editor menu bar
(example: Calendars, Dashboards, and Searches).

When you access CSM Item Managers from within a Blueprint or mApp® Solution, you can view, add,
edit, or delete items in the Blueprint or mApp Solution scope. This scope is for items that administrators
do not want users to access and manipulate. For more information, see Scope.

Note: For more information about the CSM Items and their Managers, refer to their respective
documentation.
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Access Blueprint Tools/Functionality
Access all Blueprint tools/functionality by selecting Tools on the Blueprint Editor menu bar.

Use a Blueprint to access the following Blueprint tools/functionality:

• Configure Directory Services: Opens the Directory Services window, where you can add, edit,
delete, and copy Directory Service definitions.

• Using Trusted Agents Server with Windows Domains

• Export a Schema.

• View the Blueprint Publish Log.

• Define global database settings (Options).
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Define Directory Services
Use the Directory Service Editor (within the Blueprint Editor) to configure and manage the integration
between CSM and a Directory Service.

Using the Editor, you can:

• Add: Create a Directory Service definition that enables and defines the rules for the Directory
Service integration.

• Edit: Edits an existing Directory Service integration definition.

• Delete: Deletes a selected Directory Service integration definition.

• Copy: Copies the properties of a selected Directory Service to use a starting point for another
Directory Service definition.

• Import: Imports Users from a Directory Service into CSM.

Note: For step-by-step instructions about configuring a Directory Service, refer to the
Configuring the Integration with Directory Services.
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Using Trusted Agents Server with Windows
Domains

When integrating CSM with multiple domains, you can configure single sign-on user authentication by
associating a particular Windows Domain with a Trusted Agents Group or Service.

Before you can use Trusted Agents to authenticate Users through a Windows Domain, you must first
configure Trusted Agents. For more information, see Configuring Trusted Agents.

Trusted Agents for Windows Domains do not provide pass-through authentication for Windows users.
Users must still supply their user name and password in order for their Windows credentials to be
validated using the Trusted Agents.

Note: LDAP directory configuration is not required when using Windows.

To enable Windows Domains for Trusted Agents:

1. Verify that CSM is configured for Windows domains:
◦ In CSM Administrator, select the Security category and then select the Edit security settings

task. Select each client page (Desktop Client, Browser Client, etc.) and verify that Windows is
selected as a login mode.

◦ Create or open a Blueprint, and then select Tools > Windows Domains. Specify the domain
name of the network.

2. On the Windows Domain Settings window, select the Trusted Agents page.
3. Select the Use Trusted Agents check box.

Note: If you want to disable Trusted Agents for this Windows domain, clear the Use Trusted
Agents check box.

4. Select one of these group options:
◦ Any Trusted Agent Group: Select to allow any group to handle requests for this domain.
◦ Trusted Agent Group: Select a specific group to handle requests for this domain.

5. Select OK.
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Foreign Key Administration
Foreign key fields shared across Group Members and/or Views must validate from the same table and
field to ensure that queries retrieve correct data. You can use the Foreign Key Administrator to
automatically configure all shared foreign keys in your system.

If shared foreign key fields are not configured correctly, you will receive validation warnings when you edit
a foreign key field in a Blueprint or when you run the Foreign Key Configuration Health Check rule.

An example validation warning is:

Foreign key field: Agreement.Supplier in view: (Default) requires field: OL
A.Supplier in view: (Default) to be validated from a table

Good to Know

• You can use the Foreign Key Configuration Health Check rule to return a list of all shared foreign
key fields that are not configured correctly. See About Performance Health Check.

• You can manually configure shared foreign keys in a Blueprint or mApp Solution. See Configuring
Shared Foreign Key Fields.

• Standard foreign key rules also apply: shared foreign key fields must be validated from a table and
validation must be enforced.

• Constraints for shared foreign key fields can differ between Group Members and Views

To automatically configure share foreign key fields:

1. Create a Blueprint.

2. Open the Foreign Key Administration dialog (Tools > Foreign Key Administration).

3. Select these options as they apply:

Option Description

Enforce table validation for all shared foreign key
field definitions

Select this check box to automatically configure
table validation for all shared foreign key fields in
your system. After you publish your Blueprint, the
Validate from table check box is selected on the
Validation/Auto-populate Page for all shared
foreign keys fields in your system.
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Option Description

Replicate table validation across shared foreign
key field definitions

Select this check box to replicate the validation
table selection for all foreign key fields that share
Views and Groups in the same Business Object.
The Foreign Key Administrator attempts to match
shared foreign key fields to validation tables based
on these rules:

◦ If at least one single table match is found for
a set of shared foreign key fields, the table is
applied to those that do not have a validation
table set. For example, if one shared foreign
key field in a Group Member has validation
set for Table A but a validation table is not
specified for the shared foreign key fields in
other Group Members, Table A is set as the
validation for all Group Members.

◦ If two different validation tables are detected
for shared foreign key fields in the same
Group or View, no change is made.

◦ If no validation tables are set for any shared
foreign key fields, no change is made.

I have read the following statement...
You are required to acknowledge that you
understand the implications of changing table
validation on all shared foreign key fields.

4. Select OK.

5. Publish the Blueprint.

Important: Verify changes before publishing the Blueprint to a production environment.

479

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Export a Blueprint Schema
Use a Blueprint Schema to quickly and easily scan the characteristics of your Business Objects.

A Blueprint Schema is a collection of meta-data that is exported from your system as a single document
(.html, .rtf, .txt, or .xml) to textually expose your Business Object definitions and database structure.

You can export the following meta-data for Major, Supporting, and Lookup Objects:

• Properties

• Lifecycle

• Fields (and Field properties)

• Relationships (and Relationship properties)

• One-Step Actions

• Approvals

• Automation Processes

Note: The Blueprint Schema for the CSM Starter Database is available in the CSM Starter
Database Schema Guide.

To export a Blueprint Schema:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

Note: If working on a saved Blueprint, open the existing Blueprint.

The Blueprint Editor opens.

2. On the Blueprint Editor toolbar, click Tools>Export Schema.

3. Select the types of Business Objects to export in the Schema:
◦ Major: Select to export Major Business Objects.

◦ Supporting: Select to export Supporting Business Objects.

◦ Lookup: Select to export Lookup Business Objects.

4. Select the items (meta-data) to export in the Schema:
◦ Business Object Properties

◦ Business Object Lifecycle

◦ Fields

◦ Relationships

◦ One-Step Actions

◦ Approvals
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◦ Automation Processes

5. Select OK.

6. Provide a location, filename, and file type (.html, .rtf, .txt, or .xml) for the Schema, and then click
Save.

The selected meta-data is exported to a Schema file. You can then open and view the Blueprint
Schema in a viewing tool, such as Microsoft Word.
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View the Blueprint Publish Log
Use the Publish Log to view detailed information about Blueprints published to your system.

The log tracks the following details in a Grid:

• A short description of the change the published Blueprint made to the system.

• Type (example: Form) and name (example: Incident) of the system definitions that were changed by
the Blueprint.

• User Name of the person who published the Blueprint.

• Dates/times that the Blueprint publish was initiated and completed.

• Scope (example: Global) of the system definition (if applicable), as well as the scope owner (if
applicable).

• User-defined name of the Blueprint file (.bp).

• Business Object associated with the definition (if applicable) (Association column).

• The view (example: Portal Default) that the Blueprint change applies to (if applicable).

• The path where the Blueprint file was saved (if applicable).

The Blueprint Publish Log can be opened from the Blueprint Editor menu bar (Tools>View Publish Log).

• Menu bar: Click the File menu to perform the following operations:
◦ Clear Log: Select this option to clear all entries in the log, or to clear all entries prior to a

specified date.

◦ Export: Select this option to export the Grid of Publish Log data to a file.

◦ Print: Select this option to print the Grid of Publish Log data.

◦ Close: Select this option to close the Publish Log window.

Tip: You can also select Clear Log, Export, and Print from a context menu by right-clicking an
item in the Publish Log.

• Toolbar: Select an option from the View drop-down to filter the items in the Publish Log:
◦ All Records: Shows everything that was published in a Blueprint.

◦ Definition type: Shows all definitions of a particular type (example: Business Object). When
you select this option, a Definition drop-down is displayed on the toolbar, and then select a
definition type.

◦ Only Definition Changes: Shows only the definitions that were changed by the published
Blueprint.

◦ Particular User: Shows the definitions that were published by a particular User. When this
option is selected, a User drop-down is displayed on the toolbar, where you can select a User.

◦ View: Shows the definitions that apply to a particular View (example: Default). When this
option is selected, a View drop-down is displayed on the toolbar, and then select a View.

• Refresh: Click this button to refresh the data in the Publish Log.
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• Download Blueprint: Click this button to download the selected Blueprint.

• Create rollback Blueprint: Select this check box to create a rollback Blueprint when downloading a
Blueprint. This allows you to undo a Blueprint's changes.

• Main Pane: Displays the Grid of Publish Log data, filtered by View.
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Define Global Database Settings
Global database settings/defaults control how the CSM database looks and behaves by default.

Use the Blueprint Options window in a Blueprint in CSM Administrator to define the following global
database settings:

• Global database options (Database Options page): Timeout values and Foreign Keys settings.

• Database Transaction Log settings (Database Transaction Log page): Database Recovery Model
and autogrowth settings.

• Configure Grid and Form display settings (Display Options page).

The Blueprint Options window can be opened from the Blueprint Editor menu bar (Tools>Options).
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Define Global Database Options
Use the Database Options page in the CSM Administrator Blueprint Options window (accessed from
within the Blueprint Editor) to define global general database options.

Options include:

• Database timeout values: How long the database attempts to complete an operation before giving
up.

• Foreign Keys: Whether or not to enable/enforce Foreign Keys. Foreign Keys establish and enforce a
link between tables in a relational database, and are required by SQL Reporting Services.

To define global database options:

1. Open the Blueprint Editor

2. From the Blueprint Editor menu bar, click Tools>Options.

3. Click the Database Options page.

4. Define Timeout values for the database:
a. Database command timeout: Specify the number of seconds to attempt a database command

before giving up.

b. Schema command timeout: Specify the number of seconds to use before timing out on SQL
Server DDL (Data Definition Language) commands (used to create and modify database
tables in the underlying database).

Note: Select the No Limit check box to indefinitely attempt to complete the operations.

5. Enable and define Foreign Key settings:

Note: You must enable foreign keys in order to use SQL Reporting Services.

a. Create Foreign Keys for Relationships: Select this check box to enable/create foreign keys.

b. Not Enforced/Enforced: Select whether or not to enforce foreign keys.

6. Select OK.
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Define Global Database Transaction Log Settings
Use the Database Transaction Log page in the CSM Administrator Blueprint Options window (accessed
from within the Blueprint Editor) to define global Database Transaction Log settings.

Settings include:

• Database Recovery Model: How much data is logged (Simple, Full, or Bulk-logged) in the event that
you need to restore your CSM database.

• Autogrowth: Whether or not to enable autogrowth (process for expanding the size of the CSM
database when it runs out of space), and then the autogrowth file size increments/thresholds.

Good to know:

• These are all common database tasks, so please consult your database administrator.

• If you are a SaaS User with a 2-tier connection, you must have security rights to access this page
and define settings. This page is not available to SaaS Users with 3-tier connections. See Database
Options Security Rights.

To define global database settings:

1. Open the Blueprint Editor.

2. From the Blueprint Editor menu bar, click Tools > Options.

3. Click the Database Transaction Log page.

4. Select a Database Recovery Model from the following options:
◦ Simple (recommended): Simple backup (minimal logs); can restore full or differential backups

only (no point in time).

◦ Full: Complete backup (full logs); can restore database to a specific point in time.

◦ Bulk-logged: Full backup except that bulk operations are not fully logged.

5. Enable and define autogrowth settings:
a. Enable Autogrowth for Transaction Log: Select this check box to enable autogrowth,

allowing the database to expand if it runs out of space. Then, define how the database size will
increment, either:

◦ In Percent: Select this radio button to allow the database to grow by a percentage of the
current size. Then, define the percentage.

◦ In Megabytes: Select this radio button to allow the database to grow by a specific size, in
megabytes (MB). Then, specify the size.

b. Specify a Maximum File Size for the transaction log, either:
◦ Restricted File Growth: Select this radio button to restrict the transaction log to a

maximum size (in MB). Then, specify the maximum size.

◦ Unrestricted File Growth (recommended): Select this radio button to allow the transaction
log to grow until it runs out of space.
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Note: This is not stating that the transaction log is a database, but instead that for any given
database, you can specify the associated maximum file size for the transaction log.

6. Select OK.
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Define Global Grid and Form Control Display
Settings

Use the Display Options page in the CSM Administrator Blueprint Options window (accessed from within
the Blueprint Editor) to define global display settings.

Settings include:

• Form Controls: Default border style for new Form controls.

• Grid Groupings: Enable Grid Groupings and define default display options.

Note: These defaults act like a template because they promote consistency; however, some
of the settings can be overridden in the individual Grid and Form definitions.

To define Grid and Form Control display settings:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task or the Open an Existing Blueprint task.

Tip: Your most recent working Blueprint is also listed here. Click it to open it in the Blueprint Editor.

2. From the Blueprint Editor Menu bar, click Tools>Options.

3. Click the Display Options page.

4. In the Border Style for New Controls drop-down, select a default border style for new Form Controls:

Use Value From Theme Uses the border format of the Form's default theme.

Create 3D Border Adds a raised 3D border on new Form Controls.

Create Flat Border Adds a flat border on new Form Controls.

5. In the Grids area, select default display settings for Grid Grouping:

Default to Allow Grouping on Grids

Shows the Group By box by default on all Grids.

Note: This default automatically selects the Yes, (Show
Grouping) radio button in each system Grid definition;
however, it can be overridden.

Default to Showing Grouping on
Grids on Tabs

Automatically shows Grid Grouping functionality on Grid
Tabs.

Default to Allowing User to Enable
Grouping on Grids on Tabs

Allows Users to enable Grid Grouping on Grid Tabs if it is
not automatically enabled.
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Default to Allowing Users to
Remember Grouped Columns
Between Sessions

Allows Grid Grouping persistence.
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Configuring Blueprints
System Blueprints Security rights are configured in CSM Administrator.

See System Blueprints Security Rights.
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mApp Solutions
A mergeable application (mApp) Solution is a bundle of CSM system definitions (Business Objects/Fields,
Forms, Grids, Relationships, Actions/One-Step Actions, Saved Searches, etc.), along with merge
instructions, that allows definitions to be transferred between databases and functionality to be merged.
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About mApp Solutions
Use a mApp Solution to share packages of functionality across databases, allowing Users to implement
proven functionality into their CSM systems

A number of Cherwell mApp Solutions and third-party integrations have already been created and can be
applied to your system using the Apply mApp Wizard.

You can also create your own mApp Solutions. After you create a mApp Solution, you can distribute the
file directly to potential Users, or submit it to the Cherwell community. Using the Apply mApp Wizard,
system administrators can then apply the mApp Solution to CSM systems based on the items that were
included in the mApp Solution.

mApp Solutions are accessed and managed through the mApp Solution Editor, which is similar to the
Blueprint Editor, except it has multiple options for adding items to a mApp Solution and defining their
behavior. mApp Solutions have their own workflow.

Related concepts
Apply a mApp Solution
Create a mApp Solution
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mApp Editor
mApp Solution Workflow
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mApp Solution Workflow
1. Create a mApp Solution.

2. Define mApp Solution properties.

3. Save the mApp Solution to a named .mAppBP file (File>Save As).

4. Add/edit definitions and items to the mApp Solution:
◦ System Objects:

◦ Business Objects

◦ Fields

◦ Relationships

◦ Forms

◦ Grids

◦ Form Arrangements

◦ CSM Items (example: Dashboards, Saved Searches, One-Step Actions, etc.)

◦ Business Object Data (for Supporting Objects and Lookup Objects)

◦ Security Groups and/or Roles.

5. Periodically save your changes.

6. Periodically scan the mApp Solution for potential errors.

7. View the changes the mApp Solution will make to the target system's definitions when the mApp
Solution is applied.

8. Prepare the mApp Solution for distribution by validating that it is complete and ready for distribution.

Note: At this point, the mApp Solution must be saved as a .mApp Solution file. This is
required in order for it to be applied using the Apply mApp Wizard.

9. Test the mApp Solution in a separate development environment.

10. Distribute the mApp Solution file directly to potential Users, or submit it to the mApp Exchange.

11. Apply the mApp Solution to a CSM system using the Apply mApp Wizard.
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Related concepts
Create a mApp Solution
Apply a mApp Solution
Define mApp Solution Properties
Scan a mApp Solution
Prepare a mApp Solution for Distribution
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mApp Solutions Page
Use the CSM Administrator mApp Solutions page to quickly access common mApp Solution operations.

Open the mApp Solutions page by clicking the mApp Solutions category in the CSM Administrator main
window.

Common operations include:

• View installed mApp Solutions: Opens a window to view a list of mApp Solutions that have already
been installed in your system.

• Go to the mApp Exchange: Navigates to the mApp Exchange to submit created mApp Solutions and
view mApp Solutions that other Users have submitted.

• Set Designer ID: Allows mApp Solution creators to save a unique developer ID in their current User
information. The developer ID is included in history records for all definitions the creator adds to a
mApp Solution.

• View mApp Solution History: Scans definitions in the current system and displays history records (if
available). The ability to view history records is based on security rights.

• Apply a mApp Solution: Opens the Apply mApp Wizard to walk through the process of applying a
mApp Solution to a CSM system.

• Create a New mApp Solution: Creates a new unnamed mApp Solution, and then launches it in the
mApp Editor.

• Edit an Existing mApp Solution: Allows you to browse for and open an existing mApp Solution file so
that you can edit it in the mApp Editor.

Related concepts
mApp Editor
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mApp Solutions Good to Know
Use these tips for helpful information on mApp Solutions.

• mApp Solutions affect system definitions and are used and managed from within CSM
Administrator. Access mApp Solutions and mApp Solutions functionality from the CSM Administrator
mApp Solutions page.

• When you include a definition in a mApp Solution, you decide how it will be handled when the mApp
Solution is applied to a target system:

◦ Import: Imports the definition into the target system.

◦ Remove: Removes the definition from the target system.

◦ For Reference Only: Includes the definition in the mApp Solution for informational purposes
only (the definition is not imported into the target system). You should rarely (if ever) need to
do this manually, as the system automatically adds definitions as necessary for reference only.
For example, to:

◦ Identify the Business Object associated with an item (example: One-Step Action) in a
mApp Solution so that it can be associated correctly in the target system.

◦ Identify a Group Leader when only some Group Members are added to a mApp Solution.

◦ Identify the View that items belong to. For Reference Only allows items to be imported
into systems that might not have the same associations, Groups, or Views available.

• If a definition in a mApp Solution is matched to a definition in a target system, you can select how to
import it and what to do with the existing definition:

◦ Overwrite: Overwrites the existing definition in the target system.

◦ Don't Import: Skips importing the mApp Solution definition into the target system (the existing
definition is left unchanged).

◦ Merge: Merges the mApp Solution definition with the definition in the target system (you can
import/overwrite or skip importing individual areas of the definitions).

• The following definitions can be merged:
◦ Business Objects

◦ Fields (individual Fields and their properties)

◦ Relationships (individual Relationships and their properties)

◦ Form Arrangements (individual tabs)

◦ Business Object Actions (areas [example: Task Pane] and individual Actions)

For more information, see Configure Merge Actions for Business Object Definitions.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure mApp Solution Security Rights.

Related concepts
mApp Solutions Page
Create a mApp Solution
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mApp Editor
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mApp Solution Compatibility
Due to changes made to support Globalization, the following guidelines apply to mApp Solutions:

• mApp Solutions created using CSM 9.2.0 or later cannot be applied to an earlier version of CSM.

• When you apply a mApp Solution to that was created on a version earlier than CSM 9.2.0, you are
prompted to and must select a target culture for the mApp.
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Tips for Creating and Using mApp Solutions
Use the following tips to help you create an effective mApp Solution:

• Have a plan:
◦ Gather information (interviews, research, etc.) to get ideas.

◦ Create real-world scenarios.

◦ Create flowcharts, wireframes, prototypes, etc.

• Check your assumptions:
◦ How the mApp Solution will be used.

◦ What the target system will look like.

◦ What limitations exist (example: You cannot edit an existing Form, but you can create a new
Form).

• Keep the following in mind:
◦ Check for References to ensure all dependent definitions are included in a mApp Solution.

◦ When you include a Business Object in a mApp Solution and select Merge as the merge
action, only include the Fields that apply to the mApp Solution (delete the Fields you do not
want to be imported into a target system). If the Business Object does not exist in the target
system, it will be imported in its entirety, without any unnecessary Fields.

◦ When you include a Relationship in a mApp Solution, either add the reverse Relationship to
the mApp Solution or clear the Reverse Relationship check box (on the General page in the
Relationships Properties window).

Following are some tips for applying mApp Solutions:

• Apply a mApp Solution against a test environment before committing it to your live production
environment. This allows you to verify that changes are applied without errors and produce the
expected results.

• For mApp Solutions that contain Security Groups and Roles, carefully review security changes that
may impact the target system after you apply the mApp Solution. Also, remember that you must
manually assign Users to Security Groups after you apply a mApp Solution that contains Security
Groups.
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Managing mApp Solutions
mApp Solutions are managed in CSM Administrator using the mApp Solution Editor.

Use the mApp Solution Editor to:

• Create a mApp Solution.

• Edit an existing mApp Solution.

• Save a mApp Solution.

• Scan a mApp Solution.

• Close a mApp Solution.

• View mApp Solution changes.

• Prepare a mApp Solution for Distribution.

Related concepts
mApp Editor
Open the mApp Editor
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mApp Editor
The mApp Editor is the built-in interface within CSM Administrator that allows you to manage mApp®
Solutions and access various tools for adding definitions to mApp Solution.

.

Use themApp Editor to:

• Add Business Objects to a mApp: Use the Add Business Object to mApp Wizard to add Business
Objects and their associated Fields, Relationships, Forms, Grids, and Form Arrangements to a
mApp Solution.

• Add CSM Items to a mApp: Use the mApp Solution options button  in CSM Item Managers (or
right-click item>Add to mApp) to include things like One-Step Actions, Dashboards, Saved
Searches, etc. in a mApp Solution.

• Open the Definition Reviewer: View and modify Forms, Grids, and Form Arrangements for all
Business Objects or for those that have been modified in the mApp Solution.

• Edit Business Object Data: Use the Edit Data task within a mApp Solution to modify (add, edit,
delete) data for a Supporting Object or Lookup Table.

• Manage mApp Solutions: Use the tasks in the Task Pane and/or File menu to:
◦ Define mApp Solution properties.

◦ Save and close mApp Solutions.

◦ View the changes the mApp Solution will make to the target system's definitions (File>mApp
Solution Changes).

◦ Prepare mApp Solutions for distribution.

Related concepts
Open the mApp Editor
Create a mApp Solution
Add a Business Object to a mApp Solution
Add CSM Items to a mApp Solution
Add Security Groups and/or Roles to a mApp Solution
Edit Business Object Data in a mApp Solution
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mApp Editor Menu Bar
Use the mApp Editor menu bar to access common mApp tasks.

Note: The mApp Editor menu bar is dynamic so options vary depending on what is active in the
mApp Editor Main Pane (ex: When the Object Manager is active, several additional options are
available on the Edit menu; when a Grid is active, Print Grid and Export Grid options are
available on the File menu).

File Menu

Action Description

Save mApp to disk Saves changes to the active mApp Solution.

Save As Saves the new or active mApp Solution as a named .mAppBP file.

Close mApp

Closes the mApp Solution, but not CSM Administrator. If the mApp
Solution is not yet saved to a named .mAppBP file, you are prompted
to name and save it. If changes are not yet saved, you are prompted
to save them to the active .mAppBP file.

Scan mApp Scans the active mApp Solution for potential errors.

Prepare mApp for Distribution Validates the mApp Solution to ensure it is complete and ready to be
distributed to potential users or to the Cherwell community.

mApp Properties Opens the mApp Solution Properties window to define general mApp
Solution properties and Features.

mApp Changes Opens a window to view the changes that will be made to the target
system's definitions.

Print Grid

Note: Only visible when
a Grid is active in the
Main pane.

Prints the active Grid.

Export Grid

Note: Only visible when
a Grid is active in the
Main pane.

Exports the active Grid.

Exit Exits CSM Administrator. If you are working in a mApp Solution and
have unsaved changes, CSM prompts you to save your changes.
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View Menu
Selects what to display in the mApp Editor Main pane.

Action Description

Object Manager Opens the Object Manager Home page.

Definition Reviewer Opens the Definition Reviewer.

Business Object Opens the Business Object Editor so you can manage the active
Business Object.

Relationship Opens the Relationship Editor so you can manage Relationships for
the active Business Object.

Form Opens the Form Editor so you can manage forms for the active
Business Object.

Grid Opens the Grid Editor so you can manage Grids for the active
Business Object.

Arrangement Opens the Form Arrangement Editor so you can manage the Form
Arrangement for the active Business Object.

Find Dependencies Displays the active Business Object's dependencies.

Scan Results

Note: Only visible if a mApp
Solution scan returns errors that
still need to be resolved.

Opens the Scan Results window.

Edit Menu

Action Description

Cut Moves the selected item to the clipboard. You can
then paste the item into a new location.

Copy Copies the selected item to the clipboard. You can
then paste the item to a new location.

Paste Inserts an item from the clipboard to a new
location.

Managers Menu

Action Description

Adaptive Layout Presets Opens the Adaptive Layout Preset Manager.

Attachment Manager Opens the Attachment Manager.
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Action Description

Automation Processes Opens the Automation Process Manager.

Business Hours Opens the Business Hours Manager.

Calendar Manager Opens the Calendar Manager.

Canonical Definitions Open the Canonical Definitions Manager.

Counters Opens the Counter Manager.

Dashboards Opens the Dashboard Manager, Widget Manager, Metric Manager, or
Color Palette Manager.

Database Server Objects Opens the Database Server Objects Manager.

Document Repositories Opens Document Repository Manager.

E-mail and Event Monitoring Opens the E-mail and Event Monitoring Manager.

Expressions Opens the Expression Manager.

External Connections Opens the External Connections Manager.

Formats Opens the Stored Format Manager.

Group Maps Opens the Group Map Manager.

HTML Page Manager
Opens the HTML Page Manager. This allows you to add an HTML page
to a mApp Solution. To create/edit an internal HTML page, see Managing
HTML Pages.

Images Opens the Image Manager.

Knowledge Opens Knowledge Mapping Manager, and Knowledge Source Manager.

Language Packs Opens the Language Pack Manager.

Locked Strings Opens the Locked Strings Manager.

One-Step Action Opens the One-Step Action Manager.

Prompts Opens the Prompts Manager.

Queues Opens the Queue Manager.

Reports Opens the Reports Manager.

Roles Opens the Role Manager (available only from the mApp Editor).

Scheduled Items Opens the Scheduled Items Manager.

Searches Opens the Search Manager.

Security Groups Opens the Security Group Manager (available only from the mApp
Editor).

Site Manager Opens the Portal Site Manager.

Stored Imports Opens the Stored Imports Manager.

Stored Values Opens the Stored Value Manager.
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Action Description

Teams Opens the Team Manager.

Themes Opens the Theme Manager.

Twitter Account Manager Opens the Twitter Account Manager.

Visualizations Opens the Visualization Manager.

Web Services Opens the Web Services Manager.

Webhooks Opens the Webhooks Manager.

Tools Menu

Action Description

Directory Services Opens the Directory Services window to configure and manage the Directory
Service integrations (ex: Active Directory, LDAP, etc.).

Export Schema Exports a mApp Solution Schema to an HTML file.

View Publish Log Displays the Published Blueprint Log.

Options
Opens the Blueprint Options window, to define global database settings (ex:
Timeout values, foreign keys, Transaction Log, Grid and Form display settings,
etc.).

Help

Action Description

mApp Help Opens the online help.

Report Error
Opens the Report Error window so you can report
an error to Cherwell Software.

About Opens an About window to view version and
licensing information for CSM.
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mApp Solution Editor Toolbar
Use the mApp Solution Editor toolbar to quickly access common mApp Solution tasks.

Note: The mApp Solution Editor toolbar is dynamic so options vary depending on what is active in
the mApp Solution Editor Main pane (example: When the Object Manager is active, create and
delete options are available on the toolbar).

Tip: Many toolbar items are also available from the mApp Solution Editor menu bar and the Task
Pane.

Button Action Description

Home Opens the Object Manager Home page in the Editor Main Pane.

Definition
Reviewer

Opens the Definition Reviewer, enabling you to view and modify Forms,
Grids, and Form Arrangements for all Business Objects.

Save Saves changes to the active mApp Solution.

Update Updates the current item.

Abandon Abandons changes to the current item.

Create New Creates a new item.

Delete Deletes the current selection.

Cut Moves the selected item to the clipboard, so you can then paste the
item into a new location.

Copy Copies the selected item to the clipboard, so you can then paste the
item to a new location.

Paste Inserts an item from the clipboard to a new location.

Business Object Opens the Business Object Editor, where you can manage the active
Business Object.

Relationship Opens the Relationship Editor, where you can manage Relationships for
the active Business Object.

Form Opens the Form Editor, where you can manage Forms for the active
Business Object.

Grid Opens the Grid Editor, where you can manage Grids for the active
Business Object.
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Button Action Description

Arrangement Opens the Form Arrangement Editor, where you can manage the Form
Arrangement for the active Business Object.

Related concepts
Managing mApp Solutions
Open the mApp Editor
mApp Editor
mApp Editor Menu Bar
mApp Solution Editor Task Pane
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mApp Solution Editor Task Pane
Use the mApp Solution Editor Task Pane to access mApp Solution tasks.

You can access:

• mApp Solutions: Tasks for managing mApp Solutions.

• Common Tasks: Common mApp Solution Editor tasks.

• Help: Online documentation.

Note: Additional options and sections might appear depending on which editor is currently
active.

The Task Pane is located on the left side of the mApp Solution Editor.

Behaviors include:

• Expand or collapse the pane
Hover over the line on the right side of the pane, and then click-

and-drag the Sizing Handles .

• Collapse a section Click the title banner of the section.

• Display an item in the Main
Pane

Click a specific item.

Tip: Hover over an item to display a tooltip.

Related concepts
Managing mApp Solutions
Open the mApp Editor
mApp Editor
mApp Editor Menu Bar
mApp Solution Editor Toolbar
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Open the mApp Editor
To open the mApp Editor from the CSM Administrator main window, click the mApps category, and then
click the Create a New mApp task or the Edit an existing mApp task.

Related concepts
Managing mApp Solutions
mApp Editor
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Create a mApp Solution
Use the Create a New mApp Solution task in the CSM Administrator main window to create a mApp
Solution.

When you create a mApp Solution, you:

• Define general mApp Solution properties, including name, description, display image, etc. You can
also define mApp Solution Features to group subsections of definitions together.

• Add various definitions and items (Business Objects, CSM Items, and Business Object data) to the
mApp Solution and specify how they will be merged into the target system.

To create a mApp Solution:

1. In the CSM Administrator main window, click the mApps category, and then click the Create a New
mApp task.

A mApp Solution is created, and its interface, the mApp Solution Editor, opens. By default, the
Object Manager is displayed in the mApp Editor’s Main pane. The mApp Solution is unnamed
(called New mApp*) until saved to a named mApp Solution Blueprint file (.mAppBP).

2. Define mApp Solution properties.

3. Save the mApp Solution to a named .mAppBP file (File>Save As).

4. Add definitions and items to the mApp Solution:
◦ Use the Add Business Object to mApp Solution Wizard to walk through the process of adding

Business Objects and their associated Fields, Relationships, Forms, Grids, and Form
Arrangements.

◦ Use the mApp Solution Options button  (or right-click item>Add to mApp) in CSM Item
Managers to add CSM Items (example: One-Step Actions, Dashboards, Saved Searches,
etc.).

◦ Use the Edit Data task within a mApp Solution to manage (add, edit, delete) data in a
Supporting Object or Lookup Object (only available if Show in Table Management is checked
in the Business Object's properties).

◦ Use the Security Group Manager and the Role Manager to add predefined Security Groups
and/or Roles.

5. Save changes to the named open mApp Solution (click the Save button ). You can also view the
changes that will be made to the target system's definitions.

Tip: Periodically scan your mApp Solution to find potential errors.

When ready, you can prepare the mApp Solution for distribution, and then distribute the file directly
to potential Users, or submit it to the mApp Solution Exchange. System administrators apply the
mApp Solution to CSM systems using the Apply mApp Wizard.

Related concepts
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Define mApp Solution Properties
Add a Business Object to a mApp Solution
Add CSM Items to a mApp Solution
Add Security Groups and/or Roles to a mApp Solution
Edit Business Object Data in a mApp Solution
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Set a Designer ID
Use the Set Designer ID task on the mApp Solutions page in CSM Administrator to save a unique
Designer ID to your current user information. Setting a Designer ID uniquely identifies the definitions you
add to a mApp Solution and tracks them in history records.

Good to know:

• Setting a Designer ID is optional. If you do not have a Designer ID, no history records are created
for definitions you add to a mApp® Solution.

• Each definition can have a maximum of 20 history records. When new history records exceed this
limit, the oldest records are deleted.

• Each history record contains the Designer ID, date/time the definition was saved, and the mApp
Solution name.

• If a mApp Solution creator modifies or adds a definition that has a most recent history record with
the same Designer ID, only the date/time is updated (a new record is not added).

Note: New Designer IDs cannot be created at this time.

To set a Designer ID in CSM Administrator:

1. In the CSM Administrator main window, select the mApps category, and then select the Set
Designer ID task.

2. Enter your Designer ID.

3. Select OK.

Related concepts
About mApp Solutions
Go to the Cherwell Marketplace (formerly the mApp Exchange)
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Define mApp Solution Properties
Use the mApp Solution properties window, accessed from within the mApp Editor, to define mApp
Solution properties.

• General properties:
◦ Name and description: Specific name and description for the mApp Solution.

◦ (Optional) Image: Image to represent the mApp Solution.

◦ Created by: Name of mApp Solution creator (individual or organization).

◦ (Optional) Details URL: Site that contains detailed information about the mApp Solution.

◦ (Optional) Prevent mApp customizations during install: Removes the option to ignore parts of a
mApp during an upgrade.

• (Optional) Features: Definitions grouped together into subsections of functionality.

Good to know:

• When system administrators apply a mApp Solution to a CSM system, the general properties are
displayed in the Apply mApp Wizard. When Users view the mApp Solutions that have been installed
in their systems, the general properties are shown in the Installed mApp Solutions window.

• You must define at least the general properties in order for the mApp Solution to be considered
ready for distribution.

• If you have Globalization and multiple cultures enabled for your system and translations that impact
your mApp Solution have been applied, you must define mApp Solution properties for each culture.
For more information, see Applying Cultures to mApps.

• Business Object and CSM Item definitions can be grouped together into Features (subsections of
functionality) using mApp Solution conditions. Features can then be applied (or not) as a whole in
the Apply mApp Wizard.

To define mApp Solution properties:

1. Open the mApp Editor.

2. From the mApp Editor menu bar, select File > mApp Properties.

3. Select the General Properties page.

4. Define general properties for the mApp Solution:
◦ Name: Provide a display name to use for the mApp Solution.

◦ Description: Provide a description of the mApp Solution. This should be as detailed as
possible, as it is displayed in the Apply mApp Wizard.

◦ Image: Select an image to associate with the mApp Solution.
◦ None: Select this radio button to not associate an image with the mApp Solution.

◦ File: Select this radio button to use an image for the mApp Solution. Then, select the

Ellipses button  to browse to the location of the image file, select the file, and
selectOpen.
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◦ Created by: Provide the name of the organization or individual who created the mApp
Solution.

◦ Details URL: If detailed information about the mApp Solution is available on a website, provide

the URL here. Then, select the Ellipses button  to navigate to the site and ensure that the
URL is correct.

◦ Advanced Options : As a mApp author, select the Prevent mApp customizations during
install checkbox to remove the Don't Change option when a mApp is applied during an
upgrade. This means that the mApp is applied in its entirety during an upgrade, lessening the
possibility of a mApp failure with customized content.

5. Select the Features page.

6. (Optional) Define mApp Solution Features:
a. Select Add to add a new Feature.

b. Define general properties for the Feature:
◦ Name: Provide a name for the Feature.

◦ Description: Provide a description of the Feature. This is the text that explains the
Feature to the administrator applying the mApp Solution to his system, so ensure that
the description is clear.

◦ This Feature is enabled by default: Select this check box to include the mApp Solution
Feature by default when the mApp Solution is applied to a CSM system using the Apply
mApp Wizard.

c. Select OK.

7. Select the One-Step page.

8. (Optional) Run a One-Step Action:
◦ Select a recently used One-Step Action from the drop-down or select the Ellipses button to

edit it or to select a different one.

◦ Description: Provide a description of the One-Step Action. This should be as detailed as
possible, as it is displayed in the Apply mApp Wizard and explains what the One-Step Action
does. If it already has a description, it will be pre-populated.

Note: This option is not available using the CSM Configuration command-line.

The Action must be an unassociated One-Step Action (not tied to a particular Business
Object).

9. Select OK.

10. Prepare the mApp Solution for Distribution (File > Prepare mApp Solution for distribution), or save
the mApp Solution (File > Save mApp Solution to Disk) to continue making other changes.

Related concepts
mApp Editor
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Open the mApp Editor
Apply a mApp Solution
Prepare a mApp Solution for Distribution
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Add a Business Object to a mApp Solution
The Add Business Object to mApp Solution wizard (accessed from within the mApp Editor) is a
specialized tool that adds Business Objects and their associated Fields, Relationships, Forms, Grids, and
Form Arrangements to a mApp Solution.

Use the Add Business Object to mApp Solution Wizard to select which Business Object to add to the
mApp Solution and define its importance to the mApp Solution. Then, define how the Business Object will
be imported into the target system when the mApp Solution is applied:

• Overwrite All: Overwrites the existing definitions in the target system, or adds them if they are not
already there.

• Overwrite defaults only (applies to Forms and Grids): Overwrites the existing defaults in the target
system.

• Do not overwrite any: Leaves the definitions in the target system unchanged (does not overwrite or
add the definition).

• Let me choose: Allows you to select which items or areas (example: Specific Fields) to merge.
Selected items are overwritten if they exist in the target system, and added if they are not. The items
you do not select are left unchanged in the target system.

Tip: When you select Let me choose, you can click the Uncheck All button  to clear everything in

the list (example: Clear all Fields) or the Select All button  to select everything in the list.

To add a Business Object to a mApp Solution:

1. Open the mApp Editor.

2. Click a Business Object in the Object tree, and then click the Add Business Object to mApp
Wizard task in the Structure area.
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Tip: You can also open the wizard from the Business Object Editor within a mApp Solution, either by
clicking the Add to mApp button or the Add to mApp Wizard link in the Business Object section of
the mApp Solution Editor Task Pane.

3. Select a Business Object to include in the mApp Solution, and then specify its importance to the
mApp Solution:

a. In the drop-down, select a Business Object. The Business Object you selected in the Object
Manager is automatically selected.

Note: If you add a Group Member, the Group Leader is automatically added to the mApp
Solution for reference.

Tip: The drop-down displays only Major Business Objects. To display all Business Objects,
select the Show All check box.

b. Define the importance of the Business Object to the mApp Solution. This marks the items in
the mApp Solution file according to importance so that when a mApp Solution is applied, the
most important items are asked about first.

Note: Because Group Leaders have common items that are shared by all Group Members,
Group Objects are always applied first (Group Leader followed by Group Members),
regardless of the importance selected here.
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◦ High Importance: Select this radio button if the Business Object is one of the main
Business Objects in the mApp Solution.

◦ (Default) Medium Importance: Select this radio button if the Business Object is a
supporting object for the mApp Solution.

◦ Low Importance: Select this radio button if the Business Object is not critical for the
mApp Solution.

Tip: You can click Finish on this page or any subsequent pages to accept the default
selections for the remaining pages and complete the wizard.

4. Select the Business Object Fields to overwrite in the target system:
◦ (Default) Overwrite all Fields: Select this radio button to overwrite all existing Fields in the

target system.

◦ Do not overwrite any Fields: Select this radio button to make no changes to any of the existing
Fields in the target system.

◦ Let me choose: Select this radio button to select specific Fields to overwrite.

Note: If you select an option other than Overwrite all Fields, the Business Object is added to
the mApp Solution as Merge. This is because Fields are part of Business Objects, and the
Business Object must be set to Merge if you do not want all of its Fields to be overwritten. If
the Business Object is set to Overwrite, all Fields will be overwritten. For more information,
see Configure Merge Actions for Business Object Definitions.

5. Select which Relationships to overwrite in the target system:
◦ (Default) Overwrite all Relationships: Select this radio button to overwrite all existing

Relationships in the target system.

◦ Do not overwrite any Relationships: Select this radio button to make no changes to any of the
existing Relationships in the target system.

◦ Let me choose: Select this radio button to select specific Relationships to overwrite.

6. Select which Business Object Forms to overwrite in the target system:
◦ (Default) Overwrite default Forms only: Select this radio button to overwrite the default Forms

in the target system. This includes the primary Form for the object, along with the summary
and mini-summary Forms.

◦ Overwrite all Forms: Select this radio button to overwrite all Forms (default and other) in the
target system.

◦ Do not overwrite any Forms: Select this radio button to make no changes to any of the Forms
in the target system.

◦ Let me choose: Select this radio button to select specific Forms to overwrite.

7. Select which Grids to overwrite in the target system:
◦ (Default) Overwrite Default Grids Only: Select this radio button to overwrite the default Grid for

the Business Object in the target system.

◦ Overwrite all Grids: Select this radio button to overwrite all Grids (default and other) in the
target system.
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◦ Do not overwrite any Grids: Select this radio button to make no changes to any of the Grids in
the target system.

◦ Let me choose: Select this radio button to select specific Grids to overwrite.

8. Select whether to overwrite the Form Arrangement (Major Business Objects only):
◦ Overwrite Form Arrangement: Select this radio button to overwrite the Form Arrangement in

the target system.

◦ Do not overwrite Form Arrangement: Select this radio button to make no changes to the Form
Arrangement in the target system.

9. Select which Tabs in the Form Arrangement to overwrite:

Note: This page is displayed only if you are adding a Major Business Object to the mApp Solution,
and if you selected to overwrite the Form Arrangement on the previous page.

◦ Overwrite all Tabs: Select this radio button to overwrite all Tabs in the target system.

◦ Do not overwrite any Tabs: Select this radio button to make no changes to the Tabs in the
target system.

◦ Let me choose: Select this radio button to select specific Tabs to overwrite.

Note: If a Tab is included in a mApp Solution, but the associated Relationship is not
added by the mApp Solution and does not already exist in the target system, the Tab
will not be displayed in the target system.

10. Define whether to overwrite Approvals:

Note: This page is displayed only for Major Business Objects that have Approvals defined.

◦ Overwrite Approvals: Select this radio button to overwrite Approvals in the target system.

◦ Do not overwrite Approvals: Select this radio button to make no changes to Approvals in the
target system.

11. Define whether to overwrite Business Object Action areas:

Note: This page is displayed only for Major Business Objects that have Actions defined.

◦ Overwrite all Actions: Select this radio button to overwrite all Business Object Action areas in
the target system.

◦ Do not overwrite any Actions: Select this radio button to make no changes to the Business
Object Action areas in the target system.

◦ Let me choose: Select this radio button to select specific Business Object Action areas to
overwrite.

Note: Actions are categorized by areas (Menu, Task Pane, toolbar, Context Menu, and
Automatic Actions). When you select one of the above options from the wizard, you are
defining what to do with an entire area. However, you can define separate options for
individual Actions within an area if you use the Business Object Actions window to configure
merge actions for Business Object Actions.
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12. Review the summary page.

13. Select Finish.

The Business Object and its associated Fields, Relationships, Forms, Grids, and Form
Arrangements are added to the mApp Solution. When the mApp Solution is applied, these
definitions will be imported into a target system according to the selections you made.

14. (Optional) Add additional Business Objects or CSM Items to the mApp Solution.

15. (Optional) Use the mApp Solution Options button  in the various properties windows to configure
merge actions for Business Object definitions.

16. Prepare the mApp Solution for Distribution (File>Prepare mApp Solution for distribution), or save the
mApp Solution (File>Save mApp Solution to Disk) to continue making other changes.

Related concepts
mApp Editor
Open the mApp Editor
Apply a mApp Solution
About Business Objects
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Add CSM Items to a mApp Solution

Use the mApp Solution Options button  in CSM Item Managers to include CSM Items (example:
Automation Processes, One-Step Actions, Dashboards, Saved Searches, etc.) in a mApp Solution.

Good to know:

• Click the References button to see which definitions throughout CSM are being used by the
definitions in a mApp Solution. This allows you to ensure that all necessary definitions are included
in the mApp Solution.

Note: Dashboards are currently the only CSM Items that automatically prompt you to add
associated items (Widgets) when you include them in a mApp Solution.

• You can define some additional options when adding Stored Values and external connections to a
mApp Solution. For more information, see Add a Stored Value or External Connection to a mApp
Solution.

To add a CSM Item to a mApp Solution:

1. Open the mApp Editor.

2. From the menu bar, click Managers, and then click a CSM Item Manager.

3. Select an item in the Manager, and then click the mApp Options button .

Tip: You can also right-click an item, and then click Add to mApp in the context menu. You

can then click the mApp Options button  to set import options.

4. Select the Include in mApp Solution check box.

5. Define options for how to import the item into a target system (Options area):
◦ Import to target system: Select this radio button to import the item definition into the target

system. Then, select a merge action based on whether the definition is already present in the
target system.

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the existing
definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system when the
mApp Solution is applied).

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:
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◦ Import: Select this option to import the mApp Solution definition into the target system if
does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into the
target system if it does not already exist (the mApp Solution definition will not be added
to the target system).

◦ Remove from Target System: Select this radio button to have the mApp Solution remove the
item definition from the target system when it is applied.

◦ For Reference Only: Select this radio button to include the item definition in the mApp
Solution for reference. When the mApp Solution is applied, the item definition will not be
merged into the target system; it exists in the mApp Solution for informational purposes only.
You should rarely (if ever) need to do this manually, as the system automatically adds
definitions as necessary for reference only.

6. Select the Import based on Condition check box to have the mApp Solution import the item

definition based on conditions. Then, click the Ellipses button  to open the mApp Solution
Conditions window and configure conditions.

7. Select OK.

8. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.

Related concepts
Create a mApp Solution
Open the mApp Editor
View Referenced Definitions in a mApp Solution
Configure mApp Solution Conditions
Prepare a mApp Solution for Distribution
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Add a Stored Value or External Connection to a
mApp Solution

Use the mApp Solution Options button  in the Stored Value Manager or the External Connection
Manager to include Stored Values and/or external connections in a mApp Solution and define how they
are imported into a target system when the mApp Solution is applied:

• Import to target system: Imports the item definition into the target system. You can select merge
actions based on whether the item definition already exists in the target system.

• Remove from target system: Removes the item definition from the target system.

• For Reference Only: Includes the item definition in the mApp Solution for informational purposes
only (it is not merged into the target system when the mApp Solution is applied).

• Import/remove based on condition: Imports or removes the item definition based on configured
mApp Solution conditions.

• Prompt for values: Includes a prompt in the Apply mApp Wizard to allow Users to specify their own
values for a Stored Value, or external connection information for an external database.

Good to know:

• Click the References button to see which definitions throughout CSM are being used by the
definitions in a mApp Solution. This allows you to ensure that all necessary definitions are included
in the mApp Solution.

• This procedure assumes that the Stored Values and/or external connections being added to a mApp
Solution already exist. For more information about creating Stored Values or external connections,
refer to Create a Stored Value or Create an External Connection to an External Database

To add a Stored Value or external connection to a mApp Solution:

1. Open the mApp Editor.

2. Open the Stored Value Manager.

3. Select a Stored Value or external connection, and then click the mApp Options button .

Tip: You can also right-click an item, and then click Add to mApp.
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4. Define general options for the item:
◦ Include in mApp Solution: Select this check box to include the item in the mApp Solution.

◦ References: Click this button to view which other definitions in the system are being used by
the selected item.

5. Define options for how the item will be imported into a target system (Options area):

Note: These options are only available if Include in mApp Solution is selected.

◦ Import to target system: Select this radio button to import the item definition into the target
system. Then, select a merge action based on whether or not the definition is already present
in the target system.

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the existing
definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system when the
mApp Solution is applied).
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If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target system if
does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into the
target system if it does not already exist (the mApp Solution definition will not be added
to the target system).

◦ Remove from Target System: Select this radio button to have the mApp Solution remove the
item definition from the target system when it is applied.

◦ For Reference Only: Select this radio button to include the item definition in the mApp Solution
for reference. When the mApp Solution is applied, the item definition will not be merged into
the target system; it exists in the mApp Solution for informational purposes only.

Note: You should rarely (if ever) need to do this manually, as the system automatically adds
definitions as necessary for reference only.

◦ Import/remove based on Condition: Select this check box to have the mApp Solution import or

remove the item definition based on conditions. Then, click the Ellipses button  to open
the mApp Solution Conditions window and configure conditions.

6. Define prompting options:
◦ Prompt for value during install: Select this check box to prompt Users to provide a value for the

Stored Value or to edit external connection information when they run the Apply mApp Wizard.

◦ Prompt text: Provide the text to display in the Prompt window when it pops up to prompt the
User for a value.

◦ Show prompt for Apply mApp Solution Wizard question modes: Select the interaction level(s)
at which the prompt is displayed in the Apply mApp Solution Wizard:

◦ Ask me about every decision (default): Select this check box to prompt the User in the
Apply mApp Solution Wizard if a high level of interaction is selected (Ask me about every
decision is selected on the User Interaction page of the Apply mApp Solution Wizard).

◦ Make reasonable decisions, but ask me if unsure: Select this check box to prompt the
User in the Apply mApp Solution Wizard if a medium level of interaction is selected
(Make reasonable decisions, but ask me if unsure is selected on the User Interaction
page of the Apply mApp Solution Wizard).

◦ Don't ask me unless absolutely necessary: Select this check box to prompt the User in
the Apply mApp Solution Wizard if a low level of interaction is selected (Don't ask me
unless absolutely necessary is selected on the User Interaction page of the Apply mApp
Solution Wizard).

Note: This option is only available if you also selected to make the prompt available at
the medium interaction level (Make reasonable decisions, but ask me if unsure).

7. Select OK.
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8. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Edit Business Object Data in a mApp Solution
The Data Editor is the interface within the Blueprint Editor or mApp Editor that allows you to edit data
within a Supporting Business Object or Lookup Business Object. Use the Data Editor to:

• Add records (rows) with new data.

• Delete existing records.

• Update the data in a record.

• Clear all data from the table and replace it with new/updated data.

There are several ways to open the Data Editor.

To open the Data Editor:

1. The Data Editor can be opened several ways in CSM Administrator:
◦ In the CSM Administrator Main Pane, click the Settings category, and then click the Table

Management task.
◦ In a Blueprint or mApp Solution, select a Supporting Object or Lookup Object (example:

Incident Category Lookup Object) from the Object tree in the Object Manager, and then click
the Edit Data task in the Structure area.

◦ In the Validation/Auto-Populate page of the Field Properties window, when you select to
validate a Field from a table, click the Edit Table Data button (activated after selecting a table
in the drop-down).
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1. Menu bar: Displays a row of drop-down menus available in the Data Editor.

2. Toolbar: Displays a row of buttons for operations available in the Data Editor.

3. Main Pane: Displays either the list of records in the data table (as a Grid), or the details for the
currently selected record (depending on the view you are in). The Action column shows what will be
done with the data in each row of the table when the mApp Solution or Blueprint is applied/
published.

Note: Select the Clear all data from destination table check box to have all existing data
in the current system Lookup Object cleared out when the mApp Solution or Blueprint is
applied/published. If you want to keep any existing data, you must select the rows with the

data you want to keep and click the Include in mApp or Blueprint button .

Good to know:

• The objects for which you are editing data are automatically added to the mApp Solution For
Reference Only if they are not already in the mApp Solution.
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• Because data is edited within a Blueprint or a mApp Solution, the data in your system is not actually
modified until the Blueprint is published or the mApp Solution is applied.

• Business Object Data is limited to 1,000 records. You will receive a warning if you exceed that limit.
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Add Security Groups and/or Roles to a mApp
Solution

Use the mApp Solution Options button  in the Security Group Manager or Role Manager to include
pre-defined Security Groups or Roles in a mApp Solution.

You can also define how Security Groups and/or Roles are imported into a target system when the mApp
Solution is applied.

Good to Know:

• Security Groups and/or Roles may impact security rights in the target database after the mApp
Solution is applied. Be sure to carefully review the merge actions and target items for Security
Groups and Roles when you apply the mApp Solution. To ensure that you understand the
implications of applying security changes included in the mApp Solution, we strongly advise you to
apply the mApp Solution to a test environment and verify the security changes before you commit
the mApp Solution to a production environment.

• You cannot modify Security Groups or Roles in a mApp Solution.

• Users assigned to a Security Group are not added to the mApp Solution. You must manually add
Users to the Security Group after you apply the mApp Solution to the target system.

• The following attributes are included with Role definitions:
◦ Role Name

◦ Primary Object

◦ Description

◦ Culture

◦ Role Image

If you do not choose to include Roles associated with Security Groups when you add Security
Groups, you must manually add Roles to Security Groups in the target system.

To add a Security Group and/or Role to a mApp Solution:

1. Open the mApp Editor.

2. From the menu bar, click Managers, and then click Security Groups or Roles.

3. Select an item, and then click the mApp Options button .

Tip: You can also right-click a Security Group or Role, and then click Add to mApp in the

context menu. You can then click the mApp Options button  to set import options.

4. Select the Include in mApp Solution check box.
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5. If you are adding a Security Group, you are given the option to add Roles associated with the
Security Group at the same time. You can:

◦ Click Yes to add associated Roles.

◦ Click No to add the Security Group without its associated Roles.

6. Select the Import to target system option to import the Security Group and/or Role into the target
system, and then select import options:

◦ If already present: Select an action to define how the definition is imported if it already exists
in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the existing
Security Group and/or Roles in the target system.

◦ Don't Import: Select this option to leave existing Security Group and/or Roles in the
target system unchanged.

◦ If not present: Select an action to define whether the definition is imported if it does not
currently exist in the target system:

◦ Import: Select this option to import the Security Group and/or Roles into the target
system if they do not already exist.

◦ Don't Import: Select this option to skip importing the Security Group and/or Roles into
the target system if it they do not already exist..

7. Select the Import based on Condition check box to import the Security Group and/or Roles based

on conditions. Then, click the Ellipses button  to open the mApp Solution Conditions window
and configure conditions.

8. Click OK.

9. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.

Related concepts
Create a mApp Solution
About Security Groups
About Roles
Configure mApp Solution Conditions
Prepare a mApp Solution for Distribution
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Configure mApp Solution Conditions
Use the mApp Conditions window to configure conditions that control which definitions in a mApp Solution
are imported into a target system.

When you configure conditions for a mApp Solution definition, you create a list of system definitions or
Features (defined in mApp Properties). A mApp Solution definition is only imported into a target system if
the definition listed in the condition is imported/overwritten, or if the Feature it belongs to is imported.

You can configure conditions for:

• Business Objects/Fields, Forms, Grids, Relationships, Form Arrangements

• CSM Items (Automation Processes, One-Step Actions, Dashboards, Saved Searches, etc.)

• Security Groups and Roles

Good to know:

• If you add definitions to a mApp Solution using the References window, a condition is automatically
set up to only import the definition into a target system if the item using it is also imported (or already
exists in the target system).

To configure mApp Solution Conditions:

1. Use one of these methods to open the mApp Conditions window:

◦ Select the Import Based on Condition check box, and then click the Ellipses button  in
the following areas:

◦ Business Object Properties window

◦ Relationship Properties window

◦ Field Properties window

Note: Business Objects and Fields can only have conditions based on Features. Other
items can have conditions based on other definitions being imported.

◦ Select the Import Based on Condition check box, and then click the Ellipses button  in
the mApp Options window in the following areas:

◦ Form Editor

◦ Grid Editor

◦ Form Arrangement Editor

◦ Security Groups and Roles

◦ CSM Item Managers

533

CSM 10.0.0 Administration

CSM 10.0.0 Administration



2. Add a definition to the list of conditions:
a. Click Add to open a menu of definitions organized by type (example: Business Object). The

list shows all definitions included in the mApp Solution, along with all defined Features (except
when adding conditions for Fields and Business Objects, which can only have conditions
based on Features).

b. Hover over a category to open a menu of specific definitions.

c. Select a definition to add it to the list.

3. Add additional definitions to the list as necessary.

Tip: Click Remove to remove a selected definition from the list. Use the Up/Down arrow to
change the order of the selected definitions.

4. Select OK.

Related concepts
Define mApp Solution Properties
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Open an Existing mApp Solution
Use the Edit tasks (accessed from the CSM Administrator main window) to open an existing mApp
Solution and edit it.

To open an existing mApp Solution:

1. In the CSM Administrator main window, click the mApps category, and then click the Edit an
Existing mApp task.

Tip: The last saved mApp Solution is also listed for your convenience. Click it to open it directly in
the mApp Editor, and then make edits.

2. Select a .mAppBP file, and then click Open.

The mApp Solution opens in the mApp Editor. The name of the mApp Solution is displayed at the
top of the CSM Administrator window and at the top the mApp Editor.
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Save a mApp Solution
An open (working) mApp Solution is saved to a .mAppBP file. When the mApp Solution is prepared for
distribution, it is saved as a .mApp Solution file (extension required for a mApp Solution to be applied to a
target system).

There are two save options for a mApp Solution:

• Save As: Saves a mApp Solution as a named mApp Solution Blueprint (.mApp SolutionBP) file.

• Save to disk: Saves changes to the open mApp Solution (.mAppBP) file.

To save a mApp Solution as a named .mAppBP file:

1. Create a mApp Solution. From the mApp Editor menu bar, click File>Save As.

Tip: You can also save a mApp Solution as a named .mAppBP file by clicking Save mApp Solution
to Disk in the mApp Solutions section of the mApp Editor Task Pane.

2. Provide a filename for the mApp Solution.

Note: Ensure that the file type is .mAppBP.

3. Click Save.

A .mAppBP file is created. The name of the mApp Solution is displayed at the top of the CSM
Administrator main window and at the top the mApp Editor.

To save changes to the open mApp Solution:

1. In a mApp Solution, do one of the following:
◦ From the mApp Editor menu bar, click File>Save mApp to Disk.

◦ On the mApp Editor toolbar, click the Save button.

◦ In the mApp Editor Task Pane, click the Save mApp to Disk option.
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Scan a mApp Solution
Use a mApp Solution Scan to periodically check your working mApp Solution for potential errors. The
scan will look for missing items and alert you to any changes you need to make. Use the Scan Results
window to manage any errors and warnings that are found during the scan.

Good to know:

• If you close the Scan Results window without resolving all issues found during the scan, you can
return to this window by clicking View Scan Results in the mApp Solutions section of the mApp
Editor Task Pane. This task is only available while you have issues to resolve; it disappears when
you resolve all issues.

• If you resolve errors and warnings that add definitions to a mApp Solution, scan the mApp Solution
again to ensure that the newly added definitions do not reference additional definitions that need to
be included in the mApp Solution. Depending on the nature of the mApp Solution, some errors or
warnings might be acceptable and do not need to be resolved.

To scan a mApp Solution:

1. Open the mApp Editor.

2. From the mApp Editor menu bar, click File>Scan.

Tip: You can also scan a mApp Solution by clicking Scan mApp Solution in the mApp Solutions
section of the mApp Editor Task Pane.

If the scan is successful, a success window opens.

If the mApp Solution contains changes that require reloading definitions or restarting applications
after the mApp Solution is applied, an alert appears along with the scan results. The alert is
triggered if the mApp Solution contains changes to significant system definitions, such as Business
Objects, Forms, Grids, Form Arrangements, Relationships, Custom Views, One-Step Actions,
automated behaviors, Dashboards, and/or Widgets.

If the scan detects errors, the mApp Solution Scan Results window opens.
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Examples: You will receive errors if you do not define general mApp Solution Properties, or if a
definition in the mApp Solution references another definition that is not included in the mApp
Solution.

3. Manage errors and warnings:
◦ Show Usage: Click this button to open a window that shows how a definition is used in CSM.

◦ Go to Error: Click this button to navigate to the error and resolve it (if the error cannot be
automatically resolved).

◦ Resolve: Click this button to automatically resolve each error or warning separately.

◦ Rescan: Click this button to rescan the mApp Solution.

◦ Resolve mApp Solution Issues: Click this button to resolve all errors and warnings that can be
automatically resolved. If mApp Solution Properties have not been defined, the mApp Solution
Properties window will open so that you can complete the properties.

4. Select OK.

Related concepts
Open the mApp Editor
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Define mApp Solution Properties
Apply a mApp Solution
Scan a Blueprint
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Close a mApp Solution
Use the Close mApp Solution option to close the active mApp Solution, but not CSM Administrator.

To close a mApp Solution:

1. From the mApp Editor menu bar, click File>Close mApp.

Tip: You can also close a mApp Solution by clicking Close mApp Solution in the mApp Solutions
section of the mApp EditorTask Pane.

If the mApp Solution is not yet saved to a named .mAppBP file, you are prompted to name and save
it. If changes are not yet saved, you are prompted to save them to the active .mAppBP file.
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View mApp Solution Changes
Use the mApp Solution Changes window opened from the mApp Solution Editor to view the system
definitions that will be changed by the active mApp Solution when it is applied to the target system.

The mApp Solution Changes window can be opened from the mApp Editor Menu Bar (File>mApp
Solution Changes).

When you view mApp Solution changes, you can:

• Select how changes are grouped (by Business Object, Security Groups, Roles, Definition Type, or
View).

• Search for specific items in the mApp Solution.

• Remove items from the mApp Solution.

• Compare the mApp Solution definitions with the original system definitions.

The indicators next to each definition show the selected merge actions.

Icon Merge Action Description

Overwrite Existing definition will be overwritten (or added if it does not exist).

Import if not found Definition will be imported if it does not already exist in the target
system.

Remove Existing definition will be removed from target system.

Merge Definition will be merged into target system (only selected areas will be
overwritten).

For Reference Only Definition is included in mApp Solution for informational purposes only.

No Icon Don't Import Definition will not be imported into target system.
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1. Display: Groups items in the tree by Business Object, Security Group, Role, Definition, or View.
◦ By Business Object: Groups changes by Business Object (example: Incident).

◦ By Definition Type: Groups changes by the type of system definition (example: Forms).

◦ By View and then Business Object: Groups changes by View (example: Default, Portal
Default) and then by Business Object (example: Incident).

◦ By View and then Definition Type: Groups changes by View (example: Default, Portal
Default) and then by type of system definition (example: Forms).

2. mApp Solution Type: Filters items in the tree by merge action:
◦ Do Not Overwrite: Displays items marked Do Not Overwrite (definition will remain unchanged

in the target system).

◦ For Reference Only: Displays items marked For Reference Only (definition is included in the
mApp Solution for informational purposes only).

◦ Import if not found: Displays items marked Import (definition will be imported into the target
system if it does not already exist).

◦ Merge by area: Displays items marked Merge (individual areas of the definition have separate
merge actions).

◦ Overwrite: Displays items marked Overwrite (definition will be overwritten in the target
system).
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◦ Remove if found: Displays items marked Remove (definition will be removed from the target
system if it already exists).

3. Search: Searches for items by keyword or phrase.
a. In the Search ox, provide a word or phrase to search for. The drop-down displays the most

recently used (MRU) searches.

b. Click Go to run the search. The items containing the specified word or phrase are displayed
within their hierarchical structure.

4. mApp Solution Changes Tree: Displays items in a hierarchical tree grouped by the selected Display
option.

◦ Click the arrow next to a category to expand it and view its items. Click the arrow again to
collapse it.

Tip: Right-click a category or item to open a context menu, and then select options to
expand/collapse the tree, remove items, or compare definitions.

5. Remove/Compare:
◦ Click Remove to remove a selected item from the mApp Solution (it is not removed from the

system).

◦ Click Compare to open the mApp Solution Differences window and compare the mApp
Solution definition with the existing system definition. This a low-level comparison of the
individual properties that make up the definition.

Note: Remove and Compare are only enabled when an individual definition is
selected. You cannot remove or compare definitions by selecting display categories.
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◦ Select the Different Items Only check box to limit the list of existing system definitions to
those that the mApp Solution affects.

544

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Rebase mApp Solution Definitions
Use the Rebase mApp Solution Definitions operation to reload mApp Solution definitions from your
underlying CSM system.

This allows you to update definitions in a mApp Solution with the latest versions from your system while
maintaining the defined merge actions (overwrite, do not overwrite, merge, etc.) for those definitions.

For example, if you create a mApp Solution that includes an Incident Business Object, and then the
Business Object is updated in the underlying system (example: Fields are added/deleted), you can
update the Business Object definitions in the mApp Solution to reflect those changes.

mApp Solution definitions can be rebased in several ways:

1.
◦ (All definitions in a mApp Solution) From the mApp Editor menu bar, click File>Rebase all

mApp definitions.

◦ (Business Object and associated definitions) In the Object Manager in the mApp Editor, click a
Business Object from the Object tree, and then click the Rebase mApp Version of Bus Ob,
etc. task in the Structure area.

Note: The Rebase mApp Solution Version of Bus Ob, etc. option is only available if the
selected Business Object is included in the mApp Solution.

The Rebase Business Object window opens. By default, all definitions included in the mApp
Solution that are associated with the Business Object are selected. Clear the definitions that
you do not want to rebase.

Tip: Click the Uncheck All button  to clear all definitions in the window. Click the

Select All button  to select all definitions.
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◦ (A specific CSM Item definition) In a CSM Item Manager (example: One-Step Action Manager)
in the mApp Editor, right-click an item (example: One-Step Action) that is included in the
mApp Solution, and then select Rebase in mApp from system.
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Prepare a mApp Solution for Distribution
Prepare a new mApp Solution or a new version of an existing mApp Solution for distribution when you are
ready to submit the mApp Solution to the mApp Exchange or distribute it directly to potential users.

When you prepare a version of a mApp Solution for distribution, it is scanned for errors and then saved as
a .mApp file so that it can be applied to CSM systems.

Good to Know:

• If the mApp Solution contains translations, you can define mApp Solution properties for each
culture. See Applying Cultures to mApps.

• If the mApp Solution contains encrypted Fields, encryption will be disabled and the Fields will be
converted to text in the distributable mApp file. If this occurs, you will be notified with a warning
message.

To prepare a mApp Solution for distribution:

1. Scan the mApp Solution before preparing it for distribution. This allows you to resolve any issues in
the mApp Solution, as well as in the underlying system from which the mApp Solution was created.

2. Open an existing mApp Solution.

3. From the mApp Editor menu bar, click File>Prepare mApp for distribution.

Tip: You can also prepare a mApp Solution for distribution by clicking Prepare mApp
Solution for distribution in the mApp Solutions section of the mApp Editor Task Pane.

If there are errors that need to be resolved, the mApp Solution Preparation Scan window opens.
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4. Resolve errors:
◦ Click Resolve All to resolve all items in the list at once.

◦ Click Resolve to resolve each selected item individually.

After all errors are resolved (or if there are no errors), the Final Preparation for mApp Solution
Distribution window opens.

5. Prepare the mApp Solution for distribution:

a. Enter a version number for the mApp Solution in the New Distribution Version field.

Note: The mApp Solution version must be in the form of "X.Y" where X is the major
version and Y is the minor version. The versions can be any number between 1 and
99.

b. Define a location for the mApp Solution Blueprint file (.mAppBP). This allows you to save the
mAppBP file so you can return to it later and make changes, if necessary. The path where the
file was last saved is displayed in the field.

◦ Provide the path and filename where the file will be saved.

◦ Click the Ellipses button  to browse to the location where the file will be saved.
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c. Define a location for the prepared mApp Solution file (.mApp). This is the file that will be
submitted to the mApp Exchange or distributed directly to potential users.

◦ Provide the path and filename where the file will be saved.

◦ Click the Ellipses button  to browse to the location where the file will be saved.

◦ Create Compressed File: Select this check box to save the distributable mApp Solution
file in a compressed binary format. Compressed mApp Solution files (designated with
a .mappz extension) cannot be edited.

d. View additional designers (only appears if the mApp Solution includes definitions that were
created or updated by other mApp Solution creators). Each entry includes the mApp Solution
creator’s personal and/or company name as well as the most recent creation date/time.

6. Select OK.

7. Distribute the mApp Solution.
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Using mApp Solutions
When working with mApp Solutions, Users can:

• View which mApp Solutions have already been installed in their CSM systems.

• Go to the mApp Exchange to view and download mApp Solutions created by others, or to submit
mApp Solutions.

• Apply mApp Solutions to their CSM systems (using the Apply mApp Wizard).
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Considerations for Applying mApp Solutions
Before applying any mApp® Solution, read the following recommendations to avoid conflicts or errors on
your system.

• As a precaution, back up your database prior to applying a mApp Solution.

• Never apply a mApp Solution to a database that already has an installation of the same mApp
Solution, including previous versions. To determine if the mApp Solution has already been applied to
your database, review the Items List in the documentation and compare it to your target system to
determine if those items are present. If they exist, do not proceed with applying the mApp Solution.
Otherwise, you may experience unexpected results.

• Apply your mApp Solution against a test system before applying it to your live system.

• If the mApp Solution includes definitions that have history records, a list of additional designers is
shown on the introductory page of theApply mApp Wizard. Each entry includes the mApp Solution
creator’s personal and/or company name as well as the most recent creation date/time.

• The merge actions displayed in the wizard were selected when the mApp Solution was created. If
you select a high level of interaction with the wizard (the Ask me about everything option), you can
change the merge actions. For example, if you do not want to overwrite or change a definition, you
can set the merge action to Don't Change in the wizard.

• The target objects/items displayed in the wizard are what the wizard detects in the target system as
exact (or close) matches to the mApp Solution definitions. An exact match means that the wizard
found a target object/item with the same record ID or exactly the same name as the definition in the
mApp Solution. If you select a high level of interaction with the wizard (the Ask me about everything
option), you can change the target objects/items.

• If you select a low level of interaction with the wizard, the wizard assumes you want to use the
merge actions selected when the mApp Solution was created and the target objects/items it detects
as exact matches in the target system. It only asks for input if an area requires clarification.

• The wizard asks you about objects and items in order of importance (determined by the mApp
Solution creator). Business Object Views are always asked about first, followed by Group Objects
(Group Leaders, and then Group Members), and then the remaining objects and items in order of
importance.

• After you complete the wizard, you can open a Blueprint to preview the changes the mApp Solution
will make to your system (recommended) or attempt to directly publish the changes. If you open a
Blueprint, you can then scan the Blueprint and view Blueprint changes before publishing it.

Related concepts
Apply a mApp Solution
Scan a Blueprint
View Blueprint Changes
Publish a Blueprint
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View Installed mApp Solutions
Use the View Installed mApp Solutions task in the CSM Administrator main window to view a list of mApp
Solutions that have been installed in your system.

The page is searchable.

To view installed mApp Solutions:

1. In the CSM Administrator main window, click the mApps category, and then click the View Installed
mApps task.

2. Click the name of the mApp Solution to navigate to a page containing overviews, instructions, and
specific contact information. Depending on the item selected, the page might also contain:

◦ Helpful links: The mApp Exchange, direct access to topics in the CSM web help, etc.

◦ Downloadable files: mApp Solution files, supporting files, documentation, etc.
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Go to the Cherwell Marketplace (formerly the mApp
Exchange)

Use the Go to the mApp Exchange task on the mApp Solutions page in CSM Administrator to navigate to
the Cherwell Marketplace, where you can view and download mApp Solutions created by others or submit
mApp Solutions that you created.

Note: In December 2019, the mApp Exchange moved to a new platform and is now called the
Cherwell Marketplace. Use the Go to the mApp Exchange task or open https://www.cherwell.com/
marketplace/ to access the Cherwell Marketplace.

Users must have a Cherwell SSO account to download mApp Solutions or submit their own mApp
Solutions on the Cherwell Marketplace. Go to https://zero.comaround.com/link/
c04350d8a9a147e840af08d771d31ba4/ for information on how to sign up for a Cherwell SSO account.

To go to the mApp Marketplace:

1. Select the mApps category in the CSM Administrator main window.

2. Select the Go to the mApp Exchange task.

3. Sign in to the Cherwell Marketplace to submit or download mApp Solutions.

Note: Go to https://zero.comaround.com/link/8e2d672b0f774dcc15a708d791b55673/ for
information on how to submit a mApp Solution to the Cherwell Marketplace.
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View mApp History
Use the View mApp History task on the mApp page in CSM Administrator to view a list of available history
records for all definitions within your CSM system that were modified by a mApp Solution.

Good to know:

• Viewing mApp Solution history requires security rights.

• Only definitions with history records are shown. Definitions only have history records if mApp
Solution creators used Designer IDs when creating the mApp Solutions that were applied to your
system.

To view mApp Solution history, in the CSM Administrator main window, click the mApps category,
and then click the View mApp History task.
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Apply a mApp Solution
The Apply mApp Wizard (accessed from within the mApp Editor) is a specialized tool that walks you
through the process of applying a mApp Solution to a CSM system.

Use the Apply mApp Wizard to select how to merge each definition into the target system.

When you apply a mApp Solution, you can define:

• Interaction Level: How much you want the wizard to decide automatically.

• Merge actions: How you want each Business Object (along with its associated Fields,
Relationships, Forms, Grids, and Form Arrangements) and CSM Item (including Security Groups
and Roles) to be merged into the target system.

• Target objects/items: Which existing items to overwrite in the target system. You can also select to
have a new item created for a mApp Solution definition.

To apply a mApp Solution to a system:

Note: The following procedure assumes a high level of interaction (Ask me about everything). The
pages you see in the wizard (and their order) might differ from the following procedure, as they
depend on what is included in the mApp Solution, the importance level of each object and item,
and the level of User interaction you select.

1. In the CSM Administrator main window, select the mApps category, and then select the Apply a
mApp task.

2. Select a mApp Solution to apply to the target system, and then select Open.

The Apply mApp Wizard opens, displaying the properties defined for the mApp Solution.

Tip: If available, select the More Information link to navigate to a website that contains
detailed information about the mApp Solution.

3. Select Yes to accept the terms of the license agreement, and then select Next.
4. Carefully review the security information that explains that the mApp Solution contains Security

Groups and/or Roles that may impact security rights in the target database, and then click Yes to
accept the terms.

5. On the Localization page:
◦ If you are applying a mApp Solution created in CSM 9.2.0 or later, review the cultures for

translations included in the mApp Solution. If Globalization is enabled for your system and you
have enabled the cultures listed for the mApp Solution, translated strings are shown to users
of the cultures included in the mApp Solution.
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◦ If you are applying a mApp Solution created before CSM 9.2.0, select the target culture for the
mApp Solution. You must perform this task even if Globalization is not enabled for your
system.

6. Select a level of user Interaction (how automatic the merge process should be):

Note: No matter which interaction level you select, you will have the option to see a
summary of all changes before anything is actually modified in the target system.

◦ Ask me about every decision: Allow the wizard ask how you want to apply every object and
item that is included in the mApp Solution.

◦ Make reasonable decisions, but ask me if you are unsure (default): Make the apply mApp
Solution process partially automated (you will be asked about any areas that require
clarification). If the wizard does not need to ask you anything, you will be directed to the
summary page.

◦ Don't ask me unless absolutely necessary: Make the apply mApp Solution process almost
fully automated (you will only be asked about areas that absolutely require your interaction,
such as Security Groups and Roles). If the wizard does not need to ask you anything, you will
be directed to the summary page.

7. Continue through the Wizard and define options for features and definitions included in the mApp
Solution.

Define Options for Features
This page only applies if the mApp Solution includes Features. There is a page for each Feature in the
mApp Solution.

Select the Enabled check box to apply a mApp Solution Feature with all of its associated definitions to the
target system. If you clear this check box, the Feature will not be applied to the target system (you will not
receive any further prompting about the Feature or any of its associated definitions). If the mApp Solution
creator included a Feature by default, this check box is automatically selected.

Define Options for Business Objects
This page only applies if the mApp Solution includes Business Objects. If it includes Group objects, you
will be asked about those first (Group Leaders, and then Group Members). If it includes a Group Member
without a Group Leader, you will be asked to select or create a Group Leader.

1. Select a merge action and target Business Object:
◦ Select [Business Object Name] Business Object (best match): If an exact Business Object

match is found in the target system, select this radio button to have the Business Object
definition in the mApp Solution imported into this object.

Tip: Click the information icon to view detailed information about the best match.

◦ Select a different existing object: If an exact match is not found, or to select a different
object in the target system, select this radio button to select an existing object to import the
mApp Solution object into.
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◦ Select from List: If objects with names similar to the mApp Solution object are found in
the target system, they are listed on the page. Select an object in the list.

◦ Select Other Object: Click this button to open a separate window containing a list of all
objects in the target system. Select an object from the list.

◦ Create a New Object: Select this radio button to have the mApp Solution create a new object
in the target system.

◦ Skip this Object: Select this radio button to skip importing this object in the target system.

Note: If you skip the object, related/dependent objects and associated definitions
(Relationships, Fields, Forms, etc.) will also be excluded from the import, and the
wizard will not ask you about them.

2. Select merge actions for the object's merge areas:
◦ Overwrite: Overwrites the definition in the target system.

◦ Don't Change: Leaves the definition in the target system unchanged.

3. Select merge actions and target items for the object's child items (Fields, indexes, and Relationships
associated with the object):

Note: This page does not apply if the mApp Solution is creating a new object, or if the entire
Business Object will be overwritten.

◦ Merge Actions: These are the merge actions the mApp Solution creator defined for each child
item in the object. To change the merge action for an item, select an option in the Merge
Action column's drop-downs:

◦ Overwrite: Overwrites the definition in the target system.

◦ Merge: Merges the Field's properties with the target Field's existing properties.

◦ Don't Change: Leaves the definition in the target system unchanged.

◦ Target item: If an exact match is found in the target system, it is listed in this column. To
change the target item, select an option in the Target column's drop-downs:

◦ Item with similar name: If the target system contains items with names similar to the
ones in the mApp Solution, they are listed in the drop-down. Select an item in the list.

◦ (Treat as new): Select this option to create a new item (must have a unique name).

◦ (More...): Select this option to open a separate window containing a list of all items of a
particular type (example: Fields) in the Business Object.

Note: If you select Treat as new (for this and any subsequent pages) and do not
define a unique name, or if a mApp Solution item is found to have the same
name as an item in the target system, the wizard will ask you to resolve naming
conflicts.

Define Options for Displayable Items
Select options for displayable items associated with the object (Forms, Grids, Form Arrangement, etc.).
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1. Select an option in the Merge Action column's drop-downs:
◦ Overwrite: Overwrites the definition with the same ID in the target system.

◦ (Treat as new): Creates a new item in the target system (must have a unique name).

◦ Don't Change: Leaves the definition in the target system unchanged.

Note: For Form Arrangements, you also have the option to Merge the mApp Solution
definition with the one in the target system. This means that the Tabs in the mApp
Solution Form Arrangement will be merged with the existing Tabs in the target Form
Arrangement, allowing you to add Tabs to the existing Form Arrangement without
entirely overwriting it. For more information, see Configure Merge Actions for Form
Arrangements and Tabs.

2. Select a merge action and target object for removal.

Note: This page only applies if the mApp Solution is removing a Business Object.

◦ Select [Business Object Name] Business Object (best match): If an exact Business Object
match is found in the target system, select this radio button to have it removed from the target
system.

Tip: Click the information icon to view detailed information about the best match.

◦ Select a different existing object: If an exact match is not found, or to use a different object
in the target system, select this radio button to select an object to remove from the target
system.

◦ Select from List: If objects with names similar to the mApp Solution object are found in
the target system, they are listed on the page. Select an object from the list.

◦ Select Other Object: Click this button to open a separate window containing a list of all
objects in the target system. Select an object from the list.

◦ Skip this Object: Click this radio button to skip removing this object from the target system.

Define Options for Security Groups and Roles
This page only applies if the mApp Solution includes Security Groups and Roles.

Important: Security Groups and/or Roles may impact security rights in the target database after
the mApp Solution is applied. Be sure to carefully review the merge actions and target items for
Security Groups and Roles when you apply the mApp Solution. To ensure that you understand the
implications of applying security changes included in the mApp Solution, we strongly advise you to
apply the mApp Solution to a test environment and verify the security changes before you commit
the mApp Solution to a production environment.

Select merge actions and target items for Security Groups and Roles included in the mApp Solution:

• Merge Action: To change the merge action for an item, select an option in the Merge Action
column's drop-down:
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◦ Overwrite: Overwrites the Security Group and/or Role in the target system.

◦ Don't Change: Leaves the Security Group and/or Role in the target system unchanged.

• Target item: If an exact match is found in the target system, it is listed in this column. To change the
target item, select an option in the Target Item's column drop-down:

◦ Item with similar name: If the target system contains items with names similar to the ones in
the mApp Solution, they are listed in the drop-down.

◦ (Treat as new): Select this option to create a new Security Group and/or Role (must have a
unique name).

◦ (More...): Select this option to open the CSM Item Manager and select another Security Group
and/or Role.

Define Options for CSM Items
Select merge actions and target items for CSM Items included in the mApp Solution.

• Merge Action: To change the merge action for an item, select an option in the Merge Action
column's drop-down:

◦ Overwrite: Overwrites the definition in the target system.

◦ Don't Change: Leaves the definition in the target system unchanged.

• Target item: If an exact match is found in the target system, it is listed in this column. To change the
target item, select an option in the Target Item's column drop-down:

◦ Item with similar name: If the target system contains items with names similar to the ones in
the mApp Solution, they are listed in the drop-down.

◦ (Treat as new): Select this option to create a new item (must have a unique name).

◦ (More...): Select this option to open the appropriate CSM Item Manager and select another
item.

Define Options for One-Step Actions
This page only applies if the mApp Solution includes One-Step Actions.

Select merge actions and target items for the One-Step Actions included in the mApp Solution.

• Merge Actions: These are the merge actions the mApp Solution creator defined for each One-Step
Action. To change the merge action for a One-Step Action, select an option in the Merge Action
column's drop-down:

◦ Overwrite: Overwrites the definition in the target system.

◦ Don't Change: Leaves the definition in the target system unchanged.

• Target item: If an exact match is found in the target system, it is listed in this column. To change the
target item, select an option in the Target Item column's drop-down:

◦ Item with similar name: If the target system contains items with names similar to the ones in
the mApp Solution, they are listed in the drop-down.

◦ (Treat as new): Select this option to create a new item (must have a unique name).
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◦ (More...): Select this option to open the One-Step Action Manager and select a different One-
Step Action.

Define Options for Miscellaneous Items
Select merge actions and target items for miscellaneous items included in the mApp Solution (example:
Dashboards, Stored Searches, Stored Values, external connections, etc.).

1. Merge Actions: These are the merge actions the mApp Solution creator defined for each item. To
change the merge action for an item, select an option fin the Merge Action column's drop-down:

◦ Overwrite: Overwrites the definition in the target system.

◦ Don't Change: Leaves the definition in the target system unchanged.

2. Target item: If an exact match is found in the target system, it is listed in this column. To change the
target item, select an option in the Target Item column's drop-down:

◦ Item with similar name: If the target system contains items with names similar to the ones in
the mApp Solution, they are listed in the drop-down.

◦ (Treat as new): Select this option to create a new item (must have a unique name).

◦ (More...): Select this option to open a separate window containing a list of all items of a
particular type.

Note: If this is a CSM Item, the (More...) option will open the appropriate CSM Item
Manager.

3. Provide a value for the Stored Value.

Note: This page only applies if the mApp Solution includes Stored Values that prompt Users
to provide values. If you do not specify a value, the default value for the Stored Value is
used.

4. Click Edit External Connection to open the External Connection Wizard and define settings for the
external connection.

Note: This page only applies if the mApp Solution includes external connections that prompt
Users to specify their own external connection settings.

Finalize the Wizard
To finalize the Wizard:

1. Review the Summary page, and then click the Save to File button to open the Choose Export File
window, and then provide a location, file name, and output format (.csv, .html, .htm, .txt, .rtf, .xml) for
exporting the summary of mApp Solution definitions that will be applied to the target system.
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2. Define final options (what to do after the mApp Solution is applied to the target system):
◦ (Recommended) Open a Blueprint so I can preview the changes: Select this radio button to

open a Blueprint that allows you to see the changes the mApp Solution will make to the target
system.

Important: If you select this option, you will then need to publish the Blueprint to
commit the changes to the target system.

◦ Attempt to publish the changes directly: Select this radio button to immediately publish the
Blueprint of mApp Solution changes directly to the target system without previewing it first.

3. Select Finish.
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The merge process runs and generates a Blueprint. Depending on the option selected previously,
the Blueprint either:

◦ Opens and allows you to view the mApp Solution changes.

◦ Immediately attempts to publish to the target system.

Related concepts
Considerations for Applying mApp Solutions
About Globalization
Related tasks
Applying Cultures to mApps
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Configuring mApp Solutions
Complete the following procedures to configure mApp Solutions. Configuration procedures are completed
in CSM Administrator.

To configure mApp Solutions:

1. Configure mApp Solution security rights: Configure who can access mApp Solution functionality and
data.

2. Configure merge actions for system definitions: Configure how definitions are merged into a target
system by selecting merge actions from the various properties windows (example: Business Object
Properties window, Relationship Properties window, etc.). The properties windows have more
detailed mApp Solution options available outside of the Add Business Object to mApp Wizard.

3. View referenced definitions in a mApp Solution: From the various properties windows, view all of the
system definitions throughout CSM being used by a selected mApp Solution definition (Business
Object, Relationship, Form, Grid, Form Arrangement, and/or CSM Item). Add definitions from the
References window to ensure that all necessary definitions are included in a mApp Solution.

4. Configure mApp Solution conditions: Configure conditions that control when definitions are imported
into a target system when a mApp Solution is applied.

5. Prepare mApp Solution for distribution: Creates a mApp Solution file that can be distributed or
uploaded to the mApp Exchange.
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Configure Merge Actions for Business Object
Definitions

Merge actions determine how the system definitions in a mApp Solution are merged into a target system
when a mApp Solution is applied. Use the Add Business Object to Wizard as a convenient method of
defining merge actions for Business Objects and their associated FIelds, Relationships, Forms, Grids, and
Form Arrangements. The definitions added to a mApp Solution using the wizard are imported into a target
system when the mApp Solution is applied, and the merge actions you select are applied to the definitions
in the target system if they already exist. You can select from the following basic merge actions:

• Overwrite All: Overwrites all of the existing definitions of a particular type (example: All Fields) in the
target system, or adds them if they are not already there.

• Do Not Overwrite Any: Leaves all of the definitions of a particular type (example: All Fields) in the
target system unchanged (does not overwrite or add the definitions).

• Overwrite some (the Let me choose option in the wizard): Overwrites the selected definitions of a
particular type (example: Only the Fields you select).

However, you have some additional options available when you configure merge actions using the
various properties windows (example: Business Object Properties window, Relationship Properties
window, etc.) within the mApp Editor:

• Import/Don't Import If Not Present: Imports or does not import the definition into the target system if
it does not already exist.

• Remove: Removes the definition from the target system.

• For Reference Only: Includes the definition in the mApp Solution for informational purposes only
(the definition is not imported into the target system).

In addition, when you configure merge actions using the various properties windows, certain definitions
that are imported into a target system have Merge as an available action. Merge means that you can
select separate merge actions for individual areas of these system definitions. This is useful if the target
system already has a version of the Business Objects included in a mApp Solution and you only want to
import/overwrite certain areas. Merge is available for the following definitions:

• Business Objects

• Fields

• Relationships

• Form Arrangements

• Business Object Actions

To configure merge actions for Business Object definitions:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Configure merge actions for Business Objects.

3. Configure merge actions for Fields.
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4. Configure merge actions for Relationships.

5. Configure merge actions for Forms.

6. Configure merge actions for Grids.

7. Configure merge actions for Form Arrangements.

8. Configure merge actions for Business Object Actions.

9. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Configure Merge Actions for Business Objects
Use the Business Object Properties window to configure the following:

• General properties: Whether to include the Business Object in the mApp Solution, and its
importance in the mApp Solution.

• Options for merging the Business Object into the target system when the mApp Solution is applied:
◦ Import to target system: Imports the Business Object definition into the target system. You can

select merge actions based on whether the Business Object definition already exists in the
target system.

◦ Remove from Target System: Removes the Business Object definition from the target system.

◦ For Reference Only: Includes the Business Object definition in the mApp Solution for
informational purposes only (it is not merged into the target system when the mApp Solution is
applied).

◦ Import/remove based on condition: Imports or removes the Business Object definition based
on configured mApp Solution conditions.

• Merge actions for individual Business Object properties.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp Solution check box is cleared,
then you cannot configure separate merge actions for individual properties or areas.

• When a Business Object is included in a mApp Solution using the Business Object Properties
window, its associated Relationships are not automatically added. Be sure to add all necessary
Relationships. Click the References button (on the mApp page in the Business Object Properties
window) to view/add the other definitions being used by a Business Object.

To configure merge actions for Business Objects:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Business Object in the Object tree,
and then click the Edit Business Object task in the Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.
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b. Click the Bus Ob Properties button.

3. Click the mApps page.

4. Configure mApp Solution properties and merge actions for the Business Object:
a. Define general mApp Solution properties for the Business Object:

◦ Include in mApp Solution: Select this check box to include the Business Object in the
mApp Solution. Clear this check box to leave the existing definition in the target system
unchanged (the Business Object definition is not imported into the target system when
the mApp Solution is applied).

Note: This check box is automatically selected if you added the Business Object using
the Add Business Object to mApp Wizard.

◦ Importance: Select the importance of the Business Object to the mApp Solution.
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Note: Importance is automatically selected based on the option chosen in the Add
Business Object to mApp Wizard. However, you can change it here if necessary.
Changing the importance impacts the order in which the Apply mApp Wizard asks about
Business Objects.

◦ High Importance: Select this radio button if the selected Business Object is one of
the main Business Objects in the mApp Solution.

◦ Medium Importance: Select this radio button if the selected Business Object is a
supporting object for the mApp Solution.

◦ Low Importance: Select this radio button if the selected Business Object is not
critical for the mApp Solution.

◦ References: Click this button to open the References window and view all of the other
definitions being used by the Business Object.

b. Define options (merge actions) for how the definition will be merged into a target system:

Note: These options are only available if Include in mApp Solution is selected.

◦ Import to target system: Select this radio button to import the definition into a target
system. Then, select a merge action based on whether or not the definition is already
present in the target system:

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

◦ Merge: Select this option to define separate merge actions for each individual area
of a definition.

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the definition from a
target system.

◦ For Reference Only: Select this radio button to include the definition in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).
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◦ Import/Remove Based on Condition: Select this check box to import or remove the

definition based on a condition. Then, click the Ellipses button  to open the mApp
Solution Conditions window and define mApp Solution conditions.

5. Configure separate merge actions for individual Business Object Property merge areas:
a. In the Options area of the Business Object Properties window, click the Import to Target

System check box.

b. Select Merge as the merge action for the Business Object (in the If Already Present drop-
down).

c. Define default behaviors for the Business Object's Fields and indexes. This is how Fields and
indexes will be merged unless specified otherwise. In the drop-downs, select one of the
following options:

◦ Overwrite: Select this option to have the Business Object Fields and/or indexes
overwritten in the target system when the mApp Solution is applied. You can then go to
particular Fields or indexes and exclude the ones you do not want in the mApp Solution.
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◦ Do Not Overwrite (Default): Select this option to leave the Business Object Fields and/or
indexes unchanged in the target system when the mApp Solution is applied. You can
then go to particular Fields or indexes and explicitly select which ones to include in the
mApp Solution.

Note: Because Indexes do not have IDs, they will be added to the target system if an
exact name match is not found in the system when the mApp Solution is applied.

d. Define individual merge actions for each merge area:

In the Merge Areas Grid: For each merge area, select a merge action in the Merge Action
column drop-downs:

◦ Overwrite: Select this option to have the merge area overwritten in the target system
when the mApp Solution is applied.

◦ Do Not Overwrite: Select this option to leave the merge area unchanged in the target
system when the mApp Solution is applied.

Tip: Click the Uncheck All button  to set all merge areas to Do Not Overwrite. Click

the Select All button  to set all merge areas to Overwrite.

On the remaining pages of the properties window: Click the mApp button  next to each of
the merge areas to define merge actions for individual properties:

i. Define merge actions for general Business Object properties.

ii. Define merge actions for Business Object process and procedure help.

iii. Define merge actions for Business Object lifecycle properties.

iv. Define merge actions for Business Object search results properties.

v. Define merge actions for Business Object Attachment options.

vi. Define merge actions for Business Object database options.

vii. Define merge actions for Business Object history options.

viii. Define merge actions for Business Object Record Locking settings (only if record locking
is enabled for your system).

ix. Define merge actions for Business Object advanced properties.

e. Select OK.

The header in the Business Object Editor shows the selections made in the Business Object
Properties window. For example, if you select High Importance and Merge, the appropriate
indicators will be displayed in the header:
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. These indicators
are also displayed in the Task Section of the Object Manager.

The mApp Solution Action column in the list of Fields shows the selections made in the
Defaults section of the Business Object Properties window (Default Behavior for Fields drop-
down).

6. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for General Business Object
Properties

Use the General page in the Business Object Properties window to define whether or not to overwrite the
following general properties for a Business Object:

• Name and description.

• General options: Public ID, Business Object type, tracking options, menus and shortcut keys, and
various options for defining a Business Object's behavior and where it appears in CSM.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Solution Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp Solutions
page). If the Business Object is set to any other option, or if the Include in mApp Solution check box
is cleared, then you cannot configure separate merge actions for individual properties or areas.

• For more information about defining general Business Object properties, refer to Define General
Properties for a Business Object.

To define merge actions for general Business Object properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Solution Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the General page.
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5. Click the mApp button  next to each property merge area, and then select a merge action:

For general Business Object information (name and description):

◦ Do Not Overwrite Name and Description: Select this option to leave the Business Object's
name and description unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Name and Description: Select this option to overwrite the Business Object's name
and description in the target system when the mApp Solution is applied.

For general Business Object options:

◦ Do Not Overwrite General Options: Select this option to leave the Business Object's general
options unchanged in the target system when the mApp Solution is applied.

◦ Overwrite General Options: Select this option to overwrite the Business Object's general
options in the target system when the mApp Solution is applied.
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6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object Process
and Procedure Help Properties

Use the Process and Procedure Help page in the Business Object Properties window to define whether or
not to overwrite process and procedure help properties for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp Solutions
page). If the Business Object is set to any other option, or if the Include in mApp Solution check box
is cleared, then you cannot configure separate merge actions for individual properties or areas.

• If you do not see the Process and Procedure Help page, close the mApp Solution (after saving) and
go to Settings>Edit System Settings. Click the Help page, and then select Show Process and
Terminology Help. For more information about enabling process and procedure help, refer to
Configure Global Help Settings.

• For more information about defining process and procedure help properties for a Business Object,
refer to Define Process and Procedure Help Properties for a Business Object.

To define merge actions for Business Object process and procedure help properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp Solution Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

In the If Already Present drop-down, select Merge as the merge action for the Business
Object.
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4. Click the Process and Procedure Help page.

5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Process and Procedure Options: Select this option to leave the Business

Object's process and procedure help properties unchanged in the target system when the
mApp Solution is applied.

◦ Overwrite Process and Procedure Options: Select this option to overwrite the Business
Object's process and procedure help properties in the target system when the mApp Solution
is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object
Lifecycle Properties

Use the Lifecycle page in the Business Object Properties window to define whether or not to overwrite the
lifecycle properties for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining lifecycle properties for a Business Object, refer to Define
Lifecycle Properties for a Business Object.

To define merge actions for Business Object lifecycle properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Lifecycle page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Lifecycle Options: Select this option to leave the Business Object's lifecycle

properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Lifecycle Options: Select this option to overwrite the Business Object's lifecycle
properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object Search
Results Properties

Use the Search Results page in the Business Object Properties window to define whether or not to
overwrite Search Result options for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining Search Results properties for a Business Object, refer to Define
Search Results Properties for a Business Object

To define merge actions for Business Object Search Results properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp Solution Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Search Results page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Search Result Options: Select this option to leave the Business Object's

Search Result properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Search Result Options: Select this option to overwrite the Business Object's Search
Result properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object
Attachment Properties

Use the Attachments page in the Business Object Properties window to define whether or not to overwrite
Attachment options for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining Attachment properties for a Business Object, refer to Define
Attachments Properties for a Business Object.

To define merge actions for Attachment properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Attachments page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Attachment Options: Select this option to leave the Business Object's

Attachment options unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Attachment Options: Select this option to overwrite the Business Object's
Attachment options in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object
Database Properties

Use the Database page in the Business Object Properties window to define whether or not to overwrite
database options and individual indexes for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining database properties for a Business Object, refer to Define
Database Properties for a Business Object.

To define merge actions for Business Object database properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Database page.
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5. Click the mApp button  next to each property merge area, and then select a merge action:

For database options:

◦ Do Not Overwrite Database Options: Select this option to leave the Business Object's
database options unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Database Options: Select this option to overwrite the Business Object's database
options in the target system when the mApp Solution is applied.

For an index:

◦ Do Not Overwrite Index: Select this option to leave an index unchanged in the target system
when the mApp Solution is applied.

◦ Overwrite Index: Select this option to overwrite an index in the target system when the mApp
Solution is applied.
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6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Business Object History
Properties

Use the History page in the Business Object Properties window to define whether or not to overwrite the
history tracking options for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining history properties for a Business Object, refer to Define History
Properties for a Business Object.

To define history properties for a Business Object:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the History page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite History Options: Select this option to leave the Business Object's history

properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite History Options: Select this option to overwrite the Business Object's history
properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
(File>Save mApp Solution to Disk) to continue making other changes.
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Define Merge Actions for Business Object Record
Locking Settings

Use the Record Locking page in the Business Object Properties window to define whether or not to
overwrite record locking settings for a Business Object.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Solution Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• For more information about defining Record Locking settings for a Business Object, refer to Define
Record Locking Settings for a Business Object.

To define merge actions for Record Locking settings:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.

c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Record Locking page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Record Locking Options: Select this option to leave the Business Object's

Record Locking settings unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Record Locking Options: Select this option to overwrite the Business Object's
Record Locking settings in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Advanced Business
Object Properties

Use the Advanced page in the Business Object Properties window (accessed from within the mApp
Solution Editor) to define whether or not to overwrite the following advanced properties:

• Advanced Options: Whether the Business Object is read-only, cacheable, or has an associated
color.

• General Attributes.

• Database Attributes.

Note: The Business Object Properties window is available in the Business Object Editor
(accessed from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object properties and areas
if the Business Object is set to Merge in the Business Object Properties window (mApp page). If the
Business Object is set to any other option, or if the Include in mApp check box is cleared, then you
cannot configure separate merge actions for individual properties or areas.

• Only advanced Users should define attributes. For more information about attributes, please contact
Cherwell Support.

• For more information about defining advanced properties for a Business Object, refer to Define
Advanced Properties for a Business Object.

To define merge actions for advanced Business Object properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. Open the Business Object Properties window for the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open
the Business Object Editor.

b. Click the Bus Ob Properties button.

3. Set the Business Object to Merge:
a. Click the mApps page, and then select the Include in mApp check box.

b. In the Options area, select the Import to Target System radio button.
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c. In the If Already Present drop-down, select Merge as the merge action for the Business
Object.

4. Click the Advanced page.

5. Click the mApp button  next to each property merge area, and then select a merge action:

For advanced options:

◦ Do not overwrite advanced options: Select this option to leave the advanced options
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite advanced options: Select this option to overwrite the advanced options in the target
system when the mApp Solution is applied.

For general attributes:
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◦ Do not overwrite general attributes: Select this option to leave the general attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite general attributes: Select this option to overwrite the general attributes in the target
system when the mApp Solution is applied.

For database attributes:

◦ Do not overwrite database attributes: Select this option to leave the database attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite database attributes: Select this option to overwrite the database attributes in the
target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Configure Merge Actions for Individual Fields
Use the mApp Action context menu in the Business Object Editor within a mApp Solution to configure
merge actions for individual Business Object Fields. You can also use the Field Properties window to
configure merge actions for individual Fields, as well as for Field properties.

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is cleared, then you
cannot configure separate merge actions for individual Field properties.

To configure merge actions for individual Business Object Fields:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Business Object task in the Structure area.

Tip: You can also click the Business Object button  on the mApp Editor toolbar to open the
Business Object Editor.

The Business Object Editor opens, displaying the list of Fields with a mApp Solution Action column
to show which Fields you selected to overwrite and which ones you selected not to overwrite (blank
in the mApp Solution Action column) in the Add Business Object to mApp Wizard. If you set the
Business Object to Merge in the Business Object Properties window, then the selections made in
the Defaults section (Default Behavior for Fields drop-down) are also reflected in the mApp Solution
Action column.

3. Configure separate merge actions for individual Fields (using the mApp Solution Action context
menu):

a. Select a Field, right-click in the mApp Action column, and then hover over mApp Action to
open a context menu.
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Note: The mApp Action context menu is only available if the Business Object was set to
Merge.

b. Select a merge action for the Field from the context menu:
◦ Make no changes to Field: Select this option to leave the existing definition in the target

system unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

◦ Import Field if not already there: Select this option to import the Field if it does not
already exist in the target system. If it already exists, the Field will not be imported when
the mApp Solution is applied.

◦ Overwrite Field: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Conditionally merge Field properties: This option is grayed out on the context menu
because merging a Field requires selecting separate merge actions for individual Field
property merge areas. This is done using the Field Properties window (see step 5).

◦ Remove Field from target system: Select this option to have the Field removed from the
target system.

◦ Field is reference-only: Select this option to include the Field in the mApp Solution for
informational purposes only (the definition is not imported into the target system when
the mApp Solution is applied). You should rarely (if ever) need to do this manually, as the
system automatically adds definitions as necessary for reference only.

The selected action shows in the mApp Solution status column (blank if you selected Make no
changes to Field).

4. Configure separate merge actions for individual Fields (using the Field Properties window):
a. Select a Field in the Business Object Editor, and then click the Field Properties button.

b. Click the mApps page.
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c. Define general mApp Solution properties for the Field:
◦ Include in mApp Solution: Select this check box to include the Field in the mApp

Solution. Clear this check box to leave the existing definition in the target system
unchanged (the Field is not imported into the target system when the mApp Solution is
applied).

Note: This check box is automatically selected if some or all of the Fields were set to
overwrite when the Business Object was added to the mApp Solution (using the Add
Business Object to mApp Wizard), or if you selected anything besides Make no changes
to Field in the mApp Action context menu.

◦ References: Click this button to open the References window and view all of the other
definitions being used by the Field.

d. Define options (merge actions) for how the definition will be merged into a target system:

Note: These options are only available if Include in mApp is selected.
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◦ Import to target system: Select this radio button to import the definition into a target
system. Then, select a merge action based on whether or not the definition is already
present in the target system:

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

◦ Merge: Select this option to define separate merge actions for each individual area
of a definition.

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the definition from a
target system.

◦ For Reference Only: Select this radio button to include the definition in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).

◦ Import/Remove Based on Condition: Select this check box to import or remove the

definition based on a condition. Then, click the Ellipses button  to open the mApp
Solution Conditions window and define mApp Solution conditions.

Note: The action you selected from the mApp Action context menu is automatically
selected.

5. Configure separate merge actions for individual Field property merge areas:
a. In the Options area of the Field Properties window, click the Import to Target System radio

button.

b. Select Merge as the merge action for the Field (from the If Already Present drop-down).

596

CSM 10.0.0 Administration

CSM 10.0.0 Administration



c. Define individual merge actions for each merge area:

In the Merge Areas Grid: For each merge area, select a merge action in the Merge Action
column drop-downs:

◦ Overwrite: Select this option to have the merge area overwritten in the target system
when the mApp Solution is applied.

◦ Do Not Overwrite: Select this option to leave the merge area unchanged in the target
system when the mApp Solution is applied.

Tip: Click the Uncheck All button  to set all merge areas to Do Not Overwrite. Click

the Select All button  to set all merge areas to Overwrite.

On the remaining pages of the properties window: Click the mApp button  next to each of
the merge areas to define merge actions for individual properties:

i. Define merge actions for general Field properties.
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ii. Define merge actions for Field process and procedure help properties.

iii. Define merge actions for Field behavior properties.

iv. Define merge actions for Field validation/auto-population properties.

v. Define merge actions for Field advanced properties.

d. Select OK.

The selections you made in the Options area are reflected in the Business Object Editor Grid.

6. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for General Field Properties
Use the General page in the Field Properties window to define whether or not to overwrite the following
general property merge areas for a Field:

• Name and description.

• Field type (Date/Time, Logical, Number, or Text) and Field properties based on type (size, format,
decimal places, etc.).

Note: The Field Properties window is available in the Business Object Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is cleared, then you
cannot configure separate merge actions for individual Field properties.

• For more information about defining general Field properties, refer to Define General Properties for
a Field.

To define merge actions for general Field properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp wizard.

2. Open the Field Properties window for a Field in the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens, displaying the list of Fields with a mApp Action column to
show the merge actions selected for the Fields in the Add Business Object to mApp wizard
(either Overwrite or Do Not Overwrite. The mApp Action column is blank for Fields set to Do
Not Overwrite). If you set the Business Object to Merge in the Business Object Properties
window (mApp page), then the selections made in the Defaults section (Default Behavior for
Fields drop-down menu) are also reflected in the mApp Action column.

Tip: You can also click the Edit Business Object button  on the mApp Editor toolbar to
open the Business Object Editor.

b. Click a Field, and then click the Field Properties button.

3. Set the individual Field to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the Field.
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4. Click the General page.

5. Click the mApp button  next to each property merge area to open a drop-down of merge
actions.

6. Select a merge action for general Field information (name and description):
◦ Do Not Overwrite Name and Description: Select this option to leave the Field's name and

description unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Name and Description: Select this option to overwrite the Field's name and
description in the target system when the mApp Solution is applied.

7. Select a merge action for general Field properties (merge actions vary based on Field type):
◦ For all Field types:

◦ Overwrite Field Type: Select this option to have the Field type (Date/Time, Logical,
Number, or Text) overwritten in the target system when the mApp Solution is applied.

◦ Overwrite Track Changes to Field: Select this option to have the Field's change tracking
options overwritten in the target system when the mApp Solution is applied.
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◦ For date/time Fields, select from the following additional options:
◦ Overwrite Date Format: Select this option to have the date format overwritten in the

target system when the mApp Solution is applied. This overwrites the general properties
for a date/time Field (whether it holds date and time, date only, time only, or a timestamp
and whether it is adjusted based on timezones).

◦ For number Fields, select from the following additional options:
◦ Overwrite Field Size:

◦ Do not change size of target Field: Select this option to leave the Field size
unchanged in the target system when the mApp Solution is applied.

◦ Make target Field exactly <n> digits: Select this option to overwrite the Field size in
the target system to be the exact size defined for the Field in the mApp Solution
(the exact number of whole digits and decimal digits specified for the Field).

◦ If target Field is less than <n> digits, make it <n> digits: Select this option to
overwrite the Field size in the target system if it is smaller than the size defined for
the Field in the mApp Solution (the number of whole digits and decimal digits
specified for the Field).

◦ Overwrite Negative Number Setting: Select this option to overwrite the negative number
setting in the target system when the mApp Solution is applied. This setting defines
whether negative numbers are allowed in the Field.

◦ Overwrite Currency Settings: Select this option to overwrite the currency settings in the
target system when the mApp Solution is applied. These settings define whether the
Field holds currency values and which currency symbol is used.

◦ For text Fields (either plain text or Rich Text), select from the following additional
options:

◦ Overwrite Plain Text/Rich Text Setting: Select this option to overwrite the plain text/Rich
Text setting in the target system when the mApp Solution is applied. This setting defines
whether the Field is plain text (does not contain any special formatting, images, etc.) or
Rich Text (can contain special formatting, images, etc.).

◦ Overwrite Spell-Check Setting: Select this option to overwrite the spell-check setting in
the target system when the mApp Solution is applied. This setting defines whether the
system checks for spelling errors in the Field's content.

◦ Overwrite Full-Text Search Option: Select this option to overwrite the Full-Text Search
setting in the target system when the mApp Solution is applied. This setting defines
whether the Field is indexed for Full-Text Search (used by CSM Quick Search and
Knowledge Search).

◦ Overwrite Holds Selection: Select this option to overwrite the Field's hold property in the
target system when the mApp Solution is applied. The hold property identifies the type of
data contained in the Field (example: A record ownership "Holds" property on an Owned
By Field identifies the name in the Field as a record owner).

◦ For plain text Fields, select from the following additional options:
◦ Overwrite Field Size:

◦ Do not change size of target Field: Select this option to leave the Field size
unchanged in the target system when the mApp Solution is applied.
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◦ Make target Field exactly <defined size>: Select this option to overwrite the Field
size in the target system with the Field size defined in the mApp Solution. The
defined size can be an exact length (the specified number of characters), the
maximum allowed size, or the maximum searchable size.

◦ (If an exact length is defined) If target Field is less than <n> characters, make it
<n> characters: Select this option to overwrite the Field size in the target system if
it is smaller than the Field length defined in the mApp Solution (the number of
characters specified for the Field). When the mApp Solution is applied, the target
Field size will be overwritten with the Field length defined in the mApp Solution (the
exact number of characters).

◦ (If specific length is defined) If target Field is less than <n> or max length, make it
<n> characters: Select this option to overwrite the Field size in the target system if
it is smaller than the defined length or the maximum allowed size for the Field.
When the mApp Solution is applied, the target Field size will be overwritten with the
Field length defined in the mApp Solution (the exact number of characters).

◦ (If Max Allowed or Max Searchable is defined) If target Field is less than maximum
size/maximum searchable size, make it maximum size/maximum searchable size
(whichever is selected for the Field in the mApp Solution): Select this option to
overwrite the Field size in the target system if it is smaller than the maximum
allowed size/maximum searchable size for the Field. When the mApp Solution is
applied, the target Field size will be overwritten with the Field size defined in the
mApp Solution (either maximum allowed or maximum searchable).

◦ (If Max Searchable is defined) If target Field is less than maximum searchable size
or is maximum size, make it maximum searchable size: Select this option to
overwrite the Field size in the target system if it is smaller than the maximum
searchable size, or if it is the maximum allowed size for the Field. When the mApp
Solution is applied, the target Field size will be overwritten to be the maximum
searchable size.

◦ Overwrite multiple line setting: Select this option to overwrite the multiple line setting in
the target system when the mApp Solution is applied. This setting defines whether the
Field can contain two or more lines of text.

◦ Overwrite Format: Select this option to overwrite the Field's Format. Plain text Fields can
have specified Formats to enforce how characters and digits are displayed in the Field.

◦ For Rich Text Fields, select from the following additional options:

Note: For more information about Rich Text options, refer to Enable Rich Text on Business
Object Fields.

◦ Overwrite Rich Text Field options:
◦ Overwrite form image display: Select this option to overwrite how embedded

images are displayed in the Field. When the mApp Solution is applied, the form
image display setting for the target Field will be overwritten with the setting
selected in the mApp Solution (from the Form Images Are Displayed As drop-
down).

◦ Overwrite zoom image display: Select this option to overwrite how embedded
images are displayed in the Rich Text Zoom window for the Field. When the mApp
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Solution is applied, the zoomed image display setting for the target Field will be
overwritten with the setting selected in the mApp Solution (from the Zoomed
Images Are Displayed As drop-down).

◦ Overwrite image format: Select this option to overwrite the default for how
embedded images are displayed in the Field. When the mApp Solution is applied,
the image format for the target Field will be overwritten with the format selected in
the mApp Solution (from the Image Format drop-down).

◦ Overwrite maximum size per image setting: Select this option to overwrite the
setting for the maximum size of a single image embedded into the Field. When the
mApp Solution is applied, the maximum size setting for the target Field will be
overwritten with the format selected in the mApp Solution (whether the global
setting is overridden with a different maximum size).

◦ Overwrite total size for images setting: Select this option to overwrite the setting for
the maximum size of all images embedded into the Field. When the mApp Solution
is applied, the maximum size setting for the target Field will be overwritten with the
format selected in the mApp Solution (whether the global setting is overridden with
a different maximum size).

◦ Overwrite allow User to override image display mode: Select this option to
overwrite the setting that allows Users to override the image display mode for the
Field. When the mApp Solution is applied, the setting for the target Field will be
overwritten with the selection in the mApp Solution (whether Allow User to Override
Image Display Mode is checked).

◦ Overwrite custom default font setting: Select this check box to overwrite the custom
default font setting for the Field. When the mApp Solution is applied, the custom
default font for the target Field will be overwritten with the custom default font
defined for the Field in the mApp Solution.

8. Select OK.

9. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
(File>Save mApp Solution to Disk) to continue making other changes.
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Define Merge Actions for Field Process and
Procedure Help Properties

Use the Process and Procedure Help page in the Field Properties window to define whether or not to
overwrite process and procedure help options.

Note: The Field Properties window is available in the Business Object Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is cleared, then you
cannot configure separate merge actions for individual Field properties.

• If you do not see the Process and Procedure Help page, close the mApp Solution (after saving) and
go to Settings>Edit System Settings. Click the Help page, and then check Show Process and
Terminology Help. Refer to Configure Global Help Settings for more information.

• For more information about defining process and procedure help properties, refer to Define Process
and Procedure Help Properties for a Field.

To define merge actions for Field process and procedure help properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp wizard.

2. Open the Field Properties window for a Field in the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens, displaying the list of Fields with a mApp Action column to
show the merge actions selected for the Fields in the Add Business Object to mApp wizard
(either Overwrite or Do Not Overwrite. The mApp Action column is blank for Fields set to Do
Not Overwrite). If you set the Business Object to Merge in the Business Object Properties
window (mApp Solutions page), then the selections made in the Defaults section (Default
Behavior for Fields drop-down menu) are also reflected in the mApp Action column.

Tip: You can also click the Edit Business Object button  on the mApp Editor toolbar to
open the Business Object Editor.

b. Click a Field, and then click the Field Properties button.

3. Set the individual Field to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.
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c. From the If Already Present drop-down menu, select Merge as the merge action for the Field.

4. Click the Process and Procedure Help page.

5. Click the mApp Solution button  , and then select a merge action:
◦ Do Not Overwrite Process and Procedure Options: Select this option to leave the Field's

process and procedure help properties unchanged in the target system when the mApp
Solution is applied.

◦ Overwrite Process and Procedure Options: Select this option to overwrite the Field's process
and procedure help properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Detailed Field Properties
Use the Properties page in the Field Properties window to define whether or not to overwrite the following
property merge areas:

• Whether the Field is required.

• Whether the Field is read-only.

• Values: Default and calculated values, as well as values to set before a Business Object is saved.

• Options based on lifecycle state: Behaviors and values based on the Business Object's lifecycle
state (only applicable if the Business Object has defined lifecycle states).

Note: The Field Properties window is available in the Business Object Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
Solutions page). If the Business Object is set to any other option, or if Include in mApp Solution is
cleared, then you cannot configure separate merge actions for individual Field properties.

• For more information about behavior properties, refer to Define Behavior Properties for a Field.

To define merge actions for Field behavior properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp wizard.

2. Open the Field Properties window for a Field in the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens, displaying the list of Fields with a mApp Action column to
show the merge actions selected for the Fields in the Add Business Object to mApp wizard
(either Overwrite or Do Not Overwrite. The mApp Solution Action column is blank for Fields set
to Do Not Overwrite). If you set the Business Object to Merge in the Business Object
Properties window (mApp page), then the selections made in the Defaults section (Default
Behavior for Fields drop-down menu) are also reflected in the mApp Action column.

Tip: You can also click the Edit Business Object button  on the mApp Editor toolbar to
open the Business Object Editor.

b. Click a Field, and then click the Field Properties button.

3. Set the individual Field to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.
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c. From the If Already Present drop-down menu, select Merge as the merge action for the Field.

4. Click the Properties page.

5. Click the mApp button  next to each property merge area, and then select a merge action:
◦ Do Not Overwrite Rule: Select this option to leave the specific property unchanged in the

target system when the mApp Solution is applied.

◦ Overwrite Rule: Select this option to overwrite the specific property in the target system when
the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Field Validation/Auto-
Population Properties

Use the Validation/Auto-Population page in the Field Properties window to define whether or not to
overwrite the Field's validation and auto-population properties.

Note: The Field Properties window is available in the Business Object Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is cleared, then you
cannot configure separate merge actions for individual Field properties.

• For more information about validation/auto-population properties, refer to Define Validation/Auto-
Population Properties for a Field.

To define merge actions for Field validation/auto-population properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Solution wizard.

2. Open the Field Properties window for a Field in the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens, displaying the list of Fields with a mApp Action column to
show the merge actions selected for the Fields in the Add Business Object to mApp wizard
(either Overwrite or Do Not Overwrite. The mApp Action column is blank for Fields set to Do
Not Overwrite). If you set the Business Object to Merge in the Business Object Properties
window (mApp page), then the selections made in the Defaults section (Default Behavior for
Fields drop-down menu) are also reflected in the mApp Action column.

Tip: You can also click the Edit Business Object button  on the mApp Editor toolbar to
open the Business Object Editor.

b. Click a Field, and then click the Field Properties button.

3. Set the individual Field to Merge:
a. Click the mApp Solutions page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

4. From the If Already Present drop-down menu, select Merge as the merge action for the Field.

5. Click the Validation/Auto-Populate page.
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6. Click the mApp button  next to each property merge area, and then select a merge action:

For validation properties:

◦ Do Not Overwrite the Validation Rule: Select this option to leave the Field's validation
properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite the Validation Rule: Select this option to overwrite the Field's validation properties in
the target system when the mApp Solution is applied.

For Auto-population properties:

◦ Do Not Overwrite the Auto-Populate Rule: Select this option to leave the Field's auto-
population properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite the Auto-Populate Rule: Select this option to overwrite the Field's auto-population
properties in the target system when the mApp Solution is applied.
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7. Select OK.

8. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Field Advanced
Properties

Use the Advanced page in the Field Properties window to define whether or not to overwrite the following
merge areas:

• Advanced Options: Whether the Business Object is read-only, cacheable, or has an associated
color.

• General Attributes.

• Database Attributes.

Note: The Field Properties window is available in the Business Object Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Business Object Fields and Field
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is cleared, then you
cannot configure separate merge actions for individual Field properties.

• For more information about defining advanced Field properties, refer to Define Advanced Properties
for a Field.

To configure merge actions for Field advanced properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp wizard.

2. Open the Field Properties window for a Field in the Business Object you just added to the mApp
Solution:

a. In the Object Manager within the mApp Editor, click the Edit Business Object task in the
Structure area.

The Business Object Editor opens, displaying the list of Fields with a mApp Action column to
show the merge actions selected for the Fields in the Add Business Object to mApp wizard
(either Overwrite or Do Not Overwrite. The mApp Action column is blank for Fields set to Do
Not Overwrite). If you set the Business Object to Merge in the Business Object Properties
window (mApp page), then the selections made in the Defaults section (Default Behavior for
Fields drop-down menu) are also reflected in the mApp Action column.

Tip: You can also click the Edit Business Object button  on the mApp Editor toolbar to
open the Business Object Editor.

b. Click a Field, and then click the Field Properties button.

3. Set the individual Field to Merge:
a. Click the mApp Solutions page, and then check Include in mApp.
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b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the Field.

4. Click the Advanced page.

5. Click the mApp button  next to each property merge area, and then select a merge action:

For database settings:

◦ Do Not Overwrite Database Settings: Select this option to leave the database settings
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Database Settings: Select this option to overwrite the database settings in the target
system when the mApp Solution is applied.

For general attributes:
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◦ Do Not Overwrite General Attributes: Select this option to leave the general attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite General Attributes: Select this option to overwrite the general attributes in the target
system when the mApp Solution is applied.

For database attributes:

◦ Do Not Overwrite Database Attributes: Select this option to leave the database attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Database Attributes: Select this option to overwrite the database attributes in the
target system when the mApp Solution is applied.

For presentation settings:

◦ Do Not Overwrite Presentation Settings: Select this option to leave the presentation settings
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Presentation Settings: Select this option to overwrite the presentation settings in the
target system when the mApp Solution is applied.

For the value splitter:

◦ Do Not Overwrite Value Splitter: Select this option to leave the value splitter unchanged in the
target system when the mApp Solution is applied.

◦ Overwrite Value Splitter: Select this option to overwrite the value splitter in the target system
when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.

613

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Configure Merge Actions for Individual
Relationships

Use the mApp Solution Action context menu in the Relationship Editor within a mApp Solution to
configure separate merge actions for individual Relationships. You can also use the Relationship
Properties window to configure merge actions for individual Relationships, as well as for Relationship
properties.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within the Object Manager in the mApp Editor).

To configure merge actions for individual Relationships:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

Note: You can also add Relationships to a mApp Solution without also adding the Business
Object (except for reference), but this is less common.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Relationships task in the Structure area.

Tip: You can also click the Relationship button  in the mApp Editor toolbar to open the
Relationship Editor.

The Relationship Editor opens, displaying the Relationships for the Business Object, with a mApp
Action column to show which Relationships you selected to overwrite and which ones you chose not
to overwrite (blank in the mApp Action column) in the Add Business Object to mApp Wizard.

3. Configure separate merge actions for individual Relationships (using the mApp Action context
menu):

a. Click a Relationship, right-click in the mApp Action column, and then hover over mApp
Action to open a context menu.

b. Select a merge action from the context menu:
◦ Make no changes to Relationship: Select this option to leave the existing definition in the

target system unchanged (the mApp Solution definition is not imported into the target
system when the mApp Solution is applied).

◦ Import Relationship if not already there: Select this option to import the Relationship if it
does not already exist in the target system. If it already exists, the Relationship will not
be imported when the mApp Solution is applied.

◦ Overwrite Relationship: Select this option to have the mApp Solution definition overwrite
the existing definition in the target system.

◦ Conditionally merge Relationship properties: This option is grayed out on the context
menu because merging a Relationship requires selecting separate merge actions for
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individual Relationship property merge areas. This is done using the Relationships
Properties window (see step 5).

◦ Remove Relationship from target system: Select this option to have the Relationship
removed from the target system.

◦ Relationship is reference-only: Select this option to include the Relationship in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).

The selected action shows in the mApp Solution status column (blank if you selected Make no
changes to Relationship).

4. Configure separate merge actions for individual Relationships (using the Relationship Properties
window):

a. Click a Relationship, and then click the Edit button.

b. Click the mApps page.

c. Define general mApp Solution properties for the Relationship:
◦ Include in mApp Solution: Select this check box to include the Relationship in the mApp

Solution. Clear this check box to leave the existing definition in the target system
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unchanged (the Relationship is not imported into the target system when the mApp
Solution is applied).

Note: This check box is automatically selected if you chose to overwrite some or all of
the Relationships when you added the Business Object to the mApp Solution (using the
Add Business Object to mApp Wizard) or if you selected anything besides Make no
changes to Relationship in the mApp Action context menu.

◦ References: Click this button to open the References window and view all of the other
definitions being used by the Relationship.

d. Define options (merge actions) for how the definition will be merged into a target system:

Note: These options are only available if Include in mApp is selected.

◦ Import to target system: Select this radio button to import the definition into a target
system. Then, select a merge action based on whether or not the definition is already
present in the target system:

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

◦ Merge: Select this option to define separate merge actions for each individual area
of a definition.

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the definition from a
target system.

◦ For Reference Only: Select this radio button to include the definition in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).

◦ Import/Remove Based on Condition: Select this check box to import or remove the

definition based on a condition. Then, click the Ellipses button  to open the mApp
Conditions window and define mApp Solution conditions.
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Tip: You can also click the mApp Options button  on the mApp Editor toolbar to
open the mApp Options window for a Relationship and define general mApp Solution
properties and merge actions for the Relationship. The mApp Options button will show
an indicator based on the merge action you select in the mApp Solution Options window

or in the Relationship Editor for a particular Relationship (example: for Overwrite).

5. Configure separate merge actions for individual Relationship property merge areas:
a. In the Options area of the Relationship Properties window, select the Import to Target

System check box.

b. Select Merge as the merge action for the Relationship (from the If Already Present drop-
down).

c. Define individual merge actions for each merge area:

In the Merge Areas Grid: For each merge area, select a merge action in the Merge Action
column drop-downs:
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◦ Overwrite: Select this option to have the merge area overwritten in the target system
when the mApp Solution is applied.

◦ Do Not Overwrite: Select this option to leave the merge area unchanged in the target
system when the mApp Solution is applied.

Tip: Click the Uncheck All button  to set all merge areas to Do Not Overwrite. Click

the Select All button  to set all merge areas to Overwrite.

On the remaining pages of the properties window: Click the mApp button  next to each of
the merge areas to define merge actions for individual properties:

i. Define merge actions for general Relationship properties.

ii. Define merge actions for Relationship link properties.

iii. Define merge actions for Relationship database options.

iv. Define merge actions for Relationship auditing properties.

v. Define merge actions for Relationship advanced properties.

d. Select OK.

The Merge Area selections are reflected in the Relationship Editor.

6. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for General Relationship
Properties

Use the General page in the Relationship Properties window to define whether or not to overwrite the
following property merge areas:

• Name and description.

• Relationship type.

• Relationship cardinality: Whether an object can be related to one or many items.

• Default Group Member: Group Member to create by default when the Relationship creates a new
child object record (only applicable if the child object is a Group Leader).

• Additional options: Relationship uses, reverse Relationships, and Full-Text searching options.

Note: The Relationship Properties window is available in the Relationship Editor (accessed
from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Relationships and Relationship
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is unchecked, then you
cannot configure separate merge actions for individual Relationship properties.

• For more information about defining general Relationship properties, refer to Define General
Properties for a Relationship.

To define merge actions for general Relationship properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp wizard.

2. Open the Relationship Properties window:
a. In the Object Manager within the mApp Editor, click the Edit Relationships task in the

Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the mApp Solution Editor Toolbar
to open the Relationship Editor.

b. Click a Relationship, and then click the Edit button.

3. Set the Relationship to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.
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c. From the If Already Present drop-down menu, select Merge as the merge action for the
Relationship.

4. Click the General page.

5. Click the mApp button  next to each property merge area, and then select a merge action:

For general Relationship information (name and description):

◦ Do Not Overwrite Name and Description: Select this option to leave the Relationship's name
and description unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Name and Description: Select this option to overwrite the Relationship's name and
description in the target system when the mApp Solution is applied.

For Relationship type:

◦ Do Not Overwrite Relationship Type: Select this option to leave the Relationship type
unchanged in the target system when the mApp Solution is applied.
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◦ Overwrite Relationship Type: Select this option to overwrite the Relationship type in the target
system when the mApp Solution is applied.

For the number of related items:

◦ Do Not Overwrite Number of Related Items: Select this option to leave the number of related
items unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Number of Related Items: Select this option to overwrite the number of related items
in the target system when the mApp Solution is applied.

For the default Group Member:

◦ Do Not Overwrite Default Group Member: Select this option to leave the default Group
Member unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Default Group Member: Select this option to overwrite the default Group Member in
the target system when the mApp Solution is applied.

For Relationship use:

◦ Do Not Overwrite Relationship Use: Select this option to leave the Relationship use
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Relationship Use: Select this option to overwrite the Relationship use in the target
system when the mApp Solution is applied.

For the reverse Relationship:

◦ Do Not Overwrite Reverse Relationship: Select this option to leave the reverse Relationship
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Reverse Relationship: Select this option to overwrite the reverse Relationship in the
target system when the mApp Solution is applied.

For child Full-Text Search:

◦ Do Not Overwrite Child Full-Text Search: Select this option to leave the child Full-Text Search
options unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Child Full-Text Search: Select this option to overwrite the child Full-Text Search
options in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Relationship Link
Properties

Use the Links page in the Relationship Properties window (accessed from within the mApp Solution
Editor) to define whether or not to overwrite how Business Objects are linked together in a Relationship.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Relationships and Relationship
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is unchecked, then you
cannot configure separate merge actions for individual Relationship properties.

• For more information about defining link properties for a Relationship, refer to Define Link Properties
for a Relationship.

To define merge actions for a Relationship's link properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp wizard.

2. Open the Relationship Properties window:
a. In the Object Manager within the mApp Editor, click the Edit Relationships task in the

Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the mApp Editor Toolbar to open
the Relationship Editor.

b. Click a Relationship, and then click the Edit button.

3. Set the Relationship to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the
Relationship.

4. Click the Links page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Relationship Link Options: Select this option to leave the Relationship's link

properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Relationship Link Options: Select this option to overwrite the Relationship's link
properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Relationship Database
Properties

Use the Database page in the Relationship Properties window to define whether or not to overwrite the
Relationship's database properties.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Relationships and Relationship
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is unchecked, then you
cannot configure separate merge actions for individual Relationship properties.

• Database properties allow you to create and enable foreign keys for the Relationship. Foreign Keys
establish and enforce a link between tables in a relational database, and are required by SQL
Reporting Services. It is recommended that you do not use foreign keys unless you have a specific
need to do so.

• For more information about defining Relationship database properties, refer to Define Database
Properties for a Relationship.

To define merge actions for Relationship database properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp wizard.

2. Open the Relationship Properties window:
a. In the Object Manager within the mApp Editor, click the Edit Relationships task in the

Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the mApp Editor Toolbar to open
the Relationship Editor.

b. Click a Relationship, and then click the Edit button.

3. Set the Relationship to Merge:
a. Click the mApp Solutions page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the
Relationship.

4. Click the Database page.
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5. Click the mApp button , and then select a merge action:
◦ Do Not Overwrite Database Options: Select this option to leave the Relationship's database

properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Database Options: Select this option to overwrite the Relationship's database
properties in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Relationship Auditing
Properties

Use the Auditing page in the Relationship Properties window to define whether or not to overwrite how
changes to child object records are tracked in the parent object's history records.

Note: The Relationship Properties window is available in the Relationship Editor (accessed from
within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Relationships and Relationship
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is unchecked, then you
cannot configure separate merge actions for individual Relationship properties.

• For more information about defining auditing properties for a Relationship, refer to Define Auditing
Properties for a Relationship.

To define merge actions for Relationship auditing properties:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp wizard.

2. Open the Relationship Properties window:
a. In the Object Manager within the mApp Editor, click the Edit Relationships task in the

Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the mApp EditorToolbar to open
the Relationship Editor.

b. Click a Relationship, and then click the Edit button.

3. Set the Relationship to Merge:
a. Click the mApp Solutions page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the
Relationship.

4. Click the Auditing page.
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5. Click the mApp button  , and then select a merge action:
◦ Do Not Overwrite Audit Settings: Select this option to leave the Relationship's auditing

properties unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Audit Settings: Select this option to overwrite the Relationship's auditing properties
in the target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Define Merge Actions for Relationship Advanced
Properties

Use the Advanced page in the Relationship Properties window to define whether or not to overwrite the
following advanced properties for a Relationship:

• Advanced Options: Options for deleting child objects when parent objects are deleted, making
records in the Relationship read-only, reloading the Relationship when constraints change, etc.

• Groups: Options for defining Group Member type when child records are added (only applicable if
the child object is a Group Object).

• General Attributes.

• Database Attributes.

Note: The Relationship Properties window is available in the Relationship Editor (accessed
from within the Object Manager in the mApp Editor).

Good to know:

• You can only configure separate merge actions for individual Relationships and Relationship
properties if the Business Object is set to Merge in the Business Object Properties window (mApp
page). If the Business Object is set to any other option, or if Include in mApp is unchecked, then you
cannot configure separate merge actions for individual Relationship properties.

• For more information about defining advanced properties for a Relationship, refer to Define
Advanced Properties for a Relationship.

To define merge actions for Relationship advanced properties:

1. Add a Business Object to a mApp using the Add Business Object to mApp wizard.

2. Open the Relationship Properties window:
a. In the Object Manager within the mApp Editor, click the Edit Relationships task in the

Structure area.

The Relationship Editor opens.

Tip: You can also click the Edit Relationship button  on the mApp Editor Toolbar to open
the Relationship Editor.

b. Click a Relationship, and then click the Edit button.

3. Set the Relationship to Merge:
a. Click the mApp page, and then check Include in mApp.

b. In the Options area, click Import to Target System.

c. From the If Already Present drop-down menu, select Merge as the merge action for the
Relationship.
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4. Click the Advanced page.

5. Click the mApp button  next to each property merge area, and then select a merge action:

For advanced options:

◦ Do Not Overwrite Advanced Options: Select this option to leave the advanced options
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Advanced Options: Select this option to overwrite the advanced options in the target
system when the mApp Solution is applied.

For Group settings:

◦ Do Not Overwrite Group Settings: Select this option to leave the group settings unchanged in
the target system when the mApp Solution is applied.

◦ Overwrite Group Settings: Select this option to overwrite the group settings in the target
system when the mApp Solution is applied.
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Note: These settings are displayed only if the child object in the Relationship is a Group
Object.

For general attributes:

◦ Do Not Overwrite General Attributes: Select this option to leave the general attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite General Attributes: Select this option to overwrite the general attributes in the target
system when the mApp Solution is applied.

For database attributes:

◦ Do Not Overwrite Database Attributes: Select this option to leave the database attributes
unchanged in the target system when the mApp Solution is applied.

◦ Overwrite Database Attributes: Select this option to overwrite the database attributes in the
target system when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Configure Merge Actions for Forms
The Add Business Object to mApp Wizard is a convenient way to define merge actions for a Business
Object and its associated Forms. However, you can also use the mApp Options window in the Form
Editor to configure the following:

• General properties: Whether to include the Form in the mApp Solution.

• Options for importing the Form into the target system when the mApp Solution is applied:
◦ Import to target system: Imports the Form into the target system. You can select merge actions

based on whether the Form already exists in the target system.

◦ Remove from Target System: Removes the Form from the target system.

◦ For Reference Only: Includes the Form in the mApp Solution for informational purposes only (it
is not merged into the target system when the mApp Solution is applied).

◦ Import/remove based on condition: Imports or removes the Form based on configured mApp
Solution conditions.

To configure merge actions for Forms:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Forms task in the Appearance area.

The Form Editor opens.

Tip: You can also click the Form button  in the mApp Editor toolbar to open the Form Editor.

3. Configure merge actions for Forms:
a. Select a Form in the Form drop-down (example: Default Form), and then click the mApp

Options button  on the mApp Editortoolbar.
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b. Define general mApp Solution properties for the Form:
◦ Include in mApp Solution: Select this check box to include the form in the mApp Solution.

Clear this check box to leave the existing definition in the target system unchanged (the
Form is not imported into the target system when the mApp Solution is applied).

Note: This check box is automatically selected if some or all of the Forms were set to
overwrite when you added the Business Object to the mApp Solution (using the Add
Business Object to mApp Wizard).

◦ References: Click this button to open the References window and view all of the other
definitions being used by the Form.

c. Define options (merge actions) for how the Form will be merged into a target system:

Note: These options are only available if Include in mApp Solution is selected.

◦ Import to target system: Select this radio button to import the form definition into a target
system. Then, select a merge action based on whether or not the definition is already
present in the target system.

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the form definition from
a target system.

◦ For Reference Only: Select this radio button to include the form definition in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).

◦ Import/Remove Based on Condition: Select this check box to import or remove the form

definition based on a condition. Then, click the Ellipses button  to open the mApp
Solution Conditions window and define mApp Solution conditions.

d. Select OK.
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The mApp Solution Options button shows an indicator based on the selected merge action

(example: for Overwrite).

4. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Configure Merge Actions for Grids
The Add Business Object to mApp Wizard is the primary method of defining merge actions for a Business
Object and its associated Grids. However, you can use the mApp Solution Options window in the Grid
Editor to configure the following:

• General properties: Whether to include the Grid in the mApp Solution.

• Options for importing the Grid into the target system when the mApp Solution is applied:
◦ Import to target system: Imports the Grid into the target system. You can select merge actions

based on whether the Form already exists in the target system.

◦ Remove from Target System: Removes the Grid from the target system.

◦ For Reference Only: Includes the Grid in the mApp Solution for informational purposes only (it
is not merged into the target system when the mApp Solution is applied).

◦ Import/remove based on condition: Imports or removes the Grid based on configured
conditions.

To configure merge actions for Grids:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Grids task in the Appearance area.

The Grid Editor opens.

Tip: You can also click the Grid button  in the mApp Editor toolbar to open the Grid Editor.

3. Configure merge actions for Grids:
a. Select a Grid in the Grid drop-down (example: Default Grid), and then click the mApp

Options button  on the mApp Editor toolbar.
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b. Define general mApp Solution properties for the Grid:
◦ Include in mApp: Select this check box to include the Grid in the mApp Solution. Clear

this check box to leave the existing definition in the target system unchanged (the Grid is
not imported into the target system when the mApp Solution is applied).

Note: This check box is automatically selected if some or all of the Grids were set to
overwrite when you added the Business Object to the mApp Solution (using the Add
Business Object to mApp Wizard).

◦ References: Click this button to open the References window and view all of the other
definitions being used by the Grid.

c. Define options (merge actions) for how the Grid will be merged into a target system:

Note: These options are only available if Include in mApp is selected.

◦ Import to target system: Select this radio button to import the Grid definition into a target
system. Then, select a merge action based on whether or not the definition is already
present in the target system:

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the Grid definition from a
target system.

◦ For Reference Only: Select this radio button to include the Grid definition in the mApp
Solution for informational purposes only (the definition is not imported into the target
system when the mApp Solution is applied).

◦ Import/Remove Based on Condition: Select this check box to import or remove the Grid

definition based on a condition. Then, click the Ellipses button  to open the mApp
Solution Conditions window and define mApp Solution conditions.

d. Select OK.
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The mApp Solution Options button shows an indicator based on the selected merge action

(example: for Overwrite).

4. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.
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Configure Merge Actions for Form Arrangements
and Tabs

The Add Business Object to mApp Wizard is the primary method of defining merge actions for Form
Arrangements. However, you can use the mApp Options window in the Form Arrangement Editor to
override these selections.

You can also configure separate merge actions for individual tabs in a Form Arrangement using the
following tools in the Form Arrangement Editor:

• mApp Action context menu

• Tab Properties window

When you make selections in one tool, they will be reflected in the other tools.

To configure merge actions for Form Arrangements:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Form Arrangement task in the Appearance area.

The Form Arrangement Editor opens.

Tip: You can also click the Form Arrangement button  in the mApp Editor toolbar to open the
Form Arrangement Editor.

3. Configure merge actions for the Form Arrangement:

a. Click the mApp Options button  in the mApp Editor toolbar.

b. Define general mApp Solution properties for the Form Arrangement:
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◦ Include in mApp: Select this check box to include the Form Arrangement in the mApp
Solution. Clear this check box to leave the existing definition in the target system
unchanged (the Form Arrangement is not imported into the target system when the
mApp Solution is applied).

Note: This check box is automatically selected if some or all of the tabs in the Form
Arrangement were set to overwrite when you added the Business Object to the mApp
Solution (using the Add Business Object to mApp Wizard).

◦ References: Select this button to open the References window and view all of the other
definitions being used by the Form Arrangement

c. Define options (merge actions) for how the Form Arrangement will be merged into a target
system:

Note: These options are only available if Include in mApp is checked.

◦ Import to target system: Select this radio button to import the Form Arrangement
definition into a target system. Then, select a merge action based on whether or not the
definition is already present in the target system:

If already present: In the drop-down, select a merge action to define how the definition is
imported if it already exists in a target system:

◦ Overwrite: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Don't Import: Select this option to leave the existing definition in the target system
unchanged (the mApp Solution definition is not imported into the target system
when the mApp Solution is applied).

◦ Merge: Select this option to define separate merge actions for each Tab of a Form
Arrangement definition.

If not present: In the drop-down, select a merge action to define whether the definition is
imported if it does not currently exist in the target system:

◦ Import: Select this option to import the mApp Solution definition into the target
system if does not already exist.

◦ Don't Import: Select this option to skip importing the mApp Solution definition into
the target system if it does not already exist (the mApp Solution definition will not
be added to the target system).

◦ Remove from Target System: Select this radio button to remove the Form Arrangement
definition from a target system.

◦ For Reference Only: Select this radio button to include the Form Arrangement definition
in the mApp Solution for informational purposes only (the definition is not imported into
the target system when the mApp Solution is applied).
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◦ Import/Remove Based on Condition: Select this check box to import or remove the Form

Arrangement definition based on a condition. Then, click the Ellipses button  to open
the mApp Conditions window and define mApp Solution conditions.

d. Select OK.

The mApp Options button shows an indicator based on the selected merge action (example: for
Overwrite).

4. Configure separate merge actions for individual tabs in the Form Arrangement (using the mApp
Action context menu):

a. In the mApp Options window for the Form Arrangement, select Import to Target System.

b. Select Merge as the merge action for the Form Arrangement (from the If Already Present
drop-down).

Each tab shows an indicator based on the merge action for each tab (default is Overwrite).

c. Right-click a tab, and then hover over mApp Action to open a context menu.

d. Select a merge action from the context menu.
◦ Make no changes to Tab (Default): Select this option to leave the existing definition in the

target system unchanged (the mApp Solution definition is not imported into the target
system when the mApp Solution is applied).

◦ Import Tab if not already there: Select this option to import the Tab if it does not already
exist in the target system. If it already exists, the Tab will not be imported when the mApp
Solution is applied.

◦ Overwrite Tab: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Remove Tab from target system: Select this option to have the Tab removed from the
target system.

5. Configure separate merge actions for individual tabs in the Form Arrangement (using the Tab
Properties window):

a. Right-click a tab, and then click Properties.

b. Click the mApp Solution button  (on any page), and then select a merge action for the tab:

Note: The down arrow is only active if the Form Arrangement was set to Merge in the mApp
Options window.

◦ Make no changes to tab (Default): Select this option to leave the existing tab definition (if
found) unchanged in the target system (the mApp Solution definition is not imported into
the target system when the mApp Solution is applied).

◦ Overwrite tab: Select this option to have the tab definition in the mApp Solution overwrite
the existing tab definition (if found) in the target system. If the tab definition is not found
in the target system, it is added to the system when the mApp Solution is applied.
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◦ Remove tab if found: Select this option to have the mApp Solution remove the existing
tab definition in the target system (if found).

Note: The merge action selected in the Add Business Object to mApp Wizard for the tab
in the Form Arrangement is automatically checked.

c. Select OK.

Each tab shows an indicator based on the action selected in the mApp Solution Action context
menu or the Tab Properties window.

6. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.

Note: Even if a tab is set to be added or merged into a target system, it will not be added or
merged if the necessary target Relationship does not exist.
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Configure Merge Actions for Business Object
Actions

Business Object Actions are categorized by areas (Menu, Task Pane, toolbar, Context Menu, and
Automatic Actions). When you use the Add Business Object to mApp Wizard to define merge actions for a
Business Object and its associated Actions, you are specifying merge actions for entire areas and all
Actions within those areas. However, you can use the Business Object Actions window to override these
selections. You can also define separate merge actions for individual Actions within a Business Object's
Menu, Task Pane, toolbar, and Context Menu.

To configure merge actions for Business Object Actions:

1. Add a Business Object to a mApp Solution using the Add Business Object to mApp Wizard.

2. In the Object Manager within the mApp Editor, click the Business Object from the Object tree, and
then click the Edit Actions task in the Structure area.

3. Click a page (example: Task Pane) to view the Actions for that specific area.

4. Configure separate merge actions for individual Business Object Action areas (the merge action
selected will apply to all Business Object Actions within the area:

a. Click the mApp button , and then select a merge action:
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◦ Clear overwrite option for all Actions: Select this option to set all Actions within an area to
Do Not Overwrite.

◦ Set all Actions for overwrite: Select this option to set all Actions within an area to
Overwrite.

5. Configure separate merge actions for individual Business Object Actions:

a. Select a specific Action within an area, and then click the mApp button  next to the Action
field.

b. Select a merge action in the drop-down:

Note: You can only select separate merge actions for Menu, Task Pane, toolbar, Context
Menu, and Automatic Actions. Print Actions are handled as a single merge area of a Business
Object.

◦ Do Not Overwrite Action: Select this option to leave the existing Action definition in the
target system unchanged (the mApp Solution definition is not imported into the target
system when the mApp Solution is applied).

◦ Overwrite Action: Select this option to have the mApp Solution definition overwrite the
existing definition in the target system.

◦ Conditions: Select this option to open the mApp Conditions window and define
conditions for overwriting/adding the Action definition when the mApp Solution is applied.

6. Select OK.

7. Prepare the mApp Solution for Distribution (File>Prepare mApp for distribution), or save the mApp
Solution (File>Save mApp to Disk) to continue making other changes.

642

CSM 10.0.0 Administration

CSM 10.0.0 Administration



View Referenced Definitions in a mApp Solution
References allow you to see at a glance all of the system definitions throughout CSM being used by a
selected mApp Solution definition (Business Object, Relationship, Form, Grid, Form Arrangement, and/or
CSM Item). This allows you to ensure that all necessary definitions are included in a mApp Solution.

Good to know:

• If you add a definition to a mApp Solution without also adding all of the other definitions it
references, some portions of the object or item might not work in the target system after the mApp
Solution is applied.

• You cannot add Business Objects to a mApp Solution from the References window. You must use
either the Add Business Object to mApp Wizard or the Business Object Properties window.

Use the References window to:

• View all references associated with a mApp Solution definition.

• View all references that can be automatically added to a mApp Solution.

• Add referenced definitions to a mApp Solution.

The references window can be opened several ways within a mApp Solution by clicking the References
button (activated when the Include in mApp check box is selected):

• From the mApp page in the Business Object Properties window.

• From the mApp page in the Field Properties window.

• From the mApp page in the Relationship Properties window.

• From the mApp Options window in the Form Editor.

• From the mApp Options window in the Grid Editor.

• From the mApp Options window in the Form Arrangement Editor.

• From the mApp Options window when you add a CSM Item (example: One-Step Action) to a mApp
Solution.
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1. Toolbar: Displays a row of drop-down menus available in the References window.

2. Main Pane: Displays dependent definitions grouped in a tree by system definition.
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Open the References Window
The references window can be opened several ways within a mApp Solution by clicking the References
button (activated when the Include in mApp check box is selected):

• From the mApp page in the Business Object Properties window.

• From the mApp page in the Field Properties window.

• From the mApp page in the Relationship Properties window.

• From the mApp Options window in the Form Editor.

• From the mApp Options window in the Grid Editor.

• From the mApp Options window in the Form Arrangement Editor.

• From the mApp Options window when you add a CSM Item (example: One-Step Action) to a mApp
Solution.
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References Window Toolbar
Use the References window toolbar to view and add definitions that are used by a system definitions
included in a mApp Solution. When you add a referenced definition to a mApp Solution, a condition is
automatically set to only import the referenced definition into a target system if the definition using it is
also imported (or already exists in the target system).

Note: The References window toolbar is dynamic so options vary depending on the type of
definition and what is selected in the tree.
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References Window Main Pane
Use the References Window Main pane to view referenced definitions, grouped in a tree by the type of
system definition (example: Forms). What is shown in the tree depends on where the References window
was accessed (example: Clicking the References button from the Relationship Properties window will
show a tree of all definitions being used by a particular Relationship). In the References Window Main
pane, you can:

• Expand the branches of the tree to drill down into referenced definitions.

• Contract expanded branches back to the main referenced definitions.

• Select an item and add or remove it from a mApp Solution (right-click item or use the buttons on the
toolbar).
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Automation Processes
Automation Processes allow CSM users to automate behavior by creating rules for the system to follow.
Automation Processes are executed by the Automation Process Service, which is a microservice of the
Cherwell Service Host.
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About Automation Processes
Automation Processes could include either automatically completing an Action when a particular event
takes place (example: When an Incident is closed, send a notification to the Customer), or handling time-
sensitive issues (example: If the Customer has not been contacted within four hours, automatically remind
the Technician). Automation Processes can also watch for trends (example: If the number of open
Incidents exceeds a particular threshold, then automatically act). Automation Processes operate within
the timeframe of defined Business Hours.

Automation Processes are handled by the Automation Process Service, which is a microservice of the
Cherwell Service Host.

There are three types of Automation Processes:

1.  Visual Workflow Process: Defines a sequence of time-based and event-based steps that manage
a Business Object as it passes through various stages.

2.  Threshold-Based Process: Watches a value and performs an Action after a threshold is crossed.

3.  Simple Action/Event Process: Runs a One-Step Action or Action after a specific event occurs.

CSM provides multiple tools to manage Automation Processes, including the Automation Process Editor
and Visual Workflow Process Designer.
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Automation Processes Good to Know
• Use the Automation Processes page in CSM Administrator (CSM Administrator>Automation

Processes) to quickly access common Automation Process operations.

• CSM provides two tools that can be used to manage Automation Processes. Use the Automation
Process Editor to work with Automation Processes (create, edit, delete, etc.) outside of a Blueprint
(typical use). Use the Automation Process Manager to work with Automation Processes (create,
edit, delete, etc.) within a Blueprint (required when adding an Automation Process to a mApp
Solution).

Always consider the following:

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (CSM Administrator>Security>Edit Security Groups). For detailed
information, see Configure Automation Process Blueprint Security Rights and Configure Automation
Process Service Security Rights.
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Using Automation Processes
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OOTB Automation Processes
CSM provides numerous OOTB Automation Processes, which are organized and defined based on
Business Objects:

• Incident

• Problem

• CMDB

• Change

• Knowledge Article

• Task

• Customer Internal

• Event

• Password Reset
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Customer - Internal Automation Processes
CSM provides the following OOTB Customer - Internal Automation Process:

Name Description

Last Logon 90 Days Ago -
Customer Internal

Waits 90 days after the Customer - Internal Last Logon date and time
change, then runs the Disable User Account One-Step Action (changes the
status of a User Account to Disabled).
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Event Automation Processes
CSM provides the following Event Automation Process:

Name Description

Update CI Status to
Down

When an Event Record is created, the process initiates the Update CI Status
One-Step Action, which Updates the CI status to Down.
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Password Reset Form Automation Processes
CSM provides the following Password Reset Automation Process:

Name Description

Self Service Password
Reset

When a new Self-Service Password Reset Form is created, the process
determines whether the password should be reset and then takes the
appropriate actions.
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Open an Existing Automation Process Blueprint
Automation Processes are edited within a Blueprint in order to allow the system administrator to set up
multiple rules that take place at the appropriate time. Use the Open an Existing Automation Process
Blueprint task to import a previously-created Blueprint (.bp) from your computer files.

To open an existing Automation Process Blueprint:

1. Open CSM Administrator.

2. Click Automation Processes.

3. Click Open an existing Automation Process Blueprint.

A window opens displaying your computer files.

4. Select a Blueprint file (.bp).

5. Select OK.

The Automation Process Blueprint opens.
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Enable or Disable an Automation Process
By default, all Automation Processes are disabled in CSM. Use CSM Administrator to enable Automation
Processes, which activates the processes and initiates them at the appropriate time.

Note: Automation Process e-mails use the Current System Stored Value. The processes will send
e-mails to the test receiver account (example: ServiceDeskTESTReceiver@company.com) until
you migrate to a production environment.

While many default processes are available for your use, we recommend the following at a minimum:

• Incident Confirmation E-mail on Create: (Association: Incident) When an Incident is created, the
process initiates the Incident Confirmation One-Step Action, which sends the Customer an e-mail to
confirm their record and provide the Record ID number.

• Incident - Not Touched in 3 Days: (Association: Incident) Waits for the Last Modified Date Time
Field to update. If the Field is not updated for three days, the process initiates the SLA Escalate if
Not Touched in 3 Days One-Step Action that sends an e-mail to the Incident owner with a reminder
to follow up with the Customer.

• Resolve to Closed: (Association: Incident) Waits for three days after the status of an Incident is
changed to Resolved. If the status does not change from Resolved, it marks the status as Closed.

The following CSM icons indicate the type of Automation Process:

Icon Action

Simple Action/Event Automation Process

Threshold-Based Automation Process

Visual Workflow Automation Process

Use the Individual Automation Process Status task (CSM Administrator) to either enable or disable
Automation Processes:

• Enabled Automation Process: Active in the system and operate at the scheduled time.

• Disabled Automation Processes: Inactive in the system, so they do not operate when events are
fired.

The Automation Process Status window (CSM Administrator>Automation Processes>Individual
Automation Process Status) uses the following icons to indicate status:

Icon Action

The Automation Process is enabled (active).
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Icon Action

The Automation Process is disabled (inactive).

To change the status of an Automation Process:

1. Click the Automation Processes category in CSM Administrator.

2. Click Individual Automation Process Status.

3. Select the Automation Process that you want to change.

4. Select a status:
◦ Click the Enable button  on the toolbar to enable the Automation Process.

Tip: You can also click Process on the menu bar and select Enable, or right-click an
Automation Process and select Enable.

◦ Click the Disable button on the toolbar to disable the Automation Process.

The Automation Process reflects the selected status in the Grid.

5. Close the Automation Process Status window.

Note: Your changes are saved automatically.
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Pause/Resume Automation Process Processing
Use the Pause/Resume Processing task (CSM Administrator>Automation Processes) to temporarily
pause, and then resume Automation Process Service processing. This does not stop the Automation
Process Service; rather, it suspends the microservice so that, when resumed, the microservice can pick
up where it left off. For example, pause processing to suspend sending out automatic e-mails; resume
processing to continue sending out automatic e-mails. The ability to pause or resume Automation
Processing is controlled by Automation Process Service security rights.

Good to know:

• The Automation Process Service is a microservice of the Cherwell Service Host.

• When you pause or resume processing, it could take up to five minutes for the pause or resume
operation to take effect. To immediately pause or resume processing, use the Server Manager to
disable the Automation Process microservice.

To pause or resume Automation Process Service processing:

1. In the CSM Administrator main window, click the Automation Processes category, and then click
the Pause/Resume Processing task.

2. Select to pause or resume:
a. Pause Automation Process Microservice: Select the check box to pause processing. You

must provide a reason for pausing processing.

b. Resume Automation Process Microservice Processing: Select the check box to resume
processing.

3. Select OK.
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Monitor Automation Process Statistics
You can monitor these statistics for individual Automation Processes:

• Completed runs, including successes and failures

• In-progress runs

• Scheduled activities

To view Automation Process statistics:

1. Click the Automation Processes category in CSM Administrator.

2. Click Individual Automation Process Status.

3. Select an Automation Process, and then click Process>Statistics.

To clear Automation Processes:

1. From the Automation Process Statistics window, select Clear Process.

2. Select these options to delete these items:
◦ Clear scheduled activities: Clear activities that are currently scheduled for the Automation

Process.

◦ Clear in-progress items: Clear activities that are in progress.

◦ Clear completed item history: Clear statistics for all completed runs for the Automation
Process. Use this option only if you do not need the history of completed runs for an
Automation Process.

CAUTION: Once you click OK, the selected items are deleted.
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View Automation Processes for a Single Record
You can view the Automation Processes that have run for a specific record, including detailed status
information for each run.

To view Automation Processes for a single record:

1. In the CSM Desktop Client, open a record, such as an Incident.
2. Select Tools>Current Record Automation Processes.

A list of Automation Processes that than run opens.
3. You can:

◦ Select a specific Automation Process, and then click Details to view information about the run.
◦ Click Refresh to update the list with new run records.

Tip: If you are navigating through a set of records, keep the Automation Processes run
against dialog open to see the Automation Processes that have run for each record.
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Managing Automation Processes
CSM provides multiple tools to manage Automation Processes, including the Automation Process Editor
and Visual Workflow Process Designer.

• Automation Process Editor

• Open the Automation Process Editor

Use the Automation Process Editor to:

• Create a Simple Action/Event Automation Process.

• Create a Threshold-Based Automation Process.

• Create an Automation Process Visual Workflow Process.

• Edit an Automation Process.

• Delete an Automation Process.

• Copy an Automation Process.

Use the Automation Process Visual Workflow Process Designer to:

• Define Visual Workflow Properties

• Define Visual Workflow Events

• Define Visual Workflow Actions
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Automation Process Manager
Use the Automation Process Manager to complete general CSM Item Manager operations for Automation
Processes.

Open the Automation Process Manager from the CSM Administrator menu bar (in a Blueprint or mApp®
Solution), by selecting Managers > Automation Processes.

Good to know:

• System is the only available scope. Create subfolders underneath this scope to organize items.

• Use the Manager Context (right-click) menu to quickly access menu bar/toolbar options.

• For more information about working in CSM Item Managers, refer to the Item Managers
documentation.
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Automation Process Editor
Use the Automation Process Editor to define Automation Processes, including:

• Simple Action/Event Process

• Threshold-Based Process

• Automation Process Visual Workflow Process

Note: Automation Processes are edited using Blueprints. This allows for a number of
changes to be made together, but only applied to the system when you are ready.
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Open the Automation Process Editor
To open the Automation Process Editor from the CSM Administrator main window, click the Automation
Process category and then click Create a New Automation Process Blueprint.
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Create a Simple Action/Event Automation Process
Use the Simple Action/Event Automation Process window (accessed from within the Automation Process
Editor) to create a Simple Action/Event Automation Process.

To create a Simple Action/Event Process.

1. Open the Automation Process Editor.

2. Click the New button, and then select Simple Action/Event Process.

3. Define general properties: Name, description, Business Object, execution priority, and event.

4. Define record limitations: How to limit records, based on Query, Field, or Expression.

5. Define an action: One-Step Action or Action to run when the event takes place.
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Define General Properties for a Simple Action/
Event Automation Process

Use the Simple Action/Event Automation Process window to define general properties for the process.

To define general properties for a Simple Action/Event Automation Process:

1. Create a Simple Action/Event Automation Process.

2. Define general properties:
◦ Name:

Provide a display name.

◦ Description:

Provide a brief description.

◦ Business Object:

Select the type of Business Object against which the process will operate.

◦ Execution Priority:

Select a priority level, which provides a hint to the Business Process Server as to the
importance of the Automation Process. This allows the system to attempt to execute higher
priority processes before normal or low priority processes.

◦ Event:
Select an event to use to activate the Automation Process.

Event Type Description

<Business Object> Created The Automation Process will begin when a
<Business Object> is created.

<Business Object> Changed

◦ Any Change: The Automation Process will
begin if any change is made to the
<Business Object>.

◦ Field Changed: The Automation Process
will begin if the selected Field is altered.

Note:You have the option to define if the
Automation Process should operate when
any change is made to the Field, if the Field
changes to a value, if the Field changes
from a value, or is the Field changes from
one value to another.
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Event Type Description

<Business Object> Created or Changed The Automation Process will begin when a
<Business Object> is created or changed.

<Business Object> Closed The Automation Process will begin when a
<Business Object> is closed.

<Business Object> Reopened The Automation Process will begin when a
<Business Object> is reopened.

Related Child Event

Select the Relationship, and then select the type
of change that will trigger the Automation Process
to operate:

◦ <Business Object> Added

For Relationships that use direct links,
events are created when the parent
Business Object is saved.

For Relationships that use join tables,
events are created when each link is saved.

For one-to-many Relationships, you can
select the First <Business Object> Only
check box to trigger the event for only for
the first Business Object child created for
the Relationship.

◦ <Business Object> Record Modified

◦ <Business Object> Record Field Change

You can define if the Automation Process
should operate when any change is made
to a specified Field, if the Field changes to a
value, if the Field changes from a value, or
if the Field changes from one value to
another.

Also, the event will only fire if the Business
Object is modified while working on the
parent. For example, if you edit an Approval
in the Arrangement below a Change
Request, the event will fire, but if you edit
the Approval by alone it will not). If you
encounter either scenario, then a direct
event associated with an Approval should
be created.
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Event Type Description

Queue Event

◦ Queue Event: Select the type of Queue
event that will trigger the Automation
Process to operate (Record Added to
Queue or Record Removed from Queue).

◦ Which Queue: Select the type of Queue that
should be considered (Any Queue, User
Queue, Team Queue, or Specific Queue).

3. Select OK.
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Define Record Limitations for a Simple Action/
Event Automation Process

Use the Limit Records page in the Simple Action/Event Automation Process window to define record
limitations for the process.

To define record limitations for a Simple Action/Event Automation Process:

1. Create a Simple Action/Event Automation Process.

2. Click the Limit Records page.

The Limit Records section opens below the general properties.

3. Limit records based on Query: Only records for which the Query (Saved Search) condition is true
will cause the Action to be executed when the Event occurs.

a. Select the Query check box.

The Query drop-down and Ellipses button become active.

b. Click the Ellipses button  to open the Search Manager, where you can select a Saved
Search or create a new Saved Search.

4. Limit records based on Field: Only records where the specified value is found in the specified Field
will cause the Action to be executed when the Event occurs.

a. Select the Field check box.

The Field drop-down and Value drop-down become active.

b. From the Field drop-down, select a Field.

c. From the Value drop-down, select a value for the Field.

5. Limit records based on an Expression: Only records for which the Expression is true will cause the
Action to be executed when the Event occurs.

a. Select the Expression check box.

The Expression drop-down, Ellipses button, and Custom Expression button become active.

b. Define the Expression:

◦ Select an existing Expression: Click the Ellipses button  to open the Expression
Manager, and then select an Expression.

c. Create a Custom Expression: Click the Custom Expression button  and define a Custom
Expression.

6. Select OK.
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Define Actions for a Simple Action/Event
Automation Process

Use the Action page in the Simple Action/Event Automation Process window to define general properties
for the process.

When you define actions, you define:

• One-Step Action: One-Step Action to run when the event takes place.

• Action: Action to run when the event takes place.

Note: If you create a Save One-Step Action that saves child Business Objects before the parent
Business Object is saved, those child events will not execute properly. Ensure you clear the
Execute before saving record check box on the Save Action for the child events.

To define general properties for a Simple Action/Event Automation Process:

1. Create a Simple Action/Event Automation Process.
2. Click the Actions page.

The Actions section opens below the general properties.
3. Define a One-Step Action to run when the event takes place:

a. Select the One-Step Action radio button.
The One-Step Action Field and Ellipses button become active.

b. Click the Ellipses button  to open the One-Step Action Manager, and then select an
existing One-Step Action or create a new One-Step Action.

4. Define an Action to run when the event takes place:
a. Select the Execute Action radio button.

The Execute Action Field and Action button become active.
b. Click the Action button, and then select an available Action in the drop-down:

◦ Send an E-Mail
◦ Send Tweet
◦ Update a Business Object
◦ Create a Child Business Object

5. Select OK.

671

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_simple_action-event_automation_process
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create-edit_a_one-step


Create a Threshold-Based Automation Process
Use the Threshold-Based Automation Process window (accessed from within the Automation Process
Editor) to create a Threshold-Based Automation Process. When you define the Automation Process, you
define:

• General properties: Name, description, Business Object, and execution priority.

• Value: A value that the Automation Process should monitor.

• Criteria: Search criteria for the value included in the calculation.

• Threshold: Define when and how an Action is run when a threshold is breached.

To create a Threshold-Based Automation Process:

1. Open the Automation Process Editor.

2. Select New, and then select Threshold-Based Process.

3. Define general properties:
◦ Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

◦ Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

◦ Business Object:

Select the type of Business Object against which this process will operate.

◦ Execution Priority:

Select a priority level, which provides a hint to the Business Process Server as to the
importance of the Automation Process. This allows the system to attempt to execute higher
priority processes before normal or low priority processes.

4. Define the value that the Automation Process should monitor:
a. Select the Value page.

The Value page opens below the general properties.

b. Define value properties:
◦ Number of Records:

Select the radio button to monitor the number of records that meet the defined criteria.

◦ Function:
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Select the radio button to apply a mathematical function against a Field (example:
Average, total, etc.) if there is a numeric Field on the records being evaluated.

◦ Duration Function:

Select the radio button to apply a mathematical function against the range of time
between two time-based Fields (example: Determining the average amount of time that
Incidents take to resolve).

Note: If you select a duration function, you must specify the Fields that define the
start/end date times and the unit(s) to use (example: hours, days, months, etc.).

5. Define criteria for the records included in the calculation:
a. Select the Criteria page.

The Criteria page opens below the general properties.

b. Define criteria properties:
◦ Search Criteria:

Select the Ellipses button  to select an existing Saved Search or select Search 
to define a Custom Query to limit the records considered.

◦ Date Range:

Select the Range drop-down list to select a date range or select New to create a new
date range to use to limit records for consideration.

◦ Open Incidents Only:

Select the check box to only include open Incidents in the results.

6. Define one or more thresholds.
a. Select the Thresholds page.

b. Define threshold properties:
i. Use the Check threshold values every option to set how often threshold values should

be checked. Checking begins when Automation Process is enabled or when an
Automation Process Blueprint is published.

ii. Define run Actions:
◦ Every time value is checked (if the threshold is crossed):

Select the radio button to execute the Action if the check is completed every hour
and the value is above the threshold.

◦ When the threshold is first crossed:
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Select the radio button to execute the Action the first time the value is above the
threshold, but not execute the Action again unless the "at least" operator is
specified.

◦ Each time a threshold is crossed:

Select the radio button to execute the Action the first time the value is above the
threshold, but not execute the Action again until the value falls below the threshold
at least once and then goes above the value again.

◦ At least:

Specify the "at least" operator for the rules to be reconsidered. If the option is set to
When the Threshold is First Crossed and the threshold is crossed, the Action will
be executed a single time. If you specify that at least one day must pass between
operations, then a day later the Action will be executed again if the threshold is
crossed.

Note: This option is only available if you select the Automation Process to operate
every time a value is checked or each time a threshold is crossed.

iii. Define thresholds:
◦ Create a threshold:

Select Add to add a threshold to the list.

◦ Edit a threshold:

Use the controls underneath the threshold list to customize the threshold.

◦ Remove a threshold:

Select Remove to permanently delete a threshold.

◦ Reorder the thresholds:

Select Reorder to organize the threshold list. This option sorts all of the thresholds
based on the threshold values, but does not affect the Threshold-Based
Automation Process functionality.

◦ Above/Below threshold: Specify whether the threshold should be considered
Breached when the value exceeds or falls below the threshold value.

◦ Threshold value:

Specify the value against which the returned result will be compared.

◦ Action:

Select or define a One-Step Action to run when the threshold is breached.
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Note: The Action must be an unassociated One-Step Action (not tied to a particular
Business Object). This is necessary because there is no single record to operate
against, just a single resulting value.

7. Select Save.
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Create an Automation Process Visual Workflow
Process

Use the Automation Process Visual Workflow Process Designer (accessed from within the Automation
Process Editor) to create a Visual Workflow Automation Process.

To create a Visual Workflow Automation Process:

1. Open the Automation Process Visual Workflow Process Designer.

2. Define general properties: Start event, work hours, record limitations, execution limitations, and the
abort process.

3. Define events: Amount of time before the Automation Process continues to the next step and/or the
event that triggers the Automation Process to move to the next step.

4. Define actions: Actions that occur as a result of a time or event trigger (example: Run One-Step
Action, send E-mail, etc.).
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Open the Automation Process Visual Workflow
Process Designer

To open the Automation Process Visual Workflow Process Designer:

1. Open the Automation Process Editor.

2. Click the New button, and then select Visual Workflow Process.

The Visual Workflow Process Properties window opens.

3. Define Automation Process properties.
a. Name:

Provide a display name to use within CSM (search this property in CSM Item Managers).

b. Description:

Provide a description to use within CSM (search this property in CSM Item Managers).

c. Business Object:

Select a Business Object to associate with the Automation Process.

d. Execution Priority:

Select a priority level, which provides a hint to the Business Process Server as to the
importance of the Automation Process. This allows the system to attempt to execute higher
priority processes before normal or low priority processes.

4. Select OK.
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Define Automation Process Visual Workflow
Properties

Use the Current Step Details section of the Visual Workflow Process Designer to define general
properties. When you define general properties, you define:

• Start event: Event that triggers the initiation of the Automation Process.

• Work hours: Business Hours that will be used by the Automation Process to calculate time.

• Record limitations:Limitations of records that should be monitored.

• Execution limitations: Limitations as to when and how often the process should run.

• Abort process: Criteria used to determine if the process should be aborted.
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Define the Start Event for an Automation Process
Visual Workflow Process

Use the Start Event page of the Automation Process Visual Workflow Process Designer to define the
event that triggers the initiation of the Visual Workflow Automation Process.

To define the Start Event:

1. Open the Automation Process Visual Workflow Process.

2. Click the Start Event page in the left pane of the Current Step Details section.

3. Select an event to use to activate the Automation Process.

Event Type Description

<Business Object> Created The Automation Process will begin when a
<Business Object> is created.

<Business Object> Changed

◦ Any Change: The Automation Process will
begin if any change is made to the <Business
Object>.

◦ Field Changed: The Automation Process will
begin if the selected Field is altered.

Note:You have the option to define if the
Automation Process should operate when any
change is made to the Field, if the Field
changes to a value, if the Field changes from
a value, or is the Field changes from one
value to another.

<Business Object> Created or Changed The Automation Process will begin when a
<Business Object> is created or changed.

<Business Object> Closed The Automation Process will begin when a
<Business Object> is closed.

<Business Object> Reopened The Automation Process will begin when a
<Business Object> is reopened.
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Event Type Description

Related Child Event

Select the Relationship, and then select the type of
change that will trigger the Automation Process to
operate:

◦ <Business Object> Added

For Relationships that use direct links, events
are created when the parent Business Object
is saved.

For Relationships that use join tables, events
are created when each link is saved.

For one-to-many Relationships, you can
select the First <Business Object> Only
check box to trigger the event for only for the
first Business Object child created for the
Relationship.

◦ <Business Object> Record Modified

◦ <Business Object> Record Field Change

You can define if the Automation Process
should operate when any change is made to a
specified Field, if the Field changes to a
value, if the Field changes from a value, or if
the Field changes from one value to another.

Also, the event will only fire if the Business
Object is modified while working on the
parent. For example, if you edit an Approval in
the Arrangement below a Change Request,
the event will fire, but if you edit the Approval
by alone it will not). If you encounter either
scenario, then a direct event associated with
an Approval should be created.

Queue Event

◦ Queue Event: Select the type of Queue event
that will trigger the Automation Process to
operate (Record Added to Queue or Record
Removed from Queue).

◦ Which Queue: Select the type of Queue that
should be considered (Any Queue, User
Queue, Team Queue, or Specific Queue).
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4. Select OK.
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Define Work Hours for an Automation Process
Visual Workflow Process

Use the Work Hours page of the Automation Process Visual Workflow Process Designer to define the
Business Hours that will be used by the Automation Process to calculate passed time.

To define Business Hours for the Automation Process Visual Workflow Process:

1. Open the Automation Process Visual Workflow Process.

2. Click the Work Hours page in the left pane of the Current Step Details section.

3. Define Work Hours properties.

Note: These options affect the Wait for Time, Wait for Event, and Wait for Time or Event
options listed under Events. The options affect the time that passes between each step.

◦ 24x7: Calculates time passed between steps twenty-four hours a day/seven days a week.

◦ Based on SLA: Calculates time passed between steps based on the Business Hours defined
in the Service Level Agreement (SLA).

◦ Working Hours: Calculates time passed between steps based on the defined Business Hours
of your company.

Note: If you select Working Hours, you must also select specific Business Hours using the
drop-down. To create new Business Hours for the Automation Process, select the Ellipses
button to access the Business Hours Manager.

4. Select OK.
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Define Record Limitations for an Automation
Process Visual Workflow Process

Use the Limit Records page of the Automation Process Visual Workflow Process Designer to limit records
that are used by the Automation Process to calculate passed time.

To define limited records:

1. Open the Automation Process Visual Workflow Process.

2. Click the Limit Records page in the left pane of the Current Step Details section.

3. Limit records based on Query: Only records for which the Query (Saved Search) condition is true
will cause the Action to be executed when the Event occurs.

a. Select the Query check box.

The Query drop-down and Ellipses button become active.

b. Click the Ellipses button to open the Search Manager, where you can select a Saved Search
or create a new Saved Search.

4. Limit records based on Field: Only records where the specified value is found in the specified Field
will cause the Action to be executed when the Event occurs.

a. Select the Field check box.

The Field drop-down and Value drop-down become active.

b. From the Field drop-down, select a Field.

c. From the Value drop-down, select a value for the Field.

5. Limit records based on an Expression: Only records for which the Expression is true will cause the
Action to be executed when the Event occurs.

a. Select the Expression check box.

The Expression drop-down, Ellipses button, and Custom Expression button become active.

b. Define the Expression:
◦ Select an existing Expression: Click the Ellipses button to open the Expression

Manager, and then select an Expression.

c. Create a Custom Expression: Click the Custom Expression button  and define a Custom
Expression.

6. Select OK.
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Define Execution Limitations for an Automation
Process Visual Workflow Process

Use the Limit Execution page of the Automation Process Visual Workflow Process Designer to limit
execution properties, which control when and how often the Automation Process should run.

To limit execution:

1. Open the Automation Process Visual Workflow Process.

2. Click the Limit Execution page in the left pane of the Current Step Details section.

3. Define execution properties:
◦ Only run once: Select the radio button to run the process the first time the trigger event or

Action occurs.

◦ Run any number of times: Select the radio button to run the process every time the trigger
event or Action occurs.

◦ Do not start within: Select the check box and then use the Up arrow and Down arrow to
define the amount of time (number of hours or minutes) that must pass between
Automation Process executions.

◦ Do not start if process is already running: Select the check box to stop the process from
running if the trigger event or Action occurs while the Automation Process is already
running.

4. Select OK.
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Define Abort Process for an Automation Process
Visual Workflow Process

Use the Abort Process page of the Automation Process Visual Workflow Process Designer to define
criteria used to determine when the process should be aborted.

To define the abort process:

1. Open the Automation Process Visual Workflow Process.

2. Click the Abort Process page in the left pane of the Current Step Details section.

3. Define when the process should be aborted:
a. In the Abort Process If section, select one or more criteria that must be met for the process to

abort:
◦ Criteria used to initiate process is no longer valid: Select the check box to end the

process when the criteria defined on the Start Event page is no longer true.

◦ Query: Select the check box and define the Query (Search Group) to end the process
when records for which the Query condition is true

◦ Field/Value: Select the check box and define the Field and value to end the process
when the specified value is found in the specified Field.

◦ Expression: Select the check box and select or define an Expression to end the process
when the specified Expression is true.

◦ Incident Closed: Select the check box to end the process when the Incident is closed.

b. In the Check for Abort section, select when the process should check for the abort condition(s)
to be true:

◦ Before each step starts: Select the radio button to check if the abort process criteria is
true before each step takes place.

◦ After each step executes: Select the radio button to check if the abort process criteria is
true after each step takes place.

4. Select OK.
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Define Automation Process Visual Workflow
Events

Use the Events section of the Automation Process Visual Workflow Process Designer to define time and
event criteria that trigger an Action to take place. When you define time and event criteria, you define:

• Wait for Time: Steps that wait for a defined amount of time before the process continues to the next
step.

• Wait for Event: Steps that wait for a defined event before the process continues to the next step.

• Wait for Time or Event: Steps that wait for a defined time or event (whichever occurs first) before the
process continues to the next step.
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Define a Wait for Time for an Automation Process
Visual Workflow Process

Use the Events section of the Automation Process Visual Workflow Process Designer to define a wait for
time, which includes the steps that wait for a defined amount of time before the process continues to the
next step.

Good to know:

• As you drag the icon onto the Designer Board, the locations where the icon can be dropped
highlight as the cursor passes over them.

To define Automation Process Visual Workflow Process time options:

1. Open the Automation Process Visual Workflow Process Designer.

2. Click-and-drag the Wait for Time icon  onto the Designer Board.

The Wait for Time page opens in the Current Step Details section of the designer.

3. Define time criteria for the step:
◦ Wait from: Select the amount of time that the Automation Process should wait before watching

for the process trigger.

◦ How Long: Select how long the step should wait until continuing to the next step.
◦ Specific Time: Select the amount of time (number of days, hours, minutes quarters,

weeks, years) to use for the calculation. You can also define this option based on a
specified time before or after a Calendar item.

◦ Field Based: Select a Calendar or SLA Field to use for the calculation. If you select an
SLA Field, you also have the option to define the time increment (Days, weeks, etc.)
and/or the specific time before or after another another Calendar item

◦ SLA Based: Select a defined SLA to use for the calculation.

4. Select OK.
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Define a Wait for Event for an Automation Process
Visual Workflow Process

Use the Events section of the Automation Process Visual Workflow Process Designer to define a wait for
event, which includes the steps that wait for a defined event before the process continues to the next
step.

Good to know:

• As you drag the icon onto the Designer Board, the locations where the icon can be dropped
highlight as the cursor passes over them.

To define Automation Process Visual Workflow Process Event options:

1. Open the Automation Process Visual Workflow Process Designer.

2. Click-and-drag the Wait for Event icon  onto the Designer Board.

The Wait for Event - Event page opens in the Current Step Details section of the designer.

3. From the Wait from list, select the amount of time that the Automation Process should wait before
watching for the process trigger.

4. Select an event to use to activate the Automation Process.

Event Type Description

<Business Object> Created The Automation Process will begin when a
<Business Object> is created.

<Business Object> Changed

◦ Any Change: The Automation Process will
begin if any change is made to the <Business
Object>.

◦ Field Changed: The Automation Process will
begin if the selected Field is altered.

Note:You have the option to define if the
Automation Process should operate when any
change is made to the Field, if the Field
changes to a value, if the Field changes from
a value, or is the Field changes from one
value to another.

<Business Object> Created or Changed The Automation Process will begin when a
<Business Object> is created or changed.

<Business Object> Closed The Automation Process will begin when a
<Business Object> is closed.
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Event Type Description

<Business Object> Reopened The Automation Process will begin when a
<Business Object> is reopened.

Related Child Event

Select the Relationship, and then select the type of
change that will trigger the Automation Process to
operate:

◦ <Business Object> Added

For Relationships that use direct links, events
are created when the parent Business Object
is saved.

For Relationships that use join tables, events
are created when each link is saved.

For one-to-many Relationships, you can
select the First <Business Object> Only
check box to trigger the event for only for the
first Business Object child created for the
Relationship.

◦ <Business Object> Record Modified

◦ <Business Object> Record Field Change

You can define if the Automation Process
should operate when any change is made to a
specified Field, if the Field changes to a
value, if the Field changes from a value, or if
the Field changes from one value to another.

Also, the event will only fire if the Business
Object is modified while working on the
parent. For example, if you edit an Approval in
the Arrangement below a Change Request,
the event will fire, but if you edit the Approval
by alone it will not). If you encounter either
scenario, then a direct event associated with
an Approval should be created.
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Event Type Description

Queue Event

◦ Queue Event: Select the type of Queue event
that will trigger the Automation Process to
operate (Record Added to Queue or Record
Removed from Queue).

◦ Which Queue: Select the type of Queue that
should be considered (Any Queue, User
Queue, Team Queue, or Specific Queue).

5. Click the Time Limit page in the left pane of the Current Step Details section to define a time limit
for the step:

Note: If you select any option in this section other than No Time Limit, the Wait for Event
Step changes to Wait for Time or Event and a new Wait for Time branch displays on the
Designer Board.

◦ Wait for Time: Step that waits for a defined amount of time before the process continues to the
next step:

◦ Wait from: Select the action that triggers the process to begin waiting for the event.

◦ How Long: Select how long the step should wait until continuing to the next step:
◦ Specific Time: Select the amount of time (number of days, hours, minutes quarters,

weeks, years) to use for the calculation. You can also define this option based on a
specified time before or after a Calendar item.

◦ Field Based: Select a Calendar or SLA Field to use for the calculation. If you select
an SLA Field, you also have the option to define the time increment (Days, weeks,
etc.) and/or the specific time before or after another another Calendar item

◦ SLA Based: Select a defined SLA to use for the calculation.

◦ No Time Limit. (Default)

6. Select OK.
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Define a Wait for Time or Event for an Automation
Process Visual Workflow Process

Use the Events section of the Automation Process Visual Workflow Process Designer to define a wait for
time or event, which includes the steps that wait for a defined time or event (whichever occurs first) before
the process continues to the next step.

Good to know: As you drag the icon onto the Designer Board, the locations where the icon can be
dropped highlight as the cursor passes over them.

To define Automation Process Visual Workflow Process Event options:

1. Open the Automation Process Visual Workflow Process Designer.

2. Click-and-drag the Wait for Time or Event icon  onto the Designer Board.

The Wait for Event - Event page opens in the Current Step Details section of the designer.

3. From the Wait from list, select the amount of time that the Automation Process should wait before
watching for the process trigger.

4. Select an event to use to activate the Automation Process.

Event Type Description

<Business Object> Changed

◦ Any Change: The Automation Process will
begin if any change is made to the <Business
Object>.

◦ Field Changed: The Automation Process will
begin if the selected Field is altered.

Note:You have the option to define if the
Automation Process should operate when any
change is made to the Field, if the Field
changes to a value, if the Field changes from
a value, or is the Field changes from one
value to another.

<Business Object> Closed The Automation Process will begin when a
<Business Object> is closed.

<Business Object> Reopened The Automation Process will begin when a
<Business Object> is reopened.
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Event Type Description

Related Child Event

Select the Relationship, and then select the type of
change that will trigger the Automation Process to
operate:

◦ <Business Object> Added

For Relationships that use direct links, events
are created when the parent Business Object
is saved.

For Relationships that use join tables, events
are created when each link is saved.

For one-to-many Relationships, you can
select the First <Business Object> Only
check box to trigger the event for only for the
first Business Object child created for the
Relationship.

◦ <Business Object> Record Modified

◦ <Business Object> Record Field Change

You can define if the Automation Process
should operate when any change is made to a
specified Field, if the Field changes to a
value, if the Field changes from a value, or if
the Field changes from one value to another.

Also, the event will only fire if the Business
Object is modified while working on the
parent. For example, if you edit an Approval in
the Arrangement below a Change Request,
the event will fire, but if you edit the Approval
by alone it will not). If you encounter either
scenario, then a direct event associated with
an Approval should be created.

Queue Event

◦ Queue Event: Select the type of Queue event
that will trigger the Automation Process to
operate (Record Added to Queue or Record
Removed from Queue).

◦ Which Queue: Select the type of Queue that
should be considered (Any Queue, User
Queue, Team Queue, or Specific Queue).
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5. Click the Time Limit page in the left pane of the Current Step Details section to define a time limit
for the step.

Note: If you select any option in this section other than No Time Limit, the Wait for Event
Step will change to Wait for Time or Event and a new Wait for Time branch will appear on
the Designer Board.

◦ Wait for Time: Step that waits for a defined amount of time before the process continues to the
next step.

◦ Wait from: Select the action that triggers the process to begin waiting for the event.

◦ How Long: Select how long the step should wait until continuing to the next step:
◦ Specific Time: Select the amount of time (number of days, hours, minutes quarters,

weeks, years) to use for the calculation. You can also define this option based on a
specified time before or after a Calendar item.

◦ Field Based: Select a Calendar or SLA Field to use for the calculation. If you select
an SLA Field, you also have the option to define the time increment (days, weeks,
etc.) and/or the specific time before or after another another Calendar item

◦ SLA Based: Select a defined SLA to use for the calculation.

◦ No Time Limit. (Default)

6. Select OK.
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Define Automation Process Visual Workflow
Actions

Use the Actions section of the Automation Process Visual Workflow Process Designer to define one or
more Actions, which occur as a result of a time or event trigger.

Good to know:

• If you want more than one Action to take place, drag additional Actions onto the Designer Board and
organize them as desired. You can change the behavior of an Action in the Current Step Details
pane below the Designer Board. Alternatively, you can double-click the Action to view an associated
Manager or editor for the Action (example: One-Step Action Manager).

• When you click-and-drag a Jump Step onto the Designer Board, the Jump icon  displays on
steps that allow the Action.

To define Automation Process Visual Workflow Process Actions:

1. Open the Automation Process Visual Workflow Process Designer.

2. Click-and-drag one or more Actions to the Designer Board:
◦ Run One-Step Action: Run an One-Step Action when the defined time or event occurs.

◦ Send E-mail: Send an e-mail when the defined time or event occurs to inform a User that the
event has taken place. Edit the e-mail content by clicking the Send E-mail link in the Execute
Action Field.

◦ Tweet: Compose a Tweet to inform Users or Customers that an event has taken place. Edit
the Tweet by clicking the Send Tweet link in the Execute Action field.

◦ Update Bus Ob: Update a Field in a Business Object. Edit the Business Object by clicking the
Update Business Object link in the Execute Action field.

◦ Create Child: Create a Child Business Object (example: Journal, Task, Customer Survey). Edit
the Child Business Object by clicking the Create Child Business Object link in the Execute
Action field.

◦ Queue Action: Add the Record to a specific Queue.

◦ Jump to Step: Jump to a specific step in the Automation Process. Select the step using the
drop-down.

◦ Jump to End: End the Automation Process if the previous step takes place.

3. Select OK.
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Automation Process Visual Workflow Process
Designer

A Visual Workflow Process defines a sequence of time-based and Event-based steps that manage a
Business Object as it passes through various stages. The Visual Workflow Process Designer is a tool that
allows you to easily create simple or complex automation processes to help manage workflows in CSM.

1. Toolbar:

Commonly used Visual Workflow Process Designer tasks.

2. Aerial View:

View the entire process as you zoom in and out. Also allows you to move the section of the current
process on the Designer Board.
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3. Designer Board:

A visual representation of the process.

4. Events Pane:

Time and event options that trigger an Action to occur.

5. Actions Pane:

Actions that take place as a result of a time or event trigger.

6. Step Details:

Details of the currently selected step in the process.

A new Automation Process Visual Workflow Process Designer Board includes the following elements:
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1. Start Graphic:

Event or starting point that initiates the process.

Note: Select the Start Graphic on the Designer Board to define general properties for the
process.

2. Placeholder Graphic:

Holds the steps (Events and/or Actions) that constitute the process.

3. End Graphic:

Indicates the end of the process.
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Automation Process Visual Workflow Process
Designer Toolbar

Button Action Description

Save Saves the current process (CTRL+S).

Undo Undoes the last change to the current process (CTRL
+Z).

Redo Redoes the last change to the process (CTRL+V).

Add a Child Step Add a new Child (Event or Action) to the currently
selected step.

Delete Deletes the currently selected step/Action, the step/
Action and children, or the entire diagram.

Edit Properties for the
Process

Edit Visual Workflow Process Properties, including
name, description, Business Object, and execution
priority.

Define Preferences for
the Designer/Editor

Edit Designer/Editor options, including layout, arrow
options, size, and animation.

Increases or decreases the size of the diagram on the
Designer Board.
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Configuring Automation Processes
Complete the following procedures to configure Automation Processes. Configuration procedures are
completed in CSM Administrator.

To configure Automation Processes:

1. Configure Automation Process Blueprint security rights: Configure who can access Automation
Process Blueprint functionality.

2. Configure the Automation Process Server security rights: Configure who can access Automation
Process Service functionality.
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Webhooks
Use webhooks to integrate CSM with external tools using HTTP POST methods to send data to a CSM
webhook endpoint. A One-Step Action assigned to each endpoint determines how the data is consumed
by CSM.

For example, use a webhook to update a CSM Incident with information from a Jira issue based on a
defined event in Jira. Once the Jira event is triggered, data is sent to the CSM, which fires a CSM to
update mapped Fields in the Incident.

Related concepts
About Webhooks in CSM
Webhooks Process
Configure One-Step Actions for Webhooks
Related tasks
Create a Webhook Endpoint
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About Webhooks in CSM
Webhooks process incoming messages triggered by events fired in third-party tools and sent to a CSM
endpoint. Incoming data must be valid JSON or XML. You can configure webhook endpoints to use no
authentication or basic authentication.

Webhooks Processing
Incoming webhooks are processed by the Cherwell REST API, which:

• Validates that the information passed to it is a valid webhook and that a valid URL is provided.

• Validates that the format type declared in an incoming message header matches the body format. If
they do not match, the request is rejected.

• Validates an incoming message does not exceed the webhook limit specified for your system. This
limit is set on the Set REST API URL and Webhook Settings dialog. The default size limit is 100,000
characters. For more information, see Set the Base URL for the Cherwell REST API.

• Provides a response code to the sender.

For more information, see Webhook Logging.

Parsing JSON or XML Data
Webhooks use JSON and XML Modifiers configured for One-Step Actions to parse, change, and use data
between an external tool and CSM. For JSON, incoming data must be either a valid JSON object or array.

Use these methods to convert valid JSON or XML strings into data that CSM can consume:

1. Use the Update Variables or Stored Values Action
Use this Action to create a variable that declares a data type of JSON, JSON Array, XML, or XML
Collection and holds valid string data of the selected data type. Place the Action at the beginning of
a One-Step Action to ensure the variable is available to all Actions through the Token menu. For
more information, see Define an Update Variables or Stored Values Action.

2. Use a Token as a Webhook Value
Create a webhook body token and add JSON or XML Modifiers to parse data as part of a One-Step
Action. When you create the first Modifier, select As JSON or As XML to declare the data type. You
can then chain Modifiers below that to parse complex data sent to the webhook. For more
information, see Webhook Modifier Examples.

Webhooks Authentication
The type of authentication you set for your webhook endpoint depends on the third-party tool from which
events are fired.

For example, Amazon Simple Notification Services (SNS) uses basic authentication for webhooks. Other
tools, such as Jira Software, can use no authentication.
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Using CSM Webhooks with Amazon Web Services (AWS)
CSM can use Amazon Simple Notification Services (SNS) as a webhook provider.

SNS initiates events by sending an unauthorized request to CSM. The Cherwell REST API sends a 401
response and sets the header to basic authentication. Amazon then resends the message with
authentication information. The Amazon URL should include authentication information in this format:
https://username:password@webhook_endpoint.

Note: When a webhook is configured for Basic Authentication and uses Amazon SNS as a
provider type, certain special characters in the username or password fields must be UTF-8
encoded when the subscription request is performed by Amazon.
Form example: https://CSM_User:p%40assword@yourcompany.com/webhookendpoint
Should be encoded as: https://CSM%5FUser:p%40ssword@yourcompany.com/
webhookendpoint

You should configure webhook endpoints in CSM before configuring the subscription in Amazon.
Endpoints must be in HTTPS format.

When you create a webhook in CSM, select Amazon SNS from the Provider Type drop-down list on the
General page of the Webhook dialog. For more information, see Create a Webhook Endpoint.

Related concepts
Manage Webhooks
Webhooks Security Rights
Webhook Modifier Examples
Webhook Logging
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Webhooks Process
The general process for implementing webhooks is to configure security and applicable CSM services, set
the base URL for the Cherwell REST API, configure a webhook endpoint, and use One-Step Actions with
Modifiers to map data between an external tool and CSM.

Task Notes

1. In CSM Administrator, grant webhooks security rights
to:

• Users who will manage webhooks

These are typically administrators or developers
who will be creating webhooks, mapping data
between CSM and the external tool, etc. Grant
webhooks managers rights to view, add, edit, and
delete webhooks as appropriate.

• Anonymous Browser Security Group

You must grant View rights to this group before
POST requests can be sent to webhooks.

See Webhooks Security Rights.

2. Verify that these services are configured and running:

• Cherwell Message Queue Service

• System Event Processing Service (a microservice
of the Cherwell Service Host)

• Cherwell Service Host

See:

Configure CherwellMQS/RabbitMQ

Enable the System Event Processing Service

Configure the Cherwell Service Host

3. Verify the base URL for the Cherwell REST API and
maximum webhook content length. See Set the Base URL for the Cherwell REST API.

4. In CSM Administrator, create a webhook endpoint. See Create a Webhook Endpoint.

5. Create a One-Step Action that includes JSON or XML
modifiers on the webhook body token to parse data from
an external tool to CSM records.

See Configure One-Step Actions for Webhooks.

6. Create an event in the external tool that will post to
CSM, and capture the JSON and XML data that will be
sent to CSM.

See the documentation for the external tool.

7. Test the One-Step Action assigned to your webhook
using the data captured from the external event.

See Test One-Step Actions Assigned to Webhook
Endpoints.
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Task Notes

8. Modify data mapping as needed. See Webhook Modifier Examples.

Related concepts
Configure One-Step Actions for Webhooks
Webhook Modifier Examples
Related tasks
Create a Webhook Endpoint
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Enable the System Event Processing Service
The System Event Processing Service is used primarily for webhooks and must be manually enabled
before incoming events can be processed. The other services used for webhooks (Cherwell Service Host
and Cherwell Message Queue Service) are typically enabled for most CSM systems, but you should verify
this.

To enable the System Event Processing Service:

1. Log in to a CSM server instance.

2. Search for or navigate to the Cherwell Server Manager.

3. From the Server drop-down list, select Cherwell Service Host.

4. Select the Configure button in the top section.

5. Select the Advanced Settings button.

6. Select the System Event Processing Service check box.

7. Select OK.

8. When you are prompted to restart the server, select Yes.

Related concepts
Using the Server Manager
About the Cherwell Service Host
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Manage Webhooks
Use the Webhooks Manager to add, edit, and delete webhook endpoints.

Related concepts
About Webhooks in CSM
Webhooks Security Rights
Webhook Modifier Examples
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Open the Webhooks Manager
The Webhooks Manager is only available in CSM Administrator.

To open the Webhooks Manager:

1. From the main window, select the Browser and Mobile category, and then select Open Webhook
Manager.

2. From a Blueprint or mApp Solution, select Managers > Webhooks.

Related concepts
About Webhooks in CSM
Webhooks Process
Configure One-Step Actions for Webhooks
Related tasks
Create a Webhook Endpoint
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Create a Webhook Endpoint
Create a webhook endpoint that can receive data from an external tool using HTTP POST methods.
Specify a One-Step Action that determines how the data is consumed by CSM. Each webhook can use
basic authentication or no authentication.

Good to Know

• Webhooks require that One-Step Actions include Modifiers to map data in the third-party tool to
CSM fields. For guidance on configuring One-Step Actions for webhooks, see Configure One-Step
Actions for Webhooks. For Modifier examples, see Webhook Modifier Examples.

• The Base URL for the Cherwell REST API must be set before you can create a functional webhook.
See Set the Base URL for the Cherwell REST API.

• To ensure that webhooks run for specific cultures, create a webhook endpoint for each culture. This
is useful for using the same One-Step Action for several culture-specific webhooks.

To create a webhook endpoint:

1. Open the Webhooks Manager. See Open the Webhooks Manager.
2. Select a folder in the left pane, and then select Create.
3. Provide a name and description.
4. From the Provider Type drop-down list, select one of these options:

◦ Amazon SNS: Select this option to use the Amazon Simple Notification Services (SNS). If you
select this option for the webhook and the received request is not from Amazon SNS, the
request fails and an error message is added to the Cherwell REST API log. For guidance on
using webhooks with Amazon SNS, see Using CSM Webhooks with Amazon Web Services
(AWS).

◦ Slack: Select this option to use Slack. If you select this option for the webhook and the
received request is not from Slack, the request fails and an error message is added to the
Cherwell REST API log.

◦ Other: Select this option to use any third-party provider.
5. In the Endpoint Extension field, provide text that uniquely identifies the webhook. The extension

you provide is combined with the Base URL for the Cherwell REST API to form the full endpoint
provided to an external tool.

Note: The endpoint extension cannot be empty or include special characters, including
spaces.

6. Copy the Full Endpoint. You will need it to configure the event in an external tool.
7. Select the Authentication page, and then select one of these options from the Authentication Type

drop-down list:
◦ None
◦ Basic: Select this option when basic authentication is sent in the header of the HTTP request.

Provide a user name and password. The user name does not need to be a CSM account, but
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the password must comply with CSM password complexity settings. See Configure Cherwell
Credential Settings (User/Customer Password Rules).

◦ Slack: If you select this option, you must enter the Signing Secret that you copied from the
Slack App. This is the key used to verify the authenticity of messages coming from Slack.

This option is only available when the Provider Type is Slack.

8. Select the Action page, and from the Run a One-Step drop-down list, select the One-Step Action
that is configured to run for the webhook. You can also select the Ellipses to open the One-Step
Manager, and then select a One-Step Action or create a new one.

9. From the Culture drop-down list, select the culture to use when the webhook is run. You can also
clear the selected culture.

10. Select the Test One-Step button to test data mapping between an external tool and Modifiers added
to the selected One-Step Action. For testing instructions, see Test One-Step Actions Assigned to
Webhook Endpoints.

11. Select OK.

Related concepts
About Webhooks in CSM
Configure One-Step Actions for Webhooks
Webhook Modifier Examples
Related tasks
Test One-Step Actions Assigned to Webhook Endpoints
Related information
JSON Modifiers
XML Modifiers
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Configure One-Step Actions for Webhooks
Webhooks can be used with any One-Step Action that support Tokens.

For example, you can:

• Use a Create a New Business Object or Update a Business Object Action to add data from an
external tool to CSM records.

• Use a Send an Email Action to send data from an external tool as contents of an email message.

• Use a Write to a File Action to add data from an external tool to a file.

• Use the Decide Between Multiple Cases Action to create an Incident in CSM from Slack.

One-Step Actions used by webhooks must include JSON or XML Modifiers on the webhook body token to
parse data from an external tool to CSM records. You must identify the data type and the value to return.
In some cases, you must also identify the element.

You can configure One-Step Actions from the One-Step Manager while you are:

• Configuring a webhook endpoint.

• Working in a Blueprint or mApp Solution.

• Working with One-Step Actions in the CSM Desktop Client.

Create a One-Step Action from a Webhook Endpoint
To configure a One-Step Action from a webhook endpoint:

1. Open the Webhooks Manager.

2. Create a new webhook endpoint or edit an existing webhook endpoint.

3. Select the ellipses next to the Run a One-Step drop-down list.

4. From the One-Step Manager, create or edit a One-Step Action.

5. Select the Start Graphic.

6. In the Step Details section, select the Conditions page.

7. From the Show custom tokens drop-down list, select Webhook.

Use a Variable to Parse Incoming Data
To ensure that all Actions in a One-Step Action have access to webhook modifiers through the token
menu, add an Update Variables and Stored Values Action as the first Action.

To add an Update Variables and Stored Values Action:

1. On the Designer Board, add an Update Variables or Stored Values Action as the first Action.

2. Provide a name for the Action.
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3. Select the Variable option, and then provide a name for the variable.

4. From the Data Type drop-down list, select one of these options: JSON, JSON Array, XML, or XML
Collection.

5. Right-click in the New Value box, and then select Webhook Content > Value.

6. Double-click Body, and then add Modifiers as needed. For guidance on creating Modifiers, see
Webhook Modifier Examples.

7. Save the Action.

As you configure other Actions in the One-Step Action, the variable will be available in the Token menu.

Use a Webhook Token to Parse Incoming Data
From a One-Step Action that supports tokens, right-click in the content area to open the Token menu, and
then add the Webhook Content > Value token.

For example, to add a webhook token to Business Object Action:

1. Select the Fields page.

2. From the Fields list, select the Text Field that will store the data from the webhook.

3. From the Value options, select Template.

4. Right-click in the box, and select Webhook Content > Body.

5. Double-click the Body token.

6. Add Modifiers to parse the incoming data. For examples, see Webhook Modifier Examples.

Related concepts
Webhook Modifier Examples
Related tasks
Open the Webhooks Manager
Create a Webhook Endpoint
Related information
Create/Edit a One-Step Action
JSON Modifiers
XML Modifiers

711

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_modifier_examples
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_modifier_examples
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fwebhooks%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fwebhooks%2Fcsm_modifier_examples.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fwebhooks%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fwebhooks%2Fcsm_open_webhooks_manager.html
https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fwebhooks%2F..%2F..%2F..%2Fcontent%2Fsystem_administration%2Fwebhooks%2Fcreate_a_webhook_endpoint.html
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create-edit_a_one-step
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=json_modifiers
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=xml_modifiers


Webhook Modifier Examples
Webhook Modifier examples vary from simple JSON and XML POST messages to complex examples
using POST messages from Amazon Simple Notification Service (SNS) and Jira Software.

The examples are intended to provide guidance for using Modifiers to extract JSON or XML data into a
format usable for CSM. For guidance on using Modifiers of different types, see JSON Modifiers and XML
Modifiers.

Simple JSON POST Request
This example shows how to extract this JSON notes data to a Text Field in a Business Object record:
"notes": "The customer would like to buy a Silver membership.",
Post data:

    {
        "id": "944ff7dfc501391af808764a02ab2fcd4c",
        "firstname": "Jason",
        "lastname": "Taylor Sr.",
        "email": "jason.taylor2@gmail.com",
        "siteid": 46,
        "notes": "The customer would like to buy a Silver membership.",
        "currentdatetime": "07-21-2019",
        "customertypeid": 142
    }

Modifier sample:

This example requires two Modifiers: one to declare the data type as JSON and another to map the notes
data to a Text Field in a Business Object.

Modifier Type Value, Element, etc. Notes

As JSON() N/A Declares the incoming data as
JSON.

JSON Path (value) notes Maps the notes data to the
selected Text Field.

712

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=json_modifiers
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=xml_modifiers
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=xml_modifiers


Simple XML POST Request
This example shows how to extract this XML notes data to a Text Field in a Business Object record.
<notes>The customer would like to buy a Silver membership.</notes>
Post data:

<List>
<item>

<id>944ff7dfc501391af808764a02ab2fcd4cd</id>
<firstname>Jason</firstname>
<lastname>Taylor</lastname>
<email>jason.taylor2@gmail.com</email>
<siteid>46</siteid>
<notes>The customer would like to buy a Silver memb

ership.</notes>
<currentdatetime>07-21-2019</currentdatetime>
<customertypeid>142</customertypeid>

</item>
</List>

Modifier sample:
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This example requires three Modifiers: one to declare the data type as XML, one to find the item element,
and one to map the notes data to a Text Field in a Business Object.

Modifier Type Value, Element, etc. Notes

As XML() N/A Declares the incoming data as
XML.

Find Element item Finds the item element in the
POST data.

XPath (value) () notes Maps the notes data to the
selected Text Field

Complex JSON Post Request (Amazon)
This example shows how to extract this JSON notes data to a Text Field in a Business Object record:
\"notes\": \"The customer would like to buy a Silver membership.
The sample data is from Amazon Simple Notification Service (SNS).

Post data:

{
  "Type" : "Notification",
  "MessageId" : "8db3250a-9ce2-588f-9746-70cde0de2aa0",
  "TopicArn" : "arn:aws:sns:us-west-2:000000000000:New_Customer_Object_AWS_
JSON",
  "Message" : "    {\n        \"id\": \"944ff7dfc501391af808764a02ab2fcd4c\
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",\n        \"firstname\": \"Marie\",\n        \"lastname\": \"Smith\",\
n        \"email\": \"marie.smith@gmail.com\",\n        \"siteid\": 46,\
n        \"notes\": \"The customer would like to buy a Silver membership.\"
,\n        \"currentdatetime\": \"07-21-2019\",\n        \"customertypeid\"
: 142\n    }",
  "Timestamp" : "2019-08-09T13:49:48.167Z",
  "SignatureVersion" : "1",
  "Signature" : "RoPT3rzdzZFptij0j8HpR53dBjeABhAiJ/9+y6YNdsHBWJzFJY0djUQAUr
5zyCujh9qHXXWUgHR07KPhq2YrKoO35nPVoKgIyLzVfGiTacRHpMv9+irc7qBihn+c9eb4cJdsa
RoiS+wRZGdBqnN0w4QXWf/cOnwInIHpkhNpKz2i8xCUQT/yRzUaMRbgGT+wZrtHfhwwhuUEXvli
F+Mp78zxwBGYpNQxyblMneVskroYyaZhjBb6Sl7bOLlF9AvW5riasiUnGlsbxrf9lS7FDE074fR
61bKfNhR0lGYdl4/T0lYceJU+E6tWC5PKKuiqWyArnNaLdJM0tycM7fFSAw==",
  "SigningCertURL" : "https://sns.us-west-2.amazonaws.com/SimpleNotificatio
nService-6aad65c2f9911b05cd53efda11f913f9.pem",
  "UnsubscribeURL" : "https://sns.us-west-2.amazonaws.com/?Action=Unsubscri
be&SubscriptionArn=arn:aws:sns:us-west-2:330538622256:New_Customer_Object_A
WS_JSON:1a7a7e5e-2d54-4723-a9d7-3aec73648792"
}

Modifier sample:

This example requires three Modifiers: one to declare the data type as JSON, one to find message object,
and one to map the notes data to a Text Field in a Business Object.

Modifier Type Value, Element, etc. Notes

As JSON() N/A Declares the incoming data as
JSON.

Find Object (Message) item Finds the item element in the
POST data.

JSON Path (value)(notes) notes Maps the notes data to the
selected Text Field.
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Complex XML POST Request (Amazon)
This example shows how to extract this XML notes data to a Text Field in a Business Object record.
<notes>The customer would like to buy a Gold membership.</notes>
The sample data is from Amazon Simple Notification Service (SNS).

Post data:

{
  "Type" : "Notification",
  "MessageId" : "1582a97c-dd2d-5fd5-abf5-fcbba01b3861",
  "TopicArn" : "arn:aws:sns:us-west-2:330538622256:New_Customer_Object_AWS_
XML",
  "Message" : "\t<List>\n\t\t<item>\n\t\t\t<id>944ff7dfc501391af808764a02ab
2fcd4cd</id>\n\t\t\t<firstname>Jason</firstname>\n\t\t\t<lastname>Taylor</l
astname>\n\t\t\t<email>jason.taylor2@gmail.com</email>\n\t\t\t<siteid>46</s
iteid>\n\t\t\t<notes>The customer would like to buy a Gold membership.</not
es>\n\t\t\t<currentdatetime>07-21-2019</currentdatetime>\n\t\t\t<customerty
peid>142</customertypeid>\n\t\t</item>\n\t</List>",
  "Timestamp" : "2019-08-09T13:53:58.341Z",
  "SignatureVersion" : "1",
  "Signature" : "aSOnIPCzJWj8uC4l5wBhDOoAwOCVEUuqnTIs2axWk0FDJhpLLJiVfnJ571
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GhFQw7j5QQC9fxqyUNl+M8guBfaGv5WylfZqf3nAHYYFauSOoq9kkieVrezNjvtROJGZwkyHxNj
xw0/MPTTgz60IcBrJlwK2/jur5EcFuqvyeqdn6wUowe2u1Sbo+C5E6QORsY9T/2fqTMRtA02uUw
exaIBgBp/xVb+6yXT8AlvwptHoFjV0SCySL1H0SNANuzvFtBQ7r49XRhIjgGWD9B/9RIp8dr9GE
yXtTCe+saN6KLNIynnwb1VJGDt+eMRr3nalsWZ4huwOd7vBuamNotYIB6Wg==",
  "SigningCertURL" : "https://sns.us-west-2.amazonaws.com/SimpleNotificatio
nService-6aad65c2f9911b05cd53efda11f913f9.pem",
  "UnsubscribeURL" : "https://sns.us-west-2.amazonaws.com/?Action=Unsubscri
be&SubscriptionArn=arn:aws:sns:us-west-2:330538622256:New_Customer_Object_A
WS_XML:ebed2bfb-2ec4-4085-934e-c49fc71b79bc"
}

Modifier sample:

Because SNS encapsulates all data as JSON, this example requires five Modifiers: one to declare the
data type as JSON, one to one to return a value based on the supplied JSON path, one to declare the
data inside the JSON as XML, one to find the item element, and one to map the notes data to a Text Field
in a Business Object.

Modifier Type Value, Element, etc. Notes

As JSON() N/A Declares the incoming data as
JSON.

JSON Path (value)(message) message Returns a value based on the
supplied JSON path.

As XML() N/A Declares the data inside the JSON
as XML.

Find Element (item) item Finds the item element in the POST
data.

XPath (value)(notes) notes Maps the notes data to the selected
Text Field.
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Complex JSON Post Request (Jira Software)
This example shows how to extract this JSON changelog data (shown in bold text below) to a Text Field in
a Business Object record.
{ "field": "description", "fieldtype": "jira", "fieldId": "description",
"from": null, "fromString": null, "to": null, "toString": "This is the
description field for a new JIRA issue request." },
The sample data is from Jira Software.

Post data:

{
    "timestamp": 1564693604774,
    "webhookEvent": "jira:issue_created",
    "issue_event_type_name": "issue_created",
    "user": {
        "self": "https://webhookstest.atlassian.net/rest/api/2/user?account
Id=557058%3A57f5e298-87a6-4fc8-87d7-d7ab15be260e",
        "name": "Jill Hanson",
        "key": "jill.hanson",
        "accountId": "557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e",
        "emailAddress": "jill.hanson@example company.com",
        "avatarUrls": {
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            "48x48": "https://avatar-management--avatars.us-west-2.prod.pub
lic.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e82-479b-
4034-950e-6fce17dc2d89/128?size=48&s=48",
            "24x24": "https://avatar-management--avatars.us-west-2.prod.pub
lic.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e82-479b-
4034-950e-6fce17dc2d89/128?size=24&s=24",
            "16x16": "https://avatar-management--avatars.us-west-2.prod.pub
lic.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e82-479b-
4034-950e-6fce17dc2d89/128?size=16&s=16",
            "32x32": "https://avatar-management--avatars.us-west-2.prod.pub
lic.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e82-479b-
4034-950e-6fce17dc2d89/128?size=32&s=32"
        },
        "displayName": "Jill Hanson",
        "active": true,
        "timeZone": "America/Denver",
        "accountType": "atlassian"
    },
    "issue": {
        "id": "10006",
        "self": "https://webhookstest.atlassian.net/rest/api/2/issue/10006"
,
        "key": "TES-7",
        "fields": {
            "statuscategorychangedate": "2019-08-01T15:06:44.856-0600",
            "issuetype": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/issu
etype/10001",
                "id": "10001",
                "description": "Stories track functionality or features exp
ressed as user goals.",
                "iconUrl": "https://webhookstest.atlassian.net/secure/viewa
vatar?size=medium&avatarId=10315&avatarType=issuetype",
                "name": "Story",
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                "subtask": false,
                "avatarId": 10315
            },
            "timespent": null,
            "customfield_10030": null,
            "project": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/proj
ect/10000",
                "id": "10000",
                "key": "TES",
                "name": "JIRA issue summary information",
                "projectTypeKey": "software",
                "simplified": false,
                "avatarUrls": {
                    "48x48": "https://webhookstest.atlassian.net/secure/pro
jectavatar?pid=10000&avatarId=10409",
                    "24x24": "https://webhookstest.atlassian.net/secure/pro
jectavatar?size=small&s=small&pid=10000&avatarId=10409",
                    "16x16": "https://webhookstest.atlassian.net/secure/pro
jectavatar?size=xsmall&s=xsmall&pid=10000&avatarId=10409",
                    "32x32": "https://webhookstest.atlassian.net/secure/pro
jectavatar?size=medium&s=medium&pid=10000&avatarId=10409"
                }
            },
            "fixVersions": "9.7.0",
            "aggregatetimespent": null,
            "resolution": null,
            "customfield_10027": null,
            "resolutiondate": null,
            "workratio": -1,
            "watches": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/issu
e/TES-7/watchers",
                "watchCount": 0,
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                "isWatching": true
            },
            "lastViewed": null,
            "created": "2019-08-01T15:06:44.730-0600",
            "customfield_10020": null,
            "customfield_10021": null,
            "customfield_10022": null,
            "customfield_10023": null,
            "priority": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/prio
rity/3",
                "iconUrl": "https://webhookstest.atlassian.net/images/icons
/priorities/medium.svg",
                "name": "Medium",
                "id": "3"
            },
            "customfield_10024": null,
            "customfield_10025": [],
            "customfield_10026": null,
            "labels": [],
            "customfield_10016": null,
            "customfield_10017": null,
            "customfield_10018": {
                "hasEpicLinkFieldDependency": false,
                "showField": false,
                "nonEditableReason": {
                    "reason": "PLUGIN_LICENSE_ERROR",
                    "message": "Portfolio for Jira must be licensed for th
e Parent Link to be available."
                }
            },
            "customfield_10019": "0|i0001b:",
            "aggregatetimeoriginalestimate": null,
            "timeestimate": null,
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            "versions": [],
            "issuelinks": [],
            "assignee": null,
            "updated": "2019-08-01T15:06:44.730-0600",
            "status": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/stat
us/10000",
                "description": "",
                "iconUrl": "https://webhookstest.atlassian.net/",
                "name": "Backlog",
                "id": "10000",
                "statusCategory": {
                    "self": "https://webhookstest.atlassian.net/rest/api/2/
statuscategory/2",
                    "id": 2,
                    "key": "new",
                    "colorName": "blue-gray",
                    "name": "New"
                }
            },
            "components": [],
            "timeoriginalestimate": null,
            "description": "test new issue desc",
            "customfield_10010": null,
            "customfield_10014": null,
            "timetracking": {},
            "customfield_10015": null,
            "customfield_10005": null,
            "customfield_10006": null,
            "security": null,
            "customfield_10007": null,
            "customfield_10008": null,
            "attachment": [],
            "aggregatetimeestimate": null,
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            "customfield_10009": null,
            "summary": "my new issue",
            "creator": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/user
?accountId=557058%3A57f5e298-87a6-4fc8-87d7-d7ab15be260e",
                "name": "john.smith",
                "key": "john.smith",
                "accountId": "557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e",
                "emailAddress": "john.smith@example company.com",
                "avatarUrls": {
                    "48x48": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=48&s=48",
                    "24x24": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=24&s=24",
                    "16x16": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=16&s=16",
                    "32x32": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=32&s=32"
                },
                "displayName": "John Smith",
                "active": true,
                "timeZone": "America/Denver",
                "accountType": "atlassian"
            },
            "subtasks": [],
            "reporter": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/user
?accountId=557058%3A57f5e298-87a6-4fc8-87d7-d7ab15be260e",
                "name": "john.smith",
                "key": "john.smith",
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                "accountId": "557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e",
                "emailAddress": "john.smith@example company.com",
                "avatarUrls": {
                    "48x48": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=48&s=48",
                    "24x24": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=24&s=24",
                    "16x16": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=16&s=16",
                    "32x32": "https://avatar-management--avatars.us-west-2.
prod.public.atl-paas.net/557058:57f5e298-87a6-4fc8-87d7-d7ab15be260e/ccb36e
82-479b-4034-950e-6fce17dc2d89/128?size=32&s=32"
                },
                "displayName": "John Smith",
                "active": true,
                "timeZone": "America/Denver",
                "accountType": "atlassian"
            },
            "customfield_10000": "{}",
            "aggregateprogress": {
                "progress": 0,
                "total": 0
            },
            "customfield_10001": null,
            "customfield_10002": null,
            "customfield_10003": null,
            "customfield_10004": null,
            "environment": null,
            "duedate": null,
            "progress": {
                "progress": 0,
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                "total": 0
            },
            "votes": {
                "self": "https://webhookstest.atlassian.net/rest/api/2/issu
e/TES-7/votes",
                "votes": 0,
                "hasVoted": false
            }
        }
    },
    "changelog": {
        "id": "10011",
        "items": [
            {
                "field": "description",
                "fieldtype": "jira",
                "fieldId": "description",
                "from": null,
                "fromString": null,
                "to": null,
                "toString": "This is the description field for a new JIRA i
ssue request."
            },
            {
                "field": "priority",
                "fieldtype": "jira",
                "fieldId": "priority",
                "from": null,
                "fromString": null,
                "to": "3",
                "toString": "Medium"
            },
            {
                "field": "reporter",
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                "fieldtype": "jira",
                "fieldId": "reporter",
                "from": null,
                "fromString": null,
                "to": "john.smith",
                "toString": "John Smith",
                "tmpFromAccountId": null,
                "tmpToAccountId": "557058:57f5e298-87a6-4fc8-87d7-d7ab15be2
60e"
            },
            {
                "field": "Status",
                "fieldtype": "jira",
                "fieldId": "status",
                "from": null,
                "fromString": null,
                "to": "10000",
                "toString": "Backlog"
            },
            {
                "field": "summary",
                "fieldtype": "jira",
                "fieldId": "summary",
                "from": null,
                "fromString": null,
                "to": null,
                "toString": "JIRA issue summary information"
            }
        ]
    }
}

Modifier sample:
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This example requires five Modifiers: one to declare the data type as JSON, one to find the changelog
object, one to declare the data inside the JSON as XML, one to find the item element, and one to map the
notes data to a Text Field in a Business Object.

Modifier Type Value, Element, etc. Notes

As JSON() N/A Declares the incoming data as
JSON.

Find Object (changelog) changelog Finds the changelog element in the
POST data.

Find Array (items) items Finds and returns a JSON array for
items.

Goto Array Index (0) 0 Returns a new JSON object of the
indexed object in the arrary.

Find Object (toString) toString Maps the toString data to the
selected Text Field.

Simple JSON Post Request (Slack)
This example shows how to extract this JSON event and user data to a Text Field in a Business Object
record:
"event": { "client_msg_id": "db93027c-b354-4bc4-b583-75caeafc5204", "type":
"app_mention", "text": "<@USY1K9YHH> create incident My printer doesn't work",
"user": "USDKMAUSV", "ts": "1580746614.000400", "team": "TSRMJ2UTZ", "blocks":
[ {
The sample data is from Slack.
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Post data:

{
  "token": "6EK61SvTDR1tOLA1gBTm0wU1",
  "team_id": "TSRMJ2UTZ",
  "api_app_id": "AT91HES6Q",
  "event": {
    "client_msg_id": "db93027c-b354-4bc4-b583-75caeafc5204",
    "type": "app_mention",
    "text": "<@USY1K9YHH> create incident My printer doesn't work",
    "user": "USDKMAUSV",
    "ts": "1580746614.000400",
    "team": "TSRMJ2UTZ",
    "blocks": [
      {
        "type": "rich_text",
        "block_id": "SkD",
        "elements": [
          {
            "type": "rich_text_section",
            "elements": [
              {
                "type": "user",
                "user_id": "USY1K9YHH"
              },
              {
                "type": "text",
                "text": " create incident My printer doesn't work"
              }
            ]

Modifier sample:

This example requires three Modifiers: one to declare the data type as JSON, one to find the event object,
and one to find the user object.
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Modifier Type Value, Element, etc. Notes

As JSON() N/A Declares the incoming data as
JSON.

Find Object (event) item Finds the item element in the
POST data.

Find Object (user) item Finds the item element in the
POST data.

Related concepts
Configure One-Step Actions for Webhooks
About Webhooks in CSM
Related tasks
Test One-Step Actions Assigned to Webhook Endpoints
Related information
JSON Modifiers
XML Modifiers
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Test One-Step Actions Assigned to Webhook
Endpoints

You can pass JSON or XML sample data to test data mapping between an external tool and Modifiers
added to a One-Step Action. This enables you to verify that the One-Step Action is valid before you send
events from an external tool.

To test One-Step Actions assigned to webhook endpoints:

1. Open the Webhooks Manager, and then edit the webhook endpoint you want to test.
2. Select the Run One-Step button.
3. Paste valid JSON or XML that you expect to be sent from the external tool to the CSM webhook

endpoint.

4. Select Run.
5. View the results in the bottom of the dialog. If the One-Step Action and Modifiers are not configured

correctly, review the messages and adjust the Modifiers in your One-Step Action as needed.

Related concepts
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Configure One-Step Actions for Webhooks
Webhook Modifier Examples
Related tasks
Open the Webhooks Manager
Create a Webhook Endpoint
Related information
Create/Edit a One-Step Action
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Configure a Slack Workspace for Webhooks
Create and configure a Slack webhook and workspace to integrate CSM with Slack.

After configuring a Slack webhook and workspace, you can use the Slack integration to interact with
CSM. Use a bot user token to perform a variety of functions in CSM. Some examples include:

• Create Incidents

• Check the status of Incidents

• Withdraw Incidents

For example, users can create an Incident from a request sent from the Slack workspace. CSM creates
the Incident and replies to Slack via the REST API and posts the message with an Incident number. If the
customer wants to know the status of an Incident, they can send the request from the Slack workspace.
CSM replies to Slack via the REST API and posts the message with the status and priority of the Incident.
If the customer no longer needs the Incident, the user can send the Slack request to withdraw the
Incident.

Before configuring, you will need to:

1. Verify that you have administrative rights to the Slack workspace.

2. Create a Slack application.
See https://api.slack.com/start/overview#auth.

3. Copy the Signing Secret. You will add this to CSM.

To configure CSM for the Slack webhooks integration:

1. Verify the Webhooks Security rights.
◦ From the Group drop-down list, select Anonymous Browser and then select the View check

box.

2. Enable the System Event Processing Service.

3. Create a Slack webhook endpoint. This will include selecting the One-Step Action that is configured
to run for the webhook.

To configure Slack for the webhooks integration:

1. Add a bot user token.
See https://api.slack.com/docs/token-types#bot.

2. Set up Event Subscriptions.
See https://api.slack.com/bot-users#setup-events-api.

Note: This is where you will need the Full Endpoint URL from Creating a Webhook Endpoint
in the section above. The endpoint needs to be publicly accessible.

3. Use the OAuth permission scope to subscribe to Bot Events.
See https://api.slack.com/events-api#subscriptions.
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Note: When you add permissions or scopes, the app will need to be reinstalled to the
workspace.

4. Grant the following permissions (scopes) to the bot user token:
◦ app_mentions:read
◦ users:read
◦ users:read:email

Note: When you change the scopes, the app will need to be reinstalled to the workspace.

5. Copy the Bot User OAuth Access Token. You will add this to CSM.

In CSM Administrator, update the Bot User OAuth Access Token Stored Value with the value you just
copied and then publish the Blueprint.

Note: For protection reasons, we recommend storing the Bot User OAuth Access Token Stored
Value in the Blueprint scope.

Related concepts
Enable the System Event Processing Service
Webhooks Security Rights
Related tasks
Create a Webhook Endpoint
Related information
Use Slack in the Related Items Pane
Assign a Value to a Stored Value
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Webhook Logging
Webhooks log information is stored in different locations, depending on the information captured.

• Cherwell REST API log:

Captures validation information from incoming requests. This includes authentication information,
provider type, and Amazon Simple Notification Services (SNS) subscription confirmation.

For example:
◦ Incoming requests that exceed the 100,000 kb size limit are rejected and logged.

◦ If an Amazon SNS signature is missing or invalid, requests are rejected and logged.

◦ A warning is logged on initial requests from Amazon SNS because they are initially sent as
unauthorized. The Cherwell REST API sends a 401 response and sets the header to basic
authentication. Amazon then resends the message with authentication information.

◦ If a webhook uses the provider type of Amazon SNS and the request is not of that type, the
request is rejected and an error is logged.

• System Event Processing Service log:

Captures processing information for requests after they are validated and sent to the queue.

For example:
◦ If the System Event Processing Service is paused, requests are not queued and a 503 error is

logged.

◦ If the System Event Processing Service is enabled but a webhook endpoint is disabled,
requests are not queued and a 404 error is logged.

◦ Once the System Event Processing Service is disabled, requests are queued and are
processed when the service is enabled. No logging occurs in this case.

Related concepts
About Webhooks in CSM
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Related tasks
Configure Logging for the Cherwell REST API
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Scheduler
The Scheduler is a tool that automatically runs defined actions (called Scheduled Items) on a scheduled
basis (example: Back up the database every night at midnight).

Related concepts
Define General Properties for a Scheduled Item
Configure the Cherwell Service Host for a Local Scheduler in a SaaS Environment
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About the Scheduler
The following actions are available from the Scheduler:

• Backup Database: Exports a selected CSM database to a compressed Cherwell Archive
Repository (.czar) file.

• Database Maintenance: Performs selected database maintenance operations (example:
Rebuilding the Full-Text catalog, Rebuilding Indexes and shrinking SQL logs on a scheduled basis).

• Import External Data: Imports data from external databases (example: Active Directory) into CSM.

• Import from File: Imports data from comma separated value (.csv) files into CSM.

• Import from LDAP: Imports LDAP records (example: Customer lists) into CSM.

• One-Step Action: Runs a selected One-Step Action.

• Portal Credentials: Creates Portal login credentials for Customers.

• Publish Blueprint: Publishes Blueprints to your CSM system.

• Report: Runs a selected Report.

Items can be scheduled to run on a recurring basis (daily, weekly, monthly, yearly) or one-time only. The
Scheduler operates within the timeframe of defined Business Hours and can be accessed through CSM
Administrator.

The Scheduler runs in coordination with the Scheduling Service, which is installed with the CSM Server
Installer as a microservice of the Cherwell Service Host.
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Scheduler Good to Know
• Use the Scheduler window in CSM Administrator (CSM Administrator>Scheduling>Edit Schedule) to

use and manage Scheduled Items.

• USe the Server Manager to disable the Scheduling microservice.

• When you view the details of a Scheduled Item, its properties are read-only.

• To view all Scheduled Items for a particular day, use the Calendar of Scheduled Items.

Backup Database Action:

• A nightly database backup is recommended for your CSM database.

• Schedule database backups for after business hours because backups can take significant time and
system resources.

• If a directory does not exist, one will be created on the server where CSM Administrator runs.
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Using the Scheduler
When using the Scheduler, Users can:

• Pause/resume the Scheduling Server.

• View Scheduled Items.

Opening the Scheduler Window
To open the Scheduler window from the CSM Administrator main window, click the Scheduling category,
and then click the Edit Schedule task.

Scheduler Window
Use the Scheduler window to:

• View a list of Scheduled Items, filtered by:
◦ Group: View Scheduled Items for a particular Scheduler.

◦ Action: View Scheduled Items by Action type.

◦ Status: View Scheduled Items by completion status (Pending, Completed, Not Completed).

• Add, edit, delete, and copy Scheduled Items.

• Refresh Scheduled Items and their statuses. If items are running, the Refresh button can be used to
watch the statues change from pending, to running, to complete.

• View the Last Run of a Scheduled Item to see the last time a recurring item was run, its completion
status, or any errors.

• View error(s) of a Scheduled Item that was not completed as expected.

• View the Calendar of Scheduled Items to see all of the items scheduled for a particular day.

• Test a Scheduled Item to ensure all information is available for the item to run regularly

738

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Pause/Resume the Scheduling Service
Use the Pause/Resume Scheduler task in CSM Administrator to temporarily pause and resume the
Scheduling Service.

Notes: Completing this process affects all enabled Scheduled Items. Also, even while the
Scheduling Service is paused, Events will be generated by the system. When the service is
resumed, all Scheduled Items are processed.

To pause/resume the Scheduling Service:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Pause/
Resume Scheduler task.

2. Pause or resume the Scheduling Server:
a. Pause Scheduling Server: Select this check box to pause the Scheduling Server processing.

You must provide a reason for pausing the server in order to complete the process.

b. Resume Scheduling Server: Select this check box to resume Scheduling Server processing.

3. Select OK.
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View Scheduled Items
You can view Scheduled Items in a few ways:

• View the details of a specific Scheduled Item.

• View a Calendar of Scheduled Items to see all items scheduled for a specific day.

• View Errors of a Scheduled Item to see what has interrupted a Scheduled Item's run.
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View a Scheduled Item
Use the Scheduler window to view the details of a Scheduled Item.

To view a Scheduled Item:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Edit
Schedule task.

2. Select a Scheduled Item, and then click the View button.
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View the Calendar of Scheduled Items
Use the Calendar of Scheduled Items to view all items scheduled for a specific day.

To view the Calendar of Scheduled Items:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Edit
Schedule task.

2. Click the Calendar button.

3. Click a date in the Calendar to view a list of the items scheduled for that day.

4. (Optional) Click the Refresh button to update the status of the Scheduled Items for that particular
day.

Note: By default, the Calendar shows every single occurrence of a recurring item. To view only the
next occurrence of a Scheduled Item, select the Only show next occurrence of recurring items
check box.

5. Click Close to close the window.
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View Errors of a Scheduled Item
When a Scheduled Item encounters an error, it will not be scheduled again because it is likely in a state
where it cannot run (example: Shortage of disk space, missing Report, etc.). You can view errors of a
Scheduled Item to investigate the cause of the error.

To view the errors of a Scheduled Item:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Edit
Schedule task.

2. Select an item with an Error status and click View Error.

The Scheduled Item Error window opens to provide details on the error(s) that occurred when the
Scheduler attempted to run the Scheduled Item.

Note: If a Scheduled Item has an error, it will not be scheduled to run again. Select the
Reset to pending status so item will be scheduled again check box to ensure that the
Scheduled Item will run after any errors have been resolved.
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Configuring the Scheduler
To configure the Scheduler in CSM Administrator, configure Scheduler security rights to determine who
can access Scheduler functionality.
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Managing Scheduled Items
Use the Scheduled Items Manager to complete general CSM Item Manager operations for Scheduled
Items.

There are several ways to open the Scheduled Items Manager.
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Open the Scheduled Items Manager
To open the Scheduled Items Manager:

• From the Blueprint Editor menu bar in CSM Administrator, click Managers > Scheduled Items.

• From the mApp Editor menu bar in CSM Administrator, click Managers > Scheduled Items.
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Create a Scheduled Item
Use the Schedule Item Properties window (accessed from within the Scheduler window in CSM
Administrator) to create a Scheduled Item. You can also create a Scheduled Item from the Scheduled
Items Manager (accessed from the Managers menu in the Blueprints Editor and the mApp Solutions
Editor).

When you create a Scheduled Item you define the following properties:

• General: Name and description.

• Schedule: Date/time the Scheduled item is scheduled to run.

• Action: Action the Scheduled Item runs (example: Backup Database).

• Error Handling: Options for handling errors that prevent a Scheduled Item from running.

To create a Scheduled Item from the Scheduler window:

1. In the CSM Administrator main window, select the Scheduling category, and then select the Edit
Schedule task.

2. Select Add.

3. Define Scheduled Item properties:
a. Define general properties for a Scheduled Item.

b. Define schedule properties for a Scheduled Item.

c. Define action properties for a Scheduled Item.

d. Define error handling properties for a Scheduled Item.

4. Select Save.

To create a Scheduled Item from the Managers menu:

From a Blueprint:

1. In the CSM Administrator main window, select the Blueprints category, and then select either the
Create a new Blueprint task or the Open an existing Blueprint task.

2. From the Blueprint Editor menu bar, select Managers > Scheduled Items.

3. Select Create New.

From a mApp Solution:

1. In the CSM Administrator main window, select the mApps category, and then select either the
Create a new mApp task or the Edit an existing mApp task.

2. From the mApp Editor menu bar, select Managers > Scheduled Items.

3. Select Create New.
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Note: When creating a Scheduled Item from the Managers menu, only Scheduled Items with an
Action type of One-Step or Report are available.
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Define General Properties for a Scheduled Item
Use the General page in the Scheduled Item Properties window to define general properties for a
Scheduled Item.

To define General properties for a Scheduled Item:

Schedule Group If only one Schedule Group is used, leave Default selected. If multiple schedulers
are needed, click the Ellipses button to create the different schedule groups.

Name Provide a name for the Scheduled Item.

Description Provide a description for the Scheduled Item.
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Define Schedule Properties for a Scheduled Item
Use the Schedule page in the Scheduled Item Properties window to define the schedule for an item,
including:

• One Time or Recurring: Whether a Scheduled Item will run once or multiple times.

• Scheduled time: Start date and time for the Scheduled Item.

• Recurrence: Daily, Weekly, or Monthly.

• Range of Recurrence: Number or date range for a Scheduled Item's recurrence.

Note: The Scheduled Item Properties window is accessed from within the Scheduler window
in CSM Administrator.

• Maximum time to block other schedules:

To define Scheduling properties for a Scheduled Item:

One time: Select this radio button to schedule the item to run one time. .

Start
Time Specify the time using the arrow buttons or providing the time (example: 12:30 AM).

Time
Zone

Use the drop down to specify a time zone or specify to have the schedule item run on the
same time zone as the schedule server.

Note: The Time Zone feature should only be used with a three-tier connection. A two-tier
connection causes undesired results.

Recurring: Select this radio button to schedule the item to run on a recurring basis.

Schedule Time  

Start time Specify the time using the arrow buttons or providing the time (example: 12:30 AM).

Time zone

Use the drop down to specify a time zone or specify to have the schedule item run
on the same time zone as the schedule server.

Note: The Time Zone feature should only be used with a three-tier connection. A
two-tier connection causes undesired results.

Recurrence Select how often to run the Scheduled Item.

Hourly Run the Scheduled Item every X number of hours (example: Every 24 hours).

Daily Run the Scheduled Item every X number of days (example: Every 7 days) or every
weekday.
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Weekly Run the Scheduled Item every X number of weeks on specific days (example:
Monday, Wednesday, and Friday).

Monthly
Run the Scheduled Item on a specific day of the month (example: Day 1 of every
month) or on a specified week/day of the month (example: First Monday of every 1
month).

Yearly Run the Scheduled Item on a specific date (example: Every January 1) or on a
specific day of the year (example: First Monday of June).

Range of
recurrence: Schedule the amount of time to run a recurring Schedule Item.

No end date The recurrence continues indefinitely.

End after The recurrence ends after a defined number of occurrences. Specify the number of
occurrences.

End by

The recurrences end by a certain date. Then, specify an end date.

Note: If the item is scheduled to run on then end date, it will run for the last time on
this date.

Maximum time to block other schedules: Defaults to 20 minutes; increase the interval up to 180
minutes.

Note: Ideally, scheduled items complete in sequence; that is, each scheduled item completes
prior to the start of the next. If you know a scheduled task is at risk of taking a long time to
complete, use this field to set the length of time this scheduled item is allowed to delay the next
scheduled item. Choose a value of 20-180 minutes. If the task does not finish within the additional
time you set, it will be terminated. This termination is reflected in the logs.
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Define Action Properties for a Scheduled Item
Use the Action page in the Scheduled Items Properties window to define the Actions for the Scheduled
Items.

Note: Each Action has its own unique properties. After you select an Action, the page displays the
properties that need to be defined for the selected Action.

Note: The Scheduled Item Properties window is accessed from within the Scheduler window in
CSM Administrator.

To define Action properties for a Scheduled Item:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Edit
Schedule task.

2. Click the Add button.

3. Click the Action page.

4. Select an Action.

5. Define the properties for the selected Action:
◦ Backup Database Options: Exports a selected CSM database to a compressed Cherwell

Archive Repository (.czar) file.

◦ Database Maintenance Options: Performs selected database maintenance operations
(example: Rebuilding the Full-Text catalog, Rebuilding Indexes and shrinking SQL logs on a
scheduled basis

◦ Import External Data Options: Imports data from external databases (example: Active
Directory) into CSM.

◦ Import from File Options: Imports data from comma separated value (.csv) files into CSM.

◦ Import from LDAP Options: Imports LDAP records (example: Customer lists) into CSM.

◦ One-Step Action Options: Runs a selected One-Step Action.

◦ Portal Credentials Options: Creates Portal login credentials for Customers.

◦ Publish Blueprint Options: Publishes Blueprints to your CSM system.

◦ Report Options: Runs a selected Report.
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Define Backup Database Action Options
Use the Scheduler's Backup Database Action to export a selected CSM database to a compressed
Cherwell Archive Repository (.czar) file on a scheduled basis.

To Define a Backup Database Action:

1. In the CSM Administrator main window, click the Scheduling category, and then click the Edit
Schedule task.

2. Add or edit a Scheduled Item that uses a Database Action, and then select the Action page.

3. Provide the following settings as they apply:

Option Description

Directory

Provide the directory name or click the Browse button
to select a directory for where database backup files
will be stored.

Note: The directory must be available on the
machine where the Scheduler runs. A UNC
name is recommended.

File Name Provide a file name for the database backup.
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Option Description

Rollover Files

Define the frequency of database backup files.

Note: If you do not roll over backup files, a
new file will be created for every database
backup. The date will be appended to the File
Name you entered (example:
Cherwell20090305_093501.czar).

Nightly: Uses the same file every time the backup is
run.

Weekly: Appends the day of the week to the backup
files (Sun, Mon, Tue, Wed, Thu, Fri, Sat). This means
there will be a maximum of seven files. For example,
if you run a database backup every day of the week,
you will have seven files (one for each day of the
week). If you run a backup every Monday, Wednesday
and Friday, you will have three files. These same files
are used every week.

Monthly: Appends the day of the month appended to
the backup files (example: 01-31). This means there
will be a maximum of 31 files. The same files are used
every month.

Yearly: Appends the month and day to the backup
files (example: Jun28). This means there will be a
maximum of 365 files used (366 for leap years). The
same files are used every year.

Export Type

Export a single Business Object: Select this check
box to export a selected Business Object to the
database backup file when the database backup is
run.

Export entire system: Select this check box to export
your entire database to the backup file when the
database backup is run.

754

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Option Description

Content

The options available in this section depend on the
selected export type.

Export a Single Business Object: Select the Business
Object drop-down

Export Entire System:

◦ Export all data: Exports all SQL Server tables
(example: Field names and sizes) and data.

Tip: Use this option to create a .czar file
to troubleshoot problems that are not
related to Automation Processes or
Scheduled Items.

◦ Export table structure only: Exports all SQL
Server tables without any data.

Tip: Use this option to create a .czar file
that excludes your confidential company
data.

◦ Export structure and lookup table data:
Exports SQL Server tables for all Major and
Supporting Objects, as well as tables AND data
for Lookup Objects (validation tables).

Tip: Use this to create a .czar that
excludes your confidential data but
includes values from Lookup tables
(because typically, Lookup tables do not
contain confidential data and can be
used to troubleshoot problems with
validation and relationships).

◦ Exclude attachments: Exports the Attachment
table but not the Attachment data within the
table.

Tip: Use this option to create a .czar file
to troubleshoot problems that are not
related to Automation Processes or
Scheduled Items.

◦ Exclude automation data: Exports the Events
and Scheduler tables, but not the data within the
tables.

Tip: Use this option to create a .czar file
to troubleshoot problems that are not
related to Automation Processes or
Scheduled Items.
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Define Import from LDAP Action Options
Use the Scheduler's Import from LDAP Action to import LDAP records (example: Customer lists) into
CSM on a scheduled basis. When you schedule an Import from LDAP Action, CSM launches the Active
Directory Import Wizard to help you define the import. If you are also scheduling Portal Credential updates
through the Scheduler, LDAP data must be imported first.

Note: Biweekly LDAP imports are recommended.

Note: To schedule an LDAP import, see Integrating CSM with Microsoft Active Directory for more
information.

To define an Import from LDAP Action:

Click the Setup button to be taken to the Active Directory Import Wizard. For more information, see Import
Active Directory into Business Objects for Map the Customer Object to a Directory Service.
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Define Database Maintenance Action Options
Use the Scheduler's Database Maintenance Action to perform selected database maintenance operations
on a scheduled basis. When you schedule a Database Maintenance Action, you define which database
maintenance operations to perform:

• Full-Text Search maintenance: Rebuilding Full-Text Search catalog.

• Index maintenance: Rebuilding Indexes and shrinking SQL logs. Database maintenance requires re-
indexing database tables.

• Queue and User account maintenance: Refreshing Queue status and removing unused User
accounts.

Note: Schedule your database maintenance operations for after business hours because it
can interrupt performance. For example, rebuilding the SQL Server Full-Text catalog will
prevent Users from doing Full-Text searches while the catalog is rebuilding. For more
information about database maintenance, refer to Perform Database System Maintenance.

To define a Database Maintenance Action:

Full-text
Search

Rebuild Full-Text Search catalog: Rebuild the Full-Text Search catalog when the database
maintenance action is run. CSM uses Full-Text Search for Quick Search and Knowledge
Search. If you have problems with your index getting corrupted, you might want to rebuild
the search catalog once a week or every night.

Manage
Indexes

Rebuild Business Object indexes: Rebuild Business Object indexes when the database
maintenance action is run. This option allows you to rebuild the indexes of the database
tables that represent particular Business Objects. Then, click the Select button to select
which Business Objects to re-index.

Note: By default, all Business Objects are selected. Uncheck Business Objects to exclude
them from reindexing, or select Clear All to uncheck all Business Objects, and then select
the ones you want to re-index.

If you have a high volume of data, you might want to rebuild your table indexes monthly.

Rebuild system table indexes: Rebuild the indexes of the SQL Server tables associated
with CSM system tables when the database maintenance action is run. These tables start
with "Trebuchet" (the internal code name for the product). If you have a high volume of data,
you might want to rebuild your table indexes monthly.

Shrink SQL event log: Shrink the SQL Server event log file when the database
maintenance action is run.

IMPORTANT: Consult with your Administrator before scheduling this option. If in doubt, do
not use this feature unless you run into problems.
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Data

Refresh Queue status: Refresh Queue status when the database maintenance action is
run. Queue status can get out of sync if Business Objects that were on Queues are deleted.
This option ensures that each Queue is synchronized. We recommend scheduling this
weekly.

Remove unused user accounts: Remove data associated with deleted User accounts
when the database maintenance action is run. When User accounts are deleted from the
system, their authorization information might not be removed. This option ensures that the
authorization information is in sync with the User list by removing the unused information.
We recommend scheduling this weekly.

Synchronize Team Info with team list: Synchronizes the Team Info Lookup table with
CSM User and Customer Team list.
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Define Import External Data Action Options
Use the Scheduler's Import External Data Action to import data from external databases (example: Active
Directory) into CSM on a scheduled basis. When you define an Import External Database Action, CSM
launches the External Data Import Wizard to help you define the import.

Note: You must have either a mapped CSM Business Object or an External Business Object to
hold the external data that is imported.

To define an Import External Data Action:

Click the Setup button to open the External Data Import Wizard. For more information, see Import
External Data into a Business Object.
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Define Portal Credentials Action Options
Use the Scheduler's Portal Credentials Action to create Portal login credentials for Customers on a
scheduled basis.

Note: To import Users from LDAP and then create Portal credentials: schedule an Import from
LDAP Action followed by a Portal Credentials Action that executes a few minutes later, ensuring
the order of the steps.For more information about Portal Credentials, refer to Create Portal Login
Credentials.

To define a Portal Credentials Action:

Saved
Search

Click the Ellipses button to open the Search Manager, and then select an existing
Saved Search or create a new one that contains the Customers who need Portal
credentials (example: Internal Customers).

Field with
Login ID

In the drop-down, select the field from the Customer Business Object that contains the
Customers’ login IDs.

Customer
group

In the drop-down, select the Security Group the Customers belong to. This defines the
security rights for the Portal Credential action. Selecting the Portal Workgroup Manager
Group offers greater control than selecting the Portal Customer Group.

Password

Randomly generate a password for each customer: Select this radio button to assign and
e-mail a random password to each Customer. If a Customer does not have an e-mail
address, she will not be notified.

Set password the same for all: Select this radio button to assign the same password to
all Customers, and then provide the password to use.

Password is value from field: Select this radio button to use the value from a field as the
password, and then select the field in the drop-down.

Set Login ID field as Windows/LDAP login: Select this radio button to use Windows/
LDAP login credentials, and then select an option for determining a domain if the login ID
does not include one:

• Attempt to determine domain from LDAP distinguished name: Find the
Customer domain using the stored Distinguished Name and parsing out the
Domain Component (DC).

• Attempt to use domain associated with LDAP customer mapping: Use the
domain stored in the Customer record-mapped LDAP definition.

• Use this domain: Enter a default domain for the Login ID.

Note: LDAP credentials must be configured to use this option. For more information
about configuring LDAP, see Enabling Authentication for Users or Enabling
Authentication for Customers.
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Account
details

Account locked: Select this check box to lock the Customer's account (preventing them
from logging in to the Portal). Note: A Customer can be automatically locked out of the
system, too, if there are too many failed login attempts (depending on system settings).

Password never expires: Forgo password expiration. This overrides any system setting
to reset the password. Note: If this is selected, the User must reset password at next
login and Password reset date settings are hidden.

User cannot change password: Restrict a Customer from changing their password. If a
password reset is required by the system, the system administrator must reset the
password.

User must reset password at next login attempt: Restrict a Customer from changing
their password. If a password reset is required by the system, the system administrator
must reset the password. This restarts any system administrator-scheduled password
reset. Tip: This is an immediate reset. Use this setting if the Customer forgot her
password.

Password reset date: Prompts a Customer to change their password on a specific date.
Click the Date Selector button to select a reset date.

E-mail

E-mail customer new credential information: E-mail new credential information to
Customers, and then click Edit E-mail to edit the Customer Credentials E-mail message.

Tip: To make this the default e-mail message that is used for all Customer e-
mails, click Make Default.

Skip customers with no e-mail address: Skip Customers with no e-mail address (e-
mails will not be sent to them). Leave this check box unchecked if you want an error to
be flagged when a Customer does not have an e-mail address.

Skip
customers
who already
have login
IDs
assigned

Include only new Customers. Leave it cleared to include all Customers. It is
recommended to Select this check box so IDs are not reassigned for existing users.

762

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Define Publish Blueprint Action Options
Use the Scheduler's Publish Blueprint Action to publish Blueprints to your CSM system on a scheduled
basis. When you schedule a Blueprint Publish Action, you define:

• Which Blueprint to publish.

• Whether or not to back up your database before the publish.

For more information about Blueprints, refer to the Blueprints documentation.

To define a Blueprint Publish Action:

Publish Blueprint
Use the Browse button to locate the Blueprint to publish. This directory must be
available on the machine where the Scheduler runs. A UNC name is
recommended.

Backup Database Backup the database before the Blueprint publish.

Directory Directory: Provide the directory name, or click the Browse button to select a
directory where the database backup file will be stored.

File Name File Name: Provide the file name to use for the database backup file.

Append date/time
to file name

Append the current date and time to the file name. This ensures that you do not
overwrite previous backups with the same name by adding the most current date/
time stamp to the backup file name
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Define Import from File Action Options
Use the Scheduler's Import from File Action to import data from comma separated value (.csv) files into
CSM on a scheduled basis. When you schedule an Import from File Action, CSM launches the Stored
Import Definition Manager to select an existing CSV Stored Import or create a new CSV Stored Import to
run.

For more information about CSV files, see Import Data From .csv Files .
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Define One-Step Action Action
Use the Scheduler's One-Step Action Action to run a One-Step Action on a scheduled basis. For
example, run a One-Step Action to send an e-mail indicating that another Scheduled Item is complete
(example: Database backup was successfully completed, Report was run, etc). Select the One-step to run
when scheduling a One-Step Action Action. For more information about One-Step Actions, see the One-
Step Actions documentation.

To define a One-Step Action Action:

Run One-Step Action: Select the One-Step Action from the drop down or click the Ellipses button to open
the One-Step Action Manager, and select an existing One-Step Action or create a new One-Step Action.
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Define Report Action Options
Use the Scheduler's Report Action to run a selected Report on a scheduled basis. When you schedule a
Report Action, you select the Report to run and define any parameters (example: Date range, priorities,
etc.). Consider creating one Report with different parameters (example: Prompts) so that you can reuse
the Report with different values. For example, run a Date Range Report at the end of every month, end of
every quarter, and end of every year. Or, run an Incident Report with different priorities or different
categories. If a Report has parameters, you are prompted to set the values that the Scheduler will pass to
the Report when you schedule the Report.

To automatically print a Report, create a One-Step Action that prints the Report. Then use the Scheduler
to run the One-Step Action.

For more information about Reports, see the Reporting documentation.

To define a Report Action:

Report Select a most recently used (MRU) Report. Click the Ellipses button to open the Report
Manager, and then select an existing Report or create a new Report.

Format Preferred format for the Report. Available formats
include: .pdf, .bmp, .csv, .emf, .xls, .html, .jpeg, .txt, .png, .rtf, and .tiff

Output
file

Where to output the Report file: Click the Browse button to locate the Output file for the
Report.

Note: This file must be creatable on the machine where the Scheduler runs. We
recommend using a UNC name.
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Define Error Handling Properties for a Scheduled
Item

Use the Error Handling page in the Scheduled Item Properties window to define what to do if a Scheduled
Item encounters an error during its scheduled run. The Scheduled Item Properties window is accessed
from within the Scheduler window in CSM Administrator. From the window:

• Run a One-Step Action (example: Run a Report in the event of an error).

• Still schedule next run.

Note: When a Scheduled Item has an error, it is not scheduled again because it is probably in a
state where it cannot run (disk space, missing report, etc.).

To define Error Handling Properties for a Scheduled Item:

1. In the CSM Administrator main window, select the Scheduling category, and then select the Edit
Schedule task.

2. Select Add.

The Schedule Item Properties window opens.

3. Select the Error Handling page.

4. Define the error handling operations:
a. If scheduled items fails run One-Step Action: Select this check box to run a One-Step Action

in the event of a Scheduled Item error. Select a One-Step Action in the drop-down, or select
the ellipses button to open the One-Step Action Manager, and then select an existing One-
Step Action or create a new One-Step Action.

b. If scheduled item fails, still schedule next run (if recurring): Select this check box to
continue a Scheduled Item's original schedule, ensuring that the next run occurs.

5. Select Save.
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Troubleshooting Scheduled Items
If a Scheduled Item does not run as expected, try the following troubleshooting procedures.

Check the Scheduled Items Window

1. In CSM Administrator, click the Scheduling category, and then click the Edit Schedule task.

2. Click the Calendar button.

3. The Calendar Of Scheduled Items window opens.

4. Click the day that the item should have run.

5. Look to see if the Scheduled Item is listed:
◦ If listed: Check its status. If the status has an error, click the row. The error message shows at

the top of the screen. Only the first 250 characters of an error message is stored. If the
message is longer than 250 characters, go to the Windows Event Viewer to see the complete
error message.

Note: Go to the machine where the Scheduling Service is installed. From the Windows
Start menu select Control Panel, double click on Administrative Tools, and then
double-click on Event Viewer.

◦ If the Scheduled Item is not listed and the item is recurring: Go to the date that the item should
have run last. Verify that the status on that day was complete and the Scheduled Item did not
have an error.

Verify the Scheduling Service is not Paused

1. In CSM Administrator, click the Scheduling category, and then click the Pause/Resume Scheduler
task.

2. Verify that there is not a pause. In the example, Henri the User paused the server to change some
reports.

768

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Verify the Cherwell Service Host and CherwellMQS Are Running

1. Log in to the machine where the Scheduling Service is installed.

2. Verify Cherwell Service Host configuration.
◦ From Cherwell Server Manager > Cherwell Service Host > Configure, ensure that the

Connection value is set as expected.

◦ Validate that the Cherwell User ID and Password are correct and that the a test connection
completes successfully.

◦ Additionally, under Advanced Settings, ensure that the service host processes show the
“Scheduling Service” is checked and that the “Scheduling Group” is set to the expected value
as defined by the Schedule Item (Normally, this is (Default) unless otherwise specified in the
scheduled item).

3. Verify the Message Queue configuration.
From the Cherwell Server Manager > Message Queue > Configure, ensure that the Queue
Connection settings are configured correctly per your installation.

4. From the Windows Start menu, go to Control Panel > Administrative Tools > Services.

5. Locate the Cherwell Service Host and CherwellMQS, and then verify that the Status column shows
Started. You can then take the following actions:

◦ Restart the services if they are stopped.

◦ Check the Windows Event Viewer (Administrative Tools>Event Viewer) for logging information.
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Verify SQL Server Database (Advanced Users Only)
For advanced Users who are comfortable executing SQL queries, run the following queries to see the
items that are scheduled and their statuses.

One Time Scheduled Items Status
For items that execute One Time use this query, replace [My Scheduled Item] with the name of the
Scheduled Item you are looking for:

select DefName, ExecutionType, NextDT, Status, ErrorMsg from TrebuchetScheduler where DefName =
'My Scheduled Item'
and ExecutionType = 'OneTime' order by NextDT

Recurring Scheduled Items Status
For items that are recurring use this query, replace [My Scheduled Item] with the name of the Scheduled
Item you are looking for:

select DefName, ExecutionType, NextDT, Status, ErrorMsg from TrebuchetScheduler where DefName =
'My Scheduled Item'
and (ExecutionType = 'Recurring') and (Instance > 0) order by NextDT
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Data and Database Tools
A variety of tools are provided to help you configure and manage your CSM database. Tools for importing
data into CSM are also provided.
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About CSM Data and Databases
CSM ships with two preconfigured Starter Databases. One includes a blank framework of Business
Objects, Grids, Forms, and other CSM items. A second Starter Database can also be installed that
provides sample data to populate the framework fo CSM items with.

Data and Database Overview
CSM works with several different types of databases such as:

• CSM Database: The CSM Database is a database that stores data and all of the CSM definition-
based objects, for example Business Objects, CSM, and Expressions. The CSM Database can
connect to External Databases, E-mail Exchange Servers, and integrations to third-party databases
such as Active Directory. A CSM database can have multiple connections, and users can create
several databases within their CSM instance.

• Exchange Mail Server: CSM uses POP, IMAP, or Exchange for e-mail and event monitoring and
integrates with Microsoft Outlook.

• External Database: An External Database is a third-party database that integrates with CSM by
importing or linking data. CSM can connect to SQL Server and Object Linking and Embedding
(OLE) Databases. Users can create multiple connections to External Databases as well as assign a
Scheduler to the data imports.

• Integrations: CSM can connect with third-party Integrations such as Cherwell Asset Management,
Active Directory, and PeopleSoft.

External Data and Database Overview
CSM can connect to an External Database so that data can be imported or linked with CSM or viewed/
updated in the External Database. The integration between CSM and the external system is done at the
database level. To qualify for integration, the database must be a SQL Server or have an OLE DB driver.
Most of the major databases (Oracle, DB2, Access, etc.) have OLE DB drivers. However, consult
database vendors to acquire an OLE DB driver or to determine if the server is 32-bit or 64-bit because
different drivers are required. CSM can also import existing Comma Separated Values (csv) data.

Imported and linked data are both accessed by a created External Connection:

• When importing external data into CSM, it is initially imported into the CSM Database. Once data
has been imported into the Cherwell Database, automatic re-imports can be scheduled to
automatically update and overwrite outdated data. From that point forward, the records can diverge,
although data can be re-imported (entirely replacing existing data or appending/updating changed
data) if desired. Re-imports can be run manually or they can be regularly scheduled using the CSM
Scheduler. A Last Modified Time/Date field in a Business Object assists in tracking the most
recently imported external data. Additionally, it facilitates viewing or updating that data in CSM.

• When linking to external data, the external data is viewed and updated in CSM, but it continues to
reside in the External Database. A special External Business Object monitors the external data and
facilitates viewing/updating that data in CSM.
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Database Server Objects Overview
Database Server Objects allow the User to connect stored procedures, triggers, User functions, and
replication scripts objects to CSM so that they can be dropped and recreated as necessary when CSM
Blueprints are published to the database. Database Server Objects are important because CSM Business
Object tables cannot be dropped when there is a Database Server Object referencing the table. After
CSM is connected to a Database Server Object, it can manage drops/recreates as needed during
publishing operations. If the native system is exported to a .czar file, when the .czar file is re-imported,
then the Database Server Objects are automatically created in the new database.

To import Database Server Objects:

• Use the Database Server Objects Import option if the CSM database already contains stored
procedures, SQL Server connections, or triggers.

• Add objects through a preferred SQL tool and then import the objects into CSM.

Table Views Overview
Many External Databases are normalized, meaning their data is spread across many tables. Before CSM
can share data in a normalized External Database, create one or more database Views to collect,
combine, and filter the information that is shared (importing/linking). To make mapping fields easier, first
compare the fields in the External Database View with the fields in the CSM Business Objects, then set
the fields in the View to match the names. For more information, see Create CSM Database Views.
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Database Tools
CSM provides tools and wizards to help manage data and databases. Tools are accessed in several
ways: launched automatically when performing a task, accessed from within CSM Administrator, and
accessed as stand-alone tools from the CSM Tools folder.

Database Tools and Wizards in CSM Administrator

• Connection Wizard: Provides the steps to configure the connections between the CSM
applications and the CSM Database. The steps vary depending on the type of connection, either
direct-to-database (2-tier) or Application Server (3-tier).

• External Connection Wizard: Walks through the steps to create a saved connection to an External
Database (called an External Connection). CSM also provides the External Connection Manager to
help manage (create, edit, and delete) the External Connections. In the CSM Administrator main
window, create a New Blueprint. From the Menu bar, click Managers>External Connections.

• External Data Wizard: Provides the steps to either map an existing CSM Business Object to an
External Database, or create an External Business Object to link/import external data.

• External Data Import Wizard: Provides the steps to import external data from an External
Database into a mapped CSM Business Object or an External Business Object. In the CSM
Administrator main window, click the Database category, and then the Import external data task.

• Import Data Wizard: Provides the steps to run a one-time import of .csv data into a CSM Business
Object. In CSM Administrator, click the Database category, and then either Run a one-off data
import (.csv files) or Stored Import Definition Manager (.csv files).

• Stored Import Definition Manager: Helps manage (create, edit, and delete) stored .csv imports.

• Scheduler: Use the Scheduler to manage automated data imports.

• Import Utility: Imports .csv files into the CSM Database.

Stand-alone Database Tools

• System Restore Tool: Allows a system administrator to import the CSM Database for the first time
or reload the CSM Database from an archive file (.czar file).

• System Upgrade Tool: Allows a system administrator to upgrade a CSM Database to a new
version. When installing a new version of CSM and running Cherwell Administrator, it prompts an
upgrade to the database and automatically runs this tool.

• Import Utility: Imports .csv files into the CSM Database.
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System Restore Tool
The System Restore tool is a standalone database tool that allows a system administrator to import the
CSM database for the first time or reload the CSM database from an archive file (.czar file).

Use the System Restore tool (accessed from the Cherwell Service Monitor Tools folder) to:

• Copy the database over multiple environments (testing, staging, and development).

• Provide copies of database for a support team.

• Back up and restore the data if moving the database from one server to another.

• Back up the data and restore the database in another environment.

• Enable multi-byte support for a database.

Warning: After restoring a database, replaced data is no longer accessible.

To restore a database:

1. Open the System Restore tool (Start > All Programs > Cherwell Service Management > Tools >
System Restore.

Note: On Windows 7, right-click and select Run as Administrator.

2. Select the database file (.czar) to import (restore):
a. Select Browse and navigate to a .czar file.
b. Select the file and select Open. The .czar path and name appear in the Import file field.

The .czar details (Date/Time exported, Mode, and version) appear below the file.
3. Select where to restore the .czar file, either:

◦ Existing connection: Enables the .czar file to overwrite an existing database. Select the
ellipses icon to select the database (connection) to overwrite, and then select Import.

◦ New database: Enables the .czar file to create a new database connection. Select the ellipses
icon to open the Connection Wizard to create a new database connection.

When the restore is complete, the database connection is available when CSM opens.
4. Unicode support: Enables support for multi-byte characters in your database. See Configuring CSM

for Multi-byte Language Support.
5. Select the environment type:

a. Development: The database file is being used to configure functionality.
b. Production: The database file meets all requirements, has been tested, and is ready for

business use.
c. Test: The database file is being used for testing purposes.

Note: The environment type provides visibility into the environment you are working with
while managing your system. Once this value is selected, it displays in the client login
windows, window titles for the CSM Desktop Client and CSM Administrator (when
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configured), the Health Check Results window, and the Company Information drop-down
list in the CSM Browser Client and CSM Portal. You can leverage these values in your
configurations using their associated System Functions.

6. Provide the base URL of the Cherwell REST API in the format https://host.domain/CherwellAPI/api/.

Note: If you skip this step, you can still install CSM, but an error that says that the
application is not configured to communicate with the Cherwell REST API server will display
when you attempt to log in.

When the restore is complete, the database connection is available when CSM opens.
Related concepts
Cherwell REST API Command-Line Options
Set the Base URL for the Cherwell REST API
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System Upgrade Tool
The System Upgrade tool allows a system administrator to upgrade a CSM Database to a new version.
This program usually runs automatically when a new version of CSM is loaded.

There are some systematic windows that might populate as the system runs the update. You are not
required to do anything when these windows open.

The System Upgrade tool (accessed from the Cherwell Service Management installation directory) should
only be used if the database was not upgraded as part of an application upgrade or an installation.

Note: Only Users with permissions, for example an Administrator User, can use the System
Upgrade tool.

To upgrade a database:

1. Open the System Restore tool (Start>All Programs>Cherwell Service Management>Tools>System
Upgrade).

The Connect to Cherwell Service Management - System Upgrade window opens.

2. Click to select the database to upgrade.

3. Select OK.

The System Upgrade window opens to verify the upgrade.

4. Select OK.

The Cherwell System Upgrade login window opens.

5. Provide the User ID and Password.

6. Select OK.
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Import Utility
Use the Import Utility option in CSM Administrator to import .csv files into the CSM Database.

To use the Import Utility:

1. Go to Start > All programs > Cherwell Service Management > Tools > Import Utility.

2. Select the connection to import the data to.

The Import Utility login window opens.

3. Provide the User ID and Password for the Import Utility.

The Cherwell Import Utility window opens.

4. Select OK.

The Cherwell Import Utility window opens.

5. Import from:
a. Select the Ellipses.

b. Select the file, and then select Open.

6. Import to:
a. From the drop-down list, select the Business Object.

Note: To delete the existing data, select the Delete existing data from Business
Object before import check box.

7. Advanced:
a. In the Unique fields, provide column names that make up the unique database key.

Note: Select the check box to Try to save object even if one or more fields cannot
be set.

8. Select Import.

Note: If there are unequal fields, a warning window opens. Select Yes.
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Database Export Tool
Use the Export Data option in CSM Administrator to export a selected CSM Database to a compressed
Cherwell Archive Repository (.czar) file. Export a/an:

• Single Business Object.

• Entire system (full backup).

• Log file to capture the details of the database export.

When exporting an entire system, define what to export:

• All Data: Exports all SQL Server tables (example: Field names and sizes) and data. Use this option
to create a full backup .czar of an entire CSM system.

When using this option, select to exclude the following data so that the .czar file size is smaller:

◦ Attachments: Exports the Attachment table but not the Attachment data within the table. Use
this option to create a .czar file to troubleshoot problems that are not related to file
attachments.

◦ Automation data: Exports the Events and Scheduler tables, but not the data within the tables.
Use this option to create a .czar file to troubleshoot problems that are not related to
Automation Processes or scheduled items.

◦ Encrypted fields: Exports Field data, but not encrypted Fields. Use this option to exclude
sensitive data from a .czar file. Note that a .czar file will never contain decrypted data, even if
encrypted Fields are exported. If data is provided to support, we recommend excluding
encrypted Fields from database exports. Encryption keys are not included in any database
exports; we recommend exporting keys from the Server Manager and storing them in a secure
location.

• Table Structure Only: Exports all SQL Server tables without any data. Use this option to create
a .czar file that excludes confidential company data.

• Table Structure and Lookup Tables: Exports SQL Server tables for all Major and Supporting
Objects, as well as tables and data for Lookup Objects (validation tables). Use this to create a .czar
file that excludes confidential data but includes values from Lookup tables (because typically,
Lookup tables do not contain confidential data and can be used to troubleshoot problems with
validation and Relationships).

To export a single Business Object:

1. In the CSM Administrator window, click the Database category, and then click the Export Data task.

The Export Data window opens.

2. Click the Export Single Business Object option.

The window changes to select a single Business Object.

3. Select the Business Object to export.
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4. Select the Exclude Encrypted Fields check box to exclude encrypted Fields from the export. We
recommend excluding encrypted Fields if data is provided to support.

5. (Optional) Select the Logging check box to generate and export a log file (.log) that captures the
details of the export. This file is named the same and exported to the same location as the .czar file.

6. In the Save To field, provide a name for the .czar file (example: Incident_Nov2014), and then specify

a location. Provide a location or click the Ellipses button  to navigate to a location.

7. Select OK.

To export a system:

1. In the CSM Administrator window, click the Database category, and then click the Export Data task.

The Export Data window opens.

2. Select the Export Entire System check box.

3. Select the Content to export:
◦ Export All Data: Select this check box to export all tables and data, and then select to

exclude the following so the file is smaller:
◦ Exclude Attachments: Select this check box to exclude Attachments.

◦ Exclude automation data: Select this check box to exclude automation data.

◦ Exclude encrypted fields: Select this check box to exclude encrypted Fields.

◦ Export Table Structure Only: Select this check box to export tables but no data.

◦ Export Structure and Lookup Table Data: Select this check box to export Major and
Supporting Business Object tables, as well as Lookup tables and Lookup table data.

4. (Optional) Select the Logging check box to generate and export a log file (.log) that captures the
details of the export. This file is named the same and exported to the same location as the .czar file.

5. In the Save To field, provide a name for the .czar file (example: Backup_Nov2017), and then specify
a location. Provide a location or click the Ellipses button to navigate to a location.

6. Select OK.
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Perform Database System Maintenance
System Maintenance is a database option that helps Users maintain their database within CSM. The
System Maintenance window has a series of check box options separated by categories: Full-Text
Search, Manage Indexes, and Data.

To perform database System Maintenance:

1. In the CSM Administrator window, click the Database category, and then click the System
Maintenance task.

2. Select one or all check boxes to run maintenance requests.

3. Select OK.

Full-Text Search
The Full-Text Search category has the option to Rebuild Full-Text Search catalog. The Rebuild Full-Text
Search catalog executes various SQL Server stored procedures to rebuild the SQL Server Full-Text. For
example:

exec sp_fulltext_column @tabname=N'dbo.Incident',@colname=N'IncidentID',@ac
tion=N'add',@type_colname=NULL

Note: For SQL 2012 and above there is logic behind the scenes that performs the rebuild.

Note: Rebuilding the full-text search catalog is only available for on-premises installations of CSM.

Manage Indexes
The Manage Indexes category has all of the options so that Users can run maintenance on the various
indexes in the database. The type of indexes include:

Rebuild Business Object Indexes: Runs a SQL statement for selected tables. For example using the
Task table:

DBCC DBREINDEX('[dbo].[Task]')

Rebuild System Table Indexes: Runs a SQL statement for all of the Cherwell system tables (i.e.
TrebuchetTable). For example using TrebuchetAttach:

DBCC DBREINDEX('[dbo].[TrebuchetAttach]')
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Shrink SQL event log: Runs a SQL statement to shrink the event log for the Cherwell Database. For
example using a database named C50:

DBCC SHRINKFILE(C50_log,3)

Note: Index management is only available for on-premises installations of CSM.

Data
The Data category has the options so that Users can run maintenance on the data in the database. The
Data options include:

Refresh Queue Status: Deletes orphaned records in the TrebuchetQueues system table. This table
holds the list of records and Queues that the records are on. Running this system maintenance option
removes any TrebuchetQueues records that reference a non-existing Business Object record.

Remove Unused User Accounts: Deletes orphaned records in the TrebuchetAuth system table. This
table holds the credentials for Users and Customers. Running this system maintenance option removes
any TrebuchetAuth records that reference a non-existing UserInfo or Customer records.

Synchronize Team Info with team list: Synchronizes the Team Info Lookup table with CSM User and
Customer Team list.

Delete Temporary Data: Deletes records stored in the TrebuchetAttach table where the AttachFlags
column is marked as "Temporary" or "TemporaryGeneralBlogStorage".

Remove Orphaned Attachments: Removes orphaned Attachments from the TrebuchetAttach table.
Running this system maintenance option removes any orphaned Business Object Attachments imported
into the database.

Fix mismatched definition IDs: Fixes incorrect values in the DefID columns in the TrebuchetDefs table
to match what is serialized into DefDetails columns. A backup record is saved with the old ID under the
DefName.
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Configuring Database Security Rights
Configuration procedures are completed in CSM Administrator.

To configure database security rights:

1. Configure database options and Database Server Objects security rights: Configure who can access
database functionality.

2. Configure External Data Options security rights: Configure who can access external data
functionality.
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Configuring a Database Server Object
Licensing Note: Database Server Objects cannot be configured within CSM if the User environment is
run in a SaaS or CSM-hosted environment.

1. In CSM Administrator, create a Blueprint.

2. Select Managers > Database Server Objects.

Note: This option is not available for SAAS systems or non-licensed evaluation systems.

The Database Server Object Manager opens.

3. Select Create New  to open the Database Server Object window.

General Page

1. Specify a Name.

2. Select a Server Object type in the drop-down list.

3. Select a Dependent Business Object in the drop-down list.

4. Select the Show all check box to display all possible Business Objects in the drop-down list.

5. Specify the SQL script in the text box to create the replication script.

6. Choose the object to import and select OK.

7. Select the Check Syntax button to validate that the SQL script is correct.

8. Select Save.

SQL to Create Object Page

1. Specify a SQL script or click Import to import a script.

2. Select Check Syntax to validate the SQL script.

3. Select Save.

SQL to Drop Object Page

1. Specify a SQL drop script.

2. Select a Drop and Recreate Behavior radio button.

Option Description

Table Dropped Drops and recreates the server object whenever the table for the Business
Object is dropped and recreated.
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Option Description

Table Changed Drops and recreates the server object whenever the CMS Business Object
table is changed.

Only When Function
Changes

Creates an object in the CMS database when the Blueprint is published. Use
this option to keep stored procedures, triggers, etc. with the CSM database
when it is moved.

3. Select Save.
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Configuring SQL Server
SQL Server can be optimized for your CSM system. For example, you can customize the default stoplist
to improve search performance and ensure more meaningful search results. This optimization is typically
performed by a database administrator who has knowledge of CSM database structures and tables.

SQL Drop Object Page
On the Drop page, provide the SQL that Cherwell executes to drop the database server object. The SQL
to Drop Object page allows entry of a SQL script to drop the object and allows three options for the drop/
recreate behavior.
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Customizing Stopwords and Stoplists in SQL
Server

CSM uses a default stoplist that ignores words like "the" or "an" when Users perform full-text searches.
This improves search performance and ensures more meaningful search results.

To learn more about stopwords and stoplists in SQL Server, refer to SQL Server Stopwords and Stoplists.

You can create a custom stoplist that contains stopwords specific to your company's needs. The custom
stoplist overrides the default stoplist provided with CSM. (Hosted customers: Contact Cherwell Support for
information about custom stoplists.)

Follow this process to implement custom stoplists in SQL Server:

1. Create the custom stoplist.

2. Bind the full-text catalog to a custom stoplist.

Note: The use of SQL scripts is an advanced task typically performed by database
administrators. The examples provided in this topic are intended to provide guidance for
creating SQL scripts for your system only. Cherwell Software is not liable for changes made
to your CSM system with SQL scripts.

3. Creating a Custom Stoplist

Use a SQL script similar to the following example to create a custom stoplist.

Important: Your custom stoplist must be named CherwellStopList.

The following example SQL script:

• Creates a stoplist called CherwellStopList.

• Adds the stopword "search" to the stoplist.

• Removes the stopword "will" from the stoplist.

 
USE <DBName>
GO
CREATE FULLTEXT STOPLIST [CherwellStopList]
FROM SYSTEM STOPLIST;
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ALTER FULLTEXT STOPLIST CherwellStopList ADD 'search' LANGUAGE 'English';
ALTER FULLTEXT STOPLIST CherwellStopList DROP '
will' LANGUAGE 'English';

Binding the Full-text Catalog to a Custom Stoplist
Use a SQL script similar to the following example to bind the full-text catalog to your custom stoplist. This
process must only be run once; CSM will automatically bind to new and updated tables after the script is
run once.

Important: For large databases, this process could take a significant amount of time and may
impact search results during the rebuild.

The following example SQL script:

• Creates and populates a temporary table that lists all tables using full-text search.

• Alters each table to use the custom stoplist.

Use <DBName>
go
--Create Temp Table for list of tables utilizing Full Text Search
Create table #FullTextTables(
TableName varchar(500))
--Populate the Temp Table 
Insert into #FullTextTables
select t.name as TableName
from sys.fulltext_indexes i,  sys.tables t
where i.object_id = t.object_id
--Perform Loop to alter each table to use a different StopList
Declare @TableName varchar(500)
select Top 1 @TableName = TableName from #FullTextTables order by TableName
While @TableName is not null

begin
exec ('ALTER FULLTEXT INDEX ON '+@TableName+'  Set 

StopList CherwellStopList')
set @TableName = (Select min(TableName) from #FullT

extTables where TableName > @TableName)
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end
--Rebuild the FullText Catalog to repopulate the Full Text Catalog with th
e new Stoplist

ALTER FULLTEXT CATALOG [Trebuchet] REBUILD

790

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Using Databases with CSM
CSM has the ability to connect with an External Database and integrate with third-party software using
one of the connection wizards or integrations. CSM works with the CSM Database, Exchange Mail Server,
External Database, and Integrations.

Demo and Starter Databases
CSM provides two databases:

• Starter database: Contains all the structure (example: Business Objects, Forms, One-Step Actions,
Security Groups, etc.) needed to start using CSM in a live environment. The Starter database option
does not include sample data.
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• Demo database: Contains structure (example: Business Objects, Forms, One-Step Actions, Security
Groups, etc.) and sample data (example: Sample Incidents, Requests, Problems, Users,
Customers, etc.) for new Users who want to demo CSM. Demo content can be cleared to begin
using the system.

If installing the Starter database:

1. Create User Profiles before anyone can log into CSM.

2. Create Customer Profiles before anyone can log into the Customer Portal.

Tip: Use CSDAdmin (User ID and Password) to initially log in.
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Database Categories Options
Use the CSM Administrator Database page (CSM Administrator>Database) to perform several data and
database operations:

• Export Data: Opens the Export Data window to export a database (or parts of it) to a compressed
file (.czar).

• Run a One-Off Data Import (.csv files): Opens the Import Data Wizard that walks Users through
the steps to run a one-time import of CSV data into a CSM Business Object.

• Stored Import Definition Manager (.csv files): Opens the Stored Import Definition Manager that
helps manage (create, edit, delete, etc.) Stored Imports (saved imports that can be used over and
over again). For more information, see Use the Stored Import Definition Manager for .CSV Files.

• Import External Data: Opens the External Data Import Wizard that walks Users through the steps
to import external data from an External Database into a mapped CSM Business Object.

• Import Active Directory Data into Business Object: Opens the Active Directory Import Wizard
that walks Users through the process to import contacts from Active Directory into a CSM Business
Object.

• Import Knowledge: Opens the Import Knowledge Wizard that walks Users through the steps to
import canned Knowledge from KnowledgeBroker, Inc®.

Note: For more information about Importing Knowledge, see Knowledge.

• System Maintenance: Opens the System Maintenance window to perform database system
maintenance (Full-Text Searches, indexes, and some Queue/User accounts).
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External Connection Manager
Use the External Connection Manager to complete general CSM Item Manager operations for External
Connections.

To open the External Connection Manager:

In the Blueprint or mApp Editor menu bar, select Managers > External Connections. For more
information, see Blueprint Editor Menu Bar or mApp Editor Menu Bar.
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Stored Import Definition Manager
Use the Stored Import Definition Manager to complete general CSM Item Manager operations for
stored .csv imports.
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Open the Stored Import Definition Manager
Open the Stored Import Definition Manager from CSM Administrator.

To open the Stored Import Definition Manager:

• In CSM Administrator, select Database > Stored Import Definition Manager (.csv files).
• In the Blueprint or mApp Editor menu bar, select Managers > Stored Imports.

796

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Create CSM Database Views
Database views combine data from different database tables. In CSM, Views allow Users to view or
import data using external connections.

To create a CSM Database view:

1. In CSM Administrator, create a Blueprint.

2. Select Managers > Database Server Objects.

Note: This option is not available for SAAS systems or non-licensed evaluation systems.

The Database Server Object Manager opens.

3. Select Create New .

The Database Server Object window opens.

4. On the General page:
a. Specify a Name.

b. Select View in the Server Object drop-down list.

c. Select the Business Object in the Dependent Business Object in the drop-down list.

d. Select Save.

5. Select the SQL to Create Object tab.
a. Specify a SQL script or select Import to import a script.

b. Select Check Syntax to validate the SQL script.

c. Select Save.

6. Select the SQL Drop Object tab.
a. Specify a SQL drop script.

b. Select the Drop and Recreate Behavior radio button.
i. Table Dropped: Drops and recreates the server object whenever the table for the

Business Object is dropped and recreated.
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ii. Table Changed: Drops and recreates the server object whenever the Business Object
table is changed.

iii. Only When Function Changes: Creates an object in the database when the Blueprint is
published. Use this option to keep view with the CSM database when it is moved.

iv. Select Save.

7. Publish the Blueprint.
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Clear CSM Records
Clear test records from your system so they do not interfere with your metrics during production. For
example, you can clear Demo content from a database.

Complete the following procedure for any Business Object.

To clear Business Object records:

1. Open the CSM Desktop Client.

2. Run a Quick Search for the Business Object:
a. In the CSM Desktop Client Task Pane, select the down arrow on the Search button.

b. Select a Business Object to search (example: Incident).

Tip: Make sure that you are not limiting the search by either the date or open records
only.

c. Select the Go button to run the search.

The test record(s) display in the Main Pane.

3. Select File and select Delete All.

A window opens verifying that you want to delete all of the records from the group.

4. Select Yes.

The records are cleared from the system.
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Import Data from External Databases
Import data into CSM by creating connections to an external database. Map a Business Object to the
external connection, and then import data into the Business Object.

CSM and all Business Objects can be mapped to several external databases at one time.

To define the following external connections, open CSM Administrator, create or open a Blueprint, select
Managers > External Connections, and select the Add button to open the External Connection Wizard:

• Data Source

• Provider

• Location of the database server

• Name/location of the database

• Login options (credentials)

• Owner/schema

• Pooling options
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About Imported Data and Linked Data
You can choose to use an external database connection to import or link to CSM Business Object data.
There are pros and cons to each approach.

Considerations for Linked Data
Pros:

• CSM always shows the external database's most recent data (that is, databases are in sync).

• CSM Users can directly update data in the external database if you enabled updates for the External
Business Object.

Cons:

• The option to link new Business Objects to an external database is not available for Cherwell SaaS
customers.

• You cannot modify an existing Business Object to configure external database connections.

• CSM’s underlying SQL queries cannot cross the CSM/external database boundary.
◦ Example 1: Create a One-Step Action to use a Linked External Business Object, but that

One-Step Action cannot use a CSM Business Object. Likewise, create a One-Step Action to
use a CSM Business Object, but that One-Step Action cannot use a Linked External Business
Object.

◦ Example 2: Create a Search to use a Linked External Business Object, but that Search
cannot use a CSM Business Object. Likewise, create a Search to use a CSM Business Object,
but that Search cannot use a Linked External Business Object.

• There is potential for reduced performance when retrieving data from an external database. If the
external database goes offline, there can be a significant delay while CSM attempts to connect
before timing out.

• Unless done carefully, updates from CSM could possibly violate business rules of the external
database.

• When data is changed outside of CSM, CSM Automation Processes are not initiated. If the data is
changed within CSM, then the business logic is executed.

Considerations for Imported Data
Pros:

• You can import external data into new and existing Business Objects.

• The data is available for every single feature in CSM. The data is not limited by the CSM boundary
or system boundary mentioned above.

• Use additional CSM fields to augment the imported data.

• Full-Text Search can be used for searching.
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• The imported Table/View can become part of a CSM Group (example: It could be a Configuration
Item Group member).

Cons:

• The data is only as current as the last import. However, use the Cherwell Scheduler to import the
data at regular intervals.

• If data is deleted from the external database, it still exists in CSM.
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Map an Existing Business Object to External Data
Use an existing Business Object to establish external connections and import external data directly into
both the Business Object and CSM. The imported data can be edited within CSM or updated via
Automation Processes.

An existing Business Object cannot link to external data. To link external data to a Business Object and
manipulate the data from the external source, refer to Create an External Business Object to Link to
External Data.

To establish an external connection to a Business Object and import external data:

1. In the CSM Administrator main window, click the Blueprints category, and then click Create a New
Blueprint or open an existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Select an existing Business Object (example: Incident).

3. Click the Map to external data task. Or select New Object, and then New external business
object task. The External Data Wizard opens.

4. Select Next.

The Import vs. Linked page opens.

Note: The Link to Data option is available only when creating a new Business Object.
Connecting to an existing Business Object must be performed with an import.

5. Click the Import Data radio button.

6. Select Next.

The Data Source page opens.

7. Click the ellipses button. The External Connection manager opens. Select an existing External
Database or click the New button to create a new External Connection.

8. Select Next.

The External Table to Map page opens, listing the available tables the selected External Database.

9. Select a table to import.

10. Select Next.

The Fields to Map page opens.
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11. Map fields from the selected table to a field in the new External Business Object:
a. Click the Add button.

The Map Field from External Table manager opens, listing the available fields based on the
selected External Database and External Table.

b. Select an external field (example: Created By).

c. Select an existing Cherwell Service Management field to map the external field to or create a
new field (example: Last Modified).

d. Select OK.

e. Repeat mapping process for all desired fields.

12. Select Next.

The Unique Key and Timestamp Fields page opens. Values in the Unique Key and Timestamp drop-
downs are based on the fields that were mapped in Step 11.

13. Choose a Unique Key and Timestamp field:
a. Field that Holds Unique Key drop-down: Displays the external field chosen from the previous

page. This field becomes the unique key, which is used during imports to ensure records in the
field are updated if they already exist in Cherwell Service Management.

b. Last Modified Date/Time drop-down: Select a value from the drop-down to dictate when to
update the unique key field. If selecting a Last Modified Date/Time value, it is recommended to
add SQL indexes to these fields after configuring the External Data Import (Business Object
Editor > Business Object Properites > Databases > Add Index button > Select Last
Modified Date/Time values ). Doing so ensures optimal import performance.

14. Select Next.

The Summary page opens and displays details established during the setup process.

15. Select Finish.

The Business Object's Properties window opens, showing current and editable Business Object
properties. An external data page displays External Connection details established in the External
Data Wizard.

16. Click OK to close the Properties window.

17. (Optional for Supporting Objects) If needed, create a Relationship between the newly created
Supporting Objects and the Major Object they support.

18. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Map a Business Object to Multiple External
Connections

Multiple external connections can be mapped to the same Business Object. Doing so allows users to
import data into the Business Object from both external connection sources. Users can map a Business
Object to multiple external connection through the Business Object Properties page. Users can also
create and configure external connections via the External Connections Manager.

Create Multiple External Connections with the External Connection Wizard
To map a Business Object to multiple external connections:

1. In the CSM Administrator window, click the Blueprints category and select Create a New Blueprint
or Open an Existing Blueprint.

2. Select a Business Object that has already been mapped to one or more instances of external data
(example: another user has mapped the Problem Business Object to two external databases).

3. Click Map to External Data. The External Data Wizard opens.

4. Click Next.
5. Click the Import Data radio button. The Linking Data feature is disabled; multiple database

connections can only be established when importing data directly into CSM. Linking Data is also
only available when mapping External Data to a new Business Object.

6. Click Next.
7. From the Data Source page, click the Ellipses button to open the External Connection Manager.

8. Select an additional external connection from the Data Source drop-down (example:
Employee_Info_1 and Employee_Info_2).

9. Click Next.
10. From the External Table to Map page, select a table name from the external database to map the

Business Object to (example: EmployeeName).

11. Click Next.
12. In the Fields to Map page, click Add. The Map Field from External Table picker opens.

13. Select the Existing Field radio button or the Create a New Field radio button to determine what
Business Object field the imported data is added to.

14. Click OK to close the Map Field from External Table picker.

15. Repeat for all desired fields.

16. Click Next.
17. From the Unique Key and Timestamp Fields page, select a Unique Key Field from the drop-down.

CSM uses the Unique Key and the Last Modified field to determine whether or not data needs to be
updated during imports.

18. (Optional) Select a Last Modified value (example: ActualEndDate). CSM uses the Last Modified
field to determine if the Unique Key data needs updating. Leaving this field blank means CSM
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always updates previously imported data from the selected database. If selecting a Last Modified
Date/Time value, it is recommended to add SQL indexes to these fields after configuring the
External Data Import (Business Object Editor > Business Object Properites > Databases > Add
Index button > Select Last Modified Date/Time values ). Doing so ensures optimal import
performance.

19. Click Next. The Summary page opens.

20. Click Finish. The Business Object Properties page opens, view and edit external connections
mapped to the selected Business Object if desired.

Edit External Connections from the Business Object Properties Page
A Business Object's external connections can be edited through the Business Object Properties page.
Users can also create new external connections for a Business Object that has already been mapped to
external connections.

To map a Business Object to multiple external connections:

1. Select a Business Object from the Blueprint Object Manager. The Business Object must be an
existing Business Object that is already mapped to external data.

2. Click Edit Business Object. The Edit Business Object page opens.

3. Click the Business Object Properties button. The Business Object Properties page opens.

4. Select the External Data category. If this category is not visible, then the Business Object has not
been mapped to external data. To map a Business Object to external data, see Map an Existing
Business Object to Import External Data. After selecting the External Data category, the External
Data summary page opens; detailing the external connections that have been mapped to the
selected Business Object.

5. Select an External Connection from the Mapped External Connections drop-down. Summary
information displays in the External Data summary page.
From the summary page, Users can:

◦ Click the Add button to create an additional external connection.

◦ Remove the mapping to external connections from the Business Object.

◦ Add, Edit, or Remove mapped fields.

6. After editing the external connections, click OK to close the Business Object Properties page.

7. Save or Publish the Blueprint.

Related concepts
Link External Data to a New External Business Object
Map an Existing Business Object to External Data
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Create an External Connection to an API
Use the External Connection Wizard to create and manage External Connections. External Connections
can be created with the following types of APIs that provide access to a range of data sources:

• MySQL or SQL Server

• Oracle

• ODBC: Used for many sources, including file formats like Excel files, Access databases, .txt files,
and more.

Note: The ODBC Providers list might vary depending on the drivers installed.

• OLE DB: This is the newer version of ODBC and is used for both relational and non-relational
databases (SQL, Oracle, Excel, raw files, etc.)

807

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=managing_external_connections
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_an_external_connection_to_a_mysql_or_sql_server_database
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_an_external_connection_to_oracle
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_an_external_connection_to_odbc
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_an_external_connection_to_an_ole_db


Create an External Connection to a MySQL or SQL
Server Database

Create a connection to an external MySQL or SQL Server database. Then, you can map a Business
Object to the connection, and import data into the Business Object.

MySQL Connector 6.9.4 must be installed to create, edit, or use MySQL external connections. The
MySQL Connector can be downloaded from https://downloads.mysql.com/archives/c-net/.

An external connection connects CSM to an external database. These steps are specifically for an
external connection between CSM and a SQL Database.
To create an External Connection to a MySQL or SQL Server Database:

1. Open or create a Blueprint.
2. Select Managers > External Connections to open the External Connections Manager.
3. Select Create New to open the External Connection Wizard.
4. Select Next.
5. On the Login options page, select the Use Trusted Agents check box if you use the Trusted Agents

feature and you want to control how the system logs in to the external data source.
6. Select one of these options, and then select Next.

◦ Any Trusted Agent Group: Select to allow any group to handle requests for this external
connection.

◦ Trusted Agent Group: Select a specific group to handle requests for this external connection.
7. On the Data Source page, select MySQL or SQL Server, and then select Next.

Note: The option to select MySQL is available only if the MySQL Connector 6.9.4 is
installed.

8. On the Database Location page, select the location of the SQL Database:
◦ Located on this machine: Select this option if running a local database. Typically, this is only

for evaluation systems.
◦ Specific Server: Select this option to select a database installed on a named server, and then

select the specific server in the drop-down list.

Note: If the connection is to a named instance of SQL (a non-default instance of SQL),
select the option and then specify the instance in the Specific Server value using the
format: DatabaseServer\InstanceName.

◦ IP Address: Select this option to select a database installed on a server referenced by an IP
address, and then provide the database server IP address.

9. Select Next.
10. On the Select Database page, select Browse.

The Login to server window opens.
11. Select a login radio button to use either:

808

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://downloads.mysql.com/archives/c-net/


◦ Windows authentication: Use the stored Windows credentials (user name and password) for
authentication.

◦ User ID and Password: Provide the server User ID and Password.
12. Select OK. The system runs for a few minutes and the Choose a Value window opens.
13. Select a database, select OK, and then select Next.
14. On the Login Options page, if the database requires login information, select the Login Required

check box and either:
◦ Windows Authentication: Uses the stored Windows credentials (user name and password)

for authentication.
◦ User ID and PasswordProvide a user ID and password.

Note: The account must have select rights for each table that is imported or linked to
CSM. If CSM is allowed to update data in the database, this account must also have
insert and update rights.

15. Select Next.
16. On the Database Owner or Schema page, select an option from the drop-down list or provide a

database owner or schema. This field should be pre-populated.

Note: Not all databases have this concept. If implemented and CSM is able to read the
available owners, then they are listed in the drop-down list. If not, provide the owner name. If
unsure, provide the default dbo.

17. On the Pooling Options page, select a Connection Pooling option for the database:
◦ Select the Use default pooling options radio button.
◦ Select the Customize the pooling options radio button, and then provide the minimum and

maximum pool size.

Note:

To improve performance, set the maximum pool size to three times the number of
concurrent CSM licenses that are used in your organization. You may need to adjust
this value, depending on usage of your system.

The Connection name page opens.
18. On the Connection name page, provide a name and description (optional) of the database

connection, and then select Next.
The Connection String page opens, showing the connection string that is used to connect to the
database. Modify the connection string, if needed. Many examples of connection strings can be
found at www.connectionstrings.com.

19. Select Test Connection to verify the connection to the server/database. Text appears next to the
button confirming the connection is successful.

20. Select Finish. A connection now exists to the SQL Server database.
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21. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File
> Save Blueprint) to continue making other changes.

Related concepts
Publish a Blueprint
Save a Blueprint
Related tasks
Create a Blueprint
Import External Data Using Trusted Agents
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Create an External Connection to Oracle
Create a connection to an external Oracle Server database. Then, you can map a Business Object to the
connection, and import data into the Business Object.

In order to create an Oracle connection, the Oracle client must be installed and configured.

An external connection connects CSM to an external database. The steps below are specifically for an
External Connection between CSM and an Oracle Database.
To create an external connection to an Oracle Server Database:

1. Open or create a Blueprint.
2. Select Managers > External Connections to open the External Connections Manager.
3. Select Create New to open the External Connection Wizard.
4. On the Login options page, select the Use Trusted Agents check box if you use the Trusted Agents

feature and you want to control how the system logs in to the external data source.
5. Select one of these options, and then select Next.

◦ Any Trusted Agent Group: Select to allow any group to handle requests for this external
connection.

◦ Trusted Agent Group: Select a specific group to handle requests for this external connection.
6. On the Data Source page, select Oracle.
7. On the Select Net Service Name page, provide the full string containing the service name.

 (DESCRIPTION=(ADDRESS=(protocol_address_information))(CONNECT_DATA=(SE
RVICE_NAME=service_name)))

8. On the Login Options page, if the database requires login information, select the Login Required
check box and either:

◦ Windows Authentication: Uses the stored Windows credentials (user name and password)
for authentication.

Note: When Cherwell Services use this connection, the account under which the
Cherwell Application Service is running is the account whose credentials are used to
connect to the database.

◦ User ID and Password: Provide a user ID and password.

Note: The account must have select rights for each table that is imported or linked to
CSM. If CSM is allowed to update data in the database, this account must also have
insert and update rights.

9. Select Next.
10. On the Database Owner or Schema page:

a. Select an option from the drop-down list or provide a database owner or schema. This field
should be pre-populated. Not all databases have this concept. If implemented and CSM is able
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to read the available owners, then they are listed in the drop-down list. If not, provide the
owner name. If unsure, provide the default dbo.

b. Select Next.
11. On the Pooling Options page, select a Connection Pooling option for the database, and select Next:

◦ Select the Use default pooling options radio button.
◦ Select the Customize the pooling options radio button, and then provide the minimum and

maximum pool size.

Note:

To improve performance, set the maximum pool size to three times the number of
concurrent CSM licenses that are used in your organization. You may need to adjust
this value, depending on usage of your system.

12. On the Connection name page, provide a name and description (optional) of the database
connection, and then select Next.
The Connection String page opens, displaying the connection string that is used to connect to the
database. Modify the connection string, if needed. Many examples of connection strings can be
found at www.connectionstrings.com.

13. Select Test Connection to verify the connection to the server/database. Text appears next to the
button confirming the connection is successful.

14. Select Finish. A connection now exists to the Oracle database.
15. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File

> Save Blueprint) to continue making other changes.

Related concepts
Publish a Blueprint
Save a Blueprint
Related tasks
Create a Blueprint
Import External Data Using Trusted Agents
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Create an External Connection to an OLE DB
Create a connection to connect CSM through OLE DB to an Oracle Database. OLE Database is a
standard that allows CSM to connect to a variety of databases in a common format.

The steps below are specifically for an external connection between CSM and an OLE Database to SQL.
To create an external connection to an OLE Server Database:

1. Open or create a Blueprint.
2. Select Managers > External Connections to open the External Connections Manager.
3. Select Create New.

The External Connection Wizard opens.
4. Select Next to open the Data Source page.
5. On the Login options page, select the Use Trusted Agents check box if you use the Trusted Agents

feature and want to control how the system logs in to the external data source.
6. Select one of the following options, and then select Next.

◦ Any Trusted Agent Group: Select to allow any group to handle requests for this external
connection.

◦ Trusted Agent Group: Select a specific group to handle requests for this external connection.
7. On the Data Source page, select OLE DB, and then select Next.
8. On the OLE DB Provider page, select an OLE DB Provider, and then select Next.

Note: If you are using Oracle as the provider, there are some differences in the wizard.
Drivers should be available from a database vendor. Consult the database vendor for
assistance locating this driver. There are also OLE Database drivers from third-party
vendors that can be used.

9. On the Database Location page, select one the following database locations of the connecting
database, and select Next.

◦ Located on this Machine: Select this option if running a local database. Typically, this is only
for evaluation systems.

◦ Specific Server: Select this option to select a database installed on a named server, and then
select the named server.

◦ IP Address: Select this option to select a database installed on a server referenced by an IP
address, and then provide the IP address.

◦ Data Comes from file: Select this option if the driver connects directly to a file rather than to a
database server. If selected, the Database field is replaced with a File field.

Note: This radio button is only shown when CSM does not detect if the provider
connects to a database or a file.

10. On the Select Database page, provide the name of the database/file to which to connect, or select
Browse to see a list of available databases/files.
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11. On the Login to server window, select to use either Windows authentication or the ID and password
of the server.
The system runs for a few minutes, and then the Choose a Value window opens.

12. Select a database, then select Next.
13. On the Login Options page, if the database requires login information, select the Login Required

check box and either:
◦ Windows Authentication: Uses the stored Windows credentials (user name and password)

for authentication.
◦ User ID and Password: Provide a user ID and password.

Note: The account must have select rights for each table that is imported or linked to
CSM. If CSM is allowed to update data in the database, this account must also have
insert and update rights.

14. Select Next.
15. On the Database Owner or Schema page, select an option from the drop-down list or provide a

database owner or schema. This field should be pre-populated. Select Next.
16. On the Pooling Options page, select either Use OLE DB connection pooling or No pooling.
17. On the Connection name page, provide a name and description (optional) of the database

connection, and then select Next.
The Connection String page opens, displaying the connection string that is used to connect to the
database. Modify the connection string, if needed. Many examples of connection strings can be
found at www.connectionstrings.com.

18. Select Test Connection to verify the connection to the server/database. Text appears next to the
button confirming the connection is successful.

19. Select Finish. A connection now exists to the External OLE Database database.
20. Publish the Blueprint (File > Publish Blueprint) to commit the changes, or save the Blueprint (File

> Save Blueprint) to continue making other changes.

Related concepts
Publish a Blueprint
Save a Blueprint
Related tasks
Create a Blueprint
Import External Data Using Trusted Agents
Create an External Connection to Oracle
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Create an External Connection to ODBC
An External Connection connects CSM to an External Database. The steps below are specifically for an
External Connection between CSM and an ODBC.

ODBC Requirements:

• The ODBC provider must show as available on the current machine.

• The Desktop Client must be installed.

• For Oracle: Client must have Oracle 11 or 12 on the Application Server and it must be configured.

To create an External Connection to an ODBC Server Database:

1. Open or create a Blueprint.

2. Select Managers > External Connections to open the External Connections Manager.

3. Click Create New.

The External Connection Wizard opens.

4. On the Login options page:
◦ Select the Use Trusted Agents check box if you use the Trusted Agents feature and you want

to control how the system logs in to the external data source.

◦ Select one of these options:
◦ Any Trusted Agent Group: Select to allow any group to handle requests for this

External Connection.

◦ Trusted Agent Group: Select a specific group to handle requests for this External
Connection.

◦ Click Next.

For more information, refer to Import External Data Using Trusted Agents.

5. On the Data Source page:
a. Select ODBC.

b. Select Next.

6. On the ODBC Provider page:
a. Select an ODBC Provider.

Note: The ODBC Providers list might vary depending on the drivers installed. If using
Oracle as the provider, there are some differences in the Wizard. For more information,
see Create an External Connection to Oracle.

b. Select Next.
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7. On the Database Location page:
a. Select the Database Location of the connecting database:

◦ Located on this Machine: Select this option if running a local database. Typically, this is
only for evaluation systems.

◦ Specific Server: Select this option to select a database installed on a named server,
and then select the named server.

◦ IP Address: Select this option to select a database installed on a server referenced by
an IP address, and then provide the IP address.

b. Select Next.

8. On the Select a Database page:
◦ Provide the Name of the database/file to which to connect, or click Browse to see a list of

available databases/files.

◦ Click Browse.

The Login to server window opens.

a. Select a login radio button to use either:
◦ Windows authentication

◦ User ID and Password: Provide the server User ID and Password.

b. Select OK.

The system runs for a few minutes and the Choose a Value window opens.

c. Click a database.

d. Select OK.

9. Select Next.

10. On the Login Options page:
a. If the database requires login information, select the Login Required check box and either:

◦ Windows Authentication: Uses the stored Windows credentials (user name and
password) for authentication.

Note: When Cherwell Services use this connection, the account under which the
Cherwell Application Service is running is the account whose credentials are used to
connect to the database.

◦ User ID and Password: Provide a User ID and Password.

Note: The account must have select rights for each table that is imported or linked to
CSM. If CSM is allowed to update data in the database, this account must also have
insert and update rights..

b. Select Next.
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11. On the Database Owner or Schema page:
a. Click an option from the drop-down or provide a Database owner or schema. This field

should be pre-populated.

Note: Not all databases have this concept. If implemented, and CSM is able to read
the available owners, they are listed in the drop down. If not, provide the owner name.
If unsure, provide the dbo default.

b. Select Next.

12. On the Connection Name page:
a. Provide a Name for the database connection.

b. (Optional) Provide a Description for the database connection.

c. Select Next.

The Connection String page opens, showing the connection string that is used to connect to the
database. Modify the connection string, if needed. Many examples of connection strings can be
found at www.connectionstrings.com.

13. Click Test Connection to verify that the connection to the server/database.

Text appears next to the button confirming the connection is successful.

Note: If the test connection is not successful, contact a DBA for help.

14. Select Finish.

There is now a connection to the External ODBC Database.

15. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Link External Data to a New External Business
Object

Linking Business Objects to external data allows for real-time updates between an external database and
CSM. If updates of the external data are permitted, the Business Object can be configured to enforce the
appropriate rules. A Business Object can only be linked to one external data connection.

To link external data to a new External Business Object:

1. In the CSM Administrator main window, click the Blueprints category, and then click the Create a
New Blueprint task.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Click New Object from the Object Manager, then select the New External Business Object task.

The External Data Wizard opens.

3. Select Next.

The Import vs. Linked page opens.

4. Click the Link to data radio button.

5. Select Next.

The Data Source page opens.

6. Click the ellipses button. The External Connection manager opens. Select an existing External
Database or click the New button to create a new External Connection.

7. Select Next.

The External Table to Map page opens, listing the Tables and/or Views from the External Database.

8. Click to select the Table or View to link to.

9. Select Next.

The Business Object Type page opens.

10. Select the type of External Business Object to create: Major Business Object, Supporting Business
Object, or Lookup.

11. Click Next.

The Cherwell Group page opens.
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12. Select a radio button to assign the External Business Object to a Group.

13. Select Next.

The Fields to Map page opens.

14. Map fields from the selected table to a field in the new External Business Object:
a. Click theAdd button.

The Map Field from External Table manager opens, listing the available fields.

b. Select an external field (example: Created By).

c. Select an existing Cherwell Service Management field to map the external field to or create a
new field.

d. Click OK.

e. Repeat mapping process for all desired fields.

15. Select Next.

The Unique Key and Timestamp Fields page opens. The screen shots show example fields.

16. Designate a Unique Key and Timestamp field:
◦ Field that Holds Unique Key: Select the field from the View that is deemed as the unique

identifier (example: MachineID or ComputerID).

Note: There must be a unique ID field for CSM to use the External Table/View. If the Table/
View does not have a Unique Key, add one.

◦ Last Modified Date/Time: Select the field from the Table/View that is deemed as the last
modified date/time field (example: LastScanDate or date_modified).

17. Select Next.

The Read-Only or Updatable page opens.

18. Select the radio button to establish whether the data should be read-only or if it can be updated in
CSM.

19. Select Next.

The Search Options page opens.

20. Define searching options for the External Business Objects (only available for linked external data):
a. Use SQL Server Full-Text Search: Select this check box to enable Full-Text Search.

SQL Server Note: If the External Database is SQL Server, select the SQL Server Full-Text
Search check box to have CSM send full-text queries to the External Database when
searches are done. In order to use Full-Text Search, it must be configured in the External
Database. Refer to SQL Server documentation for details on how to set up Full-Text Search.
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b. Fields to search: Click Add to select the fields that should show when searches are conducted
inside CSM (example: Quick Search).

c. Select the Search type:
◦ Exact match: The search string must exactly match a word or phrase in order for the

record to be found. For those familiar with SQL, use the SQL clause:

where (field = ‘value’)

◦ Starts with: This finds records containing words or phrases that start with the search
string. This is the recommended selection. For those familiar with SQL, use the SQL
clause:

where (field LIKE ‘value%’)

◦ Contains: This returns records that contain the search string. This is slower than the
other two options. If the database table contains millions of records, then do not use this
option. For those familiar with SQL, use the SQL clause:

where (field LIKE ‘%value%’)

21. Select Next.

The Name and Description page opens.

22. Provide a Name for the External Business Object.

23. (Optional) Type a Description for the External Business Object.

24. Select Next.

The Summary page opens. The information varies depending on selections throughout the wizard.

25. Select Finish.

The Business Object's Properties window opens, displaying current (and editable) properties,
including a:

◦ External Data page: View/edit the field mappings, unique ID, and last modified date/time
fields.

◦ External Search page: View/edit external search options (if defined).

◦ Search Results page: Displays the Full-Text Search and quick search (if defined).

◦ Database page: Read-only because the Table/View actually resides in another database.

26. Click OK to close the Properties window. Create Forms and Grids for the External Business Object
just as a new CSM Business Object.

Create Forms and Grids for the External Business Object just as a new CSM Business Object.
(Optional for Supporting Objects) If needed, create a Relationship between the newly created
Supporting Objects and the Major Object they support.
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27. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Import External Data into a New External Business
Object

Create a new Business Object to import external data into.

When importing external data, data is imported into the Cherwell Service Management system and edited
there. Linking external data allows for the data to be manipulated within the external source.

To import external data to a new External Business Object:

1. In the CSM Administrator main window, select the Blueprints category, and then select Create a
New Blueprint or open an existing Blueprint.

The Blueprint Editor opens, showing the Object Manager in its Main Pane. The Object Manager lists
the existing Business Objects.

2. Select New Object from the Blueprint Object Manager, and then select the New external Business
Object task. The External Data Wizard opens.

3. Select Next.

The Import vs. Linked page opens.

4. Select the Import data option.

5. Select Next.

The Data Source page opens.

6. Select Ellipses. The External Connection manager opens. Select an existing External Database or
select New to create a new External Connection.

7. Select Next.

The External Table to Map page opens, listing the Tables and/or Views from an External Database.

8. Select the Table or View to import.

9. Select Next.

The Business Object Type page opens if creating a new object. If using an existing object, go to the
Map to Fields page.

10. Select the Type of Business Object to create: Major, Supporting, or Lookup.

11. Select Next.

The Part of Cherwell Group Group page opens.
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12. Define Group information options for the External Business Object:
◦ Not a Member of a Group: Select this option if the Business Object is not part of a Group.

◦ Group Leader: Select this option to make the Business Object a Group Leader.

◦ Member of: Select this option if the Business Object is going to be part of an existing Group.
Select the Group from the enabled drop-down list.

13. Select Next.

The Fields to Map page opens.

14. Map fields from the Table/View to a Field in the new External Business Object:
◦ To map all available Table/View Fields at once, select Map all fields. The Wizard

automatically creates a new Field for each external Table/View Field and populates the
mapping list.

◦ To map one Field at a time, select Add.

The Map Field from External Table window opens, listing the available Table/View fields.

◦ Select the external field to map to.

◦ Select Create new field and type a name for the new field.

◦ Select OK.

15. Select Next.

The Unique Key and Timestamp Fields page opens.

16. Designate a Unique Key and Timestamp Field:
a. Field that Holds Unique Key: Select the Field from the View that is considered the unique

identifier (example: MachineID or ComputerID).

b. Last Modified Date/Time: Select the Field from the Table/View that is considered the last
modified date/time Field (example: LastScanDate or date_modified).

17. Select Next.

The Read-Only or Updatable page opens.

18. Select the Data is read-only or Allow data to be updated option.

19. Select Next.

The Name and Description page opens.

20. Provide the Name and Description for the Business Object.

21. Select Next.

The Summary page opens. The information varies depending on selections throughout the wizard.
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22. Select Finish.

The Business Object's Properties window opens, showing current (and editable) properties,
including a new external data page where the Field mappings, unique ID, and last modified date/
time Fields can be viewed/edited.

23. Select OK to close the Properties window.

24. Create Forms and Grids for the External Business Object just as for a new CSM Business Object.

25. (Optional for Supporting Objects) If needed, create a Relationship between the newly created
Supporting Objects and the Major Object they support.

26. Publish the Blueprint (File>Publish Blueprint) to commit the changes, or save the Blueprint
(File>Save Blueprint) to continue making other changes.
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Import External Data into an Existing Business
Object

Use the External Data Import Wizard to import data from an external database into an external Business
Object. External data can only be imported into External Business Objects, which is a Business Object
that has already been mapped to an external connection..

To import external data into an existing external Business Object:

1. In the CSM Administrator window, click the Database category.

2. Click the Import External Data task. The External Data Import Wizard opens.

3. Select Next.

The Select Business Object page opens. Only Business Objects that have already been mapped to
an external connection appear.

4. Select a Business Object.

5. Select Next.

The Existing Records page opens.

6. Select whether to delete or update existing records within CSM:
◦ Delete All Existing Data: Select this radio button to delete all the records from the Table/View

before importing new data.

Warning: If records were linked to CSM records and then deleted in the External Database,
those links will no longer work. Deleting records from CSM before re-importing them might
break some, or all, of the existing Relationships to that record.

◦ Update Existing Records: Select this radio button to import new data and refreshes any
existing records with changed data. Existing records are updated based on the chosen Unique
Key field.

7. (Optional) Select the Only import records changed since check box to shorten the import time
based on a selected date. Click the Date Selector button to select a date.

8. Select Next.

The Choose Filter page opens.

9. Select data to import:
◦ All records: Select this radio button to import all external data.

◦ Use filter: Select this radio button to filter the imported data based on a defined query. When
the User Filter radio button is selected, the Saved Search option enables. Click the Ellipses
button to open the Search Manager, and then select an existing Saved Search (saved Search
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Query) or create a Saved Search. Saved Searches can be used over and over in numerous
places.

Note: Typically, data in a View is already filtered.

10. Select Finish.

The data is imported and then shows in the CMDB (CSM>Tools>CMDB). If the CSM Scheduler is
used, the import starts at the scheduled time.
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Share Data with an External Database
Consider creating Views in your external database to connect to your CSM database.

To share data with an external database:

1. (Optional) If connecting to a normalized database, create Views of the data that connect to each
other.

Note: For more information about creating and testing Views of the external database,
consult a DBA.

2. In CSM Administrator, create an external connection to an external database.
3. Designate a CSM Business Object to accept the external data. There are three options:

◦ Map an existing CSM Business Object to external data, and then import the external data. (No
link option is available for existing CSM Business Objects.)

◦ Create an External Business Object to import the external data, and then import the external
data.

◦ Create an External Business Object to link to the external data.
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Import Data From .csv Files
If you do not need to import real-time record or user data into your CSM system, you can import Business
Object or user data from .csv (comma delimited) files as needed or create a Stored Import Definition that
can be used repeatedly.

For example, you can create an Excel spreadsheet to import user data. Add a column for each field you
want to import data to. A spreadsheet that has columns named Title, First Name, Last Name, Email
address, Company and Job Title can be mapped for similar fields in CSM.

When you save the spreadsheet as a .csv file, the data is saved as:

• Mr,Mark,Jones,mark_jones@rada.com,"Rada Inc.","VP, Director, Process Excellence"

• Ms,Leann,Johnson,ljohnson@wavings.edu,The Wavings Institute,Information Technology

.CSV Reference

• The .csv file must have a column name specified in the first row.

• Data that contains commas or quotes should have double-quotes around the value. A double quote
is included by being doubled. For example: "The ""very"" important data" imports very with one set
of double quotes.

• To include carriage returns, place the text \R\N into the string. To actually include the text "\R,"
double the slash: \\R. Most of these things are automatically done by programs that support
exporting in a .csv format.

• Each row can have its values imported into a Business Object and/or related Business Objects. For
example, if each row of the .csv file contains an Incident and its Customer, Journal, and Specifics
data, then the import can create an Incident Record and use its Relationships to create associated
Customer, Journal, and Specifics Records. Be aware that each row can create only one instance of
a record for each Relationship. For example, it cannot create two Journals from the same data row
unless using two different Relationships.

Related concepts
Stored Import Definition Manager
Related tasks
Import Business Object Data with .csv Files
Importing Users with .csv Files
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Import Business Object Data with .csv Files
You can import Business Object record data from a .csv (comma delimited) file. You can do this one time or
create a Stored Import Definition that can be used repeatedly.

Related concepts
Import Data From .csv Files
Stored Import Definition Manager
Related tasks
Importing Users with .csv Files
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Run a One-time Import of Business Object Data
Use a one-off import to quickly add Business Object data to your system. For example, to import data
from a legacy Service Management tool, you can export that data to a .csv file, and then run a one-time
import.

To run a one-off data import:

1. In the CSM Administrator, select the Database category.
2. Select the Stored Import Definition Manager (CSV files) task.
3. Select New to open the Import Data Wizard, and then select Next.
4. From the Primary Business Object drop-down list, select Business Object to import the .csv file

data into.
5. Optionally, select a timeout to specify the number of seconds the system should wait before the

import operation times out. This option is only available for 3-tier database connections.
6. Select Next.
7. Select a Column in File (example: Description) to map it to a Business Object Field, and then

select an action:

Option Description

Do not import this column Select this option to prevent data from this
column from being imported

Import into field Select this option, and then select a
Business Object field to import the column
data into.

Repeat these steps for all columns.
8. Select Next.
9. Optionally, selectAdd to add more data to Business Object fields, and then select a field from the

Field to Populate list.

Option Description

Expression Select this option, and then select the
Expression.

Concatenate Columns from File Select this option, and select Add to choose
a column from the file to concatenate data in
the columns based on the specified
separator characters.

Separator characters Choose the character to separate column
data during the import process.

10. Select Next.
11. Define options to take when duplicate data is detected.
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Option Description

Duplicate Records in Import File Select the Ignore Duplicate Entries
checkbox to ignore duplicate entries in
the .csv file. Select Add to select which
columns to ignore when duplicate entries are
found.

Records in Database that Match Import
File

Select one of these options:
◦ Select the Import all records - No

duplicate check radio button to import
all data from the .csv file, even if data
matches existing records in the
database.

◦ Select the Ignore/skip duplicate
records radio button to skip records that
exist in the .csv file and the database.

◦ Select the Update duplicate records
radio button to update the database with
information from the .csv file.

Important: Selecting the Ignore/
skip duplicate records radio
button or the Update duplicate
records radio buttons requires
column names to be specified
(Add>Select column names for
the Import Data Wizard to ignore
or update)

12. Select Next.
13. Optionally, use the Delete Existing Data page to define these options:

Option Description

Delete existing data from the business
object before import

Select this check box to replace current data
with new data from the .csv file.

Do not delete data if import file is empty Select this checkbox to prevent Business
Object data from being deleted but not
repopulated. (example: the .csv file has blank
columns, so the original Business Object data
is still needed).

14. Select Next.
15. Optionally, select the Test Import button. After the test runs, warnings appear for any duplicate

entries.
16. Select Import.
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Related concepts
Import Data From .csv Files
Related tasks
Run Repeated Imports of Business Object Data
Importing Users with .csv Files
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Run Repeated Imports of Business Object Data
Use the Stored Import Definition Manager to create a stored and named .csv import definition so that a
specific .csv file can be imported more than once. When a Stored Import is created, you are prompted to
complete the Import Data Wizard, and then name and save the import definition.

To run a stored import:

1. In the CSM Administrator window, select the Database category, and then select the Stored Import
Definition Manager (CSV Files) task.
The Stored Import Definition Manager opens, listing existing Stored Imports.

2. Select Create New.
The Import Data Wizard opens.

3. Follow the steps to run a One-Off Data Import.
4. Provide a name for the Stored Import when prompted.
5. Choose one of these options to use the Stored Import Definition:

◦ Select Run in the Stored Import Definition Manager window to run the import.
◦ Schedule an import using the Scheduler. For more information, see Define Import from File

Action Options.

Related concepts
Import Data From .csv Files
Stored Import Definition Manager
Related tasks
Run a One-time Import of Business Object Data
Importing Users with .csv Files
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Importing Users with .csv Files
You can import user data from a .csv (comma delimited) file. You can choose to include LDAP
authentication data in your .csv file. For best results, create a Stored Import Definition that can be used
repeatedly.

To import users with internal authentication settings:

1. In the CSM Administrator, select the Database category.
2. Select the Stored Import Definition Manager (CSV files) task.
3. Select New to open the Import Data Wizard, and then select Next.
4. Navigate to a .csv file that contains user data.
5. from the Primary Business Object drop-down list, select the Business Object that stores internal

user information. In most cases, this is the UserInfo Business Object.
6. Optionally, select a timeout to specify the number of seconds the system should wait before the

import operation times out. This option is only available for 3-tier database connections.
7. Select Next.
8. On the Set Special User Authentication Column page of the Import Data Wizard, select the

Column button for each column shown, and then select the matching data column in the .csv file.

Note: At least one Login ID column and the Rec ID, Security Group, Default Security Group,
and Default Team fields are required.

9. Optionally, select the Include LDAP Authentication checkbox if your .csv file contains LDAP user
information and LDAP is configured for your system.

10. Select Next.
11. If you are importing LDAP user information, you must add LDAP information to the import.

Option Description

Users Name Starts With Select the Column button, and then choose
the .csv column that matches the start of
each user name.

LDAP Directory Service Select the LDAP connection to use for the
data import.

LDAP Key Field Select a field from the User Business object
to serve as the LDAP key.

Default Domain Provide you LDAP domain name or IP
address.

Use Default Domain Select this option to use the specified LDAP
domain if another is not detected from
the .csv file.
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Option Description

Always Use Default Domain Select this option to use the specified LDAP
default domain.

12. Select Next.
13. Select a Column in File (example:Email) to map it to a User field, and then select an action:

Option Description

Do not import this column Select this option to prevent data from this
column from being imported

Import into field Select this option, and then select a
Business Object field to import the column
data into.

Repeat these steps for all columns.
14. Optionally, selectAdd to add more data to Business Object fields, and then select a field from the

Field to Populate list.

Option Description

Expression Select this option, and then select the
Expression.

Concatenate Columns from File Select this option, and select Add to choose
a column from the file to concatenate data in
the columns based on the specified
separator characters.

Separator characters Choose the character to separate column
data during the import process.

15. Select Next.
16. Define options to take when duplicate data is detected.

Option Description

Duplicate Records in Import File Select the Ignore Duplicate Entries
checkbox to ignore duplicate entries in
the .csv file. Select Add to select which
columns to ignore when duplicate entries are
found.
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Option Description

Records in Database that Match Import
File

Select one of these options:
◦ Select the Import all records - No

duplicate check radio button to import
all data from the .csv file, even if data
matches existing records in the
database.

◦ Select the Ignore/skip duplicate
records radio button to skip records that
exist in the .csv file and the database.

◦ Select the Update duplicate records
radio button to update the database with
information from the .csv file.

Important: Selecting the Ignore/
skip duplicate records radio
button or the Update duplicate
records radio buttons requires
column names to be specified
(Add>Select column names for
the Import Data Wizard to ignore
or update)

17. Choose one of these options to use the Stored Import Definition:
◦ Select Run in the Stored Import Definition Manager window to run the import.
◦ Schedule an import using the Scheduler. For more information, see Define Import from File

Action Options.
18. Optionally, select the Test Import button. After the test runs, warnings appear for any duplicate

entries.

Related concepts
Import Data From .csv Files
Stored Import Definition Manager
Related tasks
Import Business Object Data with .csv Files
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Troubleshooting Data and Databases

General Troubleshooting

• For any problems or issues in importing, linking, or connecting to databases through CSM, contact a
Database Administrator or Cherwell support.

• When updating to a new software version, choose to update the existing database to the most
recent database version. Updating a CSM Database installs any new and required internal system
definitions.

• Import data should be maintained in CSM and linked to transient or reference data that can be
maintained outside CSM. There are pros and cons of both imported and linked data.

• Only Users with correct permissions can use the Database tools. If a User cannot see Database
tools, ensure the User has Administrator Security Rights.

• When Cherwell Services use a Windows Authentication connection, the account under which the
Cherwell Application Service is running is the account whose credentials are used to connect to the
database. The account must have select rights for each table that is importing or linking to CSM. If
intending to allow CSM to update data in the database, then this account must also have insert and
update rights.

OLE Database Connection Troubleshooting
Drivers should be available from a database vendor. Consult a database provider for assistance locating
this driver. There are also OLE Database drivers from third-party vendors that can be used. Although
ODBC Drivers is an option in this list, it is not compatible with the .NET OLE Database mechanism, which
is used by CSM for communication with external data sources.

SQL Database Connection Troubleshooting
If connecting to a named instance of a SQL (a non-default instance of SQL), then provide the instance in
the Specific Server value using the format: DatabaseServer\InstanceName.

External Business Object and External Data Connection Troubleshooting

• External data can only be imported into External Business Objects, ensure your selected Business
Object is an External Business Object.

• A combination of imported and linked data can be used, but not within the same Business Object.
The option to Link Data is disabled when applicable: if data has already been imported into the
Business Object or an External Connection is being created.

• The Link to Data option is available only when creating a new Business Object; connecting to an
existing Business Object must be performed with an import.

• Use an existing Business Object to share external data. To use an existing Business Object, map an
Existing CSM External Business Object to Import External Data, and then import the external data
(linking from an existing Business Object is not allowed).
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• SQL Server: In order to use SQL Full-Text Search, it must be configured in the External Database.
Refer to SQL Server documentation for details on how to set up Full-Text Search.

• If External data is not importing at the selected time (example: when the selected Unique Key field
was Last Modified) ensure SQL indexes have been assigned to the selected fields. Assign SQL
indexes in CSM Administrator and the Business Object Editor (Business Object Editor >
Business Object Properites > Databases > Add Index button > Select Last Modified Date/
Time values ).

• Some advanced data types may not import into CSM and are not supported (example: Int data
types).

CSV Data Troubleshooting

• Commas are the only accepted separators.

• CSV data can only be imported, it cannot link to CSV data.

• Before importing CSV data, prepare the data so the column names are specified in the first row.

• Save an Excel Spreadsheet as a .csv file by selecting File>Save As and choosing the .csv file
format from the Save As Type box.
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Email Configuration
CSM supports sending and receiving email in several different formats (POP3/SMTP, IMAP/SMTP, and
Microsoft® Exchange).

A variety of tools are provided to help you configure and manage email.
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Configuring Email Accounts
You can perform procedures for configuring email accounts in CSM Administrator and the CSM Desktop
Client.

Complete the following procedures to configure email accounts.

To configure email accounts:

1. Configure e-mail security rights.

2. Configure global e-mail accounts: Global email accounts are configured in CSM Administrator. If a
user has security rights, they define personal e-mail settings in the CSM Desktop Client to
customize the account and use it to send emails. Make the account unavailable to users and set it
up solely as a monitored account (using the Email and Event Monitor).

3. Define default email history attachment options: Define which records to have emails attached to (as
Journal - Mail History Records). The email history attachment options selected here are set as
defaults, but users can override them using the email history attachment options in the Email
Message window in the Desktop Client.

Note: The Business Objects might also need to be configured to receive email history (see
Define Default Email History Attachment Options) or to allow users to email customers from
a Business Object Record. For emails to be sent to the current customer on a particular
Business Object (example: Incident), the Business Object must have a Customer
Relationship (example: Incident links Customer) with the CustomerInfo general attribute.
This relationship exists on most Major Business Objects in the system, but should be added
to any new objects created. If a user tries to send an email to a customer, and CSM cannot
find a relationship with this attribute, it returns a Customer e-mail address was not found
error message. For more information about relationships, see the Relationships
documentation.

4. Configure personal email accounts in the Desktop Client: Customize a global email account or
configure a personal account for special circumstances such as sending email from home or an off-
site location.
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Configure a Global Email Account
When configuring an email account, you can add or delete an account, edit or copy an existing account,
designate a default account for sending emails from within CSM, and find dependencies.

Use the Accounts page in the E-mail Options window to set up global email accounts.

To configure a global email account:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select E-mail Accounts and Settings.

2. Select the Accounts page on the E-mail Options window.
3. Configure an email account:

a. Select Add to select the type of email account to set up (POP, IMAP, or Exchange).
b. Select Edit to edit the settings for an existing account.
c. Select Delete to delete an existing account.

Note: Users might have security rights to customize global email account settings, so
there are several options when deleting an email account. See Delete a Global Email
Account for more information.

d. Select Copy to copy the settings from an existing account, then edit the settings as necessary.
4. Configure the account:

a. Define Global POP or IMAP Account Settings 
b. Define Global Microsoft Exchange Account Settings

5. Select Spell Check E-mail to have CSM spell check emails as a message is typed (misspelled
words are underlined with red lines).

6. Select Make Default Account to make the selected account the default account for sending emails.
This account is used for emails sent from the Browser Client.

7. Select Find Dependencies to show other CSM Items using the selected email account (example:
An Email and Event Monitor).
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Define Global POP or IMAP Account Settings
You can configure a POP or IMAP account to send and receive email through CSM. As a prerequisite,
gather the required information before starting the configuration process.

Setting up a POP or IMAP account requires:

• A name for the email account.

• Incoming (POP or IMAP) and outgoing (SMTP) email server information, including the:
◦ Location of the mail server.

◦ Security protocol.

◦ Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into e-mails to identify if a particular email is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in the History
Attachment Options for a global e-mail account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

• From Addresses that are allowed for sending emails from CSM.

Note: The padlock button in each of the sections determines if Users can override
administrative settings when they personalize a global e-mail account by defining their own
personal email settings. By default, server settings are locked and credentials are unlocked
so that Users can enter their own user names and passwords. Click the padlock buttons to
change the defaults.

To set up a POP or IMAP account:

Note: The options for a POP or IMAP account are the same. The ports are different and are listed
in step 6c.

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the Edit E-mail Accounts and Settings task.

2. Select the Accounts page on the E-mail Options window opens.

3. Select Add, and then select POP account or IMAP account.

Tip: Users can also edit or copy an existing account. Select Edit to modify the settings for
an existing email account. Select Copy to copy the settings for an existing email account,
then modify them as necessary.
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4. The Incoming Server page should be open as the default.

5. Define general incoming server (POP or IMAP) settings:
a. Name: Provide a name for the account.

Tip: When defining a test account, use names such as MyDevAccount or
DevTestAccount. This naming convention allows users to quickly identify test accounts
in the system.

b. Make Account Available to Users: Select this check box to allow users to send emails from
within CSM using this account. If the account is only used by the E-mail and Event Monitor to
scan incoming emails, leave the check box cleared so that users never see the account.

6. Define incoming mail server (POP or IMAP) information:
a. Incoming Mail Server: Provide the name of the POP or IMAP server.

b. Security: Select a security protocol in the drop-down list:
◦ Auto: Select this option to have CSM select the best method to use. It selects the most

secure method available in order to prevent transmission of unencrypted User IDs and
passwords, if possible.

◦ Basic: Select this option to have User IDs and passwords passed as plain text.

◦ SSL: Select this option to use SSL encryption (a Server Certificate is required).

◦ SSL with No Authentication (IMAP only): Select this option to use SSL encryption only
(no Server Certificate is required).

◦ TLS (IMAP only): Select this option to use the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select this check box to enter a port for the POP or IMAP server that is different
than the default.

Note: For POP servers, the default port is 110 (the SSL port is 995). For IMAP servers,
the default port is 143 (the SSL port is 993).

7. Enter account information:
a. User Name: Provide the user name for the email account.

b. Password: Provide the password for the email account.

Note: Leave the user name and password blank to allow Users to provide their own
credentials. Also, ensure the padlock button is unlocked . If it is locked, click it and
select Users Can Change Credentials. If all Users will use the same credentials, or if
this account will be used by an automated process like the E-mail and Event Monitor,
provide credentials here.

c. Mailbox (IMAP only): Select the mailbox (example: Inbox) from the drop-down list where the
incoming mail should be stored.

8. Select the Outgoing Server page.
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9. Define outgoing mail server (SMTP) information:
a. Outgoing Mail Server (SMTP): Provide the name of the SMTP server.

b. Security: Select a security protocol in the drop-down list:
◦ Auto: Select this option to have CSM select the best method to use. It selects the most

secure method available in order to prevent transmission of unencrypted User IDs and
passwords, if possible.

◦ Basic: Select this option to have User IDs and passwords passed as plain text.

◦ SSL: Select this option to use SSL encryption (a Server Certificate is required).

◦ TLS: Select this option to use the TLS protocol.

Note: The mail server must support the selected security mode.

c. Custom Port: Select this check box to enter a port for the SMTP server that is different than
the default (default port is 25, SSL port is 465).

10. Specify account information:
a. Requires Authentication: Select this check box if the SMTP server requires authentication

and select one of the following options:
◦ Use Same Settings as My Incoming Server: Select this radio button if the user name

and password for the SMTP server are the same as the incoming server.

◦ Log on Using: Select this radio button to specify a user name and password that is
different from the incoming server settings and provide the user name and password.

Note: To allow Users to enter their own credentials, leave the user name and
password blank and ensure that the padlock button is unlocked . If it is locked,
click it and select Users Can Change Credentials.

11. Define conversation ID options:
a. Add Conversation IDs to Outgoing Messages: Select this check box to include

Conversation IDs in outgoing emails.

Note: When a Conversation ID is found within an e-mail message, CSM can
immediately find the record (example: Incident) associated with the various e-mails. If
Conversation IDs are not used, then it can still identify records, but it has to use less
reliable techniques, such as comparing the details of the subject line.

b. Specify where in the email to include the Conversation ID, either:
◦ Add to Subject Line: Select this radio button to include the Conversation ID in the

subject line of outgoing emails.

◦ Add to Body: Select this radio button to include the Conversation ID in the body of
outgoing e-mails.

Note: Do not delete Conversation IDs from e-mail messages. Doing so makes it
harder for CSM to associate customer replies with the correct record.
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12. Select the Test Account button to ensure that emails can be sent from within CSM using this
account.

A test email is sent to the current user.

Note: All required Incoming and Outgoing Server information must be completed before
testing the account.

13. Optional: Select the From Settings page and specify the addresses and settings associated with
outbound emails.

14. Optional: Select the Trusted Agents page and define how Trusted Agents should be used with this
account.

Related concepts
Default Port Numbers
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Define Global Microsoft Exchange Account
Settings

You can configure a Microsoft Exchange account to send and receive email through CSM. As a
prerequisite, gather the required information before starting the configuration process.

Setting up a Microsoft Exchange account requires:

• A name for the email account.

• Exchange Server information.

• Account credentials.

• Options for adding Conversation IDs to outgoing messages.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into e-mails to identify if a particular email is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in the History
Attachment Options for a global email account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

• From Addresses that are allowed for sending emails from CSM.

Note: The padlock button in each of the sections determines if users can override
administrative settings when they customize a global email account by defining their own
personal email settings. By default, server settings are locked and credentials are unlocked
so that users can enter their own usernames and passwords. Select the padlock buttons to
change the defaults.

To configure a global Microsoft Exchange account:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the E-mail Accounts and Settings task.

The E-mail Options window opens.

2. Select the Accounts page.

3. Select Add.

4. Select Exchange.

Tip: Users can also edit or copy an existing account. Select Edit to modify the settings for
an existing email account. Select Copy to copy the settings for an existing email account,
and then modify them as necessary.
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The E-mail Options window for an Exchange account opens.

5. Select the Exchange Server page.

6. Define general account information:
a. Name: Provide a name for the Exchange account.

b. Make Account Available to Users: Select this check box to allow Users to send e-mails from
CSM using this account. If the account is only used by the Email and Event Monitor to scan
incoming emails, leave the check box cleared so users never see the account.

7. Define Exchange server Info:
a. Exchange Domain: Provide the name of the Exchange domain.

b. Server (Client Access): Provide the name of the Exchange Client Access server. Client
Access is the web service used by CSM to connect with Exchange.

c. Use SSL Connection: Select this check box to use SSL encryption for sending and receiving
emails.

d. Allow Invalid Server Certificate: Select this check box to allow emails to be sent and
received even when the digital certificate is invalid.

Warning: This option is not recommended, as it can pose a security risk to the
Exchange email system.

8. Enter Account Information:
a. User: Provide the email address for the Exchange account.

b. Password: Provide the password for the Exchange account.

Note: Leave the user name and password blank to allow users to enter their own
credentials. Also, ensure that the padlock button is unlocked. If it is locked, select the
image and select Users Can Change Credentials. If all users use the same
credentials, or if this account is used by an automated process like the Email and
Event Monitor, provide credentials here.

9. Define Conversation ID options:
a. Add Conversation IDs to Outgoing Messages: Select this check box to include

Conversation IDs in outgoing emails. Implementing Conversation IDs increases reliability
when attempting to locate emails discussing specific Records.

b. Specify where in the email to include the Conversation ID, either:
◦ Add to Subject Line: Select this radio button to include the Conversation ID in the

subject line of outgoing emails.

◦ Add to Body: Select this radio button to include Conversation ID in the body of outgoing
emails.

10. Select the Test Account button to ensure emails can be sent from within CSM using this account.

A test email is sent to the current user. All required Exchange server information must be filled in
before the account to be tested. Testing the account only confirms that the account was successfully
linked to CSM. It does not confirm that the account is compatible with the email monitor.
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11. Select the From Settings page and specify the addresses and settings associated with outbound
emails.

12. Select the Trusted Agents page and define how Trusted Agents should be used with this account.
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Define Default From Settings for a Global Email
Account

A system administrator might want to control which email addresses can be used to send email from
within CSM. Use the From Settings page to define allowed From Addresses for a POP, IMAP, or Microsoft
Exchange account.

Note: Many mail servers do not allow a From Address that does not match the account. In that
case, limit the From Address to prevent mail from being rejected.

To define From settings:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the E-mail Accounts and Settings task.

The E-mail Options window opens.

2. Select the Accounts page.

3. Select a POP account, IMAP account, or Exchange account that is configured.

The E-mail Options window for a POP, IMAP, or Microsoft Exchange account opens.

4. Select the From Settings page.

5. Define general account information:
a. Name: Provide a name for the account.

b. Make Account Available to Users: Select this check box to allow users to send emails from
CSM using this account. If the account is only used by the Email and Event Monitor Service to
scan incoming emails, leave the check box cleared so that users never see the account.

Note: If the general account information is defined in the settings for POP or IMAP
accounts, or for Microsoft Exchange accounts, then it shows up here.

6. Define which From Addresses are allowed (select any or all of the following options):
◦ Allow User’s E-mail Address: Select this check box to allow the user's email address as a

From Address.

◦ Allow Arbitrary From Addresses: Select this check box to allow any valid email address as a
From Address.

Note: This option is not recommended since this can be used for spam and to
impersonate other Users. Also, most mail servers reject emails with unexpected From
Addresses.

7. Provide a list of Legal From Addresses (example: servicedesk@mycompany.com,
sales@mycompany.com, support@mycompany.com).
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Note: The email server needs to be configured to allow these From Addresses from the
account.

◦ Add: Select to add a new email address as a Legal From Address.

◦ Edit: Select to edit an existing From Address.

◦ Remove: Select to remove an email address from the list.

Note: If there is a list of Legal From Addresses, select one as the default From
Address (select the Make Default Address button) that is automatically used for all
emails sent from the account.

Tip: If all emails sent from a global email account in CSM should have the same From
Address, add that address to the list of Legal From Addresses and clear the Allow
User’s E-mail Address and Allow Arbitrary From Addresses check boxes.

8. Select where to send emails from, either:
◦ Client: Select this radio button to have emails sent from the user's client machine.

◦ Server: Select this radio button to have emails sent from the server.

Note: Sending email from a server puts an additional load on the server and should be
used if only the server has access to the mail server for security reasons, or if there
are CSM users outside of the corporate firewall/network. If only a few users need to
send email from the server, create a separate account for those users.

◦ Note: If you use Trusted Agents with the email account, the email source will
automatically be set to Server.

850

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Delete a Global Email Account
You can remove a global email account that is no longer needed. When deleting an account, keep in mind
that this might be an active account with defined personal email settings for some users.

To delete a global email account:

1. In CSM Administrator, select E-mail and Event Monitoring > Edit E-mail Accounts and Settings.
The E-mail Options window opens.

2. Select the Accounts page.
3. Select the email account to delete.
4. Select the Delete button.

The Update or Delete Dependent Accounts window opens.
5. Select whether to preserve or delete user customizations on the account:

◦ Keep User Accounts: Select this radio button to have the global settings copied into each
user account based on this account, so it continues to function as before. Users are able to
edit any portion of the account (even the items that were locked previously).

◦ Delete Any User Customizations for the Account: Select this radio button to delete the
global account and all user customizations at the same time. Users are no longer able to use
the account to send email from within CSM.

6. Select OK, and then select OK again.

Related concepts
Configure User E-mail Settings
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Define Default Email History Attachment Options
Using Journal - Mail History Records, you can define default settings for attaching email history to
records.

Note: For emails to be attached to a Business Object as a Journal - Mail History Record, the
Business Object must have a History Relationship. For emails to be attached to the customer
associated with a particular Business Object (example: Incident), the Business Object must have
a Customer Relationship (example: Incident links Customer) with the CustomerInfo general
attribute. This Relationship exists on most Major Business Objects in the default system, but
should be added to any new objects created. For more information about Relationships, see the
Relationships documentation.

Use the History page in the E-mail Options window to define email history options, such as:

• What types of records emails should be attached to, either:
◦ The current Business Object.

◦ Customers identified from the email or Business Object.

Note: The email history attachment options selected here are set as defaults, but
users can override them using the email history attachment options in the E-mail
Message window.

• A Conversation ID prefix that is used when Conversation IDs are embedded in emails. The option to
embed Conversation IDs into outgoing messages is available in the account settings for the POP,
IMAP, or Microsoft Exchange account.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts Conversation
IDs into emails to identify if a particular email is a reply to a previous message that was associated
with a specific Business Object record. A Conversation ID looks similar to the following: {CMI:
ABCD1234}, where ABCD is an identifier for the particular CSM system (set this value in the History
Attachment Options for a global email account), and the numeric indicator is the specific
Conversation ID. The number is automatically incremented for each message.

To define default email history attachment options:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the E-mail Accounts and Settings task.

The E-mail Options window opens.

2. Select the History page.

3. Define Default E-mail History Attachment Options: Specify which records get a Journal - Mail History
Record when an email is sent.
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◦ Current Record: Select this check box to attach emails to the Business Object record the user
currently has in focus or has selected in a list of records (example: An Incident Record in a
search results list).

◦ Current Record’s Customer: Select this check box to attach emails to the customer associated
with the current record.

◦ Recipients in To Line: Select this check box to attach emails to the records of customers that
CSM can identify from email addresses in the To line.

◦ Recipients in Cc Line: Select this check box to attach emails to the records of customers that
CSM can identify from email addresses in the Cc line.

◦ Recipients in Bcc Line: Select this check box to attach emails to the records of customers that
CSM can identify from email addresses in the Bcc line.

Note: This option only applies to outgoing email.

◦ Parents of recipients (example: Organization that contact works for): Select this check box to
attach emails to the parent records of recipients. For example, if an email recipient is a contact
that works for a particular organization, the email can be attached to the Company Record as
well as the Customer Record.

4. Define remaining email history attachment options:
a. Import file attachments automatically when sending email: Select this check box if file

attachments sent out in emails should, by default, be imported and attached as part of history.
This will also import attachments from all system-generated emails (triggered by One-Step™
Actions, Automation Processes, etc.)

b. Message Conversation ID Prefix: Provide a prefix for Conversation IDs that are embedded in
the subject or body of emails sent from within CSM.

Note: The prefix should be unique for the system or organization and should be between two
and eight characters. If a value is not specified, a random value is created, but can be updated
at any time to something relevant to the organization. In the message, the Conversation ID
looks similar to the following: {CMI: ABCD1234}, where ABCD is the specified prefix, and the
numeric indicator is the specific Conversation ID. The prefix is especially important for sending
emails among multiple companies that use CSM (example: If contacting Cherwell Support).

Tip: Select the Information button  to view this same information.

5. Select OK.
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Implementing Email Accounts
To get started with email, you can implement the CSM default email system by completing a worksheet,
configuring test and production accounts, and configuring a global test email account.

To implement the default e-mail system:

1. Complete the e-mail worksheet.

2. Configure test and production accounts.

3. Configure a CSM global e-mail account for testing.

Note: This is the test account monitored by the OOTB E-mail and Event Monitor.

a. Define account settings. Account options include:
◦ POP or IMAP.

◦ Microsoft Exchange.

b. Define default From Address for the Global account.

c. Define default e-mail history attachment options.

4. Configure a CSM global e-mail accounts.

Note: This account is monitored by the OOTB E-mail and Event Monitor during production.

a. Define account settings. Account options include:
◦ POP or IMAP.

◦ Microsoft Exchange.

b. Define default From Address for the Global account.

c. Define default e-mail history attachment options.

Tip: Alternatively, configure these settings using the Getting Started Page in CSM
Administrator (Help>Go to Getting Started Page).

5. Implement E-mail notifications.

6. Configure the production e-mail account.
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Email Worksheet
Organize email information such as user credentials, account information, and server location into a
worksheet for easy reference during the configuration process.

Before configuring CSM email, users must create three email accounts using their own email service:

• Test Receiver Account: Create a test email account to receive test messages from CSM (example:
ServiceDeskTESTReceiver@company.com).

• Test Sender Account: Create a test email account to send messages via CSM (example:
ServiceDeskTESTSender@company.com).

• Production Account: Create a production email account to send messages via CSM (example:
support@company.com).

Depending on the type of email service being used, complete one of the following worksheets to organize
the email information.

POP or IMAP Account

Email Item Test Account (Sender) Information  Production Account
Information

Account Name    

 Example: MyDevAccount  Example: MyProductionAccount

Account Username    

 Example: ServiceDeskTESTSender  Example: Support

Account Password    

 Example: Colorado719  Example: Colorado719

Incoming (POP or
IMAP) Server Location    

 Example: pop.PrimaryDomain or
imap.PrimaryDomain  Example: pop.PrimaryDomain or

imap.PrimaryDomain

Incoming (POP or
IMAP) Server Security
Protocol

   

 Example: Auto, Basic, SSL, TLS  Example: Auto, Basic, SSL, TLS

Outgoing (SMTP Server
Security Protocol    

 Example: smtp.PrimaryDomain  Example: smtp.PrimaryDomain

Exchange Account

855

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Email Item Test Account (Sender) Information  Production Account Information

Account Name    

 Example. MyDevAccount  Example. MyProductionAccount

Account Username    

 Example. ServiceDeskTESTSender  Example. Support

Account Password    

 Example: Colorado719  Example: Colorado719

Exchange Domain    

 Example: mycompany.com  Example: mycompany.com

Server (Client
Access)    

 Example: exchange.mycompany.com  Example: exchange.mycompany.com
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Configure Test and Production Accounts
CSM provides a Stored Value, named Current System, that holds either a Development or Production
value. This Stored Value allows users to easily transition their accounts from testing to production.

By default, the Stored Value is set to Development and controls the status of the other Current System
Stored Values related to email, including:

• Current System DEV E-mail Recipient: Holds the test receiver email account (example:
ServiceDeskTESTReceiver@company.com).

• Current System DEV E-mail Sender: Holds the test sender email account (example:
ServiceDeskTESTSender@company.com).

• Current System Production E-mail Sender: Holds the production email account (example:
support@company.com).

To configure test and production email accounts:

1. In the CSM Administrator main window, select the Settings category, and then select the Open
Stored Values Manager task.

The Stored Value Manager opens, listing the existing Stored Values.

2. In the Manager tree, select the Global folder.

A list of globally available items opens in the main pane.

3. Right-click the Current System DEV E-mail Recipient Stored Value and select Edit.
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4. In the Value field, provide the test recipient account address (example:
ServiceDeskTESTReceiver@company.com).

5. Select OK.

6. Right-click the Current System DEV E-mail Sender Stored Value and select Edit.

7. In the Value field, provide the test email account address (example:
ServiceDeskTESTSender@company.com).

8. Select OK.

9. Right-click the Current System Production E-mail Sender Stored Value and select Edit.
10. In the Value field, provide the production account (example: support@company.com).
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Configure Global Email Accounts
As a prerequisite for creating test and production email accounts for users, configure a global email
account within CSM Administrator.

You can configure two separate CSM email accounts:

• Test account: Use this account while developing and testing the system. It is monitored by the Email
Monitor during development and used as the sender account for automated test emails.

Note: Use test sender account (ServiceDeskTESTSender@company.com) information on
the Email Worksheet.

• Production account: Transition to this account after development. It is monitored by the Email
Monitor during production and used as the sender account for all automated emails.

Note: Use production account (example: support@company.com) information on the Email
Worksheet.

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the E-mail Accounts and Settings task.
The E-mail Options window opens.

2. Select the Accounts page.
3. Select the Add button to select the type of email account to set up (POP, IMAP, or Exchange).
4. Configure the account:

a. Define global settings for a POP or IMAP account
b. Define global settings for a Microsoft Exchange Account

5. Select the Spell Check E-mail check box to have CSM spell check emails as messages are typed.
6. Select the Make Default Account button to make the selected account the default account for

sending emails.
7. Select OK.
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Implement Email Notifications
Use the Current System Stored Values to determine email senders and recipients for email notifications.
This is especially useful when email templates are created, and ensures that email notifications are sent
to a test account (rather than to actual customers) when the system is in a testing environment.

When ready to transition to Production, change the Current System Stored Values to Production to have
email notifications sent to Customers.

Note: Email Actions in default Incident One-Step Actions use templates with the Current System
Stored Values. Use these as a starting point, edit them, or create your own.

To implement email notifications (example: In One-Step Actions, Automation Processes, etc.):

1. From a One-Step Action or Automation Process, create a new Send Email action.

2. Configure test and production account Stored Values.

3. In the E-mail Message window, use the System State E-mail Expression for the From Address field:
a. Right-click in the From field to open the Token Selector and expand Expressions.

b. Select Browse to open the Expression Manager.

c. In the Manager tree, select the Global folder.

d. Select System State E-mail.

This Expression states that if the Current System Stored Value is set to Production, then the
Current System Production Email Sender Stored Value is used as the sender's address. If the
Current System Stored Value is set to DEV, then the Current System DEV Email Sender
Stored Value is used as the sender's address.
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4. In the E-mail Message window, define a Custom Expression for the To Address field using the test
and production account Stored Values:

a. Right-click in the To field to open the Dynamic Value Selector and expand Expressions.

b. Select New Custom Expression to create a new case Expression.

This Expression uses the Customer's email address (from the email address field on the
current record) as the default recipient address unless the Current System Stored Value is set
to DEV. If the Current System Stored Value is set to DEV, then the Current System DEV E-
mail Recipient Stored Value is used as the recipient's address.
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Configure the Production Email Account
When ready to transition the email system to production, change the Current System Stored Values from
Development (default) to Production to activate all user and customer emails. Once changed, emails are
no longer sent to users and customers during development.

To set the Current System Stored Value to production:

1. In the CSM Administrator main window, select the Settings category, and then select the Open
Stored Values Manager task.

The Stored Value Manager opens, listing the existing Stored Values.

2. In the Manager tree, select the Global folder.

A list of globally available items opens in the main pane.

3. Right-click the Current System Stored Value and select Edit.
4. Delete DEV from the Value field.

5. In the Value field, type Production.
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Configure Outlook Integration
Configure CSM to integrate with Microsoft Outlook and interact with CSM Business Object Records
directly from the Outlook interface.
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Configuring CSM Outlook Integration
Configurations in CSM Administrator

Use CSM Administrator to configure CSM to integrate with Microsoft Outlook and interact with CSM
Business Object Records directly from the Outlook interface.

To configure an Outlook Integration Configuration:

1. Configure Outlook Integration security rights: Determine who can set or override defaults, run the
Add-In from Outlook, and add, edit, or delete Outlook Integration Configurations.

2. Create an Outlook Integration Configuration in CSM Administrator: Use the Configure Outlook
Integration window (accessed from the Outlook Integration Manager) to create an Outlook
Integration Configuration and define:

a. General settings for the Outlook Integration Configuration: Name, description, auto-link
options, and Conversation ID options.

A Conversation ID is a unique, alphanumeric identifier that correlates an email message with a
particular conversation so that it can be associated with a CSM Record. CSM inserts
Conversation IDs into emails to identify if a particular email is a reply to a previous message
that was associated with a specific Business Object record. A Conversation ID looks similar to
the following: {CMI: ABCD1234}, where ABCD is an identifier for the particular CSM system
(set this value in the History Attachment Options for a global e-mail account), and the numeric
indicator is the specific Conversation ID. The number is automatically incremented for each
message.

b. Customer Identification settings for the Outlook Integration Configuration.

c. Which Business Objects can be linked to Outlook emails.

3. Configure Outlook Integration Configuration Defaults: Define which Roles can view and use which
Outlook Integration Configurations.
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Outlook Integration Manager
Use the Outlook Integration Manager to complete general CSM Item Manager operations for Outlook
Integration Configurations.

You can use the Outlook Integration Manager to disable an Outlook Integration. The disable icon 
indicates that an Outlook Integration is disabled. Enable/disable Outlook Integrations either by right-
clicking the item or by selecting Disabled from the Edit menu.

1. Manager Tree:

Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
Searches run during the session.

2. Main Pane:

Displays items by View (Icon, List, or Details [Grid]) and lists search results when a Search is run.
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General Settings Options for an Outlook
Integration

Define general settings such as name, description, user override and exclude rules, and Conversation ID
options for Outlook Integrations.

Use the General page in the Configure Outlook Integration window (accessed from the Outlook
Integration Manager) to define general settings.

To define general settings for an Outlook Integration Configuration:

Name Provide a display name (this property can be searched in CSM Item Managers).

Description Provide a description (this property can be searched in CSM Item Managers).

Auto-Link
Options

Enable auto-linking for incoming Outlook emails, and then define exclusion rules,
embedded property rules, and override options.

Default to Auto-
Linking Incoming
E-mail

Select this check box to automatically associate incoming emails from a monitored
folder with a Business Object Record (a Journal - Mail History Record is created).

Note: An email message is auto-linked only if CSM can identify a Customer from
the email, and then associate the Customer with a specific Business Object
Record. Otherwise, messages must be manually linked to Customers and
Business Objects.

Clear Embedded
properties from
Messages before
Sending

Select this check box to have embedded properties removed from emails sent
from Outlook.

Note: The Cherwell Outlook Add-In adds a single embedded property to outgoing
messages to enable recipients who also use the Add-In to see when an email is
already linked to a Business Object Record. Although this is just one small
property, Exchange Servers can only handle a limited number of unique
embedded properties, and might reject incoming emails that contain new,
unmapped properties. This limitation is sometimes encountered on Exchange
2007 and earlier (less likely on Exchange 2010 and later), but rarely warrants
removing the Add-In's embedded properties from outgoing emails. Leave this box
cleared so that other email recipients who use the Add-In can see link information.
The ability to see this information makes it less likely that the same message will
be linked multiple times.

Tip: Select the Information button to view this same information.

Allow Users to
Override Auto-Link
Settings

Select this check box to allow users to override the default auto-link settings when
configuring the Outlook Integration in Microsoft Outlook.
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Exclude
Select this button to define Skip Item Rules for determining which incoming
messages are discarded based on defined criteria (example: skip emails from
automated systems).

Define
Conversation ID
Options

Define whether to have Conversation IDs added to outgoing emails.

A Conversation ID is a unique, alphanumeric identifier that correlates an email
message with a particular conversation so that it can be associated with a CSM
Record. CSM inserts Conversation IDs into emails to identify if a particular email
is a reply to a previous message that was associated with a specific Business
Object record. A Conversation ID looks similar to the following: {CMI: ABCD1234},
where ABCD is an identifier for the particular CSM system (set this value in in the
History Attachment Options for a global email account), and the numeric indicator
is the specific Conversation ID. The number is automatically incremented for each
message.

Conversation IDs
Options

Select this check box to include Conversation IDs in outgoing emails.

Note: When a Conversation ID is found within an email message, CSM can
immediately find the record (example: Incident) associated with the various
emails. If Conversation IDs are not used, then it can still identify records, but it has
to use less reliable techniques, such as comparing the details of the subject line.

Add to Subject
Line

Select this radio button to include the Conversation ID in the subject line of
incoming emails.

Add to Body

Select this radio button to include the Conversation ID in the body of incoming
emails.

Note: Do not delete Conversation IDs from email messages. Doing so makes it
harder for CSM to associate customer replies with the correct record.
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Define Skip Item Rules for an Outlook Integration
Configuration

Skip Item Rules are defined criteria that determine which emails from a monitored account are discarded
(and not processed). For example, anything identified by a spam filter can be thrown out automatically.

Also, specify recipient addresses so that items such as global company announcements can be ignored
(and Incidents are not created from them). The discarded emails are not automatically linked to Business
Objects.

Note: Users can define Skip Item Rules for an Email Monitor.

To define Skip Item Rules:

Word/phrase Provide the text to search for incoming emails.

Appears In Select which part of incoming emails you want CSM to search for the specified word/
phrase (example: Subject).

Anywhere Select this radio button to have CSM search anywhere in the Appears In location for the
specified word/phrase.

Begins with Select this radio button to have CSM search the beginning of the Appears In location for
the specified word/phrase.

Ends with Select this radio button to have CSM search the end of the Appears In location for the
specified word/phrase.
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Define Customer Identification Options for an
Outlook Integration

Use the Identify Customer page in the Configure Outlook Integration window (accessed from the Outlook
Integration Manager) to define options for identifying customers and associating them with the appropriate
Customer and Business Object Records.

Note: The options for identifying customers are ordered hierarchically. If more than one option is
selected, CSM attempts to identify customers by the first option selected, then by the second, etc.
For example, if Find Customers by E-mail Address and Custom is selected, CSM attempts to
find the customer by email address first; if it cannot identify a customer using that method, it
attempts to identify the customer based on the Custom settings.

To define Customer Identification options:

Find
Customers
by E-mail
Address

Look up the sender's email address in the email field of the appropriate Customer
Object, and then specify which field CSM should search in Customer objects. This is
useful if emails are received from a particular company but do not necessarily know who
at the company will be sending the emails (example: If an email comes in from
Bob@Example.com, the system searches the Business Object and Field for
Example.com).

• Use Default E-mail Address Fields: Select this radio button to have CSM look in
the Customer Object (and its associated children) in the field that is marked as the
email field. Tip: This is almost always the most appropriate option.

• Search All Contact Manager Objects: Select this check box to have CSM search
email fields in all objects in the Contact Manager. Note: It is possible to include
other objects in addition to the Customer Object in the Contact Manager (example:
External data). If Customers are kept in an External Business Object or other
custom object, then check this option to include it in the search.

• Custom Business Object or Field: Select this radio button to have CSM always
search a particular Business Object and look in a particular field to identify
Customers, and then select the Business Object and Field in the drop-down lists.

Note: This is an advanced option for use when email addresses are stored in a
non-standard object for specialized use (example: A server list that sends
alerts). If these are not requirements, use the Customer - Internal Business
Object default.
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Find
Customers
by Domain

Look up the sender's domain in a specified Business Object and Field (select the
Business Object and Field in the drop-down lists).

Note: In order for this to work, the selected Business Object must be configured to have
an appropriate field containing the domain. Create a field and either require it to be
manually filled or use an Expression to determine the domain from the already-entered
email address (which can be done easily using a Text After Modifier).

Custom

Look up Customers by searching for a value in a Business Object that are specified. This
is useful if Customers need to be identified using information other than an email
address. This option uses information other than the sender's e-mail address (ex:
Subject) to identify Customers. In the drop-down, select what and where CSM should
search:

• Value to Find: Select the area of the email (example: Subject) to search.

• Business Object: Select the type of Business Object to search.

• Field: Select the field to search in the Business Object.

Default
Customer to
Use

Select a default Customer from the Contact Manager (select the Ellipses button). CSM
uses the default customer with which to associate Business Objects if the customer
cannot be identified using the other methods. This option designates a default customer
if CSM cannot identify a customer using the other methods. This is useful to
automatically link emails from unknown addresses to a particular place for later review.

Related concepts
Outlook Integration Manager
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Define Which Business Objects can be Linked to
Outlook Emails

Use the Objects page in the Configure Outlook Integration window (access from the Outlook Integration
Manager) to define which Business Objects can be linked to Outlook emails.

To define which Business Objects can be linked to Outlook emails:

Add Select a type of Business Object to add to the list (ex: Incident)

Edit Edit the settings for the highlighted type of Business Object

Remove Remove the selected Business Object type and associated settings.

Up/Down
Arrows Change the order of the Business Objects.

If Adding or
Editing:

This is only applicable when adding or editing a Business Object.

• General: Defines basic properties for the Business Object.

• Update Behavior: Defines behaviors when updating a Business Object Record
from an Outlook email.

• Create Behavior: Defines behaviors when creating a new Business Object
Record from an Outlook email.

• Available Actions: Adds One-Step Action Actions that can be executed on the
linked Business Object Record.

Related concepts
Outlook Integration Manager
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Define General Options for Business Objects
Linked to Emails

Define basic properties for Business Objects that are linked to Outlook emails. These properties
determine which Business Object Records the Cherwell Outlook Add-In lists as potential link items.

Define potential link items to show for the identified customer. For example, if an Outlook Integration
Configuration identifies a customer (based on the Customer Identification settings), but cannot find a
definitive Business Object to link to, it suggests potential link items that the user can select from.

To define general properties for Business Objects linked to emails:

Related Items Lists the most recent records based on a specified Relationship (example:
Incidents associated with the identified Customer).

Main <Business
Object> Only

Lists only the identified Customer as a link item.

Note: This option is only applicable if the Business Object selected on the
Objects page is a Customer Object (example: Customer - Internal). In this
case, using a Relationship does not make sense because the linkable
object is the Customer Record itself (rather than a Business Object related
to the Customer Record).

If Customer is not part
of the Customer bus-ob
group, automatically
determine potential link
items

Lists related Business Object Records for an identified customer who is not
part of the CSM Customer Business Object Group (example: an external
Customer Business Object). In this case, the system searches all of the
Relationships for that object until it finds one whose child type is the same
as the Business Object specified on the Objects page.

Allow Creation of new
<Business Objects (ex:
Incidents)> from
Outlook

Allows Business Objects to be created directly from the Outlook Add-In. If
this option is cleared, the Create Behavior page disappears.

Display New Record
before Saving

Shows new Business Object Records created from the Outlook Add-In
before being saved in CSM. This gives the user a chance to tweak records
and potentially fill in required information that could not be determined
automatically.

874

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=about_relationships


Define Update or Create Behaviors for Business
Objects Linked to Emails

Use the Update Record Behavior page and the New Record Behavior page to define behaviors for
updating or creating Business Object Records from Outlook emails.

To define update or create behaviors for Business Objects linked to emails:

Attach Outlook e-
mail to to
Business Object
(example:
Incident)

Attaches incoming emails to linked Business Objects as Journal - Mail History
Records.

Import
Attachments as
Part of E-mail

Imports email attachments along with incoming emails.

Options: Select this button to define rules for excluding attachments based on size
or type of file.

Attach E-mail
Attachments to
<Business Object
(for example,
Incident)>

Attaches email attachments to Business Object Records (not just to the internal
copy of the email).

Note: If this option is selected, email attachments are stored in Business
Object Records as Attachments. For more information, refer to the
Attachments documentation.

Preserve Inline
Images within E-
mail Body

Preserves images within the body of incoming emails with the text of the email.

Note: The target Field must be configured to store Rich Text for this to
work correctly.

Attach Inline
Images to
<Business Object
(for example,
Incident)>

Attaches images within the body of incoming emails to the selected Business
Object.
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Attach Outlook E-
mail to
Customers

Attaches incoming emails to Customer Records as Journal - Mail History Records.
Select the Options button to define which Customer Records to attach emails to:

• Attach to Customer (From address): Attach emails to Customer Records
that are identified from the addresses in the From line.

• Attach to Customers in CC Line: Attach emails to Customer Records that
are identified from email addresses in the CC line.

• Attach to Parents of Customers (for example, company that contact
works for): Attach emails to Parent Records of Customer Records (for
example, if an email sender is a contact that works for a particular company,
the email can be attached to the Company Record as well as the Customer
Record).

Note: This capability, along with the ability to attach to a particular Business Object,
can mean that an incoming email is attached to a specific Incident, the Customer
who sent the email, other Customers who were also CC’d on the message, and
even to the company for whom the Customer works. This powerful feature means
that the communication history about a particular record, or all communication from
a particular Customer or company, can be seen (although, of course, there is the
potential for significant overhead).

Store E-mail as
Plain Text

Discards Rich Text formatting contained in incoming emails and store them in
Journal - Mail History Record as plain text. Do this to reduce the amount of space
used by messages.

Actions  
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Add

Sselect Actions from a list. The following Actions are available:

• Create New <Business Object (for example, Incident)> (only available on the
Create Behavior page): Creates a new Business Object Record (of the type
selected in the Objects page of the Configure Outlook Integration window)
based on information from incoming Outlook emails. Specify which Fields are
populated, and the values of those Fields.

• Update <Business Object (for example, Incident)>: Updates a Business
Object Record (of the type selected in the Objects page of the Configure
Outlook Integration window) with information from incoming Outlook emails.
Specify which Fields are updated and the values of those Fields.

Note: There must be a create Action (either a direct Action to create a new
Business Object Record or a One-Step Action that contains the same functionality)
when specifying Create Behavior. For an update, however, there is no need to
specify an Update Behavior. Without custom update Actions, a Journal - Mail
History Record can still be associated with the Business Object Record, which is
frequently all that is needed.

• Add to a Queue: Determines which CSM Queue the Business Object Record
(of the type selected in the Objects page of the Configure Outlook Integration
window) is added to (for example, New Request Queue) after it is created or
updated. Select the ellipses button to open the Queue Manager and select a
Queue.

• Run a One-Step Action: Runs a One-Step Action related to the Business
Object Record (of the type selected in the Objects page of the Configure
Outlook Integration window). Select the ellipses button to select an existing
One-Step Action or create a new one.

Edit Edit the highlighted Action.

Copy Create a copy of the selected Action.

Delete Delete the selected Action

Up/Down Arrows Change the order of the selected Actions
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Define Available Actions for Business Objects
Linked to Emails

In addition to creating and updating records, you can arbitrarily make other functionality available to
execute against a linked record. For example, you can configure an Action to add a new Task to the
record (as a reminder to follow up), or to assign the record.

Actions can do anything allowed by One-Step Actions. These Actions are shown as a drop-down list in
the Cherwell Outlook Add-In.

Add, delete, or reorder Actions available for the linked Business Object (specified in the Objects page of
the Configure Outlook Integration window). The Actions specified here show up on the Actions drop-down
list within the Cherwell Outlook Add-In.

To define available actions for Business Objects linked to emails:

Add

Select a type of Action in the drop-down list.

• Add One-Step Action Action: Adds One-Step Actions to the Actions drop-
down list in the Outlook Add-In to execute them directly from Outlook. Select the
Ellipses button to open the Action Manager and select a different One-Step
Action.

Note: When this option is selected, the One-Step Action Manager opens, and
select an existing One-Step Action or create a new one.

• Add Folder: Adds a folder to the Actions drop-down menu in the Outlook Add-In
to organize Actions.

Delete Removes the currently selected Action.

Up/Down
Arrows

Moves Actions up or down in the list (this is how they appear on the drop-down list
within the Outlook Add-In).
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New Action
General
Options

• Action: Shows the name of the Action as it is recognized by CSM (example: the
name of the Dashboard).

Tip: Select the Ellipses button to open the Action Manager and select a
different Action.

• Display text: Provides the text to display on the Action in the menu.

• Image button: Opens the Image Manager, and then select an image to
represent the Action on the menu. Select an existing image or import a new
image.

Define
Expressions for
showing and
enabling
Actions

 

Visible

Shows/hides the Action based on an Expression, and then define the Expression
using one of the following options:

• Stored Expression: Select the Ellipses button to open the Expression
Manager, and then select an existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in numerous places in CSM.

• Custom Expression: Select the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression specifically for this
scenario.

Enabled

Enables/disables the Action based on an Expression, and then define the Expression
using one of the following options:

• Stored Expression: Select the Ellipses button to open the Expression
Manager, and then select an existing stored Expression or create a new stored
Expression. Stored Expressions can be reused in numerous places in CSM.

• Custom Expression: Select the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression specifically for this
scenario.

Begin Group Shows a horizontal line before the menu item, separating it from other Actions.
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Configure Outlook Integration Defaults
Outlook Integration Defaults define who sees what in the Outlook Integration (which roles can see which
Outlook Integrations). Specify default integration configurations for each role.

To configure the Outlook integration defaults:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the Outlook Integration Defaults task.

The Outlook Integration Defaults window opens.

2. Define the Default Integration Configuration for each role:

Note: For more information about roles, refer to the Security documentation on Roles.

a. In the Default by Role area, select a role (example: IT Service Desk).

b. In the Default Integration area, select a Default Integration Configuration in the drop-down
list.

c. Repeat this until a Default Integration Configuration is assigned to each role.

Note: When an Outlook user configures the Cherwell Outlook Add-In, the default configuration
specified here is the one to which she is initially assigned. Depending on Outlook Integration
security rights, the user might also be allowed to select a different Integration Configuration.

3. Select Close.
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Configuring the Cherwell Outlook Add-In in
Microsoft Outlook

View, edit, and create CSM Business Object Records directly from Microsoft Outlook using the Cherwell
Outlook Add-In.

To install the Cherwell Outlook Add-in:

1. Select Start > All Programs > Cherwell Service Management > Tools > Install or Uninstall
Cherwell Outlook Add-In.

2. Select the Install button.

3. After the installation is complete, restart Outlook.

A Cherwell Group appears in the Home tab on the Microsoft Outlook ribbon.

Note: Uninstall the Cherwell Outlook Add-In using the Cherwell Outlook Installer Wizard.
The Add-In can be disabled without uninstalling it (Microsoft Outlook > File tab > Manage
Add-Ins.

4. Configure the Cherwell Outlook Add-in to connect to the CSM database, link emails to CSM
Business Objects, and monitor specified folders.
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Configure the Cherwell Outlook Add-In
Configure the Cherwell Outlook Add-In after it has been installed in Microsoft Outlook. Configuration tasks
include connecting to the CSM database, providing login credentials, setting up auto-linking for incoming
emails, and more.

To configure the Cherwell Outlook Add-In:

1. Select Not Connected from the Cherwell Group in the Outlook ribbon.

If the Add-In has never been used before, a window opens stating that the connection is not
configured.

Note: If the Cherwell Outlook Add-In has been used before, the button may show
Connected. In this case, select Connected. A window opens with CSM connection and login
information, and the ability to edit the configuration.

2. Select Configure.

3. Check the Enable Cherwell Integration check box to enable the Cherwell Outlook Add-In.

4. Select Configure to select a CSM connection to use.

5. Specify connection and login information for the CSM connection that the Cherwell Outlook Add-In
will use:

a. Select the ellipses button and select the appropriate CSM database connection.

Note: If there is only one connection, then select this connection.

b. Provide the login credentials.
◦ Windows Authentication: The Cherwell Outlook Add-In uses Windows authentication to

connect to CSM.

Note: In order to use Windows Credentials, Windows or LDAP must be enabled
in CSM Administrator (that is, Windows and/or LDAP must be supported login
modes (Security > Edit Security Settings > Windows or LDAP.

◦ User ID and Password: The Cherwell Outlook Add-In uses CSM credentials to connect
to CSM, and then provide the User ID and password.

c. Select Test to verify that the Outlook Add-In can connect to CSM.

The name of the CSM connection now appears in the Cherwell Options window next to the
Connection button.

6. Define the remaining options for the Cherwell Outlook Add-In:
a. Outlook Configuration: Select the appropriate Outlook Integration Configuration that was

configured in CSM Administrator.
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Note: A default Outlook Integration Configuration might have been automatically set.
Depending on the security rights, select a configuration other than the default.

b. Auto-Link Incoming E-mails: Automatically associates incoming e-mails from a monitored
folder with a Business Object Record (a Journal - Mail History Record is created).

Note: This option is only available if Users are allowed to override auto-link settings,
configured in CSM Administrator (General settings for OutlookIntegration
Configurations). It only enables processing of e-mails as they arrive in a monitored
folder. If currently existing e-mails should be processed and automatically linked, select
the Rescan Items options in Outlook's explorer UI.

c. Auto-Link Outgoing Reply/Forward: Automatically associates outgoing replies or forwards
of linked e-mails with the same Business Object Record to which the original e-mail is linked.

d. Always Default to Non-Final Only Candidates: The Cherwell Outlook Add-In always lists
only non-closed Business Object Records as potential link items.

e. Folders to Monitor: Click the Ellipses button, select the folders to monitor (example: Inbox),
and then select OK.

The Cherwell Group in the Outlook ribbon (Home tab) shows connected. Users can begin
using the Cherwell Outlook Add-In.
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About the Email and Event Monitor
The Cherwell Email and Event Monitor is a CSM service that automatically monitors email accounts and
event streams, and then performs specified actions, such as creating or modifying records based on email
content or event details.

The Email and Event Monitor is a microservice of the Cherwell Service Host. In addition to connecting to
the database server, it can communicate with the mail server (example: Microsoft Exchange).

The Email and Event Monitor performs the following functions:

• Email monitoring: Email monitoring is a function performed by a CSM Email Monitor to scan an
email account's incoming mail and automatically perform actions based on specified conditions
(example: Update an Incident record with email content if an existing record can be found).

• Event monitoring: Event monitoring is a function performed by a CSM Event Monitor to detect
system events (example: file modifications) and automatically perform actions based on specified
conditions.

Note: CSM currently only supports email monitoring. Event monitoring will be available in a
future release.

To use email monitoring, there must be at least one email account configured in CSM. Email Monitor
processes incoming emails from a monitored account and performs actions, such as attaching emails to
Business Object Records as Journal - Mail History Records, creating or updating records with the
contents of incoming emails, and executing One-Step Actions™ against newly updated or created
Business Object Records.

An Email Monitor is used to watch one particular email account. Create as many individual Monitors as
required, but do not create multiple Monitors that point to the same email account unless all but one is
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disabled. Otherwise, the behavior of the Email Monitor is ambiguous. A Monitor's behavior is defined by a
series of Monitor Items (consisting of conditions and actions) that are configured as needed so that emails
are processed according to business needs.

CSM provides a default Email Monitor (complete with defined Monitor Items). Implement this default
design, edit it, or create a personal design using the Email and Event Monitoring Manager.
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Email Monitor Good to Know
Note the following behaviors and recommendations about using email and the Email and Event
Monitoring Service.

• Manage and create multiple Monitors using the Email and Event Monitoring Manager.

• Each Monitor's behavior is configured using a series of Monitor Items, which include conditions and
actions that define how emails are processed.

• Email accounts cannot be added or modified when you are managing Monitors in a Blueprint or a
mApp Solution. You can only select existing email accounts. If the email account is not found when
the Blueprint or mApp Solution is published, the email account is removed and must be reconfigured
on the target system.

• When pausing or resuming processing, it can take up to five minutes for the pause or resume
operation to take effect. To immediately pause or resume processing, use the Server Manager to
disable the Email and Event Monitor microservice. Also, even while the Email and Event Monitor
microservices is disabled, monitored email accounts continue to receive emails, but those emails
are not processed. When the microservice is resumed, all Email and Event Monitors resume
processing emails.

• System is the only available scope. Create subfolders underneath this scope to organize items.

• Defining options is not required for identifying an existing record. For example, if the Monitor Item is
set up to create a new Incident from an email, it does not need to find an existing record. However, if
one of the conditions for the Monitor Item is to find an existing record, then define how the system
finds the record.

• The options for identifying records are ordered hierarchically. If more than one option is selected
CSM attempts to identify records by the first option selected, then by the second, etc. until it finds an
existing record.

886

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsuite_features%2Fe-mail%2F..%2F..%2Fsystem_administration%2Fserver_tools%2Fabout_the_server_manager.html


Default CSM Email Monitor
CSM provides a default Email Monitor that includes several defined Monitor Items. Start with this Monitor
when testing the CSM email system. Later, edit the default Monitor or create a new Email Monitor to meet
organizational needs.

All default Monitor Items scan incoming emails for an existing customer (using the Email Field of the
Customer - Internal Business Object). If an existing Customer is not found, the Monitor uses the default
Customer Record as a placeholder.

The following is a summary of the default Email Monitor Items:

• Skip Certain Items: Skip Item Rules are defined criteria that determine which emails from a
monitored account are discarded (and not processed). For example, anything identified by a spam
filter can be thrown out automatically. Also, specify recipient addresses so that items such as global
company announcements can be ignored (and Incidents are not created from them). Skip Certain
Items is always the first in the list of Monitor Items, and it cannot be deleted.

• Reopen Incident: The Reopen Incident Monitor Item scans incoming emails for a Conversation ID
associated with an existing Incident Record. If an existing record is found, the Monitor searches the
Subject line of the email for the phrase Reopen. If the Subject line matches, the Monitor executes an
Action that reopens the Incident.

• Change Approved: The Change Approved Monitor Item scans incoming emails for a Conversation
ID associated with an existing Approval Record. If an existing record is found, the Monitor searches
the Subject line of the email for the phrase Change Request Approved. If the Subject line matches,
the Monitor executes an Action that changes the Approval status of the Change Record to
Approved.

• Change Denied: The Change Denied item scans incoming emails for a Conversation ID associated
with an existing Approval Record. If an existing record is found, the Monitor searches the Subject
line of the email for the phrase Change Request Denied. If the Subject line matches, the Monitor
executes an Action that changes the Approval status to Denied.

• Change Abstained: The Change Abstained item scans incoming emails for a Conversation ID
associated with an existing Approval Record. If an existing record is found, the Monitor searches the
Subject line of the email for the phrase Change Request Abstained. If the Subject line matches, the
Monitor executes an Action that changes the Approval status to Abstained.

• Update Existing Incident: The Update Existing Incident item scans incoming emails for a
Conversation ID associated with an existing Incident Record. If an existing record is found, the
Monitor attaches the email to the Incident (including any email attachments).

• Default: The Default Monitor Item consists of actions that a Monitor performs if no other conditions
are true. Default is always the last item in the list of Monitor Items, and it cannot be deleted. It is
configured the same way as a new Monitor Item, except that it has no Conditions page. Its built-in
condition is that none of the actions for the other Monitor Items were executed because their
conditions were not met. By default, this Monitor Item creates a new Incident from the email.
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Using Email Monitoring
When using email monitoring, users can pause or resume processing of the Email and Event Monitor
Service and process incoming emails. As a prerequisite, at least one email account must be configured in
CSM.
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Pause/Resume Email and Event Monitor Service
Processing

Use the Pause/Resume Monitoring task in CSM Administrator to temporarily pause, and then resume
Email and Event Monitor Service processing.

Pausing the service does not stop the Email and Event Monitor Service; rather, it suspends the service so
that, when resumed, the service can pick up where it left off. Pause processing to suspend processing
emails from monitored accounts, or resume processing to continue processing emails, starting with emails
that are received from that point forward. The ability to pause or resume monitor processing is controlled
by Email and Event Monitor security rights.

To pause or resume Email and Event Monitor Service processing:

1. In the CSM Administrator main window, select the E-mail and Event Monitoring category, and then
select the Pause/Resume Processing task.

2. Select to pause or resume:
a. Pause E-mail and Event Monitor Server: Select this check box to pause processing. Provide

a reason for pausing processing.
b. Resume E-mail and Event Monitoring Server Processing: Select this check box to resume

processing.
3. Select OK.
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Process Incoming Emails
An Email Monitor processes emails from a monitored account according to a series of Monitor Items,
which consist of actions that are performed based on a set of conditions.

Configure conditions, such as finding an existing record, an existing customer, and/or finding specified
information in particular parts of an email. If an incoming email meets the conditions, the Email Monitor
executes four defined actions:

• Attaching emails to Business Object Records as Journal - Mail History Records.

• Creating or updating Business Object Records with the contents of incoming emails.

• Adding newly updated or created Business Objects Records to a CSM Queue.

• Performing One-Step Actions against newly updated or created Business Object Records.

By default, each Monitor has Monitor Items for Skip Item Rules to exclude certain emails from being
processed (example: Company-wide administrative announcements) and default actions to perform if an
incoming email does not meet any of the conditions associated with the other Monitor Items. Configure as
many additional Monitor Items as needed for a particular Email Monitor.

Note: If a monitored email address is not included in the To: field, the Email and Event Monitor
Service processes emails using addresses in the CC: field first, and then the CC: field. Email
addresses in the BCC: field are not visible in Journal entries. To include the email address in the
Journal entry, add it to the the To: or CC: field.

If the monitored account is an IMAP or Microsoft Exchange account, select what to do with emails after
they are processed. Have the emails deleted, marked as read, or moved to a specified folder. Emails from
POP accounts are automatically deleted after they are processed (POP does not support folders).
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Implementing Email Monitoring
When implementing email monitoring, use the default CSM email monitor as a starting point to implement
and test email monitoring. When ready to transition to production, configure the Email and Event Monitor
account and create an email monitor.

To implement the default Email Monitor:

1. Define the monitored account.
2. Send a test email through the E-mail Monitor.

Tip: Alternatively, configure these settings using the Getting Started page in CSM
Administrator (Help > Go to Getting Started Page.

891

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Define General Settings for the Default Email
Monitor

Use the Email and Event Monitoring Manager in CSM Administrator to define the monitored account and
review default monitor items.

The default Email and Event Monitor provides several common monitor items.

To implement the default Email Monitor:

1. Open the Email and Event Monitor.
2. In the Email and Event Monitoring Manager, right-click the Demo Monitoring E-mail Monitor, and

select Edit.
3. In the E-mail and Event Monitor window, select the General page.
4. Define general properties:

a. Name: Provide an alternative name for the default Monitor.
b. Description: Provide an alternative description for the default Monitor.
c. Culture: In the drop-down list, select the culture used by the Email Monitor. If your system

uses multiple cultures, you must create an Email Monitor for each culture. For more
information, see Managing the E-mail Monitor for Multiple Cultures.

Note: This option applies to CSM Globalization features. If only one culture is used in
your system, you can ignore this setting.

d. Account: In the drop-down list, select the test sender account.
e. Do not download linked images: Select this check box to automatically discard images that

are attached to an incoming email with a URL. Use this option if your server restricts outbound
internet requests. Clearing this check box if your server restricts outbound internet requests
causes the Email Monitor to timeout.

f. Allow matching to/from address (warning: may create send loop): Select this check box
to allow processing of emails with matching to and from addresses. This option is only enabled
when opened from within a Blueprint.

5. Review the default Customer Identification settings.
6. Review the default Monitor Items.
7. Select OK.
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Send a Test Email through the Email Monitor
Test the default Email Monitor to ensure that Email Accounts and Email and Event Monitor settings work
properly.

To test the default Email Monitor:

1. Send a basic email to a test CSM account.
a. Access the test receiver account (example: ServiceDeskTESTReceiver@company.com) via

an email service.
b. Create a new email.
c. Provide the test sender email address in the To line of the email.

Note: This is the account monitored by the Email Monitor.

d. Type Test in the subject line.
e. Type Test in the body of the email.
f. Send the email.

The email is automatically sent to the Email Monitor to be scanned for properties that match
the defined Monitor Items. Since the email does not contain any Monitor Item properties, the
Email Monitor initiates the default Monitor Item, which creates an Incident in CSM.

2. Open the Incident created by the email.
a. Open the CSM Desktop Client.
b. Select Searching > All Incidents.

A list of Incidents opens in the main pane.
c. Select the Created Date Time column header to view the record first.
d. Double-click the incident to open the record in the main pane.

Note: If the email is not immediately visible in the list of Incidents, wait a few moments
for the Email Monitor to recognize the account changes and scan the account. If
Incident is still not visible, make sure the appropriate default Email Monitor settings are
selected.
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Configure the Production Email and Event Monitor
Account

After testing the default Email Monitor using a test email account, and you are ready to transition to
production, select the production email account for the Email Monitor to use.

To select the production account:

1. Open the E-mail and Event Monitor
2. Right-click the Demo Monitoring E-mail Monitor, and then select Edit.
3. Select the General page.
4. Select a culture for the Email Monitor. For more information, see Managing the Email Monitor for

Multiple Cultures.
5. Select the Account drop-down list and select the production account (example:

support@company.com).
6. Select OK so that the Email and Event Monitor now monitors the production account.
7. Select Close.
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Managing Email and Event Monitoring
Email and Event Monitors are managed using the Email and Event Monitoring Manager. You can create,
edit, disable, delete, or pin an email monitor.

CSM currently only supports email monitoring, so the only items in the Manager are Email Monitors.

E-mail and Event Monitoring Manager
Use the Email and Event Monitoring Manager to complete general CSM Item Manager operations for
Email Monitors. The small disabled icon  indicates that a Monitor is disabled. Enable/disable Monitors
either by right-clicking on the item or by selecting Disabled from the Edit menu.
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Open the Email and Event Manager
The Email and Event Monitoring Manager is located in CSM Administrator in the Managers menu.

To open the Email and Event Monitoring Manager:

• In the CSM Administrator main window, select E-mail and Event Monitoring > E-mail and Event
Monitoring Manager.

• In the Blueprint or mApp Editor menu bar, in CSM Administrator, select Managers > E-mail and
Event Monitoring.
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Create an Email Monitor
Use the Email and Event Monitoring Manager to create Email Monitors to meet the specific needs of a
company.

Create as many individual Monitors as required, but do not define multiple Monitors that monitor the same
email account unless all but one is disabled; otherwise, the behavior of the Email Monitor is ambiguous.

To create a Monitor:

1. Open the E-mail and Event Monitor.
2. Select a subfolder (if needed).

3. Select the Create New button .
4. Define general options for the Email Monitor (General page):

Note: To use email monitoring, there must be at least one email account set up.

5. Define identity customer options to associate with incoming emails (Customer Identification page).
6. Define conditions and associated actions for a Monitor (Monitors page).
7. Configure Email Monitors.
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Define General Options for an Email Monitor
Define general options for the Email Monitor, including name, description, culture, monitor email account,
account settings, and more.

Use the General page in the E-mail Event Monitor window (accessed from the Email and Event
Monitoring Manager) to define the general settings for the Monitor.

To define general settings for an Email Event Monitor:

Option Description

Name Provide a name (this property can be searched in CSM
Item Managers).

Description Provide a name (this property can be searched in CSM
Item Managers).

Culture

Select the culture used by the E-mail Monitor. If your
system uses multiple cultures, you must create an
Email Monitor for each culture. For more information,
see Managing the E-mail Monitor for Multiple Cultures.

Note: This option applies to CSM Globalization
features. If only one culture is used in your
system, you can ignore this setting.

898

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_using_email_monitor_multiple_cultures


Option Description

Monitor E-mail Account

Select an email account to monitor.

• Select the account drop-down list to select an
existing global email account to monitor.

• Select the ellipses button to open the E-mail
Accounts window and select an existing account
or configure a new one if needed.

Note: This option is not available when
you create an Email Event Monitor from a
Blueprint or a mApp solution. You can
only select existing email accounts. If the
email account is not found when the
Blueprint or mApp Solution is published,
the email account is removed and must
be reconfigured on the target system.

• Select the Do not download linked images
check box to automatically discard images that
are attached to an incoming email with a URL.
Use this option if your server restricts outbound
internet requests. Clearing this check box if your
server restricts outbound internet requests causes
the Email Monitor to timeout.

• Select the Allow matching to/from address
(warning: may create send loop) check box to
allow processing of emails with matching to and
from addresses. This option is only enabled when
opened from within a Blueprint.
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Option Description

Define Account-Specific Settings

This only applies if an IMAP or Microsoft Exchange
account is selected as the monitored account. POP
accounts do not have options for handling processed
messages; they are always deleted.

Select options for how to handle processed emails and
emails that cannot be processed due to an error.

• Delete: Deletes emails after they are processed,
or if an error occurs during processing.

• Mark as read: Marks emails as read after they
are processed, or if an error occurs during
processing.

Note: If this option is selected, emails are left in
the monitored folder. Periodically clear the
monitored folder to prevent performance
issues.

• Move to folder: Moves emails to a specified
folder after they are processed, or if an error
occurs during processing. Select a folder in the
drop-down list.

Related tasks
Configure a Global Email Account
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Customer Identification Options for an Email
Monitor

Use the Identify Customer page in the E-mail Event Monitor window (accessed from the Email and Event
Monitoring Manager) to define options for identifying Customers and associating them with the
appropriate Customer and Business Object Records.

Note: The options for identifying customers are ordered hierarchically. If more than one option is
selected, CSM attempts to identify customers by the first option selected, then by the second, etc.
For example, if Find Customers by E-mail Address and Custom is selected, CSM attempts to
find the customer by email address first; if it cannot identify a customer using that method, it
attempts to identify the customer based on the Custom settings.

To define Customer Identification options:
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Option Description

Find Customers by E-mail Address

Look up the sender's email address in the email field
of the appropriate Customer Object, and then specify
which field CSM should search in Customer objects.

• Use Default E-mail Address Fields: Select this
radio button to have CSM look in the Customer
Object (and its associated children) in the field
that is marked as the email field. This is almost
always the most appropriate option.

Search All Contact Manager Objects: Select this
check box to have CSM search email fields in all
objects in the Contact Manager.

Note: It is possible to include other objects in
addition to the Customer Object in the
Contact Manager (example: External data). If
Customers are kept in an External Business
Object or other custom object, then check this
option to include it in the search.

• Custom Business Object or Field: Select this
radio button to have CSM always search a
particular Business Object and look in a
particular field to identify Customers, and then
select the Business Object and Field in the drop-
down lists.

Note: This is an advanced option for use
when email addresses are stored in a non-
standard object for specialized use (example:
A server list that sends alerts). If these are
not requirements, use the Customer - Internal
Business Object default.
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Option Description

Find Customers by Domain

Look up the sender's domain in a specified Business
Object and Field (select the Business Object and Field
in the drop-down lists).

Note: The selected Business Object must be
configured to have an appropriate field
containing the domain. Create a field and
either require it to be manually filled or use an
Expression to determine the domain from the
already-entered email address (which can be
done easily using a Text After Modifier).

Custom

Use information other than the sender's email address
(example: Subject) to identify Customers. In the drop-
down list, select what and where CSM should search:

• Value to Find: Select the area of the email
(example: Subject) to search.

• Business Object: Select the type of Business
Object to search.

• Field: Select the field to search in the Business
Object.

Default Customer to Use

Select a default customer from the Contact Manager
(select the ellipses button). CSM uses the default
customer with which to associate Business Objects if
the customer cannot be identified using the other
methods.

903

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Define Monitor Items for an E-mail Monitor
Define conditions and actions such as adding, deleting, editing, and copying monitor items to tell a
Monitor how to process incoming emails.

Use the Monitors page to define Email Monitor Items.

To define Monitor Items for an Email Monitor:

Option Description

Add Adds a new monitor item.

Edit Edits an existing monitor item.

Delete Deletes an existing monitor item.

Copy Copy the settings for an existing Monitor Item, and
then edit the settings as necessary.

Up/Down Arrows

Select to change the order of the selected items.

The order of the items in the list is important. The
system steps through the list of conditions and
actions in order, until it finds one where the condition
is true, and then it executes the associated actions.
The system does not evaluate any other conditions
and actions once it finds one to execute.

Note: The order of Skip Certain Items
(always appears first) and Default (always
appears last) cannot be deleted or
rearranged.
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Configure Email Monitor Behaviors
Monitor items, with their associated conditions and actions, are at the heart of Email Monitors. Monitor
items determine how a Monitor behaves.

When it finds a condition that is true, it executes the defined actions. Use the Monitors page in the E-mail
and Event Monitor window (accessed from the Email and Event Monitoring Manager) to:

• Add new Monitor Items.

• Edit existing Monitor Items.

• Delete existing Monitor Items.

• Copy an existing Monitor Item, and then edit the settings as necessary.

• Change the order of the Monitor Items (use the up/down arrow buttons).

The Monitors page lists two items by default:

• Skip certain items: Configure rules for eliminating emails that the Monitor should not process.

• Default: Configure actions to execute if no other conditions in the list are found to be true.

Skip certain items is always at the top of the list, and Default is always at the bottom. Add new items
between them. When adding a new item, define:

1. General settings for the Monitor Item: Name, description, and type of Business Object to associate
with incoming emails.

2. How to identify existing records: Methods that CSM uses to identify existing records to associate
with incoming emails.

3. Conditions for the Monitor: The conditions that must be met before the associated actions are
executed.

4. Actions for the Monitor: The actions to execute if specified conditions are true.

Note: The order of the items in the list is important. The system steps through the list of
Monitor Items in order, until it finds one where the condition is true, and then it executes the
associated actions. The system does not evaluate any other Monitor Items once it finds one
to execute.
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Configure Skip Item Rules for an Email Monitor
Skip Item Rules are defined criteria that determine which emails from a monitored account are discarded
(and not processed). For example, anything identified by a spam filter can be thrown out automatically.

Also, specify recipient addresses so that items such as global company announcements can be ignored
(and Incidents are not created from them).

Skip Certain Items is always the first in the list of Monitor Items, and it cannot be deleted. If any of the
Skip Item Rules is true (example: If the text "[SPAM]" is found in the subject), then the email message is
not processed further through the list of Monitor Items. The email message itself is processed according
the account-specific settings for the monitored email account (see the general settings for an Email
Monitor).

Note: Define Skip Item Rules for an Outlook Integration Configuration.

To define Skip Item Rules:

1. Open the E-mail and Event Monitor.

2. Select the Create New button .

The Email Event Monitor window opens.

3. On the Monitors page, select Skip Certain Items..., and then select Edit.

The Skip Item Rules window opens.

4. Add new, delete existing, or reorder Skip Item Rules.

5. Define criteria for the Skip Item Rules (when adding a new item):

Word/phrase Provide the text to search for incoming emails.

Appears In Select which part of incoming emails you want CSM to search for the specified word/
phrase (example: Subject).

Anywhere Select this radio button to have CSM search anywhere in the Appears In location for the
specified word/phrase.

Begins with Select this radio button to have CSM search the beginning of the Appears In location for
the specified word/phrase.

Ends with Select this radio button to have CSM search the end of the Appears In location for the
specified word/phrase.
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Configure Default Actions for an Email Monitor
The Default Monitor Item consists of actions that a Monitor performs if no other conditions are true.
Default is always the last item in the list of Monitor Items, and it cannot be deleted.

The Default Monitor Item is configured the same way as a new Monitor Item, except that it has no
Conditions page. Its built-in condition is that none of the actions for the other Monitor Items were executed
because their conditions were not met. By default, this Monitor Item creates a new Incident from the
email.

Note: If an Email Monitor should handle all incoming messages the same way, have Default as
the only item (aside from Skip Item Rules) in the list of Monitor Items, and then the same list of
actions are performed against every email (that passes the Skip Item Rules) received in the
monitored account.

To configure the Default Monitor Item:

1. Open the E-mail and Event Monitor.
2. On the Monitors page, select Default, and then select Edit.
3. Define general properties for the Default item (General page).

Note: The name for the Default item (Default) cannot be edited.

4. Define how to identify existing records (ID Existing Record page).
5. Define actions for the Default item.
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Configure New Monitor Items
Use the Monitors page in the Email Event Monitor window (accessed from the Email and Event
Monitoring Manager) to add or edit Monitor Items.

To configure Email Monitor Items:

1. Open the Email and Event Monitor.

2. Select the Create New button .
3. On the Monitors page, select a monitor and select Add or Edit.
4. Define general options: Name, description, and type of Business Object to associate with incoming

emails.
5. Define identify existing record options: Methods that CSM uses to identify existing records to

associate with incoming emails.
6. Define conditions options: The conditions that must be met before the associated actions are

executed.
7. Define actions options: The actions to execute if specified conditions are true.
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Define General Settings for E-mail Monitor Items
Use the General page to define basic properties such as name, description, and Business Object for a
Monitor Item.

Name Provide a name (this property can be searched in CSM Item Managers).

Description Provide a name (this property can be searched in CSM Item Managers).

Business
Object

Select a Business Object to associate with the Monitor. Only one type of Business
Object can be selected. The drop-down list displays only Major Business Objects.

Show All: Shows all Business Objects.
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Define Identify Existing CSM Records Options
Use the ID Existing Record page to define how the system should find existing records and associate
them with incoming emails.

To define how to identify existing CSM records:

Attempt to find
existing record Select this check box before selecting any options for identifying existing records

Look for Cherwell
Service
Management
conversation ID

CSM identifies an existing record from the Conversation ID in an email message.

Note: This is the simplest and most reliable way of finding an existing
record, but it only works if an incoming email is a reply to a CSM email.
When an email is sent out from CSM, a Conversation ID can be
embedded in either the message body or the subject. If the message is not
a reply to a CSM message, or if the user deleted the Conversation ID, then
this option does not work.

Try to match
based on subject

CSM identifies an existing record based on the subject line of an email message.

• Ignore Short Subjects: CSM ignores subject lines that are less than 10
characters.

Note: For this option to work correctly, the original email must be attached
to an Incident.

Note: This option is not as reliable as using Conversation IDs. People
often use similar subjects for different issues (example: have problem).
Checking Ignore Short Subjects increases the reliability, as subjects with
only one or two words are less likely to be unique.

Search subject for
ID

CSM identifies an existing record from a Record ID in the subject of an email
message. This is useful receiving messages from automated systems, or if email
senders use a template that always includes the Record ID in the subject.

Look for number CSM searches an email subject for the first whole number.

Number at end of
subject CSM searches for a number as the last item in an email subject
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After term

CSM searches for a Record ID that appears after a particular term. Provide the
term (example: Incident) and select either:

• End of Line: Searches everything in the subject, starting from the specified
term until the end of the subject.

• Next Word/Number: Searches only the word or number after the specified
term.

Between CSM searches for a Record ID between two specified terms, and then provide the
terms.

Search body for
ID

CSM identifies an existing record from a Record ID in the body of an email
message.

After term

CSM searches for a Record ID that appears after a particular term. Provide the
term (example: Incident) and select either:

• End of Line: Searches everything in the subject, starting from the specified
term until the end of the message body.

• Next Word/Number: Searches only the word or number after the specified
term.

Between CSM searches for a Record ID between two specified terms, and then provide the
terms.

Ignore Closed
records

Excludes closed records from the search for an existing record.

Note: This option refers to the final state of the Business Object chosen in the
general settings and varies depending on the object (example: the final state for an
Incident is Closed, for a Knowledge Article is Retired, and for a Change Request is
Completed). If a Business Object does not have a final state (example: Approval),
then this option is not available.
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Define Monitor Item Condition Options
Use the Conditions page to control the conditions that determine whether the associated actions are
executed. The actions are executed only if all of the options selected on this page are true.

To define Monitor Item conditions:

Define the conditions that determine if the associated actions are executed.

Existing
record
found

Select this check box to have associated actions executed if an existing record is found
(using the options selected on the ID Existing Record page).

Expression

Applies an Expression against an existing record that CSM finds.

• Stored Expression: Select the ellipses button to open the Expression Manager, and
then select an existing stored Expression or create a new stored Expression. Stored
Expressions can be reused in numerous places in CSM.

• Custom Expression: Select the Custom Expression button to open the Custom
Expression Builder, and then create a custom Expression specifically for this
scenario.

Note: If this option is selected, actions are executed only if an existing record is
found and the Expression is true.

Customer
found

Associates actions are executed if a customer is identified (using the options selected on
the Identify Customer page in the E-mail Event Monitor window).

Note: If a default customer is specified, that counts as having found a customer.
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Field/
Operator/
Value

Select these check boxes to have associated actions executed if the specified fields and
values are found.

• Field drop-down list: Select a part of the email message (example: Subject and
Body Combined) to search.

Note: Some field options seem similar, but produce different results when
searching for matched values.

For example, if you select the From field, validation is performed against a
concatenation of the user's name and email address (e.g. "(Henri Bryce)
henri.bryce@address.com"). If you want the validation to run against a
name or email address only, choose From (just name) or From (just
address).

• Operator drop-down list: Select an operator.
◦ Equals: Finds email items where value in field equals value in right-most drop-

down list.

◦ Not equal: Finds email items where value in field does not equal value in right-
most drop-down list.

◦ Like: Finds email items where the value matches the value and its wildcard in
the right-most drop-down list. For example, Jo% will find Joe, John, etc.

Note: Use % or * as the wildcard character. For example, enter John
% to find all email items that start with "John." Do not use the wildcard
character at the beginning of the string if it can be avoided (i.e.,
%SON), because the underlying database query will be very slow.

◦ Not like: Finds all email items that do not match a value and its wildcard.

◦ Empty: Finds all email items where the field value is empty.

◦ Not empty: Finds all email items where the field value is not empty.

◦ Greater than: Finds all email items where the value is greater than the value in
the right-most drop-down box.

◦ Greater or equal: Finds all email items where the value is greater than or equal
to the value in the right-most drop-down box.

◦ Less than: Finds all email items where the value is less than the value in the
right-most drop-down box.

◦ Less or equal: Finds all email items where the value is less than or equal to
the value in the right-most drop-down box.

◦ Contains: Does a SQL Server Full-Text search to find email items that contain
the text in the right-most drop-down box.

◦ Does not contain: Finds email items that do not contain the text in the right-
most drop-down box.

◦ Begins with: Finds email items that begin with the value in the right-most drop-
down box.

◦ Ends with: Finds email items that end with the value in the right-most drop-
down box.

◦ Is: Finds email items where the value in the field is an exact match to the value
in the right-most drop-down box.

• Value: Provide a keyword or phrase, select a date/time, etc.

Note: The operators and values vary depending on the fields chosen. For
example, if Has Attachments is selected in the Field drop-down list, then the
available operators are Equals or Not Equals, and the available values are True
or False.
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Define Monitor Item Action Options
Use the Actions page to define the actions that are executed when the specified conditions are met. The
actions are executed only if all of the conditions are true.

Note: The actions defined on this page are executed in the order they appear. If one action fails,
the remaining actions are not executed. However, the Monitor might still consider the email to
have been handled successfully. Success is determined in the following manner: If there is at least
one Create a new Business Object or Update a Business Object Action, and the first (primary) one
succeeds, then the actions are considered to have succeeded. If the Email and Event Monitor is
configured for logging in the Server Manager, then view these errors in the specified log. If there
are no Create/Update Actions, then all of the actions must succeed for the execution to be
considered successful.

To define Monitor Item Actions:

Specific
Actions  

Attach e-mail
to [Business
Object
(example:
Incident)]

Attaches incoming emails to Business Objects as Journal - Mail History Records.
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Import
attachments as
part of e-mail

Imports email attachments along with incoming emails.

Options: Select this button to define rules for attachments.

Note: File Attachment rights control the Attachment operations that can be
performed in CSM.

• All Attachments/Files: Select this radio button to include all Attachments/files
from the selected Business Object/directory.

• First: Select this radio button to include the first defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

• Last: Select this radio button to include the last defined number of Attachments/
files from the selected Business Object/directory. Then, provide a number or use
the up/down arrows to increase/decrease the number.

Note: If First or Last is selected, Attachments/files are sorted in
alphabetical order if they are from a directory, and by the order of
appearance on the Business Object's Attachment Bar if they are from a
Business Object.

• Include Attachment/File: Select this check box to include Attachments/files
based on file masks (include Attachments/files that contain certain characters,
words, file extensions, etc.). Then, specify the file masks, using semicolons to
separate each mask.

• Exclude Attachment/File: Select this check box to include Attachments/files
based on file masks (include Attachments/files that contain certain characters,
words, file extensions, etc.). Then, specify the file masks, using semicolons to
separate each mask.

• Minimum Size: Select this check box to include Attachments/files that are of a
minimum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down list, select kilobyte or
megabyte.

• Maximum Size: Select this check box to include Attachments/files that are of a
maximum defined size. Then, provide a number or use the up/down arrows to
increase/decrease the number. In the drop-down, select kilobyte or megabyte.

Attach e-mail
attachments to
[Business
Object
(example:
Incident)]

Attaches email attachments to Business Object Records (not just to the internal copy
of the e-mail).

Note: If this option is selected, email attachments are stored in Business
Object Records as Attachments. For additional information, refer to the
Attachments.
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Preserve inline
images within
e-mail body

Preserves images within the body of incoming emails with the text of the email. 

Note: The target Field must be configured to store Rich Text for this to work correctly.

Attach inline
images to
[Business
Object
(example:
Incident)]

Attaches images within the body of incoming emails to the selected Business Object.

Attach e-mail
to Customers

Attaches incoming emails to Customer Records as Journal - Mail History Records.
Select the Options button to define which Customer Records to attach emails to:

• Attach to Customer (From Address): Select this check box to attach emails to
Customer Records that are identified from the addresses in the From line.

• Attach to Customers in Cc Line: Select this check box to attach emails to
Customer Records that are identified from email addresses in the CC line.

• Attach to Parents of Customers (example: company that contact works for):
Select this check box to attach emails to Parent Records of Customer Records
(example: If an email sender is a contact that works for a particular company, the
email can be attached to the Company Record as well as the Customer
Record).

Note: This capability, along with the ability to attach to a particular Business
Object, can mean that an incoming email is attached to a specific Incident,
the Customer who sent the email, other Customers who were also CC’d on
the message, and even to the company for whom the Customer works. This
powerful feature means that the communication history about a particular
record can be seen or all communication from a particular Customer or
company (although, of course, there is the potential for significant overhead).

Store e-mail as
plain text

Discards Rich Text formatting contained in incoming emails and stores them in the
Journal - Mail History Record as plain text. Do this to reduce the amount of space
used by messages.

Define
Custom
Actions
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Add

Select to select actions from a list. The following actions are available:

• Create New [Business Object (example: Incident)]: Creates a new Business
Object Record (of the type selected in the General page of the Event Monitor
Condition and Action window) based on information from incoming e-mails.
Specify which Fields are populated with email contents and the values of those
Fields.

To retrieve data from within an email message, insert the appropriate Email
Contents item (example: body) into the Template section of the Field to populate
(Selector button>E-mail Contents, or right-click>E-mail Contents), and then
right-click the Token and select Modifiers. Use Modifiers such as Text After and
Text Between to extract the text wanted from the email message.

If no options are selected any options for identifying an existing record and an
existing Business Object is not updating, it is typical (though not required) for the
first action to be Create New [Business Object (example: Incident)]. Otherwise,
no record is created for other actions to run against.

• Update [Business Object (example: Incident)]: Updates a Business Object
Record (of the type selected in the General page of the Event Monitor Condition
and Action window) with information from incoming emails. Specify which Fields
are updated and the values of those Fields.

Defining custom actions is not needed to have an email attached to a Business
Object Record as a Journal - Mail History Record. Selecting the Attach email to
[Business Object (example: Incident)] check box is sufficient and frequently all
that is needed.

• Add to a Queue: Determines which CSM Queue the Business Object Record (of
the type selected in the General page of the Event Monitor Condition and Action
window) is added to (example: New Request Queue) after it is created or
updated. Select the ellipses button to open the Queue Manager and select a
Queue.

• Run a One-Step Action: Runs a One-Step Action related to the Business Object
Record (of the type selected in the General page of the Event Monitor Condition
and Action window). Select the ellipses button to select an existing One-Step
Action or create a new one.

If a One-Step Action is created or edited from here, that One-Step Action has
access to email-specific data, such as the email address of the sender, the
subject line, etc. If the One-Step Action is created elsewhere and needs to
reference One-Step Action Tokens, set Show Custom Tokens to Email on the
Conditions page of the One-Step Action.

Edit Edit the highlighted section.

Copy Create a copy of the selected action.

Delete Delete the selected action.

Up/Down
Arrows Change the order of the selected actions.
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Note: To exclude all email attachments from the database, you must clear all these options:

• Import attachments as part of email

• Attach email attachments to Incident

• Attach inline images to Incident
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Disable a Monitor
Disable a Monitor if it has a problem or if there is a need to apply special handling for certain situations
(such as emergencies). For example, define an emergency Monitor and disable it until needed. When
enabling an emergency Monitor, disable the regular Monitors.

Use the Email and Event Monitoring Manager to disable specific Monitors.

Good to know:

• Disabling a specific Monitor only disables a specific Monitor that is selected. It is not the same as
pausing the Email and Event Monitor Service, which affects all enabled Monitors.

• When an Email Monitor is disabled, the monitored email account continues to receive emails.
However, those emails are not processed according to the rules in the disabled Monitor.

To disable an Email Monitor:

1. Open the E-mail and Event Monitor.

2. Select the Monitor to disable.

3. Select Edit > Disabled (or right-click and select Disabled).

The selected Monitor is disabled, and a disable icon  appears on the item in the Email and Event
Monitoring Manager.
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Configuring Email Monitors
Complete the following procedures to configure Email Monitors. Configuration procedures are completed
in CSM Administrator.

To configure Email Monitors:

1. Configure E-mail and Event Monitor security rights: Configure who can access Email and Event
Monitor functionality and data.

2. Configure E-mail Monitor Behaviors: Configure Monitor Items that define how emails are processed
(which actions to execute based on specified conditions).

a. Configure Skip Item Rules: Configure rules for eliminating emails that should not be processed
by the Monitor. This is always the first item in an Email Monitor and cannot be deleted.

b. Configure Default Actions: Configure actions to execute if no other conditions in the list are
found to be true. This is always the last item in an Email Monitor and cannot be deleted.

c. Configure New Monitor Items: Configure additional items for processing emails according to
organization needs.
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Configure a SMTP Relay Server Connection for
Microsoft Outlook

Use the Server Manager to create a Simple Mail Transfer Protocol (SMTP) Connection to avoid possible
Automation Process Service overload. If numerous e-mails are automatically sent from associated
Outlook accounts, a SMTP Relay Server allows outgoing e-mails to be distributed between multiple server
queues. Doing so prevents possible server overload by transferring e-mails from the Automation Process
Service to the SMTP Relay Server.

A SMTP Relay Server Connection requires a Web Server (IIS) Connection. During SMTP installation,
users are prompted to install or upgrade the IIS Connection if needed. For more information about
configuring mail Relay Connections, visit Microsoft's website.

To create a SMTP Relay Server Connection:

1. Install the SMTP Server Role:
a. Open the Server Manager: Click Start > Run > Server Manager > OK.

b. Click the Manage drop-down.

c. Click Add Roles and Features. The Add Roles and Features Wizard opens.

d. Click the Next button on the Before You Begin section.

e. Select the Installation Type radio button (example: Role-based or feature-based installation).

f. Click Next.
g. Select a location for the Roles to be installed (example: Select a server from the server pool).

h. Select the name of the location from the Server Pool field (example: SERVERNAME05).
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i. Click Next.
j. Server Roles:

i. Click Next to accept the default Role selections or customize the selections based on
your organization's needs.

k. Features Section:
i. Select the SMTP Server radio button. An informational pop-up displays and specifies

features of the SMTP server.

ii. Select Add Features to accept these features.

l. Click Next.

Important: Depending on your server version, you may be prompted to install
additional required features for the SMTP Server Connection before installation can
occur. Click Add Features on the notification window to also install the required
components.

m. Review the summary of changes and click Install.
n. Click Close after the installation is finished.

2. Configure the SMTP Server:
a. Open the Internet Information Services: Start > Internet Information Services (IIS) Manager.
b. Ensure an SMTP Virtual Server connection is populated the left-hand navigation pane.

923

CSM 10.0.0 Administration

CSM 10.0.0 Administration



c. If the SMTP Server Connection is missing, right-click on the computer name. If the SMTP
Server Connection already exists, move to Step M.

d. Select New > Virtual Server. The New SMTP Virtual Server Wizard opens.

e. Provide a unique name for the server.

f. Click Next.
g. Select an IP Address from the drop-down.

h. Click Next.
i. Select a Home Directory from the drop-down.

j. Click Next.
k. Provide a Default Domain name for the virtual server.

l. Click Finish. The new SMTP Virtual Server name now populates the left-hand navigation
pane.

m. Right-click on the SMTP Server Connection name and select Properties to customize the
Server Connection to fit your organization's needs.

Important: Virtual Server settings are extremely important if your Relay Server is
connected to the Internet. Security breaches can occur from spam and malware being
sent via an open-Relay Server. We recommend careful customization and working
alongside your organization's Security Team to ensure the Virtual Server Connection is
Security Compliant.

n. Customize the following Properties:
i. General Tab: Provide a Connection time-out limit (example: 10 minutes).

ii. Access Tab: Control forms of Authentication accepted by the server and establish IP
Address or Internet domain access rights.

iii. Messages Tab: Provide data for e-mail messaging limits or accept the default settings.

iv. Security Tab: Click Add to establish which Window's user accounts are allowed to
access the server.
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Add a SMTP Relay Server Connection to CSM
After establishing a SMTP Relay Server Connection, use the CSM Administrator to configure CSM so that
it directs e-mails to the Server connection.

To configure CSM for the SMTP Relay Server Connection, follow these steps:

1. In the CSM Administrator, click the E-mail and Event Monitoring category.

2. Select Edit e-mail accounts and settings. The E-mail Options Manager opens.

3. Click Add > IMAP Account.
4. Provide a Name for the IMAP account.

5. Provide a Name for the Incoming mail server.

6. Select the Outgoing Server section.

7. Provide the Name of the Virtual Server in the Outgoing mail server field.

Note: It is recommended to use the name of your Virtual Server rather than an IP Address
due to the fact that IP Addresses could change. However, both can be used in the Outgoing
mail server field.

8. Select the From Addresses section.

9. Select the Allow user's e-mail address radio button.

10. Select the Allow arbitrary FROM adresses radio button.

11. Click Add to provide a FROM address. A Legal Return Request pop-up displays.

12. Provide an e-mail address in the e-mail address field.

13. Click OK.

14. Click Test Account to ensure the provided e-mail address complies with the Server Relay.

15. Click OK to save the changes and close the IMAP Account Manager.

16. Click OK to close the E-mail Options Manager.

Once the SMTP Relay Server Connection has been established and added to your CSM Administrator
content, e-mails sent through CSM are automatically sent via the Relay Server Connection. To send an e-
mail, select CSM Desktop Client > File > Send E-mail to open and send a new e-mail message.
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System Analyzer
The System Analyzer is a tool that allows advanced users to track behind-the-scene operations in a live
environment directly from the CSM Desktop Client. The System Analyzer can be used for troubleshooting and
assessing performance.
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About the System Analyzer
3-Minute Video: About the System Analyzer

Use the System Analyzer to track operations, including messages related to:

• Business Objects and load timing.

• Table validation and load timing.

• Execution of One-Step Actions.

• System exceptions and errors.

• Technical logging information.

Track all messages or define breakpoints to pause the application when a specific message is found. The
System Analyzer allows Users to step through operations individually to see what is happening behind-
the-scenes.

The System Analyzer includes multiple features, including:

• System Analyzer window.

• Current Object views.

• Message category configuration.

• Export capabilities.

• Latency options.

• Breakpoints.

• Message detail views.

CSM provides an OOTB System Analyzer configuration. Use the configuration as-is, edit it, or define your
own using the System Analyzer window.
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System Analyzer Good to Know
Use these tips for helpful information on the System Analyzer.

• Open the System Analyzer in the CSM Desktop Client (Help > System Analyzer).
• Security rights control access to CSM functionality and are configured in the Security Group

Manager in CSM Administrator (Security > Edit Security Groups). System Analyzer security rights
are grouped with Tools security rights. For more information, see Security rights and Configure Tools
Security Rights.
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System Analyzer Window
The System Analyzer window opens independent of the CSM Desktop Client (Help>System Analyzer).
Use the window to complete the following operations:

• Start/stop the System Analyzer.

• Run/pause the System Analyzer.

• Manage message categories.

• Define latency.

• Define breakpoints.

• View Fields and values in the active Business Object.

• Export message data.

• Clear messages from the window.
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System Analyzer Main Pane
Use the System Analyzer Main pane to view operation information, such as:

• Timestamp: Date and time that the System Analyzer intercepted the operation.

• Category: Category of the message (example: Business Object, Table Validation, etc.)

• Type: Type of definition (example: Relationship, Field, etc.)

• Name: Name of the definition (example: Incident Links Similar Incidents, Incident.ServiceID, etc.)

• Message: Description (details) of the operation.

Good to know:

• You can export data from the System Analyzer Main pane by clicking the Export button  to
share information across systems.
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System Analyzer Message Categories
The System Analyzer uses messages to display operations that occur behind-the-scenes of the CSM
Desktop Client. The category is used to classify the messages listed in the Main Pane, which makes it
easy for you to filter the information.

Good to know:

• Before running the System Analyzer, define the message categories that you want to track.

• The following message categories are selected by default: Business Object, BusOb Load Timing,
Error, One-Step Action, Table Validation Timing, Token Expression Error, and Web Service Call.
Messages are not selected by default if they generate a large number of messages or are only
applicable for 2-tier or 3-tier systems.

The System Analyzer uses the following categories:

Category Description Example

App Service
Call

Tracks calls that have been made from the CSM Desktop
Client to the Application Server.

Notes: This type of message is only applicable if you are
running a 3-tier system. Logging this type of message
might cause unexpected results (example: Pausing on a
remote call might cause timeout errors).

 

Business
Object

Tracks Business Objects, including Fields and
Relationships. Use these messages to find issues related
to Field changes.

(Incident.Location) Value
set to "Colorado
Springs."

BusOb Load
Timing

Tracks the amount of time that Business Object operations
require to load. Use these messages to track messages
related to loading Business Objects and their Relationships.
It can also be used to improve efficiency by eliminating or
grouping operations.

(Customer - Internal)
Retrieved Business
Object: Tracy E. Aubin,
Time: 0.0320019.

Error Tracks various system exceptions and errors.  

One-Step
Action Tracks the execution of One-Step Actions.

(Select User) About to
execute step Select
User.

Other

Tracks all other miscellaneous messages.

Note: These messages are often dependent on the type of
system (2-tier or 3-tier) you are running.
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Category Description Example

Query

Tracks the execution of queries.

Note: This type of message is only applicable if you are
running a 2-tier system.

 

Table
Validation

Tracks Field validation values, which might read from the
local cache or cause queries to the database.

Querying for a Lookup
value in data cache for
Incident Type.Incident
Type: Valid value found.

Table
Validation
Timing

Tracks the amount of time that table validation operations
require. Use these messages to improve performance by
either changing the behavior or marking tables as
cacheable.

Retrieved single row for
Service.Service Name
table validation request:
0.052003.

Token
Expression
Error

Tracks token Expressions.

Note: Token Expressions are used for building text and
number Expressions, which replace tokens and evaluate
the results. These Expressions are also used to build text
(example: Incident.Category). While this is allowed, it can
cause performance issues (particularly on forms with
multiple token Expressions). A check box in the Expression
Editor indicates whether or not the Expression is
calculated. If the token Expression Error message opens in
the System Analyzer, it might indicate that this check box
should be unchecked.

Non-valid token
Expression evaluation for
Field Incident.Matching
Text. Value: Printing.

Web Service
Call

Tracks details related to calls made by the Web Service
One-Step Action.  

Warning Log
Message

Tracks logging information that is unexpected, but does not
cause an error.

Note: These messages are often dependent on the type of
system (2-tier or 3-tier) you are running.

 

Information
Log Message

Tracks detailed (and technical) logging information. These
messages are useful to members of the Support Team.

Note: These messages are often dependent on the type of
system (2-tier or 3-tier) you are running.
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Category Description Example

Verbose Log
Message

Tracks detailed (and technical) logging information. These
messages are useful for the Development Team.

Note: These messages are often dependent on the type of
system (2-tier or 3-tier) you are running.
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Using the System Analyzer
When working with the System Analyzer in the CSM Desktop Client, Users can:
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Open the System Analyzer
To open the System Analyzer from the CSM Desktop Client menu bar, click Help>System Analyzer.
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Run the System Analyzer
Use the System Analyzer window to run the System Analyzer.

Good to know:

• The System Analyzer immediately begins tracking messages by default. If the System Analyzer is

stopped, click the Start button  to begin tracking messages. You can stop tracking messages at

any time by clicking the Stop button .

• Clear messages from the System Analyzer window at any time by clicking the Clear button .

• The System Analyzer only runs when the System Analyzer window is open.

To run the System Analyzer:

1. Open the System Analyzer.

2. (Optional) Configure the System Analyzer.
◦ Define which messages to track.

◦ Define latency.

◦ Define breakpoints.

3. In the CSM Desktop Client, reproduce the issue that you want to test.

A list of messages appear in the System Analyzer Main Pane.

4. (Optional) Navigate breakpoints using the System Analyzer toolbar:

◦ Click the Pause button  to pause the System Analyzer (temporarily stop processing
operations).

◦ If paused, click the Next Message button  to step to the next operation.

◦ If paused, click the Run button  to run the System Analyzer until the next breakpoint.

5. (Optional) Double-click a message in the System Analyzer window to view message details
(example: Category, type, name, ID, and message).

The System Analyzer Message window opens.

6. Close the System Analyzer window.
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View Business Object Fields
Use the Current Object Values window (accessed within the System Analyzer window) to view a read-only
list of Fields and values in an active Business Object directly from the System Analyzer window, rather
than modifying forms to show all Fields or using One-Step Action prompts to show relevant data while
troubleshooting.

Good to know:

• A Business Object record (example: Incident) must be open to view Fields and values.

• All Fields are read-only. Security rights control which Fields you can view.

• To enable the ability to copy a value to the clipboard, select a value in the Value column, and then
double-click the value or press F2.

To view Business Object Fields and values:

1. With an active Business Object record open in the CSM main window, open the System Analyzer.

To open the System Analyzer:

a. From the CSM Desktop Client menu bar, click Help>System Analyzer.

2. Click the Business Object Field Values button .

The Current Object Values window opens.

3. (Optional) Define how Field values are displayed.

◦ Click the Show/Hide Fields button  to show or hide Fields that do not have values.

◦ Click the Sort Fields  button to sort Fields in folders based on type (example: SLA,
Status, Time Tracking, etc.).

◦ Click the Relationships button  to specify whether or not all Business Object
Relationships should be loaded.

Note: If you do not select this option, only the Relationships with data that has been
loaded will display in the Current Object Values tree. If you select this option, the
Current Object Values tree will execute a query against all Relationships and cause
records to be loaded, even if the Relationships have not yet been referenced.
Selecting this option might cause additional loading time, and can potentially alter
expected behaviors because it affects the order in which operations occur. After this
option is selected, de-selecting it will not affect the current record, since the
Relationship data will already be displayed. However, it will affect the data displayed
for the next record that you view.

4. Click Close.
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Export System Analyzer Data
Use the Export System Analyzer Messages window (accessed from within the System Analyzer window)
to export data to share information across systems. Data can be exported to the following file formats:

• CSV (.csv)

• HTML (.html, .htm)

• Plain Text (.txt)

• Rich Text (.rtf)

• XML (.xml)

Good to know:

• Use the Up/Down arrows   to organize the data in the pane. The data will display in this
order in the exported file.

To export System Analyzer data:

1. Open the System Analyzer.

2. Click the Export Messages button .

The Export System Analyzer Messages window opens.

3. Click the Browse button to select a file location for the data.

4. Use the Right/Left arrows   to select which System Analyzer data (columns) you want to
export. Items in the Selected Columns pane will be exported.
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Note: All columns are selected by default.

5. Select OK.

The data is exported to the defined file location.
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Configuring the System Analyzer
Complete the following procedures to configure the System Analyzer. Configuration procedures are
completed in CSM Administrator and the CSM Desktop Client.

You can configure the System Analyzer in the following ways:

• Define System Analyzer security rights.

• Define how to track System Analyzer messages.

• Define System Analyzer latency simulation.

• Define System Analyzer breakpoints.
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Define System Analyzer Messages
Use the Analyzer Messages window (accessed within the System Analyzer window) to define which
messages to track (example: One-Step Action operations).

Good to know:

• The following message categories are selected by default: Business Object, BusOb Load Timing,
Error, One-Step Action, Table Validation Timing, Token Expression Error, and Web Service Call.
Messages are not selected by default if they generate a large number of messages or are only
applicable for 2-tier or 3-tier systems.

• Click the Clear button  to clear all options and click the Select button  to select all standard
options.

To define which System Analyzer messages to track:

1. Open the System Analyzer.

2. Click the Messages button .

The Analyzer Messages window opens.

3. Define message categories by selecting or clearing the corresponding check box:
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◦ App Service (3-tier only) ◦ Table Validation

◦ Business Object ◦ Table Validation Timing

◦ BusOb Load Timing ◦ Token Expression Error

◦ Error ◦ Web Service Call

◦ Modify Value ◦ Warning Log Message

◦ One-Step Action ◦ Information Log Message

◦ Other ◦ Verbose Log Message

◦ Query (2-tier only)  

4. Select OK.
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Define System Analyzer Latency
Use the System Analyzer Options window (accessed within the System Analyzer window) to define the
amount of network latency that you want to simulate.

Good to know:

• Define latency to capture accurate timing data related to CSM operations in order to understand
how latency will affect system performance. This option is helpful as you locally develop a system
that will be deployed to clients that are geographically remote from the server.

• Use networking tools (example: Tracert or Ping) to determine the actual latency between the client
and server before defining the simulated latency in the System Analyzer.

• When the System Analyzer window is closed, simulated latency is disabled, but not cleared. When
the System Analyzer is reopened, the defined latency is enabled until you clear the Add Network
Latency check box in the Options window.

To define System Analyzer latency:

1. Open the System Analyzer.

2. Click the Options button .

The System Analyzer Options window opens.

3. Select the Add Network Latency check box.

4. Click the Up button or Down button to define latency in 50 millisecond increments.

5. Select OK.

The defined latency displays in the System Analyzer window.
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Define System Analyzer Breakpoints
Use the Breakpoints window (accessed within the System Analyzer window) to define breakpoints, which
pause CSM when a specific operation is found.

Good to know:

• CSM will not pause for breakpoints unless the System Analyzer is open and running.

• During the pause, you can examine the data to determine if the application is functioning as
expected, and then step operation by operation to see what is happening behind-the-scenes.

• Delete all breakpoints from the list by clicking the Delete button .

• Deselect all breakpoints by clicking the Clear button .

• Select all breakpoints by clicking the Select button .

• If a breakpoint is deselected, the System Analyzer will not stop when the breakpoint is encountered
during a process. This allows you to save commonly used breakpoints in the Breakpoints window for
later use.

To define a System Analyzer breakpoint:

1. Open the System Analyzer.

2. Click the Breakpoints button .

The Breakpoints window opens.
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3. Click the Add button.

The Edit Breakpoint window opens.

Note: Use the Edit button and Delete button to edit and delete existing breakpoints.

4. Define the breakpoint.
a. Category: In the drop-down, select a category (example: Business Object).

Tip: To search all categories for the breakpoint, select (Any) in the drop-down.
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b. Look for: Specify text (example: Name, ID, or any other text) to serve as the breakpoint
(example: ServiceID).

c. Select OK.

5. Select OK.
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Performance
CSM provides tools to view, analyze, and optimize performance, along with performance best practices to help
you review your system and analyze specific performance issues.

Related concepts
Best Practices for Performance
About Performance Health Check
Creating Indexes
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Best Practices for Performance
For best results, periodically review performance best practices to analyze and troubleshoot performance
issues.

Determine the Affected Location
Communicate with your team at a high level to find out if the entire system or a specific area of the system
is perceived as slow. Specific areas might include:

• CSM Desktop Client

• CSM Administrator (example: Publishing)

• CSM Browser Client

• CSM Customer Portal

• Certain Business Objects (example: Incident, Change Request)

• Internal databases (example: CMDB)

• External databases (example: Active Directory, SCCM)

In addition, determine if the slowness is perceived in one of the following environments:

• Geographic location: Offices in other cities, states, or countries.

• Remote employees: Employees who are connecting via wireless, using a VPN, or working from
home.

• Hosted or on-premises: Installation method of the affected environment.

Evaluate the Installation Configuration
Investigate the installation configuration of the affected environment, which affects how you analyze
performance and who implements the recommendations. After connecting to the environment (either via
the hosted server or via a remote session), consider the following:

• Available memory.

• Available Central Processing Units (CPUs).

Note: If you are using a virtual machine, ensure that all memory and CPUs are dedicated.

• Available disk space.

• Load balancing.

• Subscription numbers.

• Separate installed applications.

• Distribution of servers (on one machine or several).
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Note: Refer to the Sizing and Scalability documentation for information on minimum and
recommended server configurations based on the number/type of CSM Clients.

CSM uses a dedicated message queue system to allow horizontal and vertical scaling for one or more
server components. Scaling CSM enables the system to use a network of machines to distribute work,
providing more resources to alleviate barriers and improve availability. See About the Cherwell Service
Host and Cherwell Service Host Horizontal Deployment and Configuration

Assess Resource Consumption
Determine how resources such as available memory and the number of processors are being used. If the
performance issue is acute, restarting a Server might provide a resolution. If the issue is chronic,
resources might need to be increased or expanded (example: Hosted environments running a version of
CSM of 7.0.0 or later should use a minimum of 6GB of available memory; if you require additional
memory, submit a request from your IT team).

Investigate the Network Environment
If you determine that there are sufficient resources, consider the network environment, including the
network path between Users and the server. Pings, TraceRoutes, and Packet evaluations can help
identify the existence of an issue and diagnose complications with remote locations. After investigation, if
you suspect that a network issue is affecting performance, consider searching for common indicators
(example: All affected Users are using wireless or accessing the VPN).

Evaluate the Business Object Relationship Structure
Review your system structure to determine if Business Object Relationships are loading in a way that
impacts performance. For example, when an Incident loads, the related Journal tab references all
Journals that exist in a one-to-many Relationship between the Incident and Journal Business Objects; by
default, all of these Journal records are loaded, even if they are not referenced by the Incident. Use the
System Analyzer to determine which aspects of the Business Object structure are impacting performance.

You can prevent this from happening using the Advanced page of the Relationship Properties window for
the Relationship by deselecting the Load Immediately check box and selecting the Don't Load When
Constraints are Blank check box.

Assess Memory and CPU Usage
Investigate your server memory and CPU usage to determine if either factor is affecting performance.
Access this information by right-clicking the Windows Task Bar, selecting Start Task Manager, and
selecting the Performance tab. When you have the data, consider the following:

• Memory usage should not consistently rise above 80%. Consider that even though system memory
is in the normal range, a server (example: Automation Process Server) might be running higher than
expected.

• CPU usage should not consistently rise above 80%. Consider that CPU does not necessarily
negatively impact performance, so consider other potential issues, as well.

Common issues that impact memory and CPU include:
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• Setting logging to both Splunk and a file.

• Running a Report that uses all Application Server resources.

• Using an Automation Process continuously, which causes the Automation Process Service to use
additional resources.

If you notice memory spikes when loading an SLA record, specifically, the configuration of the SLA
Business Object could be causing the issue. The Breached Incidents and Open Incident alert bars in the
Quick Info Tile use an Aggregate Expression with a Count function to determine the number of records for
each category; this can cause the system to reference a large number of records, which can result in a
memory leak and issues with the Application Server. To resolve this issue, remove the Aggregate
Expressions from the Form. If you do not want to remove the Expression, consider adding an attribute
with the name RecalculateSetDirty to the field; this identifies the record as saved after the Expression on
the field is run. You can use this solution for any fields that contain an Aggregate Expression with a Count
Function.

Implement Database Maintenance Actions
Define Database Maintenance Actions using the Scheduler to perform selected database maintenance
operations on a scheduled basis. Using these Actions, you can:

• Rebuild Full-Text Search catalog: Rebuild the Full-Text Search catalog when the database
maintenance action is run. CSM uses Full-Text Search for Quick Search and Knowledge Search. If
you have problems with your index getting corrupted, you might want to rebuild the search catalog
once a week or every night.

• Rebuild Business Object indexes: Rebuild Business Object indexes when the database
maintenance action is run. This option allows you to rebuild the indexes of the database tables that
represent particular Business Objects. Then, select the Select button to select which Business
Objects to re-index.

Note: By default, all Business Objects are selected. Clear Business Objects to exclude them
from reindexing, or select Clear All to clear all Business Objects, and then select the ones
you want to re-index. If you have a high volume of data, you might want to rebuild your table
indexes monthly.

• Rebuild system table indexes: Rebuild the indexes of the SQL Server tables associated with CSM
system tables when the database maintenance action is run. These tables start with "Trebuchet"
(the internal code name for the product). If you have a high volume of data, you might want to
rebuild your table indexes monthly.

• Shrink SQL event log: Shrink the SQL Server event log file when the database maintenance action
is run.

Note: Consult with your Administrator before scheduling this option. If in doubt, do not use
this feature unless you run into problems.

• Refresh Queue status: Refresh Queue status when the database maintenance action is run.
Queue status can get out of sync if Business Objects that were on Queues are deleted. This option
ensures that each Queue is synchronized. We recommend scheduling this weekly.
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• Remove unused user accounts: Remove data associated with deleted User accounts when the
database maintenance action is run. When User accounts are deleted from the system, their
authorization information might not be removed. This option ensures that the authorization
information is in sync with the User list by removing the unused information. We recommend
scheduling this weekly.

• Synchronize Team Info with team list: Synchronizes the Team Info Lookup table with CSM User
and Customer Team list.

• Run SQL Traces: Run traces on your SQL using a tool such as SQL Server Management Studio.
This helps you to identify problematic or slow SQL queries that may be causing poor application
performance. For more information on using SQL profilers to run SQL traces, see Microsoft
documentation: https://docs.microsoft.com/en-us/sql/tools/sql-server-profiler/sql-server-profiler?
view=sql-server-ver15

Mitigate Database Growth
Use the E-mail Monitor, Blueprint Publish Log, and Automation Process Log to reduce database growth.
When emails are imported into your system, large attachments can contribute to increased database size.
To keep database growth caused by email attachments under control, you can prevent attachments being
imported and control their size by using the E-mail Monitor Actions.

You can define the following settings for each monitor:

• Attach email to [Business Object (example: Incident)]: Attaches incoming emails to Business
Objects as Journal - Mail History Records.

• Import attachments as part of email: Imports email attachments into the database along with
incoming emails and allows you to define Attachment settings such as type and size.

• Attach email attachments to [Business Object (example: Incident)]: Attaches email
attachments to Business Object Record's Attachment bar (not just to the internal copy of the email).

• Preserve inline images within email body: Preserves images within the body of incoming emails
with the text of the email.

• Attach inline images to [Business Object (example: Incident)]: Attaches images within the body
of incoming emails to the selected Business Object.

• Attach email to Customers: Attaches incoming emails to Customer Records as Journal - Mail
History Records.

Using the Blueprint Publish Log, you can reduce the size of the TrebuchetPublishLogs system table,
which holds historical publishing data. Before clearing the data, ensure that you have the information you
need. Clear the log usingCSM Administrator by selecting File > Clear in the Publish Log window.

Using the Automation Process Publish Log, you can reduce the size of the TrebuchetProcesses system
table, which holds historical publishing data. Clear the log using CSM Administrator by selecting File >
Clear All Processes > Clear Completed Item History in the Automation Process Statistics window.

Investigate Browser Configurations
If the Browser Client loads more than a few seconds slower than the Desktop Client, determine if any
system configurations are impacting performance. Consider the following when investigating the issue:
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• Server memory and CPU usage can cause performance issues with the Browser Client. Review the
standards in the Assess the Memory and Computer Processing Unit (CPU) section for more
information.

• Calendars can cause performance issues due to the amount of data that refreshes each time a
Calendar is opened.

• Automatic Actions can cause issues because the Save Actions are executed before the Save
occurs. Prevent this from happening by creating an Expression for the Actions to run if a condition is
true/false and clearing the Execute Before Saving a Record check box; this allows the system to
only save the record if necessary.

General Server Maintenance
Investigate your server memory usage to determine if Portal performance is being affected as a result.
Access this information by right-clicking the Windows Task Bar, selecting Start Task Manager, and
selecting the Processes tab. Then, you can restart the process or server using the IIS Manager. When
you restart the process or server, the memory use will temporarily decrease, but will continue to increase
afterwards; this might happen because the Application Pool in IIS does not have permissions to write to
the directory and instead of displaying an error, the log messages consume memory. If this happens, you
have several options:

• Using the Portal Logging Options window and the Browser Logging Options window in the Cherwell
Server Manager, change the file path.

• Using the Application Pool Identity window in the IIS Manager, change the Identity for the
Application Pool.

Note: We do not recommend using LocalSystem for a long period of time since it can cause
a security risk.

• Enable file permissions for the Application Pool so it can write log files to your chosen location. See
Securing IIS.

Related concepts
About Performance Health Check
Run the Health Check Tool
Interpreting Health Check Results
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About Performance Health Check
The Health Check tool helps system administrators monitor and optimize system configurations that
impact performance.

For example, use the tool to:

• Discover missing indexes for Business Object database tables that contain a large number of
records.

• See which Business Objects can be set as cachable.

• Find and fix mismatched Def IDs.

• Send Health Check results to Cherwell Support for analysis on request.

There are three levels of Health Check tests:

• Basic: Provides information about your CSM system and the Health Check plug-in. Basic results
are included every time you run the Health Check.

• Rule-based: Provides information for the rules you select when you run the Health Check.

• Usage Statistics: Provides system and database information not related to the rules you select
when you run the Health Check. Examples include expensive database queries, wait statistics, and
table sizes.
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Run rule-based or usage tests alone or as a set.

Related concepts
Run the Health Check Tool
Interpreting Health Check Results
Related tasks
System Information
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Run the Health Check Tool
Run the Health Check Tool to monitor and optimize system configurations that impact performance. You
can select which tests to run and then save the results to a file.

Good to Know

• If you are running CSM version 7.0 or later, you can run the Health Check Tool to inspect a
database.

• We recommend that the SQL Server be running for a minimum of 3 business days before using the
Health Check tool.

• If changes are made, again let the server run for a minimum of 3 business days before using the
Health Check tool.

• Note: In all cases suggestions made for adding or dropping indexes should be made by the
customer and should be done through the product; no indexing changes should be made
through the backend. This is to prevent the next Blueprint publish from wiping the changes
out.

To run the Health Check tool:

1. From the CSM Administrator main window, select the Performance category.

2. Select Run Health Check.

3. Choose which tests to run:
◦ In the Run Selected Rules pane, select the rules to check various areas of your system. The

list of rules available to you may vary depending on the version of CSM and the Health Check
plug-in that you have installed.

◦ Select the Generate Usage Statistics check box to check system and database information.

Note: Some rules and usage statistics require View server state privilege for the
database login account. In SQL Server Management Studio, this privilege is located on
the Securables tab of the Login Properties dialog box.

◦ Select the Select None link to generate CSM system and the Health Check plug-in
information only.

4. Select OK.

The Health Check results open in a separate window. Select Save to File to save the results to an HTML
file; select Submit to send the results to Cherwell Support on request.

Related concepts
Interpreting Health Check Results
Related tasks
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System Information
Business Object Attribute Checks
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Interpreting Health Check Results
After running the Health Check Tool, you can optimize system configurations based on the results of the
basic checks, rules reports and usage statistics.

Basic checks:

• System Information

• Business Object Unique Attribute Checks

• Plugin Manager Rules

Interpreting Rules reports:

• Missing Native REST API Clients

• Runtime Performance Warnings

• Foreign Key Configuration

• Check Canonical Compliance

• Out of Date Index Statistics

• Check Business Objects for Consistency

• Mismatched Def IDs

• Business Object Cachable Check

• Missing Index Rule

Interpreting Usage Statistics:

• Check Database

• Worst Queries by Average Reads

• Worst Queries by CPU

• SQL Wait Statistics

• Table Size Statistics

• Index Usage Statistics

Note: Open your report in a browser.

Related tasks
System Information
Business Object Attribute Checks
Plugin Manager Rules
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System Information
Run the Health Check Tool and select the Select None check box or any rule. This rule gives you a high-
level overview of your system.

Good to Know

• You may be asked to provide some of this information if you contact Cherwell Support.

1. Select the Select None check box or any of the rules when you Run the Health Check Tool.
You see the System Information results as part of the basic checks in the report.

2. Connection shows you the type of connection (2 tier/3 tier) used to run the test.

Note: If the connection is 3-tier, the Cherwell Application Server version is shown and it
should match the CSM version shown above.

3. Check that the System Environment value is Production.

Related concepts
Define Advanced Properties for a Business Object
Related tasks
Business Object Attribute Checks
Plugin Manager Rules
Runtime Performance Warnings
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Business Object Attribute Checks
Run the Health Check Tool and select the Select None check box or any rule. This rule checks that
specific attributes are applied to a unique Business Object in the system.

Good to Know
These are the attributes that are checked:

• CustomerBusinessObject

• DefaultPrimaryBusinessObject

• ConfigurationItemBusinessObject

• JournalBusiinessObject

1. Select the Select None check box or any of the rules when you Run the Health Check Tool.
You see the results in the report.

2. If you get results in this report, you need to remove the duplicate attribute from the affected
Business Object to make sure that they are unique. For example, you cannot have two Business
Objects with an attribute called CustomerBusinessObject.

Related tasks
Plugin Manager Rules
Runtime Performance Warnings
Foreign Key Configuration
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Plugin Manager Rules
Run the Health Check Tool and select the Select None check box or any rule. This rule indicates the
version of the Health Checker being used to run all the performance checks.

1. Select the Select None check box or any of the rules when you Run the Health Check Tool.
You see the Plugin Manager results as part of the basic checks in the report.

2. You may be asked to provide these details if you contact the Cherwell Support.

Related tasks
Runtime Performance Warnings
Foreign Key Configuration
Check Canonical Compliance
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Missing Native Rest API Clients
Run the Health Check Tool and select the Missing Native REST API Clients rule. This rule looks for
missing REST API clients that should have been created when a native application, such as a CSM
Customer Portal, is added to CSM.

Good to Know

• By selecting Browser and Mobile > Site Manager in the CSM Administrator, you can set up
custom login options for a CSM Customer Portal. If your custom login options are not being
displayed on the Portal as expected, then you should run this Health Check rule.

To see information about Missing REST API clients:

1. Select the Missing Native REST API Clients rule when you Run the Health Check Tool.
You see the Missing Client results in the report.

2. If you get any results at all in this report, select Repair in the top right-hand corner of the report.
All missing native client entries are fixed for you.

3. Re-run the Health Check again with this rule to verify that the report is now empty.

Related tasks
Runtime Performance Warnings
Foreign Key Configuration
Check Canonical Compliance
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Runtime Performance Warnings
Run the Health Check Tool and select the Runtime Performance Warnings rule. This rule collates any
performance messages which are logged at runtime as warnings.

Good to Know

• Any warnings that occurred in the past week are shown when the Health Check tool is run with this
rule.

• When the report finishes, the warning records are cleared from the database.

• Two performance issues are reported:
◦ Reports which retrieve rich text fields.

◦ Business Object relationships that retrieve over 1000 rows.

1. Select the Runtime Performance Warnings rule when you Run the Health Check Tool.
You see any warnings from the past week in the report.

2. If you see warnings for reports which retrieve Rich text fields, this can affect performance. To
remove Rich Text fields from a report, clear the Retrieve Rich Text Fields check box.

3. If you see warnings for a Business Object relationship that retrieves more than 1,000 rows, scroll
down to read the guidance. You can change the relationship to load only the keys and/or add
constraints to the relationship to retrieve less values. For example, instead of a relationship
retrieving all of a customer's Incidents, the relationship could retrieve just the last 30 days of
incidents. For more information, see: Define Advanced Properties for a Relationship.

Related tasks
Foreign Key Configuration
Check Canonical Compliance
Out of Date Index Statistics
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Foreign Key Configuration
Run the Health Check Tool and select the Foreign Key Configuration rule. This rule looks at all
Business Object fields in the system which are flagged to use Foreign Keys and validates that those fields
are configured correctly for use with foreign keys.

Good to Know

• For Fields, a foreign key stores Field values in validated Lookup Tables as record IDs rather than
text.

• A foreign key relationship correctly links values in a Lookup Table to the validated Field.

To see information about foreign key fields:

1. Select the Foreign Key Configuration rule when you Run the Health Check Tool.
You see the field validation results in the report.

2. If you get results in the report, define new foreign key relationships.

Note: There are examples for defining foreign key relationships if you need some help. You
can also store foreign keys for fields that are validated from Lookup tables and that enforce
validation. This ensures that changes to Lookup table values are updated in existing records
because record IDs are used rather than text values.

Related concepts
Defining Foreign Key Relationships
Example: Defining a Foreign Key Relationship for Asset Status Field
Storing Foreign Keys for Validated and Auto-populated Fields
Related tasks
Check Canonical Compliance
Out of Date Index Statistics
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Check Canonical Compliance
Run the Health Check Tool and select the Check Canonical Compliance rule. This rule looks at any
canonical definitions and checks whether they have been mapped correctly for use.

Good to Know

• About the Cherwell Canonical REST API

• Canonical REST API Mapping Wizard

• Important: To ensure standardization, canonical definitions are supplied and managed by
Cherwell. You can access canonical definitions in the Canonical Definitions Manager, but we
strongly advise against creating, editing, or deleting canonical definitions as you may
inadvertently impact your system's integration capabilities.

To see information about canonical compliance:

1. Select the Canonical Compliance rule when you Run the Health Check Tool.
You see the compliance results in the report.

2. If you get results in the report, see Interpreting the Results of a Canonical Compliance Health Check
for a list of common errors and descriptions of what to do next.

Related concepts
About the Cherwell Canonical REST API
Interpreting the Results of a Canonical Compliance Health Check
Related tasks
Canonical REST API Mapping Wizard
Out of Date Index Statistics
Check Business Objects For Consistency
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Out of Date Index Statistics
Run the Health Check Tool and select the Out of Date Index Statistics rule. This rule retrieves tables
where a large number of rows have been created and the statistics are not up to date with the row count.

Good to Know

• If you have a hosted system, a nightly job is run to update the statistics, so you should generally
never see information in this section unless you run the Health Check just prior to the job running.

• If your system is on-premises, we recommend that you ask your DBA to run a job to update these
statistics.

To see information about Out of Date Index Statistics:

1. See the above Good to Know point about timing of this report.
2. Select the Out of Date Index Statistics check box when you Run the Health Check Tool.

You see the Out of Date Index Statistics in the report.

Related tasks
Check Business Objects For Consistency
Mismatched Def IDs Check
Business Objects Cachable Check
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Check Business Objects For Consistency
Run the Health Check Tool and select the Check Business Objects for Consistency rule. This rule
checks if there are duplicate fields in the system by storage name or field ID.

1. Select the Check Business Objects for Consistency rule when you Run the Health Check Tool.
You see the results in this report.

2. If this report shows duplicate fields in the system, fix them yourself or ask your DBA for help.

Related tasks
Mismatched Def IDs Check
Business Objects Cachable Check
Missing Index Rule
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Mismatched Def IDs Check
Run the Health Check Tool and select the Mismatched Def IDs Check rule. This rule checks definition
tables to that DefID columns match the information that is serialized into DefDetails columns.

1. Select the Mismatched Def IDs Check rule when you Run the Health Check Tool.
You see the results of using this rule in the report.

2. If you get any entries is this report, you can Perform Database System Maintenance to fix the
mismatched definition IDs.

Related tasks
Business Objects Cachable Check
Missing Index Rule
Check Database
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Business Objects Cachable Check
Run the Health Check Tool and select the Business Objects Cachable Check rule. This rule looks at all
the Business Objects that are not flagged as cachable and then checks the row count in each table.

Good to Know

• Data which doesn't change very often can be cached to improve system performance. One method
is to cache Business Objects when used as a validation table. See: Define Advanced Properties for
a Business Object

• These tables are often Lookup tables that don't change much in terms of their content.

1. Select the Business Objects Cachable Check Rule when you Run the Health Check Tool.
You see the results of using this rule in the report.

2. Check each of the listed Business Objects. If the row count is small, the system recommends that
you switch on the cachable flag. See: Define Advanced Properties for a Business Object
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Related tasks
Missing Index Rule
Check Database
Worst Queries by Average Reads
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Missing Index Rule
Run the Health Check Tool and select the Missing Index rule. This rule looks for missing indexes.

Good to Know

• For more guidance on creating indexes, see Creating Indexes.

To see information about Missing Indexes:

1. Select the Missing Index Rule when you Run the Health Check Tool.
You see the Missing Index results in the report.

2. Identify any tables with a high TotalCost and high IndexSeeks. Also look for values which are an
order of magnitude higher than the rest of the values; these tables are good candidates to add
indexes. In the example shown above, this would be the first two rows.

3. Identify any tables that have values in EqualityUsage or InequalityUsage. The indexes
recommended by those rows could also be good candidates. In the example above that would be
the fourth and fifth rows; with one index you also aggregate the cost of both rows.

4. Indexes need to be added using a Blueprint. Add the index to the table and field identified and
include the fields identified in the IncludeColumns section.

Note: Adding the recommended Include columns can help speed up the query by covering
the query. However, the more Include columns are added, especially when they are key
columns, the longer it can take to keep the indexes up to date.

5. The columns in the EqualityUsage indicate columns being used in queries with equality predicates
("Select * from employee where id = 2") and the InequalityUsage column displays columns being
used in queries using inequality predicates, for example, "Select * from employee where id > 2").

Related tasks
Check Database
Worst Queries by Average Reads
Worst Queries by CPU
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Check Database
Run the Health Check Tool and select Generate Usage Statistics. Check Database runs a high-level
check of the database without inspecting tables.

1. Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the Check Database results in the report.

2. Verify the database name to ensure that the correct database is being checked.
3. Check that ServerCollation and DatabaseCollation match. They should be case insensitive as

indicated by CI in the collation name, for example SQL_Latin1_General_CP1_CI_AS.
4. Check that RecoveryModel is FULL.
5. Check that ServerMaxMemory is 1GB less than the total available system memory.
6. If you are using a dedicated server for CSM then OptimizeAdHoc should be set to true.
7. Check that Version contains one of the supported SQL versions and has x64 in it.
8. Check that the Database Files section has two entries.

◦ The is_percent_growth column should be false.
◦ In general, and for small databases, it is recommended that growth not be more than 10% of

the Size column. For example, if the Size is 1000 MB, the growth should ideally not be more
than 100 Mb. For production databases, the minimum recommended value for the Growth
column is 50 MB.
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Related tasks
Worst Queries by Average Reads
Worst Queries by CPU
SQL Wait Statistics
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Worst Queries by Average Reads
Run the Health Check Tool and select Generate Usage Statistics. Worst Queries by Average Reads
retrieves the most expensive queries on the system as determined by the average reads per execution.

To see information about the worst queries:

1. Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the Worst Queries by Average Reads in the report.

2. Focus on the queries with the highest execution_count and the highest MaxReads (10th column to
the right). Then look at the queries and compare them to the Missing Indexes section.

Note: A query being at the top of the list doesn't necessarily mean it is a bad query.

Related tasks
Worst Queries by CPU
SQL Wait Statistics
Table Size Statistics
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Worst Queries by CPU
Run the Health Check Tool and select Generate Usage Statistics. Worst Queries by CPU retrieves the
most expensive queries as detemined by total CPU usage. This statistic is similar to Worst Queries by
Average Reads but is based on total CPU time for a query, rather than the number of reads executed.

To see information about the worst queries:

1. Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the Worst Queries by CPU in the report.

2. Focus on the queries with the highest TotalCPUTime and the highest execution_count.

Note: You may have expensive queries that reference system tables, such as
TrebuchetCounters. It is not possible to add indexes to system tables so these can be
ignored.

Related tasks
SQL Wait Statistics
Table Size Statistics
Index Usage Statistics
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SQL Wait Statistics
Run the Health Check Tool and select Generate Usage Statistics. Retrieves SQL Wait Statistics which
can be used to identify performance issues with the CSM SQL server.

Note: High wait times indicate that an investigation may be needed. Inform your DBA that there
are possible issues with the SQL server.

Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the SQL Wait Statistics in the report.

Related concepts
Configuring the Performance Health Check Tool
Related tasks
Table Size Statistics
Index Usage Statistics
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Table Size Statistics
Run the Health Check Tool and generate usage statistics. Table Size Statistics retrieves the row count
and size statistics for all tables.

To see information about table sizes:

1. Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the Table Size Statistics in the report.

2. Use this information to identify tables that could be cleaned up by your DBA.

Note: Pay special attention when the TotalSpaceMB is much larger than the DataSpaceMB
for a row. This could be an indication that the number or configuration of indexes on that
table isn't ideal. Below is a very clear example:

Related concepts
Configuring the Performance Health Check Tool
Creating Indexes
Related tasks
Index Usage Statistics
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Index Usage Statistics
Run the Health Check Tool and select Generate Usage Statistics. Index Usage Statistics retrieves index
usage statistics from the SQL server.

To see information about index usage:

1. Select the Generate Usage Statistics check box when you Run the Health Check Tool.
You see the Index Usage Statistics in the report.

2. Check for indexes with a high value for user_updates and very low or zero values for users_seeks
and user_scans. This means that this index is not being used much, and you can get this index
dropped from the system to improve performance.

3. Overall ideally you should see more seeks than scans. A high value for user_scans compared to
user_seeks could justify the addition of an index to that table. Check the worst queries by reads or
CPU results to find out if a query is being run on the same table.

Related concepts
Configuring the Performance Health Check Tool
Creating Indexes
Related tasks
Log Viewer Utility
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Configuring the Performance Health Check Tool
Health Check Security rights are configured in CSM Administrator. See Tools Security Rights.

Related concepts
Tools Security Rights
Creating Indexes
Best Practices for Performance
Related tasks
Log Viewer Utility
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Creating Indexes
After running the Health Check Tool, you may need to add new indexes to some tables or make changes
to those you already have.

Combining Multiple Rows
To combine multiple rows in an index:

Identify any tables that have values in EqualityUsage or InequalityUsage. The indexes recommended
by those rows could good candidates for adding an index. In the example above that would be the fourth
and fifth rows; with one index you also aggregate the cost of both rows.

About Key Columns and Include Columns
The columns in the EqualityUsage indicate columns being used in queries with equality predicates
("Select * from employee where id = 2") and the InequalityUsage column displays columns being used in
queries using inequality predicates, for example, "Select * from employee where id > 2").

An Index key column is the column used in the index, and used by the optimizer to decide if the index is
applicable. It is also used by the execution engine to fulfill the WHERE part of the query. It is used for the
SELECT part of the query if the column is needed.

An Included column is added to the index, not used by the optimizer or execution engine in finding the
rows or joining tables. It can only be used by the SELECT part of the query to return the data.

What not to do
Adding the recommended Include columns can help speed up the query by covering the query. However,
the more Include columns are added, especially when they are key columns, the longer it can take to
keep the indexes up to date.
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Log Viewer Utility
Use the Log Viewer utility to review CSM logs, even if you do not have access to the server on which
CSM or its services are installed.

Use the Log Viewer Utility to view logs for the:

• Application Server

• Trusted Agents Server

• Cherwell Service Host

• CSM Browser Client

• CSM Portal

You must select Log to File in your logging configuration in the Cherwell Server Manager. If you are a
SaaS customer, contact Cherwell Support to configure file logging.

Note: To avoid system performance issues, the Log Viewer only retrieves the most recent 10,000
lines (up to 512kb of data) from the latest log file. The Log Viewer does not combine the beginning
of a new log file with the end of a previous log file if the new log file has fewer than 10,000 lines in
it.

To use the Log Viewer:

1. In CSM Administrator, select the Performance category.
2. Select Log Viewer.

The Log Viewer window opens.
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3. Use the drop-down list to choose the logs you want to view.
4. Select the log level you want to view.
5. Select Export to generate a .txt of the log results.
6. Choose List or Split to control your view. Choosing Split gives you a detail pane for the log record

you select.
7. Use the search box to search the log records.

Note: Search results are shown as highlighted matching terms in the viewer, rather than a
filtered list of matching records.

8. Select Refresh to update log information.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Best Practices for Performance
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Server Tools
Server Tools include the Server Manager, the Service Monitor, and command-line options.

CSM provides the following server tools:

• The Server Manager is a stand-alone tool that allows system administrators to efficiently monitor,
manage (start, stop, or restart), and configure (database connections, login authentication, logging,
etc.) the CSM services, and restart some managed CSM Web Applications.

• The Service Monitor is a stand-alone Web Application that allows system administrators to remotely
monitor and manage (start, stop, and restart) CSM services and Web Applications and restart IIS,
using a browser and an IIS-hosted web page. Service Monitor is installed using a stand-alone
installer and is deployed using the Service Monitor web page.

• Command-line options are available for the CSM Client, CSM Configuration, Administrative, and
System Restore.

Related concepts
CSM Services
About the Server Manager
About the Service Monitor
About the Cherwell Service Host
CSM Command-Line Options
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CSM Services
CSM services are Microsoft Windows® Services dedicated to particular tasks. These services run in the
background while monitoring for, and accepting, requests from CSM clients.

The available CSM services are:

• Cherwell Application Server: Runs programs and handles application operations between Users
and their databases. The Application Server is the middle tier of the Cherwell three-tier application.
Client applications connect to the Application Server via a three-tier connection.

• Cherwell Service Host: Serves as a container host and allows you to configure the following
microservices, which use queues to distribute workload:

◦ Automation Process Service: Monitors events and executes background business rules in
your system (example: notifications and escalations). Automation Processes are configured in
CSM Administrator.

◦ Email and Event Monitor Service: Manages processing for emails sent to CSM.

◦ Mail Delivery Service: Manages processing for emails sent from CSM.

◦ Scheduling Service: Executes actions or activities, such as imports and reports, on a time-
based recurring basis. Predefined actions are scheduled in CSM Administrator and run by the
service (example: A system backup can be scheduled to occur at a set time every night).

◦ System Event Processing Service: Processes incoming messages triggered by events
triggered by events fired in third-party tools and send to a CSM webhooks endpoint. The
System Event Processing Service is used primarily for webhooks and must be manually
enabled before incoming events can be processed.

• Server Farm: Provides a framework that consists of a load balancer, multiple web servers, SQL
Server, and Redis.

• Trusted Agent Server: Allows connections to CSM servers using firewall-friendly protocols; the
Trusted Agents perform operations on behalf of CSM servers.
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About the Server Manager
The Server Manager is a stand-alone tool that allows system administrators to efficiently monitor, manage
(start, stop, or restart), and configure (database connections, login authentication, logging, etc.) the CSM
services, and restart some managed CSM Web Applications.

Use the Server Manager to:

• Monitor the status (running or stopped) of CSM services and Web Applications.

• Start, stop, and restart CSM Servers.

• Restart CSM Web Applications (Browser Client, Portal, and Web-Forms).

• Configure CSM Services: CSM Services are configured by default during installation. If settings
need to be changed, use the Server Manager. For example, you can change the protocol used to
communicate with the Cherwell Application Server, a connection to the database, or a method of
logging Server events.

• Configure the Trusted Agents Server.

• Configure Encryption Keys for CSM services or Web Applications.

• Configure logging for CSM services or Web Applications.

This Server Manager is automatically installed on the same machine where CSM Servers are installed.

Related concepts
Configure the Application Server
Configure the Cherwell Service Host
Start/Stop/Restart a Service or Web Application from the Service Monitor
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
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Using the Server Manager
The Cherwell Server Manager is installed on each CSM server instance. It enables administrators to
configure and manage all CSM, including the Application Server, the Cherwell Service Host, and CSM
Web Applications.

To open the Server Manager:

1. Log in to the a CSM server instance.

2. Search for or navigate to the Cherwell Server Manager.
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Start/Stop/Restart a CSM Server, or Restart a Web
Application from the Server Manager

Use the Server Manager to stop, start, or restart the following CSM Servers:

• Application Server

• Cherwell Service Host

• Trusted Agents Server (if installed and configured)

Note: If using Trusted Agents for security or e-mail operations, restart the Trusted Agents
server first.

Use the Server Manager to restart (recycle the application pools) the following CSM Web Applications:

• Browser Client

• Customer Portal

• Web-Forms

To start/stop/restart a CSM Server or restart a web application:

1. Click Start>All Programs>Cherwell Service Management>Tools>Server Manager.
2. From the Server drop-down, select a CSM Server or web application.

The CSM Server or Web Application is shown in the Server drop-down.

3. Select an operation:
◦ To force a refresh of the server status, double-click the Server Status icon.

◦ To start a selected CSM Server or Web Application in the Server drop-down, click the Start
Server button.

◦ To stop a selected CSM Server or Web Application in the Server drop-down, click the Stop
Server button.

◦ To restart a selected CSM Server or Web Application, click the Restart Server button.
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Configure the Application Server
Use the Server Manager to configure the 3-tier Cherwell Application Server connection so that
connections can be maintained between the CSM Applications and the Database.

Important: TCP connections are a legacy configuration and are only available for systems
upgraded from a version earlier than CSM 9.5.0. For new installations of CSM, only HTTP
connections are supported.

To configure the 3-tier Application Server connection:

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. Select Application Server from the Server field drop-down.

3. Click the Configure button.

4. Click the Ellipses button to select the connection the server should use to connect to the CSM
Database.

5. Select the desired Connection or click Add to configure a new connection.

6. Click OK.

7. Select a Server communication method:
a. Communicate via HTTP: The Communicate via HTTP radio button is selected by default and

uses HyperText Transfer Protocol (HTTP) to communicate with the Application Server. It is
recommended to use HTTP as the Server communication method.

b. Communicate via TCP: Select this radio button to use Transmission Control Protocol (TCP)
to communicate with the Application Server.

8. Set a Use Port value based on the selected communication method:
a. Communicate via HTTP: Select the default Use Port value of 80.

b. Communicate via TCP: Select the default Use Port value of 8001.

Note: Use Port values are configurable based on unassigned ports as well as selected
Encryption settings. Provide a custom Use Port value if desired.

9. (Optional): Edit the Server Name. The Server Name field is disabled by default on newer CSM
instances.

10. (Optional): Select Encrypted from the Security Mode drop-down to sign and encrypt
communications using the specified server certificate. The encryption is at the transport level using
SSL/TLS. By default, the communications between the Client applications and the Application
Server are not encrypted or signed.

11. (Optional): Select the Encryption Server Certificate.

12. (Optional): Select a Certificate Authentication option to determine how the Server Certificate
should be authenticated.

13. Click the Advanced tab to view default settings.
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Do not change the Advanced Server Configuration settings without consulting the Cherwell Support
team.

14. Click OK.

Application Server Reference
Application Server Advanced Settings Tab Reference:

Item Description

Maximum TCP
Connections

Maximum number of client connections the server keeps pooled.

Note: A client might maintain a connection that is not actively being
used for a service request.

Maximum Concurrent
Calls

Maximum number of service requests the server handles concurrently. Service
requests above this amount fail.

Maximum Concurrent
Instances

Maximum number of concurrent service instances. This value is used for testing
purposes.

Maximum Concurrent
Sessions

Maximum number of concurrent sessions allowed to the server.

Note: A client may have more than one session at a time. Trying to
create sessions above this amount result in an error.

Allowed Connection
Backlog

Number of connections above the maximum that can be backlogged before the
server returns an error.

Maximum Buffer Pool
Size

Maximum memory, in bytes, the server uses for buffering messages.
Decreasing this amount can reduce the memory usage of the server but could
cause a performance degradation on each service call.

Maximum Message
Size

Maximum size of a message, in bytes, the server or client consumes. Messages
over this size are not be processed and result in an error.

Note: The message header is included in this size.

Maximum Message
Depth

Maximum depth the client or server accepts when parsing an XML message.
Depth refers to the nesting of XML elements in a message.

Maximum Message
Table Count

The message table contains the unique names of all elements and attributes in
a message as it is consumed on the client or server. If this value is exceeded,
an error message is generated. Reports with large datasets could require this
setting to be increased.

Maximum Content
Length Maximum number of characters allowed in XML element content.

Maximum Array
Length Maximum allowed size of a message being received by the client or server.
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Item Description

Enable Message
Compression

When selected, compresses message traffic between the client and application
server.

Enable Service
Performance
Counters

When selected, allows the entire service behavior to be measured, which can
then be used to diagnose performance. These can be found under the
performance object when viewing with Performance Monitor (Perfmon.exe).

Enable Rest for
HTTP

When selected, the Application Server communicates with REST and gzip
rather than SOAP and Cherwell compression. Select this option to use less
bandwidth, ensure that communication is more discoverable by standard
security tools, and enhance debugging capabilities with external tools, such as
Fiddler.

Restore Default
Value When selected, restores all limits and options to their default values.

Related concepts
Using the Server Manager
Configure the Server Connection
Default Port Numbers
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Configure Encryption Keys for a CSM Server or
Web Application

Use the Server Manager to configure encryption keys for CSM Servers or Web Applications. Encryption
keys protect sensitive data contained in Business Object Fields (example: Financial data, SSNs, etc.).
When configuring encryption keys, you can:

• Add keys, or modify the display name of existing keys.

• Import and export keys using password-protected Cherwell Key Files (.ckf) to move them across
systems.

• Configure compliance logging to the Splunk Server to log decryption attempts (whether or not they
are successful).

Good to know:

• The ability to configure encryption keys depends on your security rights.

• Encryption keys are managed on a per-server basis; all servers within a server farm require the
same encryption keys.

• Encryption keys are protected using Windows Data Protection API (DPAPI) and are stored in a
restricted area of the Windows file system (the Windows Keystore). The keys cannot be accessed
directly; they can only be managed using the Encryption Key Management interface in the Server
Manager.

• Compliance logging to a Splunk server is handled separately from event logging for a Server or web
application. For more information on integrating Splunk and CSM, see Splunk Integration (Splunk
Integration, http://docs.splunk.com/Documentation). The Splunk integration is included in hosted
environments by default. Compliance logging is optional.

• Internal CSM auditing is enforced. CSM uses Journal-History records to track encryption/decryption
attempts for encrypted fields in Business Object records.

• References to encryption keys (identifiers and display names) are stored in the CSM database in a
table separate from the Business Objects to which they belong; however, the actual encryption keys
are not stored in the database. We recommend exporting keys to a password-protected Cherwell
Key File (.ckf) and storing them in a secure location as backup. As a best practice, store .ckf
and .czar files in separate locations.

To configure encryption keys for a CSM Server or Web Application:

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. From the Server drop-down, select a Server or Web application.

3. Click the Configure button next to Encryption keys.

4. Select a database connection and enter your login credentials.

Note: This can only be done on a two-tier connection and is intended to be performed
directly on the server running CSM.
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The Encryption Key Management window opens.

5. Add an encryption key:
a. Click the Add button.

b. In the Prompt window, enter a name for the key. This is a display name only; the actual key is
stored in the Windows Keystore.

Tip: To edit the display name of an encryption key, select the key, and then click the
Edit button.

c. Select OK.

A caution message opens, giving you the option to export encryption keys.

d. Click Yes to export keys to a password-protected .ckf file.

Note: You can choose not to export keys. However, we recommend exporting and
storing them in a secure location. Encryption keys are not stored in the database, and
therefore are not exported in .czar files.

e. If exporting keys, specify a folder location and name for the .ckf file.

f. Click Save.

Before the file is saved, you are prompted to enter a password to protect the file.

6. (Optional) Configure compliance logging:
a. Select the Compliance Logging check box.

b. Click the Configure button.

The Splunk Server Settings window opens.

c. Define the following settings:
◦ Server URL: Provide the URL of the Splunk Server (example: https://splunkserver:

8089).

◦ User Name: Provide the user name for the Splunk Server acount.

◦ Password: Provide the password of the individual with an account on the Splunk Server.

◦ Ignore Certificate Errors: Select this check box to ignore certificate errors that might be
generated by Splunk using self-signed certificates to encrypt data. Select this check box
only if you trust your connection with the server.

d. Click Test to test the CSM Connection to the Splunk Server.

e. Select OK.

7. Close the Encryption Key Management Window.

8. Configure encryption keys for another server or web application, as necessary.
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Configure Logging for a CSM Service, Web
Application, and Cherwell REST API

Use the Cherwell® Server Manager to configure logging for CSM services, CSM Web Applications, and
the Cherwell REST API. Logging records significant events and errors, and is used for troubleshooting.

Logging can be configured to go to an event log, a file locations, or a Splunk server. For more information
about integrating Splunk and CSM, see Splunk Integration and http://docs.splunk.com/Documentation.

You can configure separate logging for:

• Cherwell Application Server

• Cherwell REST API

• Cherwell Service Host and its microservices (Automation Process Service, Email and Event Monitor
Service, Mail Delivery Service, Scheduling Service, and System Event Processing Service)

• CSM Web Applications (Browser Client, CSM Portal, and Web Forms)

• Cherwell Trusted Agents Service

Use these guidelines to configure logging:

• Consider logging debug messages (debug and above) to a file or to Splunk, and not to an event log.
CSM logs numerous debug messages, so a log would be slow and might require more resources.
When logging is enabled for the Cherwell Application Server, the logging settings will also apply to
the System Upgrade and System Restore Utilities.

• Logging may need to be enabled for multiple services. For example, if you use the Desktop Client
with a 3-tier connection using Trusted Agents, enable logging for the Application Service and the
Trusted Agents Service to log all 'authlog' messages.

• Best practice is to separate each server/application to point to its own logging file.

• If you log to a file for the CSM Web Applications, the log file must be stored in a location accessible
to the account that IIS uses to run the CSM sites. This is typically the ApplicationPoolIdentity, also
referred to as the IUSR account. To prevent security issues, do not configure the IIS Application
Pool to use the LocalSystem account.

• You can use the Log Viewer utility to view logs in CSM Administrator, but you must save logs to
files.

• Logging can be enabled for each instance of the Desktop Client. For more information, refer to
Configure User General Settings.

To configure logging:

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. Select a service from the Server drop-down list.
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Note: If you select the Cherwell Service Host, logging is enabled for all microservices. To
configure logging for specific microservices, select Cherwell Service Host, select Logging,
and then select the microservice from the Services list.

3. Select Logging.

The Logging Options window for the selected service opens.

4. Define logging options for the selected service. See Logging Options.

5. Select OK.

Related concepts
Blueprint Editor Menu Bar
Logging Options
About the Server Manager
Related tasks
Log Viewer Utility
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Configure Logging to a Splunk Server
Use the Server Manager to configure event logging for selected CSM services to a Splunk Server. Event
logging records significant events and errors, and is used for troubleshooting.

Splunk is a third-party tool that identifies data patterns, provides metrics, diagnoses problems, and
provides intelligence for business operations. CSM integrates with Splunk so that CSM event log data can
be indexed and made easily searchable. Download and install Splunk onto a server and configure it for
logging events.

To configure logging to a Splunk server:

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. Select a service from the Server drop-down list.

Note: If you select the Cherwell Service Host, logging is enabled for all microservices. To
configure logging for specific microservices, select Cherwell Service Host, then click the
Logging button and select the microservice from the Services list.

3. Click the Logging button.

The Logging Options window for the selected Server opens.

4. Select the Log to Splunk check box.

5. Select a log level:
◦ Debug and above: Very verbose messages. This level is space and resource intensive.

Note: For best results, log debug messages (Debug and above) to a file or to Splunk,
and NOT to an event log. CSM logs numerous debug messages, so a log would be
slow and might require more resources.

◦ Stats and above: Detailed messages that track performance.

◦ Info and above: Informational messages that can be used to diagnose a problem.

◦ Warning and above: Warning messages that occurred.

◦ Error and above: Errors that were encountered.

◦ Fatal only: Errors that caused the service or process to stop.

6. Click OK.

7. In the Log Server area, click the Configure button.

8. Define the following settings:
◦ Server URL: Provide the URL of the Splunk Server (example: https://splunkserver:8089).

◦ User Name: Provide the user name for the Splunk Server acount.

◦ Password: Provide the password of the individual with an account on the Splunk Server.
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◦ Ignore Certificate Errors: Select this check box to ignore certificate errors that might be
generated by Splunk using self-signed certificates to encrypt data. Select this check box only if
you trust your connection with the server.

9. Click Test to test the CSM Connection to the Splunk Server.

10. Select OK.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Logging Options
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Logging Options
Logging options apply to most CSM logs, such as the Cherwell® Service Host, Cherwell Application
Server, and the Cherwell REST API. Users can create custom logs from the CSM Desktop Client, as well.
For each CSM log, you can choose to log to the event log, to a file, or to Splunk.

From the Logging Options window, select one of the following log locations:

• Select Log to event log to log CSM events to the Windows Event Viewer. Then, the log level:
◦ Debug and above: Very verbose messages. This level is space and resource intensive.

Note: For best results, log debug messages (Debug and above) to a file or to Splunk,
and NOT to an event log. CSM logs numerous debug messages, so a log would be
slow and might require more resources.

◦ Stats and above: Detailed messages that track performance.

◦ Info and above: Informational messages that can be used to diagnose a problem.

◦ Warning and above: Warning messages that occurred.

◦ Error and above: Errors that were encountered.

◦ Fatal only: Errors that caused the service or process to stop.

• Select Log to file to write the logs to a specific location and file for the selected service. Then, set
your file limits.

◦ Log Level: Select a log level.

◦ File Name: Select the ellipses button to select a location and file name for the log file. When
you configure log files:

◦ For the Browser Client and CSM Portal, the logging path is automatically modified using
the application name. For example, if the user chooses the file path c:/logs/logs.log, the
system will use c:/logs/{application name}/logs.log.

◦ For the Cherwell Service Host, specify a file location and name.

◦ For the Cherwell Service Host microservices, you only need to specify a file location. A
log file is automatically created for each microservice leader and worker.

◦ For the Cherwell Web API (Cherwell REST API), which is required for CSM
authentication, the recommended setting is to log warnings and above to the Window
Event Viewer and debug and above to a specified file location.

◦ By default, the file size is set to 10 MB, but can be changed by entering a new value in the File
Size Limit field.

◦ File Count Limit: Rolling event logs are used, so that when the maximum file size is reached
for a log file, a new file is created. By default, the number of files is set to 20 (but can be
changed), after which the oldest log file is overwritten by continued logging.

• Select Log to Splunk to write the logs to a Splunk server, and then configure Splunk logging.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
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Configure Logging to a Splunk Server
Configure User General Settings
Define a Write to Log Action
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Configure Logging for the Cherwell REST API
If issues occur when working with CSM features that rely on the Cherwell REST API (example:
Authentication, Saved Searches, and webhooks), you can configure event logging in the Cherwell Server
Manager to log warnings and errors that are associated with REST API.

The base URL for the Cherwell REST API is required for CSM authentication. If the base URL is not
configured properly either in CSM Administrator or through the Command-Line Configure Utility, users will
get an error when logging in to CSM.

Configure event logging for warnings and errors that are associated with the REST API:

1. To open the Cherwell Server Manager, select Start > All Programs > Cherwell Service
Management > Tools > Server Manager.

2. In the Server field, select Cherwell Web API.
3. Select Logging.
4. Select your logging location and level of log messages. The recommended setting is to log warnings

and above to the Window Event Viewer and debug and above to a specified file location. See
Logging Options for more information.

5. Select OK.
6. Select Restart server to apply the changes.

Related concepts
Logging Options
Set the Base URL for the Cherwell REST API
Cherwell REST API Command-Line Options
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About the Cherwell Service Host
The Cherwell Service Host serves as a container for these microservices: Automation Processes, Email
and Event Monitoring, Email Delivery, Scheduling, and System Event Processing.

The microservices use the Cherwell Message Queue Service, which is a centralized queue that enables
workload distribution. The microservices can be configured to allow for both local and remote installations
of the Cherwell Service Host to process the queue, providing increased throughput.

Each piece of work sent to the Cherwell Message Queue Service is considered a message. For example,
email messages sent from CSM are delivered to Cherwell Message Queue Service; the Mail Delivery
Service consumes the messages from the queue and sends them.

Each microservice has:

• A leader that monitors the CSM database and identifies work that needs to be done. That work is
then queued.

• Multiple workers that pull work off the queue and then complete that work.

Monitor the number of workers and workload on the RabbitMQ management interface to help determine
when you need to scale the Service Host or manually multiply the number of workers.

Good to Know:

• You can set the database connection for the Cherwell Service Host in the Cherwell Server Manager.
You can also start, stop, and restart the service.

• No actual user or email data will be stored in queue channels with the Cherwell Message Queue
Service. The service only uses IDs used to complete processes.

• You can monitor, stop, and start the Cherwell Service Host from the Command Line Configure utility
or from the Cherwell Service Monitor, if it is installed and configured.

Related concepts
About Automation Processes
About the Scheduler
About the Email and Event Monitor
Configure the Cherwell Service Host
Monitor Queues from the RabbitMQ Management Interface
Start/Stop/Restart a Service or Web Application from the Service Monitor
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Configure the Cherwell Service Host
The Cherwell Service Host, its five microservices, and Cherwell Message Queue Service are
automatically installed with the Server Installation, but you can choose which microservices to enable as
you install. You can later enable or disable microservices and configure connection settings in the
Cherwell Server Manager.

The Cherwell Service Host manages these microservices:

• Automation Process Service

• Email and Event Monitor Service

• Mail Delivery Service

• Scheduling Service

• System Event Processing Service

The microservices process and add work messages to queues, which are managed by the Cherwell
Message Queue Service. Each microservice has a single queue, but you can distribute microservices
across multiple servers to enable horizontal scaling.

Use the Server Manager to configure these Service Host settings:

• Configure connection and login settings.

• Enable or disable Service Host microservices.

• Configure logging for the Service Host and microservices.

• Configure Message Queue connection settings.

Important: You must configure and start the Service Host after you install or upgrade CSM.

Use the Configuration Command Line Utility to configure the settings above and to additional settings,
such as setting the maximum number of workers per virtual processor.

Configuring Service Host Connection and Login Settings
The Service Host can be installed on a single server or on multiple servers, depending on the needs for
your environment. Use connection and login settings to ensure that each instance of the Service Host
uses the same database connection.

To configure connection and login settings:

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. From the Server list, select Cherwell Service Host.
3. Click the Configure button.

4. Select the connection the Service Host should use to connect to the CSM database.

1003

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=clc_servicehost


If the name of the correct database connection is not displayed, click the Ellipses button to open
the Connection window and select an existing connection or configure a new connection.

5. Select the method the Service Host will use to log in to CSM.

Option Description

Windows Authentication

Uses the account associated with the Windows
credentials used by the Windows server.
Windows must be a supported login mode (Open
CSM Administrator>Security>Edit security settings,
select the Desktop Client, Browser Client, or
Browser Portal, and in the Supported login modes
section, select Windows).

User ID and Password

Uses CSM login credentials. Provide the username
and password. This is usually an administrative
account with broad system access, such as
CSDAdmin.

Blank Password
Allows a user to log in without a password. This only
works if the specified account does not have a
password assigned. This is not recommended.

Execute Using Default Role of This User

Runs the Service Host using the properties of the
View associated with the Role that the login account
is configured to use.
When this setting is not selected, this CSM Server
uses a system default Role. However, control the
behavior of Field properties in a View, based on the
Role of the logged in User, by making this selection.
In other words, based on a custom View for the Role
of the person logging in (example: IT Manager), the
behavior of the Fields for a Business Object can be
different when a record is created or modified.

6. Click Test to confirm that the login/connection works.

Enabling or Disabling Service Host Microservices
During the CSM installation or upgrade process, the Cherwell Service Host is configured and you choose
which microservices to enable by default.

This might be useful for distributing the microservices across multiple services. For example, if your
system processes a large number of email messages on a regular basis, consider moving the Mail
Delivery Service to its own server. In this case, you would enable the Mail Delivery Service, but disable all
other services.

1. Select Start > All Programs > Cherwell Service Management > Tools > Server Manager.
2. From the Server field drop-down, select Cherwell Service Host.
3. Click the Configure button.
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4. Click the Advanced Settings button.

5. Select the check box for each microservice to enable it; clear the check box to disable it:
◦ Automation Process Service

◦ Email and Event Monitor Service

◦ Mail Delivery Service

◦ Scheduling Service

◦ System Event Processing Service

Note: You can choose to run all Scheduled Items on the machine or select a Scheduling
Group to run a specific set of Scheduled Items. If you choose to run multiple Scheduling
Groups, you must distribute the work across multiple machines.

Configuring Logging for the Service Host and Microservices
You configure separate logging for the Cherwell Service Host and its microservices. For each
microservice, separate log files for leaders and workers are created.

Event and file logging apply to the machine on which logging is configured in the Server Manager. See
Configure Logging for a CSM Service, Web Application, and Cherwell REST API.

To aggregate logs across distributed machines, use Splunk.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Service Host Command-Line Options
Connect Multiple Cherwell Service Hosts to a Single CherwellMQS
Configure CherwellMQS/RabbitMQ
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Configure the Cherwell Service Host for a Local
Scheduler in a SaaS Environment

In SaaS envinronments, you can configure the Cherwell Service Host to run the Scheduling Service on
your local network. Configuration steps include creating a new Schedule Group and then associating that
Group with the Cherwell Service Host.

A common use case for this configuration is setting up a schedule to run a report and save a PDF of the
report on your local network. Another use case is setting up a schedule to import a locally generated file
into CSM. For example, you might want to create a schedule that runs a PowerShell script on your local
network, save the output as a .csv file, and then import that .csv file into CSM. In this case, the script can
access resources on your local network that are not available to the CSM server.

Requirement for 3-Tier Client Connection With Locally Installed RabbitMQ
Running a local Scheduler in a SaaS environment requires a 3-tier connection between the Cherwell
Service Host and your SaaS connection.

Also, to use the Scheduling Service in your local network, you must also configure the Cherwell Message
Queue Service (RabbitMQ) so that it can communicate with the Cherwell Service Host on your local
network. The Cherwell Service Host does not use the RabbitMQ that is installed on the CSM server that is
hosted by Cherwell.

Create the Schedule Group
Schedule Groups allow you to set up schedules for a specific Cherwell Service Host.

Note: The default Schedule Group ([Default]) is designed for running Scheduled Items in a SaaS
environment only.

To create the Schedule Group:

1. Open CSM Administrator, and select Scheduling > Edit Schedule.

2. In the Scheduled Items window, select Add.

3. Beside the Schedule group field, select the ellipses button to create a new group for Schedule
Items that you want to run locally (example: MyLocalServer).

4. Save your changes.

Configure the Cherwell Service Host
After you create the Schedule Group to run Scheduled Items in your local environment, you must enable
the Scheduling Service in the Cherwell Service Host and configure it to point to the new Schedule Group.

To configure the Cherwell Service Host:

1. Open the Cherwell Service Host (Start > All Programs > Cherwell Service Management > Tools
> Server Manager).
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2. In the Cherwell Server Manager window, in the Server field, select Cherwell Service Host, and
then select Configure.

3. In the Cherwell Service Host window, select Advanced Settings.

4. Select Scheduling Service, and then select the Schedule Group that you created earlier to run on
your local network (example: MyLocalServer).

5. Select OK to save your changes.

Now, the Cherwell Service Host will run only the Scheduled Items that are configured for your local
Schedule Group.

Related concepts
Configure CherwellMQS/RabbitMQ
Configure the Cherwell Service Host
About the Scheduler
Related information
Configure the Client Connection
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Configure CherwellMQS/RabbitMQ
The Cherwell Message Queue Service (CherwellMQS) is required for queuing. CherwellMQS requires
minimal configuration.

The RabbitMQ User ID and password are set to admin/admin during installation. It is highly recommended
that you change this password after installation and update the RabbitMQ credentials in CSM. When you
change the RabbitMQ credentials, you must also update the credentials in CSM.

The RabbitMQ credentials are set using the RabbitMQ Management Interface and the credentials are
configured in CSM using the Command-Line Configuration option or the Message Queue configuration in
the Server Manager. The following procedures describe credential configuration using the CLC option.

Note: Both Cherwell Service Host and the Application server use message queuing and must be
recycled if any CherwellMQS details change.

Disable Queuing

• Use the Cherwell Server Manager to stop the Cherwell Service Host.

• Use the Windows Services Manager to stop the CherwellMQS.

Change Administrator Credentials in RabbitMQ

1. In a browser, enter the RabbitMQ Management Interface URL:
http://localhost:15672

2. Log in with the RabbitMQ credentials.

3. On the Admin tab, select admin from the Name column of the Users table.

4. In the Update this user section of the User page, enter the new password in the Password field and
in the Confirm field.
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5. Click Update user.

Note: Because you are changing the password for the user you are logged in as, you will
see an error message with the message, "Login failed." To make additional changes in the
RabbitMQ Management Interface, log out and log back in.

6. Close the RabbitMQ Management Interface.
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Update RabbitMQ Credentials in CSM

1. Stop Cherwell Service Host and Cherwell Message Queue Service.

2. On the primary Message Queue Service host machine, open a Command window from the Cherwell
Service Management folder.

3. Run the following command:

Trebuchet.CommandLineConfigure.exe -messagequeue -connectionuserid=[NE
W USER ID] -connectionpassword:[NEW PASSWORD]

4. Restart the Cherwell Service Host and the Application server.

Related concepts
About the Cherwell Service Host
Configure the Cherwell Service Host
Connect Multiple Cherwell Service Hosts to a Single CherwellMQS
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Advanced Configurations for the Cherwell Service
Host

Only one Cherwell Message Queue Service (CherwellMQS) node is permitted per CSM environment.
Configure complex systems with Cherwell Service Host by adding multiple service host instances,
connecting distributed Cherwell Service Host instances to a primary CherwellMQS instance, or
connecting distributed Cherwell Service Host instances to a RabbitMQ cluster.

During the Server Installation, CherwellMQS is automatically installed. By default, Cherwell Service Host
is connected to the CherwellMQS instance on the machine on which it was installed. If you use multiple
instances of the Cherwell Service Host, you must connect those distributed instances to a primary
CherwellMQS or connect all RabbitMQ instances into a cluster and leave Cherwell Service Host
connected to the CherwellMQS instance on the machine on which it was installed.

Adding Multiple Service Host Instances
Add multiple instances of the Cherwell Service Host and distribute microservices across multiple
machines to distribute the queuing workload. Use the Server Installer to add the Service Host and
selected microservices to additional machines.

To add Service Host instances:

1. Verify that your main instance of the Cherwell Message Queue Service and Cherwell Service Host
are configured correctly and running. See Configure the Cherwell Service Host.

2. Launch the CSM Server installer, and select normal installation options until you come to the
Database Selection page.

3. Select the Don't load any data option. Select Next.
4. On the Server Selection page, select one or more of these microservices:

◦ Automation Process Service

◦ Scheduling Service

◦ Email and Event Monitor Service

◦ Mail Delivery Service

◦ System Event Processing Service

Note: You can clear the Application Server check box.

5. Click Next.
6. On the Logon Information page, select a user account that has privileges to run and modify services

on the machine.

7. Click Next, and then finish the installer.
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Connect Multiple Cherwell Service Hosts to a Single CherwellMQS
Though a RabbitMQ node is installed along with Server Installation, you can choose to point to an existing
node of RabbitMQ. If you have multiple Service Hosts, you can configure them to point to the same
RabbitMQ node, or you can set up RabbitMQ clustering and direct the Service Hosts to the cluster.

To connect multiple Cherwell Service Host instances to CherwellMQS:

1. On the machines that have distributed instances of Cherwell Service Host, open the Cherwell
Service Manager.

2. Select Configure next to Message Queue. The Message Queue Options dialog box opens.

3. In the Host Name field, change "localhost" to the server name or IP address of the primary
CherwellMQS instance.

4. Change the User ID and password to match the credentials for the primary instance of
CherwellMQS.

Note: You should change the default CherwellMQS password as part of your initial
configuration of CSM. See Configure CherwellMQS/RabbitMQ.

5. Select Save.

6. Repeat for each distributed instance of CherwellMQS.

Connect Multiple Cherwell Service Hosts to a RabbitMQ Cluster
Cherwell Service Hosts cannot point to multiple RabbitMQ nodes. However, each machine with Cherwell
Service Host installed also has CherwellMQS installed. If each instance of CherwellMQS is part of a
single RabbitMQ cluster, the Service Host can remain connected to its local version of CherwellMQS.

Refer to https://www.rabbitmq.com/clustering.html for more information on RabbitMQ clustering.
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Cherwell Service Host Horizontal Deployment and
Configuration

Cherwell® Service Management (CSM) uses a dedicated message queue system to allow horizontal and
vertical scaling for one or more server components. Scaling CSM enables the system to use a network of
machines to distribute work, providing more resources to alleviate barriers and improve availability.

Common Terms and Definitions
See the following common terms and definitions that are related to horizontal and vertical scaling
deployments.

• Horizontal Scale — The process of adding more machines to a pool of resources.

• Vertical Scale — The process of adding more resources (CPU, RAM) to a single machine.

• Queue — The message destination and repository where messages are stored until they are
delivered to a CSM Service.

• Scaled Services — Services include Automation Process Service, Email and Event Monitor Service,
Mail Delivery Service, and Scheduling Service.

• Enqueue — To add a unit of work or data to the queue to await processing.

• Dequeue — To remove a unit of work or data from the queue to begin processing.

Configuration Rules and Considerations
The number of configurations for CSM is widely varied, but these constant rules must be followed for a
successful configuration.

• At least one of each of the scaled services must be enabled.

• If a scheduled group item makes use of a resource that only exists on a single node, then the
system must be configured to only run scheduled group items of that group on that specific node.

• Cherwell Service Host comes preconfigured to vertically scale all services equally. This
configuration may not work in all installations and can be adjusted, allowing the services to scale
vertically to different levels.

• To ensure the correct actions are taken, consider the current utilization of a node before changing
the scale of that node,
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Recommended Cherwell Service Host Scaling
Configurations

Cherwell recommends the following deployments and configurations to horizontally scale the various
components of CSM.

The configurations described below do not apply to hosted environments that use the Cherwell Service
Host to run a local Scheduler.

Note: Cherwell recommends no more than 100 workers per Service Host process.

Single-Node Configuration
In this typical CSM server installation, all Cherwell components are on a single machine and do not
require horizontal scaling considerations. However, individual services scale vertically automatically. By
default, each of the scaled services vertically scale when more work is enqueued then can be dequeued
with the current resources.

To set up a single-node configuration, the Cherwell Service Host component is installed on a new
machine. After the installation is complete, Cherwell Service Host is configured to communicate with the
Application Server and the Cherwell Message Queue Service.

Full-Node Scaling Configuration
When the original installation can no longer handle the rate of work enqueued by CSM, and the original
node can no longer vertically scale, then you should scale the system horizontally. The most
straightforward way to horizontally scale CSM is to create a new full node.
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In this configuration, the Cherwell Service Host component is installed on a new machine. After the
installation is complete, Cherwell Service Host is configured to communicate with the Application Server
and the Cherwell Message Queue Service from the first node.

Single-Service Separate Node Partial Scaling Configuration
Individual components of the CSM infrastructure may become overwhelmed as a company’s domain-
specific business logic is implemented. In these cases, the CSM installation can be a single service at a
time to help accommodate the workload.
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In this scenario, the original installation is no longer able to keep up with the mail delivery workload and
must scale. To accommodate a large amount of mail that needs to be delivered, a new instance of
Cherwell Service Host is installed on a new server. The server is configured to communicate with the
Application Server and the Cherwell Message Queue Service that is installed on the first node. Cherwell
Service Host manages all services except for Mail Delivery Service, which is disabled.

Single-Service Separate Node Full Scale Configuration
In more advanced scenarios, CSM is scalable on any combination of services that are active on any
number of nodes. While the options of scaled services are almost endless, a few rules must be
maintained. One example configuration of CSM at scale is a single service per node.
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In this configuration, the Cherwell Service Host component is installed on three new machines. After the
installation is complete on each of the machines, Cherwell Service Host is configured to communicate
with the Application Server and the Cherwell Message Queue Service from the first node. With
communications configuration complete, each of the four Cherwell Service Host systems are configured
to enable only a single service, one on each box.
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Monitor Queues from the RabbitMQ Management
Interface

RabbitMQ, which is the message-oriented middleware used by Cherwell Message Queue Service
(CherwellMQS), offers a management interface for on-premises installations that displays data related to
queues and connections.

Use the data that RabbitMQ provides to make informed decisions about scaling CSM microservices.
Helpful data includes a list of machines with CSM installed connecting to RabbitMQ, the number of
workers, the number of pending messages, and the number of queued messages.

Note: Access to the RabbitMQ Management Interface is only available for on-premises
installations of CSM.

Opening the RabbitMQ Management Interface
Use a standard web browser to access the RabbitMQ management interface.

The default location of the management interface is http://localhost:15672. The default login ID and
password are admin/admin. To change these default settings, refer to the RabbitMQ documentation.

Note: The CherwellMQS settings must match RabbitMQ. If you update the username or password
for RabbitMQ, as is advised, you must update the CherwellMQS settings to match. See Configure
CherwellMQS/RabbitMQ.
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RabbitMQ Connections
The Connections tab of the RabbitMQ management interface provides data to help monitor connections.

Identifying Connections
The Connections tab on the RabbitMQ management interface displays the following information when
Cherwell® Service Host is started:

Information Description

Machine Name The name of the server hosting CSM. If CSM is horizontally scaled, it will
display multiple machine names.

Process ID Windows assigned value. This information is also in Task Manager on the
"Details" tab for a specific CSM process that is running.

AppDomain ID Internal to .NET. There will be a different integer value for each CSM service
that is running under Cherwell Service Host.

Trebuchet object name Either display the Exchange name or the Queue name, depending on the
nature of the queuing.
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RabbitMQ Queues
The RabbitMQ management interface provides data to help monitor queues.

Monitoring Queues
The Queues tab on the RabbitMQ management interface displays the following information when
Cherwell Service Host is started:

Information Description

Name The name of the queue is a reflection of the service it supports.

Consumers Each queue must have at least one consumer when it is initially set up.

Messages Messages are the number of messages currently being held by the queue.

Queue Naming Conventions
Queues names are created using the following pattern:

[Code Namespace].messages.[Queue Name].[Partition Key].[ServiceHostIdentifi
er]

The last three components are described in the following table:

Component Description

Queue Name Lists what type of items are in the queue and is used to discern how to interpret
metrics that deal with the number of items in the queue.

Partition Key
Primarily used for scenarios where multiple CSM instances share a single
RabbitMQ instance. For on-premises environments, the partition key should be
constant, but may get changed on upgrade of CSM.

Service Host Identifier Allows you to determine machine-specific queues where applicable. Not all
queue names are scoped per machine.

Consider this queue name as an example:

Trebuchet.Plugin.core.services.messages.Starttaskmessage. 909e287f-a1fa-4f53-
be17-194a0a061770.15424

This queue name has the following components:

• Queue name: Starttaskmessage

• Partition Key: 909e287f-a1fa-4f53-be17-194a0a061770

• Host identifier: 15424
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Queue names can indicate information about their ready and unacknowledged (unacked) message
volumes. In the following table, some of these elements are described. Large queues refer to the total
number of items in the queue:

Queue Name Element Description

Sendmailrequest Large queues are representative of items pending
retrieval from the database for transmission.

Automatedprocessmsg

Large queues are representative of items which are
pending processing for AP (Automated Processing)
Events.

Note: Each message does not usually
correlate to a single Business Object as a
message can signal to process multiple
records.

Schedulemsg

Large queues are representative of items that are
pending processing by the scheduler. Each message
includes items that are due to be run but not items that
have not reached time to execute.

Starttaskmessage
A request to create a new worker for scaling. The
number of messages waiting should always be small
(less than 20% of the maximum number of workers).

Stoptaskmessage

A request to remove a worker. This occurs when the
Cherwell Service Host is scaling down workers after
high activity. The number of messages waiting should
always be small (less than 20% of the maximum
number of workers).

Restarttaskmessage

Each worker sends a heartbeat periodically. A process
monitors workers, and if the worker has a critical error,
the worker will be restarted. This message is used to
queue a worker to be shutdown.

Note: Any messages indicate critical failures
for the service host and should be investigated.

Emaildeliverymessage Large queues are representative of items pending
transmission.

Heartbeatmessage

Each worker generates periodic messages to alert the
Cherwell Service Host that the worker is responsive and
report metrics. Large message counts could indicate a
failure in the Cherwell Service Host monitoring. (This
should be very close to 0.)

Note: Select an item on the RabbitMQ management interface to drill down and investigate a
specific queue.
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Exchange Types
Queues names are created and managed by CherwellMQS. They are based on the type of exchange the
queue is bound to. CSM uses two types of exchanges:

• Direct: Delivers a message to a single queue based on the message routing key.

• Fanout: Delivers messages to multiple unique queues bound to the exchange. In a Fanout
exchange, the routing key is ignored.

The name for a queue that is bound to a Direct exchange is a combination of the name of the message,
the tenant's partition key, and depending on the behavior of the message, the instance ID. The name for a
queue that is bound to a Fanout exchange includes the message handler's target name to create multiple
queues to handle multiple messages per instance.

Note: Since queue names created automatically by CherwellMQS with specific meaning, Users
should not attempt to edit or rename queues.

Analyzing Messages
The Overview tab on the RabbitMQ management interface displays data that helps determine the health
of the queue over time. Monitor trends of published messages, consumed messages, and queued
messages. Pay attention to the following graphs in the Overview tab:

• Queued messages: This graph displays the number of messages queued over time. If there is a
growth rate, then the queue will fall behind and eventually overflow.

• Message rates: This graph displays the most basic and telling metric in the queuing system. If the
number of messages being Published is greater then the number of Consumer acknowledged
(acked) messages, then the system is getting more work requests then it can handle. In this case,
steps must be taken to prevent a failure

Analyzing Queuing Data
Decisions you make regarding scaling CSM services or multiplying the number of workers available on
any single Cherwell Service Host machine depend on a number of factors. Each organization has unique
needs, and you must consider the needs of your organization to determine the best scaling options.

For example, you may see short-terms spikes in the amount of queued work based on business demands
or on your organization's business hours. Or, you may notice one CSM microservice is continually filling
the queue when it is enabled on a machine where other microservices are enabled.

When to scale or distribute microservices:
Consider adding another machine instance of the Cherwell Service Host in these cases:

• The numbers of consumers, pending messages, or messages queued grows or remains even over
a period of time.

• The CPU of the Cherwell Service Host machine consistently hits or exceeds unacceptable ranges.
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Use the Server Installer to add the Cherwell Service Host to additional machines. See Advanced
Configurations for the Cherwell Service Host.

When to multiply the number of workers on a Cherwell Service Host machine:
Consider multiplying the number of workers on a single machine in these cases:

• The numbers of consumers, pending messages, or messages queued grows or remains even over
a period of time.

• The CPU of the Cherwell Service Host machine is not fully used.

Use the Configuration Command-Line Utility to increase the number of workers per virtual processor on
each Cherwell Service Host machine. See CherwellMQS Command Line Options.
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CherwellMQS Metrics
Identify the metrics on the RabbitMQ management interface that help monitor queues and connections.

Use the following RabbitMQ metrics, which can be found in the management interface, to monitor queue
health:

Metrics Descriptions

Disk space used

Ideal is less than 50 mb per node.
On the machine where RabbitMQ is installed, an important metric to track is the
amount of disk space used. This metric reflects how many messages each RabbitMQ
node is using to store messages that are queued or in process. See https://
www.rabbitmq.com/disk-alarms.html.

Memory used

Ideal is less than 20 percent of the entire machine.
Once RabbitMQ exceeds a default threshold of 40%, RabbitMQ will start to block all
connections that are publishing messages. See https://www.rabbitmq.com/memory-
use.html.

Connection performance
All traffic flows through a TCP connection. Monitoring the connection will help you
understand the traffic for the application, see how the network is used, and determine
if there are connectivity issues. See https://www.rabbitmq.com/reliability.html.

Data rates

This includes throughput and performance.
Queues receive, push, and store messages. After a message is routed through an
exchange, it is placed in a queue. A queue is the final destination within RabbitMQ
before the message is passed to an application.

Queue depth Number of the messages in the queue.

Messages
unacknowledged

Number of messages a queue has delivered without receiving an acknowledgement
from a consumer.

Messages ready Number of messages available to be consumed.

Message rates

Number of messages that move in and out of a queue per second. This is highly
variable from tenant to tenant, depending on the type of work being done and how
long each piece of work takes. A complicated Automated Process will result in a lower
message rate. Monitor this section to see messages pass from the Ready state to the
Unacked state. If there are messages in the Ready state, then there should be an
equal number of messages in the Unacked column as Consumers for that queue.
With enough time on a given tenant, a pattern starts to emerge.

Number of consumers

Number of workers that are registered to do work from that queue. Each service is
designed to scale within the bounds of its settings. If there is a lower, or higher then
expected number of consumers, it could mean there is a failure of some type in
Cherwell Service Host.

Consumer utilization

Time that a queue’s consumer could take on new messages. It is a number between 0
and 1, or NA if a queue does not have any consumers. If the utilization is less then 1
(100%) then a consumer is not able to take a message. This can be an indication of
network congestion.
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CherwellMQS Good to Know
It is important to know how to interpret CherwellMQS through the RabbitMQ management interface.

When a Queue Appears Stuck
An item cannot be stuck in the queue. Sometimes, a worker is unable to process a request, so an item will
sit as unacknowledged (Unacked) and appear to be stuck. For example, a scheduled job can keep an
Unacked message at > 0 for long period of time (30 minutes or more) may have an issue. Deleting the
queue may mean that job and subsequent jobs won’t run until its next scheduled time. Similarly, deleting
Automation Processing (AP) events that are queued and unacked could skip those events from
processing and removing mail delivery queues could keep items that are in an Unacked state from being
sent. All queues with a Cherwell Service Host identifier can be cleanly deleted if needed.

Using a Get Messages operation within a queue for one item will allow you to surgically remove a single
item from a queue without wiping out items in backlog. As noted above, be aware a single AP event
message may contain multiple Business Object records.

Increase Speed of Automation Processing Events Leader
The quantity and processing time of AP events directly correlate to how much work the events generate in
the system. Disabling events will not prevent the leader from processing those items. To maximize
performance, you should have only the number of events you need. Broad functionality like Change on
Any Field can also have a negative impact on performance, because these items require more effort than
may be needed.

Decrease Processing Time
There are two settings that can have a large impact on processing time. These are found in the C:
\ProgramData\Trebuchet\Trebuchet.settings file:

VPMultiplier: Default is two. This number is multiplied by the processor count to determine the amount of
workers to create. (Example, four processors will create eight workers by default.) A VPMultiplier of 0 will
create 1 worker.

Note: Allocating high numbers to the VP Multiplier can negatively impact workers and other
processes on the server where Cherwell® Service Host is running.

MaxWorkers: This is the maximum number of workers that can be created for each service. While the
total number of workers between services exceeds what is created by the VPMultiplier, the total count of
workers will be limited by the VPMultiplier in a first come first serve fashion.

Monitor the AP Events Leader
For AP Events, the following SQL Queries can provide some context:

--The longest running AP by BusObType for today
Declare @Now DateTime;
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Declare @Earlier DateTime;
--Select up to now.
Select @Now = GetDate();

--Get from midnight today
Select @Earlier = DATEFROMPARTS(DatePart(yyyy, @Now) , DatePart(M, @Now), D
atePart(D, @Now))

Select td.DefName, 
Cast(FORMAT(DatePart(HOUR, ttp.Duration), 'D2') as VarChar(20)) + '

:' 
+ Cast(FORMAT(DatePart(MINUTE, ttp.Duration), 'D2') as VarChar(20)

) + ':' 
+ Cast(FORMAT(DatePart(SECOND, ttp.Duration), 'D2') as VarChar(20)) As Elap
sedTime, 

ttp.RecCount
from TrebuchetDefs td WITH(NOLOCK)
INNER JOIN (SELECT BusObTypeID, Duration=(MAX([CompletedDateTime]-[StartedD
ateTime])), count(RecId) as recCount

  FROM [dbo].[TrebuchetProcesses] with (NOLOCK)
  where startedDateTime >= @Earlier AND completedDateTime <= @Now
  group by [BusObTypeID]
  )  as ttp ON td.DefId = ttp.BusObTypeID

--Count of AP Events pending processing by the leader, high numbers are pro
blematic.
SELECT COUNT(RecId) FROM TrebuchetEvents WITH(NOLOCK) WHERE EventStatus = '
Logged'
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About the Service Monitor
The Service Monitor is a stand-alone Web Application that allows system administrators to remotely
monitor and manage CSM services and Web Applications and to restart IIS. The Service Monitor is
installed using a stand-alone installer and is deployed using the Service Monitor web page.

Important: The Service Monitor is currently available only for On-Premise Customers and
Cherwell Support in order to monitor application performance.

Use the Service Monitor to:

• Monitor the status (running and stopped) of CSM services and Web Applications.

• Start, stop, and restart CSM services and Web Applications.

• Reset IIS.

The Service Monitor is accessed via a web page, allowing you to remotely monitor and manage services.
Use the Server Manager, a similar tool, to locally monitor and manage services.

The Service Monitor is comprised of two components:

• A service-hosted Windows Communication Foundation (WCF): This component improves security
by providing each log-in with a new session ID. Along with encryption, this ensures that HTTP
messages are not hijacked by a malicious client.

• An Internet Information Services (IIS)-hosted website: This component allows end Users and
administrators to securely manage remote IIS Servers. The URL https://
<domain>cherwellservicemonitor/.

Install the Service Monitor using an installation wizard. Use the Rights tab in the Security Group Manager
to define a User's access to the Service Monitor. See Define Functionality Security Rights (Access to
Functionality).

Note: Cherwell Service behavior and access is established during the installation. For specific
control, install the Service Monitor from the Command Line (Advanced Users Only) or edit the
Cherwell Monitor config file.
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Service Monitor Good to Know
• Cherwell Service behavior is established during the installation. For specific control, install the

Service Monitor from the Command Line (Advanced Users Only) or edit the Cherwell Monitor config
file (advanced users only).

• Authentication to the Service Monitor requires the base URL of the Cherwell® REST API in the
following format: https://host.domain/CherwellAPI/api/. If the URL is not already set, the system will
prompt for it during installation, upgrading, or system restore. If this step is skipped, the URL must
be configured in the Security section of CSM Administrator or through the command line.

• Use the Cherwell Monitor Log (.txt) file to track Service Monitor operations (example: Each time a
user selects a Service Monitor button).

• Servers and Web Applications can be restarted without resetting IIS because the restart modifies
the web.config files for each, which causes the applications to be recompiled and restarted.

• The Application Server is special because it forms the interface between the Client applications and
database (a 3-tier connection).

• If the Application Server is installed under IIS Server, only one server can be running. The other is
listed as unavailable.
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Install the Service Monitor
Use the Service Monitor installer to specify:

• Server name.

• Server type.

• User access.

Contact Cherwell Support to receive the Service Monitor installation file.

Before installing the Service Monitor, the following steps must be completed:

• Install the Cherwell REST API to log in to the Service Monitor. See Run the Web Applications
Installation. For the Service Monitor, the REST API root URL needs to point to the instance where
the REST API is installed. See Configure Miscellaneous Settings for Web Applications.

• The Service Monitor Windows service must be installed.

• The Service Monitor web site must be running and pointing to the Service Monitor Windows service.

To install the Service Monitor:

1. Double-click the Cherwell Service Monitor.exe file.

The Cherwell Service Monitor Wizard opens.

2. Review the introductory text, and then click Next.

The License Agreement page opens.

3. Read the license agreement. The license agreement can also be printed. To accept the license
terms, select the I accept the terms in the license agreement check box, and then click Next.

The Monitor Configuration page opens.

4. Specify the general server details:
a. Displayed Name of Server: Use the default name (Cherwell Service Monitor) or provide

another name. This is displayed on the Service Monitor web page banner.

b. Select the type of server to be monitored, either:
◦ Production: Select this radio button to install the Service Monitor on a live system used

in a production environment.

◦ Non-production: Select this radio button to install the Service Monitor on a development
or test server.

5. Select Next.

The Destination Folder page opens.
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6. Select the folder location to install the Service Monitor installation files. Click Next to accept the
default or click Change to browse and select the desired folder location. Using the default
installation folder is recommended.

◦ On 32-bit machines, CSM files are installed to C:\Program Files\Cherwell Service
Management.

◦ On 64-bit machines, CSM files are installed to C:\Program Files (x86)\Cherwell Service
Management.

Note: Even though CSM files are installed to the (x86) directory, CSM runs as a 64-bit
application on 64-bit machines. CSM installs to the x86 directory because Windows
installers do not easily support installing applications that are both 32-bit and 64-bit.
CSM does not install to C:\Inetpub because IIS removes files in this directory in certain
scenarios.

7. Select Next.

The Ready to Install the Program page opens.

8. Click Install.

When the install is complete, the Install Complete page opens.

9. Select Finish.
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Open the Service Monitor
To open the Service Monitor:

• Browse to https://<domain>/CherwellServiceMonitor/. The domain is set up in the web.config
during the installation process. See Configure Service Monitor Behavior by Editing the Config File
(Advanced Users Only).

After authentication is complete, the Service Monitor page opens.
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Reset IIS from the Service Monitor
Use the Reset IIS Action (under Actions) on the Service Monitor web page to reset IIS, which restarts
anything running under IIS (example: Web Applications).

To reset IIS from the Service Monitor:

1. Open the Service Monitor.

2. In the Actions area, click Reset IIS.

Tip: To refresh the services and update the web page, click Refresh.
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Start/Stop/Restart a Service or Web Application
from the Service Monitor

Use the Service Monitor to stop, start, or restart the following CSM services:

• Application Server

• Cherwell Service Host

When you stop, start, or restart the Cherwell Service Host, the action impacts the host's microservices:
Automation Processes, E-mail and Event Monitor, Mail Delivery, and Scheduling.

Use the Service Monitor to stop, start, or restart the following CSM Web Applications:

• Browser Client

• Customer Portal

• Web-Forms

• Cherwell Web Service

To start/stop/restart a CSM service or restart a Web Application:

1. Open the Service Monitor.

2. Locate a CSM service or Web Application.

3. Click an operation:
◦ Start: Start a service or Web Application.

◦ Stop: Stop a service or Web Application.

◦ Restart: Restart a service or Web Application.

◦ Refresh: Refresh the services and update the web page (under Actions).

Note: If a service is already running, the start option is disabled.
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Configuring the Service Monitor for Advanced
Users

Cherwell Service behavior and access is established during the installation. For specific control, install the
Service Monitor from the Command Line (Advanced Users Only) or edit the Cherwell Monitor config file
(Advanced Users only).
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Configure Service Monitor Behavior by Editing the
Config File (Advanced Users Only)

Default behaviors are established during install, but advanced Users can edit the Service Monitor
configuration file (CherwellMonitorConfiguration.xml) to change the options.

To edit the Service Monitor configuration file:

1. Locate the file at:

C:\Program Files (x86)\Cherwell Service Management\CherwellMonitor\App_Data
\CherwellMonitorConfiguration.xml.

2. Open the file with a text editor.

From here, the access commands and settings can be edited and tailored to fit the needs of
administrators or advanced Users. For a table of command definitions and values, see Install the
Service Monitor from the Command Line (Advanced Users Only).

3. Make any desired changes to the configuration file and Save (using File>Save or CTRL+S).
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Install the Service Monitor from the Command Line
(Advanced Users Only)

Advanced Users can install the Service Monitor from the command line by running Cherwell Service
Monitor.exe. When installing from the command line, define:

• Settings: Where to install the files, what type of server to monitor, what title to display on the website
banner, and default access.

• Access: Who can view and make changes to the Service Monitor (access is generally defined
through default rights, and access is specifically defined via a list of Users.

The tables list the settings and access commands.

Note: Installs for ALL USERS by default.

Available Settings Definition Default Values

INSTALLDIR
Location/folder in which to
install the Service Monitor
files.

[programfilesfolder]\Cherwell
Service Management (default)

CW_ISPRODUCTION Type of server to be
monitored.

• True = Production (default)

• False = Non-production

CW_TITLE Title to be displayed on the
Service Monitor web page.

Cherwell Service Monitor
(default)

CW_DEFAULTACCESSISREADONL
Y

Default access to the
Service Monitor.

This is the default access
for Users who are not
explicitly given access
through the Read/Write
Permissions List.

• 1 = Read-only (default)

• 0 = Access denied.

The following are set only through the command line. Note: View = Read-only access (example: View
service status in the Service Monitor but no edit); Edit = Full read/write access (example: View service
status AND start/stop/restart services in the Service Monitor.
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CW_USERSWHOCANALWAYSEDIT
List of Users who explicitly
can edit the Service Monitor
(full read/write access).

Blank (default), but information
is required.

Comma delimited list of Users.

Format: DOMAIN\Username if
the server is joined by a domain.
Ex. Cherwell\Henri.Bryce

CW_USERSWHOCANNEVEREDIT
List of Users who explicitly
cannot edit the Service
Monitor (access denied).

CW_ADMINISTRATORSCANVIEW
Allow Users in the OS-level
Administrator Group to view
but not edit the Service
Monitor (read-only access).

• True

• False (default)

CW_ADMINISTRATORSCANEDIT
Allow Users in the OS-level
Administrator Group to edit
the Service Monitor (full
read/write access).

• True

• False (default)

The following is an example command line:

“Cherwell Service Monitor.exe" /s /v"/qn CW_USERSWHOCANALWAYSEDIT=”user lis
t” CW_DEFAULTACCESSISREADONLY=”1”"

Anything Variable that is passed and has spaces requires the quotes be proceeded by a \. If there are not
spaces, this is not required ; however, it will not hurt anything if they are used:

“Cherwell Service Monitor.exe" /s /v"/qn CW_USERSWHOCANALWAYSEDIT=\”user li
st\” CW_DEFAULTACCESSISREADONLY=\”1\”"
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CSM Command-Line Options
There are situations where it is useful to launch CSM and have it automatically execute an instruction. For
example, a third-party tool might launch the CSM application to have the User taken to a specific Incident
record, or an Administrator might want to automatically execute a system backup. CSM supports a
number of command-line options for making this possible.

The following command-line options are available: CSM Client, CSM Configuration, Administrative, and
System Restore.

A command also allows a hyperlink to be created in an e-mail that, when clicked, launches the CSM
application and executes an instruction. For this to work, CSM must be installed on the machine.

Note: In both cases (command-line or hyperlink) if CSM is already running, the command is still
executed, without relaunching the application or requiring the User to log in again. CSM executes
the command in a separate console window and will not interfere with any CSM windows/
applications running.
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CSM Client Command-Line Options
Use the CSM Client command-line to automatically execute instructions or commands. CSM Client
command-line options can launch programs more quickly and uses fewer system resources.

To use the CSM Client command-line options, execute the CSM Desktop Client with arguments.

When launching the CSM Desktop Client application, the actual application to run is called
Trebuchet.App.exe (Trebuchet is the internal library name for the CSM application). This is usually found
in the directory C:\Program Files\Cherwell Service Management.

Note: Arguments can either be prefixed with a forward slash or with a dash, so /? and -? are
equivalent.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

General Settings

Option Description

/? This is the help option and it provides a display of the supported CSM Client command-line
options.

/c

This is the connection to use. To use a common connection (a connection that is available to
all Users of the machine), prefix the connection with [Common]. To use a connection that is
associated with the current User, prefix the connection with [User]. When using the interactive
dialog, [Common] connections are on the All Users tab, while [User] connections are on the
tab named for the current User.

/u This is the User ID to use. This only works when CSM authentication is enabled (instead of
Windows or LDAP).

/p

This is the password to use. This only works when CSM authentication is enabled (instead of
Windows or LDAP).

Note: Putting a password into a shortcut is a potential security issue, since other
Users are able to edit the properties of the shortcut and read the password.

/l or /r
This is the culture override. Example language culture pairs are: de-DE (German), fr-FR
(French), and pt-BR (Portuguese). Use /l to set the culture for content strings; use /r to set the
culture for platform strings. For more information, see String Types.

The format for connection is:
Trebuchet.App.exe /c "[Common]connection name"
The format for User ID and password is:
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Trebuchet.App.exe /u User ID/p password
The format for culture is:
Trebuchet.App.exe /l language-culture pair /r language-culture pair

Logging Authentication Information

Option Description

/la logfile This option specifies the path and file name where authentication information should be
logged (must also be enabled in Security Settings).

Command Execution

Option Description

/n This option specifies to use a new window (default).

/g [name]
[id]

This is the Goto record: Name = name of Business Object; ID = ID of record. This command
takes the system to a particular record, identified by its internal Record ID. This is a special
value used to uniquely identify records (Example:
939cd1f313b3b6866ef7d043faa258398c765d444a). Obtain this value by running a One-
Step Action that populates or writes to a field or a file, the value in the RecID field. An
exception to this is the Incident Business Object. For historical reasons, (although there is a
RecID field in Incident) Incident actually uses its IncidentID as a RecID. Other custom
objects might also use different fields for the record ID. If using a tool to launch CSM and
bring up a record, sometimes the RecID comes from a query or other mechanism.

/gp
[name]
[public id]

This is the Goto record by public ID: Name = name of the Business Object; Public ID =
Public ID of record. The Public ID of a Business Object is the ID by which it is normally
identified by Users. For an Incident, this would be the Incident ID; for a Change, it would be
the Change ID (Example: Change 12345). The Public ID does not need to be a number. For
example, the Public ID for a Customer is the Customer's full name.

/gs
[name]
[Saved
Search]

This is the Goto Saved Search: Name = name of the Business Object; Saved Search =
Name of Saved Search. This option launches a named global search and displays the
results. Use the following format for the Saved Search to launch non-global searches:
Scope;Scope-Owner;SavedSearch. The scope can be any supported scope – Global,
Team, Persona (the internal name for Role), User, etc. The scope-owner must be the
internal ID of the owner.

Note: This is a 42-character ID that identifies the Team, the User, or the Role. For
this reason, this functionality is designed to be used in very specialized
circumstances.

/s [name]
[search
text]

This executes a text search: Name = name of the Business Object; Search text = text to
find. This option allows searching for arbitrary text in the specified type of record. This is the
equivalent of typing search text into the quick search box in the main application.

Note: The Business Object must have Full-Text Searching enabled, and the text
needs to be URL encoded.
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Option Description

/NP

This executes a new process. Normally, when launching the CSM Desktop Client (with or
without any additional command-line arguments) the system looks to see if it is already
running. If it is, a new window of the existing process is launched. This means the program
launches more quickly and uses less system resources. If the application is already running,
arguments related to connection, User ID, and password are ignored. By using /NP, the
application does not try to find an existing instance and always launches a new one.

Note: If the CSM Desktop Client is run from two different directories, it always
creates a new instance.

The format for Goto record is:
Trebuchet.App.exe /g [name] [id]
The format for Goto record by public ID is:
Trebuchet.App.exe /gp [name] [public id]
The format for Goto Saved Search is:
Trebuchet.App.exe /gs [name] [Saved Search]
The format for search for text is:
Trebuchet.App.exe /s [name] [search text]
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Command-Line Configuration (CLC) Options
Use Configuration command-line options to automatically run instructions or commands that configure
and manage CSM after it is installed using the CSM installation package or silent installation command-
line options. For example, CSM Configuration command-line options can publish a Blueprint and create a
Blueprint from a mApp file.

Use a command window to run Trebuchet.CommandLineConfigure.exe, which is usually found in the
directory C:\Program Files\Cherwell Service Management.

Note: Arguments can either be prefixed with a forward slash or with a dash, so /? and -? are
equivalent.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

Create a Blueprint File From a mApp File

Option Description

/mapp This option allows for the creation of a Blueprint file from a mApp file.

/mappfilepath This is the file path to a mApp file (*.mapp or *.mappz).

/mappoutputpath This is the file path to store a Blueprint file (*.bp) created from a mApp
file (*.mapp or *.mappz).

/mapplegalaccept
This is a flag for accepting legal terms. The default is False. The
options are: True or False.
False prevents the Blueprint from being created.

/mappsecurityinformationaccept

This is the flag for accepting the security message that explains that a
mApp Solution contains Security Groups and/or Roles that may
impact security rights in the target database. The options are: True or
False.
False prevents the Blueprint from being created.

/connection This is the common connection name (Example: Demo).

/connectionuserid This is the User ID for a connection. Typically, this is the CSM User ID
for the requested server.

/connectionpassword This is the password for a connection. Typically, this is the CSM User
password for the requested server.

Example:
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Trebuchet.CommandLineConfigure.exe /mapp /mapplegalaccept=true
          /mappfilepath="C:\..." /mappoutputpath="C:\..." /connection="[Com
mon]Cherwell
          Browser" /connectionuserid=User ID/connectionpassword=password 
      

Publish an Existing Blueprint File

Option Description

/publish This option publishes an existing Blueprint file.

/blueprint This is the file path to a Blueprint (*.bp) for restore. It requires a User ID
and password.

/[createrollback] This is a flag for saving a Blueprint rollback file. The default is True. The
options are: True or False.

/[scanblueprint] This is a flag for scanning a Blueprint prior to publishing. The default is
True. The options are: True or False.

/[ignoreconflicts] This is a flag for ignoring Blueprint conflicts while publishing. The default is
True. The options are: True or False.

/[restartservices] This is a flag for restarting services after publishing. The default is True.
The options are: True or False.

/[unlocksystem] This is a flag for unlocking the system after publishing. The default is True.
The options are: True or False.

/[updateforeignkeys] This is a flag for updating foreign keys while publishing. The default is
False. The options are: True or False.

/[stoponwarning] This is a flag to stop publishing on a warning during "/[scanblueprint]". The
default is False. The options are: True or False.

/[scanenabledculturesonly] This is a flag to scan Business Object property values for enabled cultures
only. When False is passed, all cultures are scanned.

/[rebuildfulltext] This is a flag for rebuilding the full text catalog while publishing. The default
is False. The options are: True or False.

/connection This is the common connection name (Example: Demo).

/connectionuserid This is the User ID for a connection. Typically, this is the CSM User ID for
the requested server.

/connectionpassword This is the password for a connection. Typically, this is the CSM User
password for the requested server.

Example:
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Trebuchet.CommandLineConfigure.exe /publish
          /blueprint="C:\..." /connection="[Common]Cherwell Browser"
          /connectionuserid=User ID/connectionpassword=password

Restore a .czar File

Option Description

/restoreczar This option restores a .czar file.

/restoreczarfile This is the file path to a .czar file for restore. This requires a User ID
and password.

/restoreenv This is the CSM installation environment. The options are:
Development, Test, or Production.

/[restoreunicode] Restore the .czar as Unicode? The options are: True or False.

/[restoreplatformczarfilepath] This is the file path to the .czar file containing platform strings.

/[ignoreplatformczarversioncheck] Option to skip version checks when loading a .czar file that contains
platform strings. The options are: True or False.

Enable Server Farms

Option Description

/serverfarm This option sets up server farms.

/[serverfarmenable] Enable server farms? The options are: True or False.

/[serverfarmredislist]

This option specifies a comma delimited list of Redis servers to add for
server farms (Example: server1:6379,server2:6379).

Note: This will overwrite the list already in use.

/[serverfarmredispassword] This is the Redis password for server farms.

/[serverfarmredistimeout] This is the Redis connection time-out for server farms. The value is in
seconds.

/[serverfarmredissynctimeout] This is the Redis sync time-out for server farms. The value is in
seconds.

/[serverfarmsessionexpiration] This is the session expiration. The value is in minutes.
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Test Connection

Option Description

/testconnection This option tests a connection by name.

Trusted Agents Server

Option Description

/trustedagenthost This option sets up the Trusted Agents Server.

/[trustedagenthostuninstall] This uninstalls the Trusted Agents Server.

/[trustedagenthostinstallaccount] This is the account the service will log on as. The options
are: LocalService, LocalSystem, or NetworkService.

/[trustedagenthostinstalluserid] This is the User ID the service will log on as. The value
type is String.

/[trustedagenthostinstallpassword] This is the password the service will log on with. The
value type is String.

/[trustedagenthostinstallautostart] This option sets the service to auto start during
installation. The options are: True or False.

/[trustedagenthoststart] This option starts the Trusted Agents Server.

/[trustedagenthoststop] This option stops the Trusted Agents Server.

/[trustedagenthostdisplayname] This option sets the display name. The value type is
String.

/[trustedagenthosthuburl] This is the URL of the Trusted Agent Hub to connect to.
HTTPS is recommended.

/[trustedagenthosthubsharedkey] This is the shared key for the Trusted Agent Hub.

/[trustedagenthostpingfrequency] This is the hub ping frequency. The value is in seconds.

/[trustedagenthostlogeventloglevel] This is the setting for the Trusted Agent logging event log
level. The value type is String.

/[trustedagenthostlogfileloglevel] This is the setting for the Trusted Agent logging file log
level. The value type is String.

/[trustedagenthostlogfilepath] This is the setting for the Trusted Agent logging file path.
The value type is String.

/[trustedagenthostlogserverloglevel] This is the setting for the Trusted Agent logging server log
level. The value type is String.

/[trustedagenthostlogtoevent] This is the setting for the Trusted Agent logging to event
log. The options are: True or False.

/[trustedagenthostlogtofile] This is the setting for the Trusted Agent logging to file.
The options are: True or False.
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Option Description

/[trustedagenthostlogtoserver] This is the setting for the Trusted Agent logging to log
server. The options are: True or False.

/[trustedagenthostlogmaxfilesizeinmb] This is the setting for the Trusted Agent logging max file
size in MB. The value type is Integer.

/[trustedagenthostlogmaxfilesbeforerollover] This is the setting for the Trusted Agent logging max files
before rollover. The value type is Integer.

Trusted Agents Hub

Option Description

/trustedagenthub This option allows configuration of the Trusted Agents Hub.

/[trustedagenthubenable] This enables or disables the use of Trusted Agents. The options
are: True or False.

/[trustedagenthuburl] This is the URL that should be used for Trusted Agent
communication. HTTPS is recommended.

/[trustedagenthubsharedkey] This is the value to use as the shared key for Trusted Agent
communication.

/[trustedagenthubgeneratesharedkey]

This option generates a new cryptographically secure key for
the Trusted Agent shared key.

Note: Only one option can be used: Provide the value
for a shared key or generate a shared key.

/[trustedagenthuboperationtimeout] This is the operation timeout for Trusted Agents. The value is in
seconds.

/[trustedagenthubregistrationtimeout] This is the registration timeout for Trusted Agents. The value is
in seconds.

Upgrade Database

Option Description

/upgrade This option upgrades the database, if needed.
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Application Server Command-Line Options
Use the /appserver major command to access all sub-commands to configure, start, stop, and uninstall
the Application Server.

/appserver
Example:

/appserver /connection="[Common]Cherwell Browser" /connectionPort:8001 /con
nectionhostingmode:AppServer /connectionProtocol:$env:Protocol_AppServer

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

Sub-command Description

/connection

Name of the CSM connection.

Accepted values: string

Required: Yes

/connectionservername
The server name for the specified connection.

Accepted values: string

/connectionport

The port to host the Application Server connection.

Accepted values: {0 - 65535}

Default: 80

/appservercertificatesubject

The display name of the certificate subject. This is not
used for searches.

Accepted values: string

Examples: CN=myhost.cherwell.com, OU=NA, O=NA,
L=Colorado Springs, S=CO, C=US.

/appservercertificatethumbprint

Certificate thumbprint used to look up certificates in the
store configured by option /appservercertstorename.

Accepted values: string

Example:
99C732FBDD70D798AE2AB23D862835D144C658F4
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Sub-command Description

/appservercertificatevalidationmode

Certificate validation mode to pass to auto-clients.

Accepted values: {server | chain | peer | trust |
peerorchain}

Default: peerorchain

/appservercertstorelocation

The location on the machine with the X.509 certificate
store.

Accepted values: {currentuser | localmachine}

Default: currentuser

/appservercertstorename

The name of the certificate store that the /
appservercertstorelocation option is configured to use.

Accepted values: {addressbook | authroot |
certificateauthority | disallowed | my | root |
trustedpeople | trustedpublisher}

Default: my

/appserverlogtoevent

If true, log to the event log.

Accepted values: {true | false}

Default: True

/appserverlogeventloglevel

The minimum level at which logs will be sent to the
event log.

Accepted values: {fatal | error | warning | info | stats |
debug}

Default: warning

/appserverlogtofile

If true, log to the log file.

Accepted values: {true | false}

Default: False

/appserverlogfileloglevel

The minimum level at which logs will be sent to the log
file.

Accepted values: {fatal | error | warning | info | stats |
debug}

Default: warning

/appserverlogfilepath

The path to the log file.

Accepted values: string

Default: Path to the directory that contains CSM
executables.
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Sub-command Description

/appserverlogmaxfilesbeforerollover

Maximum number of log files before files roll over.

Accepted values: integer

Default: 20

/appserverlogmaxfilesizeinmb

Maximum log file size in MB.

Accepted values: integer

Default: 10

/appserverlogtoserver

If true, Service Host will log to the log server (Splunk).

Accepted values: {true | false}

Default: False

/appserverlogserverloglevel

The minimum log level at which logs will be sent to the
log server (Splunk).

Accepted values: {fatal | error | warning | info | stats |
debug}

Default: warning

/appserverrecoverylocation
Overrides the patch to the Application Server recovery
file.

Accepted values: string

/appserversecuritymode

Application Server security mode for encryption. Normal
equals none.

Accepted values: {normal | signed |encrypted | server}

Default: normal

/appserveruserest

If true, the Application Server will attempt to bind WCF
calls to REST.

Accepted values: {true | false}

Default: False

/appserverinstall
Use the /appserverinstall sub-command to install the Application Server.

Example:

/appserver /appserverinstall /connection="[Common]Cherwell Browser" /appser
verinstalluserid="domain\userloginID" /appserverinstallpassword="password" 
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Sub-command Description

/appserverinstalluserid

The Windows domain account the service will use to
log in. Format: domain\useraccount.

Accepted values: string

Required: Yes

/appserverinstallpassword

Password for the Windows domain account.

Accepted values: string

Required: Yes

/appserverinstallautostart

If true, the service starts automatically during
installation.

Accepted values: {true | false}

Default: False

/appserverstart
Use the /appserverstart sub-command to start the Application Server. There are no options for this sub-
command.

Example:

/appserver /appserverstart

/appserverstop
Use the /appserverstop sub-command to stop the Application Server. There are no options for this sub-
command.

Example:

/appserver /appserverstop

/appserveruninstall
Use the /appserveruninstall sub-command to uninstall the Application Server. There are no options for this
sub-command.

Example:

/appserver /appserveruninstall

Related concepts
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Configure the Application Server
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Connections
Installing CSM from the Command Line
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Auto-Deploy Command-Line Options
Use the /autodeploy and autodeployfromsettings major commands to create an Auto-Deploy package that
automatically distributes preconfigured Desktop Client and CSM Administrator installations and
connections.

Arguments passed through the /autodeploy are saved to the C:\ProgramData\Trebuchet
\trebuchet.settings file. You can then use /autodeployfromsettings to create the Auto-Deploy package from
those settings.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

/autodeploy
Example with minimally required commands:

Trebuchet.CommandLineConfigure.exe /autodeploy /adconnectionname="[Common]3
TierConnectionName" /adtargetfolder="C:\Program Files (x86)\Cherwell Browse
r Applications\CherwellAutoDeploy" /adsite="https://YourAutoDeploymentSite/
CherwellAutoDeploy/" 
      

Example with installation options:

Connection /adoverwrite=True /admakedefault=True /adnoprompt=True /adminorr
elease=False /ReqMinorReleases=False /adtargetfolder="C:\Program Files (x86
)\Cherwell Browser Applications\CherwellAutoDeploy" /adsite=https://YourAut
oDeploymentSite/CherwellAutoDeploy/ /adnouseroptions=False /adinstalloption
s=UserChoice /adinstallallusers=True /adinstallaccounts=[{\"Domain\":\"cher
well\",\"Username\":\"john\",\"Password\":\"12345},{\"Domain\":\"cherwell\"
,\"Username\":\"john2\",\"Password\":\"12345\"}]
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Sub-command Description

/adconnectionname

The Client connection that is pushed out to all clients
during installation. This must be an Application Server
connection (3-tier connection).

Accepted values: string

Required: Yes

/adtargetfolder

The directory on the server where the install files are
stored. This should be the directory where Auto-Deploy is
installed (the physical directory that is pointed to by the
Auto-Deploy site). If defaults were selected during the
installation, this should be ..\Cherwell Browser Applications
\Cherwell Auto-Deploy.

Accepted values: string

Required: Yes

/adsite

The URL of the website housing the Auto-Deploy
installation. If the defaults are selected during the
installation, the URL is https://YourAutoDeploymentSite/
CherwellAutoDeploy.

Accepted values: string

Required: Yes

/admsifilepath

The full path to the CSM installer .msi file. The system will
attempt to locate the file, but if it has been moved from its
default location (\ProgramData\cherwell service
management), you must provide the location.

Accepted values: string

/admakedefault

If true, uses the installation connection as the default Auto-
Deploy connection for Users.

Accepted values: {true | false}

Default: True

/adnoprompt

If true, automatically connects to the installation connection
without prompting Users.

Accepted values: {true | false}

Default: False

/adminnorelease

If true, Users are required to install minor releases even if
the current version is compatible with the CSM server.

Accepted values: {true | false}

Default: False
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Sub-command Description

/addebug

If true, a series of message boxes is shown during
deployment to assist with troubleshooting.

Accepted values: {true | false}

Default: False

/adoverwrite

If true, the installer will overwrite existing connections with
the same name.

Accepted values: {true | false}

Default: True

/adnouseroptions

If true, Users are not prompted with options during
installation.

Accepted values: {true | false}

Default: True

/adinstalloptions

Indicates the type of installation created. If /
adnouseroptions is true, then either ClientOnly, or
Complete must be selected.

Accepted Values: {ClientOnly | Complete | UserChoice}

Default: UserChoice

/adinstallallusers

If true, all Users can run the installation. If false, then
installation accounts must be defined.

Accepted values: {true | false}

Default: True

/adinstallaccounts

If set, the installer runs as one of the specified
administrative Users that matches the domain on the target
machine (or does not specify domain) rather than as the
current User.

Accepted values: JSON string. Example:

[{\"Domain\":\"cherwell\",\"Username\":\"
john\",\"Password\":\"12345},{\"Domain\":
\"cherwell\",\"Username\":\"john2\",\"Pas
sword\":\"12345\"}]

Default: Installation accounts not used.

Related concepts
Configuring Auto-Deploy
Configuring Auto-Deploy Options
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Using Auto-Deploy
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CherwellMQS Command Line Options
Use commands to configure Cherwell Message Queue Service.

/messagequeue
Use the /messagequeue major command to access sub-commands to configure CherwellMQS.

Sub-command Description

/connectionport

The port to contact on the server.

Accepted values: Any integer

Default: 5672

/connectionservername
The host name or IP where the RabbitMQ broker is
installed.

Default: localhost

/connectionuserid

User ID for the connection.

Accepted values: Any string

Default: "admin"

/connectionpassword

Password for the connection.

Accepted values: Any string

Default: "admin"

/connectionvirtualhost

Virtual host to use on the RabbitMQ server. The
administrator must setup the virtual host within
RabbitMQ.

Accepted values: Any string or "/"

Default: "/", which is RabbitMQ's default virtual host

/cmqs
Use the /cmqs major command to access sub-commands to configure CherwellMQS.

/cmqsstart
Use the /cmqsstart sub-command to start CherwellMQS. This command is typically run after performing
management actions that require CherwellMQS to be restarted.

Example:

/cmqsstart
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/cmqsstop
Use the /cmqsstop sub-command to stop CherwellMQS.

Example:

/cmqsstop
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Command-Line Configure Logging Options
Use the /commandlineconfigure major command to configure logging for the Command-Line Configure
(CLC) utility. Use sub-commands to configure log location and maximum log file sizes.

/commandlineconfigure
Example:

/commandlineconfigure /commandlineconfigurelogtoevent=true /commandlineconf
igurelogeventloglevel=debug

Sub-command Description

/commandlineconfigurelogtoserver
If true, Command Line Configure will log to the log
server.

Accepted values: {true | false}

/commandlineconfigurelogserverloglevel

The minimum level at which logs will be sent to the
log server.

Accepted values: {fatal | error | warning | info | stats |
debug}

/commandlineconfigurelogtoevent
If true, Command Line Configure will log to the event
log.

Accepted values: {true | false}

/commandlineconfigurelogeventloglevel

The minimum level at which logs will be sent to the
event log.

Accepted values: {fatal | error | warning | info | stats |
debug}

/commandlineconfigurelogtofile
If true, Command Line Configure will log to the file
system log.

Accepted values: {true | false}

/commandlineconfigurelogfileloglevel

The minimum level at which logs will be sent to the file
system log.

Accepted values: {fatal | error | warning | info | stats |
debug}

/commandlineconfigurelogfilepath
The path to the file system logs.

Accepted values: string
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Sub-command Description

/commandlineconfigurelogmaxfilesizeinmb
Maximum log file size in MB.

Accepted values: integer

/commandlineconfigurelogmaxfilesbeforerollover
Maximum number of log files before files roll over.

Accepted values: integer

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
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Connection Creation Command-Line Options
Use the /create2tier and /create3tier major commands to access all sub-commands to create or update
two-tier or three-tier connections to the CSM database.

/create2tier
Example:

/create2tier /connection=2TierConnection /sqlconnectionstring="Data Source=
$env:dbServer,1433;Initial Catalog=$env:dbName;DbOwner=dbo;User ID=$env:dbA
dminUser;Password=$env:dbAdminPass;Default Pooling=True;Packet Size=4096" /
sqlconnectionuserid=$env:dbAppUser /sqlconnectionpassword=$env:dbAppPass

Sub-command Description

/connection

Name of the CSM connection.

Accepted values: string

Required: Yes

/sqlconnectionstring

The SQL Server administration connection string.

Accepted values: string

Example: Data Source=ServerName,1433:Initial
Catalog=DatabaseName;DbOwner=dbo;User
ID=SQLAdminUserId;Password=SQLAdminPassword;Default
Pooling=True;Packet Size=4096

Required: Yes

/sqlconnectionuserid

The SQL Server User ID.

Accepted values: string

Required: Yes

/sqlconnectionpassword

The password for the SQL Server User ID.

Accepted values: string

Required: Yes

/create3tier
Example:
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/create3tier /connection=3TierConnection /url=Https://127.0.0.1:8001 /appse
rverhostiis=true

Sub-command Description

/connection

Name of the CSM connection.

Accepted values: string

Required: Yes

/url

The URL to the remote machine.

Accepted values: string

Required: Yes

/appserverhostiis
If true, the Application Server is hosted in Internet
Information Services (IIS).

Accepted values: {true | false}

Related concepts
Configure the Server Connection
Configure the Client Connection
Related tasks
Configure the Browser Connection
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Environment Command-Line Options
Use the /environment commands to get or set the installation environment partition key or type.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

/environment
Example:

/environment /envvalue="Test" /connection="[Common]Cherwell Browser" /conne
ctionuserid=CSDAdmin /connectionpassword=CSDAdmin

Note: These commands only work on 2-tier connections.

Sub-command Description

/connection

Name of the CSM connection.

Accepted values: string

Required: Yes

/connectionuserid
The CSM User ID for the requested server.

Accepted values: string

/connectionpassword
The CSM password for the requested server.

Accepted values: string

/envvalue
The CSM installation environment.

Accepted values: {Development | Test | Production}

/envpartitionkey
The CSM installation partition key.

Accepted values: string

Related concepts
Connections
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Export System Command-Line Options
Use the /exportsystem major command to export CSM to a .czar or .car file.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

/exportsystem
Example:

/exportsystem /connection="[Common]Cherwell Browser" /connectionuserid=CSDA
dmin /connectionpassword=CSDAdmin /filename=C:\temp\system.czar /format=Cza
r /mode=EntireSystemAndData

      

Sub-command Description

/connection

The name of the CSM connection.

Accepted values: string

Required: Yes

/connectionuserid

The CSM User ID for the requested server.

Accepted values: string

Required: Yes

/connectionpassword

The CSM password for the requested server.

Accepted values: string

Required: Yes

/filename

The full path and filename to export the system to.
The path must exist.

Accepted values: {filepath}

Required: Yes

/format

File format for the exported system.

Accepted values: {czar | car}

Default Value: czar
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Sub-command Description

/mode

What is to be exported.

Accepted values: {EntireSystemAndData |
EntireSystemStructureOnly |
EntireSystemAndLookupData}

Default Value: EntireSystemAndData

/flags

Different options for the export. Multiple flags can be
separated by a comma or pipe.

Accepted values: {ExcludeAttachments |
GenerateLog | ExcludeBusinessProcessData |
ExcludeEncryptedFields}
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License Command-Line Options
Use the /license commands to add or update a CSM license key.

/license

Sub-command Description

/connection

Name of the CSM connection.

Accepted values: string

Required: Yes

/connectionuserid

The CSM User ID for the requested server.

Accepted values: string

Required: Yes

/connectionpassword

The CSM password for the requested server.

Accepted values: string

Required: Yes

/licensekey

A company's license key. For upgrading, this is the
only required parameter.

Accepted values: string

Required: Yes

/licensename

The name of the company that owns the license.
This parameter is required for installation but not
upgrade.

Accepted values: string

Required: Yes

Related concepts
Connections
Add a License Key
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Cherwell REST API Command-Line Options
Use the /restapiurl commands to get or set the Cherwell® REST API base URL. The base URL for the
REST API is required for various CSM features, including authentication, Saved Searches, and
webhooks.

You can also set the base URL for the Cherwell REST API in CSM Administrator by navigating to
Security > Edit REST API client settings > File > Set API URL.

Always use HTTPS instead of HTTP for security purposes.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

/restapiurl
Example: Set the API URL:

/restapiurl /baseurl=https://host.domain/CherwellAPI/api/ /connection="[Com
mon]Cherwell Browser" /connectionuserid=CSDAdmin /connectionpassword=CSDAdm
in

Example: Get the API URL

/restapiurl /connection="[Common]Cherwell Browser" /connectionuserid=CSDAdm
in /connectionpassword=CSDAdmin
Output: https://host.domain/CherwellAPI/api/

Sub-command Description

/baseurl

Retrieve the Current URL

To retrieve the current base URL of the REST API,
omit this value to write the current URL to the
console.

Set the URL

The base URL of the REST API must be in the
following format: https://host.domain/CherwellAPI/
api/.

Accepted values: string
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Sub-command Description

/connection
The name of the CSM connection.

Accepted values: string

/connectionuserid
The CSM user ID for the requested server.

Accepted values: string

/connectionpassword
The CSM password for the requested server.

Accepted values: string

Related concepts
Set the Base URL for the Cherwell REST API
Related tasks
Configure Logging for the Cherwell REST API
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Service Host Command-Line Options
Use the /servicehost major command to access all sub-commands for the Cherwell Service Host and its
microservices: Automation Processes, E-mail and Event Monitor, Mail Delivery, Scheduling, and System
Event Processing. Use sub-commands to configure, start, stop, and uninstall the Service Host.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

/servicehost
Example:

/servicehost -servicehostapleaderpause=false -connection="[Common]Cherwell
" -connectionuserid=CSDAdmin -connectionpassword=CSDAdmin

Sub-command Description

/servicehostlogtologserver
If true, Service Host will log to the log server (Splunk).

Accepted values: {true | false}

/servicehostlogserverloglevel

The minimum log level at which logs will be sent to the log
server (Splunk).

Accepted values: {fatal | error | warning | info | stats |
debug}

/servicehostlogtoeventlog
If true, Service Host will log to the event log.

Accepted values: {true | false}

/servicehostlogeventloglevel

The minimum log level at which logs will be sent to the
event log.

Accepted values: {fatal | error | warning | info | stats |
debug}

/servicehostlogtofile
If true, Service Host will log to the file system log.

Accepted values: {true | false}

/servicehostlogfileloglevel

The minimum log level at which logs will be sent to the file
system log.

Accepted values: {fatal | error | warning | info | stats |
debug}

1068

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Sub-command Description

/servicehostlogfilepath
The path to the file system logs.

Accepted values: string

/servicehostlogmaxfilesizeinmb
Maximum log file size in MB.

Accepted values: integer

/servicehostlogmaxfilesbeforerollover
Maximum number of log files before files roll over.

Accepted values: integer

/servicehostuserid
Service Host User ID setting.

Accepted values: string

/servicehostpassword
Service Host password setting.

Accepted values: string

/servicehostconnection
Service Host connection setting.

Accepted values: string

/servicehostusewindowslogin
If true, Service Host will use a Windows login.

Accepted values: {true | false}

/servicehostusedefaultroleofuser
If true, Service Host will use the default role of the User.

Accepted values: {true | false}

/servicehostvpmultiplier

The number used to determine the maximum number of
workers. For example, if you specify four and the machine
has 4 virtual processors, then you will have a maximum of
16 workers.

Accepted values: string

/servicehostapleaderenable

If true, the Automation Process Service Leader is enabled.

Accepted values: {true | false}

Default: True

/servicehostapleadermaxworkers

The maximum number of workers for the Automation
Process Service.

Accepted values: integer

Default: 5

/servicehostapleaderheartbeatinterval

The AAutomation Process Service heartbeat interval in
seconds.

Accepted values: integer

Default: 30
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Sub-command Description

/servicehostapleaderwaittime

The amount of wait time in seconds for the Automation
Process Service Leader to check the system for work.

Accepted values: integer

Default: 15

/servicehostapleaderblockstoprocess

The number of blocks of work for an Automation Process
Service leader to process per interval.

Accepted values: integer

Default: 100

/servicehostapleaderscheduleditemspullcount

The number of items for the Automation Process Service to
pull per block.

Accepted values: integer

Default: 100

/servicehostapleaderpause

If true, Automation Process Service is paused.

Accepted values: {true | false}

Default: false

/servicehostedleaderenable

If true, the Mail Delivery Service Leader is enabled.

Accepted values: {true | false}

Default: True

/servicehostedleadermaxworkers

The maximum number of workers for the Mail Delivery
Service.

Accepted values: integer

Default: 5

/servicehostedleaderheartbeatinterval

The Mail Delivery Service heartbeat interval in seconds.

Accepted values: integer

Default: 30

/servicehostedleaderwaittime

The amount of wait time in seconds for the Mail Delivery
Service Leader to check the system for work.

Accepted values: integer

Default: 15

/servicehostedleaderpause

If true, the Mail Delivery Service is paused.

Accepted values: {true | false}

Default: False
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Sub-command Description

/servicehosteeleaderenable

If true, the Email and Event Monitor Service Leader is
enabled.

Accepted values: {true | false}

Default: True

/servicehosteeleadermaxworkers

The maximum number of workers for the Email and Event
Monitor Service.

Accepted values: integer

Default: 5

/servicehosteeleaderheartbeatinterval

The Email and Event Monitor Service heartbeat interval in
seconds.

Accepted values: integer

Default: 30

/servicehosteeleaderwaittime

The amount of wait time in seconds for the Email and Event
Monitor Service Leader to check the system for work.

Accepted values: integer

Default: 15

/servicehosteeleaderemailitemspullcount

The number of items for theEmail and Event Monitor Service
to process per pull.

Accepted values: integer

Default: 100

/servicehosteeleaderpause

If true, the Email and Event Monitor Service is paused.

Accepted values: {true | false}

Default: False

/servicehostssleaderenable

If true, the Scheduling Service Leader is enabled.

Accepted values: {true | false}

Default: True

/servicehostssleadergroup
The group that this Scheduling Service will work on
exclusively.

Accepted values: string

/servicehostssleadermaxworkers

The maximum number of workers for Scheduling Service.

Accepted values: integer

Default: 5

1071

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Sub-command Description

/servicehostssleaderheartbeatinterval

The Scheduling Service heartbeat interval in seconds.

Accepted values: integer

Default: 30

/servicehostssleaderwaittime

The amount of wait time in seconds for the Scheduling
Service Leader to check the system for work.

Accepted values: integer

Default: 15

/servicehostssleaderpause

If true, the Scheduling Service is paused.

Accepted values: {true | false}

Default: True

/servicehostwhleaderenable

If true, the System Event Processing Service Leader is
enabled.

Accepted values: {true | false}

Default: True

/servicehostwhleadermaxworkers

The maximum number of workers for System Event
Processing Service.

Accepted values: integer

Default: 5

/servicehostwhleaderheartbeatinterval

The System Event Processing Service heartbeat interval in
seconds.

Accepted values: integer

Default: 30

/servicehostwhleaderwaittime

The amount of wait time in seconds for the System Event
Processing Service Leader to check the system for work.

Accepted values: integer

Default: 15

/servicehostwhleaderpause

If true, the System Event Processing Service is paused.

Accepted values: {true | false}

Default: True

/servicehostinstall
Use the /servicehostinstall sub-command to install the Cherwell Service Host Windows service.

Example:
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/servicehost /servicehostinstall /servicehostinstallaccount=LocalService

Example:

/servicehost /servicehostinstall /servicehostinstalluserid=Bob /servicehost
installpassword=1234 /servicehostinstallaccount=NetworkService

Option Description

/servicehostinstalluserid
User ID the service will log on as. Optional as long
as /servicehostinstallaccount has a valid value.

Accepted values: string

/servicehostinstallpassword

Password that the service will log on with. Optional
as long as /servicehostinstallaccount has a valid
value.

Accepted values: string

/servicehostinstallaccount

Account the service will log on as.

Optional as long as /servicehostinstalluserid and /
servicehostinstallpassword have valid values.

If no /servicehostinstallaccount or /
servicehostinstalluserid or /
servicehostinstallpassword values are provided, then
LocalService is used.

Accepted values: [LocalService | LocalSystem |
NetworkService]

Default: LocalSystem

/servicehostinstallautostart

Set the service to auto start during installation.

Accepted values: {true | false}

Default: False

/servicehoststart
Use the /servicehoststart sub-command to start the Cherwell Service Host Windows service. There are no
options for this sub-command.

Example:

/servicehost /servicehoststart
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/servicehoststop
Use the /servicehoststop sub-command to stop the Cherwell Service Host Windows service. There are no
options for this sub-command.

Example:

/servicehost /servicehoststop

/servicehostuninstall
Use the /servicehostuninstall sub-command to uninstall the Cherwell Service Host Windows service.
There are no options for this sub-command.

Example:

/servicehost /servicehostuninstall

Related concepts
About the Cherwell Service Host
Configure the Cherwell Service Host
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
Installing CSM from the Command Line
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Trusted Agent Host Command-Line Options
Use the /trustedagenthost major command to access all sub-commands for the Trusted Agent Host and
host configuration.

/trustedagenthost
Examples:

/trustedagenthost /trustedagenthostpingfrequency=60 /trustedagenthosthubsha
redkey=supersecretkey

Sub-command Description

/trustedagenthostlogtologserver
If true, Trusted Agent Host will log to the log server.

Accepted values: {true | false}

/trustedagenthostlogserverloglevel

The minimum log level at which logs will be sent to the
log server.

Accepted values: {fatal | error | warning | info | stats |
debug}

/trustedagenthostlogtoeventlog
If true, Trusted Agent Host will log to the event log.

Accepted values: {true | false}

/trustedagenthostlogeventloglevel

The minimum log level at which logs will be sent to the
event log.

Accepted values: {fatal | error | warning | info | stats |
debug}

/trustedagenthostlogtofile
If true, Trusted Agent Host will log to the file system log.

Accepted values: {true | false}

/trustedagenthostlogfileloglevel

The minimum log level at which logs will be sent to the
file system log.

Accepted values: {fatal | error | warning | info | stats |
debug}

/trustedagenthostlogfilepath
The path to the file system logs.

Accepted values: string

/trustedagenthostlogmaxfilesizeinmb
The maximum log file size in MB.

Accepted values: integer
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Sub-command Description

/trustedagenthostlogmaxfilesbeforerollover
The maximum number of log files before files roll over.

Accepted values: integer

/trustedagenthostdisplayname
Overrides the display name of Trusted Agent Host.

Accepted values: string

/trustedagenthosthuburl
The URL that is used for Trusted Agent communication.
HTTPS is recommended.

Accepted values: {url}

/trustedagenthosthubsharedkey
The shared key that is used for Trusted Agent
communication.

Accepted values: string

/trustedagenthostpingfrequency
The hub ping frequency in seconds. The default value is
30 seconds.

Accepted values: integer

/trustedagenthostinstall
Use the /trustagenthostinstall sub-command to install the Trusted Agent Host Service.

Examples:

/trustedagenthost /trustedagenthostinstall /trustedagenthostinstallaccount=
LocalService

/trustedagenthost /trustedagenthostinstall /trustedagenthostinstalluserid=B
ob /trustedagenthostinstallpassword=1234 /trustedagenthostinstallaccount=Ne
tworkService
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Sub-command Description

/trustedagenthostinstallaccount

The account used by the service. This sub-command
is optional if /trustedagenthostinstalluserid and /
trustedagenthostinstallpassword have valid values.

Note: If no values for the /
trustedagenthostinstallaccount sub-command
or /trustedagenthostinstalluserid or /
trustedagenthostinstallpassword sub-
commands are provided, then LocalSystem is
used.

Accepted values: {LocalService|LocalSystem|
NetworkService}

/trustedagenthostinstallautostart
Sets the service to auto-start during installation. The
default value is false.

Accepted values: {true | false}

/trustedagenthostinstallpassword

The password used by the service to log on. This sub-
command is optional if /trustedagenthostinstallaccount
has a valid value.

Accepted values: string

/trustedagenthostinstalluserid

The user ID used by the service to log on. This sub-
command is optional if /trustedagenthostinstallaccount
has a valid value.

Accepted values: string

/trustedagenthoststart
Use the /trustedagenthoststart sub-command to start the Trusted Agent Host Windows service. There are
no options for this sub-command.

Example:

/trustedagenthost /trustedagenthoststart

/trustedagenthoststop
Use the /trustedagenthoststop sub-command to stop the Trusted Agent Host Windows service. There are
no options for this sub-command.

Example:

/trustedagenthost /trustedagenthoststop
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/trustedagenthostuninstall
Use the /trustedagenthostuninstall sub-command to uninstall the Trusted Agent Host Windows service.
There are no options for this sub-command.

Example:

/trustedagenthost /trustedagenthostuninstall

/trustedagenthub
Use the /trustedagenthub sub-command to configure the settings for the Trusted Agent hub.

Examples:

/trustedagenthub /trustedagenthubenable=true

/trustedagenthub /trustedagenthubenable=true /trustedagenthuboperationtimeo
ut=60 /trustedagenthubregistrationtimeout=360

Sub-command Description

/trustedagenthubenable
Enable or disable the use of Trusted Agents. The
default value is false.

Accepted values: {true | false}

/trustedagenthuburl
The URL that is used for Trusted Agent
communications. HTTPS is recommended.

Accepted values: {url}

/trustedagenthubsharedkey
Value to use as the shared key for Trusted Agent
communications.

Accepted values: string

/trustedagenthubgeneratesharedkey
Generates a new cryptographically secure key for the
Trusted Agent shared key. This key is then used as the
value for /trustedagenthubsharedkey.

/trustedagenthuboperationtimeout
The operation timeout for Trusted Agents in seconds.
The default value is 30 seconds.

Accepted values: integer
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Sub-command Description

/trustedagenthubregistrationtimeout
The registration timeout for Trusted Agents in seconds.
The default value is 180 seconds.

Accepted values: integer

Related concepts
Trusted Agents
Configuring Trusted Agents
Trusted Agents Logging
Related tasks
Install the Trusted Agents Server
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Administrative Command-Line Options
Use the Administrative command-line to launch CSM Administrator and automatically execute instructions
or commands. Administrative command-line options can launch programs more quickly, use less system
resources, and perform tasks more efficiently.

To use the Administrative command-line options, execute CSM Administrator with arguments.

When launching CSM Administrator, the actual application to run is called Trebuchet.Admin.exe
(Trebuchet is the internal library name for the CSM application). This is usually found in the directory C:
\Program Files\Cherwell Service Management.

Note: Arguments can either be prefixed with a forward slash or with a dash, so /? and -? are
equivalent.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

General Settings

Option Description

/? This is the help option and it provides a display of the supported CSM Administrative
command-line options.

/c

This is the connection to use. To use a common connection (a connection that is available to
all Users of the machine), prefix the connection with [Common]. To use a connection that is
associated with the current User, prefix the connection with [User]. When using the interactive
dialog, [Common] connections are on the All Users tab, while [User] connections are on the
tab named for the current User.

/u This is the User ID to use. This only works when CSM authentication is enabled (instead of
Windows or LDAP).

/p

This is the password to use. This only works when CSM authentication is enabled (instead of
Windows or LDAP).

Note: Putting a password into a shortcut is a potential security issue, since other
Users are able to edit the properties of the shortcut and read the password.

/l or /r
This is the culture override. Example language culture pairs are: de-DE (German), fr-FR
(French), and pt-BR (Portuguese). Use /l to set the culture for content strings; use /r to set the
culture for platform strings. For more information, see String Types.
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System Backup

Option Description

/b [path and
file]

This is the path and file name that the back up should go to. If the extension is a .car,
then the backup is an uncompressed archive. If the extension is a .czar, or not included,
the backup is compressed in a .czar file format.

/r [rollover
option]

These are the rollover options. To have the file name automatically have date/time
information be appended, use this optional argument. If used with /b, it causes the date/
time information to be appended to the file name. The options are:

• Unmodified: No value is appended.

• Current: The current date and time is appended.

• Nightly: The current date is appended.

• Weekly: The day of the week is appended.

• Monthly: The day of the month is appended.

• Yearly: The month and day of the month is appended.

/c

This is the connection to use. To use a common connection (a connection that is
available to all Users of the machine), prefix the connection with [Common]. To use a
connection that is associated with the current User, prefix the connection with [User].
When using the interactive dialog, [Common] connections are on the All Users tab, while
[User] connections are on the tab named for the current User.

/u This is the User ID to use. This only works when CSM authentication is enabled (instead
of Windows or LDAP).

/p

This is the password to use. This only works when CSM authentication is enabled
(instead of Windows or LDAP).

Note: Putting a password into a shortcut is a potential security issue, since other
Users are able to edit the properties of the shortcut and read the password.

There are times when there is no need to use the CSM Scheduler to do backups, there is a preference to
use a different scheduler, or Users would like the backup to be done on a system that does not have the
scheduler running. This is common when installed in a SaaS environment.

The format for backing up CSM is:
Trebuchet.Admin.exe /c "C:\..." /u User ID/p password /b [path and file] /r
["rollover option"]
The connection, User ID, and password work the same as for any other application.
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Logging Authentication Information

Option Description

/la logfile This specifies the path and file name where authentication information should be logged
(must also be enabled in Security Settings).

System Maintenance

Option Description

/db

This is a comma-delimited list of which database maintenance operations to run. The options
are:

• RebuildSystemTableIndexes: Rebuilds indexes of all system database tables.

• RebuildFullTextCatalog: Rebuilds the Full-Text Search catalog.

• RebuildAllBusObIndexes: Rebuilds indexes of all business object tables.

• RefreshQueueStatus: Updates the queue status data.

• ShrinkDatabaseLog: Reduces the size of the database log.

• RemoveUnusedAuthRecords: Clears up obsolete authorization data.

The format for system maintenance is:
Trebuchet.Admin.exe /c "[Common]connection name" /u User ID/p password /db
delimited-list-of-options
As an example, to rebuild the full text catalog and refresh queue status, execute the following command
(all on one line):
Trebuchet.Admin.exe /c "[Common]Cherwell Browser" /u Henri /p password /db
RebuildFullTextCatalog,RefreshQueueStatus

Export a .czar
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System Restore Command-Line Options
Use the System Restore command-line to automatically execute instructions or commands. A system
administrator can use the System Restore command-line options to import the CSM database for the first
time or reload the CSM database from an archive file (.czar file).

To use the System Restore command-line options, execute CSM Administrator with arguments.

Open the command prompt in the Cherwell Service Management directory or give the file path for the
SystemRestore.exe utility.

Note: Arguments can either be prefixed with a forward slash or with a dash, so /? and -? are
equivalent.

Note: In the following examples, square brackets (example: [Common]) denote placeholder
variables for customer data. Replace these variables, including the brackets, with your own
values.

General Settings

Option Description

/? This is the help option and it provides a display of the supported system restore command-
line options.

/s or /i This option specifies to run from the installer.

/w This option specifies to run for web applications.

/a This option specifies to run automatically.

/pc This specifies a privileged connection.

/z This is the .czar file location.

/c

This is the connection to use. To use a common connection (a connection that is available to
all Users of the machine), prefix the connection with [Common]. To use a connection that is
associated with the current User, prefix the connection with [User]. When using the
interactive dialog, [Common] connections are on the All Users tab, while [User] connections
are on the tab named for the current User.

/u This is the User name to use. This only works when CSM authentication is enabled (instead
of Windows or LDAP).

/p

This is the password to use. This only works when CSM authentication is enabled (instead of
Windows or LDAP).

Note: Putting a password into a shortcut is a potential security issue, since other
Users are able to edit the properties of the shortcut and read the password.

/pe This is the encrypted password to use.
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Option Description

/ps This is the platform definition file location.

/unicode This option enables Unicode support.

Example of a System Restore command-line flag:

/c "[Common]Cherwell Browser" /u henri /p mypassword /z "C:\Cherwell/
CherwellDemo.czar" /a
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Platform Resource Manager Command-Line
Options

Use the Platform Resource Manager command-line utility to export and import CSM platform string
satellite assemblies. Assemblies are exported as .dll files, which can be imported into software
localization tools. You can review and modify strings in the localization tool, then export them as a satellite
assembly that can be reimported into CSM using the Platform Resource Manager command-line utility.

The Platform Resource Utility is run from the command window by calling
Trebuchet.Platform.Resource.Manager.exe. This utility is located in the Cherwell Service Management
installation directory.

Note: Arguments can either be prefixed with a forward slash or with a dash, so /? and -? are
equivalent.

Prerequisites
To exports assemblies, you must install the .Net SDK developer Tools on the machine that runs the
Platform Resource Manager command-line utility. You can download and install the relevant tools from
https://developer.microsoft.com/en-us/windows/downloads/sdk-archive.

Export and Import Options

Option Description

/devex

Use to convert to a .tsv file DevExpress assemblies
from English to the specified culture. The DevExpress
binaries must be available in the specified folder.
(Use /rexp to export the DevExpress assemblies.)

Example:

/devex "C:\temp\filelocation\de-de" "de-
de"

/rexp

Use to export and create the binary resource files in
the specified location for the target language
specified. The target language parameter must match
a value in the CSM database.

Example:

/rexp "C:\temp\filelocation" "de-de"
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Option Description

/ri

Use to import resource assemblies.

Optional parameters: Assemblies folder location;
language/culture pair.

Example:

/ri "C:\temp\filelocation\de-de" "de-de"
When invoked with no parameters from the folder than
contains assemblies, the assemblies are scanned for
resources and imported as en.

/tools

Optional. Use with /rexp to provide the location of the
Microsoft Windows SDK utility (AL.exe).

Example:

/tools "C:\Programs\toollocation\al.exe"
If not used, the application will try to determine the
location, if possible.

Optional Connection Options
You can specify optional connection options from the command line. If you do not, you are prompted to
select a connection and login information when you run an export or import command.

Option Description

/c

This is the connection to use. To use a common
connection (a connection that is available to all Users
of the machine), prefix the connection with [Common].
To use a connection that is associated with the
current User, prefix the connection with [User]. When
using the interactive dialog, [Common] connections
are on the All Users tab, while [User] connections are
on the tab named for the current User.

/u
This is the User ID to use. This only works when CSM
authentication is enabled (instead of Windows or
LDAP).

/p

This is the password to use. This only works when
CSM authentication is enabled (instead of Windows or
LDAP).

Note: Putting a password into a shortcut is a
potential security issue, since other Users are
able to edit the properties of the shortcut and
read the password.
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CSM Sizing and Scalability
Scale and size your CSM system by records, users, or locations.

• The number of records, Attachments, and reports stored in your system.

• How many concurrent users CSM supports based on usage scenarios.

• Installation location of the CSM database and server components.
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About Sizing and Scalability
The CSM Sizing section offers general guidance regarding sizing and scalability of CSM in a customer
environment. For example:

• Considerations for scaling variables, such as the number of records, Attachments, and reports.

• How many concurrent Users CSM supports based on usage scenarios.

• Considerations for installation location of the CSM database and server components.

1088

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Technical Architecture
Installation configurations vary; however, a typical installation is called a single-server installation because
the Cherwell Application Server and supporting services are all installed on one machine. A typical single-
server installation involves three tiers:

• (Tier 1) Database server: Houses the CSM database (SQL database).

• (Tier 2) Cherwell Server (main server): Houses the Cherwell Application Server and supporting
services, and CSM Web Applications.

• (Tier 3) Client machines: House the client-only files/administrator tools (the Desktop Client, CSM
Administrator, and all the supporting tools/utilities.

The following figure shows a typical single-server installation.
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Network Configuration Examples
Network configurations can range from basic to those that contain full redundancy and scalability.
Examples of four setups are given with a brief description. These do not represent the only way a network
can be set up, but they show our recommendations.

HTTP/TCP Communications:

The diagram below shows how various components of the deployment communicate under a typical
implementation.

Note: The ports used by the different services can vary.
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Consolidated Layout
Use the consolidated layout for smaller establishments with a low number of Users.

The configuration is deployed as either a physical server or a virtual server (SaaS, for instance). This
configuration is also referred to as a single-server scenario.

Consolidated sizing:

• Small/med customers: Up to 1,000 concurrent Users.

• Cannot scale beyond 14 cores (approximately 1,000 Users).

• Does not address high availability.

Best Practices

• 50 to 100 licenses = 150-300 technicians, 30 percent technicians concurrent (1:3).

• 900 Portal Users = 18,000-20,000 User pool, 5 percent concurrent coverage.

• 1 CPU core per 75 concurrent Users. 2 minimum: 1 for OS, 1 for CSM.

• 50 MB of memory per session for application and web servers.

• 600 MB of storage per license per year.
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Dedicated Layout
This setup is the most common for Customers. Each front-end and back-end service is broken out on its
own machine. For Scheduling service, it scales horizontally and can have active instances on multiple
machines. There are two ways to scale out the Scheduling service:

• Split the workload using Groups.

• Distribute the workload across multiple servers per Group.

If scaling horizontally, consider the balance between the CPU off-loading and the impact on SQL. This
configuration offers high availability using a master/slave and clustering.

1093

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Advanced Layout
This setup is the most complicated and should only be used in an environment with advanced technical
support. This approach offers full redundancy and scalability. This configuration can also be referred to as
a server farm configuration. For more in-depth information, see the Cherwell Server Farm section.
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Sizing and Scalability Considerations
When planning for sizing and scalability, use these recommendations for installations (database and
server), deployment, trusted agent, and scaling variables.

Installation Considerations
Database Installation Considerations
CSM uses Microsoft SQL Server as a back-end database (see the System Requirements for supported
versions). SQL Server can often be installed on the same server as CSM. However, organizations with a
centralized database server should host CSM on that server instead. This setup is more efficient because
it simplifies management and ensures that CSM data participates in an existing backup/recovery plan.

When moving the CSM database to a separate server, consider the following:

• Network activity exists between the CSM server and database server (typically via TCP/IP). There is
typically a fast connection between the two machines, though firewalls might require configuration to
allow this communication.

• CSM servers must have appropriate security access to the database. This is accomplished by either
providing SQL credentials for the database to the CSM server or ensuring that the account used by
the CSM servers has appropriate rights on the database server (and also has appropriate local
rights on the CSM server machine).

Server Components Installation Considerations
By default, servers and server components are installed on a single server. However, the components can
be separated onto additional servers if necessary.

Consider the following reasons for separating components:

• Support of existing infrastructure: Customers commonly have separate servers set up for specific
functionality. Typically, this includes either the database or the web server.

• Scalability: When the number of concurrent Users increases substantially, separating secondary
services might improve efficiency. Typically, this includes secondary services expected to use a
significant amount of data.

• Server Farms: The Cherwell Server and CSM Web Applications also support enabling of server
farms starting with CSM 6.0. This utilizes a Redis cache to handle state management between
multiple servers when used with a hardware load balancer.

Deployment Considerations
Prior to deployment, consider factors that might affect performance, such as:

• Network performance.

• Database performance.

• Complexity of the SQL database network configuration.

• Use of CSM on a shared or dedicated server.
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• Use of CSM in a high availability environment.

Trusted Agent Considerations
Prior to deployment, consider the impact of Trusted Agents on scalability and system performance. In
most cases, the use of Trusted Agents adds only a marginal amount of overhead, but in the case of the
Trusted Agents for email, the impact can be as much as a 40% reduction in the throughput of emails.

Scaling Variables
See System Requirements for minimum requirements, then scale CSM based on the specific projections
of the organization. For more information on scaling in a single-server configuration, see Consolidated
Layout. The table below lists variables that will affect your system's scalability:

Variable Notes

Total number of Users

Concurrent licenses used Consider factoring 600 MB of database storage per
license per year.

Connection pools

To improve performance, set the maximum pool size
to three times the number of concurrent CSM licenses
that are used in your organization. You may need to
adjust this value, depending on usage of your system.

Number of records created (example: Incident or
Change)

If the record count is especially high, consider
increasing the memory and processors on both
servers.

Number and complexity of system relationships

Number and type of CSM reports run

If running multiple reports frequently, or reporting
historical/trend data for extended periods of time,
consider increasing the memory and processors on
both servers.

Number and type of CSM attachments used If using many large attachments, consider doubling
the amount of storage.

Using a server farm

• Utilizing one or more services as a server farm
incurs overhead that lowers the number of
concurrent Users serviced by a single machine.
While the total number of Users supported is
higher, the hardware requirements per User also
increases.

• If server farms are deployed, the network
interface to the Redis server can require very
high bandwidth. If possible, utilize dedicated
network connections for Redis traffic to and from
server farm servers.
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Related concepts
System Requirements
Cherwell Server Farms
Consolidated Layout
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Cherwell Server Farms
A Cherwell Server Farm is a configuration where a number of servers (physical or virtual) are configured
to work together as a single unit, as opposed to a single-server scenario where there is only one instance
of each Cherwell Server running.

There are several reasons to implement a Cherwell Server Farm. The most obvious reasons are:

• To scale the number of Users.

• To provide the ability to scale the number of Users that a Cherwell Server Farm can serve. If there
are more Users, you can add more hardware and be able to grow horizontally to satisfy the
demands of the population. In a single-server scenario, you would have to add hardware to a single
server, but there's a limit to the amount of hardware you can implement in a single machine. The
more you grow a single server, the more expensive it gets. Using a Cherwell Server Farm allows
you to add low-cost commodity boxes to the farm without having to exponentially pay more.
Cherwell Server Farm provides the ability to:

◦ Scale.

◦ Scale less expensively.

◦ Scale more without constraints of single server.

• To offer high availability.

Provide high availability (HA) so that even when one server goes down (because of a hardware
failure), Users can continue using CSM. A Cherwell Server Farm eliminates a single point of failure
because if one server goes down, CSM can still be used by its Users).

High availability has different levels of service. In a perfect world, when a server goes down, there is
no effect to the end User. Many environments need such level of high availability, but others are
prepared to sustain different levels of high availability given the cost of maintaining perfect high
availability. For example, administrators trade faster performance for a level of service where some
Users could be logged off if the server goes down, but they would be able to immediately log in
again to continue working.

1098

CSM 10.0.0 Administration

CSM 10.0.0 Administration



About Cherwell Server Farms
A server farm allows high volumes of Users to utilize several medium (4-core or higher) servers. A server
farm consists of multiple CSM servers connecting to multiple Redis Servers.

Using multiple servers allows for:

• A level-of-fault tolerance.

• Individual servers to also be taken offline without impact to users.

• Operating system and hardware maintenance without reducing User availability.

Note: Services that are not load balanced should not be installed on more than one machine. Set
up another single-server connection for services that cannot be load balanced.

There is near-linear growth using Cherwell Server Farms. The more servers added to the farm, the more
Users CSM servers can support. For example, assuming identical hardware is used: If Users are
consuming 100 percent of CPU on a single server, create a farm with three servers in order to support
more Users. If two servers support 100 Users, then three servers can support 150 Users.

Important: Using the Cherwell Server Farm can increase the stress on SQL Server, the
load balancer, and Redis Server. When creating a Cherwell Server Farm, it is imperative to
consider the impact of an increased load on the entire infrastructure. Do not simply add
servers without considering the impact.

Specific Requirements

• CSM must be installed as an IIS service, not a Windows service.

• Windows IIS features HTTP Activations and non-http activations must be installed. See Configure
IIS for CSM.

• Machine keys must be generated in IIS on one CSM server and copied to IIS on all CSM servers in
the Cherwell Server Farm. See Configuring Server Farms in IIS.

• Session pinning is not supported.
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Components
Server farms can be configured differently from business to business, but all server farms should have
similar components set up in the same way.

A server farm will contain the following components at a minimum:

• Load Balancer (not provided by Cherwell): Takes a certain load of Users and balances them out
across different servers. The load balancer is set up between the company firewall and the web
service servers. The load balancer directs traffic to the server with the most availability, or one of the
other distribution methods.

• Web Servers: Deliver information and process User's requests. All servers must be configured the
same way. Be sure all servers have the same hardware configuration and point to the same SQL
and Redis. There are two types of servers:

◦ A physical server (box)

◦ A virtual server, which is a software server, installed on a physical server; or a virtual machine
installed on a hypervisor (bare-metal OS installed on a physical host).

• Databases (not provided by Cherwell): The SQL Server and Redis Server hold the content of a
CSM system.
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Operations and Resources
Server Farms require a number of components to work together. This comes at a measurable cost of
extra CPU and network, especially for the web server.

The following table contains the high-level sequence of events every time the web server serves a web
request. The Resource Required column offers some insight into the consequences of scaling up a User
base. The Added by Cherwell Server Farm column indicates if the Operation is added when configuring a
Cherwell Server Farm. Based on the information in the table, consider additional resource usage.

Operation Added by Cherwell Server Farm Resource Required

Request begins

Web Server sends a Redis request to
get latest Session State Yes CPU, negligible

Redis Server retrieves state and send
it over the network Yes CPU, light

Web Server waits for 3-5MB of data to
be transferred to the web server from
Redis

Yes Network 3-5mb/User

Web Server decompresses 3-5MB of
data Yes CPU

Web Server deserializes 3-5MB of
JSON Yes CPU

Web Server Execute request as usual

Web Server serializes session state Yes CPU, light

Web Server compresses session state Yes CPU, light

Web Server send 3-5MB of state to
Redis Yes Network 3-5mb/User

Redis Server stored session Yes CPU, light

Web Server ends request

Resource Considerations
Based on the table above, consider the following:

Memory Usage

• Web server: Non load-balanced Cherwell Servers are memory intensive, but load-balanced servers
free up memory as soon as a request is ended. This makes memory a less probable bottle neck.

• Redis: Redis is used as a centralized in-memory database. Everything stored in Redis is kept in
RAM. There should be enough RAM to serve concurrent Users. A good rule is 10 MB x Expected
peak number of Users.
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CPU

• Web server: The cost of deserializing session is four times the cost of serialization.

• Redis: If using a single-server scenario (no slaves), the rule is that 5000 Users will probably use
about 15% of your CPU. Remember to assign 2 CPUs to your Redis machines. One will be used by
the system, the other one by your Redis process.

Network

• Traffic between the Browser and the Web server: This is highly dependent on your content, and
outside the scope of this document. Bottlenecks are related to the volume of traffic between the
Cherwell Web Server(s).
Network traffic between Browser and Server is not affected by a server farm configuration, and
therefore is not considered in this document, but evaluate if the network is prepared to support the
traffic.

• Traffic between each web server and Redis: This number is highly dependent on your content. Each
page on the browser might turn into multiple web requests, depending on the page content.
Best practice: Estimate between 6-10 MB of memory usage per User session. For example: 1,000
concurrent Users x 10 MB/User = 10 GB of RAM per server.
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Purpose of Redis
Redis is an in-memory data structure store, and is used as a database, cache, and message broker.
Redis functions as an in-memory cache for Cherwell Server Farms.

By connecting every web server to the same Redis, the applications can share state and collaborate.
When a server performs an operation, it saves the state of the current User or application to Redis. In a
scenario where a User is bounced from one server to the another, each server can pick up from where the
previous server left off by retrieving the latest state from Redis.

For a Cherwell Application Server, the cost of synchronizing with Redis is minimal because the
Application Server exchanges a limited amount of information with Redis. For a Cherwell Web Server, IIS
holds state for each User in form of session, and it can reach the size of a few MB (3-5MB is the typical
size). For every web request going from the Cherwell web application to the server, there is an exchange
of session state twice with Redis:

• When the request starts, in order to retrieve session from Redis.

• When the request ends, in order to save session to Redis.

Important: When Redis is hosted within a virtual machine, it is critical that memory is never
oversubscribed.
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Configuring Server Farms in Cherwell Server
Manager

There are several ways to configure a server farm, but you must configure the Cherwell Server Farm for
each Cherwell Server. Use the Export and Import buttons to use the Server Farm Configuration across
servers.

Some key points:

• A server farm can only be used when the Cherwell Application Server is hosted in IIS. Http and Rest
are required for the Application Server.

• Members of a Cherwell Server Farm should not share a hypervisor. VMs should be distributed
across several hypervisors.

• A load balancer is required (CSM does not provide this). 

Note: The Microsoft Windows IIS Server module known as ARR (Application Request
Routing) is not recommended.

• Performance could be penalized by enabling a server farm because it brings overhead to the
individual servers participating in the farm.

Important: Ensure the configuration is the same across servers.

To configure a Cherwell Server Farm:

1. Click Start>All Programs>Cherwell Service Management>Tools>Server Manager.
2. Click the Configure button located next to the Server farm mode label.

An Alert window opens warning to stop the server farm before changing settings.

3. Click Yes to continue.

4. Define Website options:
a. Use the up and down arrows to select the Session expiration time in minutes.

b. Select the Enable server farm mode check box.

5. Define New Redis Server options:
a. Provide the Host IP address for the Redis Server.

b. Use the up and down arrows to select the Port.
c. Click Add.
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The IP address and Port appear in the Connect to list. Repeat this step to add all Redis
Servers.

6. Provide the Password for the Redis Server.

Note: If there are multiple servers in a master/slave configuration, ensure all servers share
the same password.

7. Use the Connection Timeout to specify the number of seconds the system will wait for a connect
operation to complete before returning a timeout message. On startup, the system evaluates the list
of connections in the order they appear in the Connect to list, and then attempts to connect to the
first available master. The Connection Timeout setting determines how long the system will wait for
each Redis endpoint to connect before returning a timeout.

8. Use the Sync Timeout setting to specify the number of seconds the system will wait for a
Synchronous operation to complete before returning a timeout.

Note: If you have a master/slave with sentinel configuration and a slave becomes a master,
the Sync Timeout setting determines how many seconds will elapse before your application
switches to the new master.

9. Use the Import/Export buttons to enter the Redis information in a server, export the information,
and then import it in another server.

10. Click OK.
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Export a Server Farm Configuration
A server farm configuration can be exported to an XML file and used for several server configurations.

To Export Server Farm Configuration Information:

1. Click Start>All Programs>Cherwell Service Management>Tools>Server Manager.
2. Click the Configure button next to Server farm mode is:.
3. An Alert window opens warning to stop the server farm before changing settings.

4. Click Yes to continue.

5. In the Configuration window, select the Enable server farm mode check box.

6. Click Export.
7. Navigate to the location where to save the file.

8. Click Save.

9. After the file is saved, go to the Server Manager for different Cherwell Application Servers and
Import a Server Farm Configuration.
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Import a Server Farm Configuration
A server farm configuration can be imported from a saved XML file. The XML file can be used across
several server configurations.

To Import Configurations to a Server Farm:

1. Click Start>All Programs>Cherwell Service Management>Tools>Server Manager.
2. Click the Configure button next to Server farm mode is:.
3. An Alert window opens warning to stop the server farm before changing settings.

4. Click Yes to continue.

5. In the Configuration window, select the Enable server farm mode check box.

6. Click Import.
7. Navigate to the location where the XML to import file is stored.

8. Click Open.

The window closes, and the configuration information appears in the Connect to section.

9. Select OK.
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Configuring Server Farms in IIS
You must create and apply a machine key that is applied to internet Information Services (IIS) for all CSM
servers in a Cherwell Server Farm. The key you apply must be identical across all CSM servers.

To generate machine keys:

1. Choose one server to create validation and encryption machine keys that can be added to IIS on all
other instances of CSM.

2. Open IIS on the server.
3. Determine at which level the keys should be generated:

◦ If IIS hosts only CSM sites on all servers included in the server farm, you can create your keys
for the IIS instance by selecting the top-level server name.

◦ If other sites are hosted on any of the servers in the server farm, generate keys at a CSM site
level, such as CherwellClient.
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◦ Select the level, and then double-click the Machine Key icon.
4. Choose a validation method (example: AES).

5. Click the Generate Keys link located in the Actions area.
6. Copy the Validation Key and Decryption Key to an external location for easy access.
7. Select Apply.
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8. If you generated keys at the site level, such as CherwellClient, apply the saved keys to all other
Cherwell sites on this IIS instance.

9. Restart IIS.

You must apply the machine keys generated in the previous section to IIS on all CSM servers in your
Cherwell Server Farm. The keys must be the same.

The keys should be applied at the same level: server or site.

IIS or the Application Pool must be restarted on each server after you apply machine keys.
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Configuration Best Practices
Learn about the most common and recommended methods of configuring a Cherwell Server Farm.

Tested Redis Connections
CSM has been tested with Redis in the following environments:

• Windows with a single instance.

• Linux master/slave with sentinel.

• Windows master/slave with a sentinel.
When configuring a cluster environment in Trebuchet Server Managers, Users only need to provide
one IP for the cluster. In master/slave environment, add the IPs of the master and all slaves in the
Connect to field when configuring.

• Redis Labs Enterprise Cluster.
When configuring a RedisLab Enterprise Cluster environment in Trebuchet Server Managers, Users
only need to provide one IP for RLEC. In master/slave environment, add the IPs of the master and
all slaves in the Connect to field when configuring.

Recommendations
Hardware: Use the same hardware across server for easier management and performance predictability.

IIS ARR as a load balancer: Cherwell does not recommend using IIS ARR. While it can be made to
work, ensure all of its response-caching features are disabled.

Using virtual machines: Be careful when using VMs. If all VMs are on the same server and the server
goes down, the web farm stops working.
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Cherwell Server Farms Q&A
Question: Could I take one physical box, divide it into two virtual machines, and install Cherwell Services
on them as two different participants of the server farm?

Answer: You can, but we do not recommend it. One of the purposes of the farm is to eliminate having a
single point of failure. If the hardware below the two virtual machines fails, the entire farm goes down,
making the purpose of the farm useless. Having the two VMs reside on different hardware is a better
option.

Question: Can I mix and match server types on a single box?

Answer: Yes you can. You would have to make some performance and high availability considerations to
determine which servers can reside together.

Question: How do I know if I have to separate my servers onto multiple machines with a dedicated
machine, or if I can share a machine across multiple Cherwell Servers?

Answer: Depending on the size of the machine and the performance load, you might find that a shared
machine is not enough.

Question: How many servers in a Cherwell Server Farm should be deployed to match the performance of
a single standalone server, and why?

Answer: Three load-balanced servers should be deployed to match the performance of a single
standalone server in the event that one of them fails. This is because of the overhead associated with the
Cherwell Server Farm topology. The UI in the load-balanced environment can appear slightly slower
because of session state serialization and Redis traffic.

Question: What are the bandwidth and latency requirements for the Cherwell Server Farm?

Answer: Network interfaces should provide high bandwidth and very low latency. For example, 10GbE
interconnects to high capacity hardware-switched aggregators that provide near 100 percent wireline
throughput bi-directionally with no backplane over-subscription and nanosecond latency performance.

Process Servers
Question: Can CSM services (Automation Processes, E-mail and Event Monitoring, Mail Delivery, and
Scheduling) be load-balanced?

Answer: CSM services use a centralized queue to enable the distribution of workload. For more
information, see About the Cherwell Service Host.

Question: Can these non-load-balanced services be set up for high availability?

Answer: Yes, using Windows Server Fail-over Clustering with the Generic Service or VM Clustering.

SQL Server
Question: What type of cluster model does Cherwell recommend for SQL?
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Answer: Always-On Availability Groups.

Question: What is the formula for determining the total amount of disk storage needed?

Answer: A starting best practice is to allocate 600 MB of storage per licensed User per year. If routinely
saving large attachments to records, this formula should be doubled.

Question: When using SANs to store SQL data, are there any special considerations?

Answer: Yes. Differentiate networks between SAN traffic and other traffic, i.e. communications between
applications servers, SQL, and Redis. Storage for SQL data should be on different spindles than other
data.

Question: Does SQL Server have to be set up on a dedicated, physical machine?

Answer: We highly recommend that SQL Server run on dedicated hardware or on virtual machines with
dedicated CPU cores, memory, and dedicated physical storage. It was Microsoft's position to say "never
run SQL Server on a virtual machine". SQL is optimized in how it accesses memory and deals with the file
system. Microsoft has backed away from this firm stance, although it still recommends running SQL on
physical, dedicated machines. If SQL is run on a virtual machine, memory and CPUs CANNOT be
oversubscribed. It is still recommended that SQL hit physical disks (or NAS) and not a virtual file system.
Dedicated is best. If you give SQL 'X' amount of memory and another process on that machine suddenly
takes the memory away, it drastically affects SQL's performance.

Question: Does SQL Server need to be set up on the same LAN as the application and process servers?

Answer: Not required, but highly recommended. High throughput and low latency is the goal for best
performance.

Question: Should SQL files be distributed across separate disks?

Answer: Yes. For example: Data, Logs, temp, and DB.

Load Balancer
Question: Can software-based load balancers be used for Cherwell's Server Farm solution?

Answer: Yes, as long as they are set up properly. IIS ARR is an example of a software load balancer
solution, although we do not recommend it. To use it, ensure that all of its response-caching features are
disabled.

Question: What are the key performance indicators of a load balancer?

Answer: Max throughput, SSL throughput, SSL transaction per second (TPS) based on key size -
typically 2048 - HTTP requests per second.

Question: For health monitoring, which application may be monitored to indicate server online state?

Answer: /CherwellService application pool is a good candidate for this; others can be used.
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Configuring HTTP Headers for Load Balancers,
Web Application Firewalls, and Reverse Proxies

Certain functionality in the Cherwell Browser Client, Portal, Cherwell REST API, and Cherwell Service
requires knowledge of a user's fully qualified domain name (FQDN). In the initial request, this is provided
by the "Host:" header, but web application firewalls (WAFs), load balancers, and reverse proxies typically
overwrite the value of this header as they pass the request through to the web server that will ultimately
service the request (upstream server).

CSM looks for two groups of headers to determine the original connection's host (FQDN) and protocol/
scheme (HTTP vs. HTTPS) respectively. These follow current web standards, some of which are set by
default on some of the more common WAFs and load balancers:

Connection's Host

• X-Forwarded-Host: https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/X-Forwarded-
Host

• Host: https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Host

Connection's Protocol/Scheme

• Forwarded: https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Forwarded (note that
CSM only evaluates the "proto=" part of this header's value, if present)

• X-Forwarded-Proto: https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/X-Forwarded-
Proto

If multiple headers are present, CSM will look for the first one present, starting at the top of the lists above
(that is, "X-Forwarded-Host" takes precedence over "Host").

Alternate option: Some WAFs, load balancers, and reverse proxies allow system administrators to
configure the value used for the "Host:" header sent to the upstream server. This can work, but is not
recommended in CSM 9.5.0 and newer. Prior to CSM 9.5.0, this was a valid workaround for network
topologies that included one or more WAFs, load balancers, or reverse proxies.

Note: We include reference to reverse proxies due to certain similarities to WAFs and load
balancers. However, we recommend using a load balancer for server farms and an optional WAF;
a reverse proxy is not required by CSM and is typically unnecessary and discouraged.
Furthermore, (forward) proxies continue not to be supported by Cherwell.
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Advanced Cherwell Server Farms
Learn about advanced techniques for optimizing Cherwell Server Farms.

A simple configuration of the Cherwell Sever Farm is sufficient in most instances. The information in the
Advanced Cherwell Server Farm section is intended for those who are comfortable and knowledgeable
with the components and configuration of a Cherwell Server Farm.
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Implementing a Cherwell Server Farm
Consider setting up a single-server farm for testing and sizing purposes. The single-server configuration
ensures that Redis is configured correctly and measures how much memory the Redis Servers need.

To implement a Cherwell Server Farm (high-level):

1. Distribute the requests to a single server across multiple servers.

2. Use a load balancer to distribute requests among servers.

3. Size the infrastructure to increase the number of Users and considering the levels of reliability you
want to provide.

Warning: Do not attempt to implement these processes if you are not an advanced User. Serious
network and system issues can occur.

Setting up a Single-server Farm
To set up a single-server farm:

1. Install the Cherwell Application Server and Cherwell Web Server on a single machine.

2. In the Server Manager, turn on Server Farm features and connect to Redis. For more information,
see Configure a Cherwell Server Farm.

3. Do not set up a load balancer.
At this point you have a single server that behaves as if it is part of a farm. Open the Portal and
Browser Client to see the data being stored in Redis.
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Distributing the Requests to a Single Server
Across Multiple Servers

After distributing the requests, the overall configuration changes from a single server to a multiple server.

The main differences are the addition of the load balancer and extra Cherwell Servers. The Cherwell
Server Farm uses a number of servers; the exact number depends on your specific scenario. Cherwell
runs on different physical or virtual servers. Different Cherwell Servers (like the Application Server and the
Web Servers) are installed multiple times on different boxes.
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Using a Load Balancer
A Cherwell Server Farm enables you to add load-balancing capabilities using your existing firewall
between the CSM server and the web.

In a single-server scenario, all traffic that comes in for CSM is directed to the same server. In a Cherwell
Server Farm, users are redirected to different machines.

CSM servers that can be load balanced are the Cherwell Application Server and the web server. These
servers can run in a load-balanced mode where servers on different machines can coordinate as a single
unit by communicating with a central-state storage. CSM uses Redis as a central-state storage
technology. For more information, see Purpose of Redis.

Three load-balanced servers should be deployed to match the performance of a single standalone server.
This is due to the overhead associated with the Cherwell Server Farm topology. The UI in a load-balanced
environment can appear slightly slower because of session state serialization and Redis traffic.

The following example shows how a load balancer can be configured to handle requests.
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Load-Balancing Methods

Note: Sticky sessions or other methods of load balancing where Redis is not deployed are not
supported.

These examples describe commonly supported load-distribution methods available to most load
balancers.

• Round Robin

(Most Common) The system passes each new connection request to the next server in line,
eventually distributing connections evenly across the array of machines being load balanced. This
method works well in most configurations, especially if the equipment that is being load balancing is
roughly equal in processing speed and memory.

• Least Connections:
◦ Node:(Most Common) The system passes a new connection to the node that has the least

number of current connections out of all pools of which a node is a member. This method
works best in environments where the servers or other equipment you are load balancing have
similar capabilities. This is a dynamic load balancing method, distributing connections based
on various aspects of real-time server performance analysis, such as the number of current
connections per node, or the fastest node response time.

◦ Member: The system passes a new connection to the node that has the least number of
current connections in the pool. This method works best in environments where the servers or
other equipment you are load balancing have similar capabilities. This is a dynamic load-
balancing method, distributing connections based on various aspects of real-time server
performance analysis, such as the current number of connections per node or the fastest node
response time.

• Dynamic Ratio (member)

This method is similar to Ratio (node) mode, except that weights are based on continuous
monitoring of the servers and are continually changing. This is a dynamic load-balancing method,
distributing connections based on various aspects of real-time server performance analysis, such as
the number of current connections per node or the fastest node response time.

• Ratio Least Connections
◦ Node: The system selects the node according to the ratio of the number of connections each

node has active.

◦ Member: The system selects the pool member according to the ratio of the number of
connections each pool member has active.

• Ratio (member)

The number of connections that each machine receives over time is proportionate to a ratio weight
defined for each machine within the pool.
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• Weighted Least Connections
◦ Node: The system uses the value specified in the node's connection limit and the number of

current connections to a node to establish a proportional algorithm. This algorithm requires all
nodes used by pool members to have a non-zero connection limit specified.

◦ Member: The system uses the value specified in connection limit to establish a proportional
algorithm for each pool member. The system bases the load-balancing decision on that
proportion and the number of current connections to that pool member. For example,
member_a has 20 connections and its connection limit is 100, so it is at 20 percent of capacity.
Similarly, member_b has 20 connections and its connection limit is 200, so it is at 10 percent
of capacity. In this case, the system selects member_b. This algorithm requires all pool
members to have a non-zero connection limit specified.

• Least Sessions

The system passes a new connection to the node that currently has the least number of persistent
sessions. This method works best in environments where the servers or other load-balanced
equipment have similar capabilities. This is a dynamic load-balancing method, distributing
connections based on various aspects of real-time server performance analysis, such as the
number of current sessions. Use of this load-balancing method requires that the virtual server
reference a type of persistence profile that tracks persistence connections.

• Observed
◦ Node: The system ranks nodes based on the number of connections. Nodes that have a better

balance of fewest connections receive a greater proportion of the connections. This method
differs from Least Connections (node), in that the Least Connections method measures
connections only at the moment of load balancing, while the Observed method tracks the
number of layer-four connections to each node over time and creates a ratio for load
balancing. This dynamic load-balancing method works well in any environment, but can be
particularly useful in environments where node performance varies significantly.

◦ Member: The system ranks nodes based on the number of connections. Nodes that have a
better balance of fewest connections receive a greater proportion of connections. This method
differs from Least Connections (member) in that the Least Connections method measures
connections only at the moment of load balancing, while the Observed method tracks the
number of layer-four connections to each node over time and creates a ratio for load
balancing. This dynamic load-balancing method works well in any environment but can be
particularly useful in environments where node performance varies significantly.

• Predictive
◦ Node: The system uses the ranking method used by the Observed (member) methods, except

that the system analyzes the trend of the ranking over time, determining whether a node's
performance is improving or declining. The nodes in the pool with better performance rankings
that are currently improving, rather than declining, receive a higher proportion of the
connections. This dynamic load-balancing method works well in any environment.

◦ Member: Uses the ranking method used by the Observed (member) methods, except that the
system analyzes the trend of the ranking over time, determining whether a node's
performance is improving or declining. The nodes in the pool with better performance rankings
that are currently improving, rather than declining, receive a higher proportion of the
connections. This dynamic load-balancing method works well in any environment.
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Sizing an Infrastructure
There are a number of questions to answer if you are thinking about an expandable User base that goes
beyond what a single server can serve:

• What is the total number of Users I want to support?

• What is the typical number of parallel Users that I need to support?

• Are there any peak of usage where a high percentage of your Users might flood the system? If so
what does that look like?

Once you have those numbers, then consider:

• Is your SQL Server sized correctly?

• Can your internal and external network pipe support such traffic?

• How much hardware do you need for the different Cherwell Services?
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Architecture Guidelines
In a Cherwell Server Farm, services can be distributed onto different machines depending on the
expected traffic. A Cherwell Server Farm is comprised of a number of Cherwell Servers that are
distributed across hardware depending on the abilities of the server.

As the architecture diagram shows, the Browser Client Server and Application Servers (tier 2) are in the
same machine along with a variety of other servers.

1122

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Coordinated Servers
Some servers can be load balanced, for example the application server and web server. These servers
can be run in a load-balanced mode where servers on different boxes can work together as a single unit.
They are coordinated by communicating with a centralized session-state storage, Redis. In order to scale
the service provided by these servers, more servers need to be added to the Cherwell Server Farm.
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Should one of those servers go down, Users experience a performance degradation inversely
proportional to the number of machines.

Independent Servers
Some servers can collaborate even if they are not aware of each other. These are servers that process
items from a queue. Typically, more than one of the servers can be fired up without having to change
anything. The servers pick up items from a queue and process them individually. To scale the service
provided by these servers, install and run the server on multiple machines. Should one of those machines
go down, Users experience a performance loss that is inversely proportional to the number of machines.

Single-Instance Servers
For other servers, you cannot run more than one instance at a time. To scale these you need a bigger,
faster machine. If that machine goes down, the service is interrupted. These servers process items from a
queue. If a machine breaks and is offline for a few minutes, quickly bring the machine back online (or
bring an identical machine back online). The new machine begins where the original machine left off,
delaying the delivery or the processing by an interval of time. Since these machines work off of a queue,
and not in real time, it is possible that Users might not notice the service interruption.
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Advanced Redis Information
Redis is a fast, in-memory, caching mechanism that allows Cherwell to quickly exchange data between
servers.

Cherwell stores temporary, volatile data into Redis so that each server can pick up where other servers
have left off. Redis runs very well on commodity hardware and does not need any hard-drive space
because it stores everything in-memory. Redis is an open source database that can run both on Windows
and Linux. Download it here.

CAUTION: Do not attempt to implement these processes if you are not an advanced User.
Serious network and system issues can occur.

Redis is used to share two types of data:

• User session data: Describes the state of the current logged in User. There is an entry in Redis for
each of the active sessions on the web. No sensitive data (password or encrypted fields) are stored
in Redis. Session data is only stored transiently as Users go from one request to another. All
session information is deleted on session expiration, and all information is deleted if Redis is turned
off.

• Common application data needed for the application server to work: Application data is stored
in Redis for the entire time that the application is running.

Redis Labs Enterprise Cluster
CSM is compatible with Redis Labs Enterprise Cluster (RLEC), the enterprise offering that allows you to
simplify your Redis management. In a RLEC environment, many implementation details are simplified.
For example, RLEC eliminates the need to manually edit configuration files, manually set up a master/
slave environment, or determine how many sentinels you need.

While the documentation in this section is primarily intended written for users who do not use RLEC, it is
beneficial for you to understand the underlying technology and the options described in our
documentation so you can make decisions appropriate to your specific environment.

If you are using RLEC, we recommend you become familiar with the concepts expressed in the
documentation, as they apply in both scenarios. For the few places where RLEC deserves specific
considerations, you will see RLEC notes accompanying the documentation.

1125

CSM 10.0.0 Administration

CSM 10.0.0 Administration

http://redis.io/download


Redis Sizing Guidelines
Redis stores two types of data: Application state and User state.

Application state typically can take up a few MB and is not a factor when making sizing considerations.
Session state grows linearly with the number of concurrent Users in your system. Since Redis stores
session data for the duration of active sessions, if you have session duration set to 90 minutes, at any
given point in time, Redis stores session for any User with activity in the last 90 minutes.

As a best practice, calculate how much Redis memory you need by figuring out the maximum number of
Users in any time window equivalent to a session duration, and then multiply it by 10 MB. That covers in
the majority of the cases. If this proves to be insufficient, proceed with the process below in order to
measure actual memory consumption

The size needed for each system can vary depending on your content and the particular page and activity
Users are performing. Measure your own specific load in order to estimate the sizing numbers. Use the
measurements below to calculate what kind of Redis memory your Cherwell Server Farm requires; and, if
necessary, increase the memory of your server.

To measure sizing numbers:

• For the purposes of sizing Redis, set up a farm with a single server.

• Load into the system with 10 Users, and then measure the load in Redis.

• Load into the system with 20 Users, and then measure the load in Redis.

• Load into the system with 100 Users, and then measure the load in Redis.

With the data points, compute the average Redis load per User expressed in Kb. Multiply that number by
the peak (or total) number of Users..

Retrieving the Size of Redis Memory
When Redis is installed, it is easy to open a client window and send Redis commands. One of those
commands is INFO, which shows the current memory size occupied by the Redis database. The sample
output of the command shows the peak usage of Redis. This is the number needed to calculate how
much memory each User needs.
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Current Sizing Limitations
There are some physical limits to the number of Users that can be supported based on the current
configuration:

• Physical memory on a machine: Adding memory to a machine should be easy. It is common to have
servers with hundreds of GB or even 2TB of data. Assuming a single User footprint of 4MB, that
means being able to support 10,000 concurrent Users with 40GB of RAM.

• Network traffic: Once the RAM is sized, your next concern is throughput. The calculation would be
similar to the table below (input rows are indicated, others are calculated).

Organizational specifics for sizing can vary depending on the assumptions made. Generally, based on the
common numbers expect 10,000 Users to require 10 GIG+ per second to go through a network. These
numbers are only the Redis traffic. Web and SQL traffic also increases the number. The increase happens
in such a way that it is impossible to project, but should be fairly easy to find if metrics are run on the
network. As Redis becomes the bottleneck, performance needs to be addressed across the board.

The calculations in the table below are based on default Cherwell Server Farm settings.

The example calculations below are from proven averages.

Example: For every page, you need to read from Redis an average of four times, and to figure out the
actual traffic you have to double that (every time there is a read, there must be a write). The following
table gives an idea of how to calculate the traffic:
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Calculating Redis Network Traffic

Input:Clicks per User per
minute 2

How many times per minute does an average User click a
button or a link? Once every 30 second is a good average
between active Users and Users that wait between
performing actions (or that just leave their browser open
without even looking at it).

Input:Users 10,000 What is a reasonable peak of maximum concurrent Users?
The number of concurrent Users that are using the system.

Input:Redis reads per click 4

Reads per click: Every time a User clicks a button,
something happens. It can navigate from one page to
another, or save an object being. Depending on content, the
Browser Client is rendering a page that might make a
number of changes.

Input:Redis Writes per click 4 This varies depending on content and the page the User is
on.

Redis requests per minute 160,000 Calculated = Clicks x Users x (Reads + Writes)

Input:State size per User in
MB 4 Varies depending on the content and the page that the User

is on.

Redis Network Traffic per
minute in MB 640,000 Calculated = Requests per minute x 4

Requests per second 2,667 Calculated = Requests per minute/60

Redis traffic per second in MB 10,667 Calculated = Traffic per minute/60
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Redis Requirements
Redis can be configured in multiple ways. Cherwell recommendations are based on testing results for
working optimally with a general configuration of CSM.

For more information and support, refer to Redis.Io.

Redis Labs Enterprise Cluster
CSM 8.3.2 and later is compatible with Redis Labs Enterprise Cluster (RLEC). Use RLEC to configure
Redis environments. Any version of RLEC will work with CSM.

Hardware Requirements
Sizing Redis is not just a matter of sizing its memory, but also fine tuning the rest of the resources. Be
aware that:

• A machine (or virtual machine) should be dedicated to Redis.

• In the dedicated machine, there should be exactly two CPUs. One CPU is used by the system and
is mostly idle. The other CPU is used by Redis.

• Allocating three CPUs does not hurt Redis, but the third CPU will never be used.

• CPU speed is not a crucial factor. The Redis CPU remains dormant most of the time. It takes a lot of
traffic to increase the CPU to a heavy load. With the current configuration of Redis, by the time the
CPU is getting fatigued, the network connection might already be the bottleneck. Pay attention to
the network connection between the servers and Redis and between the Redis Servers (if
clustered).
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Redis Configuration
Redis can be configured to run in single mode or a cluster configuration.

This section offers suggestions on how to setup an ideal CSM environment, including high availability
considerations that add resiliency to a Redis database.

Settings
Redis is a simple application that requires an executable to be present and running on a given machine.
On the startup.exe, Redis reads a flat .config file that contains a number of value pairs to establish the
different available settings. Some settings will be specific to your environment, but others directly impact
CSM.

Common Settings
All Redis instances should be configured to NOT save any data to disk by commenting out the SAVE
directive in the default config file. Commenting is done by adding a # in front of it. Use the password
directive in the default file to set the password so communication with Redis only happens with processes
that know the password.

Optional Settings
Depending on the environment, if you want to provide high availability, you need to configure sentinels,
masters, and slaves. If the Redis memory demand exceeds what is provided on a single server, configure
Redis with clustering. Using a cluster configuration provides three main benefits:

• Shares large memory cache across many servers.

• Provides high availability.

• Distributes the CPU load across multiple CPUs (Redis is a single CPU process).

Connections
Run Redis in standalone, master/slave, or cluster mode. Ideally the minimum configuration is master/
slave with sentinels.

For more information on Redis sentinels, refer to Redis Sentinel Documentation.

Sentinels
A sentinel is a component of Redis that keeps an eye on both the master and the slave. It identifies when
the master goes down and immediately promotes the slave as the master. Ideally the minimal
configuration has two sentinels, one for master and one for slave. When the sentinel switches the master,
CSM switches as well if both are listed in Connect to field on the Server Manager.

Master/Slave
This configuration is only required if operating Redis as a high availability service. If an organization wants
to horizontally scale Cherwell services, only one Redis server is required.

A master/slave connection has one copy of the master data kept in a slave. The slave and master both
must be configured via the Server Manager, including both IPs and both ports with the same password. If
there is a cluster of Redis, add the IP of the cluster in Host field on the Server Manager. If master and
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slave copy each other, one is always master and one is slave. If the master goes down, the slave does
not know unless there is a sentinel. If the master goes down, it becomes the slave when it comes up
again. CSM does not need to know who is master and who is slave, just the nodes for Redis in the chain.

Backup vs. Slave
Redis, by default, is setup to backup information to disk every second, but it causes slowdowns. When
Redis is installed, the configuration file has a save directive with parameters. Turn off the save to disk by
deleting the directive or commenting it out. Use a master/slave configuration to provide backup
functionality. There are some points to remember:

• If all of Redis goes down and the Customer does not have the save to disk feature, then everyone
will be logged off and can log on again when it comes up.

• If all of Redis goes down and the Customer does not have save to disk feature, then there is no way
to predict how the server farm will behave because it errored out and IIS went down. This is why the
save directive is not recommended.
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Redis Q&A
Question: What if my Redis Server goes down? Is that a single point of failure?

Answer: Yes it is. Fortunately, you can set up Redis with high availability, see Redis Configuration.

Question: How many slaves should I have for a master?

Answer: For high availability, have at least three Redis Servers and three sentinels.

Question: How often does Redis fail?

Answer: Cherwell tests have not experienced an unstable Redis. Failures are usually due to hardware
problems, with the following exceptions:

• If enough memory is not allocated to the Redis process. When Redis starts requesting more
memory than the system can allocate, it fails.

• If too much memory is pre-allocated to Redis, and the OS does not have any memory left for itself.

Question: How many sentinels should I install, and where?

Answer: A common approach is to install a sentinel for each Redis Server running. For example, if there
are one master and two slaves, then have three sentinels.

Question: How does a sentinel work?

Answer: A sentinel pings the master server at regular intervals, and if it does not receive an answer
within a certain amount of time (configurable in the settings), it evaluates the possibility of promoting a
slave to master. A single sentinel does not necessarily have the authority to switch a master to a slave,
because there might be other sentinels that disagree with it. For the master to actually be swapped with a
slave, a minimum number of sentinels (configurable) called quorum, need to agree that the master is
down. That means that based on your particular setup, you might have to change the default quorum
number, as well as the master timeout interval.

Question: Can Redis Servers be deployed in multiple geographic locations?

Answer: No, all Redis Servers should be together on the same LAN as the application servers in the
Cherwell Server Farm due to latency sensitivity.

Question: What is the minimum line speed and latency required for Redis?

Answer: At least 1 GbE with latencies below 3 milliseconds between the Redis Servers and the
application servers. Today's Enterprise networks are usually 10 GbE or better, which is more desirable.
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Configuration Scenarios
Three example Server Farm configuration scenarios help clarify the options and what variables can be
manipulated to adapt your organizational needs.

No two Cherwell Server Farms are identical because of the load they are under, the CSM content and
configuration, as well as their usage can differ dramatically from Customer to Customer. In the examples,
we assume that your network, load balancer, and SQL infrastructure are inherently scalable to the size
needed. The three example scenarios are:

• Minimal server farm.

• Server farm and independent services.

• Maximum distribution of services.

Design Best Practices
When designing the configuration for the Cherwell Server Farm, remember these best practices:

• 1 CPU core per 50 concurrent Users; minimum of two to start.

• 10 MB of memory per session for Redis Servers; 2 CPU cores per server.

• 50 MB of memory per session for Cherwell Application and Web Servers, plus Redis memory.

• 500 MB of storage per license per year.

• Redis must be deployed in a high-speed, low-latency, directly-connected environment. This is
typically a 10 GbE network (dedicated is best).

• When promoting from a single server to a Cherwell Server Farm model, remember that a Cherwell
Server Farm incurs overhead that lowers the number of concurrent Users serviced by a single
machine. Performance and high availability convention is three load-balanced servers = a single
server.

Hardware Considerations
Some scaling can typically be done in a single-server scenario just by adding CPUs and memory to the
one machine. Such a proposition usually costs more than increasing the number of commodity servers in
a Cherwell Server Farm. The example scenarios assume each machine in the Cherwell Server Farm is a
commodity box.

Cost considerations for Commodity Hardware
If CSM is installed on a single server using a big server approach (8 core, 32 GB and up) and not
commodity hardware (4 core, 16 GB). Determine if the same hardware configuration should be kept for
each server or if there is a cost saving opportunity by moving to commodity hardware when moving to a
Cherwell Server Farm. If you decide to move to less expensive hardware, there is no exact equation for
how many servers are needed, but keep the following in mind: Load-balanced servers are typically CPU
heavy, so the CPU is the first and most important factor in the multiplier.
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Minimal Scenario
In this scenario, only the application and web servers are load balanced and provide high availability.

All other servers are located on one machine. If the machine with multiple servers goes down, remedial
action should be taken to bring it online as soon as possible. A minimal configuration has the following
characteristics:

• Only the coordinated servers are load balanced.

• All coordinated servers are on individual machines.

• All other servers are on a dedicated machine.
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Independent Services Scenario
This scenario is similar to the minimal scenario by having the application and web servers load balanced,
but provides scalability and higher availability for the other servers.

• More than one instance of all independent servers are on so they can collaborate handling the
workload.

• The single-instance servers are all installed in a single machine, but there is a replicated machine
that remains offline. Should the first machine go down, the second machine can quickly be brought
online to serve Users.
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Maximum Distribution of Services Scenario
In the maximum distribution scenario, servers are installed on multiple boxes because no single machine
has enough performance to be able to run more than one single Cherwell server at the time.

The main concept remains the same, but there are more machines in the Cherwell Server Farm and one
dedicated machine for each server. In the diagram, there are three machines dedicated to the application
server and three machines for the web server.
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Migrating to a Cherwell Server Farm
The migration procedures focus on the Desktop Client and Web Applications because the majority of
systems have a primary need of a server farm in order to provide scalability and high availability for those
types of clients.

To migrate to a Cherwell Server Farm:

• Establish a baseline

• Calculate the numbers of servers needed

• Incorporate Redis

Establish a Baseline
Start by isolating the web and application servers from all the other servers. Your scheduling or e-mail
servers might be using the resources needed to serve the Desktop Client and Web Applications. Create a
single-server environment where the web and app server have a dedicated machine and all other
services are together in one machine.

Calculate the Number of Servers Needed
To calculate the number of server, have a few data points ready:

• USER_POPULATION: What is your total number of Users?

• CONCURRENT_USER_PEAK: What is the peak number of concurrent Users I want to support?

• USER_LOAD_THRESHOLD: At what point do you start experiencing slowness?

• MACHINE_FAILURE_TOLERANCE: How many machines do I expect could go down at the same
time?

Example: You have an environment with three thousands Users, a typical peak usage of one thousand
Users, and the system performance starts slowing at around three hundred Users.

Based on the calculations above, you would need six servers to be able to comfortably serve a typical
peak User population, but you would need 69 servers to support 100 percent of Users coming online at
the same time.
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The calculation above does not take into consideration if the Users are Web or Desktop Client Users.
There is a possibility that the environment is heavy loaded on one type of client. If this is true, start with a
configuration where both application and web servers are distributed across the
LOAD_BALANCED_SERVERS_REQUIRED. If that is insufficient, select one of two strategies:

• Add more hardware, keeping web and application servers on the same box. See Minimal Scenario.

• Separate the application and web servers and perform the above calculation for the DIFFERENT
load that you expect on each platform. See Maximum Distribution Scenario. At the end there is a
number of LOAD_BALANCED_SERVERS_REQUIRED for web and application.

Example: Migrating from large servers to commodity hardware
If the core machine is 8 2.4gHz, and you want to use commodity hardware instead, consider using two 4-
core 2.4gHz machines, or three 3-core 1.8ghz machines. The calculation is not perfect science, but the
cost saving should allow you to err on the side of caution.

If the original LOAD_BALANCED_SERVERS_REQUIRED is six, consider a multiplier of two or three
depending on the commodity hardware you chose to use, for a total of 12 or 18 commodity machines
instead of six servers.
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Advanced Server Farm Q&A

Upgrades
Question: Do I need to stop services when I upgrade CSM?

Answer: Certain components of the system can be upgraded without stopping but others require taking
everything offline.

Stop the entire farm if you are:

• Upgrading any Cherwell component.

• Changing configuration elements, especially:
◦ Connection to the SQL database.

◦ Connection to Redis.

◦ Logging.

In the following cases do not stop the entire farm, instead take servers offline one (or more, but not all) at
a time:

• Changing hardware

• Adding or removing servers

• Installing virus scan on the system

• Installing windows updates

Configuration
Question: Given a high availability configuration, what can go wrong?

Answer: One server in the farm could go down, Redis master could go down, but the server farm remains
up and running (provided that there are other web servers running, the Redis master is backed up to a
slave, and a sentinel was able to detect the failure of the master). If, as a whole, the load balancer, SQL,
or Redis go down, they take down the entire farm, even if the servers in the farm are still running.

Question: How do I know if I have to break up my servers onto multiple machines with a dedicated
machine, or if I can share a machine across multiple Cherwell servers?

Answer: Depending on the size of your machine and the performance load you have, a shared machine
might not be enough.
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Trusted Agents
Trusted Agents offer cross-network access between CSM servers and other private resources, such as
LDAP directories, mail servers, and relational databases. Enabled Trusted Agents connect to CSM
servers using firewall friendly protocols. The CSM servers then call Trusted Agents to perform operations
on their behalf.

For example, Trusted Agents:

• Provide CSM SaaS customers secure access between resources on their private network and the
Cherwell data center.

• Enable secure access to private resources across networks in your organization.

• Enable secure access between a Cherwell partner's CSM network and private resources on your
network.

The following diagram provides an example of one possible Trusted Agents configuration. While other
deployment architectures are possible, this diagram provides a simple visual representation of the
relationship between the components.

Features That Can Use Trusted Agents
Trusted Agents support integration with several different kinds of private resources. The table below
summarizes these supported types of resources and the CSM operations that can be performed with
each. You can create service groups to control which private resources use Trusted Agents and to route
requests to each service group. For more information, see Configure Trusted Agents Service Groups.
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Private Resource
Type CSM Operations

Email All email operations within CSM.

LDAP Directory

LDAP Authentication.

LDAP-mapped user import.

LDAP-mapped Business Object import.

One-Step Actions

The following Action types:

• Print

• Run a Program

• Run a Report

• Write to a File

• Transfer Attachments

• Call a Web Service

• Excel Merge

External databases
(relational database)

Bulk import of mapped Business Objects.

Note: Linked data imports are not supported at this time.

Windows Domain Windows Authentication.

Related concepts
Configuring Trusted Agents
Configuring Trusted Agents Features
Trusted Agents Logging
Troubleshoot Trusted Agents
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Trusted Agents Components
Understanding the components that participate in Trusted Agents scenarios is key to a successful cross-
network implementation.

Component Definition

Private CSM Network

The network in which CSM servers are running. For SaaS customers, this is the
Cherwell data center.

This network is separate from the network in which one or more private resources
reside, so Trusted Agents are required to communicate with those private
resources.

Private Customer Network
A network that contains one or more private resources, such as an LDAP
directory and/or a relational database, that need to be accessed by CSM but
which are separated from CSM by one or more network security boundaries.

Private Resource

A server, service, or data source that is not directly accessible to CSM servers
because of one or more network security boundaries. A typical scenario is to
have one or more private resources within a private customer network while CSM
is hosted outside of the customer network.

Redis Cache A Redis database used to enable scale-out of Trusted Agents Hubs.

Trusted Agent

A software component that acts as a proxy for communication between a Trusted
Agents Hub and one or more private resources of a given type. Each Trusted
Agent can handle communication with one type of private resource, but it can
handle communication with more than one instance of that private resource type.

For example, a Trusted Agent for external data can connect to any number of
databases as long as those databases are accessible to the Trusted Agent.
Similarly, a Trusted Agent for LDAP can connect to any number of LDAP
directories as long as those directories are accessible to the Trusted Agent.

Each Trusted Agent is hosted within a Trusted Agents Service.

Trusted Agents Hub

A CSM software component that runs within a CSM Browser Client web
application and acts as the central point of communication for all Trusted Agent
interactions. Trusted Agents connect to a Trusted Agents Hub at startup, and
CSM servers communicate to Trusted Agents by sending requests to the Trusted
Agents Hub, which selects the Trusted Agent to receive each request.

Trusted Agents Hubs may be scaled out using Redis just as CSM Browser Client
can be scaled out.

For SaaS customers, the Trusted Agents Hub is hosted in the Cherwell data
center.

1142

CSM 10.0.0 Administration

CSM 10.0.0 Administration



Component Definition

Trusted Agents Service
Group

A configurable set of Trusted Agent Services that can be created in CSM
Administrator and selected when configuring Trusted Agent usage for CSM
features. Trusted Agents Groups are used to route requests to only specific
Trusted Agent Services. If no groups are configured, all Trusted Agent Services
are assumed to be capable of performing all Trusted Agent operations.

Trusted Agents Server

The physical or virtual machine that hosts a Trusted Agents Service and is
collocated on a private network with the private resources that should be
accessible to CSM servers. A Trusted Agents Server can host only one Trusted
Agents Service, but multiple Trusted Agents Servers can be used to support
request routing and fault tolerance.

For SaaS customers, the Trusted Agents Server is hosted in the servers in the
customer's domain.

Trusted Agents Service

A Windows service that hosts Trusted Agents. Each Trusted Agents Service hosts
one Trusted Agent for each feature supported by CSM, for a total of five: external
databases, LDAP authentication, Windows Domains, email, and One-Step
Actions.

Related concepts
Trusted Agents Server Technical Architecture
Configuring Trusted Agents
Related tasks
Using Trusted Agents Server with LDAP
Using Trusted Agents Server with Windows Domains
Import External Data Using Trusted Agents
Using Trusted Agents with Email
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Configuring Trusted Agents
Trusted Agents configuration requires steps on two networks and potentially multiple servers.

Good to Know:

• You need separate Trusted Agent Hubs and shared keys for each CSM environment (development,
test, and production, for example).

• Each Trusted Agent Server makes one connection to each LDAP or Active Directory server. If you
have multiple domains, you must install a Trusted Agent Server on each domain, but each server
can connect to the same Trusted Agent Hub for its environment.

• For server and operating system requirements, refer to the CSM System Requirements.

• When you upgrade CSM, you must also upgrade all Trusted Agents Servers.

Process for SaaS Customers
To facilitate communications between CSM and your private resources, Cherwell configures the Trusted
Agents Hub on Cherwell servers. You install and configure one or more Trusted Agents servers on your
network.

Configuration Task Task Location

1. Request a Trusted Agents Hub from Cherwell. Cherwell data center.

2. Install the Trusted Agents Server.
See Install the Trusted Agents Server.

A server on the same network as your private
resource.

3. Configure the Trusted Agents Server.
See Configure the Trusted Agents Server.

The same server where you installed the Trusted
Agents Server on the same network as your private
resource.

4. Grant Security rights to control access to Trusted
Agent configuration options in CSM Administrator.
See Tools Security Rights.

From CSM Administrator.
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Configuration Task Task Location

5. Connect to the Trusted Agents Hub from CSM
Administrator.
This step is required if you intend to use features that
require configuration in CSM Administrator. These
features include:

• Importing external data using Trusted Agents

• Scaling Trusted Agents for request routing

• Importing Directory Service data Into Business
Objects

• Using email

• Executing One-Step Actions on a remote
network

See Connect to the Trusted Agents Hub from CSM
Administrator.

From CSM Administrator.

6. Create Trusted Agents Service groups.
This step is required if you want to route requests to
only specific Trusted Agent Services.

See Configure Trusted Agents Service Groups.

From CSM Administrator.

Process for On-premises Customers
On-premises customers configure all Trusted Agents components.

Configuration Task Task Location

1. Enable the Trusted Agents Hub.
See Configure the Trusted Agents Hub in the Server
Manager.

On the server that runs the CSM Browser Client web
application.
If you are using server farms, this task must be
performed on each server.

2. Install the Trusted Agents Server.
See Install the Trusted Agents Server.

A server on the same network as your private
resource.

3. Configure the Trusted Agents Server.
See Configure the Trusted Agents Server.

The same server where you installed the Trusted
Agents Server on the same network as your private
resource.

4. Grant Security rights to control access to Trusted
Agent configuration options in CSM Administrator.
See Tools Security Rights.

From CSM Administrator.
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Configuration Task Task Location

5. Connect to the Trusted Agents Hub from CSM
Administrator.
This step is required if you intend to use features that
require configuration in CSM Administrator. These
features include:

• Importing external data using Trusted Agents

• Scaling Trusted Agents for request routing

• Importing Directory Service data Into Business
Objects

• Using email

• Executing One-Step Actions on a remote
network

See Connect to the Trusted Agents Hub from CSM
Administrator.

From CSM Administrator.

6. Create Trusted Agents Service groups.
This step is required if you want to route requests to
only specific Trusted Agent Services.

See Configure Trusted Agents Service Groups.

FromCSM Administrator.

Related concepts
Tools Security Rights
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Configure the Trusted Agents Server
Connect to the Trusted Agents Hub from CSM Administrator
Configure Trusted Agents Service Groups
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Configure the Trusted Agents Hub in the Server
Manager

The Trusted Agents Hub is configured in the Cherwell Server Manager on the same machine running the
CSM Browser Client. If you are using a server farm, you must install the Trusted Agents Hub on each
server.

Cherwell performs this task for SaaS customers.

To configure the Trusted Agents Hub:

1. On the machine running the CSM Browser Client, go to Start>All Programs>Cherwell Service
Management>Tools>Server Manager to open the Cherwell Server Manager.

2. Select the Configure button next to Trusted Agents usage.
3. On the Trusted Agents Hub Configuration dialog, select the Enable Trusted Agents check box.
4. In the Hub URL box, provide the address that is used to connect to the Hub from other Cherwell

servers and services. This is typically the same URL that is used to access the CSM Browser Client
(https://server name/CherwellClient).

5. In the Shared Key box, provide the key that will be used in each Trusted Agents Server
configuration. This key is used to ensure that only properly configured Trusted Agents are permitted
to connect to the Hub. Each CSM system should have a unique Shared Key.

6. Select Generate Key to generate a secure shared key. You can create your own Shared Key, but
the key generation tool provides a simple way to generate a unique key.

7. Select Test to verify connection information.
8. Set timeout settings:

Option Description

Agent Operation Timeout Specify the amount of time the Trusted
Agents Hub waits for an operation to
complete, send data back, or how long an
operation takes to send a progress update
before timing out. The default setting is 30
seconds.

Note: Use -1 to disable timeouts.
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Option Description

Agent Registration Timeout Specify the amount of time the Trusted
Agents Hub waits for a ping from the Trusted
Agent before it assumes the Trusted Agent
is down. The default setting is 180 seconds.

Note: This setting should never be
lower than the Hub Ping Frequency
set for each Trusted Agents Server.
The default for the Hub Ping
Frequency is 20 seconds.

9. Select OK.
10. Restart all Cherwell services and Internet Information Services (IIS).

Related concepts
Configuring Trusted Agents
Using the Server Manager
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Server
Connect to the Trusted Agents Hub from CSM Administrator
Configure Trusted Agents Service Groups
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Install the Trusted Agents Server
The Trusted Agents Server is installed on the same network as the private resource to which it connects.
For example, if you want to use Trusted Agents for LDAP authentication, install the Trusted Agents Server
on the same network as your directory service.

Good to Know:

• This task applies to on-premises and SaaS customers.

• The Trusted Agents Server can be installed on the same server as the Cherwell Service Host. For
example, you can use the same server to host the Trusted Agents Server and the Scheduling
microservice provided by the Cherwell Service Host.

To install the Trusted Agents Server:

1. Go to the Cherwell Disk Image folder.
2. Open the Utilities folder.
3. Double-click the Cherwell Trusted Agents Server.exe file.

The Trusted Agents Install Wizard opens.
4. Select Next.
5. Select I accept the terms in the license agreement.
6. Select a custom installation location or select Next to use the default location.
7. Select Install.
8. Select Finish.

Related concepts
Configuring Trusted Agents
Related tasks
Configure the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Connect to the Trusted Agents Hub from CSM Administrator
Configure Trusted Agents Service Groups
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Configure the Trusted Agents Server
Configure the Trusted Agents Server to connect to the Trusted Agents Hub. The Trusted Agents Server is
installed on a same machine in the same network as your private resources.

This task applies to on-premises and SaaS customers.

To configure the Trusted Agents Server:

1. Go to the installation directory to run the Trebuchet.ServerConfigTool.exe. The default path from the
install is: C:\Program Files (x86)\Cherwell\Cherwell Trusted Agents Server.

2. Double-click Trebuchet.ServerConfigtool.exe to open the Server Manager.
3. Select Trusted Agent Server from the Server drop-down list, and then select Configure.
4. Provide a display name for the server. This will display in CSM Administrator.
5. Provide Hub connection settings:

Option Description

Hub URL Provide the URL. This is the address that
should be used to connect to the Hub from
other Cherwell servers and services.

Note: Secure transport (HTTPS)
should be used for all Hub
communications in production
environments.

Shared Key Provide the Shared Key. This must be the
same Shared Key that is used in the Trusted
Agents Hub configuration.

Cherwell provides this key to SaaS
customers.

Test Select to verify that the Hub URL and shared
key are valid.

6. Provide connection to the CSM database:

Option Description

Connection Use the Ellipsis button to browse and locate
the database to connect to.
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Option Description

Login to Cherwell Chose one of these options:
◦ Windows authentication: Use the

Windows credentials for the account
that is used to run the Trusted Agent
Service.

◦ User ID and Password: Provide a
CSM user ID and password. Provide a
blank password to allow the specified
user to log in without a password. This
only works if the user does not have a
password. This is not recommended.

Test Select to verify login information.

7. Enter the Hub Ping Frequency in seconds, to send a ping to the Hub. If a ping is not received by
the Hub within the Agent Registration timeout period, then the Agent's registration with the Hub is
considered expired. No further requests are sent to the Agent until the next registration request or
ping is received from the Agent. The Hub Ping Frequency should always be lower than the Agent
Registration period set for the Trusted Agent Hub. The Hub default is 180 seconds.

Note: Use -1 to disable pings sent to the Hub (not recommended).

8. Select OK.
9. Restart the Trusted Agents Server.

Related concepts
Configuring Trusted Agents
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Connect to the Trusted Agents Hub from CSM Administrator
Configure Trusted Agents Service Groups
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Connect to the Trusted Agents Hub from CSM
Administrator

Once you connect to the Trusted Agents Hub from CSM Administrator, return here to easily access your
Hub URL and shared key.

Trusted Agents must be configured before you can connect to the Trusted Agents Hub from CSM
Administrator.

This task applies to on-premises and SaaS customers.

To connect to the Trusted Agents Hub:

1. In CSM Administrator, select the Trusted Agents category, and then the Edit Trusted Agents Hub
Settings task.

2. On the Trusted Agents Hub Settings dialog, provide:
◦ The URL for your Trusted Agents Hub.
◦ The Shared Key used by the Trusted Agents Server and the Trusted Agents Hub.

3. Select Test to verify that you can connect to the Trusted Agents Hub.

Related concepts
Configuring Trusted Agents
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Configure Trusted Agents Service Groups
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Configure Trusted Agents Service Groups
Trusted Agent service groups are used to route requests to specific Trusted Agent Services. If no groups
are configured, all Trusted Agent Services are assumed to be capable of performing all Trusted Agent
operations.

Trusted Agents service groups are created in CSM Administrator and selected when you configure
Trusted Agents for external data sources, LDAP directories, Windows Domains, One-Step Actions, and
email operations.

You can view status and last ping time information for each Trusted Agent Service and Trusted Agent
Service Group.

To configure the Trusted Agents service groups, you must configure Trusted Agents and connect to the
Trusted Agents Hub from CSM Administrator.

To add Trusted Agents service groups:

1. In CSM Administrator, select the Trusted Agents category, and then the Edit Trusted Agents
service groups task.
The Trusted Agents dialog opens. If Trusted Agents is correctly configured and running, all Trusted
Agents Services appear under the All Agent Services node.
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Note: Trusted Agents Services are shown when they are successfully connected to the
Trusted Agents Hub. If no Trusted Agents Services are present in this dialog, connect your
services to the Trusted Agents Hub first, and then use this dialog to configure your services
and groups.

2. Select the Create icon.
3. In the Trusted Agent Group Info section, provide a Name and Description for the service group.
4. Select Save.
5. Repeat the steps to add all of the service groups you need.

The newly created groups appears in the tree.

6. Select a service group, and then select the Add trusted agent service to group  icon.
7. Select a Trusted Agent Service to assign to the service group.
8. Select OK.
9. Assign a Trusted Agents Service to each service group.
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Related concepts
Configuring Trusted Agents
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Connect to the Trusted Agents Hub from CSM Administrator
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Configuring Trusted Agents Features
Trusted Agents can be used for LDAP connections, validation through Windows domains, importing
external data, One-Step Actions, and email operations.

Related tasks
Using Trusted Agents Server with LDAP
Import External Data Using Trusted Agents
Using Trusted Agents with Email
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Using Trusted Agents Server with LDAP
Use your LDAP connection with Trusted Agents to authenticate users, import Directory Services users,
and import Directory Service data into Business Objects.

Before enabling LDAP for Trusted Agents, you must first configure Trusted Agents. For more information,
see Configuring Trusted Agents.

To enable LDAP for Trusted Agents:

1. Verify that CSM is configured for LDAP:
◦ In CSM Administrator, select the Security category and then select the Edit Security

Settings task. Select each client page (Desktop Client, Browser Client, etc.) and verify that
LDAP is selected as a login mode.

◦ Create or open a Blueprint, and then select Tools>Directory Services. Edit an LDAP
connection, and then verify that the Map LDAP Object settings are applied.

2. On the Map LDAP Object dialog, select the Trusted Agents page.
3. Select the Use Trusted Agents check box.

Note: If you want to disable Trusted Agents for a specific LDAP connection, clear the Use
Trusted Agents check box.

4. Select one of these group options:
◦ Any Trusted Agent Group: Select to allow any group to handle requests for this LDAP

Connection.
◦ Trusted Agent Group: Select a specific group to handle requests for this LDAP connection.

5. Select the General tab.
6. Optionally, select the Client-side LDAP (for SaaS) check box.

Note: This setting is not required for Trusted Agents, but it may complement its use by
reducing round trips between CSM Administrator and LDAP directories for activities initiated
within CSM Administrator using an Application Server and 3-tier connection. This setting
does not impact LDAP interactions that are initiated by Cherwell services that use a direct-
to-database and 2-tier connection.

7. Select OK.

Related concepts
Configuring Trusted Agents
Import Directory Service Users
Import LDAP Data into Business Objects
Configuring CSM Directory Services Settings
Related tasks
Install the Trusted Agents Server
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Using Trusted Agents Server with Windows
Domains

When integrating CSM with multiple domains, you can configure single sign-on user authentication by
associating a particular Windows Domain with a Trusted Agents Group or Service.

Before you can use Trusted Agents to authenticate Users through a Windows Domain, you must first
configure Trusted Agents. For more information, see Configuring Trusted Agents.

Trusted Agents for Windows Domains do not provide pass-through authentication for Windows users.
Users must still supply their user name and password in order for their Windows credentials to be
validated using the Trusted Agents.

Note: LDAP directory configuration is not required when using Windows.

To enable Windows Domains for Trusted Agents:

1. Verify that CSM is configured for Windows domains:
◦ In CSM Administrator, select the Security category and then select the Edit security settings

task. Select each client page (Desktop Client, Browser Client, etc.) and verify that Windows is
selected as a login mode.

◦ Create or open a Blueprint, and then select Tools > Windows Domains. Specify the domain
name of the network.

2. On the Windows Domain Settings window, select the Trusted Agents page.
3. Select the Use Trusted Agents check box.

Note: If you want to disable Trusted Agents for this Windows domain, clear the Use Trusted
Agents check box.

4. Select one of these group options:
◦ Any Trusted Agent Group: Select to allow any group to handle requests for this domain.
◦ Trusted Agent Group: Select a specific group to handle requests for this domain.

5. Select OK.
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Import External Data Using Trusted Agents
Use Trusted Agents to import external data into existing Business Objects.

To import external data using Trusted Agents, first configure Trusted Agents. For more information, see
Configuring Trusted Agents.

Trusted Agents are compatible with any connections available in CSM. You can import data using Trusted
Agents, but you cannot link data or import realtime or bidirectional data.

To import external data using Trusted Agents:

1. Open or create a Blueprint.
2. Select an existing Business Object, or create a new Business Object.
3. Go to Manager > External Connections.
4. Select Create New.
5. Select Next on the Welcome page.
6. Select Use Trusted Agents, and then select one of these options:

◦ Any Trusted Agent Group: Select to allow any group to handle requests for this External
Connection.

◦ Trusted Agent Group: Select a specific group to handle requests for this External
Connection.

7. Continue through the External Connection Wizard.
8. Map to a Business Object or create a new external Business Object.

Note: If you are using a new Business Object and you select Link to data on the Import vs
Linked page, an error appears on the Data Source page because you can only import data
using Trusted Agents.

9. Select the Database category, and then select the Import Data task.
10. Complete the steps in the External Data Import Wizard.

Related concepts
Configuring Trusted Agents
Create an External Connection to an API
Map an Existing Business Object to External Data
Import External Data into an Existing Business Object
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Using Trusted Agents with Email
Use Trusted Agents to process CSM emails from a server on a remote network.

To use Trusted Agents with email, you must first configure Trusted Agents. For more information, see
Configuring Trusted Agents.

Note: Using Trusted Agents with email will increase e-mail processing time.

To configure an email account to use Trusted Agents:

1. In CSM Administrator, select the Email and Event Monitoring category.
2. Select the Edit email accounts and settings task.
3. Select the email account you wish to configure, and then select the Edit button.
4. On the Email Options dialog, select the Trusted Agents page.
5. Select the Use Trusted Agents checkbox, then select a Trusted Agent Group, or select Any

Trusted Agent Group to allow any group to handle email requests.

Note: When using Trusted Agents, outgoing email messages will always be sent from the
Server, not the Client. This setting (viewable in the From Settings page) will be changed
automatically.

Related concepts
Configuring Trusted Agents
Related tasks
Configure Global Email Accounts
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Configure One-Step Actions for Trusted Agents
One-Step™ Actions can be configured to execute using Trusted Agents. This enables you to execute
specific Actions, such as Print, on remote servers and distributed systems.

You can use Trusted Agents with these Actions:

• Print

• Run a Program

• Run a Report

• Write to a File

• Transfer Attachments

• Call a Web Service

• Excel Merge

You can configure Trusted Agents for one or more of the supported Actions within a single One-Step
Action. Depending on your needs, you can assign a different Trusted Agent service group to each Action.

To use Trusted Agents with One-Step™ Actions:

• Trusted Agents must be configured for your system. For more information, see Configuring Trusted
Agents.

• Optionally, define Trusted Agents Service Groups so you can execute One-Step Actions on specific
Trusted Agents Services.

• You must have security rights to configure One-Step Actions to run on Trusted Agents. If you do not
have these rights, you can view Trusted Agent configuration settings, but you cannot change them.

To configure a One-Step Action to run on a Trusted Agent:

1. From the One-Step Editor Designer Board, select an Action that supports Trusted Agents.
2. Select the Trusted Agents page.
3. Select the Run on Trusted Agent check box.
4. Select one of these Trusted Agent service group options:

◦ Any Trusted Agent Group: Uses the next available Trusted Agent to execute the Action.
◦ Specific Trusted Agent Group: Uses a specific Trusted Agent service group to use for the

Action.
5. Review General properties for the One-Step Action to ensure they are valid for the selected Trusted

Agent service group. For example, for a Print Action, verify that the printer you select is valid for the
Trusted Agent service group.

Related concepts
Configuring Trusted Agents
Define a Write to a File Action
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Define a Run a Program Action
Define a Run a Report Action
Define a Call a Web Service Action
Related information
One-Step Security Rights
Define a Print Action
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Scaling Out the Trusted Agents Service
While a single Trusted Agents Service can be used to provide access to one or more private resources in
a single private network, additional Trusted Agents Services may be used for fault tolerance and request
routing.

Related concepts
Scaling Trusted Agents for Fault Tolerance
Scaling Trusted Agents for Request Routing
Related tasks
Configuring Trusted Agents for Request Routing
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Scaling Trusted Agents for Fault Tolerance
More than one Trusted Agents Service can be provisioned within a single private network to allow for
increased redundancy of communication with private resources. If one Trusted Agents Service goes down
or is otherwise unavailable, additional Trusted Agents Services can facilitate communications with the
same private resources.

The Trusted Agents Hub will distribute work among registered Trusted Agents based on a simple
selection algorithm that considers the last ping time for each Trusted Agent. As a result, work will not
necessarily be load balanced between the Trusted Agents but will be distributed between them depending
on the timing of requests and the timing of pings received from each agent.

To enable scale-out of Trusted Agents on a single private network, install and configure more than one
Trusted Agents Service on that private network, and then configure each to use the same Trusted Agents
Hub URL and Shared Key. No further configuration is required.

While there is no enforced limit on the number of Trusted Agents Servers that can be provisioned and
connected to a single Hub, you might experience performance and maintenance issues with large
numbers of Trusted Agents Servers. Therefore, no more than 20 Trusted Agents Servers are
recommended. Since each Trusted Agents Server hosts five Trusted Agents (one for each feature that
uses Trusted Agents), this recommendation allows for 100 Trusted Agents.

Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
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Scaling Trusted Agents for Request Routing
Use Trusted Agents Groups to allow request routing to specific groups of Trusted Agents Services,
whether in the same or different private networks.

If private resources reside in multiple private networks, Trusted Agents Services may be provisioned in
each of those private networks to allow communication with those private resources. Trusted Agents
Groups may be used to route requests to the appropriate Trusted Agents Services in each private
network.

For example, consider a sample distributed network that contains more than one Active Directory (AD)
domain, such as a "Denver" domain and a "Seattle" domain. While these domains may have an Active
Directory trust between them, authentication requests may be more efficient if "Denver" domain requests
are routed to Denver Active Directory domain controllers and "Seattle" authentication requests are routed
to "Seattle" Active Directory domain controllers. Routing of requests in this way can be accomplished
using Trusted Agents Service scale-out.
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Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
Configuring Trusted Agents for Request Routing
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Configuring Trusted Agents for Request Routing
Before you configure request routing, you must:

1. Configure Trusted Agents.

2. Connect to the Trusted Agents Hub from CSM Administrator.

3. Configure Trusted Agents service groups.

To configure the Trusted Agents Service scale-out for request routing:

1. Configure service groups as described in Configure Trusted Agents Service Groups.
2. Create a new Blueprint.
3. Choose one of the following:

◦ For LDAP, go to Tools>Directory Services, and then edit your LDAP connection.
◦ For Windows domains, go to Tools>Windows Domains, and then edit your domain

connection.
4. Verify the Trusted Agents page is configured to have authentication requests properly routed.
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5. Select the Trusted Agents page.
Verify that the requests are routed to the correct Trusted Agents group. For example, Colorado
domain requests can be routed to the Colorado Trusted Agents group by selecting that group when
configuring the Colorado LDAP settings.
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Related concepts
Scaling Trusted Agents for Request Routing
Related tasks
Install the Trusted Agents Server
Configure the Trusted Agents Hub in the Server Manager
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Trusted Agents Server Technical Architecture
Each Trusted Agent establishes its own connections to the Trusted Agent Hub and to the private
resources it accesses. Trusted Agents may also communicate with the Cherwell Application Server for
some operations, including bulk data import.

Related concepts
Communication Between Trusted Agents and private resources
Communication Between Trusted Agents and the Trusted Agents Hub
Communication Used for Bulk External Data Imports
Trusted Agents Network Communication
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Communication Between Trusted Agents and
private resources

The connections between Trusted Agents and the private resources they access are typically short-lived
and utilize the communication protocols appropriate for the target private resource type.

For example, when a Trusted Agent receives a request from a Trusted Agents Hub to verify an LDAP user
account, that request includes LDAP directory connection information configured in CSM Administrator.
The Trusted Agent uses this connection information to open a direct LDAP connection to the LDAP
directory and issues LDAP queries to verify the User account. When completed, the Trusted Agent
disconnects from the LDAP directory and returns the result of the user verification operation to the
Trusted Agents Hub for delivery to the requesting CSM service or application.

The connection between a Trusted Agent and a private resource should typically occur over a private
local network to reduce latency. Additionally, just as you would with other direct connections to secure
resources, consideration should be given to using secure LDAP and encrypted database communications
to protect the flow of sensitive information between these two components on the private network.

Note: The way in which Trusted Agents connect to and interact with private resources is exactly
the same as CSM would directly connect to and utilize those resources if no network security
boundaries were in place. That is, the same resource access logic is used for both scenarios.
Trusted Agents simply provide a mechanism to relay those requests across network security
boundaries. As a result, it may be helpful to configure an LDAP connection or an External
Database connection in CSM Administrator without using Trusted Agents first, when possible.
Then, when the connection is working properly, you can update the connection settings to indicate
that Trusted Agents should be used.

Related concepts
Trusted Agents Server Technical Architecture
Communication Between Trusted Agents and the Trusted Agents Hub
Communication Used for Bulk External Data Imports
Trusted Agents Network Communication
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Communication Between Trusted Agents and the
Trusted Agents Hub

Unlike connections to private resources, the connection between a Trusted Agent and a Trusted Agents
Hub is established when the Trusted Agent is started and is maintained until the Trusted Agent is
stopped, the Trusted Agents Hub is no longer available, or there is a loss of network connectivity between
the two.

In either of the latter two cases, the Trusted Agent will continue to try to reconnect to the Trusted Agents
Hub until the Trusted Agent is stopped.

This long-lived and resilient connection is established to ensure a Trusted Agents Hub can send requests
to Trusted Agents as needed. Since Trusted Agents reside inside a private network that is different than
the network of the Trusted Agents Hub, a Trusted Agents Hub would not be able to initiate an inbound
connection request to a Trusted Agent without opening the private network in a way that is typically
undesirable.

As a result, a Trusted Agent establishes an outbound connection from within the private network to the
Trusted Agents Hub using web-standard and firewall friendly protocols. The outbound connection request
is made to either port 443 or port 80 of the CSM Browser Client web application, which hosts the Trusted
Agents Hub. The port number is dependent on the protocol specified for the Trusted Agents Hub URL
when the Trusted Agents Service is configured in Cherwell Server Manager.

Note: Production environments should always use HTTPS (TLS/SSL) for the connection between
Trusted Agents and Trusted Agents Hubs to protect sensitive authentication information and
business object data.

Trusted Agents use a technology called SignalR to establish a persistent, bi-directional connection with a
Trusted Agents Hub. SignalR is an open source technology from Microsoft which facilitates use of several
transports for real-time messaging between a client (Trusted Agent) and a server (Trusted Agents Hub). A
SignalR connection starts as HTTP(S) and then may be promoted to a WebSocket connection if it is
available. Otherwise, other another transport is used.

The following summary describes the transports SignalR may use to establish bi-directional
communication between a Trusted Agent and a Trusted Agents Hub:

• WebSocket: an HTML5 protocol for an efficient and persistent two-way connection between client
and server

• Server Sent Events, also known as EventSource: an HTML5 standard describing how servers can
initiate data transmissions to clients after a client connection has been established

• Forever Frame: a technique in which a hidden IFrame makes a request to an endpoint on the server
that does not complete. The server then continually sends script to the client which is immediately
executed, providing a one-way real-time connection from server to client
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• Ajax long polling: a technique in which the client polls the server with a request that stays open until
the server responds, at which point the connection closes and a new connection is requested
immediately

More information about SignalR is available from Microsoft at the following site:

Introduction to SignalR

Related concepts
Trusted Agents Server Technical Architecture
Communication Between Trusted Agents and the Trusted Agents Hub
Communication Used for Bulk External Data Imports
Trusted Agents Network Communication
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Communication Used for Bulk External Data
Imports

When you use Trusted Agents to perform a bulk external data import, a Trusted Agent establishes a
connection to the Cherwell Application Server similar to how CSM Administrator or the CSM Desktop
Client establish a 3-tier connection to the Cherwell Application Server.

The settings for this Cherwell Application Server connection are configured using the Trusted Agent
Server Settings dialog box in Cherwell Server Manager.

The connection from the Trusted Agent to the Cherwell Application Server is used to send data from an
external database to CSM for mapping and importing as CSM Business Objects.

During the import, progress information is sent back to the CSM Administrator regarding the different
phases of the import operation. You can let the operation run to completion or cancel the operation. If you
cancel the operation, a request is sent along the path described above to allow each step in the operation
to cancel its processing.

The following table describes an example request flow for Business Object imports using a Trusted Agent.

Steps Actions

1
Using CSM Administrator with a 3-tier connection to a Cherwell Application Server, create an
External Connection that uses Trusted Agents, maps data from the External Connection to a CSM
Business Object, and initiates an import of external data into that Business Object.

2

The Cherwell Application Server recognizes that the External Connection is configured to use
Trusted Agents and that Trusted Agents are enabled in Cherwell Server Manager. The Cherwell
Application Server sends a request to the Trusted Agents Hub to import external data through a
Trusted Agent.

3

The Trusted Agents Hub attempts to find an active Trusted Agent that is configured to handle
external data import requests (for example, a Trusted Agent for External Data). If the External
Connection indicates that only agents in a specific Trusted Agents Group should be used to process
the request, the Trusted Agents Hub further restricts the selection process to only include Trusted
Agents in that group. When a Trusted Agent is selected, the Trusted Agents Hub sends a request to
that agent to import the specified external data.

4
The Trusted Agent receives the import request and uses the provided External Connection settings
to open a connection to the specified database. The Trusted Agent then constructs a query to obtain
the required data from the database and executes the query to obtain a data reader with the results.

5
The Trusted Agent then opens a connection to the Cherwell Application Server using the settings
defined in Server Manager and begins to stream the data obtained from the external database to the
Application Server.

6
The Cherwell Application Server receives the stream of data from the external database, maps each
record from the data stream to a new or existing Business Object based on the settings specified for
the import, and saves the Business Object to the CSM Database.
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Related concepts
Trusted Agents Server Technical Architecture
Communication Between Trusted Agents and private resources
Communication Between Trusted Agents and the Trusted Agents Hub
Trusted Agents Network Communication
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Trusted Agents Network Communication
When started, each Trusted Agent registers itself with the Trusted Agents Hub and begins to send "ping"
requests to the Trusted Agents Hub regularly to confirm to the Trusted Agents Hub that the Trusted Agent
is still present and available to receive requests.

Each Trusted Agent's initial registration request and subsequent pings are logged in both the Trusted
Agents Service log and the Trusted Agents Hub log if Debug level logging is enabled.

Additionally, CSM Administrator provides Trusted Agent registration and last ping time information for
each Trusted Agents Service and Trusted Agents Service Group.

Related concepts
Trusted Agents Server Technical Architecture
Communication Between Trusted Agents and private resources
Communication Between Trusted Agents and the Trusted Agents Hub
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Communication Used for Bulk External Data Imports
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Trusted Agents Logging
Extensive and detailed logging is available for Trusted Agents connectivity and operations, including
activities that occur on CSM servers, Trusted Agents Hubs, and Trusted Agents.

Logging can be configured to go to the Windows event log, files, or to a Splunk server. For best results,
log debug messages to a file or to Splunk rather than to the Windows Event Log because CSM generates
many messages when debug logging is enabled.

The logging information collected is determined by the service/server with logging enabled.

Detailed logging
information for: Then enable logging for: Location

Trusted Agents Hub

Browser Client

When using file logging:

• SaaS customers can view the Hub
logs by selecting Browser Client in
the Log Viewer in CSM
Administrator. For more
information, see Log Viewer Utility.

• The log file must be writable by the
IIS application pool in which the
Browser Client is running.

• Do not place the log file within the
physical path for the Browser
Client. Changing the files in this
directory, or subdirectory, can
cause the application pool to
recycle every time the log file is
updated, resulting in Users being
logged out unexpectedly.

Cherwell Server Manager on the Trusted
Agents Hub.

Cherwell performs this task for SaaS
customers.

Trusted Agents Trusted Agents Server

Cherwell Server Manager on each Trusted
Agents Server.

This task applies to on-premises and
SaaS customers.

Initiation of Trusted
Agents operations
from CSM servers

Application Server or Cherwell Service
Host Cherwell Server Manager.

Manual Active
Directory or external
data imports from
CSM Administrator.

Client-side logging.

Logging configured in the CSM Desktop
Client applies to CSM Administrator. For
more information, see Configure User
General Settings

Set log levels for selected log types:
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Log to Option description

Event log

Log level:

• Debug and above: Very verbose messages. This level is space and resource intensive.

Note: For best results, log debug messages (Debug and above) to a file or to
Splunk, and NOT to an event log. CSM logs numerous debug messages, so a
log would be slow and might require more resources.

• Stats and above: Detailed messages that track performance.

• Info and above: Informational messages that can be used to diagnose a problem.

• Warning and above: Warning messages that occurred.

• Error and above: Errors that were encountered.

• Fatal only: Errors that caused the service or process to stop.

Note: To see email success and failure messages, choose Info and above or Debug
and above.

File

• Log Level: Select an event classification as described above (example: Debug and
above, Info and above, etc.)

• File Name: Select the Ellipses button to select a location for the log file.

• File Size Limit: By default, the file size is set to 10 MB, but can be changed by entering a
new value in the field.

• File Count Limit: Rolling event logs are used, so that when the maximum file size is
reached for a log file, a new file is created. By default, the number of files is set to 20 (but
can be changed), after which the oldest log file is overwritten by continued logging.

Splunk Writes the logs to a Splunk server. You must configure Spunk logging for logging to Splunk.

Related concepts
Using the Server Manager
Splunk Integration
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Troubleshoot Trusted Agents
Before you call support for assistance, review troubleshooting tips and verify that your system adheres to
the recommendations.

If Trusted Agents operations are failing but the cause is unknown or more information is needed, detailed
logging can provide more information about the cause of the failure. Refer to Trusted Agents Logging for
more information.

Related concepts
Verify that a Trusted Agents Hub is Operational
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Find Your Trusted Agents Hub URL and Shared
Key

Each Trusted Agents Server must use the same Hub URL and shared key set in the Trusted Agents Hub.
There are various ways to find your Hub URL and shared key.

Use one of these options to find your shared key:

• Cherwell provides the shared key to SaaS customers when a Trusted Agents Hub is provisioned.
Locate the communication from Cherwell to find the Hub URL and shared key.

• If Trusted Agents are already configured and you need the key to configure an additional Trusted
Agents Service, open CSM Administrator, and then select the Trusted Agents category. Select the
Edit Trusted Agents Hub Settings task to see the Hub URL and the shared key for your system.

• On-premises customers can find the shared key in the Trusted Agents Hub on the server that hosts
the CSM Browser Client. For more information, see Configure the Trusted Agents Hub in the Server
Manager.
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Verify that a Trusted Agents Hub is Operational
When enabled and operational, a Trusted Agents Hub responds with a message at a relative URL:/
SignalR/Hubs. If you do not receive this file when you access this URL, the Trusted Agents Hub is not
operational.

For example, if your CSM Browser Client is accessible at this URL:

https://www.example.com/CherwellClient

The Trusted Agents Hub uses this URL:

https://www.example.com/CherwellClient/SignalR/Hubs

This URL responds with a message similar to this example:

/*!
* ASP.NET SignalR Javascript Library v2.2.2
* http://signalr.net
* 
* Copyright (c) .NET Foundation. All rights reserved.
* Licensed under the Apache License, Version 2.0
*
*/

To fix this issue:

• Verify that Trusted Agents are enabled in the Cherwell Server Manager.

• Restart Internet Information Services (IIS) or the CSM Browser Client web application.

Note: For SaaS customers, Cherwell Support must perform these tasks.

Related concepts
Troubleshoot Trusted Agents
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Verify Trusted Agents Connections to the Trusted
Agents Hub

When a Trusted Agent fails to connect to a Trusted Agents Hub, you should verify connection settings and
shared keys between the Trusted Agents Service and Trusted Agents Hub.

For example, you should verify:

• The Trusted Agents Hub is enabled and operational. See Verify that a Trusted Agents Hub is
Operational.

• You can connect to the CSM Browser Client from the machine that is hosting the Trusted Agents
Service. If you cannot, the network connection between the Trusted Agent and Trusted Agents Hub
may be experiencing a problem.

• A firewall is not preventing outbound communication from a Trusted Agent to the Trusted Agents
Hub on port 443 (if using HTTPS) or port 80 (if not using HTTPS). (HTTPS should be used for all
production Trusted Agents deployments.)

• The URL specified for the Trusted Agents Hub is valid and points to theCSM Browser Client web
application. See Verify that a Trusted Agents Hub is Operational.

• The shared key specified for the Trusted Agent Service in Cherwell Server Manager on the Trusted
Agents Server exactly matches the shared key for the Trusted Agents Hub using Cherwell Server
Manager on the CSM web server. See Configure the Trusted Agents Hub in the Server Manager.

• Enable Debug level logging on the Trusted Agents Service to determine more information about the
cause of the problem. See Trusted Agents Logging

Related concepts
Troubleshoot Trusted Agents
Verify that a Trusted Agents Hub is Operational
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Verify LDAP Authentication Outside of Trusted
Agents

Trusted Agents relay authentication requests from CSM servers using the same LDAP configuration
settings that are specified in CSM Administrator. The most common cause of LDAP authentication
problems is LDAP misconfiguration due to the number and variety of LDAP directory types and settings.

If LDAP authentication is not working through Trusted Agents, verify the LDAP settings by running CSM
Administrator on the same network as the LDAP directory. Enable "Client-side LDAP" so that LDAP
queries are executed directly by CSM Administrator rather than sending them to the Cherwell Application
Server for execution. If the LDAP settings work correctly when on the same network as the LDAP
directory, enable Trusted Agents usage.

See Using Trusted Agents Server with LDAP.

Related concepts
Troubleshoot Trusted Agents
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Verify Clients Are Using a 3-Tier Connection
Authentication requests that originate on a CSM client, such as CSM Administrator, are only sent through
a Trusted Agent if the CSM client has a 3-tier connection to a Cherwell Application Server and the request
is processed by theCherwell Application Server.

Other reasons why authentication requests may not be sent through a Trusted Agent include:

• Trusted Agents are not enabled on CSM servers using Cherwell Server Manager. See Configure the
Trusted Agents Server.

• There are no Trusted Agents available to process the request. This situation is noted in a Debug log
by the Trusted Agents Hub. See Trusted Agents Logging.

Related concepts
Troubleshoot Trusted Agents
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Verify the Maximum Message Size Setting for the
Cherwell Server Manager

If you attempt to import a large number of records from an external database through a Trusted Agent,
you may receive a CommunicationException error.

An example error is:

System.ServiceModel.CommunicationException: The maximum message size quota for
incoming messages (50000000) has been exceeded. To increase the quota, use the
MaxReceivedMessageSize property on the appropriate binding element.

To solve this problem:

1. Open the Cherwell Server Manager (Start > All Programs > Cherwell Service Management >
ToolsServer Manager.

2. Select the Application Server, and then select Configure.

3. Select the Advanced page.

4. Increase the Maximum Message Size. The maximum value is 2147483647.

Related concepts
Troubleshoot Trusted Agents
Verify that a Trusted Agents Hub is Operational
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify Trusted Agent Hub Timeout Settings
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Verify Trusted Agent Hub Timeout Settings
If the Trusted Agent Server is not processing as expected, verify timeout settings for the Trusted Agents
Hub against the Hub Ping Frequency setting for the Trusted Agents Server. Restarting services may also
solve the issue.

For example, the Trusted Agent server may time out when attempting to process email messages with
large attachments. This would trigger a communication error message in the Trusted Agent log file.

Possible solutions:

• Verify that the Agent Registration Timeout setting on the Trusted Agents Hub is greater than the
Hub Ping Frequency setting for the Trusted Agents Server. For more information, see Configure
the Trusted Agents Hub in the Server Manager and Configure the Trusted Agents Server.

Note: SaaS customers must contact Cherwell Support to determine if the Agent Registration
Timeout period for the Trusted Agents Hub has changed from the default of 180 seconds.

• Restart the Trusted Agents Server.

• Restart the Trusted Agent Server and CSM service used by the feature that is not working as
expected, in that order. For example, if the Trusted Agent Server is not processing email, restart the
Trusted Agent Server, and then restart the Cherwell Service Host.

Related concepts
Troubleshoot Trusted Agents
Verify that a Trusted Agents Hub is Operational
Verify Trusted Agents Connections to the Trusted Agents Hub
Verify LDAP Authentication Outside of Trusted Agents
Verify Clients Are Using a 3-Tier Connection
Verify the Maximum Message Size Setting for the Cherwell Server Manager
Verify Trusted Agent Hub Timeout Settings
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Verify Access to Remote Files, Printers, and
Network Resources

Resources using Trusted Agents must be in a network location that is accessible by the Trusted Agent. In
addition, Trusted Agents must run as domain users on the external network so they can access domain
resources such as printers and network resources.

For example, if you used Trusted Agents to run a One-Step Action that writes to a file on a remote
network, the Trusted Agent must have permissions to write to files on the remote network location. In
addition, users running the One-Step Action must have permissions to access and write to the file location
you specify.
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Globalization
You can use Globalization tools to translate text, referred to as "strings," into one or more languages. This
ensures that Users can use a single CSM installation to view the same data in multiple languages.

You can translate strings for:

• Content definitions for all Business Objects or for specific Business Objects and their associations.

• Portal definitions, such as User-defined menus, toolbars, headers and footers.

• Lookup Table data.

• System platform strings.

• System Portal strings.

Related concepts
Globalization Terms and Concepts
Globalization Workflows
Globalization Best Practices
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About Globalization
CSM provides several methods for translating your system into multiple languages.

Use Globalization features to:

• Perform Bulk Updates

Export a Language Pack, and then send the Language Pack to a translator. After strings in the
Language Pack are translated, you can import the file back into your system.

• Perform Updates in the Language Pack Editor

Use the Language Pack Editor to translate a small number of strings or modify existing translations.

• Use Machine Translation

Apply machine translations to a Language Pack. Currently, the Google Cloud Translator is
supported.

• Perform On-the-Fly Updates

Translate strings as you manage CSM features, such as Forms, One-Steps, and Expressions. This
method is recommended for maintaining an existing translation.

Related concepts
Globalization Workflows
Globalization Terms and Concepts
Globalization Best Practices
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Globalization Terms and Concepts

Globalization Terms

• Culture
Culture is used to assign a language and locale pair to Users. For example, the culture "en-US"
assigns the English language and the U.S. locale to Users. Cultures can be set globally and
assigned to Roles and to individual Users.

◦ Base Cultures
Refers to the strings provided for these languages and cultures:

◦ English (United States) (en-US)

◦ German (Germany) (de-DE)

◦ French (France) (fr-FR)

◦ Portuguese (Brazil) (pt-BR)

◦ Spanish (Spain) (es-ES)

◦ Primary Culture
The primary culture, also referred to as the installed culture, is the culture used by the majority
of a CSM system. In most cases, the culture is based on the culture selected when you
upgrade CSM from a version earlier than 9.2.0.

◦ Preferred Culture
Refers to the first preferred fallback culture that is shown to Users when a translation is
unavailable in their selected culture. The preferred culture is always the first enabled culture
listed on the Manage Cultures page of the Globalization Management window.

◦ Source Culture
Refers to the culture that is a starting point for a Language Pack. The source culture provides
a set of strings for a particular culture that you can translate.

◦ Target Culture
Refers to the culture for which you will translate strings. For example, your source culture
might be English and your target culture might be Danish (Denmark). In this case, you will
translate English strings to Danish.

• Definition
A definition is a system entity that makes up a CSM content object, such as a Business Object,
Form, Grid, Relationship, or Saved Search.

Each definition contains a set of strings that can be modified. These strings may be used in one or
many definitions.

• Language Pack
A Language Pack is a set of strings that enable support for specific languages and locales. Each
Language Pack has a set of strings in a source language; these strings are translated to a target
language.

• Language Pack Bundle
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A Language Pack Bundle is a set of Language Packs based on existing languages in your system
when you create a Language Pack.

String Types
Each CSM system includes the following types of strings that can be translated.

String Type Description

Content
Strings for Business Objects, Forms, Dashboards,
Expressions, One-Step Actions, etc. This includes
OOTB content and customer-created content.

Lookup Table Data
Strings for Fields values for Lookup Tables can be
translated after you enable localization for each table
and Fields within those tables.

Portal Content Portal-based strings for User-defined header and
footer, menus, toolbars, and more.

Platform

Typically client-based strings, such as those for menu
items, toolbars, dialogs, form controls, and tooltips.

You cannot change the Platform strings for the
languages provided by CSM. You can, however, use
one of the five base CSM languages as the starting
point for a Language Pack that includes platform
strings.

Portal Platform Portal-based resource strings for toolbars, menus,
errors, and more.

To translate various string types, select the scope when you create a Language Pack.

Fallback Mechanism
The order of cultures on the Manage Cultures page determines which language is shown to Users if there
is not a translation available for the culture they are using.

Note: The fallback mechanism applies to all strings, except those in Lookup Tables.

The first culture in the list is known as the "preferred" culture. This is the culture that pertains to most
Users in your system. Below that, the order of enabled languages determines what is shown to Users if a
translation is not available for their culture.

In the example below, Users with the Spanish (Peru) culture set will see strings in Spanish. If a string is
not available for that language, it will be shown in English, and then French if an English version is not
available.
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Globalization Workflows

Workflow for Translating Strings
Follow this general process to translate strings.

Task Notes

1. Populate your system with cultures. See Manage Cultures.

2. Define security by assigning cultures to Roles or to
Users.

See Configure Security for Cultures.

3. Create Language Packs. See Create a Language Pack.

4. Translate strings.

Use one of these approaches:

• Perform Bulk Updates
Export a Language Pack, and then send the
Language Pack to a translator. After strings in
the Language Pack are translated, you can
import the file back into your system.

• Perform Updates in the Language Pack
Editor
Use the Language Pack Editor to translate a
small number of strings or modify existing
translations.

• Use Machine Translation
Apply machine translations to a Language
Pack. Currently, the Google Cloud Translator is
supported.

• Perform On-the-Fly Updates
Translate strings as you manage CSM features,
such as Forms, One-Steps, and Expressions.
This method is recommended for maintaining
an existing translation.

5. Apply Language Packs to your system. When you
apply Language Packs, a Blueprint is created.

See Apply a Language Pack.

6. From the Blueprint created when you apply a
Language Pack, use the Definition Reviewer to review
the impact of your translations on Forms, Grids, and
Form Arrangements. You can modify these visual
elements as you review them in the Definition
Reviewer.

See Review Visual Elements for All Business Objects.

7. Publish the Blueprint that contains the Language
Pack.

See Publish a Blueprint.

8. Verify that your Portal strings have been translated
and add the Language Selector to each Portal Site. See Translating Strings for Portal Sites.
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Task Notes

9. Enable cultures so that translations are visible to
Users.

See Enable and Disable Cultures.

Workflow for Distributing Language Packs
You can distribute translated strings to various target systems by adding Language Packs to a Blueprint
or mApp Solution. After the Blueprint or mApp Solution is published, apply the included Language Packs
to your target system.

Follow this general process to distribute Language Packs:

Task Notes

1. Create Language Packs. See Create a Language Pack.

2. Translate strings using one of the approaches
listed in the table above.

3. Create a Blueprint or mApp Solution. See Create a Blueprint or Create a mApp Solution.

4. Add the Language Pack to the Blueprint or mApp
Solution.

From the Blueprint or mApp Solution, select
Managers > Language Pack Manager, and then
select the Language Pack.
Then, right-click and select Add to Blueprint or Add
to mApp.

5. Publish the Blueprint or apply the mApp Solution to
a target system. See Publish a Blueprint or Apply a mApp Solution.

6. Apply the Language Pack. See Apply a Language Pack.

1195

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_manage_cultures
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_create_language_pack
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_blueprint
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=create_a_mapp
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=publish_a_blueprint
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=apply_a_mapp
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_apply_language_pack


Globalization Good to Know

Excluded Strings
Most text strings can be translated. The following list contains examples of strings that are excluded from
Language Packs or that should not be translated:

• Team and Workgroup names

• File paths

• E-mail addresses

• Date formats

• True/false values, unless they appear in a sentence string

• The word "System," unless it appears in a sentence string

• [Font] strings

• Strings that start with "BO:" and "DefType:"

You can create custom lists of locked strings to prevent them from being translated. See Managing
Locked Strings.

mApps Compatibility
Due to changes made to support Globalization, the following guidelines apply to mApp Solutions:

• mApp Solutions created using CSM 9.2.0 or later cannot be applied to an earlier version of CSM.

• When you apply a mApp Solution to that was created on a version earlier than CSM 9.2.0, you are
prompted to and must select a target culture for the mApp.

Globalization and Cherwell Mobile
Globalization support is currently not available for Cherwell Mobile for iOS or Cherwell Mobile for Android.

Date, Time, Number, and Currency Formats
Date, time, number, and currency formats are determined by the User's operating system's region setting
for all CSM Windows-based clients and for the Microsoft Edge browser. For other web browsers, date,
time, number, and currency formats are determined by the browser's language settings; the top language
set for a browser is used for these formats.

Disabling Localization on Localized Fields
You may see unexpected values for Fields that have been localized if you disable localization support for
the Fields. (This task is performed on the Localization page of the Business Object Properties dialog. See
Define Localization Properties for a Business Object) If this occurs, you can manually edit values in the
Data Editor to reflect values for your installed culture.
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Configuring Globalization
Before you can translate platform and content strings, you must first add cultures, configure machine
translation, and manage security rights.
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Manage Cultures
Use the Manage Cultures page of the Globalization Management dialog to manage the cultures for your
system.

You can:

• Add cultures

You must do this before you can enable the culture so that translations are visible to Users.

• Enable and disable cultures

This enables you to control which translations are visible to Users for each culture.

• Reorder cultures to specify "fall-back" languages

Culture order determines the "fall-back" languages that are visible to users if a translation is not
available for their selected culture.

• Delete cultures

Delete cultures that are no longer needed.

Add Cultures
When you add a culture, definitions for that culture are added to a Blueprint that you can publish
immediately or save and publish later.

Note: Newly created culture-specific fields are automatically populated with data from the primary
culture. This prevents the culture-specific Fields from having null values.

To add a culture:

1. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

2. Select the Manage Cultures page.

3. Click the Plus sign to the right of the drop-down.
The Add Culture dialog opens, and the Cultures drop-down contains cultures you can add to your
system.

4. Select the culture to add to your system.

5. Click OK.

The Blueprint that contains new definitions based on the added culture opens. Once you publish the
Blueprint, the newly added culture is shown on the Manage Cultures page. You must enable the culture
before it is available in the culture selector.
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Enable and Disable Cultures
Cultures are available in the culture selector after you enable them. Disabled cultures are not available in
the culture selector.

To enable a culture, select the Enabled check box.

To disable a culture, cear the Enabled check box.

Reorder Cultures to Specify "Fall-back" Languages
Use the arrows to reorder the priority in which enabled cultures are shown to Users if a translation is
unavailable for their culture. For more information, see Fallback Mechanism.

Delete Cultures
When you delete a culture, associated definitions are deleted from Business Objects, Grids, and Forms. A
Blueprint is created so you can verify your changes before you publish them to your system.

Warning: When a culture is deleted, data associated with culture-specific fields is also deleted
and cannot be recovered once you publish the Blueprint.

The primary culture, also referred to as the installed culture, cannot be deleted or removed from the list of
cultures.

To delete a culture:

1. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

2. Select the Manage Cultures page.

3. Select a culture in the list, and then click the Delete icon.

The Blueprint with deleted definitions opens. Once you publish the Blueprint, deleted definitions are
removed from your system and the deleted culture is no longer shown on the Manage Cultures page.
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Configure Machine Translators
You can use machine translators to more quickly add translations to strings in a Language Pack. You can
then use the Language Pack Editor to review and modify strings.

Google Translate can be used to power translations in CSM. For more information, refer to https://
translate.google.com.

Note: You must create your own Google Cloud Translator account and add your API key to
enable machine translations for CSM.

To configure a machine translator:

1. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

2. Select the Translators page.

3. Select Google, and then click Configure.

4. Apply the following settings to the Google Translation dialog.

Setting Description

Enable Google Translator Select this check box to enable the Google Cloud
Translator for your system.

Application Name Provide the Application Name you used when set up
your Google Cloud Translator account.

Google Key Add the API key for your instance of Google Cloud
Translator.

Error Tolerance Level

Select an error tolerance level to use for machine
translations. The tolerance level determines the
number of attempts made to translate strings when
errors occur. Errors can occur because of complex
strings or rules in your machine translation API. A
lower tolerance level increases the number of
translation attempts and the amount of time needed
to translate strings. In most cases, a higher
tolerance level produces acceptable results;
however, machine translations should always be
reviewed in the Language Pack Editor.

Verify
Click this button to verify your settings. If you receive
an error, verify that you specified the correct
application name and Google key.

5. Click OK.
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Configure Localization Support for Lookup Tables
Before you can translate values for Fields in Lookup Tables, you must enable localization support for each
Lookup Table.

To enable localization support for Lookup Tables:

1. Verify that you have multiple cultures enabled for your system.
2. Review the information about current culture Fields and specific culture Fields. See About

Globalization and Lookup Tables.
3. Enable localization support for Lookup Tables.
4. Use the Data Editor to translate values for culture-specific Fields.
5. Publish your Blueprint.
6. Optionally, set and update foreign key values to ensure that Lookup Table values is updated in

existing records in your system.
7. Verify security settings for Lookup Tables. See Configure the Default Domain, Anonymous Login,

and Lookup Table Security Settings.

Related concepts
Manage Cultures
Storing Foreign Keys for Validated and Auto-populated Fields
Related tasks
Enable Localization Support for a Lookup Table
Translating Values for Culture-Specific Fields
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About Globalization and Lookup Tables
When you enable localization support for a Lookup Table, you can determine which Text Fields within that
object can show translated values to Users as they select, search for, and validate Field values based on
their current culture or from other enabled languages in your system.

A separate copy of each Field is added to the Lookup Table for each enabled culture in the system.

Tip: Consider storing foreign keys for Fields in your Lookup Table. This ensures that Users are
presented with the translated values in the correct language and lets you backfill translated values
in existing records. For more information, see Storing Foreign Keys for Validated and Auto-
populated Fields.

Fields in Lookup Tables with localization enabled are referred to as:

• Current Culture Fields

A current culture Field is used when localization is enabled for a specific Field. For example, if you
enable localization for the Priority and Urgency Fields for the Change Priority Lookup Object, these
are considered the current culture Fields. The value of the current culture Field is based on the
User's currently selected culture.

• Specific Culture Fields

A specific culture Field refers to the Field added to a Lookup Object for each culture enabled for
your system. For example, if you enable localization for the Priority and Urgency Fields, a copy of
each field is added for each culture you have enabled in your system. Users can use specific culture
Fields to validate values from languages other than their current culture.

Specific culture Fields are identified by their language and locale pair.
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You can also view information about the current culture and specific culture Fields on the Advanced page
in the Field Properties window. See Define Advanced Properties for a Field.
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Enable Localization Support for a Lookup Table
You must enable localization support for Lookup Tables before you can translate Field values for the
table.

To enable localization support for a Lookup Table:

1. Create a Blueprint.
2. In the Object Manager, select the Lookup Table for which you want to enable localization features.
3. Select Edit Business Object.
4. Click Bus Ob Properties.
5. Select the Localization page.
6. Select the Supports Localization check box.
7. Select the Fields for which you will translate values.

Note: To enable localization support for a Field in a Group Member, enable localization for
the Group Leader, and then select the Fields to translate.

8. Click OK.
The Manage Culture-specific Fields dialog opens.

9. Select options to determine how values are managed for the languages enabled for your system.

Option Description

Copy the neutral-culture field values to
specific culture Fields

Select this check box to copy existing values
into Fields for the selected culture.

Select the culture that the neutral-culture
field value is currently in

Select a culture that you know has existing
values for the fields you want to translate.
Typically, this is the installed culture for your
system.

Overwrite existing culture-specific Field
values

Select this check box to overwrite existing
culture-specific values with values from the
selected culture.

Copy the neutral-culture value to all
culture-specific Fields

Select this check box to copy the neutral-
culture value to all culture-specific Fields. This
adds a value for all enabled cultures.

Tip: For best results, select this option
because it gives you a starting point for
translations.

Open the Data Editor Select this check box to open the Data Editor
after values are copied.

1204

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/bundle/csm_administration_10_help_only/page/content%2Fsystem_administration%2Fglobalization%2F..%2Fblueprints%2Fcreate_a_blueprint.html


Option Description

Add culture-specific values to the default
Form and Grid

Select this check box to add culture-specific
values to the Default Form and Grid.

Purge orphaned culture-specific Fields Select this check box to remove culture-specific
Fields that exist in your system but are not
used. For example, you may have Fields from
a culture no longer used in your system, so you
can remove these orphans.

10. Click OK.
A message opens, indicating the results of the copy.

11. Close the message.

You can now:

• Use the Data Editor to translate values for culture-specific Fields. You can do this before you publish
the Blueprint.

• Publish the Blueprint, and then create a Language Pack that includes the Lookup Table and use the
Language Pack Editor to translate values for culture-specific Fields. Refer to Create a Language
Pack.

• Manage culture Fields from the Object Manager. From the Object Manager, select the Lookup Table,
and then click the Manage Culture Fields link.
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Translating Values for Culture-Specific Fields
Use the Data Editor to modify values for culture-specific Fields.

The Data Editor opens automatically after you enable localization support for a Lookup Table if you
selected the Open the Data Editor check box on the Manage Culture Specific Fields dialog. You can also
follow the steps in Open the Data Editor.

To translate culture-specific Field values:

1. Configure a Lookup Table for localization.
2. Open the Data Editor.
3. Double-click a row in the Data Editor.
4. Translate the values for each language as needed.

5. Publish the Blueprint.
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Configure Security for Cultures
You can control the cultures that are available to Users by enabling culture settings globally, for Roles, or
for individual Users.

Specifically, you can give Users access to:

• All Cultures

Enables Users to choose any enabled culture as they work with CSM.

• Preferred Culture

Presents the preferred fall-back culture listed at the top of the listed on the Manage Cultures page.

• Specific Culture

Presents a single, specific culture to Users. For example, if your system is translated into Italian, you
can specify that only Italian is used globally (for all Users), for Users assigned to specific Roles, or
to individual Users. This also removes the culture selector from all clients, except the CSM Portal.

Culture Hierarchy
The following hierarchy determines which culture is presented to Users:

• User settings override Role settings

• Role settings override Global settings

• Global settings override Preferred culture

Related concepts
Hide the Culture Selector
Related tasks
Set Global Cultures
Set Cultures for Roles
Set Cultures for Users
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Set Global Cultures
The cultures you set globally are applied to all Users and Roles, unless you explicitly override the global
settings for specific Users and Roles.

By default, the preferred culture is used.

To set cultures at a global level:

1. In the CSM Administrator main window, click the Settings category, and then click the Edit System
Settings task.

2. Select the Globalization page.
3. Select one of these options:

◦ Use preferred culture:

Select this option to use the preferred fall-back culture that is shown to Users when a
translation is unavailable in their selected Culture. The preferred culture is always the first
enabled culture listed on the Manage Cultures page.

◦ All cultures

Select this option to enable Users to choose any enabled culture as they work with CSM.

◦ Specific culture

Select this option to designate a single enabled culture for your system, and then select the
culture from the drop-down list. This option removes culture selector for all Users in all clients,
except the CSM Portal.

4. Click OK.

Related concepts
Configure Security for Cultures
Hide the Culture Selector
Related tasks
Set Cultures for Roles
Set Cultures for Users
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Set Cultures for Roles
You can specify cultures for specific Roles to override culture settings made at the global level.

By default, the global setting is used.

To set cultures at the Role level:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Roles
task.

2. In the Culture section, select one of these options:
◦ Use global culture:

Select this option to use the global culture setting.

◦ All cultures

Select this option to enable Users assigned to the Role to choose any enabled culture as they
work with CSM.

◦ Specific culture

Select this option to designate a single enabled culture for Users assigned to the Role, and
then select the culture from the drop-down list. This option removes culture selector for Users
assigned to the Role.

3. Click OK.

Related concepts
Configure Security for Cultures
Hide the Culture Selector
Related tasks
Set Global Cultures
Set Cultures for Users
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Set Cultures for Users
You can specify cultures for specific Users to override culture settings made at the global and Role level.

By default, the role setting is used.

To set cultures at the User level:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Users
task.

2. In the Culture section, select one of these options:
◦ Use Role setting:

Select this option to use the culture set for the User's Role.

◦ All cultures

Select this option to enable Users to choose any enabled culture as they work with CSM.

◦ Specific culture

Select this option to designate a single enabled culture for the User, and then select the
culture from the drop-down list. This option removes culture selector for the User in all clients,
except the CSM Portal.

3. Save your changes.

Related concepts
Configure Security for Cultures
Hide the Culture Selector
Related tasks
Set Global Cultures
Set Cultures for Roles
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Hide the Culture Selector
Select a specific culture at the global level, for a user, or for a role to hide the culture selector from the
CSM Desktop Client and CSM Browser Client. You can hide the culture selector for each CSM Portal Site.

Note: In the CSM Desktop Client, CSM Browser Client, and CSM Portal, only enabled cultures
appear. In the CSM Administrator, all cultures in the system are available.

Hide the Culture Selector for All Users
Set a specific culture globally to hide the culture selector from the CSM Desktop Client and CSM Browser
Client for all users. Once you specify a global culture, that culture is used for all Users, unless you
override the global setting at the User or Role level.

To hide the culture selector for all Users:

1. In the CSM Administrator main window, select the Settings category, and then click the Edit
System Settings task.

2. Select the Globalization page.

3. Select the Specific culture option, and then select the language that CSM display for all Users.

Hide the Culture Selector for Roles or Users
Set a specific culture for Roles or Users to hide the culture selector from the CSM Desktop Client and
CSM Browser Client.

To hide the culture selector for Roles or Users:

1. In the CSM Administrator main window, select the Security category, and then click the Edit User
or Edit Roles task.

2. Select a User or Role.

3. In the Culture area, select the Specific culture option, and then select the language that CSM
display for the User or Role.

Hide the Culture Selector from the Portal
You can hide the culture selector from each Portal Site.

To hide the culture selector:

1. In CSM Administrator, select Site Manager to open your CSM Portal Site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Localization page.

4. Clear the Show Language Selector on Application Bar check box.
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Related concepts
Switching Cultures
Related tasks
Set Global Cultures
Set Cultures for Roles
Set Cultures for Users
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Configure CSM for Multi-Byte Language Support
CSM is configured to support single-byte languages by default. You can, however, use the System
Restore tool to enable multi-byte languages, such as Chinese and Japanese, for your CSM database.

Note: Right-to-left languages, such as Arabic, are not supported at this time.

To enable multi-byte support for your CSM database:

1. Use the Export Data tool to export your existing database to a .czar file, selecting these options:
◦ Export Entire System
◦ Export All Data
◦ Exclude Attachments
◦ Exclude Automation Data
◦ Exclude Encrypted Fields

2. Use the System Restore Tool to reload the exported .czar file, selecting the Use Unicode Data
Types check box as part of the restore process.

3. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

4. Select the Show Multi-byte Languages check box.

Note: If the check box is disabled, you must first enable support for multi-byte languages in
your database.

After you enable multi-byte language support for your system, cultures that use multi-byte languages can
be enabled on the Manage Cultures page.

Related concepts
Database Export Tool
Manage Cultures
Related tasks
System Restore Tool
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Change the Installed Culture
When CSM is upgraded from a version earlier than CSM 9.2.0, you are prompted to select a primary
culture, which is also referred to as the installed culture. You can change the installed culture in CSM
Administrator, but you should understand the impact of doing so first.

Good to Know

• This feature is intended for customers who upgraded CSM from a version earlier than 9.2.0 who
may have chosen the incorrect installed culture during the upgrade process. You should not need to
change your installed culture if you initially installed CSM 9.3.0 or later.

• Be sure to back up your database before changing the installed culture. Publishing a Blueprint that
changes the installed culture of your system is irreversible. Restoring a database backup is the only
recovery method.

• The installed culture does not impact formatting of your system; it only determines the basis of your
installation.

• If you want to hide or disable cultures from your system, the recommended methods are:
◦ Disabling cultures. See Enable and Disable Cultures.

◦ Hiding the culture selector globally or for specific Roles or Users. See Hide the Culture
Selector.

Changing the Installed Culture
To change the installed culture:

1. Back up your CSM database.

2. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

3. On the General page, select Change.

4. On the Change Installed Culture dialog, select the installed culture you want to change your
system to.

5. Select these options:

Option Description

Overwrite existing [new installed culture] values
with values from [old installed culture]

Select this check box to overwrite the target
installed culture with strings from the original
installed culture. You should only perform this
action if you want to permanently replace strings
in the selected installed culture with those in the
current installed culture.

Only content strings are impacted by this action;
platform strings not changed.
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Option Description

Purge [old installed culture] completely from the
system

Select this option to permanently delete content
strings for the original installed culture from your
system.

Culture-specific fields are also removed from
localized Business Objects, Forms, and Grids,
causing data to be deleted.

I have read the following statement...
You are required to acknowledge that you
understand the implications of changing the
installed culture.

6. Click OK.

A Blueprint with the replaced installed culture and overwritten values is created. This process may take
several minutes.

Applying the Installed Culture Changes

Important: Cherwell highly recommends publishing the Blueprint in a test environment before
publishing it to a production environment.

You can save or publish the Blueprint created when you change the installed culture. It may take several
minutes to publish the Blueprint.

After the Blueprint is published, all CSM clients should be restarted.
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Managing Globalization
You can manage string translations through Language Packs or as you work with content elements in
your system.

For example:

1. Use Language Packs translate strings for a specific scope, such as a Business Object, a set of
Business Objects, or CSM platform strings.

2. Translate strings as you work with elements, such as Field names or Form elements.
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Managing Language Packs
Manage Language Packs through the Language Pack Settings dialog in the Globalization category in
CSM Administrator or through a Blueprint or mApp Solution, depending on how you intend to distribute
the Language Pack.

For example:

• If you are managing translated strings for a single CSM system, use the Language Pack Settings
dialog box.

• If you intend to distribute translated strings with a mApp Solution or a Blueprint, use the Language
Pack Manager.

Language Pack Settings Dialog
Use the Language Pack Settings dialog to:

• Create Language Packs.

• Edit strings in a Language Packs.

• Apply a Language Pack bundle to your system.

• Export a Language Pack to a tab-delimited (.tsv) file.

• Import Language Packs after strings have been translated in an exported Language Pack.

• Merge two Language Packs with the same culture pair.

• View Language Pack bundle properties.

• Delete a Language Pack.

To open the Language Pack Settings dialog from the CSM Administrator Main Window, select the
Globalization category, and then select Manage Language Packs.

You can sort and filter the list of Language Packs on the Language Pack Settings dialog by:

• Name

• Source

• Target

• Scope

• Description

• Created By

• Created Date

• Last Modified By

• Last Modified Date

To sort the list, click a column header.
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To filter the list, select the Filter icon on the right side of the column header, and then select the values to
filter the list as needed. For example, you can filter the list of Language Packs by scope, such as those
that only include platform strings.

Language Pack Manager
Use the Language Pack Manager to:

• Add a Language Pack to a Blueprint or mApp Solution.

• Create a Language Pack.

• Edit a Language Pack.

To open the Language Pack Manager from a Blueprint or mApp Solution, select Managers > Language
Packs.
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Create a Language Pack
Use the Create Language Pack Wizard to create a Language Pack based on a source culture and scope,
such as content strings for a specific Business Object or system platform strings.

You can then use the Language Pack Editor to translate strings in a Language Pack or you can export the
Language Pack and send it to a vendor for translation. After strings are translated, you can apply
translated strings in a Language Pack bundle to a Blueprint that you can publish immediately or save and
publish later.

Run the Create a Language Pack Wizard
To run the Create Language Pack Wizard:

1. Use one of these methods to open the wizard from CSM Administrator :
◦ In the Main Window, select the Globalization category, and then select Manage Language

Packs. On the Manage Language Packs page, select Create.

◦ From a Blueprint or mApp Solution, select Managers > Language Packs, and then select the
Create icon.

2. Select Next on the Language Pack Wizard Welcome page.

3. Select a target culture. This represents the language and locale you want to translate to. Example:
Select French (Canada) to translate source strings to Canadian French.

4. Select Next.

Select the Language Pack Scope
Identify the scope for your Language Pack.

You can choose one of three options:

• Content Strings
Choose one or more of the following options:

◦ Definitions
Select a Business Object scope:

Option Description

All Strings for all Business Object definitions.

Specific Business Objects
Strings associated with Business Objects
selected on the Identify Specific Business
Objects page.

Blueprint Content

Strings for new or modified Business Object
definitions only. This option is only available
when you create a Language Pack from a
Blueprint or a mApp® Solution that contains
new or modified definitions.
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◦ Portal Content Strings
Extract strings for User-defined labels.

◦ Lookup Table Data
Extract strings for Field values in Lookup Tables.

Note: You must configure Lookup Tables for localization before you can create a
Language Pack that includes Lookup Table data. See Enable Localization Support for
a Lookup Table.

• Platform Strings
Choose one or both of the following options:

◦ System Platform Strings
Extract strings for application controls, dialogs, etc. for all CSM clients, except for the CSM
Portal.

◦ Portal Platform Strings
Extract strings for CSM Portal resources, such as error messages, toolbar definitions, menus,
etc.

• None
Create an empty Language Pack. Empty Language Packs are useful for merging multiple Language
Packs with the same target language. For more information, see Use Small Scopes for Language
Packs.

Limit the Scope to Specific Business Objects
If you chose to create the Language Pack with specific Business Objects, the Identify Specific Business
Objects page opens.

Select the Business Objects and Views to include in your Language Pack. You can choose from:

• Major

• Supporting

• Lookup

• Group Leader

• Group Member

Tip: Use the options at the top of the list to filter Business Objects by type. You can also select the
Type column to sort the list.

Select the Source Culture for Platform Strings
If you chose to create the Language Pack with platform strings, select the source culture or base
language from which strings will be translated.

Initially, you can choose one of the following base languages as your source:
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• English (en)

• German (de)

• French (fr)

• Portuguese (pt)

• Spanish (es)

After you have translated platform strings in at least one Language Pack, you can select the source
culture for that Language Pack. For example, if you translate platform strings into Italian (Italy) (it-IT), you
can use that as your source culture for new Language Packs.

Add Lookup Table Strings
If you chose to include Lookup Tables in your Language Pack, the Identify Specific Lookup Tables page
opens.

Select the Lookup Tables to apply translations to, and then select Next.

Adding Portal Site Strings
If you chose to include CSM Portal content strings in your Language Pack, the Identify Specific Sites page
opens.

Select the Sites to apply translations to.

Define Language Pack Properties
Finalize the Language Pack by defining these properties:

• On the Order the Source Cultures page, use the arrows to order the selected source cultures to
determine the fall-back mechanism for strings that don't exist in a particular language. For more
information, refer to Fallback Mechanism.

• On the Define Properties page, provide a name and description for your Language Pack.

On the Summary page, review the options you selected.

Select Back to change your options; select Finish to complete the wizard.

Related tasks
Export a Language Pack
Import a Language Pack
Apply a Language Pack
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Edit a Language Pack
Use the Language Pack Editor to translate and manage strings in a Language Pack.

Each Language Pack contains a row for each string for the scope chosen when the Language Pack was
created.

1. Language Pack toolbar

2. Language Pack Grid

3. Language Pack row count

4. Filter options

The Language Pack Toolbar

Icon Action Notes

Save changes you make to the
Language Pack.

Update the Language Pack with strings
from new definitions. See Refreshing a Language Pack.

Export the Language Pack to a .tsv file. See Export a Language Pack.
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Icon Action Notes

Select a machine translator and
translation options for the Language
Pack.

See Using Machine Translation.

Add a row to your Language Pack.

This feature is useful if you want to
pre-translate strings in the Language
Pack and apply them to your system
as part of the Language Pack.

Open an Item Details page for a
specific string. You can then add or
modify the target value and comments.

See Editing a String Row.

Delete selected rows from the
Language Pack.

When you delete a row, translations
are not applied for the target culture.

You can only delete unlocked rows.

Tip: If you delete a row and
later want to restore it, you
can update the strings from
the definition. See Refreshing
a Language Pack.

Undo the last change in the Editor.

Redo the last change in the Editor.

View the history of changes to strings
for the current editing session.

See Working with String Change
History.

Find source and target strings and
replace target strings. See Finding and Replacing Strings.

Copy the source value for selected
strings to the target value.

Lock selected rows so they cannot be
edited or deleted.

Unlock selected rows so they can be
edited or deleted.

Set the status for selected string rows. See Setting Status for Strings.
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Icon Action Notes

Apply a pre-defined filter to the Editor.

Choices are:

• Hide locked items

• Hide items not containing whole
words

• Hide items containing Expression
Tokens and Rich Text strings

• Show only items containing Token
Expressions

• Show only items containing Rich
Text strings

Select Clear Filter to remove the filter
applied to the strings list.

To create a custom filter, see Creating
a Custom Filter for the Language
Pack Editor.

Select the previous row.

Toggle between the row view and the
detailed view.

Select the next row.

View statistics for the Language Pack. See Viewing Language Pack Statistics
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Opening the Language Pack Editor
To open the Language Pack Editor:

1. Do one of the following:
◦ In the CSM Administrator Main Window, select the Globalization category, and then select

Manage Language Packs.

◦ From a Blueprint or mApp Solution, select Managers > Language Packs.

2. Select a Language Pack bundle, then select a Language Pack from the context menu. Click Edit.
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Editing a String Row
You can edit each string row directly in the Language Pack Grid by providing target values and
comments.

You can also edit string rows on the Item Details page, which provides more detail about each row.

To open the Item Details page:

1. Open the Language Pack Editor.
2. Select a string row, and then click Edit.
3. The Item Details page opens. From here, you can:

◦ View status information for the string. See Setting Status for Strings.
◦ See who validated a string and when.
◦ See who locked a string and when.
◦ See the source value and change the target value, if the string is unlocked.
◦ Provide comments for a string.

4. Click Update to apply your changes.
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Translating Plain Text Associated with Tokens
Use the Language Pack Editor to translate or move plain text in strings that contain Tokens.

Tokens are dynamic values that are handled by the system, so the Tokens themselves do not need to be
translated. Text associated with a Token can be translated and its location in the string can be changed,
however.

Note: You can translate text before or after the Token, but not in both locations. When text is
added before and after a token, the translation is not applied.

To translate text associated with Tokens in a Language Pack:

1. Open the Language Pack Editor.
2. From the toolbar, select the Filter icon, and then click Show only items containing Token

Expressions.
3. Double-click a row in the Editor.

Tokens are shown as disabled text in the Source Value box. Translatable text is showed as editable
text.

4. Click Copy Source to Target, and then translate the editable portion of the string.
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5. Click Copy Source to Target, and then click the Expand icon ( ).
6. Translate and move plain text in the string as needed, and then click OK.
7. Click Update.
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Translating Rich Text Strings
Use the Language Pack Editor to translate or format Rich Text strings.

Strings that use Rich Text formatting can be translated as long as the formatting elements are left intact.

1. Open the Language Pack Editor.
2. From the toolbar, select the Filter icon, and then click Show only items containing rich text

strings.
3. Double-click a row in the Editor.

Depending on the string, the Source Value box shows text, formatting, and Tokens. Tokens should
not be modified or deleted.

4. Click Copy Source to Target, and then click the Expand icon ( ).
The Rich Text Editor opens.

5. Use the Editor to translate and format editable text, and then click OK.
6. Click Update.
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Setting Status for Strings
As you translate strings, you may want to apply a status to each string to help manage the effort,
especially if multiple Users participate in translations.

To apply a status to strings:

1. Open the Language Pack Editor.
2. Select one or more strings in the Grid.
3. From the toolbar, select one of these status values:

Icon Status

Untranslated

Set by default for new items in a Language
Pack.

Translated

Translation is complete, but not reviewed or
validated. When you add a value to the
Target column, this status is set
automatically.

For Review

Translation is ready for review.

Validated

Translation is complete and has been
validated.

Validated-preferred

If you have duplicate strings in the target
language, set one string to this status to
ensure the translation is always used for the
string.
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Refreshing a Language Pack
You can update the strings that have been added or changed since the Language Pack was created. This
enables you to easily manage translations over time as your content changes or as you upgrade CSM.

Examples:

• If you add new Fields to a Business Object included in a Language Pack with a content scope, use
the refresh feature to add strings for that field.

• If you upgrade to a new version of CSM, use the refresh feature to update platform strings that were
added or modified.

To update strings in a Language Pack:

1. Open the Language Pack Editor.

2. Select the Update Language Pack icon (  ).
The Update Language Pack dialog opens.

3. Select one of the following options:
◦ Add and Update Existing Items

Select this option to update your Language Pack with new strings for the Language Pack
scope and with strings that have been updated in your target language since the Language
Pack was created.

◦ Include Updating Items with a Translated Status

Select this option to overwrite strings that have a status of "translated" with the strings
stored in the definition.

◦ Include Updating Items with a Validated or Validated Preferred Status

Select this option to overwrite strings that have a status of "validated" or "validated-
preferred" with the string stored in the definition.

Note: Translated strings are never replaced by empty strings.

◦ Only Add New Items

Select this option to only update your Language Pack with new strings for the Language Pack
scope.

A pop-up window opens and shows the results of the update.
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Using Machine Translation
You can use a configured machine translator to translate stings in a Language Pack. You can choose to
translate a set of strings or all strings in a Language Pack.

Note: To quickly translate selected strings in the Language Pack Editor, use the Quick Translation
feature. See Using Machine Translation.

1. Verify that you have a machine translator configured for your system. See Configure Machine
Translators.

2. Open the Language Pack Editor.
3. If you want to translate a set of strings, select them in the Grid.

4. Click the Translator icon ( ).
The Translate Language Pack dialog opens.

5. Select the following options:

Option Description

Translator Select the translator configured for your
system.

Translate All Select this option to translate all of the
strings in the Language Pack.

Translate Selected Items Select this option to translate the strings you
selected before you opened the Translate
Language Pack dialog.

Only translate items that have not been
translated

Select this option to use the machine
translator for strings with an "untranslated"
status or strings with empty target rows.

Do not translate locked items Select this option to have the machine
translator skip locked items.

Maximum number of words per string Select this option to limit the machine
translation to strings under a specified
character size. This enables you to use
machine translation for short strings. You can
then manually translate strings with a larger
number of characters.

6. Click OK.
Strings in the Target column are translated based on selections made in the Translate Language
Pack dialog.
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Using Quick Translation

Use the Quick Translation feature to quickly translate selected strings in the Language Pack Editor. Quick
translation uses the options defined in the Translate Language Pack dialog.

To use Quick Translation:

1. Verify that you have a machine translator configured for your system. See Configure Machine
Translators.

2. Open the Language Pack Editor.
3. In the Language Pack Editor, select strings you want to translate.
4. Right click, and then select Quick Translation Selected Items With, and then select your

configured machine translator.
The selected items are translated into the language defined for the Language Pack.
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Working with String Change History
You can view the history of changes to strings for the current editing session. All changes are shown,
except those made by machine translators.

You can also use the Change History dialog to:

• Undo and redo changes made in the current editing session.

• Revert selected strings to their original state.

• Go to a selected item in the Language Pack Editor strings list.

To open the Change History dialog:

1. Open the Language Pack Editor.
2. Modify strings in the strings list, and then save your changes.

3. Click the Change History icon ( ).
The Change History dialog opens and shows the index number for each change, each source string,
and each change made during the current editing session.

Tip: Move the Change History dialog to a position where you can easily see changes you
made to strings in the Language Pack Editor Grid.

4. Use the following options to manage changes:

Option Description

Go to Selected Row Click this icon to open the selected string row
in the Language Pack Editor Grid.

Revert Changes Click this icon to revert all changes made to a
string past the point where the string is
selected in the changes list. This enables you
to selectively revert changes to a string
without losing all changes.

Undo Last Change Click this icon to revert the last change made
to a selected string.

1235

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_open_language_pack_editor


Option Description

Redo Change
Click this icon to redo a change for a selected
string.

5. Click OK.
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Finding and Replacing Strings
You can search for strings in a Language Pack and replace strings in the target language as needed.

To find and replace strings in a Language Pack:

1. Open the Language Pack Editor.

2. Click the Find icon ( ).
The Find and Replace dialog opens.

Note: To find and replace strings, your cursor must be placed in a Target row when you click
the Find icon.

3. Use the following options to find and replace strings:

Option Description

Find What Provide the text you want to find.

Replace and Replace With If you select the Target segment option, you
can select the Replace check box and
specify replacement text.

Segment Choose to search for Source or Target
strings.

Only Whole Words Select this check box to limit the search to
whole words only.

Match Case Select this check box to limit the search to
words that match the case of the text you
want to find.

Find Previous Click this button to find text that occurs
before the string selected in the Language
Pack Grid.

Find Next Click this button to find the next occurrence
of the text.

Replace Click this button to replace the next
occurrence of the text.

Replace All Click this button to replace all occurrences of
the text.
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Viewing Language Pack Statistics
You can view the following information about strings in a Language Pack:

• Number of rows

• Source word count

• Number of untranslated strings

To view Language Pack Statistics:

1. Open the Language Pack Editor.

2. Click the Strings Statistics icon ( ).
3. Review statistics for the current view based on the applied filter and for the entire Language Pack.
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Creating a Custom Filter for the Language Pack
Editor
You can create a custom filter to help limit the strings list in the Grid to a manageable set. You can use the
Filter Editor to add a condition expression, or you can use the filter icon above each visible column to modify
the existing filter.
Use the Filter Editor

To create a custom filter using the Filter Editor:

1. Open the Language Pack Editor.
2. Click Edit Filter in the bottom right corner of the Editor.

The Filter Editor opens with the filter set from the Filter option ( ) on the toolbar.
3. Click And to add, change, or remove operators, conditions and groups.
4. Click the Plus sign to add a condition and value.

5. Add as many conditions as needed to filter the strings to the list you need.
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6. Click Apply.
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Use the Filter Icons

To customize a filter using Filter icons:

1. Hover over a column header in the Language Pack Editor, and then click the Filter icon.
2. Choose an appropriate filter based on the type of data in the column. For example, for the Source

column, select the Text Filters tab, then set the filter to show source values that end with "ing."

Changes are cumulative; each change you make using filter icons is added to the Edit Filter dialog.
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Apply a Language Pack
Use the Apply a Language Pack wizard to apply translated strings in a Language Pack bundle to a
Blueprint that you can publish immediately or save and publish later. The Blueprint only includes
definitions modified by the Language Pack.

Once a Blueprint containing a Language Pack bundle is published, Users will see strings in the language
associated with the Language Pack bundle based on their selected culture and their security settings. For
more information, see Configure Security for Cultures.

To apply a Language Pack bundle:

1. Use one of these methods to open the wizard from CSM Administrator:
◦ In the Main Window, select the Globalization category, and then select Manage Language

Packs.
◦ From a Blueprint or mApp Solution, select Managers > Language Packs.

Note: You can also apply a Language Pack to any definition or one or more Form controls.
See Applying Language Pack Bundles to Definitions or Form Controls.

2. Select a Language Pack bundle, and then select Apply.
The Apply Language Pack wizard opens.

3. Select Next.
The Identify Scope page opens and the scopes applied to the Language Pack when it was created
are selected by default.

4. (Optional) Change the scope if you want to apply translations to identical strings in your Language
Pack to a different scope. See Select a Language Pack Scope.

5. Select Next.
If you chose to apply the Language Pack bundle to specific Business Objects, the Identify Specific
Business Objects page opens and the Business Objects chosen for the Language Pack when it was
created are selected by default.

6. (Optional) Select additional Business Objects and Views if you want to apply translations to identical
strings in different Business Objects and Views.

7. Select Next.
If you chose to apply the Language Pack bundle to Lookup Tables, the Identify Specific Lookup
Tables page opens and the Lookup Tables applied to the Language Pack when it was created are
selected by default.

8. Select the Lookup Tables to apply translations to.
9. Select Next.

If you chose to apply the Language Pack bundle to Portal content strings, the Identify Portal Sites
page opens and the Sites applied to the Language Pack when it was created are selected by
default.

10. (Optional) Select different Sites to apply translations to.
11. Select Next.

The Select Strings to Update page opens.
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12. Choose one of these options:
◦ Update All Strings

Select this option to update and overwrite all strings in the system, including strings you may
have already translated.

◦ Only Update Strings Without Translations

Select this option to only update strings that do not have translations applied.

Note: If you are applying a Language Pack with a Lookup Table scope and you copied
neutral-culture values to culture-specific Fields, select the Update All Strings option to
ensure that translated values are correctly applied.

The Locked Strings File page opens.
13. If you have created locked strings lists that prevent the translation of strings, you can select a one or

more lists or no locked string lists.
14. Select Next.
15. On the Summary page:

◦ Review selections you made with the wizard.
◦ Select the Log Change check box to view or save a list of translation changes that will be

made once you publish the Blueprint that contains the Language Pack. See Log Translation
Changes in a Language Pack.

16. Click Back to change your options; click Finish to complete the wizard.

A Blueprint that contains the applied Language Pack opens. You can publish the Blueprint or save it and
publish it at a later date.

Related concepts
Create a Language Pack
Using Language Packs to Translate Portal Strings
Managing Locked Strings
Publish a Blueprint
Related tasks
Configure Localization Support for Lookup Tables
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Log Translation Changes in a Language Pack
You can view and save translation changes for a Language Pack. The log contains changes to Lookup
tables, definitions, Portal strings, and platform strings. This enables you to understand the impact of your
translations once you publish a Blueprint that contains the Language Pack.

You can choose to log changes from the Summary page of the Apply Language Pack Wizard or from
individual definitions or Form Controls.

If you select the Log Changes check box when you apply a Language Pack, the log opens in a separate
window. Click Save to File to save the log file.

Related concepts
Publish a Blueprint
Related tasks
Apply a Language Pack
Applying Language Pack Bundles to Definitions or Form Controls
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Export a Language Pack
To ease large translations, translation reviews, and translations completed by an external vendor, you can
export a Language Pack to a tab-delimited (.tsv) file.

Vendors can either import the .tsv file into their translation tool or convert the file to a format supported by
their translation tool.

Note: Tokens and Rich Text strings are included in the exported file but should always be
translated in the Language Pack Editor. For more information, see Translating Plain Text
Associated with Tokens and Translating Rich Text Strings.

To export a Language Pack:

1. In the CSM Administrator Main Window, select the Globalization category, and then select Manage
Language Packs.

2. Select a Language Pack bundle, and then click Export.
The Export Language Pack dialog opens.

3. Select the following file options as they apply:

Option Description

Include Header Row Select this check box to include a header in
the exported file. If you do not include
metadata, the header includes the source
value and the target value.

Include Metadata Select this check box to include metadata,
such as origin, validation, and lock data, in
the exported file. Headers for metadata are
included if you select the Include Header
Row check box.

4. Select one the following export options:

Option Description

All strings Select this option to export all strings in the
Language Pack.

Translated strings Select this option to export only translated
strings included in the Language Pack.

Untranslated strings Select this option to export only untranslated
strings included in the Language Pack.

Strings marked for review Select this option to export only strings that
need to be reviewed.

5. Click OK.
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6. Provide a file name and location for the exported Language Pack.
7. Click Save.

Once the exported file has been translated, you can import the Language Pack back into CSM. See
Import a Language Pack.

Related concepts
Guidelines for Translating .tsv Files
Related tasks
Import a Language Pack
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Guidelines for Translating .tsv Files
Strings files are exported in tab-delimited (.tsv) format. You must follow specific guidelines for modifying
these files to successfully import translations into CSM.

• Each string is exported in this format:

(untranslated text) tab (translated text) tab EOL

Add translations to the "(translated text)" portion of each string only. Do not modify other portions of
the string.

• If you do not use a translation tool to translate the strings file, use Microsoft Excel to help you
adhere to the tab-delimited format.

• The .tsv file must be encoded as UTF-8. For steps on viewing and setting the encoding, refer to your
editor's documentation.

• Do not modify the first line of the exported file.

• Tokens are exported in this format:

$$(TOKEN NAME)$$

Do not modify text between dollar signs.

• Rich Text strings are included in the exported file but should always be translated in the Language
Pack Editor.

Related tasks
Export a Language Pack
Import a Language Pack
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Import a Language Pack
You can import a Language Pack that is in a tab-delimited (.tsv) file. For best results, the .tsv file should
originate as a Language Pack that you exported from CSM and then modified.

To import a Language Pack:

1. In the CSM Administrator Main Window, select the Globalization category, and then select Manage
Language Packs.

2. Click Import.
The Import Language Pack dialog opens.

3. Click the Ellipses icon to navigate to the file you want to import.
4. Select the Source Culture for the Language Pack you are importing.
5. Select the Target Culture for the Language Pack you are importing.
6. Provide a name and description for the Language Pack.
7. Optionally, select the Merge with existing Language Pack check box. When you click OK, the

Merge Language Pack wizard opens after the import is complete.
See Merge Language Packs.
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Merge Language Packs
You can merge two Language Packs that have the same language and culture pair. This enables you to
focus translation efforts on specific areas, and then consolidate translations into a single Language Pack.

To merge two Language Packs:

1. In the CSM Administrator Main Window, select the Globalization category, and then select Manage
Language Packs.

2. Select a Language Pack bundle, and then click Merge.
The Merge Language Pack wizard opens.

3. Click Next.
The Identify Language Pack page opens.

4. Select the Language Pack to merge into.
5. Click Next.

The Identify Merge Options page opens.
6. Select an option to handle duplicate values from the source language:

◦ Select which Language Pack to take target values from.
◦ Select the Allow me to choose with targets to keep to control how duplicate or conflicting

values are handled during the merge.
7. Optionally, select the Delete the Language Pack that is being merged from check box. This

deletes the Language Pack when the wizard is complete.
8. Click Next.
9. If you selected the Allow me to choose with targets to keep option on the previous page, the

Handle Duplicate Source Values page opens if the following types of duplicate values are found.

Language Pack #1 Language Pack #2 Merge Result

Source value of "AAA" and target
value of "BBB"

Source value of "AAA" and target
value of "CCC"

Duplicate list to choose from;
choose either "BBB" or "CCC"

Multiple source values of "AAA" and
multiple different target values. No duplicates.

Duplicate list populated with
source "AAA" and a choice of all
target values; choose none or
multiple values.

Note: Empty target values are automatically merged with a source value if one exists in either
Language Pack. If not, the blank values are retained for the source and target values.

10. Click Next.
11. On the Summary page, review the options you selected.
12. Click Back to change your options; click Finish to complete the wizard.
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View Language Pack Properties
You can view the properties for each Language Pack bundle, including target culture, source culture, and
scope.

To view Language Pack bundle properties:

1. In the CSM Administrator Main Window, select the Globalization category, and then select Manage
Language Packs.

2. Select a Language Pack bundle, and then click the Properties button.
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Managing Locked Strings
You can prevent strings from being translated by locking them. You can then exclude the locked strings
when you apply a Language Pack.

For example, you may want to lock your company or product name so that it is not inadvertently
translated and applied to your CSM system.

Good to Know

• Certain strings are automatically locked by the system or should not be translated in any system.
See the list in Globalization Good to Know.

• For best practices, see Best Practices For Locking Strings from Translation.

• You can create a locked strings list from a Blueprint or mApp Solution. Locked strings lists can only
be applied to a Language Pack once a Blueprint has been published or a mApp Solution applied.

• You can lock text strings or use regular expressions to lock strings.

• String lists are case sensitive.

Process for Locking Strings

1. Create a Blueprint or a mApp Solution.

2. Select Managers > Locked Strings to open the Locked Strings Manager.

3. Select Create to open the Locked Strings List Editor.

4. Provide a name and description for the locked strings list.

5. Select Add, and then select one of these string types:
◦ String: Locks exact strings you specify.

◦ RegEx: Locks strings based on the regular expression. For example, Service Catalog|
Service Catalogs locks "Service Catalog" and "Service Catalogs".

6. Select OK.

7. Add all strings that you want locked.

8. Select Save.

9. Publish the Blueprint or apply the mApp Solution.

10. Apply a Language Pack.

11. Select a locked strings list to prevent matching target strings in the Language Pack from being
translated.

Merging Locked Strings Lists

1. Create a Blueprint or a mApp Solution.
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2. Select Managers > Locked Strings to open the Locked Strings Manager.

3. Select the locked strings you want to merge.

4. Right click, and then select Merge.

The lists are merged into a single list.

Related concepts
Create a mApp Solution
Publish a Blueprint
Apply a mApp Solution
Related tasks
Create a Blueprint
Apply a Language Pack
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Translating Content Strings On the Fly
When globalization and multiple cultures are enabled for your system, you can translate content strings
on the fly as you work with elements. This is useful for maintaining a translated system or for adjusting
translations after you apply a Language Pack.

You can translate text strings for Business Object elements, such as Fields and Grids, as you work with
Blueprints and mApps in CSM Administrator.

You can also apply Language Packs directly to Form controls. See Applying Language Pack Bundles to
Definitions or Form Controls.

Strings for certain elements, such as Stored Queries and Expressions, can be also be translated in the
Desktop Client.

To translate content as you work with elements:

1. Use the culture selector to switch to a different culture.
2. Edit elements and translate or modify text strings as needed.
3. Save your changes.
4. Switch to additional cultures and translate the element as needed.

Note: If you have applied translated Language Packs to your system, you may see
translated text strings for some elements. You can keep the translations or modify them as
needed. If you delete translations, Users will see text for the preferred culture, which serves
as a fall-back culture.

Remember to update strings from definitions if you edit a Language Pack that was created before you
made on-the-fly changes.
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Example: Translating E-mail Templates on the Fly
To translate E-mail Templates on the fly:

1. Open the One-Step Editor.
2. Create or edit a One-Step Action that uses a Send an E-mail Action.
3. Edit the Send an E-mail Action, and then add text for the language selected in the culture selector.

4. Click OK.
5. Use the culture selector to switch languages.
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6. Edit the One-Step Action and the Send an E-mail Action.
7. Translate text strings for the language you selected in the culture selector.
8. Click OK.
9. Repeat as needed for additional cultures.

Related concepts
Open the One-Step Editor
Define a Send an E-mail Action
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Example: Translating Expressions on the Fly
The logic for an Expression applies to all cultures, but you can manually translate Expression values for
multiple cultures.

To translate Expressions on the fly:

1. Open the Expression Manager.
2. Create or edit an Expression. For this example, create an Expression, and select Case from the

Editor drop-down.
3. Provide values for the language selected in the culture selector.
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4. Click OK.
5. Use the culture selector to switch languages.

6. Edit the Expression.
7. Provide values for the language you selected in the culture selector.
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8. Click OK.
9. Repeat as needed for additional cultures.

Related concepts
Open the Expression Manager
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Managing Translations for Individual Definitions
You can perform several localization tasks related to individual definitions from a Blueprint or a mApp
Solutionin CSM Administrator.

• View Translations

See Viewing Translations for Definitions and Form Controls.

• Apply Language Pack Bundles

See Applying Language Pack Bundles to Definitions or Form Controls.

• Delete Translations

See Deleting Translations from Definitions.

From a Blueprint, you can also restrict definitions from being localized. See Restricting Translations for
Definitions and Removing Translation Restrictions from Definitions.
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Viewing Translations for Definitions and Form
Controls

You can view translated strings and property information for individual definitions from a Blueprint or a
mApp Solution.

You can:

• Use the Item Managers to view translations for definitions, such as One-Step Actions, Stored
Values, and Expressions.

• Use the Definition Reviewer to view translations for Forms, Grids, and Form Arrangements.

• Use the Form Editor to view translations for Form control text.

To view translations for a definition:

1. In CSM Administrator, create a Blueprint or mApp Solution.
2. Do one of the following:

◦ Select an Item from the Manager menu, and then select an item, such as a Stored Value.
◦ Open the Definition Reviewer, and then select an item in the definition list.
◦ From the Form Editor, select a Form control.

3. Use one of these methods to open the Translations dialog:
◦ Right-click and select Localization > View Translations.
◦ Select the Localization icon on the toolbar, and then select View Translations (Item Managers

and Form Editor only).
4. View the following string definition information for each enabled culture:

Column Description

Culture Indicates the string's culture.

Property Indicates the string's definition property.

Definition Type Indicates the string's definition type.

Definition Name Indicates the name of the definition for each
string.

Value Indicates the value for each string.
Translations are shown for each culture.

5. Click OK.

Related concepts
Managing Controls on Translated Forms
Form Editor
Related tasks
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Review Visual Elements for All Business Objects
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Restricting Translations for Definitions
You can control which Items can be translated. This enables you to ensure that certain definitions, such
as Stored Values, remain in a specific language for all Users.

This option is available when Globalization is not enabled so you can ensure that certain strings are not
translated if definitions are shared across systems that may or may not be translated. This option also
helps you prepare for translation by enabling you to specify invariant values that you want ignored during
a translation effort. For example, you may want to ensure that all organizations in your company are
shown in English.

To prevent a definition from being translated:

1. In CSM Administrator, create a Blueprint.
2. Select an Item from the Managers menu. For example, select Managers > Stored Values.
3. Select an Item, and then you can:

◦ Right-click and select Localization > Do not allow the item to be localized.
◦ Select the Localization icon on the toolbar, and then select Do not allow the item to be

localized.
The Select the Invariant Culture dialog opens, with all applicable cultures listed.

4. Select the culture that contains values you want shown for the definition for all cultures. This
invariant culture is also referred to as a "constant" culture because the values cannot be translated
and will therefore not change based on a User's selected culture.

5. Click OK.

Definitions that cannot be translated include a Localization stamp in the upper right corner.
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Removing Translation Restrictions from Definitions
You can remove translation restrictions from definitions that have restrictions defined, but you must select
a culture whose value can be copied to all cultures. The invariant value typically comes from the culture
that was selected when the restriction was placed on the definition. (See Restricting Translations for
Definitions.)

To remove translation restrictions from a definition:

1. In CSM Administrator, create a Blueprint or mApp Solution.
2. Select an Item from the Managers menu. For example, select Managers > Stored Values.
3. Select a definition that has a Localization stamp in the upper right corner. This indicates that

translations are restricted for the definition.

4. You can then:
◦ Right-click and select Localization > Allow item to be localized.
◦ Select the Localization icon on the toolbar, and then select All item to be localized.

The Select the Invariant Culture dialog opens, with all applicable cultures listed.
5. Select the culture from which to apply an invariant value. This copies the invariant value from the

selected culture to all cultures.
6. Click OK.

You can now apply Language Packs to translate the definition values.

1263

CSM 10.0.0 Administration

CSM 10.0.0 Administration

https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_preventing_translations_for_defs
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_preventing_translations_for_defs
https://help.cherwell.com/csh?product=version-csm-10.0.0&topicname=csm_removing_translation_restrictions_defs


Applying Language Pack Bundles to Definitions or
Form Controls

You can apply one or more Language Pack bundles directly to one or more definitions or Form controls.

Translations will be applied to strings contained in the definition or control, but not to strings referenced by
the definition or control. To see which strings will be translated, you can view the strings before applying
translations.

You can:

• Use the Item Managers to apply Language Pack bundles to definitions, such as One-Step Actions,
Stored Values, and Expressions.

• Use the Definition Reviewer to apply Language Pack bundles to Forms, Grids, and Form
Arrangements.

• Use the Form Editor to apply Language Pack bundles to one or more Form controls.

To apply Language Packs to definitions:

1. In CSM Administrator, create a Blueprint or mApp Solution.
2. Do one of the following:

◦ Select an Item from the Manager menu, and then select an item, such as a Stored Value.
◦ Open the Definition Reviewer, and then select an item in the definition list.
◦ Open a Form, and then select one or more Form controls.

3. Use one of these methods to open the Select Language Pack Bundles dialog.
◦ Right-click and select Localization > Apply Language Pack Bundles.
◦ Select the Localization icon on the toolbar, and then select Apply Language Pack (Item

Managers and the Form Editor only).

Tip: You can apply Language Pack Bundles to multiple definitions from an Item Manager.

The Select Language Pack Bundles dialog opens.
4. Select the Language Pack Bundles to apply to target culture of the selected definitions. You can

choose one or more Language Pack Bundle.
5. Select the Log Change check box to view or save a list of translation changes that will be made

once you publish the Blueprint that contains the Language Pack. See Log Translation Changes in a
Language Pack.

6. Click OK.

Related concepts
Managing Controls on Translated Forms
Log Translation Changes in a Language Pack
Related tasks
Viewing Translations for Definitions and Form Controls
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Review Visual Elements for All Business Objects
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Deleting Translations from Definitions
You can delete translations for a selected definition. Translations contained in the definition are deleted,
but translations for referenced strings are not deleted. To see which strings will be deleted, you can view
the strings in each definition.

You can:

• Use the Item Managers to delete translations for definitions, such as One-Step Actions, Stored
Values, and Expressions.

• Use the Definition Reviewer to delete translations for Forms, Grids, and Form Arrangements.

Note: You cannot delete strings for the preferred culture.

To delete translations for definitions:

1. In CSM Administrator, create a Blueprint or mApp Solution.
2. Do one of the following:

◦ Select an Item from the Manager menu, and then select an item, such as a Stored Value.
◦ Open the Definition Reviewer, and then select an item in the definition list.
◦ Open a Form, and then select one or more Form controls.

3. Use one of these methods to open the Select Translations to Remove dialog:
◦ Right-click and select Localization > Delete Translations.
◦ Select the Localization icon on the toolbar, and then select Delete Translations (Item

Managers only).
The Select Translations to Remove dialog opens.

4. Select the culture than contains the translation for the definition.
5. Click OK.
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Managing Controls on Translated Forms
You can modify the size and location of Form controls for each Adaptive Layout for each Form.

This enables you to use a single Form for all cultures by adjusting the Form for Users of various cultures.

For example, the English text for a Form control may be shorter than the German text for the same
control. You can expand the size of the control for German without impacting the size of the control for
English.

Modifying Forms for Multiple Cultures
To modify Forms for multiple cultures:

1. In CSM Administrator, create a Blueprint.

2. Create or edit a Form.

3. Use the culture selector to switch to the culture you want to modify for the Form.
The Form should appear the same for all cultures, except you may have translated strings if you
previously translated and applied strings.

4. Modify a control on the Form. For example, move a control or resize it.

The changes you make apply only to the culture where you made the change. To apply changes to
multiple cultures, see the following section.

Applying Form Values to Multiple Cultures
To apply Form control size and location settings to multiple cultures:

1. Select a control on a Form.

2. Right-click on the control, and then select Localization Options > Copy Between Cultures.

3. You can then:
◦ Copy values from one culture to the culture you are currently viewing.

◦ Copy values from the current culture to one or more other cultures.

◦ Select Copy size, Copy position, or both.

◦ Click Apply.

The size and position values for the control are copied to the selected cultures.

Setting Tab Order for Multiple Cultures
You can set tab order, also known as tab stops, for each culture for a single Form. Use the culture
selector to select a culture, and then follow the steps in Set Tab Order on a Form.

Related concepts
Form Editor
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Create/Edit a Form
Switching Cultures
Related tasks
Applying Language Pack Bundles to Definitions or Form Controls
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Optimizing Content for Localization
The Content Optimization Tool assesses your content and makes recommendation for changes to help
prepare your content for translation, particularly strings used for Lookup Tables. You can choose to keep
the recommended changes or make your own changes based on the tool's assessment.

Before You Get Started

CAUTION: The Content Optimization Tool can potentially make significant changes, including
schema changes, to your system. Before you proceed, read this entire topic and follow the steps
and guidance provided.

About the Content Optimization Tool
The tool can:

• Convert Validation Lists to Lookup Tables

• Consolidate Lookup Tables

• Upgrade Existing Validated Fields

• Localize Text Fields

Guidelines for Optimizing Content
Follow these guidelines to optimize your content:

1. Always use the Content Optimization Tool in a test environment before you run the tool on your
production system.

2. Carefully review each tab and each selected item before you finalize your changes.

3. Always save a log file when you use the tool. This will help you troubleshoot issues you find after
you run the tool.
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Running the Content Optimization Tool

Important: Read the information in Optimizing Content for Localization before you use the
Content Optimization Tool.

To run the Content Optimization Tool:

1. In the CSM Administrator main window, select the Globalization category, and then select Content
Optimization Tool.

2. Select each page tab in the tool and carefully review the recommendations. For guidance, see:
◦ Converting Validation Lists to Lookup Tables
◦ Consolidating Lookup Tables
◦ Upgrade Existing Validated Fields
◦ Localize Text Fields

3. Modify recommended selections as needed.
4. Click OK.
5. When the Content Optimization Log dialog opens, save the results to a log file.

6. Save the results as a Blueprint.
7. Publish the Blueprint.
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Important: Do not publish the Blueprint on a production environment until you publish and
review the results in a test environment.
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Converting Validation Lists to Lookup Tables
The Content Optimization Tool finds all Fields that validate from a list. You can choose to convert these
lists to a newly created Lookup Tables or to an existing Lookup Table that has the same values.

Important: Read the information in Optimizing Content for Localization before you use the
Content Optimization Tool.

Tip: Using Lookup Tables to validate Fields is best practice for a localized system. For more
information, see Globalization Best Practices.

To convert validation lists to Lookup Tables:

1. Run the Content Optimization Tool.
2. Select the Convert List Expressions tab.
3. Review the recommended selections and the information in these columns:

Column Description

Lookup Table Shows the new Lookup Table that will be
created or the existing Lookup Table that will
be used to store values.

For Fields Shows the Fields that will be converted.

Current Validated Fields If an existing Lookup Table is found, shows
the Fields that will be converted to use that
object.

Values Shows the discovered list values.

4. Select or clear these check boxes as they apply:
◦ Convert

Converts the Fields listed in the For Fields column into a new Lookup Table (shown in the
Lookup Table column), and adds Fields to the new table to store converted values.

◦ Localize

Enables localization support for the new Lookup Table and the newly created Field in the
object.

5. Select the Consolidate Lookup Tables tab to review options.

Tip: You can also choose to convert all items in the list, convert nothing, localize all, or localize
nothing.
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Consolidating Lookup Tables
The Content Optimization Tool detects duplicate values across multiple Lookup Table Fields and gives
you the option of consolidating them into a single Lookup Table.

For example, if multiple Lookup Tables contain values of "Active," "New," and "Retired," the Content
Optimization Tool selects one Lookup Table to store the values and converts the remaining tables to use
that Lookup Table.

Important: Read the information in Optimizing Content for Localization before you use the
Content Optimization Tool.

To consolidate Lookup Tables:

1. Run the Content Optimization Tool.
2. Select the Consolidate Lookup Tables tab.
3. Review the recommended selections and the information in these columns:

Column Description

Lookup Fields Shows the Lookup Table and Field that
duplicate values will be converted to use.

Lookups Shows the Lookup Tables and Fields that
will be converted.

Values Shows the duplicate values in the specified
Lookup Tables.

4. Select the Consolidate check box for each set of duplicate values you want to convert.
5. Select the Consolidate Lookup Tables tab to review options.
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Upgrade Existing Validated Fields
The Content Optimization Tool can enable foreign key support for validated Fields and apply localization
support to Lookup Tables and validation Fields in those objects.

The tool will also increase the size of Fields as needed when localization is enabled for those Fields.

Important: Read the information in Optimizing Content for Localization before you use the
Content Optimization Tool.

To upgrade existing validated Fields:

1. Run the Content Optimization Tool.
2. Select the Upgrade Existing Validated Fields tab.
3. Review the recommended selections and the information in these columns:

Column Description

Validated Field Shows Fields that validate from a Lookup
Table.

Validation Business Object Shows the Business Object that contains the
validated Field.

Validation Field Shows the Fields that are used to validate
Fields in the first column.

4. Select or clear these check boxes as they apply:
◦ Foreign Key

Enables foreign key support for selected validated Fields.

◦ Localize Validation Business Object

Enables localization support for selected Business Objects that contain validation Fields.

◦ Localize Validation Field

Enables localization support for selected validation Fields and increases each Field's size as
needed.

5. Select the Localize Fields tab to review options.

Tip: You can also choose to upgrade all items in the list or upgrade nothing.
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Localize Text Fields
The Content Optimization Tool can enable localization support for Text Fields that are not used for
validation.

Important: Read the information in Optimizing Content for Localization before you use the
Content Optimization Tool.

To enable localization support for Text Fields:

1. Run the Content Optimization Tool.
2. Select the Localize Fields tab.
3. Select the Localize check box for the Fields for which you want to enable localization support.

Tip: The text before the period indicates the table name; the text after the period indicates
the Field name.

4. Click OK.
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Translating Strings for Portal Sites
Portal Sites can be easily translated into other languages. Use Language Packs to translate strings for
Portal Sites; to translate the Service Catalog, use Language Packs and manually translate records in
specific Lookup Tables.

Related concepts
Create a Language Pack
Build and Manage a Portal
Related tasks
Apply a Language Pack
Define Localization Properties for a Site
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Using Language Packs to Translate Portal Strings
Use Language Packs to translate strings for Portal Sites. Once you apply translated Language Packs for
enabled cultures, you can override startup actions, login actions, and custom Search Widgets for each
language.

There are two types of Portal strings:

• Content: User-defined labels.

• Platform: System resource strings for error messages, toolbar definitions, menus, etc.

To fully translate Portal Sites, you must create at least two Language Packs for each culture: one for
content strings and one for platform strings. The content Language Pack can include translations for
multiple Sites.

To translate content for CSM Portal Sites:

1. Verify that you have Portal Sites created and configured.

2. Verify that cultures used by your Portal Sites are enabled for your system. If cultures are not
enabled, the languages will not be shown in the language selector.

3. Verify security settings for cultures.

4. Create two Language Packs with these scopes for each culture:
◦ Portal Content Strings

◦ Portal Platform Strings

5. Translate the strings for each Language Pack using the Language Pack Editor or an external
vendor.

6. Apply both Language Packs.

7. Verify that the Show Language Selector on application bar check box is selected for each
translated Portal Site. See Define Localization Properties for a Site.

8. Override the startup action, login action, and custom Search Widget for each Site translation, as
needed. See Override Site Options for Each Language.

Related concepts
Create a Language Pack
Configure Security for Cultures
Related tasks
Apply a Language Pack
Define Localization Properties for a Site
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Translating Service Catalog Strings
Service Catalog strings presented to Users in the CSM Portal may come from multiple sources, so the
process for translating strings involves multiple steps.

The following figure shows the types of strings in the OOTB Service Catalog. The steps explain where
strings originate and how to translate them.

1. Translating the Service Name and Description
The Service Name and Description labels are populated from records in the Service Business Objects.

To translate Service name and description labels:

1. From the CSM Desktop Client or CSM Browser Client, use the culture selector to switch to the
culture you want to translate labels to.
Example: Switch to German.

2. Use a Search feature to locate a Service record.
Example: From the Quick Search Pane, select the Service Business Object from the drop-down list,
and then search for Account Management.

3. Open the record, and then manually translate values for the Name and Description Fields.

4. Repeat for each culture.

2. Translating the Service Category Name and Description
The Service category and subcategory name and description labels are populated from values in the
Incident Category and Incident SubCategory Lookup Tables.

To translate Service category and subcategory name and description labels:

1. In CSM Administrator, create a Blueprint.
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2. Enable localization support for the Incident Category and Incident SubCategory tables.

3. Publish the Blueprint.

4. Create a Language Pack that includes these options:
◦ Scope: Lookup Table Data

◦ Lookup Objects: Incident Category and Incident SubCategory.

5. Translate the Language Pack.

6. Apply the Language Pack.

7. Repeat for each culture.

Related concepts
OOTB Service Catalog and Cards with Search Styling
About the Service Catalog
Switching Cultures
Related tasks
Configure Localization Support for Lookup Tables
Enable Localization Support for a Lookup Table
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Managing the E-mail Monitor for Multiple Cultures
You can use E-mail Monitors with multiple cultures to create or modify records based on specific
languages. For best results, use a culture-specific e-mail account for each E-mail Monitor.

To use E-mail Monitors with multiple cultures:

1. Create an E-mail Monitor for each culture that is enabled for your system.

2. Select the applicable culture for each E-mail Monitor.

3. Select a culture-specific e-mail account for each E-mail Monitor.

4. Select the Monitors page, and then verify or modify rules to accommodate translations in your
system. For example, verify that strings for One-Step Actions that run based on the rule have been
translated.
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Configuring Record Translation
Configure record translation to translate Fields in Business Object Records using a translation Web
Service, such as the Google Translate API. For example, enable a technician to translate a localized
Incident description to English. Leveraging a translation Web Service allows the translation to take place
directly in CSM so that translated text is stored in the Business Object Record.

For this procedure, some experience with designing Forms and One-Step Actions is highly
recommended. Work with your system administrator if your CSM experience is limited.

Follow this general process to configure record translation:

Task Notes

1. Configure the translation Web Service. See below.

2. Configure the Business Object Form with Fields
for translation. See below.

3. Configure the One-Step Action to perform the
translation. See Configure a Translation One-Step Action.

Configure the Translation Web Service

To configure the translation web service:

1. Verify that you have an API key for your selected translation service.
2. In CSM Administrator, create a new Blueprint.

3. Open the Web Services Manager, and select the Create New button .
4. Define the General properties for the Web Service. For more information about defining General

properties and Methods for a Web Service, see Set Up a Web Service.
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5. Define a translation Method for the Web Service.
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6. Save and publish the Blueprint.
The translation Web Service is now available in the system.
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Configure the Form and Fields for Translation

To configure the Business Object Form with Fields for translation:

1. In CSM Administrator, create a new Blueprint.
2. From the list of Business Objects, select the Business Object to be configured for translation. For

example, select Incident.
3. Select Edit Business Object.

The Business Object Editor opens.
4. Create or edit Fields for the translation inputs and outputs. For example, navigate to the Business

Object Editor for Incident and create a text Field called Translated Description to display the
translated text on an Incident Form.

5. Return to the Object Manager and select Edit form.
The Form Editor opens. Edit the Form to facilitate translation. For example, add the Translated
Description Field next to the Description Field.
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6. Create a One-Step Action to perform the translation in the Business Object Record. Refer to
Configure a Translation One-Step Action.

7. Save and publish the Blueprint.
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Configure a Translation One-Step Action
Verify that your translation Web Service is set up in the Web Services Manager and that you have an API
key for the service.

1. Open the One-Step Manager, and verify that the association is set to the Business Object to be
configured for translation. For example, select Association>Incident.

2. Click Create New.
3. Add a Call a Web Service Action to the Designer Board.
4. With the Call a Web Service Action selected, in the General properties, click the ellipses button next

to Service.
The Web Services Manager opens. Select your translation Web Service and then click OK.

5. Check the box next to Store result as: Call a web service result.
This stores the translated text as a variable.

6. In the Method properties, set the parameter values.
For example, if using the Google Translate API, set the following parameters:

Parameter Value

q (Endpoint Parameter) The Field that contains the text to be translated,
such as Incident.Description

target (Endpoint Parameter) The target language for the translation, such as
en for English

key (Endpoint Parameter) The API key

7. Add an Update Business Object Action to the Designer Board.
8. In the General properties, check the box to save Business Object after action.

The Business Object Record will be saved each time the One-Step Action is run.
9. In the Fields properties, select the Field that contains the translated text and choose Template from

the available options. Right-click in the white space and select Variables>Call a web service
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result. For example, expand Incident and set the Translated Description Field.

The Field is now set to the variable that contains the translated text.
10. Optional: Right-clickcall a Web Service result and select Modifiers to modify the value of the

variable. For example, if using the Google Translate API, the JSON response includes other
information in addition to the translated text. Modify the value so that only the translated text is
displayed in the Field.

11. Optional: Define an automatic action so that the translation One-Step Action is executed
automatically when the Business Object is saved. See Define Automatic Actions for a Business
Object
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Applying Cultures to mApps
You can apply cultures to mApp® Solutions if:

• Multiple cultures are enabled.

• You have applied Language Packs that include translations for the enabled cultures.

The enabled cultures are included with the mApp Solution, along with translations for definitions included
in the mApp Solution.

To apply cultures to a mApp Solution:

1. Create a mApp.
2. Define mApp properties for the culture currently selected in CSM Administrator.
3. Use the culture selector to change to each culture enabled for your system, and then define mApp

properties for each culture.
If you do not define mApp Solution properties for each enabled culture, properties for the default
culture are applied.

4. Prepare a mApp Solution for distribution and verify that mApp Solution properties have been defined
for all cultures included in the mApp Solution.

5. Apply the mApp Solution. The cultures and translations included in the mApp Solution will be listed
on the Localization page of the Apply mApp Solution Wizard.

For more information on modifying multi-language mApp Solution, see the Applying a mApp to a
Globalized System free Video Learning Library course.

Related concepts
Create a mApp Solution
Define mApp Solution Properties
Prepare a mApp Solution for Distribution
Apply a mApp Solution
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Using Globalization with CSM Features
Users with rights to access multiple cultures can use the culture selector to switch languages as they work
with CSM.
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Switching Cultures
When multiple cultures are enabled, Users with multi-language security settings can switch cultures to
change the display language for each CSM client.

The culture selector is available in the:

• CSM Desktop Client

• CSM Browser Client

• CSM Portal

• CSM Administrator

• CSM Dashboard Viewer

• CSM Report Runner (Report Manager only)

In the CSM Desktop Client and CSM Administrator, the culture selector is available in the Item Managers,
such as the Dashboard Manager and One-Step Manager.

The initial culture selection is determined by:

1. The culture last selected by the User.

2. The culture set for a specific User in CSM Administrator.

3. The culture set for specific Role in CSM Administrator.

4. The Global culture set for CSM in CSM Administrator.

5. The language setting for the User's operating system for all CSM Windows-based clients and for the
Microsoft Edge browser. For other web browsers, the browser's language settings; the top language
set for a browser is used.

6. The CSM primary culture.

Using the Culture Selector in the Web Applications
In the CSM Browser Client, select Languages, and then select your preferred language.
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In the CSM Portal, select the language/culture on the toolbar, and then select your preference language.

Multi-tab browsing support in the Browser Client allows you to open tabs in multiple languages and work
in the tabs within the same session. In the CSM Portal, multi-tab browsing means you can have multiple
tabs of the same language open. If you have multiple tabs open and select a new culture, all tabs refresh
to display the newly chosen culture.

Using the Culture Selector in the Windows Clients
In most CSM Windows clients, such as CSM Desktop Client and CSM Administrator, you can select your
preferred language and quickly toggle between two languages.

Note: In the CSM Desktop Client, only enabled cultures appear. In the CSM Administrator, all
cultures in the system are available.
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1. Select the language/culture on the toolbar, and then select your preferred language.

2. Select the first flag icon to switch to the preferred culture for your system.

3. Select the second flag icon to switch to the previously used culture. This is always a different culture
than the preferred culture.

Using the Culture Selector in Blueprints
You can change cultures as you manage Blueprints so you can manually translate definitions as you
work. Only content strings change when you switch cultures in a Blueprint, unless you close the Blueprint.
In this case, CSM Administrator uses the last-selected culture from the Blueprint.

Related concepts
Manage Cultures
Multi-Tab Browsing Support
Hide the Culture Selector
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Using Reports with Multiple Cultures
Reports are not managed by Language Packs, so you must create a copy of a Report for each culture
you have enabled in your system. This enables you to translate column headers and labels in the Report
for each culture.

Note: The culture selector does not impact how a Report appears when it is run. Users run a
unique Report for each translation.

See Translating a Report.

In addition, you are prompted to select a culture for each Report when you run or edit an existing report if
its culture has not been defined.

Selecting a Report Culture
The first time you run or edit each existing Report in the CSM Desktop Client, you may be prompted that
the Report does not have an associated culture. The installed culture is detected, however, and you are
asked if you want to use that culture.

If you:

• Click Yes, the Report's culture is set.

• Click No, the Report Properties dialog opens. Select the culture you want to use for the Report.
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You can use the Report Properties dialog to change the culture assigned to a particular Report at any
time.

Translating a Report
Report elements, such as labels and headers, must be translated in each Report assigned to a specific
culture. You do not need to do this for every Report, but you may want to translate Reports that are
pertinent to Users of a specific culture.

To translate a Report:

1. Open the Report Manager.

2. Copy and paste the Report you want to translate.

3. Rename the Report.

4. Right-click on the Report, and then select Edit Report Properties.

5. Select a new culture for the Report, and then click OK.

6. Right-click on the Report, and then click Design Report.
7. Use the Report Designer to translate visual elements, such as labels and headers.

Related concepts
Open the Report Manager
Designing Reports
Related tasks
Editing Report Properties
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Setting a Culture for Running One-Step Actions
You can choose a specific culture to use when a One-Step Action is run. This is particularly useful for
ensuring that email messages sent by a One-Step Action are translated into a specific language.

If you do not select a specific culture, the One-Step Action runs in the culture of the User who runs the
One-Step Action.

To set a culture for a One-Step Action:

1. Open the One-Step Manager.

2. Create or edit a One-Step Action.

3. Click the Start Graphic on the Designer Board to edit One-Step Action general properties and
conditions.

4. On the General page, select the Use a specific culture when executing the One-Step check box.

5. Click the arrow, and then select a specific culture. Options include:
◦ Select a culture from the list of enabled cultures.

◦ Select a custom culture code stored in a Business Object Field. For example, you can create a
Culture Field in the UserInfo table so the One-Step Action is run using the culture set for the
User running the One-Step Action.

Related concepts
Open the One-Step Action Manager
Create/Edit a One-Step Action
Define General Properties for a One-Step Action
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Using Online Help with Multiple Cultures
CSM provides extensive online help in English and German. Limited online help is also available for
French, Spanish, and Brazilian Portuguese.

When Users access online help from within CSM, the selected culture determines which language for
which help is opened in the Documentation Portal. For example, if you select German (Germany) as the
culture, German help is shown.

If online help content is not available for a selected culture, Users are shown English content.

Related concepts
Switching Cultures
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Globalization Keyboard Shortcuts

Culture Selector Shortcut Keys (CSM Desktop Client)
Use the following keyboard shortcuts to use the culture selector in the CSM Desktop Client .

Key Action

CTRL+Q
Switch between the preferred culture and the last
selected culture.

CTRL+D Switch to the preferred culture.

CTRL+P Switch to the last culture you selected.

Language Pack Editor Navigation Shortcut Keys
Use the following keyboard shortcuts to navigate string rows in the Language Pack Editor.

Key Action

CTRL+UP Select the previous row.

CTRL+ENTER Toggle between the row view and the detailed view.

CTRL+DOWN Select the next row.
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Globalization Best Practices
Globalization is a powerful yet complex feature. Following best practices as you plan and implement
multiple languages will help ensure your success.

Consider Impact of Translations
If you intend to globalize your system at some point, always design your customizations with translation in
mind. Some translations may require Form adjustments, for example. See Managing Controls on
Translated Forms.

Add One Culture at a Time
For best results, enable one culture and translate strings for that culture before enabling additional
cultures.

Use Lookup Tables for Field Validation
Values for Fields that validate from lists cannot be localized. Use Lookup Tables to ensure that validated
values are available to users in all languages.

Benefits include:

• You can apply foreign key support to the validated Fields. See Storing Foreign Keys for Validated
and Auto-populated Fields.

• You can backfill translated values in existing records.

Use the Content Optimization Tool to easily convert validation lists to Lookup Tables.

Manage Language Packs Within Blueprints
Create and apply Language Packs through Blueprints or mApp Solutions to manage translations for new
or modified definitions. This enables you to maintain translations as your system changes and to manage
smaller Language Packs than those created outside of Blueprints or mApp Solutions.

Use Small Scopes for Language Packs
While you can create a Language Pack that contains a large set of strings for multiple scopes, you may
find it easier to manage multiple Language Packs that have a smaller scope for each target language.

Benefits include:

• You can manage translations, particularly reviews, in small batches. This is especially useful if
multiple people are performing these tasks.

• You can apply small Language Packs more quickly than large Language Packs.

• You can use Language Pack naming techniques to manage the various types of strings that need to
be translated.
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You can apply Language Packs separately as they are ready, or you can create a Language Pack with an
empty scope, and then merge completed Language Packs into it. You can then apply the merged
Language Pack at one time.

Create Language Packs that Contain Only Tokens or Rich Text
You may find it useful to translate certain items as a single Language Pack. For example, you may want
to create a Language Pack for the Incident scope that contains only Tokens.

To do so:

1. Create a Language Pack.

2. Open the Language Pack in the Language Pack Editor.

3. Verify that the Hide items containing Expression Tokens and Rich Text Strings check box is
selected.

4. Select all of the visible strings, and then delete them.

5. Change the filter to Show only items containing Rich Text strings.

6. Select all of the visible strings, and then delete them.

Your Language Pack now only contains Tokens. You can use the Show only items containing Token
Expressions filter to view and modify these strings following the guidance in Translating Plain Text
Associated with Tokens.

Best Practices For Locking Strings from Translation
You can prevent strings from being translated by locking them. You can then exclude the locked strings
lists when you apply a Language Pack. This can be important during different stages of your localization
strategy, including the first time you localize your system and also during system maintenance and
upgrades.

• First Time Localizing Your System: When first localizing your system, you might exclude certain
strings from being translated. Users can create one or more lists that can be selected when applying
a language pack as part of the LP wizard. For example, you can create individual lists for each
language, category of strings, child company of an MSP (Managed Service Provider), etc. Locked
strings lists can be modified and updated at any time.

• System Maintenance or Upgrades: Once the system has been localized, translations for certain
strings might need to be changed based on context or preference (personal or stylistic preference).
Since Language Packs do not contain duplicate entries, only one possible translation is contained in
the Language Pack. This can result in existing, customized, context-based strings being overwritten.
To preserve these existing translations, locked strings lists can be used to prevent overwriting when
a new Language Pack is applied for updating (localizing newly added content) or maintaining your
system.

Best practices for strings to include in locked strings list:

• Team Names: Team names (such as "Customer Service" and "Accounting") might be used in other
contexts in the application (example: Service Category within an organization). Also, Expressions
and Stored Searches can reference Team Names and can break if Team Names are translated.
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• Company and Product Names: You may want to lock Company and/or Product names so they are
not inadvertently translated and applied to your system.

• Polysemantic Words: Words with different meanings based on context/part of speech can be
difficult to translate (examples: order, record, open, site, state). These words can be used as a noun
or verb or assume completely different meanings based on context.

For general guidelines on creating and managing Locked String lists, see Managing Locked Strings

For specific categories of strings that could cause issues when being translated, see Globalization Good
to Know.
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Troubleshooting Globalization
Learn about potential issues might occur with Globalization features and how to rectify these issues. If
you have an issue that is not listed, contact Cherwell Support for assistance.
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Problem: Culture Selector Is Not Visible
Troubleshoot problems that prevent Users from seeing the culture selector in any CSM client, so they are
not able to switch languages.

If this problem occurs, try the following solutions.

Solution: Verify that Cultures Are Enabled

1. In the CSM Administrator Main Window, select the Globalization category, and then select
Globalization Settings.

2. Select the Manage Cultures page.
3. Verify that at least one culture is enabled.

Note: Only enabled cultures are visible to Users.

Solution: Verify Culture Security Settings

1. Read about how to apply security settings for different cultures.
2. Verify that security is correctly enabled:

◦ Globally
◦ For Roles
◦ For Users

Solution: Reload Definitions in the CSM Desktop Client

1. Open the Desktop Client.
2. Select Help>Reload Definitions.

Solution: Clear Browser Cache

If Users cannot see the culture selector in the CSM Browser Client or CSM Portal, suggest that they clear
their browser cache.

Solution: Restart IIS

If Users cannot see the culture selector in the CSM Browser Client or CSM Portal and clearing the
browser cache did not solve the problem, restart Internet Information Services (IIS).
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Problem: Solving Blueprint Conflicts in Globalized
Systems

Troubleshoot issues that cause conflicts when you publish Blueprints in a globalized system.

Conflict errors typically occur because many Globalization features make schema changes. Depending on
the order in which some features are enabled, you may receive conflicts when you publish a Blueprint.

If this problem occurs, try the following solution.

Solution: Overwrite Blueprint with Your Changes

To resolve conflicts, select the Use my Blueprint option on the Blueprint Conflict Resolution dialog. For
more information, see Develop Blueprints Concurrently .
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Problem: Multiple Legal Value Messages Appear in
the Log File

Troubleshoot issues that cause "multiple legal values" messages to appear in log files.

You may see messages in the System Analyzer or the Application Server log that state:

Multiple legal values were detected for the field [field name].

The error indicates that duplicate values exist for a Lookup Table Field, so Users may see unexpected
results in Searches, etc.

If this problem occurs, try the following solutions.

Solution: Remove Duplicate Values for a Lookup Table Field

Use the Data Editor to remove duplicate values from the Lookup Table Field specified in the log message.
Repeat this task for all languages.

Solution: Change Field Properties

1. In CSM Administrator, create a Blueprint.
2. Edit the Lookup Table that contains the Field referenced in the log file.
3. Select the Field referenced in the log file, and then click Edit.

Select the Validation/Auto-populate page of the Field Properties dialog.
4. In the Validation area, select the On Conflict Use First Match check box.

Related concepts
Data Editor
Define Validation/Auto-Population Properties for a Field
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Problem: Errors Occur When Large Language
Packs Are Applied

Troubleshoot errors that occur when you apply a Language Pack that contains a large number of strings.

You may receive "System.OutOfMemoryException" errors when you apply a Language Pack with a large
number of strings.

If this problem occurs, try the following solution.

Solution: Increase Database Connection Timeout Values

1. In CSM Administrator, create a Blueprint.
2. From the Blueprint Editor menu bar, select Tools>Options.
3. Increase the number of seconds set for the Database command timeout option or select the No

Limit check box.
4. Save your changes and publish the Blueprint.
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Administrative Resources
There are various methods for linking to CSM items from within CSM clients, from email messages, and in
other applications. In some cases, you need an internal record ID, or RecID, to correctly construct URLs.
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Linking Directly to CSM Objects
You can provide links (also known as deep linking) to CSM objects, such as records and Saved Searches.
This is useful for adding links to email messages sent to users or to records on remote systems.

Hyperlinks always open a new window in CSM. Users may be prompted for connection information and
their user ID and password.

Parameter Key
Parameters are in italics and should be replaced with the values noted in the following table. Parameter
values that contain spaces must be URL-encoded.

Parameter Replacement Value

ServerName The server name or IP address for the Browser Client or CSM Portal.

BusinessObjectID

The internal ID for the Business Object type, such as Incident.

A typical internal ID might look like:

6dd53665c0c24cab86870a21cf6434ae

BusinessObjectName

or

rectype

The common name for a Business Object type.

A typical name might be: incident

RecID

or

RecordID

This internal ID, or Record ID, uniquely identifies Business Object records (also
referred to as Object.RedID). For most types of records, this string looks similar
to:

939cd1f313b3b6866ef7d043faa258398c765d444a

To find internal IDs, refer to Finding Internal Record IDs.

PublicID

The Business Object Public ID is normally identifiable by users. For example,
the Public ID for an Incident would be an Incident ID. The Public ID does not
need to be a number. For example, the Public ID for a customer is the
customer’s full name, which needs to be URL-encoded.

A typical record ID might look like:

102259

Scope The name or internal ID of an items' Scope (Global, Team, etc.).

ScopeOwner

The internal ID of the Scope Owner. For example, if Team is the Scope, then
1st Level Support might be a Scope Owner.
For best results, use the internal ID for Scope Owner. For more information,
refer to Finding Internal Record IDs.
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Go to Record Links

• Go to Record by Record ID: Desktop Client
◦ URL Command

CherwellClient://commands/goto?rectype=BusinessObjectName&recid=Record ID

◦ Example:
CherwellClient://commands/goto?
rectype=incident&recid=93d6067b6f6e1a17a2364744bc984bdb2715f624fa

• Go to Record by Record ID: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/BusinessObjectID/Record ID

◦ Example:
https://ServerName/CherwellClient/Access/incident/
93d6067b6f6e1a17a2364744bc984bdb2715f624fa

• Go to Record by Record ID: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/BusinessObjectID/Record ID

◦ Example:
https://ServerName/CherwellPortal/IT/incident/
93d6067b6f6e1a17a2364744bc984bdb2715f624fa

• Go to Record by Public ID: Desktop Client
◦ URL Command

CherwellClient://BusinessObjectName/PublicID

◦ Example:
CherwellClient://commands/goto?rectype=incident&PublicID=123456

• Go to Record by Public ID: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/BusinessObjectName/PublicID

◦ Example:
https://ServerName/CherwellClient/Access/incident/123456

• Go to Record by Public ID: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/BusinessObjectName/PublicID

◦ Example:
https://ServerName/CherwellPortal/IT/incident/123456

• Go to Record in Edit Mode: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/Command/Queries.GoToRecord?
BusObID=BusinessObjectName&PublicID=PublicID&EditMode=True

◦ Example:
https://ServerName/CherwellClient/Access/Command/Queries.GoToRecord?
BusObID=incident&PublicID=123456&EditMode=True
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• Go to Record in Edit Mode: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/Command/Queries.GoToRecord?
BusObID=BusinessObjectName&PublicID=PublicID&EditMode=True

◦ Example:
https://ServerName/CherwellPortal/IT/Command/Queries.GoToRecord?
BusObID=incident&PublicID=123456&EditMode=True

Create Record Links

• Create Record by Business Object Name: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/New/BusinessObjectName

◦ Example:
https://ServerName/CherwellClient/Access/New/incident

• Create Record by Business Object Name: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/New/BusinessObjectName

◦ Example:
https://ServerName/CherwellPortal/IT/New/incident

• Create Record for a Specific Locale: CSM Portal
The following example shows the URL for creating an incident in the CSM Portal for a French locale.

Important: This does not work if a User's preferred culture is set to a different culture than
specified in the URL.

◦ URL Command
https://ServerName/CherwellPortal/SiteName/New/BusinessObjectName?Locale=locale

◦ Example:
https://ServerName/CherwellPortal/IT/New/Incident?Locale=fr-FR

Search Links

• Go to a Saved Search: Desktop Client
To run Saved Searches from other Scopes, change the ScopeName and ScopeOwner parameters.
Example: the Scope is Team and the ScopeOwner is the internal ID for 1st Level Support.

Note: For best results, always use the internal ID for the Scope Owner. For more
information, refer to Finding Internal Record IDs.

◦ URL Command
CherwellClient://commands/goto?rectype=recordType&group=Search%20Group%20Name

◦ Example:
CherwellClient://commands/goto?rectype=incident&group=All%20Incidents
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• Go to a Saved Search: Browser Client
To run Saved Searches from other Scopes, change the ScopeName and ScopeOwner parameters.
Example: the Scope is Team and the ScopeOwner is the internal ID for 1st Level Support.

Note: For best results, always use the internal ID for the Scope Owner. For more
information, refer to Finding Internal Record IDs.

◦ URL Command
https://ServerName/CherwellClient/Access/Command/Queries.SearchByID?
Scope=Global&ScopeOwner=(None)&Owner=BusinessObjectID&Name=Saved%20Search
%20Name

◦ Example:
http://localhost/CherwellClient/Access/Command/Queries.SearchByID?
Scope=Global&ScopeOwner=(None)&Owner=incident&Name=All%20Incidents

• Go to a Saved Search: CSM Portal
To run Saved Search from other Scopes, change the ScopeName and ScopeOwner parameters.
Example: the Scope is Team and the ScopeOwner is the internal ID for 1st Level Support.

Note: For best results, always use the internal ID for the Scope Owner. For more
information, refer to Finding Internal Record IDs.

◦ URL Command
https://ServerName/CherwellPortal/SiteName/Command/Queries.SearchByID?
Scope=Global&ScopeOwner=(None)&Owner=BusinessObjectID&Name=Saved%20Search
%20Name

◦ Example:
https://ServerName/CherwellPortal/IT/Command/Queries.SearchByID?
Scope=Global&ScopeOwner=(None)&Owner=incident&Name=All%20Incidents

• Search for Text Format: Desktop Client
This option allows searching for arbitrary text in the specified type of record. This is the equivalent of
typing search text into the quick search box in the main application.

Note: The recordType must be a Business Object that has Full-Text Searching enabled, and
the searchText must be URL encoded.

◦ URL Command
CherwellClient://commands/search?rectype=recordType&search=searchText

◦ Example:
CherwellClient://commands/search?rectype=incident&search=Printer%20%problem

Dashboard Links

• Open a Dashboard by Name: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/Dashboard/Dashboard%20Name
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◦ Example:
https://ServerName/CherwellClient/Access/Dashboard/CMDB%20Assets

• Open a Dashboard by Name: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/Dashboard/Dashboard%20Name

◦ Example:
https://ServerName/CherwellPortal/IT/Dashboard/CMDB%20Assets

• Open a Dashboard by ID: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/Dashboard/by-id/Dashboard%20ID

◦ Example:
https://ServerName/CherwellClient/Access/Dashboard/by-id/
93c6d34533492283691b0b4531802a4e6552e8baf5

• Open a Dashboard by ID: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/Dashboard/by-id/Dashboard%20ID

◦ Example:
https://ServerName/CherwellPortal/IT/Dashboard/by-id/
93c6d34533492283691b0b4531802a4e6552e8baf5

Calendar Links

• Go to a Calendar: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/Calendar/CalendarName

◦ Example:
https://ServerName/CherwellClient/Access/Calendar/Change%20Calendar

• Go to a Calendar: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/Calendar/CalendarName

◦ Example:
https://ServerName/CherwellPortal/IT/Calendar/IT%20Calendar

Miscellaneous Links

• Specify Login Method: Browser Client and CSM Portal
◦ URL Command

https://ServerName/ClientName/LoginMethod

◦ Example:
https://ServerName/CherwellClient/CherwellLogin
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Note: Acceptable values are: WinLogin for Windows credentials, SamlLogin for SAML,
and CherwellLogin for internal credentials.

• Run a One-Step Action
◦ URL Command

https://ServerName/CherwellPortal/SiteName/One-Step/OneStepName

◦ Example:
https://ServerName/CherwellPortal/IT/One-Step/Create%20Task

◦ Alternate Format:
https://ServerName/CherwellPortal/SiteName/One-Step/OneStepName/BusObName/
BusObRecIDorPublicID

Warning: The following format will be deprecated soon; we suggest you use one of the
methods listed above:
https://ServerName/CherwellPortal/SiteName/command/OneStep.LaunchOneStep/
OneStepName

Note: Linking to One-Step Actions works best when users are logged into CSM.

• Run a Report by ID: Browser Client
◦ URL Command

https://ServerName/CherwellClient/Access/Report/by-id/ReportID

◦ Example:
https://ServerName/CherwellClient/Access/Report/by-id/
939015c2ff09e43342f1094612a5cfc84de38baa37

• Go to an HTML Page: CSM Portal
◦ URL Command

https://ServerName/CherwellPortal/SiteName/Page/PageName

◦ Example:
https://ServerName/CherwellPortal/IT/Page/IT%20Home
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Friendly Links and URL Encoding in CSM
Use an expression in the email options or a One-Step™ Action to provide links to send inside of CSM.

The display text of the link is the same as the content of the link. If you send links from One-Step Actions,
the display text is different than the actual link. This works for launching CSM and links to other web sites
or files.

Insert a Custom Text Expression into a One-Step Action
To create a link with a different display text in a CSM email message or One-Step Action and then
change the expression to Text:

1. Right-click in the body of the message, and select Expressions > New customer Expression.

2. In the Editor drop-down list, select Text.

The format for the text must be:
[LINK]friendly-text|URL
The word LINK in square brackets tells CSM to treat this as a link, the friendly text is what is displayed as
the link text, and the URL after the | (pipe) character is the actual hyperlink.

The new line is caused by wrapping because there are no line breaks in the expression. When the user
gets this email, the link looks similar to: Go to Incident 10928. When the user selects the link, they are
taken to the record.
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URL Encoding
The following rules apply to URL encoding:

• Values must be URL encoded to pass field values that might contain unsupported characters.

• Links cannot include spaces or certain punctuation characters.

• You can use a token, such as IncidentID, but if you use search text, it may cause issues.

You can URL encode the URLs to convert certain characters to an allowed format. For example, spaces
are converted into the sequence %20.

To perform URL encoding:

1. Right-click in the inserted field of the One-Step Action.

2. In the Modifier drop-down list, select URL Encode.

3. Select OK.
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Finding Internal Record IDs
Each CSM object has an internal ID, also referred to as a RecID. Typically, you do not need to know the
internal ID, but this information is helpful for certain features. For example, Internal IDs are useful for
constructing URLs so users can link directly to CSM objects.

Use these tips for finding Internal IDs for CSM objects:

• Export an object, such as a Saved Search or Dashboard. You can then open the .ced file in a text
editor to retrieve Internal IDs for elements such as Scope and Scope Owner. See Import/Export a
CSM Item.

• Find the Internal IDs for Business Objects, Fields, and Relationships in the CSM Administrator.

• Use an appropriate Cherwell REST API operation to find the RecID for an object. For example,
usegetbusinessobjectsummaries to find RecIDs for Business Objects and Fields. For more
information, refer to About the Cherwell REST API.

Finding Record IDs for Field Values
To simplify the process of finding record IDs for Field values, add the RecID field to the Grid for the
Business Object that contains the foreign key field. Users can then use Table Management to see the
record ID.

You may first need to change presentation properties for the RecID field to allow it to be added to Grids.
See Define Advanced Properties for a Field.
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CSM Web-Forms
Cherwell Web-Forms™ is a browser-based application that allows Users to enter, view, and edit Business
Objects over the web without having to log in (example: Registration, ordering, etc.). This tool also allows
for the remote execution of One-Step Actions.

Use Web-Forms to create Customer satisfaction surveys, inquiry systems, order forms, exit surveys, or
Customer complaint forms.

Related concepts
Using Web-Forms
Configuring Web-Forms
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Using Web-Forms
Usage examples for Web-Forms:

Create a Customer Survey
Web-Forms can be used to measure customer satisfaction, complete the following high-level steps to
create a Customer Survey Web-Form.

1. Create a Survey Business Object along with an associated form and grid.

2. Create a One-Step that runs when an Incident is closed and generates a Survey record with a link to
the Web Form.
When an Incident is closed, the One-Step then runs and creates a Survey Web-Form for the
customer to fill out.

Tip: Create a WebinarSignUp Business Object using the same high level steps.

Create a Customer Inquiry System
Similar to Customer Survey's, Inquiries allow for customer communication. Complete the following high-
level steps to create an Inquiry system that allows customers to request to be contacted by a company
employee (example: a salesperson):

1. Create an Inquiry Business Object.

2. Create an additional Form with company specific fields (example: product of interest, name, phone
number).

3. Add a link to the Web-Form to your website.

Related concepts
Create/Edit a Business Object
Create/Edit a One-Step Action
Configuring Web-Forms
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Configuring Web-Forms
Cherwell Web-Forms are a browser-based application that allow users to enter, view, and edit CSM
Business Objects without having to log in.

CSM provides Web-Forms with limited default settings. However, the following settings should be
modified in the web.config file to fit your system settings:

• Data source: Defines the CSM data connection to use for Web-Forms (example: Cherwell
Browser).

• Login account: Defines login access to Web-Forms

• Display text: Customizes text at the top of the Web-Form for viewing, adding, and editing a
Business Object.

• Return to Home Page link: Sets the Home Page URL.

• Banner: Choose whether or not to display a Banner.

Web-Forms web.config File
The Web-Forms web.config file is an XML file stored in the following default directory on the server where
CSM Web Applications are installed:

...\Cherwell Browser Applications\CherwellWebForms 
      

To modify the default settings and configurations, modify the

<appSettings>

section of the code using any XML editor.

Tip: Save a copy of the web.config file before editing.

An example of the lines of code:

<?xml version="1.0"?>
<configuration>

<!-- For AJAX -->
<!-- End For AJAX -->
<appSettings>

<add key="LoginName" value=""/>
<add key="LoginPassword" value=""/>
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<add key="BusObName" value="Incident Follow Up"/>
<add key="Incident Follow Up_ViewName" value=""/>
<add key="Incident Follow Up_TextAtTop_New" value=""/>
<add key="Incident Follow Up_TextAtTop_Edit" value="You ca

n make changes to your incident survey"/>
<add key="Incident Follow Up_TextAtTop_View" value="Thank y

ou for filling in this incident survey"/>
<add key="Incident Follow Up_GoBackLink" value="Go to Cherw

ell Software"/>
<add key="Incident Follow Up_GoBackURL" value="http://www.C

herwellSoftware.com"/>
<add key="SubmitRedirect" value="http://www.CherwellSoftwar

e.com"/>
<add key="SaveRedirect" value="http://www.CherwellSoftware.

com"/>
<add key="AbandonRedirect" value="http://www.CherwellSoftwa

re.com"/>
<add key="ShowBanner" value="true"/>
<add key="DefaultActionObject" value="MyBusOb"/>
<add key="TrebuchetDataSource" value="[Common]Cherwell Brow

ser"/>
</appSettings>

Good to Know

• There are several web.config files used by CSM.

• When an application starts, the web.config file is backed up in a separate folder.

• Content of the web.config files is retained during both upgrade and reinstallation, so any changes
you make to web.config files are preserved.

Related concepts
Configuring the Data Source for Web-Forms
Configuring the Log In Account for Web-Forms
Define a Business Object to Display in Web-Forms
Configuring Web-Form Components
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Configuring the Data Source for Web-Forms
Use the web.config file to customize the Data Source connection.

Note: By default, the Data Source for Web-Forms is set to the "Cherwell Browser" database
connection

To customize the Data Source connection:

1. Open the Web-Forms web.config file in an XML Editor (C:\Program Files\Cherwell Browser
Applications\CherwellWebForms).

2. Locate the following line of code:

<add key="TrebuchetDataSource" value="[Common]Cherwell Browser"/>

3. Provide a new value.

4. Save the web.config file.

Good to Know

• There are several web.config files used by CSM.

• When an application starts, the web.config file is backed up in a separate folder.

• Content of the web.config files is retained during both upgrade and reinstallation, so any changes
you make to web.config files are preserved.

Related concepts
Configuring the Log In Account for Web-Forms
Define a Business Object to Display in Web-Forms
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Configuring the Log In Account for Web-Forms
Complete the following steps to define a log in account for Web-Forms:

1. Open the Web-Forms web.config file in an XML Editor. (C:\Program Files\Cherwell Browser
Applications\CherwellWebForms)

2. Locate the following line of code:

<appSettings>
<add key="LoginName" value=""/>
<add key="LoginPassword" value=""/>

3. Provide a value for Login Name and Login Password.

4. Save the web.config file.

Related concepts
Define a Business Object to Display in Web-Forms
Configuring Web-Form Components
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Define a Business Object to Display in Web-Forms
To select a Business Object to display in Web-Forms, complete the following steps:

1. Open the Web-Forms web.config file in an XML Editor. (C:\Program Files\Cherwell Browser
Applications\CherwellWebForms)

2. Locate the following line of code:

<add key="BusObName" value="Incident Follow Up"/>

3. Provide a value (example: Inquiry).

4. Save the web.config file.

Related concepts
Configuring Web-Form Components
Configuring Web-Forms to Run One-Steps
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Configuring Web-Form Components
Web-Form display text, banner text, and home page URLs can be customized depending on your
organization's needs.

Customize Web-Form Display Text
Use the following lines of code to provide text that displays at the top of the Web page for viewing, adding,
and editing a Business Object:

<add key="Incident Follow Up_TextAtTop_New" value=""/>
<add key="Incident Follow Up_TextAtTop_Edit" value="You ca

n make changes to your incident survey"/>
<add key="Incident Follow Up_TextAtTop_View" value="Thank y

ou for filling in this incident survey"/>

• New: Appears above a new, empty form.

• Edit: Appears above a form when being edited.

• View: Appears above a form after it has been saved and is displayed in view-only mode

Customize a Home Page URL
Use the following lines of code to define the text that displays on the link that returns users to the home
page:

<add key="Incident Follow Up_GoBackLink" value="Go to Cherwell Software"/>
<add key="Incident Follow Up_GoBackURL" value="http://www.C

herwellSoftware.com"/>

Customize a Banner on Web-Forms
Use the following lines of code to determine whether or not a banner displays:

<add key="ShowBanner" value="true"/>

Provide one of the following values:

• True: Displays a banner

• False: Does not display a banner.
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Related concepts
Configuring Web-Forms to Run One-Steps
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Configuring Web-Forms to Run One-Steps
Cherwell Web-Forms are a browser-based application that allow users to enter, view, and edit CSM
Business Objects without having to log in

Web-Forms can be configured to automatically run a One-Step. Complete the following procedures:

Create Config File for Each Business Object

1. Create or Edit a One-Step that fits the needs of your organization's Web-Forms.

2. Create a web.config file for each Business Object that is involved in the One-Step (example:
Change and E-mail).

Example code:

<WebFormActions Name="Change">

<ActionList>

<Action Name="Approve">

       <OneStep Scope="Global" ScopeOwner="">Approve Change</OneStep>

         <HeaderText AppendObjectID="true">Approving Incident</HeaderText>

         <SuccessText>Your change has been approved.</SuccessText>

         <FailureText>Unable to approve your change. The system reported th
e following error:</FailureText>

      </Action>

      <Action Name="Deny">

         <OneStep Scope="Global" ScopeOwner=" ">Deny Change</OneStep>

         <HeaderText AppendObjectID="true">Denying Change</HeaderText>
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         <SuccessText>Your change has been denied.</SuccessText>

         <FailureText>Unable to deny change. The system reported the follow
ing error:</FailureText>

      </Action>

   </ActionList>

</WebFormActions>

Create a URL to Run a Web-Forms One-Step
Users can run the One-Step by using a URL:

http://ServerNameorIP/CherwellWebForms/Action.aspx?
BusObName=Change&RecId=1692&Action=Approve

The Action.aspx page is used for running One-Steps.

There are three parameters you pass in the URL string:

• BusObName: Business Object that the One-Step runs against.

• RecId: ID of particular record to run against (only needed if the One-Step is running against an
existing business object).

• Action: Name of the <Action> to run in the config file.

If desired, you can leave off the BusObName parameter and instead add a DefaultActionObject entry in
the appSettings section of the web.config file.

<appSettings>

            <add key="LoginName" value="Henri"/>

            <add key="LoginPassword" value="password"/>

<add key="DefaultActionObject" value="Change" />

            <add key="TrebuchetDataSource" value="[Common]Cherwell Browser"
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/>

      </appSettings>

Note: If the DefaultActionObject is not specified in the web.config file it must specified in the URL
string.

Parameters such as View, New, or Edit can also be established on the URL used to open a Web-Form.
Incorporate the following parameters into your web.config file if desired:

• cmd: New, Edit, View

• BusObName: Any Cherwell Business Object. If not passed, the one in the web.config file is used.

• RecID: If csm=View or cmd=Edit ensure that the parameter contains the Record ID of the Business
Object.

Create a Customized HTML Page
If desired, create a custom HTML page to display to the user after visiting the Web-Form.

Example lines of code:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.
w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml" >

<head>

    Action for Incident</title>

</head>

<body>

<p>Business Object Definition's DisplayName: $$(DisplayName)$$</p>

<p>Business Object Definitions's PluralDisplayName: $$(PluralDisplayName)$$
</p>
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<p>Business Object Definitions's Image: <img src='$$(Image)$$' /> </p>

<p>Record ID: $$(RecordID)$$</p>

<p>Header: <b>$$(Header)$$</b></p>

<p>Message: $$(Message)$$</p>

</body>

</html>

Use any of the following variables, in any order, and as many times as needed:

• $$(DisplayName)$$

• $$(PluralDisplayName)$$

• $$(Image)$$

• $$(RecordID)$$

• $$(Header)$$

• $$(Message)$$

Good to Know

• There are several web.config files used by CSM.

• When an application starts, the web.config file is backed up in a separate folder.

• Content of the web.config files is retained during both upgrade and reinstallation, so any changes
you make to web.config files are preserved.

Related concepts
Create/Edit a One-Step Action
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